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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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Chapter 1
About This Guide

1  About This Guide

Audience and Scope  
This legacy guide provides you with many of the concepts and procedures you need to implement a sales force
automation solution using sales features that were available as of Update 23B. This guide isn't being updated,
so you must use it in conjunction with sales playbooks and by searching our library of questions and answers on
docs.oracle.com. The playbooks and answers cover the newest features and provide the most recent documentation. If
you've remaining questions, please post them on Oracle Customer connect.

Refer to the Implementation Reference guide for information on how to extend the application and to implement
additional features that aren't covered in this guide.

The name "CX Sales" in this guide refers to the existing sales version that's now being redesigned and replaced by
Digital Sales, the next generation of Oracle's sales application (Next Gen Sales). Digital Sales is built on top of the same
sales foundation. Because the Digital Sales is still being rolled out, you will need to implement some features in CX Sales
for a complete solution.

For some features, you may even decide to have some teams work in CX Sales while other teams work in Digital Sales
exclusively. For example, if the business plan, quota, and forecasting features are important to your solution, you may
decide to have sales managers work on business plans, quotas, and forecasts in CX Sales. Business plans, quotas, and
forecasting are still not available in Digital Sales.

Oracle is focusing on completely replacing, redesigning, and expanding the user-facing functionality. However, the
majority of the initial implementation steps are completed in the same CX Sales setup and administration pages as
previous releases.

Related Topics
• CX Sales and Digital Sales Features in the Sales Solution

• How to Use This Guide

• Related Guides for Your Sales Implementation

• Oracle Fusion Cloud Sales Automation Implementation Reference guide

Sales Application Interfaces  
Oracle Sales supports functionality across multiple interfaces.

• Web access from desktop and laptop for all sales, channel, and partner roles. This is the UI that administrators
also use to configure the application. Oracle is currently replacing the existing CX Sales web UI with the new
Digital Sales web UI. Some features are available in both web UIs and others only in one during the transition.

• CX Sales Mobile app for salespeople to use at or away from their desks.

• Microsoft 365 for Redwood UX (alongside Exchange integration) for salespeople to view sales-related
information in Microsoft 365.

1

https://docs.oracle.com/en/cloud/saas/sales/playbooks.html
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OASAL
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30247505
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• Microsoft Teams integration for team collaboration on sales deals and view sales information in Teams.
Microsoft Teams also integrates with Oracle Sales Assistant. To learn more, see Set Up Oracle Sales Assistant for
Microsoft Teams.

CX Sales and Digital Sales Features in the Sales Solution  
Here's an overview of key new features available in Digital Sales only, features that apply to both CX Sales and Digital
Sales, and features that are available only in the CX Sales. CX Sales Mobile and the CX Sales Add-in for Microsoft
Outlook work with both CX Sales and Digital Sales.

Because Digital Sales features are built on the same sales foundation, you complete most of the setup in CX Sales
administration and setup pages. For example, you use sales territories to assign opportunities and leads in both Digital
Sales and CX Sales, but you create and manage those territories in CX Sales.

Features Available Only in the Digital Sales UI
Here are some of the key new features available in Digital Sales that aren't available CX Sales.

Features Specific to Digital Sales

Feature Description More Information

Record overviews Redesigned pages that eliminate clutter and
place key information in panels. You update
and add information using natural language
commands in the Action Bar.

Anatomy of a Record

Action Bar From the Action Bar on every individual record,
 you can use natural language commands to
add information, update individual fields, take
actions, filter activities, and search.

Action Bar at the Top of the Record Overview

Activities (Activity Stream) panel and page on
each record

Accounts, opportunities, contacts, and leads
display relevant activities in each record. From
the Activities panel and page, you can review
email exchanges, notes, call logs, past and
future tasks and appointments, as well as
recent updates to the record itself.

Activities

Email discussions from each record You can create and review email conversations
with contacts directly in each record. You can
send emails using the built-in Oracle Email
application or from any email client that's
hooked up to Microsoft Exchange. Email
conversations are saved in Activities for the
accounts, leads, opportunities, and contact
involved.

Email Integration Options

2

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20080374
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20076526
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20077508
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30007117
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Feature Description More Information

Web conference integration Salespeople can start a Zoom or web
conference meeting or schedule a zoom
meeting from within their sales application.

Overview of Web Conference Integration Setup

Computer Telephony Integration (CTI) Computer telephony integration (CTI) enables
integration of third-party media toolbars.
You can display a media toolbar by enabling
the Partner CTI Service, and by giving you're
signed-in users the Access Partner Media
Toolbar privilege that allows access to the
toolbar.

Overview of Computer Telephony Integration
(CTI) in Digital Sales

Key Performance Indicators (Sales
Performance)

Sales managers are always looking to
boost sales by measuring performance and
motivating their teams. The Digital Sales
performance feature makes it possible for them
to do both by setting up goals and contests.

About Key Performance Indicators (KPI)

Sales Recommendations The application analyzes the text of notes and
call logs and recommends appropriate follow-
up actions. An action can be either a task or
appointment, depending on the text that was
entered.

Recommended Actions from Text Analysis

Sales Dashboard Salespeople and sales managers can use the
Sales Dashboard to review items that need
their immediate attention, including upcoming
appointments and tasks. The dashboard
can also display tables of information and
visualizations from OTBI and from shared saved
searches.

Overview of the Sales Dashboard

Orchestration Create processes that guide salespeople
through best sales practices for different
sales situations. In the current release, you
can specify recommended sales processes
for opportunity sales methods. At each sale
stage in the sales method, you specify what
information the salesperson needs to provide
and what actions they need to take to move
the opportunity to the next sales stage and to
complete the sale.

Guide Salespeople Through Best Practices Using
Orchestration

Oracle Eloqua Integration Digital Sales integrates with Oracle Eloqua
to provide enhanced details about your
contacts and leads. With this integration, sales
representatives can view Eloqua Profiler directly
from Digital Sales for a contact or lead.

Enable the Oracle Eloqua Profiler Link

Sales Guides You can create interactive scripts that
salespeople can follow during calls with

Create Interactive Scripts (Sales Guides)

3

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30231636
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30231636
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Feature Description More Information

customers or use for assessing the quality
of an opportunity, for example. During calls,
the scripts, called sales guides, can update
information in opportunities and leads as the
call progresses and present different follow-
up questions, depending on the previous
answers. To create sales guides, you use Oracle
Intelligent Advisor, an application that you must
license separately.

Features Shared by Both Digital Sales and CX Sales
The UIs for Digital Sales are completely redesigned and you must complete any UI-related setup in VB Studio.

Features Shared by Both Digital Sales and CX Sales

Feature Explanation More Information

Search All Digital Sales features use Adaptive Search.
Adaptive Search, a high-performance search
engine that provides keyword searching and
enhanced filtering capabilities. In CX Sales,
some work areas still use the legacy CRM
Search.

Overview of Optional Setup for Adaptive Search

Home Page Both use the same home page. Navigation
icons are in the Sales and Digital Sales tabs.

Overview of Navigator and Home Page
Configuration

Security Starting with this release (23A) ,both CX
Sales and Digital Sales use the same sales
roles provided by Oracle, including Sales
Representative and Sales Manager.

Overview of Users and Security

Sales Resources, Roles, and Sales Organizations You set up users as resources, as you do in CX
Sales.

Overview of Users and Security

Accounts work area Redesigned UI for Digital Sales.
The CX Sales version is still available in the
Sales tab on the home page.
 

Account and Contact Basics

Contacts work area Redesigned UI for Digital Sales.
The CX Sales version is still available in the
Sales tab on the home page.
 

Account and Contact Basics

Leads work area Redesigned UI for Digital Sales.
The CX Sales version is still available in the
Sales tab on the home page.
 

Overview of Leads Setup

Opportunities work area Redesigned UI for Digital Sales. Many features,
 such as Sales Methods are shared. However,
 some features, such as Sales Coach and
Assessment Templates, are only available in

Summary of Opportunity Setup
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Feature Explanation More Information

CX Sales as they are being replaced with other
features in Digital Sales.
The CX Sales version is still available in the
Sales tab on the home page.
 

Sales Catalog Redesigned UI for Digital Sales. Overview of the Sales Catalog

Sales Territories and Assignment Sales territories are managed in CX Sales UIs,
 but they are used in both Digital Sales and CX
Sales.

Overview of Sales Territory and Assignment
Setup

Tasks and Appointments Redesigned UI for Digital Sales. Tasks and
appointments are tracked in Activities in
individual records and using the Activities Work
area and Sales Dashboard.

Overview of Appointments and Tasks

Task Templates You can use Task Templates to create tasks for
opportunities at different sales stages for both
UIs. Digital salespeople can use Task Templates
only in CX Sales, however. This technology is
slated for replacement by Sales Orchestration.

Add Task Templates to Sales Stages

Activities work area Redesigned UI for Digital Sales. In Digital
Sales, you come here to manage tasks and
appointments.
 
CX Sales includes a calendar that isn't available
in Digital Sales. In Digital Sales, salespeople use
Microsoft 365 instead.
 

For Digital Sales, see the topic: Overview of
Activities Setup
 
For CX Sales, see the Activities chapter in the
Implementation Reference guide starting with
the topic: Overview of Activities
 

Notifications (Bell Icon) You can open the same notifications in both
UIs. Clicking on notification links in CX Sales
pages opens CX Sales work areas. Clicking on
the same link in Digital Sales UIs, opens Digital
Sales pages.

Overview of Notifications Setup

Competitors Salespeople may be required to enter
competitors when closing opportunities in
both Digital Sales and CX Sales. You can create
competitors in both in the Setup Assistant
and in the CX Sales work area. However, you
must enter competitor details and can edit
competitors only in CX Sales.

About Sales Competitors

Application Composer You use Application Composer to create custom
fields for both Digital Sales and CX Sales. For CX
Sales, you can also use Application Composer
to expose those fields on the CX Sales UIs.
For Digital Sales, you must use a different tool,
 VB Studio, to expose fields on UI pages.
 

About Application Composer

Rollups Rollups summarize data for an attribute of a
business object and its related objects. For
example, a rollup can calculate the sum of the
potential revenue from the opportunities for
an account and its hierarchy within the last 120
days.

What are rollups?

Enrichment with Data as a Service (DaaS) You can enrich account and contact information
with Oracle Account and Contact Enrichment by

See the topic:
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Feature Explanation More Information

Dun & Bradstreet (D&B), a service that provides
you with information for millions of companies
worldwide. A separate service, Oracle Address,
 Email, and Phone Verification, ensures that you
have the correct postal addresses, that your
emails don't bounce, and your calls go through.

• Two Services to Enrich and Verify Your
Data and Save Salespeople Time

Integration with LinkedIn Digital Sales integrates with LinkedIn Sales
Navigator and maps LinkedIn profiles with
sales contacts. Salespeople can view a LinkedIn
profile, find an icebreaker to connect with the
contact, and get introduced to the contact.
They can send in-mails or messages from
LinkedIn to stay connected - all with the goal of
improving sale prospects.

Overview of LinkedIn Sales Navigator

Sales Machine Learning Use the Sales Machine Learning model in the
sales application as a platform to build machine
learning models that identify and fetch similar
accounts from a data pool.

Overview of Sales Machine Learning

Phone number and email address verification When your sales organization subscribes to the
Oracle Address, Email, and Phone Verification
service, you know right away if you entered an
invalid phone number or email address.

Enable the Verification of Addresses, Emails,
and Phone Numbers

Routines Automate routine tasks and enforce sales
process compliance.
 
For example, to reduce risk and enforce data
integrity, you can create routines to update
fields, send email notifications, and create tasks
based on rules. Routines can help salespeople
be more efficient and productive.
 

Automate Repeated Tasks with Routines

Mass Update Enables the update of multiple fields in multiple
records listed on the page.

Enable Mass Update

CX Sales-Only Features
Many features not included in Digital Sales are being completely reengineered. For example, in CX Sales, you can
provide salespeople with different tasks, suggestions, and documents at each opportunity sales stage using Sales
Coach and task templates. Digital Sales is transitioning to a completely different technology, called Sales Orchestration,
to do the same thing and more. In the near future, you will be able to use Sales Orchestration to create sales processes
with many type of actions and branches. Using a process, you will be able to create tasks, schedule appointments and
calls, and send emails, depending on the information salespeople provide.

Features Available Only in CX Sales UIs

Functionality or Feature Description More Information

Business Plans Use business plans to plan account activities. Overview of Business Plans

Products work area Enables you to create and view products in CX
Sales. Products are used in Digital Sales, but

Overview of Working with Sales Products
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Functionality or Feature Description More Information

you must either import them or create them in
the CX Sales work area.

Forecasting Lets your sales organization submit sales
forecasts that salespeople and their managers
can adjust and pass up the management
hierarchy.

How Forecasting Works and How You Can
Change It

Quotas Lets you set up and manage sales quotas for
salespeople.

Overview of Sales Quotas

Resource Directory Lets users view and manage the resource
directory.

How do I enable desktop pages for Resource
Directory?

Promotions Manage promotions and offer discounts. Overview of Sales Promotions

Assets Assets track what products and product groups
the customer purchased from the sales catalog.

Overview of Setting Up Sales Assets

Price Books Lists of products with prices that can be used
with sales and contracts applications.

Overview of Price Books

Click to Edit The click-to-edit feature lets salespeople edit
records directly from landing pages of CX Sales
work areas.

About Click to Edit

Favorites Feature you can use in CX Sales to bookmark
your favorite records. In Digital Sales, you use
the browser instead.

Mark Favorite Records
To create a list of favorite setup tasks, you must
follow this procedure step by step: Speed up
Access to Setup Tasks by Marking Them as
Favorites
 

Assessment Templates Questionnaires that let you score leads and
opportunities to recommend actions. This
feature is being replaced by the Orchestration
Framework.

Overview of Assessments

Global Search Enables keyword search across objects in CX
Sales UIs.

Global Search UI

Search and Saved Searches in legacy work
areas

Search in legacy work areas. Those work areas
that don't yet use Adaptive Search use CRM
search.

Overview of Work Area Search Setup Configure
Default Search in Subtabs

Workspace Work area where salespeople can manage all of
their sales information in one place. In Digital
Sales, you use the work areas for the different
objects.

Workspace and Work Areas Powered by
Adaptive Search

Infolets powered by Adaptive Search
(Workspace Infolets)

Home page information portlets that let
salespeople review key sales information.
Infolets are replaced by the Sales Dashboard in
Digital Sales.

About Workspace Infolets

Analytics work area and page The Analytics page shows up to five of a
salesperson's favorite analyses for easy access.

Overview of Sales Analytics Pages

Lightbox Allows the sales organization to share
presentations and other documents and
comment on them.

Overview of Sales Lightbox
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How to Use This Guide  
This guide assumes that you use the Setup Assistant setup wizard to start your implementation. It covers the setup
steps you must complete manually after you run the Setup Assistant.

This guide also explains how to import the data you need for setup using Excel macros provided by Oracle on the Oracle
support portal. It doesn't cover Import Management or Export Management.

The guide doesn't cover in detail all the manual equivalents for the steps the Setup Assistant automates. You can find
these in the Implementation Reference guide.

Here's how to use the guide:

1. Plan out which features your organization will be using and which UIs you will use. See the topic CX Sales and
Digital Sales Features in the Sales Solution for an overview of the features available in each UI.

2. Before starting the implementation, familiarize yourself with the information you must enter in Setup Assistant
and what Setup Assistant completes for you. See the topic What Setup Assistant Completes for You.

3. Refer to the chapters in the guide to understand the different features Setup Assistant automates and the
manual tasks required after you run Setup Assistant.

4. Run Setup Assistant.
5. Complete the manual setup tasks in the chapters in the order the chapters are listed. Each chapter includes a

setup overview with key setup tasks for both the Digital Sales UI and CX Sales UIs. Some of the chapters and
setup tasks have dependencies on what you have already completed, so you should work your way down the
table of contents. For example, you can't import contacts before you import accounts.

Related Guides  
This guide covers only key setups for your sales solution. You must refer to other guides for additional information.

Implementation Guides
Here's a list of related implementation guides:

Guide Description

Oracle Fusion Cloud Sales Automation:
Implementing Customer Data
Management for Sales and Fusion Service
 

Contains information to help implementors define the setup for managing customer information and
the configuration for customer hub deployment.
 

Oracle Fusion Cloud Sales Automation:
Implementation Reference
 

Contains reference information and procedures needed to implement sales components and features
not covered in this guide.
 

Oracle Fusion Cloud Sales Automation:
Securing Sales and Fusion Service
 

Contains information to help setup users and sales administrators configure access to sales
functionality and data.
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Guide Description

Oracle Fusion Cloud Sales Automation:
Security Reference for Sales and Fusion
Service
 

Provides a reference for roles, role hierarchies, privileges, and policies delivered for the Sales and
Service offerings.
 

Oracle Cloud: Using Data as a Service
 

Describes how to use Data as a Service (DaaS) to update company and contact data in your Oracle
Cloud application.
 

Oracle Cloud: Using Oracle Address
Verification Cloud
 

Describes how to use Oracle Address Verification Cloud to verify and standardize addresses in your
Oracle Cloud application.
 

User Guides
Here's a list of useful user guides:

Guide Description

Oracle CX Using Customer Data
Management for Sales and Fusion Service
 

Contains information about managing customer information and customer data quality.
 

Oracle Sales Using Sales
 

Contains information about performing day-to-day sales tasks.
 

Analytics Guides
Here's a list of analytics and reports guides:

Guide Description

Oracle Sales Creating and Administering
Analytics
 

Contains information about reports and analytics provided by Oracle and explains how to create your
own reports, analytics, and dashboards.
 

Configuration Guides
Here's a list of useful configuration guides.

Guide Description

Oracle Applications Cloud Configuring
Applications Using Application Composer
 

Describes how to create and modify objects and to configure the user interfaces and navigation
menus.
 

Oracle Applications Cloud Groovy Scripting
Reference
 

Explains the basics of how you to use the Groovy scripting language to enhance your applications.
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Guide Description

Oracle Applications Cloud Configuring and
Extending Applications
 

Describes the tools and concepts for configuring applications.
 

Common Applications Guides
Here are some Oracle cloud guides covering common features.

Guide Description

Oracle Applications Cloud Using
Functional Setup Manager
 

Describes how to use Oracle Functional Setup Manager (also known as the Setup and Maintenance
work area) to implement the applications.
 

Oracle Applications Cloud Understanding
Enterprise Structures
 

Explains how to use the Oracle Fusion Applications enterprise structures to meet your company's legal
and management objectives.
 

Oracle Applications Cloud Using Common
Features
 

Provides an overview of the application functionality that is common across the applications.
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2  Get Started

Overview of Preliminary Tasks  
Before you roll up your sleeves and start implementing your sales application, complete these preliminary tasks:

Step Applies to Description Where to Get More Details

1
 

Both Digital Sales and CX Sales Before you sign in for the first time,
 complete the actions listed in the
Service Administrator Action List
provided by Oracle, and create your
account with My Oracle Support
(support.oracle.com).
 

See the topic: What to Do After You
Get Your Welcome Email
 

2
 

Both Digital Sales and CX Sales If you haven't done so already,
sign in and reset your temporary
password. You click the user initials
at the top-right of the Welcome
page, and select Set Preferences
from the menu.
 

See the topic: What to Do After You
Get Your Welcome Email
 

3
 

Both Digital Sales and CX Sales Enable the Sales and Service
offerings for implementation. The
Service offering includes tasks
required to set up the telephony
integration for Digital Sales.
 

See the topic: Enable Sales
Features for Setup
 

4 Digital Sales Digital Sales is now enabled for
all new customers. No promotion
code is required.
 
If you're an existing Sales customer
that hasn't started to implement
Digital Sales, then you must opt
in to this feature in Setup and
Maintenance.
 

See the topic: Opt In to Digital Sales
for Existing Sales Customers.
 

5 Digital Sales Optionally, display the Digital Sales
tab as the first tab users see when
they sign in.

See the topic:Display the Digital
Sales Tab When You Open the
Home Page.
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Toolbar Icons and What They Mean  
You can use the top of your application page for navigation, configuration, and other tasks that are common across
applications. Here are few features useful in your setup. You can get more information on using common application
features from the Oracle Applications Cloud Using Common Features guide.

Callout Number Icon Name or Description Function

1
 

Navigator
 

Gets you to where you need to go.
 
The Navigator includes more selections than
the icons on the home page.

2
 

Company logo
 

You can upload your own as part of home page
setup.
 

3
 

Home
 

Returns you to the page defined as the home
page. By default, home is the Welcome page
displaying the different work area icons. The
Welcome page is also called the springboard.
 

4
 

Favorites and Recent Items
 

Marks a page as favorite and provides access to
recently viewed pages and setup tasks.
 
To create a list of favorite setup tasks, follow the
procedure: Speed up Access to Setup Tasks by
Marking Them as Favorites

5
 

Watchlist
 

Not used in the sales application. Watchlist
enables the tracking of business objects in
some applications.
 

6
 

Notifications
 

Accesses application notifications. Some of
these are also delivered using email.
 

7
 

Settings and Actions menu
 

Opens the Settings and Actions menu. From
the menu, you can sign out, personalize and
configure the UI, turn on and access help, and
navigate to the Setup and Maintenance work
area.
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Speed up Access to Setup Tasks by Marking Them as
Favorites  
Keep a list of your setup tasks in the Favorites and Recent Items menu (the star icon in the toolbar) , so you can access
them with one click. To add a task to the list, you must follow the exact navigation path in this procedure. You must
open the task by going to Offerings first.

1. In the Navigator, click My Enterprise > Offerings.
2. Click the Sales offering.
3. Click View Features.
4. On the Opt In: Sales page, click Setup for Sales, the topmost row.
5. Find and open the task you want to mark as favorite.
6. With the task open, click Favorites and Recent Items (the star icon) at the top of the page.
7. In the Favorites and Recent Items window, click Add to Favorites.
8. In the Add to Favorites dialog box, you have the option of creating a folder, or just click Save and Close.
9. You can cancel out of the task and open another task to add to favorites in the same way.

Results:
You can now open the tasks you added as favorites from the Favorites and Recent Items (star icon) menu.

What to Do After You Get Your Welcome Email  
Got the welcome email? Here's what to do next. When your environment is ready, Oracle sends an email to the person
designated as the administrator when you signed up with the service. This email includes the link to your service, a
temporary password, and instructions on how to access the Service Administrator Action List. You must follow the
instructions in the action list before signing in for the first time.

When you sign in for the first time, reset your password by clicking your user initials at the top-right of the Welcome
page and selecting Set Preferences from the Settings and Actions menu.

Enable Sales Features for Setup  
Before you start work, you must enable both the Sales and Service offerings and the functional areas you're
implementing. Enabling the offerings and their functional areas provides access to setup tasks and displays icons in
your application. You can always enable more functional areas later.

Although you are setting up sales, you must enable Service to run CTI

Enable the Sales Offering

1. In the Navigator, click My Enterprise > Offerings.
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2. Click the Sales offering icon in the left pane of the Offerings page (callout 1 in the screenshot).

3. Click Opt In Features (callout 2).
4. On the Opt In: Sales page, select the Enable option for Sales, the folder at the top of the list (callout 1 in the

screenshot). Your selection enables the offering.

Note:  If you enabled other offerings, you may have to select Sales from the Opt In: list. That's because the
offerings are listed in alphabetic order.

5. Select the Enable option for all the sales functional areas you're using. For the tasks in the scope of this guide,
enable all of the functional areas through Quotas.

6. Click Done.
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You're returned back to the Offerings page.
7. Click Home in the global header to return to the Welcome page.

Enable the Service Offering
1. In the Navigator, click My Enterprise > Offerings.
2. Click the Service offering icon in the left pane of the Offerings page.
3. Click Opt In Features.
4. On the Opt In: Service page, select the Enable for Service, the folder at the top of the list, and the Redwood

User Interface for Service option at the bottom of the page.
5. Select the Enable option for all the service functional areas you're using.
6. Click Done.

You're returned back to the Offerings page.
7. Click Home in the global header to return to the Welcome page.

Opt In to Digital Sales for Existing Sales Customers  
If you're new to Sales or already implementing Digital Sales, then Digital Sales is already enabled for you and you can
skip this step. Existing Sales customers who haven't started implementing Digital Sales, must opt in to the feature as
described in this topic.

1. Click Navigator > My Enterprise > Setup and Maintenance
2. Make sure the Sales offering is selected in the Setup menu.
3. Click the Change Feature Opt In link at the top of the left pane.
4. On the Opt In: Sales page, click Features (the pencil icon) for Sales on the top row.

5. On the Edit Features: Sales page, select Enable for the Digital Sales Next Gen UI feature.
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6. Click Done.

Display the Digital Sales Tab When You Open the Home
Page  
You can have the Digital Sales tab open on the home page when users sign in by moving it to the first position in the list
of tabs.

Here's how:

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox.
3. In the Create Sandbox page, enter a name and select Structure as the tool.
4. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
5. From Tools, select Structure to open the Structure page.

16



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 2
Get Started

6. Locate and select the Digital Sales entry in the Navigation Configuration tab of the Structure tool (callout 1 in
the screenshot).

7. Click Move Up (the up arrow on the right highlighted by callout 2) to move Digital Sales up in the list.
8. Repeat until Digital Sales is at the top of the list.
9. Optionally, you can check how the home page looks by clicking Home in the toolbar at the top of the page.

10. Publish the sandbox by clicking the sandbox name (callout 3) and Publish.

Options for Importing Data Into Your Application  
Here's an overview of the multiple ways you can import your data from a file or directly from an external application.
Which import method you use depends on the type of data you're importing, the volume of data, and technical
requirements. If you're integrating your sales application with other cloud services, then you may be required to use
additional import methods not covered here.

Whichever import method you use, you must make sure that any prerequisite records already exist in the application.
For example, if you're importing contacts for an account, then the account must already exist in the application. If you're
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importing data that depends on other data, then the prerequisite import process must complete successfully before you
start the dependent process.

Import Method Description When to Use How to Access Where to Get More
Information

Import Macros
 

The Excel macros speed
up and simplify the import
of up to 5,000 records at
a time for some objects.
The macros help you
by validating your data
entries, providing lists of
values, and automatically
populating constant values.
 
The macros create data
files that are imported
automatically.
 
Macros are available to
import the following types
of sales information:
 

• Sales users

• Products

• Product groups

• Accounts and the
account hierarchy

• Contacts

• Leads

• Opportunities

• Opportunity revenue
lines

Use the import macros
for importing data in your
initial deployment.
 
The macros are targeted
to the simple proof of
concept sales automation
use case covered in this
guide. For example, the
import macros assume that
you're importing account,
 contact, and lead records
for one country at a time.
 
The macros generate log
files of the actual data
that's imported, including
the values populated for
you. The log files can serve
as a learning tool for more
complex import.
 

You can download the Excel
macros and any required
mapping files from the
Oracle CX Sales: Getting
Started with Your Sales
Implementation: Import
Macros (Document ID
2229503.1) article on My
Oracle Support.
 

The different chapters in
this guide provide detailed
instructions for using the
macros.
 

Import Management
 

Use Import Management to
import data files (.csv) with
up to 50,000 records.
 
Import Management
improves definition, error
handling, and performance.
For example, you can drag
and drop attributes while
creating import mappings.
The import also validates
the first ten records in your
data file before you import
the rest. You don't have
to wait around to see if
your data meets the import
requirements.
 
Import Management
supports import for all sales
objects and the majority of
other objects as well.
 

Use Import Management
for importing data .
 
 

Click Import Management
in the Navigator.
 

See the Understanding
Import and Export
Management guide for
instructions on using the
import.
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Import Method Description When to Use How to Access Where to Get More
Information

External Data Loader Client
 

The data loader is a
command-line tool you can
use to import high-volume
data files. The tool supports
the same objects as Import
Management.
 
The tool automatically
splits a large data file into
multiple smaller files to
adhere to the application's
import volume limits, and
enables the tracking of
import status.
 
 

Use this import method for
importing very large data
files for the same objects
supported by Import
Management.
 

You can download the
client from Oracle Support
Document 2325249.1
(External Data Loader
Client) on My Oracle
Support.
 

Instructions for using the
client are available in the
document and in the client
itself.
 
For REST API
documentation, see the
REST API for CX Sales and
B2B Service guide.
 

Web Services
 

Web services let you
Import data directly
from other applications.
You can manage Import
Management imports using
REST web services.
 

Use web services to
manage import jobs
if you need to import
directly from an external
application.
 

Public APIs are available for
Import Management and
REST services.
 
The REST services include
the following:
 

• Import Activities

• Import Activity Maps

• Import Export Objects
Metadata

For REST API
documentation, see the
REST API for CX Sales and
B2B Service guide.
 
For SOAP API
documentation, see the
SOAP Web Services for
CX Sales and B2B Service
guide.
 

High-Volume Import
 

An import mode available
in both REST web services
and in the External Data
Loader Client that is
designed to import millions
of records at a time. High-
Volume Import is available
for the following objects:
 

• Account

• Asset

• Contact

• Hierarchy

• Hierarchy Member

Use this import mode
for importing very large
number of records for the
set of available objects.
You can't use this mode
with any custom import
logic that you added,
 including Oracle workflows,
 ICS triggers, or custom
validation.
 

You can access High-
Volume Import either using
REST services or using
External Data Loader Client.
 
When importing using
REST, set the "High-
volume" attribute to enable
High-Volume Import.
 
When importing using the
External Data Loader Client,
set the command-line
parameter "-high-volume"
to enable High-Volume
Import.
 

For REST API
documentation, see the
REST API for CX Sales and
B2B Service guide.
 

Here's a diagram that illustrates the different import methods:

• The import macros (callout 1), Import Management (callout 2), and the External Data Loader Client (callout 5)
all use the same Oracle Enterprise Scheduler processes for import. When you import very large files using the
EDLC client, the REST web services (callout 4) create multiple processes to respect the Import Management file
size limit.

• If you need to import from an external application, then you can use the REST web services directly.
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Speed up Import Using Excel Macros  
You can speed up import of up to 5,000 records at a time by using Microsoft Excel macros provided by Oracle. The
macros validate your data entries, provide lists of values so you don't make mistakes, and automatically populate
constant values.

After you enter your data, you click a button in the macro to import. The macros automatically create an import activity
for you and permit you to monitor the progress of the import activity from within the macro itself. The import macros
are targeted to the simple sales automation use case covered in the guide. They can also serve as a learning tool for
more complex import.

The import macros are available for these objects:

• Sales users

• Products

• Product groups

• Accounts

• Account hierarchy

• Contacts

• Addresses

• Leads

• Opportunities

• Opportunity revenue lines

All of the available macros use the new Import Management import feature.

The Import Data with Custom Fields chapter explains how to use the macros to import additional fields, including
custom fields you created in Application Composer. You download the Excel macros from the Oracle CX Sales: Getting
Started with Your Sales Implementation: Import Macros (Document ID 2229503.1) article on My Oracle Support.
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Note:  While you can import additional fields by appending columns to the import macros, you can't make any other
changes. You can't edit the Visual Basic for Applications (VBA) code or other functions.
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3  Run Setup Assistant

Speed Up Your Initial Setup with Setup Assistant  
Use the Setup Assistant to automate many of the initial setups in your sales application. You enter the minimum
required information directly in Setup Assistant or gather the information offline using an Excel template. Setup
Assistant then runs background processes that complete many of the initial setups for you.

Watch video
 

You can use Setup Assistant for Sales stand-alone implementations as well as implementations on top of other Oracle
Fusion Cloud applications.

You can run Setup Assistant up to 5 times to add information, but you can't use it to change much of what you enter the
first time around. For example, on subsequent runs you can't update the company information, the accounting calendar
periods, the root of your sales catalog, or the person you designate as the top of the resource hierarchy. You must use
manual setup tasks to make these corrections.

Related Topics
• What Setup Assistant Completes for You

• Overview of Setup with Setup Assistant

• Run Setup Assistant

Overview of Setup with Setup Assistant  
Here are the steps you should follow to automate your initial setups with Setup Assistant:

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

Familiarize yourself with
the initial setups that Setup
Assistant automates for
you. You need to make
some implementation
decisions before you start.
 

N/A See the topic: What Setup
Assistant Completes for You
 

2 Both Digital Sales and CX
Sales

Gather the information
you will enter. Descriptions
are available in the Setup
Assistant wizard itself and
in the Excel spreadsheet
you can download.

Setup and Maintenance >
Sales > Company Profile >
Setup Assistant

See the topic: Run Setup
Assistant

3 Both Digital Sales and CX
Sales

Run Setup Assistant
after you entered the

Setup and Maintenance >
Sales > Sales

See the topic: Run Setup
Assistant
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Step Applies To Description Navigation Where to Get More Details

 data directly in the
Setup Assistant UI or
imported the data from the
spreadsheet.

Foundation > Setup
Assistant

 

4 CX Sales If you enabled Forecast
by Opportunity Owner
in Setup Assistant, then
you must complete a
one-time manual setup
required internally by the
application: you must
enable a sales territory
dimension even though
you aren't using any
dimensions.

Setup and Maintenance >
Sales > Sales Territories >
Enable Dimensions and
Metrics

See the topics:
 

• What are some
common opportunity
forecasting scenarios?

• Complete One-Time
Manual Step If You
Enabled Forecast by
Opportunity Owner

5 Both Digital Sales and CX
Sales

Optionally, you can export
the setup data you entered
into Setup Assistant
for import into another
environment.

Setup and Maintenance >
Sales > Sales
Foundation > Setup
Assistant

Export Setup Assistant Data
to Another Environment

What Setup Assistant Completes for You  
Here's a table summarizing the information you enter in Setup Assistant, what it does for you, and what other tasks
you must complete in the application itself. See the chapters referenced in the last column for details about additional
setups you need to complete manually. The Setup Assistant completes some setups without any entries from you.
These include the running of indexing processes for global and work area searches, for example. Be sure to check each
chapter to learn what's set up for you behind the scenes.

Setup Assistant Section Setup Assistant Entries and
Actions

Steps to Complete Manually More Information

Company Information
 

You enter the company name,
 street address, country, and the
corporate currency. Setup Assistant
creates a rudimentary enterprise
structure required for Oracle
Fusion Cloud applications.
 
Except for the currency, the
information you enter doesn't
appear anywhere in your sales
application. The currency you
select becomes the default
currency in your sales transactions.
 
You can't modify this information
using Setup Assistant in
subsequent runs.
 

If you need to change the
corporate currency after you run
Setup Assistant for the first time,
 then you can do so in the Sales
offering, by using the Quick Setup
for the Company Profile functional
area.
 

Enter Your Company Information
and Corporate Currency
 

24

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20060827
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20060827


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 3
Run Setup Assistant

Setup Assistant Section Setup Assistant Entries and
Actions

Steps to Complete Manually More Information

Accounting Calendar
 

Based on your entries, Setup
Assistant creates the periods for
your sales forecasts, quotas, and
reports. Setup Assistant creates the
default accounting calendar for 5
years starting on the first day of
the month and the year you enter.
You should start the calendar at
least 2 years in the past, to allow
for historical data you may import.
 
You can't make changes after you
submit on the first run.
 

None.
 
In the future, you can generate
additional periods and years
for forecasting using Manage
Accounting Calendar setup task.
 

Accounting Calendar Setup Tasks
Setup Assistant Completes for You
 

Geographies
 

You can import reference
geography data for countries
where you do business and enable
the countries for address mapping.
 
You can import additional
countries in subsequent runs.

You can set up UI validation for CX
Sales UIs and import additional
countries using the Manage
Geographies setup task.
 

Setup Assistant and Geography
Data

Top of the Sales Resource
Hierarchy
 

You enter the name, email address,
 and resource organization name
of the Chief Executive Officer. Even
if the CEO never uses your sales
application, having him or her at
the top of the hierarchy makes it
easier for you to build the rest of
the resource hierarchy underneath.
 
The sales application creates
the resource hierarchy from
the resource organization
hierarchy, so you must enter a
resource organization name for
every manager. The resource
organization name doesn't have
to correspond to any actual
organization, so for the CEO you
can enter the company name.
 
Both the CEO's name and the
resource organization name
appear in the sales resource
directory, so make sure you enter
them the way you would like them
displayed to the sales organization.
 
The application sends email
notifications to users when their
accounts are created. If you don't
want to spam the CEO, enter a
dummy email address.
 
You can't update this information
in Setup Assistant on subsequent
runs.
 

After creating the CEO, you must
import the rest of the users or
create them manually in the UI.
 

See the topics:
 

• Overview of Sales User Import

• Create Sales Users in the UI
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Setup Assistant Section Setup Assistant Entries and
Actions

Steps to Complete Manually More Information

Sales Catalog Root Product Group
 

Sales Assistant creates the top
node of your sales catalog.
In addition, the application
automatically creates all of the
prerequisites for creating products,
 including the units of measure
salespeople use to enter product
quantity in opportunities.
 
You can't update this information
in Setup Assistant on subsequent
runs.
 

You must create the rest of the
sales catalog in the application
either in the UI or using import.
You may also need to create
additional units of measure. For
example, the application creates
Unit, but not Each. If you want
to salespeople to use Each for
entering products in opportunities,
 then you must create the unit of
measure using the task Manage
Units of Measure.
 

See the topics:
• Overview of Sales Catalog

Setup

• Review Units of Measure for
Products

Resource Roles and Role Mappings
 

Your entries in Setup Assistant
can create additional resource
roles and the accompanying role-
provisioning rules. For example, if
your sales organization includes
sales support agents, you enter
the resource role name here and
select the job role you want to
provision to salespeople with that
title. Setup assistant creates the
accompanying role-provisioning
rule automatically.
 
You can add more resource roles
on subsequent Setup Assistant
runs.

None.
 
You can also create additional
resource roles and role-
provisioning rules manually, as
described in the Get Ready to
Create Sales Users chapter.
 

How Setup Assistant Gets You
Ready to Create Sales Users
 

Opportunities
 

Set the default sales method to
guide salespeople through the
sales process. Unless you create
additional sales methods ahead
of time, you can select one of the
two predefined sales methods:
standard or accelerated.
 
You can edit the names of sales
stages for the selected sales
method, add new ones, or reorder
them.
 
By default salespeople must
enter both win or loss reasons
and the primary competitors
when they close an opportunity
in the UI. When salespeople open
opportunities, the application
automatically enters a default close
date for the opportunity 20 days
after the opportunity creation date.
You can change these defaults.
 

You must complete these steps
outside Setup Assistant:
 

• Modify opportunity statuses

• Set up win and loss reasons.

• Set up your own sales
methods

• Set up Sales Coach (CX Sales-
only feature)

Setup Assistant and Opportunities
 

Competitors
 

You can create the competitors
salespeople can enter when
closing lost opportunities. In
Setup Assistant, you enter the
basic information including the

None, but you can enter additional
competitor details in the CX Sales
Competitors work area.
 

Review the List of Competitors and
Create Additional Ones
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Setup Assistant Section Setup Assistant Entries and
Actions

Steps to Complete Manually More Information

organization size, line of business,
 and threat level.
 
You can create additional
competitors on subsequent runs.
 

Setup Users
 

Create other users to help you
with setup. The application
automatically notifies setup users
by email that their accounts are
created and allows them to set
their passwords. The user names
are set to the email address by
default.
 
You can create additional setup
users on subsequent runs.
 

None. You can also create
additional setup users in the UI,
 using the Manage Users task.
 

Create Setup Users

Forecast by Opportunity Owner
 

If individual salespeople in the
sales organization own all of their
opportunities and forecast them up
the management chain, then select
this option.
 
Don't select this option if your
organization uses geography,
 product, industry, or other territory
dimensions to assign salespeople
to opportunities. You must instead
set up forecasting as described in
this guide.
 
You can't change the setting after
your initial Setup Assistant run.
 
You select the option in Setup
Assistant and then enable a sales
territory dimension as described
in the topic: Complete One-
Time Manual Step If You Enabled
Forecast by Opportunity Owner.
 
This manual setup is required
internally by the application even
though you're not using territory
dimensions.
 

You must run several processes
to update both the resource and
sales territory hierarchies after you
create and import users:

• Send Pending LDAP Requests

• Update Person Search
Keywords

• Reporting Hierarchy
Generation

• Synchronize User GUID

• Refresh Territories from
Resources process

• Run Processes to Complete
Resource and Resource
Hierarchy Creation

• Run the Refresh Territories
from Resources Process

• Overview of Sales Territory
and Assignment Setup

• Overview of Forecasting
Setup

Adaptive Search
 

Select all of the sales objects you
want to enable for Adaptive Search.
 
You can't enable additional objects
in Setup Assistant in subsequent
runs.
Adaptive Search powers all Digital
Sales search.
 
In CX Sales, it powers Workspace
and other work areas, global search
(the search at the top of the page),

You can make additional fields
searchable in Adaptive Search.
 
You can also enable additional
objects for use with REST APIs and
other products using the Configure
Adaptive Search task in Setup and
Maintenance.
 

• Setup Assistant and Search

• Overview of Optional Setup
for Adaptive Search

• Make Additional Fields
Searchable
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Setup Assistant Section Setup Assistant Entries and
Actions

Steps to Complete Manually More Information

REST APIs, and infolets powered by
Adaptive Search.
 
The Setup Assistant runs the
required indexing process and
schedules an hourly index refresh.
(This is the equivalent of running a
full publish for Adaptive Search.)
 

Run Setup Assistant  
You can use Setup Assistant to set up a stand-alone sales implementation (the subject of this guide) or to implement
sales on top of another Oracle Fusion Cloud application.

Make sure that the required information you enter is correct before clicking the submit button for the first time. While
you can run Setup Assistant up to 5 times to add information, you can't use it to change much of what you enter the
first time around. For example, on subsequent runs you can't update the company information, the accounting calendar
periods, the root of your sales catalog, or the person you designate as the top of the resource hierarchy. You must use
manual setup tasks to make these corrections.

Stand-Alone Sales Implementation
Here's how to use Setup Assistant to set up Sales as a stand-alone application in a new environment.

1. Sign in as the initial user provided by Oracle.

To run Setup Assistant, you must have the following job roles:

◦ Application Implementation Consultant

◦ Application Diagnostics Administrator

◦ IT Security Manager

2. In Setup and Maintenance, go to the Setup Assistant task:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Setup Assistant

3. On the Setup Assistant page, click Use Excel Spreadsheet to download a spreadsheet for collecting data
offline, or click Use Application to enter the data directly. Both the spreadsheet and the application include the
same basic instructions.

Note:  The Excel spreadsheet is provided in English only. However, you can enter data in any of the languages
supported by CX Sales.

If you used the spreadsheet to collect your data, you must upload the data into Setup Assistant. Here's how:
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a. Click Create Import File in the spreadsheet and save the file to your desktop.
b. In the Setup Assistant, upload the file.
c. Click Import Data.

4. Enter and verify the information in Setup Assistant. You can make changes until you run the setup process from
the last setup page.

5. Click Run Setup Process and monitor the process progress by clicking Refresh.

The process takes approximately 5 minutes to complete. Contact support if you run into errors. Common errors
involve web service time-outs, so you can also try running the process again to see if that fixes the error.

6. You can add more data and run the process as many as 5 times by clicking Load More Data. You can use these
subsequent runs to create additional setup users, import geographies for additional countries, add competitors,
add resource roles, and so on. After each iteration, you can click View Setup History to review the changes you
made in your last run.

7. If you enabled Forecast by Opportunity Owner in Setup Assistant, then you must complete the manual setup
step described in the topic: Complete One-Time Manual Step If You Enabled Forecast by Opportunity Owner.

Sales on Top of an Existing Oracle Fusion Cloud Application
Here's how you can use Setup Assistant if you're implementing sales on top of another Oracle Fusion Cloud application,
such as HCM.

1. Sign in as the initial user provided by Oracle.

To run Setup Assistant, you must have the following job roles:

◦ Application Implementation Consultant

◦ Application Diagnostics Administrator

◦ IT Security Manager

2. In Setup and Maintenance, go to the Setup Assistant task:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Setup Assistant

3. On the Setup Assistant page, click Sales Setup Status.
4. Click Rerun Status Check.

The Sales Setup Status page lists the setups already completed in the environment and provides
recommendations for those steps that you must complete either in Setup Assistant or elsewhere in the
application.

5. After you review the report, click Cancel.
6. Click Use Application and enter missing information in the Setup Assistant. You can make changes until you

run the setup process from the last setup page.
7. Click Run Setup Process and monitor the process progress by clicking Refresh.

The process takes approximately 5 minutes to complete. Contact support if you run into errors. Common errors
involve web service time-outs, so you can also try running the process again to see if that fixes the error.

8. You can add more data and run the process as many as 5 times by clicking Load More Data. You can use these
subsequent runs to create additional setup users, import geographies for additional countries, add competitors,
add resource roles, and so on. After each iteration, you can click View Setup History to review the changes you
made in your last run.
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9. If you enabled Forecast by Opportunity Owner in Setup Assistant, then you must complete the manual setup
step described in the topic: Complete One-Time Manual Step If You Enabled Forecast by Opportunity Owner.

Complete One-Time Manual Step If You Enabled
Forecast by Opportunity Owner  
If you enabled Forecast by Opportunity Owner in Setup Assistant, then you must complete a one-time manual setup
required internally by the application: you must enable a sales territory dimension even though you aren't using any
dimensions. Here's how:

1. Open the task Enable Dimensions and Metrics from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

2. On the Enable Dimensions and Metrics page, click Edit.
3. In the Dimensions region, click Select and Add.
4. Select Account Type and click OK.
5. From the Actions menu at the page level, select Load and Activate.

Your selection runs a process that loads the required data.
You can select Refresh Status from the Actions menu at the page level to monitor the process progress. When the
process completes successfully, you're done.

How You Get to Setup Tasks Not Covered by Setup
Assistant  
There are two ways to get to setup tasks not covered by Setup Assistant:

• Open tasks from the Sales offering Setup page in the Setup and Maintenance work area

• Use the Navigator

Get to Your Tasks Using the Setup Page
After you enable the offering, you can open setup tasks, including those not covered in this guide, from the Setup and
Maintenance work area Setup page. Here is how:

1. In the Navigator, click My Enterprise > Setup and Maintenance

You can also click Setup and Maintenance icon on your desktop. It's available in the My Enterprise tab.
2. If you enabled more than one offering, you may have to select Sales from the Setup list. The Setup page

displays offerings in alphabetic order.
3. In the Functional Areas column, select the functional area you want to set up.
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Here's a rundown of the features on the Setup: Sales page.

Callout Number Description

1
 

Select a functional area to set up in the left pane.
 

2
 

The application lists the required tasks for that functional area in the right pane.
 

3
 

You may need to show All Tasks to see the task you want.
 

4
 

You can search for tasks in the offering using the Search Tasks field.
 

5
 

Quick Setup (gear icons) in the Functional Areas column open pages that you can use for basic
setup. In Sales, Setup Assistant takes care of these for you.
 

6
 

Clicking the Shared link lists other offerings using the same functional area.
 

7
 

If you can't find the task you are looking for in the Sales offering, you can search for tasks
across offerings using the Tasks side panel.
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4. You can open tasks by clicking on their names in the Task list. By default, you see only the required tasks, but
you can select All Tasks from the Show menu to see them all.

5. You can also search for tasks in the offering by name using Search Tasks. Use the percent sign (%) to represent
missing letters or words. For example, to find the Manage HCM Role Provisioning Rules task, you can search for
manage hcm%rules. The searches aren't case-sensitive.

6. Some functional areas include a Quick Setup page (gears icon) that you can use to set up the minimum
requirements for the functional area. These Quick Setup pages, including those for Company Profile, Sales
Foundation, and Opportunities, and Forecasting, cover the same ground as Setup Assistant, so you won't need
them.

Navigating to Other Work Areas for Setup
To open some setup tasks and for testing your setup, you must use the Navigator. The Navigator, which you open by
clicking its icon at the top of the page, lists what's available to you based on your security permissions. Because a setup
user has a broad range of permissions, the selections you see aren't limited to the features you purchased. Aside from
the Setup and Maintenance work area, you use only a small number of the features listed. Here are the most important:

• My Team

◦ Users and Roles

Use this work area to create and edit records for individual users. The Manage Users task in Setup and
Maintenance opens the same work area.

• Tools

◦ Scheduled Processes

Use this work area for scheduling and monitoring background processes.

• Configuration

◦ Appearance

Lets you control application appearance, including background color and icon shape.

◦ Structure

Lets you control which items appear in the Navigator and on the Welcome page.

◦ Application Composer

Use Application Composer to expose fields on page layouts, to create custom fields, and otherwise
configure your application.

• Sales

Use the different work areas under this heading for functional setup and to create data used to test your sales
application.

• Digital Sales

Setup for some Digital Sales-specific features such as Key Performance Indicators (Sales Performance) area
available under this heading.

The Navigator arranges the items in folders. You can open all the folders and display all the items, by clicking Show
More.
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Export Setup Assistant Data to Another Environment  
You can export your entries in Setup Assistant to a JSON file, which you can then import into another environment. You
can move your initial entries from your test environment to production, for example. Here's how.

1. Click the Export Data  button on the Setup Assistant landing page.
2. Save the exported JSON file on your desktop.
3. Open the Setup and Maintenance work area in the environment where you want to import and go to the Setup

Assistant task:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Setup Assistant

4. In the Setup Assistant page, click Use Excel Spreadsheet.
5. Upload the file.
6. Click Import Data.
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4   User Account and Password Preferences

Setup Assistant and User Account Preferences  
Setup Assistant uses the default settings when creating setup users and the CEO at the top of the resource hierarchy.
You can change the default behavior for the rest of your setup.

Here are the default settings:

• User names are set to email addresses.

• Passwords must be at least 8 characters long and include a number

• The application automatically notifies users when their accounts are created, when passwords need to be
changed, and so on

Setup Overview  
Review the settings for user name format and password strength and set up notifications before you create users. By
default, the application uses the email address to create user names and requires passwords with eight letters and one
number.

You may want shorter user names and stronger passwords. You must also create your own versions of the notifications
users receive regarding their accounts. Oracle provides sample notifications, but they include Oracle-specific language
and may not include all of the information users need.

The Security Console that you use for all these tasks includes many advanced features. Some don't even apply to your
sales application. So, limit your use of the Security Console to the scope listed here.

Here's a list of the setup tasks covered in this chapter. You can open the tasks from the Setup and Maintenance work
area, Sales offering, and Users and Security functional area. Remember that you may have to show All Tasks to see the
task that you want.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

Initialize the Security
Console.
 

Setup and Maintenance >
Sales > Users and
Security > Import Users
and Roles into Application
Security
 

See the topic: Initialize the
Security Console
 

2
 

Both Digital Sales and CX
Sales

Set up preferences for user
name format, passwords,
 and create your own
versions of the notifications
that users receive about
their accounts and
passwords.
 

Setup and Maintenance >
Sales > Users and
Security > Manage
Applications Security
Preferences, then select
the User Categories tab.
 

To understand the
notification process
for new accounts and
recommendations on
the kinds of notification
changes you may want
to make, see the topic:
Automatic New Account
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Step Applies To Description Navigation Where to Get More Details

Notifications and What to
Change
 
For setup instructions,
 including a list of tokens
you can use in your
notifications, see the topic:
Set Up Preferences for User
Names, Passwords, and
Notifications
 

Related Topics
• Automatic New Account Notifications and What to Change

• Set Up Preferences for User Names, Passwords, and Notifications

The Dos and Don'ts for Using the Security Console  
The Security Console is a powerful tool, but you don't need all of its power for your initial setup. Here's an overview of
the Security Console tabs and their uses. Only setup users, or other users with the IT Security Manager job role, can
access the Security Console.

Tab Dos and Don'ts

Roles
 

Create your own roles as described in Securing Sales and Service guide.
 

Users
 

• Don't create users or provision job roles here. For sales, you must create users as resources using
the Manage Users task, resource import, and REST web services. Follow the instructions in the
rest of this guide to create users and provision job roles. If you do create user accounts in the
Security Console, then you must create the users again as resources using the Manage Users task
and link the accounts you created in the Create Users page.

• Use this tab only to manage user passwords and update user email addresses. Note that all users,
 even members of the sales organization who can't access the Security Console, can reset their
own passwords. That's done by clicking the user name in the welcome page and selecting the
Preferences option from the Settings and Actions menu.

• While you can use this tab to change user names, doing so requires some extra setup for Oracle
BI Answers, the embedded reporting tool for building and modifying reports. Oracle BI Answers
creates a separate GUID from the user ID when you create a user. If you change the user ID, then
you must update the BI Answers GUID by running the Rename Accounts Self-Service utility. You
can download the utility from My Oracle Support, article Oracle Fusion BI: Self Service Forget
Accounts and Rename Accounts Tools (Doc ID 2635720.1).

Analytics
 

Review role assignments and compare roles. This advanced security functionality is covered in the
Securing Sales and Service guide.
 

Certificates
 

The sales application doesn't use this functionality.
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Tab Dos and Don'ts

User Categories
 

Specify password policies and manage notifications users receive about their accounts and passwords.
You can specify different behavior for different categories of users. For the sales application, all the
users you create are initially assigned to the Default category. But you can create additional user
categories and move users to them.
 

Single Sign-On
 

Configure single sign-on.
 

API Authentication
 

Used for defining JSON Web Tokens other applications can use to validate themselves with Oracle CX
Sales and Fusion Service.
 

Administration
 

Use to set role copying preferences and other advanced features covered in the Securing Sales and
Service guide.
 

You can find information about more advanced tasks, including security configuration, in the Securing Sales and Service
and the Extending Sales and Service guides.

Initialize the Security Console  
You must initialize the Security Console before using it for the first time by running the process Import Users and Roles
into Application Security. The process copies users, roles, privileges, and data security policies from the LDAP directory,
policy store, and Applications Core Grants schema to Oracle Fusion Applications Security tables. Having this information
in the tables makes the search feature of the Security Console fast and reliable. After the process completes the first
time, Oracle recommends that you schedule the process to run daily.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Show: All Tasks

◦ Task: Import Users and Roles into Application Security

2. On the Import Users and Roles into Application Security page, click Submit.

This action starts the Import User and Role Application Security Data process. After the process completes, you
can use the Security Console.

3. Now set up this same process to run daily:

a. On the Import Users and Roles into Application Security page, click Advanced.
b. Click the Schedule tab.
c. Select the Using a schedule option.
d. From the Frequency list, select Daily.
e. Enter an end date far in the future.
f. Click Submit.
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Automatic New Account Notifications and What to
Change  
For security reasons, users get the sign-in information they need to start using the application in two separate
notifications. The first email tells users an account was created for them and includes a link they can use to create their
passwords. The second email, which confirms the password reset, includes the user name.

Here's how the process works by default:

1. The application sends the new account notification. The email includes only the link to reset your password. It
doesn't list the user name.

2. Users click the link in the email and create their passwords.
3. If users already know their user names, they can sign in to the application right away.
4. The application sends the second password reset confirmation, which includes the user name.
5. If users don't know their user names, they can get the user names from the second notification.

You can view the default notification text by opening the two templates provided by Oracle: ORA New Account Template
and ORA Password Reset Confirmation Template in the Security Console. When you create your own templates, the text
of the Oracle notification templates is copied automatically to your new template. You can edit the text or replace it with
your own.

As set up by Oracle, the application also notifies the user's manager when a user account gets created and when
passwords get reset. If you don't want to spam sales managers, you can disable these notifications or replace them with
text of your own.

Suggested Changes
At a minimum, change the text of sample notifications to replace Oracle-specific language. You may also want to clarify
the process:

• New Account Template:

Add language that makes it clear that to users that they can get the user name from the notification they
receive immediately after they create their passwords.

• Password Reset Confirmation Template

Modify the text to highlight the user name, so it's easy to spot in the email. When making the edits, remember
that users receive this notification every time they reset their passwords, not just the first time they create their
password.

For navigation and setup details, including available tokens, see the topic: Set Up Preferences for User Names,
Passwords, and Notifications.

Related Topics
• Set Up Preferences for User Names, Passwords, and Notifications

38



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 4
User Account and Password Preferences

Set Up Preferences for User Names, Passwords, and
Notifications  
Use the Security Console to set your preferences for user names, passwords, and user notifications. For example, you
can require users to set stronger passwords, implement shorter user names, change the text of the notifications your
users receive, or turn notifications off completely.

Oracle provides only sample notifications. You must change the Oracle-specific language in the notifications and add
additional information users may need. For example, the initial notification users receive about their new account
includes a link to create your password. But, for security reasons, Oracle doesn't include the user name. In that initial
new account notification, you may want to explain that you get the user name from the subsequent password reset
confirmation.

Set Preferences for User Names and Passwords

1. Open the Security Console from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Show: All Tasks

◦ Task: Manage Applications Security Preferences

Alternatively, click Tools > Security Console on the home page.
2. Click User Categories.

On the User Categories tab, you can set up different preferences and notifications for different categories of
users. Since all of the sales users you create and import are created in the Default category, you set preferences
for that category only.

3. Click DEFAULT.

On the DEFAULT User Category: Details page, you can set the user-name format.
4. Click Edit.
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5. Select the user-name format you want to use from the User Name Generation Rule list.
The application uses your selection to generate user names unless you enter the user names manually or
import them from a file. By default, the application uses the email address as the user name.
If you're implementing Partner Relationship Management, then you must use email for creating partner
contacts. Otherwise, you can use any of the three following options:

◦ First name.last name

◦ Email

◦ First initial and last name

Don't use Person or party number because numbers aren't easily remembered by users. For example, if the
person number generated by the application for John Smith is 100000000178803, then the user name is
100000000178803 as well.

6. Selecting the Generate system user name when generation rule fails option ensures that the application
generates a user name even if there is no information available for the option you selected.

7. Click Save and Close.
8. Click the Password Policy subtab.
9. Here you can specify password strength and expiration. For example, you can require users to use special

characters in passwords and specify how frequently passwords must be changed.
10. Selecting the Administrator Can Manually Reset Password option, makes it possible for administrators to

manually create new passwords for users.
11. Click Save and Close.

Configure Email Notifications and Change the Oracle-Specific Text
In the Notifications subtab on the DEFAULT User Category tab, you can specify which email notifications, if any, are sent
to users and the text of those notifications. At present, the application supports text-only notifications in one language.

You can make these changes:

• Turn all notifications on or off.
By default, all notifications are turned on. If you're setting up a test environment, turn off notifications while
creating sales users to prevent the users from signing in to the application while you're setting it up.

• Turn individual notifications on or off.
By default, all individual notifications are turned on.

• Create your own notifications.
Oracle provides predefined English-language sample templates with Oracle-specific language. You must create
your own templates to provide users with the information they need.

Here's how to configure the email notifications:

1. Click the Notifications subtab.
The subtab lists the default notification templates provided by Oracle. The list includes the events that trigger
the notifications and the email subject lines.

2. To make changes, click Edit.
3. If you want to turn off all notifications, then deselect the Enable Notifications option under the Notification

Preferences heading.
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4. If you want to turn off individual notifications, then:

a. Click the template name link.
b. Deselect the Enabled check box.
c. Click Save and Close.

5. Here's how to create your own notification templates:

a. Click Add Template  and select the event.

Selecting the event automatically copies over the text provided in the corresponding Oracle template,
which you can then edit.

b. Edit the notification subject line and text.

Here's a list of the tokens you can include in the message text. Each token must be within curly brackets
and preceded by a dollar sign, for example: ${firstName}.

Token Meaning Events

userLoginId
 

User name
 

- Forgot user name

- Password expired

- Password reset confirmation

firstName
 

User's first name
 

All events
 

lastName
 

User's last name
 

All events
 

managerFirstName
 

Manager's first name
 

- New account created - manager

- Password reset confirmation -
manager

- Password reset - manager

managerLastName
 

Manager's last name
 

- New account created - manager

- Password reset confirmation -
manager

- Password reset - manager

loginURL
 

URL where the user can sign in
 

- Expiring external IDP signing
certificate

- Password expired

- Password expiry warning

resetURL
 

URL where the user can reset his or her
password
 

- New account created - manager

- New user created

- Password generated

- Password reset

- Password reset - manager

CRLFX
 

New line
 

All events
 

SP4 Four spaces All events
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Token Meaning Events

   

adminActivityUrl
 

URL where an administrator initiates an
administration activity
 

Administration activity requested
 

providerName
 

External identity provider
 

Expiring external IDP signing certificate
 

signingCertDN
 

Signing certificate
 

Expiring external IDP signing certificate
 

signingCertExpiration
 

Signing certificate expiration date
 

- Expiring external IDP signing
certificate

- Expiring service provider signing
certificate

encryptionCertExpiration
 

Encryption certificate expiration date
 

Expiring service provider encryption
certificate
 

adminFirstName
 

Administrator's first name
 

- Administration activity location-
based access disabled confirmation

- Administration activity single sign-
on disabled confirmation

adminLastName
 

Administrator's last name
 

- Administration activity location
based access disabled confirmation

- Administration activity single sign-
on disabled confirmation

c. Select the Enabled option.
d. Click Save and Close.

The predefined template provided by Oracle is automatically disabled. You can only have one template for each
event.

6. On the DEFAULT Category: Notifications page, click Done.

Set the Synchronization Process Frequency Warning
If you don't like warning messages, read on. Whenever you navigate to the Security Console, you get a warning if the
Import User and Role Application Security Data process was not run in the last six hours. If you scheduled the process to
run daily, then it makes good sense to change the value of the warning as well.

1. Click the Administration subtab.
2. Change the value for the Hours Since Last Synchronization Job Run Warning.

Related Topics
• Automatic New Account Notifications and What to Change
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5  Setup Users

Setup Overview  
Using the Setup Assistant, you can create up to 15 users to help you with setup.

Use this chapter to:

• Create additional setup users.

• Enable the initial user created by Oracle to participate in the setup process.

The initial user can perform security tasks, such as creating other users and granting setup permissions, but
needs the additional privileges granted to setup users.

• Enable setup users to monitor all background processes

• Learn how to reset passwords for users

Here's a list of the setup tasks. You can open the tasks from the Sales offering in the Setup and Maintenance work area.
Tasks are organized by functional areas. Remember that you may have to show All Tasks to see the task you want.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

Create other setup users.
 

Setup and Maintenance >
Sales > Users and
Security > Manage Users
 

Create Setup Users

2
 

Both Digital Sales and CX
Sales

Provision the initial user
with the same permissions
as the other setup users.
 

Setup and Maintenance >
Sales > Users and
Security > Manage Users
 

Provide the Initial User the
Same Permissions as Other
Setup Users

3
 

Both Digital Sales and CX
Sales

Any setup users you
create receive an email
notification with a link
they can use to reset their
passwords. If they don't
receive the email for some
reason, you can reset user
passwords and update
email addresses in the
Security Console. (You can
open the Security Console
using the task Manage
Applications Security
Preferences)
 

Setup and Maintenance >
Sales > Users and
Security > Manage
Applications Security
Preferences
 

See the section: Reset User
Passwords and Update
Email Addresses
 
To understand the
notification process
for new accounts and
recommendations on
the kinds of notification
changes you may want
to make, see the topic:
Automatic New Account
Notifications and What to
Change
 
For setup instructions, see:
Set Up Preferences for User
Names, Passwords, and
Notifications
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Step Applies To Description Navigation Where to Get More Details

4
 

Both Digital Sales and CX
Sales

By default, setup users can
only see the scheduled
processes they themselves
submit. Use the Security
Console to provide all of
the setup users the ability
to see what processes are
running and their status,
 no matter who submitted
them.
 

Setup and Maintenance >
Sales > Users and
Security > Manage
Applications Security
Preferences
 

See the topic: Give Users
the Permission to View All
Scheduled Processes
 

About Setup Users and Security  
Providing users with the security permissions they need to complete the setup tasks in this guide is very simple if you
used Setup Assistant for your initial setup. You just make a couple of entries and click Save. Provisioning rules provided
by Oracle do the rest. This topic provides a brief overview of Oracle's security model, lists the permissions that setup
users need, and explains how the provisioning process works.

How Permissions Are Grouped and Provisioned
Oracle uses the Role-Based Access Control (RBAC) security industry standard. The permissions are grouped in two
types of roles:

• Job roles, which provide users with the permissions to carry out tasks specific to a job, such as a sales manager
or sales administrator

• Abstract roles, which permit users to complete tasks that are common to all employees or resources

You typically provision salespeople with the job roles corresponding to the roles they play in the sales organization (their
resource roles), as well as the employee and resource abstract roles. The employee abstract role provides access to
reports and personal profile information. Without the resource abstract role, users can't participate in the sales process,
create accounts and opportunities, or be assigned to sales teams. You can find the description of each job and abstract
role Oracle provides and all the duties that come with it in security reference guides.

When you create users, the application automatically provisions them with the required job roles and abstract roles
using role-provisioning rules. Each role-provisioning rule is made up of the rule conditions and the names of the job
roles and abstract roles that are assigned to the user if the conditions are met. In the sales application, the job role and
the resource abstract role are assigned to a user based on the resource role. The employee abstract role is provisioned
to all users of type employee.

As long as you used Setup Assistant, the application creates all the role-provisioning rules you need for setup users and
all the standard sales users. If you set up the company information in a different way, then you must create all the role
provisioning rules yourself. That's true if you're setting up the application together with Oracle HCM Cloud or another
cloud service. You must also create role-provisioning rules for any additional resource roles you create. You can learn
more about role-provisioning rules in the Get Ready to Create Sales Users chapter and in the Securing CX Sales and B2B
Service guide.
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Security Roles Required by Setup Users
To complete the setup tasks in this guide, you must be provisioned with the security roles listed in the table. The initial
user provided by Oracle comes provisioned with only the first three. While the initial user can create other users and
perform many setup tasks, the initial user can't complete all the tasks without the additional security roles.

Role Type Permissions the Role Provides

Application Implementation Consultant
 

Job Role
 

Access all setup tasks across all products
 

IT Security Manager
 

Job Role
 

Access security tasks, including the ability to
assign other security roles
 

Application Diagnostics Administrator
 

Job Role
 

Access diagnostic tests and data
 

Employee
 

Abstract Role
 

Access BI reports and run and monitor
background processes
 

Sales Analyst
 

Job Role
 

Create sales recommendation rules
 

Sales Administrator
 

Job Role
 

Perform the sales administrator duties
 

Note:  For licensing reasons, use the Application Implementation Consultant role only for the initial setup tasks.

How You Create and Provision Setup Users
To provision the required security roles, just create setup users as users of type employee and assign them the Sales
Setup User resource role. It doesn't matter whether the user you're setting up is an actual employee or not. Provided
you used Setup Assistant for your initial setup, Oracle creates two role-provisioning rules that do the rest:

• The Employee rule automatically assigns the Employee abstract role to all users of type Employee.

• The Sales Setup User rule automatically assigns all users with the Sales Setup User resource role (the
condition), with all of the required job roles.
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The setup users you create aren't assigned the Resource abstract role, so they can't participate in the sales process. But
there is nothing stopping you from creating other provisioning rules to provision sales administrators or others with the
same setup permissions.
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Create Setup Users  
Follow this procedure to create users who can perform the sales setup discussed in this guide. This procedure applies to
both CX Sales and Digital Sales.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Users

Alternatively, click Navigator > My Team > Users and Roles.
2. On the Search Person page, click Create.
3. On the Create User page, in the Personal Details region, enter the user's name and a unique email address.

The application automatically sends user notifications to this email address unless you disable notifications in
the Security Console.

4. In the User Details region, you can enter a user name.

If you leave the User Name field blank, the application automatically creates a user name for you. By default,
the application uses the email unless you made changes in the Security Console.

5. To automatically send an email notification to the user, select the Send user name and password option in
User Notification Preferences. The email includes a link to create a password in the application.

Note:  If this option isn't available, notifications may be disabled. Check the notification settings in the
Security Console.

6. Select these values in the Employment Information region:

Field Value to Select Comments

Person Type
 

Employee
 

For setup only. The user need not be an
employee.
 

Legal Employer
 

Your company name followed by the letters
LE

 

The legal employer name is used for setup
only, so doesn't have to correspond to any
actual entity.
 

Business Unit
 

Your company name followed by the letters
LE BU

 

The business unit name, like the legal
employer name, is used for setup only.
 

7. In the Resource Information section, select Sales Setup User from the Resource Role list.
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8. Click Autoprovision Roles.

The Role Requests region displays the following roles:

◦ Application Diagnostics Administrator

◦ Application Implementation Consultant

◦ IT Security Manager

◦ Employee

◦ Sales Analyst

◦ Sales Administrator

The role request process may take a few minutes to complete because it's set to run periodically. You can view
the status of the request anytime you edit the user.

9. Click Save and Close.

If you selected the Send user name and password option and notifications are enabled, the application sends
the new account notification email. If you didn't select this option, then you must reset the password for the
user using the procedure described in the Resetting User Passwords topic. After you create the user, you can
no longer update the email address in this UI. You can instead update the email address on the Users tab in the
Security Console.

Related Topics
• Set Up Preferences for User Names, Passwords, and Notifications

• Automatic New Account Notifications and What to Change

Provide the Initial User the Same Permissions as Other
Setup Users  
Use this procedure to grant the initial user the same permissions as the other setup users. This setup applies to both CX
Sales and Digital Sales.

1. Click Navigator > My Team > Users and Roles.

Alternatively, you can open this task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Users

2. On the Search Person page, enter the first name of the initial user in the Keywords field and click Search (the
right-arrow icon).

3. Select the name link in the Search Results.
4. On the Edit User page, in the Resource Information region, select Sales Setup User from the Resource Role

list.
5. Click Autoprovision Roles.

The Role Requests region displays these roles:
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◦ Sales Analyst

◦ Employee

◦ Sales Administrator

Your role request process may take a few minutes to complete because it's set to run periodically. You can view
the status of the request anytime you edit this user.

6. Click Save and Close.

If you're signed in as the initial user, you must sign out and then sign in again for the new permissions to take
effect.

Reset User Passwords and Update Email Addresses  

Reset Passwords for Others  
Use the Security Console to reset passwords for other users. Only setup users, and other users with the IT Security
Manager job role, can access the Security Console. This setup applies to both CX Sales and Digital Sales.

All users can reset their own passwords by clicking their user name or image, and selecting the Set Preferences link in
the Settings and Actions menu. They can also reset their passwords by using Forgot Password on the sign-in page.

1. Open the Security Console. You have two options:

◦ In Setup and Maintenance, go to the following:

- Offering: Sales
- Functional Area: Company Profile
- Show: All Tasks
- Task: Manage Applications Security Preferences

◦ Click Navigator > Tools > Security Console.

2. You can ignore and close any warnings regarding the scheduling of the Import Users and Roles Application
Security Data job.

3. Click the Users tab.
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4. Search for the user using one of the following:

◦ First or last name, but not both

◦ User name

Here's a screenshot of the Users tab highlighting the location of the Action menu.

5. From the Action menu, select Reset Password.
6. In the Reset Password page, you have two options:

◦ To send an email to users with a link they can use to create their own passwords, select the
Automatically generate password option.

◦ Reset the password yourself:

i. Select the Manually change the password option.
ii. Enter the new password twice.

Note:  The manual option is available only if you selected the Administrator can manually reset
password option while editing the password policy for the DEFAULT user category in the Security
Console.

7. Click Reset Password.

Related Topics
• Set Up Preferences for User Names, Passwords, and Notifications

Change a User's Email Address  
To change sales users' email addresses, use the same import process that you used to create them. You can also use
REST services. This setup applies to both CX Sales and Digital Sales.

You can also use these steps to change email addresses on the Users tab in the Security Console work area. However,
this method is not always foolproof:

1. Open the Security Console by clicking the Security Console link under the Tools heading in the Navigator.
2. Click the Users tab.
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3. Search for the user using one of the following:

◦ First or last name, but not both

◦ User name

4. Click the user name link.
5. On the User Account Details window, click Edit.
6. In the Edit User Account window, edit the email address.

Note:  Don't edit any of the other information available on the Edit User Account page. Use the Manage Users
task instead.

7. Click Save and Close.

Related Topics
• What can I use the Security Console for?

Change Your Password  
Use the application link your company gave you to open the Sign In page and change your password for better security.
You can use either of these methods to change your password. This setup applies to both CX Sales and Digital Sales.

• After you sign in, you can change your password using the Set Preferences option.

• On the Sign In page, you can change your password using the Forgot Password link.

Change Your Password Using Set Preferences
1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set

Preferences.
2. In the General Preferences section, click Password, and enter your password details.
3. Click Save and Close.

Change Your Password Using Forgot Password
1. On the Sign In page, click the Forgot Password link.
2. Enter the registered work email, select the Forgot Password option and click Submit.

A notification containing a link to reset your password is sent to your work email.

Note:
• If you don’t have your work email registered, the notification is sent to your line manager.

• If both you and your line manager don’t have work emails registered, you’ll not be able to reset your password.
Contact your security administrator to register your work email.

This table shows which method you can use for resetting passwords based on your Single Sign-On (SSO) configuration.
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Password Reset Method to UseSSO Configuration

Set Preferences Option Forgot Password Link

SSO Disabled Yes Yes

SSO Enabled No No

SSO with Chooser Enabled (both SSO sign-in and local
authentication options are available)

No Yes

Give Users the Permission to View All Scheduled
Processes  
Your application setup requires you to run numerous scheduled processes and ensure they complete successfully. By
default, users can only see the scheduled processes they themselves submit. By creating a custom role in the Security
Console and assigning all of the setup users to it, you ensure that everyone can see what processes are running and
their status, no matter who submitted them. This setup applies to both CX Sales and Digital Sales.

1. Open the Security Console.
2. Click the Roles tab.
3. On the Roles tab, click Create Role.

The Create Role page displays a series of steps you can click directly or reach using the Next button.
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4. In the Create Role: Basic Information step, make the following entries:

Field Suggested Entry

Role Name
 

Monitor ESS Processes
 

Role Code
 

MonitorESSProcesses
 

Role Category
 

Common -Abstract Roles
 

5. Click the Role Hierarchy step.

6. Click Add Role.
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7. In the Add Role Membership window, search for ESS Monitor Role and click Add Role Membership.

8. Click Cancel to close the Add Role Membership window.
9. Click the Users step.

10. Click Add User and add all of the setup users by searching for each by name and clicking Add User to Role.
11. Click Cancel when you are done.

The Users step should list all of the users you added.
12. Click Next to get to the Summary and Impact Report step.
13. Click Save and Close.

The users you added to the role can now monitor all of the scheduled processes in the Schedule Processes
work area.
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6  Accounting Calendar

How the Accounting Calendar Impacts Forecasting and
Other Sales Features  
The accounting calendar defines the start and end of your fiscal year and the time periods in that calendar, including
the exact dates for each time period. Your sales application uses these defined periods, often called enterprise periods,
for multiple purposes.

Here are some examples:

• Reports that provide amounts by enterprise period, such as a sales pipeline analysis

• Metrics calculations by period for territory analysis

• The ability to adjust forecast amounts by time period

• Distribution of quota amounts by time period

The period frequency set in your fiscal calendar is the shortest period you can use. Most sales organizations select
monthly (the default setting in Setup Assistant). A monthly period frequency enables you to generate monthly
forecasting windows that permit your organization to update quarterly forecasts. And you can break down activities
and reports by month and summarize by quarter and year. If you set the period frequency to yearly, then you can create
reports and activities for the year, but cannot break them down by month. If you set the period frequency to weekly,
then you can perform activities and generate reports by week, quarter, and year, but not by month because the number
of weeks varies by month.

Accounting Calendar Setup Tasks Setup Assistant
Completes for You  
The entries you make in Setup Assistant completes all of the tasks you need to create the accounting calendar and
enable it for use in your sales application:

• Creates the accounting calendar itself.

• Creates the forecasting periods for five years from the year you entered.

• Enables the calendar for use by setting the profile Accounting Calendar Default.

• Enables the calendar to be used in analytics and report by running the Refresh Denormalized Time Dimension
Table for BI process.

Follow the procedures in this chapter to review the accounting calendar that was created for you and, if required, to
create additional forecast periods in the future.
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Review the Accounting Calendar and Generate
Additional Forecasting Periods  
You can review the accounting calendar Setup Assistant created for you. Optionally, you can generate forecasting
periods for additional years in the future in your review.

If you need to make other changes to the accounting calendar, if you need to start the calendar in an earlier year,
for example, then you must create a new accounting calendar. See the Create the Accounting Calendar topic in the
Implementation Reference guide. You can't create a different accounting calendar after you start using your calendar for
forecasting and reporting.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Accounting Calendars

2. On the Manage Accounting Calendars page, click the name of the calendar created for you by Setup Assistant.
3. The Edit Accounting Calendar page displays the periods created for you by year from the starting date you

entered in Setup Assistant. You can change the year format and generate periods for additional years.
4. Here's how to generate periods for additional years. For each year, do the following:

a. On the Edit Accounting Calendar page, click Add Year.
b. Click Save.

5. When you complete adding all the years, click Save and Close.
6. Click Done.

Related Topics
• Create the Accounting Calendar
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7  Geography Data

Setup Overview  
Import and set up reference geography data for the countries where you do business. Importing the reference
geography data makes it possible for you to set up validation for address elements such as states and cities to prevent
address data entry errors.

For example, if you're setting up sales territories by states in the US, it's a good idea to have salespeople select the
states from a list rather than entering them manually. Preventing address entry errors ensures that the accounts are
assigned to the correct territory and that opportunities are included in forecasts. If you subscribe to the Oracle Address,
Email, and Phone Verification service, you don't really need the validation. Using the service, salespeople can look up
and enter valid addresses for most countries in the world at a fraction of a penny a piece. However, it's a good idea to
import and set up the geography data anyway. An extra bit of validation can't hurt. Besides, the geography data you
import is a shared resource that's used by HCM, supply chain, and financials cloud services, and it's free!

Oracle licenses geography data from Loqate that you can import, at no additional cost. Alternatively, you can license
geography data from another supplier and import it from a file. For more information about importing third-party
geography data, see the guide Understanding Import and Export Management for CX Sales and Fusion Service.

Here's the list of the setup tasks. You can open the tasks from the Sales offering in the Setup and Maintenance work
area. Tasks are organized by functional areas. Remember that you may have to show All Tasks to see the task that you
want.

Step Applies To Description Functional Area and Task
Name

Where to Get More Details

1
 

Both Digital Sales and CX
Sales

You can import the
geography of up to 3
countries at a time using
the Setup Assistant.
 
You can also import
countries using the Manage
Geographies task.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Geographies
 

See the topics:
 
What Setup Assistant
Completes for You
Import Geography
Reference Data
 

2
 

Both Digital Sales and CX
Sales

For the countries you
imported, you can enable
validation and lists of
values for address elements
such as states.
 
When you enable validation
on an address element,
 the application suggests
alternatives during address
entry. Enabling a list of
values requires the user to
make a selection from a list.
Both validation and lists of
values are enforced in the
UIs.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Geographies
 

See the topic: Set Up
Geography Validation
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Step Applies To Description Functional Area and Task
Name

Where to Get More Details

3
 

Both Digital Sales and CX
Sales

The validation affects
entries made in the
application UI only. You
must set the profile option
Geography Address
Validation Enabled to Yes
to validate addresses you
import.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Administrator Profile
Values
 

See the topic: Set Up
Geography Validation
 

4
 

Both Digital Sales and CX
Sales

Enable the mapping of
account and contact
addresses for each of the
countries that you import.
With mapping enabled,
 salespeople on the go can
view their contacts on a
map and obtain directions
on their mobile phones with
the click of a button.
 
If you selected the
geocoding option for a
country in Setup Assistant,
 you can skip this step.
Selecting geocoding for
one country, enables it only
for that country.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Geographies
 

See the topic: Enable
Address Mapping
 

Setup Assistant and Geography Data  
Using Setup Assistant, you can import the geography data for up to three countries at a time. Here's an explanation of
what geography setups Setup Assistant completes for you and which you must complete manually as described in this
chapter.

What Setup Assistant Does for You
• Imports the geography data for up to three countries each time you run it.

• Enables the mapping of addresses for a specific country when you select the Geocoding option for that country.

• If you selected the Geocoding option for any country, the application schedules the Populate Location Latitude
and Longitude Information process to automatically generate geographic coordinates from addresses. Oracle
CX Sales Mobile and other applications use this to put addresses on a map.

What You Must Complete Manually
• You must set up validation for address elements that you are using for sales territory assignment.

If you're assigning accounts to salespeople by state, for example, having a list of values for States ensures that
salespeople don't make mistakes during manual address entry.
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• Import geographies for additional countries.

• Enable geocoding for additional countries.

• If you didn't turn on geocoding in Setup Assistant, you must run the Populate Location Latitude and Longitude
Process on a regular schedule.

Import Geography Reference Data  
Here's how to import geography reference data licensed by Oracle.

1. In Setup and Maintenance, go to the Manage Geographies task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies

2. In the Manage Geographies page, enter either the country name in the Country Name field or the two-letter
ISO code of the country in the Country Code field.

Examples of ISO country codes include US (United States) and AT (Austria).
3. Click Search.
4. Select the country in the search results. Don't click the link.
5. Select Import Geography Data from the Actions menu.

Note:   The Import Geography Data action is disabled if the country isn't available from DaaS Loqate or if the
country data is already imported.

6. Click OK to close the warning message.
7. Click OK to close the confirmation message.

The import of larger countries may require several hours to complete. You can track the progress of the import process
by selecting Scheduled Processes from the Navigator menu.

After the import completes successfully, the Completed icon (check mark) replaces Go to Task icon in the Structure
Defined and Hierarchy Defined  columns on the Manage Geographies page.

Here's a screenshot of the Manage Geographies page with the Completed icons (check marks) highlighted.
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The Geocoding Defined and Address Cleansing Defined columns are used for additional features that you set up
separately:

• Geocoding enables mapping features in your application, such as the display of customer locations on a map in
the UI. For details, see the Enable Address Mapping topic.

• Address cleansing makes it possible to validate addresses down to the street level. Address cleansing requires
you to obtain a separate license for the Address Verification Cloud Service.

Note:  The geography data is provided by Loqate is third-party content. As per Oracle policy, this software and
documentation may provide access to or information on content and services from third parties. Oracle and its
affiliates aren't responsible for and expressly disclaim all warranties of any kind with respect to third-party content
and services. Oracle and its affiliates aren't responsible for any loss, costs, or damages incurred due to your access
to or use of third-party content, products, or services. Report any issues with Loqate data to Oracle Support who will
contact the appropriate team for correction. Alternatively, you can make manual changes to the geography data by
using the Manage Geographies task in the Setup and Maintenance work area.

Related Topics

List of Available Countries with Loqate Geography
Reference Data  
Oracle Applications Cloud provides third-party Loqate geography data for import. Here's the list of countries for which
the Loqate geography data is available for import.

Country Name Country Code

Andorra
 

AD
 

Angola
 

AO
 

Argentina
 

AR
 

Australia
 

AU
 

Austria
 

AT
 

Belgium
 

BE
 

Bolivia
 

BO
 

Bosnia and Herzegovina
 

BA
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Country Name Country Code

Brazil
 

BR
 

Bulgaria
 

BG
 

Canada
 

CA
 

Cayman Islands
 

KY
 

Chile
 

CL
 

China
 

CN
 

Croatia
 

HR
 

Cuba
 

CU
 

Cyprus
 

CY
 

Czech Republic
 

CZ
 

Denmark
 

DK
 

Dominican Republic
 

DO
 

Ecuador
 

EC
 

Estonia
 

EE
 

Finland
 

FI
 

France
 

FR
 

Germany
 

DE
 

Great Britain
 

GB
 

Greece
 

GR
 

Guadalupe
 

GP
 

Guam
 

GU
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Country Name Country Code

Guernsey
 

GG
 

Hungary
 

HU
 

Iceland
 

IS
 

India
 

IN
 

Indonesia
 

ID
 

Ireland
 

IE
 

Isles of Man
 

IM
 

Israel
 

IL
 

Italy
 

IT
 

Jamaica
 

JM
 

Japan
 

JP
 

Jordan
 

JO
 

Kenya
 

KE
 

Latvia
 

LV
 

Liechtenstein
 

LI
 

Lithuania
 

LT
 

Luxembourg
 

LU
 

Malaysia
 

MY
 

Malta
 

MT
 

Martinique
 

MQ
 

Mexico
 

MX
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Country Name Country Code

Netherlands
 

NL
 

New Zealand
 

NZ
 

Norway
 

NO
 

Oman
 

OM
 

Peru
 

PE
 

Poland
 

PL
 

Portugal
 

PT
 

Puerto Rico
 

PR
 

Qatar
 

QA
 

Reunion Island
 

RE
 

Romania
 

RO
 

Russia
 

RU
 

San Marino
 

SM
 

Singapore
 

SG
 

Slovakia
 

SK
 

Slovenia
 

SI
 

South Africa
 

ZA
 

South Korea
 

KR
 

Spain
 

ES
 

Sri Lanka
 

LK
 

Swaziland
 

SZ
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Country Name Country Code

Sweden
 

SE
 

Switzerland
 

CH
 

Taiwan
 

TW
 

Thailand
 

TH
 

Tunisia
 

TN
 

Turkey
 

TR
 

United Arab Emirates
 

AE
 

United States
 

US
 

Uruguay
 

UY
 

Vatican City
 

VA
 

Vietnam
 

VN
 

Set Up Geography Validation  
Set up geography validation for those geography elements that you plan to use in your sales territories to prevent data
entry errors. By default, application enforces the validation you specify for creating addresses in the UI only, so you
must turn the validation on for import.

Set Up Validation

1. Open the Manage Geographies task from the Setup and Maintenance work area using the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for each country you imported using either its name or its two letter
ISO code. For example, you can search by entering either the country name United States or the two letter ISO
code US, and clicking Search.

3. Select the country in the Search Results area.
4. Click Go to Task in the Validation Defined column.
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Here's a screenshot of the Manage Geographies page highlighting the Go to Task icon in the Validation Defined

column. 
5. On the Manage Geography Validation page. Address Style section, ensure that the No Styles Format address

style is selected. Defining validation for the No Styles Format address style ensures that the validations are
performed for all addresses in the country.

6. Select Enable List of Values in the Geography Mapping and Validation section to display a list of values during
address entry in the UI. For example, to have users select states from a list, select Enable List of Values for
State.

Vision Corp. enables the list of values for State. The company uses states for its sales territories and wants to
ensure that state names are always entered correctly.
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7. Select Geography Validation for all the geography types that you plan to use in territories.

In our example, Vision Corp. plans to set up sales territories by state, so it selects Geography Validation for
State.

Here's a screenshot of the Manage Geography Validation page highlighting the location of the Enable List of
Values and Geography Validation options for the US State geography type.

Note:  If you don't select the validation for an address element, the application still suggests values during
address entry. It just doesn't validate the address element.
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8. Specify if you want to allow users to save incomplete or invalid addresses by making a selection from the
Geography Validation Level for Country list.

◦ No validation: permits users to save incomplete or incorrect addresses.

◦ Error: permits only valid addresses to be saved.

Vision Corp. wants to save all addresses, including incomplete and invalid addresses, so it selects No
validation.

9. Click Save and Close.
10. Click Done in the Manage Geographies page.

Turn On Validation for Address Import
You must set a system profile option Geography Address Validation Enabled to Yes for the validation to be enforced
during import.

1. Open the Manage Administrator Profile Values task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option by entering Geography Address
Validation Enabled in the Profile Display Name.

3. Select Yes as the Profile Value.
4. Click Save and Close.

Enable Address Mapping  
You can quite literally put your accounts and contacts on the map by enabling geocoding as described in this topic.
Geocoding turns the addresses you enter or import into longitude and latitude coordinates so that the locations can be
displayed on a map.

Enabling address mapping involves two steps:

1. You enable the generation of geographic coordinates for a country
2. You run a process that converts the addresses into geographic coordinates

Salespeople must enter valid postal addresses for geocoding to work, so it's a good idea for you to validate the
addresses in your application by subscribing to Oracle Address Verification Cloud Service.
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What You're Enabling
Salespeople benefit from geocoding in two ways:

• In the office, salespeople can view the location of an account address on the map while editing the account
record.

• Using Oracle CX Sales Mobile on their smart phones, salespeople can view a map showing the locations of
accounts and contacts within a certain radius of their current location, or any other location they choose.
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They can obtain travel directions to any of the locations with the tap of a finger (CX Sales Mobile passes the
coordinates to the native mapping application on the phone).

Turn on Geocoding on the Manage Geographies Page
To turn on geocoding for a country, all you need to do is select the Geocoding Defined icon for the country where you
want to turn it on. Here are the steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies
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2. On the Manage Geographies page, search for a country you imported using either its name or its two letter ISO
code. For example, you can search by entering either the country name United States or the two letter ISO code
US, and clicking Search.

3. Click the Geocoding Defined icon.
4. Click Done

Run the Populate Location Latitude and Longitude Process
Run the process that converts the addresses to the location latitude and longitude regularly and each time you import.
Addresses that salespeople enter or addresses that you import don't show up on the map until the process completes,
so schedule the process to run as frequently as necessary. If you imported geography data using Setup Assistant and
turned on geocoding for any country, the process is already scheduled to run for you. Here's how to run the process:

1. In the Navigator, click Scheduled Processes under the Tools heading.
2. Click Schedule New Process.
3. Click the Name drop-down list icon and the Search link at the bottom of the list.
4. In the Search and Select: Name window, search for "Populate Location Latitude and Longitude Information".
5. Select the process name in the search results and click OK.
6. In the Schedule new Process dialog box, click OK to confirm your selection.
7. In the Process Details window, click Advanced to view the advanced options.
8. You can make the following entries on the Parameters Tab:

Parameter What to Enter

Country Code
 

Leave this field blank if you want to generate the coordinates for all the countries you enabled
for geocoding, or enter a specific country code.
 

Start Date, End Date, and Regenerate
Geocode
 

Leave these fields blank. The geocoding process picks up any addresses that have not been
geocoded previously.
 

Batch Size
 

Leave this field blank unless you're geocoding more than 50,000 addresses at a time. If you're
processing a large number of addresses, then enter 1000. By default, the application launches
a subprocess for each batch of 500 addresses. There's a maximum of 10 subprocesses, so, if
you're processing more than 50,000 addresses, then you must run the process multiple times.
You can increase the batch size up to a maximum of 1,000.
 

9. Schedule the process to run regularly:

a. Click the Schedule tab.
b. Select Using a Schedule and specify the frequency.

10. Click Submit.

The application confirms your process was submitted.
11. You can monitor the process completion on the Overview page.

The process spawns multiple processes, depending on the batch size and the number of addresses you need to
process.
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8  Search

Overview of Optional Setup for Adaptive Search  
Setup Assistant enables the Adaptive Search configuration provided by Oracle for the objects that you selected. In this
chapter, you learn about optional setups for Digital Sales and CX Sales UIs: how to make additional keywords available
for search in both UIs, for example. And you learn how to restrict the number of objects searchable by Global Search,
which is available in CX Sales only.

For additional advanced configuration and for information on how to configure search in individual work areas, see the
Adaptive Search and Workspace chapter in the Implementation Reference guide.

Here's a list of optional tasks that you can use to configure the way search works in your application:

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

By default, Adaptive Search
is configured for keyword
search on all the important
fields. However, you can
make additional fields
searchable both in Digital
Sales UIs and in CX Sales
UIs, including global search
and Workspace.
 

Setup and Maintenance >
Sales > Sales
Foundation > All Tasks >
Configure Adaptive
Search > Setup >
Advanced
 
 

See the topic: Make
Additional Fields
Searchable
 

2 Digital Sales Configure the list of values
that use Adaptive Search,
 called Smart Pickers.

Configuration done in
Application Composer and
in VB Studio.

See "Configure the
Adaptive Picker" in the
Oracle Fusion Cloud Sales
Automation Extending
Digital Sales (Next Gen
Sales) guide. To access this
guide, contact your Oracle
representative.
 
.
 

3 Digital Sales and CX Sales
 

Configure what shows up
in list of prioritized recent
items, called Smart Lists.
 
For example, you can
specify how long to keep
the items in smart lists if
they aren't acted on and
how frequently the lists are
refreshed.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Administrator Profile
Values

See the topics:
 

• My Lists

• Modify My List
Behavior

4
 

CX Sales For Global Search, a feature
available only in CX Sales,
you can restrict the number
of the objects that can be
searched.

Setup and Maintenance >
Sales > Sales
Foundation > All Tasks >
Configure Adaptive

See the topic: Configure
Global Search Scope and
Display of Search Results
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Step Applies To Description Navigation Where to Get More Details

 
By default, all of the objects
you enabled in Adaptive
Search are automatically
searchable from the Global
Search box at the top of the
page. If you enabled the
Partner object, for example,
 a salesperson searching
for the name "Pinnacle",
 gets both the accounts and
partners named Pinnacle.
 

Search > Configure Global
Search
 

5
 

CX Sales Optionally, you can
configure the way the
global search UI appears
to salespeople by creating
your own configuration
for CX Sales. For example,
 you can change which
suggestions display when
you click in the search
box and which objects get
displayed in search results
by default.
 

Setup and Maintenance >
Sales > Sales
Foundation > All Tasks >
Manage Global Search
Configurations
 

See the topics:
 

• Global Search UI

• Configure Global
Search UIs

Related Topics

Overview of Adaptive Search  
Oracle is completing the process of replacing the CRM search technology with Adaptive Search, a high-performance
search engine that provides keyword searching and enhanced filtering capabilities. Digital Sales UIs and features rely
exclusively on Adaptive Search. In CX Sales, some work areas still rely on legacy CRM Search technology.

By default, all customers now have Adaptive Search enabled automatically for Accounts and Contacts. You can enable
other objects using Setup Assistant or manually. Not all the available objects are sales objects. For example, Partner and
Partner Contact are only pertinent for Partner Relationship Management. HR Help Desk Request, Installed Base Asset,
Internal Service Request, and Service Request are specific to Fusion Service. Adaptive Search is also available on custom
objects or child objects you create.

Here's where you can use Adaptive Search:

• All Digital Sales UIs

• Workspace in CX Sales

A work area where salespeople can work on all of the available business objects at the same time.

• Work areas for individual business objects in CX Sales.

• Global Search in CX Sales

This is the keyword search available at the top of the page in CX Sales.
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• REST APIs

Note:  Many customers run their applications and Oracle Databases in their own data centers on Oracle
Cloud@Customer. Currently, Cloud@Customer pods or government pods don't support Adaptive search.

Setup Assistant and Search  
Setup Assistant sets up everything your sales organization needs to start using Adaptive Search both in Digital Sales
and in CX Sales.

What Setup Assistant Does for You
• Enables the objects you selected for Adaptive Search and runs the indexing process at the recommended

intervals. The Setup Assistant enables the search configuration provided by Oracle. Adaptive Search is the
search technology that powers all Digital Sales UI searches, including smart pickers. It's also the search
technology for most search UIs in CX Sales, including Workspace, individual work areas, Workspace infolets,
Global Search, and REST APIs.

• Displays the global search field at the top of the page for CX Sales UIs. (Behind the scenes, it sets the profile
option Global Search Enabled to Yes.)

• Sets up the search for work areas that still use the legacy CRM-specific search technology:

◦ Enables the work area searches in the work areas that don't yet use Adaptive Search.

◦ Runs the Synchronize CRM Search Indexes process every 5 minutes. This process sets up the search
index for work area searches.

◦ Runs the Optimize CRM Search Indexes process weekly. This process keeps the work-area search index
from getting fragmented.

Note:   If your implementation requires indexing processes to run at different intervals, you must
schedule the processes separately using individual tasks available from the Scheduled Processes page
(Navigator > Tools > Scheduled Processes). For details, see the topic Schedule Work Area Search
Processes topic in the Implementation Reference guide.

What You Can Set Up Manually
• Modify the way global search works.

• Configure the way keyword searches work.

• Add or remove objects available in Adaptive Search.

• Create saved searches for the sales organization.

• Create any saved searches for the work areas that don't yet support Adaptive Search and modify search
behavior. See the Implementation Reference guide (Overview of Work Area Search Setup) and the Configuring
Applications Using Application Composer guide for details.

Note:  You must create separate saved searches for these legacy individual work areas.
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Related Topics
• Create Saved Searches

• Modify Work Area Search Behavior

Search in Digital Sales and CX Sales UIs  
There are multiple ways to search in Digital Sales and CX Sales.

List Pages in Digital Sales
Here's a brief overview of how salespeople search in the list pages in Digital Sales work areas.

1. They place the cursor in the search field and select a saved search as the starting point.

The selected saved search determines the breadth of the search. For example, the My Accounts saved search
restricts the search to accounts where the salesperson is in the team or territory. The filters are displayed right
above the search field.

2. In the search field, they can enter filters and keywords:

◦ Add filters to filter results by a specific field. For example, to filter out all the accounts in Boston:

i. Enter city.
ii. Select Primary Address: City to specify the address type.

iii. Select Equals as the operator.
iv. Enter the city name: Boston.

For more search options see the Using Digital Sales guide topics Filter a List and Filter by Numbers and
Dates

◦ Enter one or more keywords to search on and press return. Keywords can be words in the name or in
related fields and objects. See the topic: Search Using Keywords.

3. Further configure the search results:

◦ You can group your results by selecting the attribute you want to group by.

◦ Change the columns displayed in the search results by clicking Actions (the three dots) and selecting
Manage Columns.

◦ Change the order of the columns by selecting and dragging.

◦ Change the default sort order using the controls at the top of each column.

4. Click Save to save your search criteria and search result formats to create a saved search.

Digital Sales List Page Features

Callout Number Description

1 Name of the saved search that's generating the list on the list page.

2 List of filters in the search.
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Callout Number Description

3 Search bar where you select saved searches, and enter filters and search terms

4 Group search results

5 Take actions:
• Save to create a new saved search

• Export the list

• Manage columns in list results

• Sort to display most relevant records first

Search in Workspace and Work Areas in CX Sales
For searches focused on one sales object and to explore sales data, you can use Workspace and the different work
areas.

Here's an annotated screenshot of Workspace to explain how it works. (The search experience in the work areas
targeted to single objects is exactly the same. You just can't switch objects.) :

1. You select a particular saved search as your staring point (callout 1 in the screenshot).
2. Adding filters (callout 2) lets you explore the list along a particular dimension. When you add industry as a filter

to a list of accounts, for example, you can see which industries have the most accounts and how many there
are.

3. If you are looking for a specific record in the list, you can search by keyword (callout 3).
4. You can save your personalized search as a new search (callout 4).
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Smart Pickers in Digital Sales
In Digital Sales, a smart picker is a special kind of search on a list of values. Smart pickers leverage your Adaptive Search
setup so that users can quickly and easily find the record they're looking for. Adaptive Search makes it possible to
search using attributes of related objects and you can create saved searches to narrow down the search to the items you
want. For example, a salesperson searching for an account can search on the name of the contact, or the city where the
account is located. Smart pickers also provide "type ahead keyword search", which means that search results appear as
the user starts typing.

Here's an example of a smart picker:
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Global Search in CX Sales
In CX Sales, you can use the global search, located at the top of the application pages, to search by keyword across the
different types of sales information. For example, searching using the keyword "Paris," finds all the contacts named
Paris, as well as all the accounts, opportunities, leads, and other records Paris is associated with. You also get all of the
records with Paris addresses. Global search makes it possible to search all records you have permission to view.

Global search uses the same Adaptive Search technology as Digital Sales, Workspace and work areas, but it supports
keyword searches only.

Search in Work Areas That Still Use CRM Search
For Products, Business Plans, Service Requests, and Competitors work areas, salespeople can search either by record
name or switch to an advanced search mode to search using multiple search criteria. The saved searches (lists) for the
different work areas use a different technology from those you create for Adaptive Search, so you must set them up
separately.

To highlight the differences in UI features, here's a screenshot of the Advanced Search panel in the Business Plans work
area landing page, a work area with the legacy CRM search.
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Search Type Differences  
Here are the key differences between the two search types.

Search Technology Differences Overview

Search Properties Adaptive Search CRM Search

Where It's Used All Digital Sales searches: including list pages,
 "smart pickers", and saved searches.
 
In CX Sales: Workspace, work areas powered by
Adaptive Search, Infolets powered by Adaptive
Search, and saved searches for these.
 
Adaptive Search is also used in REST APIs.
Global Search uses only Adaptive Search
keyword searches.
 

Legacy work areas including Product, Business
Plans, Service Requests, and Competitors.
Note that you set up Saved Searches for legacy
work areas separately because they use CRM
Search.
 

Search Scope
 

In list pages, you select a saved search to set
the scope of your search
You can search using related information. For
example, you can search for an account by
contact name, address city, and owner.
 

In list pages, you select a saved search to set
the scope of your search and search by name.
You can use advanced search to search using
multiple search criteria.
 

Indexing Frequency
 
Until a new record is indexed, it's not available
for search.
 

Records you create and update in the UI are
automatically indexed and made searchable
within seconds.
 
Imported records or records updated by
background processes aren't available for
search until the process completes.
 

Both records that you create in the UI and those
you import are available almost immediately.
The indexing process usually runs every 5
minutes.
 

List of Recent Items
 
Records you recently created, edited, or
accessed, includes records that haven't been
indexed yet.
 

You get a list of up to 10 most recent items for
each object. In addition, selecting a Smart List,
 displays up to 50 items you recently accessed
ranked by the number of times you accessed
them.
 

Displays recent items when you place your
cursor in the Search field.
 

Wildcards and Operators
 

Use an asterisk (*) at the end or middle of
a word to indicate missing letters and the
question mark (?) to indicate a single missing
letter. You can also use operators OR and NOT,
 and quotation marks (") for exact phrases.
 
Adaptive Search also includes multiple numeric
and text operators that you can use for
advanced search. For example, you can search
on a range of values, on all the words, and
words in a specific order. You can also find
records with no values.
 

Use a percent sign (%) at the beginning, end, or
middle of a word to indicate missing letters.
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Search Properties Adaptive Search CRM Search

Filters Extensive ability to use filters to explore your
data. For example, you see the most frequent
values in a filter and how many records appear
in each.
 
For example, adding the primary industry as a
filter when searching accounts, automatically
displays the most frequent industries and
the number of records for each. A search of
opportunities using win probability as a filter,
 displays different ranges of win probabilities
and the number of records in each range.
 

You can filter your results by adding new search
terms and rerunning yours search.
 

Saved Searches You can create personal saved searches and
sales administrators can also create saved
searches for different roles in the organization.
 
Adaptive Search saved searches can be used in
any feature powered by Adaptive Search.
 
You can reuse Digital Sales saved searches in
Workspace, in infolets powered by Adaptive
Search and in CX Sales Mobile.
 

You can create personal saved searches
and sales administrators can create saved
searches for different roles. Because the saved
searches are built on a different technology
from Adaptive Search, you can't use them in UIs
that use Adaptive Search, including Workspace
and Digital Sales list pages.
 

How Salespeople Search and What You Can Configure  
Here's how salespeople search with Adaptive Search and how you can modify the default behavior provided by Oracle.

How Salespeople Search in the UI What Administrators Can Configure

Selecting a saved search displays a list
that matches the saved search criteria and
determines the scope of any search you
perform on the page. For example, if you
select All Accounts, you're searching all
accounts you can view. If you select My
Accounts, then you're searching only the
accounts that you own.
 

You can create your own saved searches targeted to specific roles within the sales organization. And
you can determine which saved search appears by default when salespeople open the UI. Salespeople
can create their own personal saved searches and override the administrator defaults.
 

You can enter one or more search terms in
the Search field.
 
You can use related information for your
searches. For an account, you can search
by company name, the city where the
account is located, or the primary contact
at the company, for example. You can even
search for an account by the name of the
salesperson on the sales team.
 
The search results match whole terms,
 but you can use the (*) wildcard for partial

You can enable or disable the attributes available for search. Oracle enables the most common
attributes for you, but you must enable the search for any child objects and fields you create in
Application Composer.
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How Salespeople Search in the UI What Administrators Can Configure

words and use operators, including NOT,
 OR, and Between for date ranges.
 

You can view the filters used in the saved
search by clicking the Show Filters link.
You can also add filters of your own.
 

You can specify which additional fields users can add as filters and you can set up groupings of values
the filters show. For example, you can break down opportunities by revenue ranges: 0 to 10,000, 10,
000 to 100,000, 100,000 to 500,000, and 500,000 and up.
 

Filters show the most common values
and the number of records in each. For
example, a search of accounts with the
primary industry as a filter, automatically
displays the most frequent industries and
the number of records for each. A search
of opportunities using win probability as
a filter, displays different ranges of win
probabilities and the number of records in
each range.
 
Your filter selections are additive, if
you select Health Care as the primary
industry and then Lisa Jones as the owner,
Workspace displays only those Health Care
accounts Lisa owns.
 

You can configure value ranges for numeric, corporate currency, percent, and date filters. For example,
 you can configure value ranges for the opportunity win probability filter and other similar filters.
 

Salespeople can save any search criteria
they enter as their own personal saved
search.
 

You can create saved searches for use by the whole sales organization and you can tailor them to
different roles.
 
You can expose the saved searches as filters in Workspace infolets to display key sales information
right on the home page.
 

Sales administrators and sales managers
can download search results into an Excel
spreadsheet.
 

You can remove the Export List button from the page using Application Composer. You can also enable
other custom sales roles to use the button, by granting the privilege ZCA_WORKSPACE_EXPORT.
 

Make Additional Fields Searchable  
By default, Workspace, Global Search, and the work areas that use Adaptive Search, include all of the key fields you need
for search. (See the topic Adaptive Search Configuration Provided by Oracle for a list.)

However, you can enable additional fields for search, including custom ones. And you can remove existing fields from
use. This example shows you how to enable the Chief Executive Name field. The field is a standard application text
field, but the same procedure applies to any field, even a custom field on a standard application object. When you're
done with this configuration and publish it, a salesperson can search on the CEO's name to find the account where the
person is the CEO. The search also returns all of the opportunities for that account when you enable opportunities to be
searched by account fields.

Suppose that you added the CEO name field to the Account UI and want to make entries in this field searchable. Here's a
screenshot of the Edit Account page highlighting the location of the field.

80

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20069092


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 8
Search

Making the field searchable involves these steps:

1. Make the field searchable for its business object.
2. Optionally, you can enable the field for search of a related object.
3. You publish your configuration.
4. Enable the field for display in UIs as a column and a filter.

Note:  If you want the field to be displayed in the UI, either as a filter or as a column in search results, then you must
enable it for display on the Configure Workspace UI tab of the Configure Adaptive Search page.

Make the Field Searchable in Its Business Object
Here's how you make the field available for searching its business object. For example, making the account searchable
by the CEO name.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, Setup tab (callout 1 in the screenshot), click Advanced (callout 2).
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3. In the left pane, click the name link for the object where the custom field appears (callout 3). The CEO name
field is an account field, so you click Account.

The field is listed in the Configure Fields section.

4. Select the Enable option to index the field for Workspace and Global Search (callout 4).
5. For a text field, including Chief Executive Officer, select the Analyzed Text Search option to index individual

words in the field. Your selection also enables fuzzy search (search that retrieves results with similar spellings).
And you enable other search operators, including All of the words and Any of the words.

6. Select the Include in Keyword Search option to enable the field for searches in the Digital Sales list pages and
in CX Sales Workspace and Global Search.

If you leave this check box deselected, users can't search for accounts using the CEO name. But in Workspace,
they can still add the Chief Executive Name field as a filter for accounts and search the field there. Global Search
doesn't permit you to add filters, only to search by keyword.

7. Select the Include in Object Reference option to enable the field for search in related objects. Make the
selection if you want to use the CEO name when searching for opportunities, for example.

If you didn't select the Include in Keyword Search option, but select Include in Object Reference, then users
searching opportunities can use the field only as a filter in Workspace.
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Make the Field Available for Searching a Related Object
You can only make the field available for search in a related business object if you selected the Include in Object
Reference option for the field.

1. In the left pane of the window, open the object where you want to enable the search. For this example,
Opportunity (callout 1 in the screenshot).

2. Select the field in the left pane, in this example, Account (Callout 2).
3. In the right pane, select Enable (callout 3).
4. If you want to use the field for searches in Global Search and in the Workspace Search box, you must select the

Include in Keyword Search  option (callout 4).
If you don't select this option, but selected Enable, then the field remains available as a filter in Workspace, but
can't be searched in Global Search.
The Include in Object Reference option isn't relevant here. Here's a summary of the two use cases:

Use Case Enable Include in Keyword Search

Users can search on the field using Global
Search and in the Workspace Search box.
For example, entering the CEO name,
 they get results containing, not only the
account where the person is a CEO, but the
opportunities for that account as well. In
Workspace, they can also select the fields
as a filter when searching for the object. For
example, when searching for opportunities
in Workspace, they can filter by CEO name.
 

Selected
 

Selected
 

Users can add the field as a filter in
Workspace, but can't search on it using the
Search box or using Global Search.
 

Selected
 

Deselected
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Publish Your Configuration
After making your option selections, click Action > Publish.

Publishing triggers an indexing process that you can monitor on the Monitor tab, Publish subtab. Your new
configuration becomes available after the indexing process completes. If the process completes with errors for some
reason, contact your help desk.

Enable the Field for Use as a Filter in Digital Sales List Pages and CX Sales
UIs
You must enable the field for display on the UI, so it can be used as a filter and added as a column in search results.

1. In the Configure Adaptive Search page, click Configure UI.
2. To enable the field for use as a filter on its object (for example, to enable the account field to be used as a filter

when searching accounts), do the following:

a. Select the object in the left pane of the Configure UI tab.
b. Select the Display in UI option for the field.

3. To enable the field for use in the UI of other related objects (for example, to enable the account field as a filter in
opportunity searches), do the following:

a. Display the related object hierarchy for the object where you want to enable the filter in the left pane of
the Configure UI tab. For example, select Opportunity (callout 1 in the following screenshot).

b. Locate and select the field's object in the object hierarchy. For example, select Account (callout 2).
c. Select Display in UI option for the field (callout 3).

4. Click Save and Close.
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Related Topics
• Adaptive Search Configuration Provided by Oracle

Lists of Prioritized Recent Items  

My Lists  
Based on your use and engagement patterns with your Digital Sales and CX sales application, My Lists present the most
contextually relevant records to help minimize navigation and searching.

My Lists are automatically created for you and are derived from your past and recent application touches and
interactions with the following supported objects:

• Accounts

• Activities

• Contacts

• Leads

• Opportunities

• Partners

• Products,

• Product Groups

Using a predefined relevancy scoring mechanism, lists are based on near real-time user context and display the most
relevant and contextual records data to users once every 10 minutes. They also help reduce the amount of navigation
and clicks required to perform additional searches. For example, the My List for Accounts includes accounts ranked by
the number of times a salesperson has opened each account, its contacts, and its opportunities and how recently. So,
if today you open or update account information on Acme four times, but only open Pinnacle once, then Acme appears
higher on the list than Pinnacle. Each list can display a maximum of 50 items. Items that haven't been touched for 30
days get automatically taken off the list.

Here are some of the factors that affect how relevancy scores influence the presentation of records for your respective
My List saved searches:

• Recency: Last time you interacted with an object

• Frequency: How frequent you interact with an object

• Favorites: Records you mark as a favorite

• Urgency: When an action is expected from you such as task due tomorrow, upcoming appointment, and so on

• Related objects: Relevancy scores are boosted for related account, opportunity, or lead objects associated with
overdue tasks and appointments

• Event-based updates: Updates to win probability, status, and sales stage boosts the relevancy score for
opportunity records

My Lists are included along with saved searches in Digital Sales list pages and in the Sales Dashboard.
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In CX Sales, My Lists are available in Workspace, in work areas powered by Adaptive Search, infolets, and in CX Sales
Mobile app. For example, to display a list of your accounts in Workspace, salespeople select Accounts > My List for
Accounts, just like any other saved search.

The list is created and maintained by two processes:

• The Generate Relevancy Feed process creates the list. By default, this process runs every 3 hours.

Note:  You can reduce the refresh rates of My Lists from once every 3 hours to near real-time (10 minutes
refresh intervals) by setting the Enable Near Real Time User Context Relevancy profile option to Y.

• The Age User Context Relevancy process removes items from the list that haven't been touched by the user in
the past 30 days. By default, this process runs once a day.

Modify My List Behavior  
My Lists are available automatically to salespeople as soon as they start working in the application. No setup is required.
However, you can modify My List behavior in a few ways:

• Change how long untouched items are kept in the list. By default, items are kept 30 days after they're accessed
last. For example, if your organization has long sales cycles, then you may want to keep items on the list for a
little longer.

• Enable the Near Real-Time User Contextual Relevancy profile option.

• Change how frequently and when My Lists are refreshed to improve user experience.

Change How Long Items Are Kept in the List
You can change the number of days untouched records are kept in the list by setting the profile option, Relevancy Aging
Maximum Number of Days (ZCA_UC_AGING_CYCLE). Here's how:

1. In Setup and Maintenance, open the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, search by the profile option name Relevancy Aging
Maximum Number of Days or code ZCA_UC_AGING_CYCLE .

3. Click the profile option name link.
4. Set the profile option value to the desired number of days.
5. Save your changes.

Enable the Near Real-Time User Contextual Relevancy Profile Option
You can enable near real-time user contextual relevancy by setting the profile option, Enable Near Real Time User
Context Relevancy (ORA_ZCA_UC_ENABLE_NRT). Here's how:

1. In Setup and Maintenance, open the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation
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◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, search by the profile option name Enable Near Real Time
User Context Relevancy or code ORA_ZCA_UC_ENABLE_NRT .

3. Click the profile option name link.
4. Change the profile option value from FALSE to Y to enable near real-time user contextual relevancy.
5. Save your changes.

Run the My List Processes with Different Frequencies and Schedules
You can change how often or when you run the two processes that generate the My List and remove untouched items
from the list:

• Generate Relevancy Feed
Generates My Lists by analyzing all records that have been updated in the last 24 hours. By default, this process
runs every three hours.

• Age User Context Relevancy Feed
Removes from My Lists all items that haven't been accessed in the past 30 days (the number of days set in the
profile option Relevancy Aging Maximum Number of Days). By default, this process runs once a day.

See the User Context section of the Sales and B2B Service Scheduled Processes chapter of Understanding Scheduled
Processes guide for details.

Related Topics
• Create and Edit Profile Options

• Age User Context Relevancy Feed

CX Sales Search Setups  

Global Search  

Global Search UI  
Global Search is the search box at the top of the page in the CX Sales UIs. This feature isn't available in Digital Sales.
Here's a summary how global search works and how you can configure it.

How It Works What You Can Change

When salespeople click in the global
search box (callout 1), the application
suggests recent search terms, recent
pages you visited, and other recent items.
The items are organized in suggestions
groups (callout 2). For example, under
Recent Items, the application suggests
recent pages you visited.
 

• Change the "Search" prompt in the global search box.

• Specify which suggestion groups get displayed for users by default. For example, you may want
to hide Recent Items and show Recent Searches first.
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How It Works What You Can Change

Salespeople can specify which suggestion
categories they want to see and which
categories of results are available in the
search results, by clicking Personalize
(callout 3), the application suggests recent
items they worked on recently.
 

• Specify which suggestion groups are available for use. For example, instead of hiding Recent
Items by default, you may want to remove it from use entirely so users can no longer display the
category.

Salespeople enter keywords in the search
box (callout 1) and press Return to search
across different objects.
 

• You can specify which objects are available for global search and how the results are displayed.
See the topic Configure Global Search Scope and Display of Search Results

Here's how the results get displayed after you enter your search term and press Enter.

How It Works What You Can Change

The results of the search show the objects
that are enabled for global search during
setup.
 

• You specify which objects are available for global search and how the results are displayed. See
the topic Configure Global Search Scope and Display of Search Results

Salespeople click Show Filters, and select
those objects they want to see in their
search results (callout 1).
 

• The objects you selected for use in global search, show up as the available filters here.

• You can specify which objects are selected by default.
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How It Works What You Can Change

Clicking on the first line of each search
result opens the record for editing.
 

• By default, users drill down on the record name, but you can specify a different field as the title.

• You can also specify which fields display in the two lines below the title in each search result.

Salespeople can personalize their global searches by clicking Personalize. See the topic Configure Global Search and
Result UIs to learn how to make changes in the default behavior.

How It Works What You Can Change

Salespeople can specify which objects are
included in search results and in which
order.
 

• You can specify which objects are available for selection and which are enabled by default.

• You can disable personalization of search categories.

Salespeople can specify which
autosuggest groups show up and in which
order when they click in the global search
box.
 

• You can specify which autosuggest groups are available for display and which are enabled by
default.

• You can disable personalization of autosuggest groups.

Here's the Search Categories tab salespeople can use to select which objects (categories) are included in search results.
Changing the order of results isn't supported.
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Salespeople can control which Autosuggest Groups tab makes it possible to control the suggestions you get when you
first click in the global search.
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Related Topics
• Configure Global Search UIs

Configure Global Search Scope and Display of Search Results  
You can specify which of the objects you enabled for Adaptive Search are searchable in Global Search and how the
search results are displayed.

Each search result, includes:

• A title that provides the link that users click to drill down into the record. By default, the name of the record is
the title, but you can choose a different field.

• Two lines displaying fields you specify

Here is a screenshot showing the results of an account search:
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1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

92



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 8
Search

2. In the Configure Adaptive Search page, click the Configure Global Search tab in the left-side of the page
(callout 1 in the screenshot).

1. Configure each object you enabled for Adaptive Search:

a. Click the object link in the Objects column on the left (callout 2).
b. You can prevent users from using Global Search to search the object by deselecting the Display in UI

option (callout 3). By default, users can search all objects you enabled for Adaptive Search.
c. By default, users click on the record name link in the search results to drill into a record, but you can

select a different field. To change the drill-down link, click Title (the pencil icon, callout 4) and select the
alternate field.

d. Click the Line 1 edit button and select the fields you want to display in the first line under the title.
e. Click the Line 2 edit button and select the fields you want to display in the second line.
f. Click Save.

2. When you complete configuring all the objects, click Save and Close.

Configure Global Search UIs  
Optionally, you can configure the behavior of global search UIs. For example, you can specify which suggestions display
automatically when users click in the search field and which objects display in search results. You can create different
configurations for different application pages.

Tip:  If you already made a copy of the new OSC Default Global Search Configuration, then you can edit that copy and
make your changes there. You don't need to create a second copy.

Duplicate the Default Configuration Provided by Oracle
You can't make changes to the Global Search configuration provided by Oracle. You must copy the Oracle configuration
and edit that copy instead. If you already created a copy, you can skip this step.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
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2. In the Setup and Maintenance work area, open the Manage Global Search Configurations task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Manage Global Search Configurations

3. On the Manage Global Search Configurations page, select the configuration with the OSC short name and
Default Global Search Configuration name.

4. Click Duplicate (the document icon).
5. In the Short Name field, enter an alphanumeric code with uppercase letters and no spaces.
6. Enter a name for your configuration in Display Name.
7. Select CRM as the product family and module.
8. Leave the Default option deselected for now. You select this option as a last step.
9. Click Save and Close.

10. Open the Manage Global Search Configurations page again.
11. Click the name link for the configuration you created.
12. Use the tabs to define your configuration:

◦ Autosuggest: Determine what's available to users in the global search autosuggest, as well as how
autosuggest looks and behaves.

◦ Search Field: Control the Search field in the global header and in the search results dialog box.

◦ Search Results: Specify if salespeople can personalize the filters used in their searches

◦ Pages: Specify where you want your configuration to apply.
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Define Which Groups of Suggestions Users See

1. While editing the global search configuration you created, click the Autosuggest tab.

2. Skip setup of Synonyms as they don't apply to Sales.
3. Keep the Enable personalization of search groups option selected unless you want to prevent users from

personalizing suggestion groups.
4. In the Suggestion Groups section:

◦ Move the Saved Searches group (callout 2), and any other unwanted suggestion groups, to the Available
Groups column. This action removes them from use. Saved searches can't be used with Global Search.

◦ You can remove a suggestion group from being displayed by default by setting Enable to No. Users can
still enable the group when they personalized their global search.

◦ You can change the order the suggestion groups are presented to users.

◦ You can change the suggestion group headings.
i. Click Manage Suggestion Groups.

ii. Duplicate an existing group and edit your copy.
iii. Click Refresh.
iv. Swap your copy for the original.

5. You can turn the suggestion group headings off in the Appearance section (callout 3).
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6. You can change suggestion behavior (callout 4):

◦ Show Top Suggestions: Enable this option to display suggestions in autosuggest as soon as the user
clicks in the search field, even without entering a search term. For example, the last few pages the user
opened would appear as suggestions in the Recent Items group.

◦ Minimum Characters for Autosuggest: Enter the number of characters that users must enter in the
search field before matching suggestions appear in autosuggest.

◦ Maximum Number of Suggestions: Enter the maximum number of suggestions to be displayed across
all suggestion groups. This total is distributed as equally as possible among the groups.

Configure the Global Search Field
Here are the main configurations for the global search box field:

• You can change the minimum and maximum number of characters required for search.

• You can specify a different word to appear in the Global Search box instead of "Search".

Configure How Salespeople Can Use Filters

• In the Saved Search and Recent Search section, you can disable the display of recent searches by deselecting
Enable recent searches. Saved searches aren't available in global search.

• In the Filters section:

◦ Keep Enable personalization of search categories selected unless you want to prevent users from
specifying which objects they see in the search results. You determine the objects that show up as filters
in global search while setting up Adaptive Search (see the topic Configure Global Search Scope and
Display of Search Results).

◦ Enable clear all filters: Allow users to clear all filters by clicking the Clear All Filters button in search
results.

◦ Show applied filters: Show all the filters that have been applied

• The Search Categories section and the rest of the sections on this tab don't apply to CX Sales.
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Specify the Sales Pages Where Your Configuration Applies and Complete the Configuration
Entering the application pages is a one-time setup. If you're editing a configuration you created, then you don't need to
reenter the page codes again. You can skip this step.

1. Enter codes (view IDs) for the applications or pages where you want your configuration to apply. Here are the
entries for CX Sales:

View Type View ID

Application
 

CRMPerformanceApp%
 

Application
 

ORA_CRM_SERVICESAPP%
 

Application
 

ORA_CRM_UIAPP%
 

Application
 

ORA_SERVICEAPP%
 

Application
 

SalesApp%
 

Application
 

ORA_FSCM_UIAPP%
 

You can obtain other codes in Setup and Maintenance, using the Manage Taxonomy Hierarchy task as
described the linked topic: Specify the Pages or Applications That a Global Search Configuration Applies To.

2. At the top of the page, select the Default option.
3. Click Save and Close.
4. Clear your browser cache and navigate to any of the sales pages to test your configuration.
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9  Saved Searches

Saved Searches in Digital Sales and CX Sales  
This chapter outlines how you create saved searches for different roles in the sales organization. You can create, share,
and manage the saved searches in two separate UIs: one in Digital Sales and the other in CX Sales. Which UI you use
doesn't matter. The result is the same.

Salespeople can use the saved searches in any of the UIs that use Adaptive Search. In Digital Sales, this includes all list
pages and some lists of values (smart pickers). In CX Sales, this includes Workspace and the work areas powered by
Adaptive Search. The saved searches you create are also available in CX Sales Mobile.

Note:  This guide explains how to create saved searches for UIs that use Adaptive Search. For an explanation of how
to create saved searches for the legacy work areas that still use CRM Search, see the topic Overview of Work Area
Search Setup in the Implementation Reference guide.

Overview of Saved Search Setup  
Here's an overview of how you can create saved searches for different roles in your organization in both Digital Sales
and CX Sales.

Step Applies to Description Navigation Where to Get More Details

1 Both Digital Sales and CX
Sales

If you haven't already,
 review the list of fields
available in Adaptive Search
and make changes before
you create saved searches.

N/A Adaptive Search
Configuration Provided by
Oracle

2
 

Both Digital Sales and CX
Sales

Create saved searches for
different job roles in the
sales organization. You
accomplish this in either
the Digital Sales UI or the
CX Sales UI.
 

On any list page For Digital Sales, see
the topic Create Saved
Searches for the Sales
Organization
 
For CX Sales, see: Specify
the List of Saved Searches
for Different Job Roles
 

3
 

Both Digital Sales and CX
Sales

Share the saved searches
with the appropriate job
roles in the organization.
 
You accomplish this in
either the Digital Sales UI or
the CX Sales UI.
 

Click in the search field
in the list page and select
Manage Saved Searches.
 

For Digital Sales, see the
topic How do I share a
saved search with everyone
or with specific job roles?
 
For CX Sales, see: Specify
the List of Saved Searches
for Different Job Roles
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Step Applies to Description Navigation Where to Get More Details

4
 

Both Digital Sales and CX
Sales

Specify which saved search
appears by default when a
user opens each work area.

Click in the search field
in the list page and select
Manage Saved Searches.
 

For Digital Sales, see the
topic: Specify Which Saved
Search Appears for Users by
Default.
 
For CX Sales, see: Specify
the List of Saved Searches
for Different Job Roles
 

5 Digital Sales If the saved search is for
a lead or contact, you can
specify if you want users to
see the first item in the list
instead of the list itself.

Click in the search field
in the list page and select
Manage Saved Searches.
 

See the topic Display the
First Record in Leads and
Contact Lists.

6 Digital Sales You can create a
visualization (a chart) of the
data in a saved search.

Navigate to
Configuration > 
Application Composer.

See the topic Create a
Visualization of a Saved
Search or an Analysis.

7 Digital Sales You can add shared
saved searches and any
visualizations you create
for them to the Sales
Dashboard.
You can display a saved
search in the Sales
Dashboard as a Metric Card
(one of the tiles across the
top), as a list, or as a table.
 

VB Studio See the topic: Create a
Visualization of a Saved
Search or an Analysis

8 CX Sales For each job role, you can
specify which business
object and saved search
they see when they open
Workspace or a work area
for an object.

Manage Saved Searches
page in Workspace.

See the topic: Specify the
List of Saved Searches for
Different Job Roles
 

Saved Searches in Digital Sales  

Saved Searches Targeted at Different Users  
As a sales administrator, you can configure saved searches targeted to different job roles in the sales organization.

Note:  The saved searches you create in Digital Sales are identical to those you create in Oracle CX Sales Workspace
and work areas powered by Adaptive Search. You can create, delete, and otherwise manage searches in either
application, and the saved searches are available to users of both applications.

Configuring the saved searches for each work area involves two steps:

1. Create the saved searches in the landing page for each sales object. When you name your searches, keep in
mind that users see them listed in alphabetic order.
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2. Use the Manage Saved Searches page to share your saved searches with everyone or with the appropriate job
roles. You can configure different lists of saved searches for different job roles, specify the search that runs by
default when users open the work area, and you can hide the saved searches provided by Oracle.

While you can configure saved searches for the sales organization, every user can personalize the list of saved searches
in each work area for their own use. They can save their current search criteria and their preferred way of displaying
search results as a new saved search. Every user can specify which saved search runs by default whenever they open
that particular work area. Users can also hide any saved searches they don’t want to see.

Review What Searches Are Available for a Sales Object  
Here's how to review saved searches available for a particular sales object.

1. Navigate to the appropriate work area landing page. Each business object has its own list of saved searches.
2. Click in the search field and select Manage Saved Searches .
3. From the Manage Saved Searches page, Visible To list, select Me. The Me list includes saved searches you created

and haven’t shared, the saved searches visible to everyone, and all of the saved searches visible to the job roles
assigned to you. Saved searches provided by Oracle are shared with everyone and list Oracle as the owner.

4. Different job roles may have saved searches available to them that won’t appear on your Me list. To ensure you see
all of the saved searches, cycle through all the job roles in the Visible To list.

Create Saved Searches for the Sales Organization  
Creating a saved search that you can share with the sales organization is as simple as clicking the save button on the
landing page.

The new saved search includes not only your current search criteria and keywords, but also your preferred way of
displaying and sorting the results. Here are the details:

1. Click Save on the landing page.
2. In the dialog box, enter the name for your saved search.
3. Click Save.

Your new saved search is now listed in the Manage Saved Searches page. You’re now ready to share the saved
search with the sales organization. For details, see the topic How do I share a saved search with everyone or
with specific job roles?.

Manage Saved Searches Page  
As a sales administrator, you can use the Manage Saved Searches page to specify saved searches for others in the sales
organization. You can also use the page to maintain your own list as does any other user, as described in the Using
Digital Sales guide.

Here's what you can do on the Manage Saved Searches page:

• Share saved searches you created.

• Remove from use any saved searches provided by Oracle that you don't need. You can’t delete the saved
searches Oracle provides, but you can unshare them.
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• Specify which saved search appears by default when users navigate to the work area.

• Delete any saved searches you created.

• Create different lists of saved searches for different job roles.

• For contacts and leads, you can choose to display the first record in the list rather than the list itself.

Here's an annotated screenshot to give you an overview:

Callout Number Column Explanation

1
 

Visible To
 

Access the different lists of saved searches for
different job roles. Each role can have its own
configuration.
 

2
 

Name
 

Clicking on the name of the saved search
displays the search results.
 

3
 

Created By
 

You can only delete saved searches created
by your organization. You can’t delete saved
searches created by Oracle, but you can
unshare them so they're visible only to you.
 

4
 

Shared With
 

Saved searches you create are personal (Shared
With Only Me) unless you share them.
 

5
 

Open As
 

List: The saved search displays results as a
list. For lead and contact saved searches only,
 you can instead open the first record in the list
(Detail).
 

6
 

Actions
 

The Actions menu (three dots) displays the
available actions for each saved search.
 

7 Show in List Indicates if the saved search is visible or hidden
from you when you put your cursor in the
search field on the landing page.

8 Default For each list of saved searches, you can specify
a different saved search to run by default when
users open the landing page. Users can always
specify their own default.
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How do I share a saved search with everyone or with specific job
roles?  
You can configure the saved search setup to specify the saved search that appears by default whenever a user opens
the work area. You can also setup saved searches to share with everyone or to share with each specific job role.

After you create a saved search, it’s initially visible only to you. Here’s how to share it with the whole sales organization
or with individual job roles.

1. Navigate to the work area.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, select Me.
4. Click Actions (the three dots in the Actions column) for the saved search you want to share and select Edit.
5. Make a selection from the Shared With list:

◦ If you’re making the saved search available to the whole sales organization, select Everyone.

◦ If you’re making it available for specific roles, here’s how to add them:
i. Select Specific Roles.

ii. Click Add.
iii. Select the role.
iv. Click Save (the check mark icon).

6. Click Save.
If you shared the saved search with job roles that aren’t assigned to you, then the saved search is no longer visible on
your page. To see it, select one of the job roles assigned to it from the Visible To list.
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Remove a Saved Search from Use by Unsharing It  
As an administrator, you can remove saved searches from use entirely by unsharing them. Doing so removes them
from the lists of saved searches for all users except yourself. Use this method to remove from use any saved searches
provided by Oracle that you don't need.

1. Place your cursor in the search field on the landing page and select Manage Saved Searches.
2. On the Manage Saved Searches page, click Actions (the three dots) for the saved search you want to remove,

and select Edit.

3. On the edit page, click Shared With and select Not shared (callout 1 in the screenshot).

4. Click Save.
The saved search is now visible only to you. It's removed from use for the entire organization.
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Specify Which Saved Search Appears for Users by Default  
For each business object, you can specify the saved search that appears by default whenever a user opens the work
area. You can specify different defaults for each job role.

1. Navigate to the work area.
2. Click in the search field and select  Manage Save Searches.
3. From the Visible To list, select the job role where you want to define the default.
4. Click Actions (the three dots in the Actions column) for the saved search and select Set as Default.

Rename a Saved Search  
You can rename saved searches you created. Saved searches are listed in alphabetic order for users when they put their
cursor in the search field.

1. Navigate to the work area.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, select Me to see the lists that you shared with everyone and those you haven’t shared yet. If

you shared the list with a specific job role, and that job role isn’t assigned to you, then you must select that job role to
see the saved search that you want to rename.

4. Click Actions (the three dots in the Actions column) and select Edit.
5. Enter a new name.
6. Click Save.

Delete a Saved Search You Created  
You can delete saved searches you and other administrators created. Your action deletes the saved search for every role
where it is shared. You can't delete saved searches provided by Oracle, but you can hide them.

1. Navigate to the work area.
2. Click in the search field and select  Manage Saved Searches.
3. From the Visible To list, select Me to see the lists that you shared with everyone and those you haven’t shared yet. If

you shared the list with a specific job role, and that job role isn’t assigned to you, then you must select that job role
from the list to see the saved search you want to delete.

4. Click Actions (the three dots in the Actions column) and select Delete.
5. Click Save.
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Display the First Record in Leads and Contact Lists  
For contacts and leads only, you can display the first record in the list rather than the list itself. Salespeople then work
through the items in the list by clicking Next to get the next record. You can specify a different default for different job
roles.

1. Navigate to the work area.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, make a selection that matches how the list is shared. For example, if the list is shared only

with Inside Sales Representatives, then select that job role.
4. Click Actions (the three dots in the Actions column) for the saved search and select Edit.
5. In the Open As field, select Detail.

Saved Searches in CX Sales  

Create Saved Searches  
Here's how you can create saved seaches in the CX Sales UI either for yourself or for others in the organization. The
saved searches you create are the same ones you create in Digital Sales. You're just creating them in a different UI.

1. In Workspace, select a saved search as your starting point. For example, the All Accounts saved search
provided by Oracle lets you create your saved search for all the accounts you can see.

2. Enter your search terms. You can enter search terms in the Search box, add filters, select filter values, or any
combination of these.

3. You can add or change the columns displayed in the search results by clicking Edit Columns (the pencil icon
highlighted by callout 2 in the following screenshot).
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4. Click Save As (highlighted by callout 1).

5. Enter the name for your saved search. Remember that the saved searches are listed in alphabetic order.
6. To make this saved search the default saved search for you personally, select the Set as my default saved

search option. The default saved search is what you see whenever you navigate to Workspace.
7. Specify how you want to share the saved search you are creating. There are three options:

◦ Only Me

◦ Everyone

◦ Specific Roles

8. If you selected Specific Roles, click Search (the people icon) and select the job roles.
9. Click Create.
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Overview of the Manage Saved Searches Page  
Use the Manage Saved Searches page to manage your own list of saved searches, manage the lists sales users see, and
to specify the default saved search different roles see when they open Workspace.

My List
On the My List tab, you can manage your own personal lists of saved searches (there's a separate list for each business
object).

• You can specify which saved search displays when you navigate to Workspace by making a selection from My
Default Saved Search (callout 1 in the screenshot).

• To view the saved searches for a specific business object, just make a selection from Manage List (Callout 2 in
the screenshot).

• You can hide individual saved searches by deselecting Show in List.

• You can delete only saved searches that you created.

While you can't delete saved searches provided by Oracle, you can hide them.

Workspace List
On the Workspace List tab, you can share saved searches with everyone, with specific user roles, or with no one.
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For each business object that you select from Manage List (callout 1 in the following screenshot), you can:

• Specify who can view each saved search by specifying a value in the Shared With column (callout 2 in the
screenshot).

◦ For saved searches provided by Oracle, you can either share the saved search with everyone or not share
it at all, effectively hiding it from use.

◦ For saved searches created by you or other administrators, you can select one of the following:

- Only Me

Makes the saved search a personal saved search that you can manage on the My List tab.
- Everyone

Makes the search available to all roles.
- Specific Roles

Makes it possible for you to specify one or more specific job roles that can see the saved search.
- Not Shared

Removes the search from use.

• You can delete only saved searches that you created (callout 3 in the screenshot).

While you can't delete saved searches provided by Oracle, you can remove it from use by selecting the Not
Shared value in the Shared With column.

Defaults by Role
Use the Defaults by Role tab to define the default saved search for each job role. This is the saved search that users
with the job role see when they open Workspace.
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Specify the List of Saved Searches for Different Job Roles  
Specify the lists of saved searches that are available for each business object in Workspace. You can create different lists
for different job roles. The saved searches appear in ascending alphabetic order in the list.

The same saved searches show up as filters in actionable infolets. For example, because All Accounts starts with the
letter A, users see All Accounts when they view the My Accounts actionable infolet, unless you create a different saved
search to appear on top. To display the most critical sales information for sales users by default, remove the All Account
saved search from the list by hiding it and replace it with a more appropriate saved search. If need be, you can recreate
saved searches and rename them to get the order you want.

Here's how to configure the list:

1. In Workspace, click the drop-down list you use to select the object and saved search.
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2. Select Manage Saved Searches (highlighted in the screenshot).

3. Click Workspace List.
4. Select the business object in Manage List (callout 1 in the following screenshot)
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5. Specify who sees which saved searches for each object. Here's how:

◦ For each saved search, specify who can see it by making a selection in the Shared With column (callout 2
in the screenshot).

- For saved searches provided by Oracle, you can either share the saved search with everyone or not
share it at all, effectively hiding it from use.

- For saved searches created by you or other administrators, you can select one of the following:

◦ Only Me

Makes the saved search a personal saved search that you can manage on the My List tab.

◦ Everyone

Makes the search available to all roles.

◦ Specific Roles

Makes it possible for you to specify one or more specific job roles that can see the saved
search.

◦ Not Shared

Removes the search from use.

◦ You can delete only saved searches that you created (callout 3 in the screenshot).

While you can't delete saved searches provided by Oracle, you can remove it from use by selecting the
Not Shared value in the Shared With column.

6. To specify the default saved search users see when they open Workspace, click Defaults by Role and select the
default saved search for each role.

7. Click Save and Close.
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Specify What Users See When They Open Workspace  
For each job role, you can specify which business object and saved search they see when they open Workspace or a
work area for an object.

1. In Workspace, click the drop-down list you use to select objects and saved searches.
2. Select Manage Saved Searches.
3. In the Manage Saved Searches page, click Defaults by Role.
4. Select the default saved search for each role
5. Click Save and Close.

Create a Visualization of a Saved Search or an Analysis  
You can create a visualization of a saved search or an Oracle Analytics Cloud analysis, which you can then display in the
Sales Dashboard and in the CX Sales Mobile app.

You must be a setup user or a user with one of the following job roles to create a visualization:

• ORA_ZCA_CUSTOMER_RELATIONSHIP_MANAGEMENT_APPLICATION_ADMINISTRATOR_JOB (Customer
Relationship Management Administrator)

• ORA_ZBS_SALES_ADMINISTRATOR_JOB (Sales Administrator)

Note:  If you created custom roles, you must make sure that the role has the privilege
ZCA_VIEW_DATA_VISUALIZATION_CONFIGURATION_PRIV.  To add the role, do the following:

1. Navigate to Security Console > Roles and search for
ZCA_VIEW_DATA_VISUALIZATION_CONFIGURATION_PRIV (make sure that enabled all role types and
privileges in the search filters).

2. From the Expand Toward list, select Users.

3. From the Show list, select Users to see which users have the privilege and from what role.

4. To add the privilege, edit the custom role:
a. Go to Function Security Policies  >  Privileges  > Add Function Security Policy and search for

privilege ZCA_VIEW_DATA_VISUALIZATION_CONFIGURATION_PRIV.
b. Add the privilege to the role.
c. Save.

How to Create a Configuration Visualization from a Saved Search
You must make sure that the saved search is visible both to the user performing configurations and to the users who will
view the visualization.

1. Navigate to Configuration >  Application Composer.
2. Click Visualization Configuration in the right-hand pane.
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3. Select the Adaptive Search source type from the Create Configuration page.

4. In the Visualization Configurations page, click Add.
5. In the Source Type field, select Adaptive Search.
6. In the Source field, select the saved search. The saved search is used as the data source for the visualization.
7. In the Visualization Type field, choose your preferred visualization, such as a bar chart, donut chart, and so on.
8. In the Details section, enter the dimensions and other preferences for the visualization.
9. In the Drill Down section, change the Action option from None to Link. This enables drill down to the search

list.
10. Set the Status field to Active.
11. Click Create to save the configuration.
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You can now add this visualization to a Sales Dashboard Add a Visualization to the Sales Dashboard, or to the mobile
dashboard using Mobile Application Setup under Application Composer. Configure the Reports Page Layouts

You can also display the saved search visualization on the CX Sales Mobile application Home page as a card. See the
topic: Display Visualizations from Saved Searches in Home Page Cards and the Reports List.

How to Create a Visualization Configuration from an Analysis
1. Navigate to Configuration >  Application Composer.
2. Click Visualization Configuration in the right-hand pane.
3. Click Add to create a new configuration. The Create Configuration page displays the source type and source.
4. To create a configuration based upon an OTBI Analysis:

a. Select OTBI Analysis as Source Type.
b. Select a folder by clicking on the catalog icon and navigate to where you have saved the OTBI Analysis. By

default, the Custom folder is selected.

5. In the Source field, enter your search criteria. You're searching the catalog for an existing analysis under the
selected catalog folder.

6. Select a source analysis from the search results. All the fields get auto-selected and the visualization shows on
the page. If the selected source analysis has more columns than required, there could be a warning message
that the visualization might not show the correct data. To resolve this issue, remove the columns that are not
used, and reload the configuration.
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7. For the Sales Dashboard only, if you want to enable drill-down functionality, you need to take a few more steps.
a. Select a folder by clicking on the Select Catalog folder icon where you have saved the Target OTBI

Analysis.
b. In the Target field, enter your search criteria. You're searching the BI catalog for an existing target analysis

under the selected catalog folder. The target analysis should have a prompted filter applied on the same
field as selected in the source analysis. The target analysis opens in a new window showing the drilled-
down report. If you want to create a configuration using a predefined or seeded BI Analysis, you should
select the Catalog folder as Sales and then search for the source.

c. After enabling drill-down, you can validate the drill-down functionality by clicking on any component of
the visualization.

8. Click Create to save the configuration.

After enabling drill-down, you can validate functionality by clicking on any component of the visualization.

How do I group data in saved searches and visualizations
by team members?  
To group data, including by the different team members in saved searches and their visualizations, you enable the Team
Members attribute for the Group By feature in Adaptive Search. You can then use the Team Members field to group data
in your search and the resulting visualization.

Here's the setup overview:

1. If you're using Workspace in the classic Sales UI, then enable the Group By feature for Workspace. This step isn't
required for Sales in the Redwood user experience.

See the Enable the Group By Feature for Workspace section for detailed steps.
2. Enable the Team Members and Team Member fields for Group By in the Configure UI tab on the Configure

Adaptive Search page.

See the Enable Team Member Fields for Group By section for detailed steps.
3. Create the saved search with the Team Members group by selected.

See the topic Create Saved Searches for the Sales Organization.
4. Create the visualization from the saved search as described in the topic Create a Visualization of a Saved

Search or an Analysis.
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Enable the Group By Feature for Workspace
1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
2. In the Setup and Maintenance work area, open the Configure Adaptive Search task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Parameters tab.
4. Highlight the Enable Group By and click Edit.
5. In the Warning message, click Yes.
6. In the Current Value field, change the value from N to Y and click Save and Close.

Enable Team Member Fields for Group By

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area, and open the Configure Adaptive Search task :

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

3. On the Configure Adaptive Search page, click the Configure UI tab.
4. Select the object you want to set up for your Group By in the left pane of the tab and open the object hierarchy

to locate Team Members and Team Member.

5. Select the Enable for Group By option for both Team Members and Team Member fields.

Note:  Ensure that the Display in UI option is also selected

6. Click Save and Close.
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7. Sign out and then sign in again to see your changes.

No publishing is required to see the option in the group by. The changes you made are reflected in the Workspace UI for
the Group By field drop down lists for the selected object.

Related Topics
• Create Saved Searches for the Sales Organization

• Create a Visualization of a Saved Search or an Analysis
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10  Users and Security

Overview of Users and Security  
Access to your sales application's functionality and data is secured using role-based access control. In a role-based
access control model, users are assigned roles, and roles are assigned access privileges to protected system resources.

Oracle provides predefined job and abstract roles that you assign to users to give them access to application data and
functionality. Job roles provide users with the permissions they need to perform tasks that are specific to a job. Abstract
roles provide users with the permissions to complete tasks that are common to all users.

To create users and provision them with roles, you perform Sales Setup tasks listed for the Users and Security functional
area. For information about creating users and provisioning them with roles, see these chapters of the guide:

• Get Ready to Create Sales Users

• Create Sales Users in the UI

The predefined job roles provide users with access to both CX Sales and Digital Sales UIs:

• Sales Representative

• Sales Manager

• Sales VP

• Sales Administrator

This chapter introduces each of the security configuration work areas you can use to review and configure your security
setup and describes the data sharing mechanisms used to give users visibility to sales object records. For additional
information about setting up and configuring security, see the Securing Sales and Fusion Service guide.

Security Configuration  
You can review information about the access provided by the sales job roles and can configure the default settings if
necessary. For example, you can create custom versions of the roles and add or remove the privileges they provide.

The following sections describe each of the security configuration work areas and the types of configurations you can
make using each one. See the Securing Sales and Fusion Service guide for further information about using each work
area.

Security Console
You can make custom copies of the sales job roles and can edit the custom roles from the Roles tab of the Security
Console. You can add or remove function security policies from a custom role, add additional roles to the custom role
hierarchy, and assign the custom role to users. You can also add custom data security policies to either the predefined or
custom sales job roles.
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Note:  It's recommended that you use access groups and object sharing rules rather than data security policies to
configure data security. For additional information, see the Access Groups chapter in the Securing Sales and Fusion
Service guide.

You can access the Security Console by clicking the Security Console link under the Tools heading in the Navigator.

Tip:  The Data Security Policies train stop on the Roles tab of the Security Console lists only the data security policies
that are assigned directly to a Digital Sales role. Policies that the role inherits from subordinate roles aren't displayed.
To review all the data access policies a Digital Sales role provides, use the Sales and Service Access Management work
area as described in the next section.

Sales and Service Access Management UI
Review a user's access to object data using the Sales and Service Access Management UIs. You can access the Sales and
Service Access Management work area by clicking the Sales and Service Access Management link under the Tools
heading in the Navigator.

The Sales and Service Access Management UI displays all the data security policies provided by a predefined or custom
job role for a selected object. You can update policies for a custom job role and object on this UI, or extend the custom
role's access to other object data. You can also use the access explorer functionality in the work area to view all the
access an individual user has to object data, including access provided by data security policies and access group
membership.

Access Groups UI
You can create and manage access groups and object sharing rules using the Access Groups UI in the Sales and Service
Access Management work area.

You can access the Access Groups UI by clicking the Sales and Service Access Management link under the Tools
heading in the Navigator, then clicking Configure Groups.

Access groups provide a way of providing access to object data based on conditions you define in object sharing
rules. Use access groups to either supplement the data access users receive through their job roles and other security
mechanisms, or to refine the access that's provided by the predefined conditions to sales object data.

There are two types of access groups:

• Custom access groups you create.

You can add members to these groups, define rules to specify the access group members should have to object
data, and edit or delete the groups as required.

• System access groups created for you by Oracle.

System groups provide an alternative way of managing a user's access to data. A system group is created for
each of the predefined job roles in your environment. Predefined object sharing rules associated with each
group provide the same access to data as is provided by the predefined job roles and associated data security
policies.
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Related Topics
• Overview of Security Configuration

• Overview of Data Security Configuration

• Overview of Access Groups

Data Sharing and Visibility  
Review the information in this section to learn how users gain visibility to data for various objects used in the sales
application.

The conditions specified in access group rules or data security policies control visibility to record-level data associated
with a schema object, such as an opportunity. Conditions can use the following components as mechanisms for sharing
data, provided that the sharing mechanism is applicable for the object:

• Team membership

• Territory assignment

• Resource and territory hierarchy

• Business unit assignment

For example, for the Opportunity object, data can be shared through team membership, through the resource hierarchy,
or through territory membership.

Note:  Users assigned the Sales Administrator job role get full access to all object data. This access is based on their
privileges, regardless of where the administrators are in the management hierarchy or their team membership.

How Sales Users Gain Access to Sales Information  
The security reference implementation provided by Oracle determines who can access opportunity information in your
sales organization. While basic information on accounts and contacts is available to all salespeople, your access to sales
data is restricted by your position in the resource hierarchy, membership in the sales team, and ownership.

Whether or not you can access a particular opportunity or a lead depends on your membership in the resource and
territory hierarchies. Here's how you gain access to opportunities. Lead access follows the same pattern. You can access
an opportunity if:

• You create the opportunity.

• You're on the opportunity sales team.

• The opportunity owner or sales team member is your direct or indirect report in the resource hierarchy.

• You're the owner or are a member of the territory assigned to the opportunity.

• You're the owner or member of a parent territory of the territory assigned to the opportunity.

• You're assigned to a territory for the account associated with the opportunity.

• You're assigned to a territory that's a parent of the territory for the account associated with the opportunity.
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Salespeople can see all opportunities related to their accounts but access differs between territory members and
opportunity members:

• An opportunity owner gets full access to the opportunity, which includes the ability to edit as well as add and
remove team members.

• Owners and members of territories or parent territories assigned to the opportunity account get read-only
access to the opportunity and aren't added to the opportunity sales team.

• Owners and members of territories assigned to the opportunity product lines are added as a distinct list
of territories to the opportunity sales team. Owners and members of these territories get full access to the
opportunity. Depending on a profile option, either only the owner or all the members of the territory are added
as resources to the opportunity sales team. Regardless of the access level for these members as a resource on
the opportunity team, they always have full access.

Owners and members of parent territories of the territory assigned to the opportunity aren't added to the
opportunity sales team but they always get full access.

The following diagram illustrates some of the different ways that you can gain access to an opportunity:

• Named agents in the diagram (A, B, and C) can access the opportunity.

• Unnamed agents (highlighted in yellow) can't access the opportunity.

• Sales managers can access the opportunity because a salesperson in their management chain has access.

• Owners of parent territories can access the opportunity through the sales territory hierarchy.
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This diagram shows who in a sales hierarchy can access an opportunity. 

• Agent A can access the opportunity because she created it. When you create an opportunity, you're the initial
owner.

• Agent B can access the opportunity because he's on the sales team.

• Sales managers who are higher up in the management chain can also see the opportunity because access is
provided through the resource hierarchy. The managers of Agent A and Agent B can access the opportunity
information, but agent A and Agent B's colleagues can't.

• Agent C can access the opportunity because he's the owner of the NW territory. The owner of the parent
territory can also access the opportunity.

• Sales administrators can access the opportunity.

Note:  Access using accounts isn't shown in this diagram.
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Special Access
Some access isn't affected by the management hierarchy and membership in sales teams or territories. This special
access includes:

• Administrators: Users assigned the Sales Administrator job role get full access to opportunities and other
objects. This access is based on their privileges, regardless of where the administrators are in the management
hierarchy. Administrators don't have to be on the sales team or members of territories.

• Deal Protection: Salespeople assigned to an opportunity retain the sales credit on an opportunity even if they're
moved to another opportunity.

How Sales Users Gain Access to Digital Sales Objects  
Three objects are specific to Digital Sales: the Sales Contests object, the Sales Goals object, and the Sales KPI object.
Sales users with access to the Digital Sales UIs gain access to these object records through a number of access paths.
Review the following sections to learn who can create and view sales contests, sales goals and sales KPIs.

How Users Gain Access to Sales Contests
You can access data about a sales contest if you're the owner of the contest, are a participant in the contest, or if you're
in the management hierarchy of the owner or a participant. All users who have access to a contest can view data for all
contest participants. Specifically, you can access a sales contest if:

• You create the contest. If you create a contest, you're the contest owner.

Sales Managers, Sales VPs, and the Sales Administrators can create contests. Sales Managers and Sales VPs
can only add participants from their own downward hierarchy to the contest. Sales Administrators can add any
users as participants.

• You're a participant in the contest.

Users added to a contest can view contest data for themselves and for all other participants in the contest.

• The contest owner or participant is your direct or indirect report in the resource hierarchy.

You can view contest details for your reports.

• The user who owns the contest can edit or delete the contest.

• Sales administrators can view all contests and can edit and delete any contest.

Once a contest is running, the contest owner, all participants, and the management hierarchy of the participants receive
access to view the contest. Everyone who gets access to the contest can see the same information. So, for example,
contest participants can see each other's scores on a given KPI, along with statistics such as the daily average score of
each participant.

How Users Gain Access to Sales Goals
Whether or not you can access data about a particular sales goal depends on your membership in the resource
hierarchy and whether or not you're a goal participant. In general, you can access goal data for yourself and for your
direct and indirect reports. Specifically, you can access a goal if:

• You create the goal.
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The user who creates the goal can view the goal and can edit and delete the goal.

Sales Managers, Sales VPs, and the Sales Administrator can create goals. When creating a goal, Sales Managers
and Sales VPs can only add users from their own downward resource hierarchy as participants of the goal. Sales
Administrators can add any users as goal participants.

• You're a participant of the goal.

Each participant can see only their own goal target and progress.

• The goal owner or participant is your direct or indirect report in the resource hierarchy.

Members of the management hierarchy of a goal participant can view goal data and edit targets for goal
participants in their own downward resource hierarchy.

For example, the following figure shows an example sales hierarchy consisting of a sales VP who has three sales
managers reporting to him. Each of the sales managers has a team consisting of two direct reports. If Martin
Conway, the sales VP, sets a goal for all the sales people in his organization, then each member of the hierarchy
has access to goal performance data according to their own position in the hierarchy as follows:

a. (Callout 1) Martin Conway can see goal performance data for each of the three sales teams and for each
participant in each team.

b. (Callout 2) Each sales manager can see goal performance data for their direct reports. So Alex Smith can
see goal data for Peter and Marilyn but not for any of the salespeople on Michael or Mateo's teams.

c. Each individual salesperson can see their own goal performance data but can't see goal data for anyone
else.

• Sales administrators can access all goals and all goal participants, and can edit and delete any goal.
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How Users Gain Access to Sales KPIs
Oracle provides a number of predefined key performance indicators (KPIs) that sales managers can use for creating
goals and contests but you can also create your own KPIs. All users can view KPIs but only sales administrators can
create and manage KPIs. You can access sales KPI data as follows:

• All users can view the predefined sales KPIs.

Sales Managers, Sales Representatives, Sales VPs, and Sales Administrators can view the predefined sales KPIs.

• Only sales administrators can create custom KPIs.

Sales Managers, Sales Representatives, and Sales VPs can view all active, custom sales KPIs.

• Sales administrators can update, delete, and change the status of custom KPIs. Sales administrators can also
change the status of predefined KPIs and can copy predefined KPIs.

Privileges for Digital Sales  
This topic lists the Digital Sales privileges that are assigned to all sales job roles.

If you created custom versions of these roles, review this information to make sure users who are assigned the custom
roles have all the Digital Sales privileges they need.

Note:  Only the Digital Sales-specific privileges are shown for each of the job roles listed in the tables in this topic.
Each role is assigned other privileges that provide access to CX Sales and Fusion Service functionality.

Function Security Policies
These are the function security policies for Digital Sales features and the sales job roles they're assigned to.

Function Security Policy Name (Code) Function Security Policy Description Assigned to Role

Access Feed View (ORA_ZCA_ACCESS_VIEW_
FEEDS_PRIV)
 

Allows access to view feeds. Sales VP
 
Sales Administrator
 

Access Partner Media Toolbar (SVC_ACCESS_
PARTNER_MEDIA_TOOLBAR_PRIV)
 

Allows access to the partner media toolbar. Sales VP
 
Sales Administrator
 

Access View Feed Configurations (ORA_ZCA_
ACCESS_VIEW_FEED_CONFIGURATIONS_PRIV)
 

Allows access to view feed configurations. Sales Administrator

Create Digital Sales Account (ZCM_CREATE_
DIGITAL_SALES_ACCOUNT_PRIV)
 

Allows creating Digital Sales account. Sales Administrator
 
Sales VP
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Function Security Policy Name (Code) Function Security Policy Description Assigned to Role

Create Digital Sales Activity Appointment
(ZMM_CREATE_DIGITAL_SALES_ACTIVITY_
APPOINTMENT_PRIV)
 

Allows creating Digital Sales activity
appointment.

Sales Administrator
 
Sales VP
 

Create Digital Sales Activity Task (ZMM_
CREATE_DIGITAL_SALES_ACTIVITY_TASK_
PRIV)
 

Allows creating Digital Sales activity task. Sales Administrator
 
Sales VP
 

Create Digital Sales Contact (ZCM_CREATE_
DIGITAL_SALES_CONTACT_PRIV)
 

Allows creating Digital Sales contact. Sales Administrator
 
Sales VP
 

Create Digital Sales Opportunity (MOO_
CREATE_DIGITAL_SALES_OPPORTUNITY_PRIV)
 

Allows creating of Digital Sales opportunity. Sales Administrator
 
Sales VP
 

Create Sales Contests (ZCA_CREATE_SALES_
CONTESTS_PRIV)
 

Allows creating sales contests. Sales VP
 
Sales Administrator
 

Create Sales Goals (ZCA_CREATE_SALES_
GOALS_PRIV)
 

Allows creating sales goals. Sales VP
 
Sales Administrator
 

Create Sales Lead Digital Sales (MKL_CREATE_
SALES_LEAD_DIGITAL_SALES_PRIV)
 

Allows creating sales leads for Digital Sales. Sales Administrator
 
Sales VP
 

Create Sales KPI (ZCA_CREATE_SALES_KPI_
PRIV)
 

Allows creating sales KPI. Sales Administrator
 

Create Sales Orchestration (ZCA_CREATE_
SALES_ORCHESTRATION_PRIV)
 

Allows creating a new Sales Orchestration. Sales Administrator
 

Delete Sales Contests (ZCA_DELETE_SALES_
CONTESTS_PRIV)
 

Allows deleting sales contests. Sales VP
 
Sales Administrator
 

Delete Sales Goals (ZCA_DELETE_SALES_
GOALS_PRIV)
 

Allows deleting sales goals. Sales VP
 
Sales Administrator
 

Delete Sales KPI (ZCA_DELETE_SALES_KPI_
PRIV)
 

Allows deleting sales KPI. Sales Administrator
 

Delete Sales Orchestration (ZCA_DELETE_
SALES_ORCHESTRATION_PRIV)

Allows deleting a Sales Orchestration. Sales Administrator
 

Manage Application Metrics (ORA_ZCA_
MANAGE_APPLICATION_METRICS_PRIV)

Allows read, create and update of recent items
information.

Sales Administrator
 

127



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 10
Users and Security

Function Security Policy Name (Code) Function Security Policy Description Assigned to Role

 

Manage Communication Details (ORA_ZCA_
INSIDE_SALES_COMMUNICATION_MGMT_
PRIV)
 

Allows managing communication details
such as create and manage call scripts, email
templates.

Sales Administrator
 

Manage Data Visualization Configuration
(ZCA_MANAGE_DATA_VISUALIZATION_
CONFIGURATION_PRIV)
 

Allows creation, modification and deletion
of data visualization configurations, either
through UI pages or through REST service
calls. For example, a data visualization could be
configured to be displayed as a bar chart.

Sales Administrator
 

Manage Data Visualization Preference
(ZCA_MANAGE_DATA_VISUALIZATION_
PREFERENCE_PRIV)
 

Allows creation, modification and deletion of
the user preferences for the data visualization
configuration. For example, a user might prefer
to view a data visualization configured initially
as a horizontal bar chart to be displayed as a
vertical bar chart instead.

Sales Administrator
 
Sales VP
 

Manage Feed Configurations (ORA_ZCA_
MANAGE_FEED_CONFIGURATIONS_PRIV)

Allows create, delete and update of feed
configurations.

Sales Administrator
 

Manage Omnichannel Presence and Availability
(SVC_MANAGE_OMNICHANNEL_PRESENCE_
AND_AVAILABILITY_PRIV)
 

Allows management of the omnichannel
availability for new work, presence menu, and
indicator.

Sales VP
 

Run Sales Orchestration Scheduled Jobs (ZCA_
RUN_SALES_ORCHESTRATION_SCHEDULER_
PRIV)

Allows running, scheduling and monitoring
Sales Orchestration related scheduled jobs.

Sales Administrator
 

Update Sales Contests (ZCA_UPDATE_SALES_
CONTESTS_PRIV)
 

Allows updating sales contests. Sales VP
 
Sales Administrator
 

Update Sales Goals (ZCA_UPDATE_SALES_
GOALS_PRIV)
 

Allows updating sales goals. Sales VP
 
Sales Administrator
 

Update Sales KPI (ZCA_UPDATE_SALES_KPI_
PRIV)
 

Allows updating sales KPI. Sales Administrator
 

Update Sales Orchestration (ZCA_UPDATE_
SALES_ORCHESTRATION_PRIV)

Allows updating an existing Sales
Orchestration.

Sales Administrator
 

View Account from Digital Sales (ZCM_VIEW_
DIGITAL_SALES_ACCOUNT_PRIV)
 

Allows viewing of account from Digital Sales. Sales Administrator
 
Sales VP
 

View Activity from Digital Sales (ZMM_VIEW_
DIGITAL_SALES_ACTIVITY_PRIV)
 

Allows viewing of activity from Digital Sales. Sales Administrator
 
Sales VP
 

View Contact from Digital Sales (ZCM_VIEW_
DIGITAL_SALES_CONTACT_PRIV)
 

Allows viewing of contact from Digital Sales. Sales Administrator
 
Sales VP
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Function Security Policy Name (Code) Function Security Policy Description Assigned to Role

View Communication Details (ORA_ZCA_
INSIDE_SALES_COMMUNICATION_PRIV)
 

Allows viewing communication details such as
email status, call scripts.

Sales Administrator
 

View Data Visualization Configuration
(ZCA_VIEW_DATA_VISUALIZATION_
CONFIGURATION_PRIV)
 

Allows viewing of data visualization
configurations.

Sales Administrator
 
Sales VP
 

View Digital Sales (ZCA_VIEW_DIGITAL_SALES_
PRIV)
 

Allows viewing of the Digital Sales application. Sales VP
 
Sales Administrator
 

View My Day (ZBS_VIEW_MY_DAY_PRIV)
 

Allows viewing of various record types within a
single page.

Sales VP
 
Sales Administrator
 

View Navigator Menu (ORA_ZCA_VIEW_
NAVIGATOR_MENU_PRIV)
 

Allows viewing navigator metadata information. Sales VP
 
Sales Administrator
 

View Opportunity from Digital Sales (MOO_
VIEW_DIGITAL_SALES_OPPORTUNITY_PRIV)
 

Allows viewing of opportunity from Digital
Sales.

Sales Administrator
 
Sales VP
 

View Quotes and Quote Lines in Digital Sales
(ZCA_VIEW_DIGITAL_SALES_QUOTES_PRIV)
 

Allows viewing of quotes and quote lines in
Digital Sales.

Sales Administrator
 
Sales VP
 

View Sales Contests (ZCA_VIEW_SALES_
CONTESTS_PRIV)
 

Allows viewing sales contests. Sales VP
 
Sales Administrator
 

View Sales Goals (ZCA_VIEW_SALES_GOALS_
PRIV)
 

Allows viewing sales goals. Sales VP
 
Sales Administrator
 

View Sales KPI (ZCA_VIEW_SALES_KPI_PRIV)
 

Allows viewing sales KPI. Sales VP
 
Sales Administrator
 

View Sales Lead from Digital Sales (MKL_VIEW_
DIGITAL_SALES_SALES_LEAD_PRIV)
 

Allows viewing of sales lead from Digital Sales. Sales Administrator
 
Sales VP
 

View Sales Orchestration (ZCA_VIEW_SALES_
ORCHESTRATION_PRIV)

Allows viewing the list of Sales Orchestrations
or a particular Sales Orchestration.

Sales Administrator
 
Sales VP
 

View Smart Actions (ZCA_VIEW_SMART_
ACTIONS_PRIV)
 

Allows read and view access to Smart Actions
Framework data.

Sales VP
 
Sales Administrator
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Function Security Policy Name (Code) Function Security Policy Description Assigned to Role

 

View Text Analysis Intelligence (ZCA_VIEW_
INTERACTION_EVENT_TEXT_ANALYSIS_PRIV)
 

Allows user to view intelligence derived from
text analysis.

Sales VP
 
Sales Administrator
 

View Web Activity (ZCA_VIEW_WEB_ACTIVITY_
PRIV)
 

Allows viewing web activities synchronized
from B2B Marketing.

Sales Administrator
 
Sales VP
 

When you're providing your users with access to Digital Sales functionality, here are a few things to be aware of:

• If you want sales administrators to create and manages rollups, assign the Manage Rollup Metrics privilege to a
custom sales administrator job role, then assign the role to relevant users. The Manage Rollup Metrics privilege
isn't assigned to the predefined job roles by default. For additional information see the Rollups chapter in this
guide.

• Administrators must be assigned the Manage Signal Definitions privilege as well as the KPI privileges to create
and manage custom KPIs. The Sales Administrator job role is assigned all these privileges by default.

Data Security Policies
These are the data security policies for Digital Sales objects and the job roles they're assigned to.

Data Security Policy Name Data Resource Condition Permission Assigned to Role

Grant on Sales Contests
 

Sales Contests
 

Access the sales contests
for table ZCA_CONTESTS
where user is participant of
contest
 

Read; View Sales Contest
 

Sales VP
 

Grant on Sales Contests
 

Sales Contests
 

Access the sales contests
for table ZCA_CONTESTS
where user is owner or
creator of contest
 

Read; View Sales Contest
 
Update Sales Contest
 
Delete Sales Contest
 

Sales VP
 

Grant on Sales Contests
 

Sales Contests
 

Access the sales contests
for table ZCA_CONTESTS
where their subordinate is a
participant of contest
 

Read; View Sales Contest
 

Sales VP
 

Grant on Sales Contests
 

Sales Contests
 

All values
 

Read; View Sales Contest
 
Update Sales Contest
 
Delete Sales Contest
 

Sales Administrator
 

Grant on Sales Goals
 

Sales Goals
 

Access the sales goals for
table ZCA_GOALS where
user is participant of goal
 

Read; View Sales Goal
 

Sales VP
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Data Security Policy Name Data Resource Condition Permission Assigned to Role

Grant on Sales Goals
 

Sales Goals
 

Access the sales goals for
table ZCA_GOALS where
user is owner or creator of
goal
 

Read; View Sales Goal
 
Update Sales Goal
 
Delete Sales Goal
 

Sales VP
 

Grant on Sales Goals
 

Sales Goals
 

Access the sales goals for
table ZCA_GOALS where
their subordinate is a
participant of goal
 

Read; View Sales Goal
 
Update Sales Goal
 

Sales VP
 

Grant on Sales Goals
 

Sales Goals
 

All values
 

Read; View Sales Goal
 
Update Sales Goal
 
Delete Sales Goal
 

Sales Administrator
 

Grant on Sales Goal
Participants
 

Sales Goal Participants
 

Access the sales goal
participants for table ZCA_
GOAL_PARTICIPANTS
where user is participant of
goal
 

Read; View Sales Goal
Participants
 

Sales VP
 

Grant on Sales Goal
Participants
 

Sales Goal Participants
 

Access the sales goal
participants for table ZCA_
GOAL_PARTICIPANTS
where user is owner or
creator of goal
 

Read; View Sales Goal
Participants
 
Update Sales Goal
Participants
 
Delete Sales Goal
Participants
 

Sales VP
 

Grant on Sales Goal
Participants
 

Sales Goal Participants
 

Access the sales goal
participants for table ZCA_
GOAL_PARTICIPANTS
where their subordinate is a
participant of goal
 

Read; View Sales Goal
Participants
 
Update Sales Goal
Participants
 
Delete Sales Goal
Participants
 

Sales VP
 

Grant on Sales Goal
Participants
 

Sales Goal Participants
 

All values
 

View Sales Goal
Participants
 
Update Sales Goal
Participants
 
Delete Sales Goal
Participants
 

Sales Administrator
 

Grant on Sales KPI
 

Sales KPI
 

All values
 

View Sales KPI
 

Sales Administrator
 
Sales VP
 

Grant on Sales KPI Sales KPI All values Delete Sales KPI Sales Administrator
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Data Security Policy Name Data Resource Condition Permission Assigned to Role

    
Update Sales KPI
 
Update Sales KPI Restricted
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11  Get Ready to Create Sales Users

What You Need to Understand Before Creating Sales
Users  
Unlike setup users you created earlier, you must create sales users as resources who are part of the sales resource
hierarchy.

You can create sales users either in the Manage Users task UI or by resource import. You can't create resources in the
Security Console.

Creating sales users creates rudimentary Human Resources records, even if you aren't implementing HCM. Before you
create sales users, you must create the elements of the resource hierarchy they are a part of. And you must create the
provisioning rules that automatically provide the sales users you create with the security permissions they need to do
their jobs.

Sales Resource Hierarchy
The sales resource hierarchy shows up as the org chart in the Resource Directory. But the hierarchy is more than a pretty
picture. It determines who can see what sales information and forms the basis of your forecasting setup. For example,
sales managers can view and forecast the opportunities of their subordinates, but not the opportunities managed by
others. Oracle supports matrix management, so the resource hierarchy you build doesn't have to match the formal
reporting hierarchy in the Oracle Global Human Resources Cloud or other Human Resources applications.

To give you an idea of what a sales resource hierarchy looks like, here's a screenshot of a portion of Vision Corp.'s
Resource Directory. Aside from their names, all users in the hierarchy must have:

• A resource role (highlighted by callout 1)

The resource role describes the role that each resource plays in the organization. It displays right underneath
the user name in the Resource Directory available in the CX Sales UI and elsewhere. Resource roles are also
used as the primary condition in the role-provisioning rules. You can create resource roles either in Setup
Assistant or manually, using the setup task Manage Resource Roles.

• A resource organization (callout 2)

You must create a resource organization for every manager. Each individual contributor who isn't a manager
automatically inherits the manager's organization. The name of the resource organization need not be any
formal department name, but you should avoid using manager names to accommodate hierarchy changes. You

133



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 11
Get Ready to Create Sales Users

can create resource organizations as you are create users in the UI, or you can create them when you import
users using the Excel import macro.

The application builds the resource organization hierarchy using the management hierarchy that you specify when you
create users. You must enter a manager for each user you create, except for the top of the resource hierarchy.

Sales Resource Roles Provided by Oracle
Oracle provides you with these standard resource roles and the appropriate job roles for each:

• Channel Account Manager

• Channel Operations Manager

• Channel Sales Manager
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• Chief Executive Officer

• Contract Administrator

• Contract Manager

• Customer Data Steward

• Data Steward Manager

• Partner Administrator

• Partner Sales Manager

• Partner Salesperson

• Sales Administrator

• Sales Lead Qualifier

• Sales Manager

• Salesperson

• Sales Restricted User

• Sales Setup User

• Sales Vice President

Except for the Chief Executive Officer and the Salesperson, there's a corresponding job role with the same name for
each of the resource roles provided by Oracle. The job role corresponding to the Salesperson resource role is Sales
Representative. The Chief Executive Officer is usually assigned the Sales Vice President job role.

Role-Provisioning Rules Setup Assistant Creates Automatically
If you used Setup Assistant, you're in luck. Setup Assistant automatically creates the role-provisioning rules for users
with all the standard sales resource roles. The rules provision user with the job roles and abstract roles they need.

If you didn't use Setup Assistant, perhaps because you're implementing multiple services at the same time, then you
must create all of the role-provisioning rules manually. You create the rules using the Manage HCM Role Provisioning
Rules task.

Here's a list of the role-provisioning rules Setup Assistant creates, the condition that triggers the provisioning, and the
job and abstract roles each rule provisions. You can get a description of each job and abstract role from the Security
Reference for CX Sales and Fusion Service guide.

Provisioning Rule Name Condition Job or Abstract Roles
Provisioned

UI Access

Channel Account Manager
 

HR Assignment Status is Active
 
Resource Role is Channel Account
Manager
 

Channel Account Manager
 
Resource
 

CX Sales UIs

Channel Sales Manager
 

HR Assignment Status is Active
 
Resource Role is Channel Sales
Manager
 

Channel Sales Manager
 
Resource
 

CX Sales UIs

Channel Operations Manager
 

HR Assignment Status is Active
 

Channel Operations Manager
 

CX Sales UIs
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Provisioning Rule Name Condition Job or Abstract Roles
Provisioned

UI Access

Resource Role is Channel
Operations Manager
 

Resource
 

Chief Executive Officer
 

HR Assignment Status is Active
 
Resource Role is Chief Executive
Officer
 

Sales VP
 
Resource
 

CX Sales UIs

Contract Administrator
 

HR Assignment Status is Active
 
Resource Role is Contract
Administrator
 

Contract Administrator
 
Resource
 

CX Sales UIs

Contract Manager
 

HR Assignment Status is Active
 
Resource Role is Contract Manager
 

Contract Manager
 
Resource
 

CX Sales UIs

Customer Data Steward
 

HR Assignment Status is Active
 
Resource Role is Customer Data
Steward
 

Customer Data Steward
 
Resource
 

CX Sales UIs

Data Steward Manager
 

HR Assignment Status is Active
 
Resource Role is Data Steward
Manager
 

Data Steward Manager
 
Resource
 

CX Sales UIs

Partner Administrator
 

Resource Role is Partner
Administrator
 

Partner Administrator
 

CX Sales UIs

Partner Sales Manager
 

Resource Role is Partner Sales
Manager
 

Partner Sales Manager
 

CX Sales UIs

Partner Sales Representative
 

Resource Role is Partner
Salesperson
 

Partner Sales Representative
 

CX Sales UIs

Sales Administrator
 

HR Assignment Status is Active
 
Resource Role is Sales
Administrator
 

Sales Administrator
 
Resource
 

Both CX Sales and Digital Sales UIs

Sales Lead Qualifier
 

HR Assignment Status is Active
 
Resource Role is Sales Lead
Qualifier
 

Sales Lead Qualifier
 
Resource
 

CX Sales UIs

Sales Manager
 

HR Assignment Status is Active
 
Resource Role is Sales Manager
 

Sales Manager
 
Resource
 

Both CX Sales and Digital Sales UIs

136



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 11
Get Ready to Create Sales Users

Provisioning Rule Name Condition Job or Abstract Roles
Provisioned

UI Access

Sales Representative
 

HR Assignment Status is Active
 
Resource Role is Salesperson
 

Sales Representative
 
Resource
 

Both CX Sales and Digital Sales UIs

Sales Restricted User
 

HR Assignment Status is Active
 
Resource Role is Sales Restricted
User
 

Sales Restricted User
 
Resource
 

CX Sales UIs

Sales Setup User
 

HR Assignment Status is Active
 
Resource Role is Sales Setup User
 

Application Implementation
Consultant
 
IT Security Manager
 
Application Diagnostics
Administrator
 
Sales Administrator
 
Sales Analyst
 

Both CX Sales and Digital Sales UIs

Sales Vice President
 

HR Assignment Status is Active
 
Resource Role is Sales Vice
President
 

Sales VP
 
Resource
 

Both CX Sales and Digital Sales UIs

Contingent Worker
 

HR Assignment Status is Active
 
System Person Type is Contingent
Worker
 

Contingent Worker
 

CX Sales

Employee
 

HR Assignment Status is Active
 
System Person Type is Employee
 

Employee
 

Not applicable.

You create sales users as employees. So, two role-provisioning rules come into play: the rule triggered by the users'
resource roles and the rule triggered by the fact that they are employees. For example, when you create a user with the
Sales Manager resource role provided by Oracle, the application automatically provisions the Sales Manager job role
and the Resource abstract role. Because you're creating the user as an employee, the application also provisions the
Employee abstract role.

Here's a diagram that shows the two rules that are triggered when you create an employee resource with the Sales
Manager resource role.

137



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 11
Get Ready to Create Sales Users

Resource Roles That Provide Access to Digital Sales UIs
When you assign these four resource roles to resources, the role provisioning-rules created automatically by the Setup
Assistant provide access to both the Digital Sales and CX Sales UIs.

• Sales Representative

• Sales Manager

• Sales VP

• Sales Administrator

When You Need Additional Resource Roles and Role-Provisioning Rules
You may need to create additional resource roles either by entering them in the Setup Assistant, or using the Manage
Resource Roles task for any of these reasons:

• You want other job titles to display for your users.

For example, if you want a user to display the Sales Evangelist title in the organization chart, you must create
the Sales Evangelist resource role and a provisioning rule for it.

• You want to provision some users with special privileges.

For example, if one of the sales managers in your organization also acts as a sales administrator, you provision
her with both job roles. To do this, you must create a new resource role and a provisioning rule to go along with
it.
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• You want to create a sales administrator who is a manager.

The Sales Administrator resource role provided by Oracle is intended for an individual contributor (member).
If your sales administrator manages others, then you must create a separate manager resource role and a
provisioning rule to go with it.

Each time you create a resource role, you must also create a corresponding role-provisioning rule. For example, if you
created the Sales Support resource role, then you must create a role-provisioning rule to provision one or more of the
available job roles and the Resource abstract role. If you created the resource roles in Setup Assistant, then the rules
are created for you automatically. If you create the resource role using the Manage Resource Roles task, then you must
create the role-provisioning rules manually.

For information on how to change the resource role for a user and make other organizational changes, see the topic
How do I change user resource roles when job assignments change? and the rest of the User Management chapter in the
Securing Sales and Fusion Service guide.

How Setup Assistant Gets You Ready to Create Sales
Users  
Here's how Setup Assistant helps you get ready to create sales users and the setups you may need to complete
manually.

Note:  If you're implementing sales on top of an existing HCM application, salespeople are already created as
employees and users. In this case, you must manually convert the employee into a resource and provision them with
the job roles they need. Make an Employee a Sales Resource

What Setup Assistant Does for You What You May Need to Do Manually

Creates additional resource roles. All you
do is enter their names.
 

After you run Setup Assistant, you can create additional resource roles manually in Setup and
Maintenance, using the Manage Resource Roles task:
 

• Offering: Sales

• Functional Area: Users and Security

• Task: Manage Resource Roles

Creates the role-provisioning rules for the
standard resource roles provided by Oracle
and for the additional resource roles that
you created in Setup Assistant.
 

You can also create additional provisioning rules for any resource roles you create outside Setup
Assistant in Setup and Maintenance, using the task Manage HCM Role Provisioning Rules:
 

• Offering: Sales

• Functional Area: Users and Security

• Task: Manage HCM Role Provisioning Rules

Sets the resource organization that you
entered for the CEO as the top of the
resource organization hierarchy.
 

If you need to change the name of the resource organization after you run Setup Assistant, you can
edit it in Setup and Maintenance, using the Manage Internal Resource Organizations task:
 

• Offering: Sales
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What Setup Assistant Does for You What You May Need to Do Manually

Setup Assistant eliminates two manual
steps: creating the resource organization
and then using the Manage Resource
Organization Hierarchies task to specify
that resource organization as the top
of the Internal Resource Organization
Hierarchy.
 

• Functional Area: Users and Security

• Task: Manage Internal Resource Organizations

Prevents you from accidentally entering
duplicate email addresses for users
by setting the system profile Enable
Validation of User Work Email.
 

Nothing.
 

Related Topics
• Create Role-Provisioning Rules for the Additional Resource Roles

• How can I change the name of the top resource organization and other resource organizations?

• Create a Resource Organization

• Designate an Organization as the Top of the Sales Hierarchy

• Create Additional Resource Roles

Overview of Setup Before You Create Sales Users  
Because the Setup Assistant does most of the required prep work for you, only the first setup step listed here is required
for users who will access Digital Sales UIs. It's also recommended that you provision all your users with a custom version
of the Employee abstract role (step 2). Optionally, you can create additional resource roles and provisioning rules
outside the Setup Assistant.

Step Applies To Description Navigation Where to Get More Details

1 Both Digital Sales and CX
Sales

Create a custom version of
the Employee abstract role
and provision the custom
role to your employees
to avoid unnecessary
licensing charges.

Various See all the topics in the
section:
How to Configure the
Employee Abstract Role for
Sales Users
 

2
 

Both Digital Sales and CX
Sales

If you don't want to run
Setup Assistant again,
 you can create additional
resource roles manually
using the Manage Resource
Roles task.
 

Setup and Maintenance >
Sales > Users and
Security > Manage
Resource Roles
 
 

See the topic: Create
Additional Resource Roles
 

3 Both Digital Sales and CX
Sales

Create provisioning rules
for any resource roles that
you created outside Setup
Assistant, by using the

Setup and Maintenance >
Sales > Users and
Security > Manage HCM
Role Provisioning Rules

See the topic: Create Role-
Provisioning Rules for the
Additional Resource Roles.
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Step Applies To Description Navigation Where to Get More Details

task Manage HCM Role
Provisioning Rules.

For information on how to manage sales users after you create them initially, see the topic How do I change user
resource roles when job assignments change? and the rest of the User Management chapter in the Securing Sales and
Fusion Service guide.

Create Additional Resource Roles  
Use these steps to review the resource roles provided by Oracle and to create any additional resource roles you need.
Remember that the resource role is only a title. So, if you create a resource role, you must also create the provisioning
rule to go with it.

1. Open the task Manage Resource Roles from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Resource Roles

2. To review all the existing resource roles, click Search without entering any search criteria.

All the available resource roles are listed. Roles that are predefined by Oracle are labeled System.
3. Here's how to create a resource role:

a. Click Create.
b. In the Role Name field, enter the name of the resource role as you want it to appear in the application UI,

for example, Inside Sales.
c. In the Role Code field, enter a unique internal name in capital letters. No spaces are permitted, but you

can use the underscore character (_) instead. For example, enter INSIDE_SALES.
d. If the resource role belongs to a manager, select the Manager option. If the resource role belongs to an

individual contributor, such as an inside sales representative, then select the Member option.
e. From the Role Type list, select Sales to classify the role that you are creating.

4. Click Save and Close.

Related Topics
• Make an Employee a Sales Resource

Create Role-Provisioning Rules for the Additional
Resource Roles  
Create the rules that provision the required security permissions for any new resource roles that you created outside the
Setup Assistant. For all internal sales users, including sales administrators, you must add the Resource abstract role in
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addition to the required job roles. The Resource abstract role permits the users to access the Resource Directory. Don't
add the Resource abstract role for partner roles.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage HCM Role Provisioning Rules

2. On the Manage Role Mappings page, click Create.
3. On the Create Role Mapping page, Mapping Name field, enter a name that helps you identify the mapping.
4. In the Conditions section, enter these conditions:

Field Entry

Resource Role
 

Select the resource role that you want to provision.
 

HR Assignment Status
 

Select Active. This additional condition ensures that the provisioned roles are automatically
removed if the user is terminated in Global Human Resources.
 

5. In the Associated Roles region, click Add to add the job roles you want to provision.
6. For all internal sales users, add the Resource abstract role. Don't add this role for partner roles.
7. Make sure that the Autoprovision option is selected for all the roles.
8. Click Save and Close.

How to Configure the Employee Abstract Role for Sales
Users  
The Employee abstract role is assigned to all sales users who are employees but many of the privileges it provides aren’t
required if you’ve implemented only CX Sales.

Although these privileges aren’t used, they can incur licensing charges. For this reason, Oracle recommends that you
create a custom version of the Employee role that doesn’t include these unnecessary privileges and provision the
custom role to your sales users. This task involves these steps.

• Copy the predefined Employee role to create a custom version of the role.

See the topic: Create a Custom Employee Role for Sales Users.

• Edit the custom employee role to remove unnecessary privileges.

See the topic: How do I remove unneeded privileges from my custom employee abstract role?.

• Edit the predefined Employee provisioning rule so that it assigns the custom employee role instead of the
predefined Employee role to all users created as employees.

Test the changes you've made to the rule and then implement it for all your users. See the topic: Provision the
Custom Employee Role to Users.
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Create a Custom Employee Role for Sales Users  
Create a custom employee abstract role that contains only the privileges sales users require using these steps.

1. Sign in to the sales application as a user who has the IT Security Manager job role.
2. Navigate to the Security Console (Navigator  > Tools  > Security Console).
3. On the Roles tab, search for and select the Employee abstract role (ORA_PER_EMPLOYEE_ABSTRACT).
4. In the search results, select Copy Role from the Actions menu of the Employee role.
5. In the Copy Options dialog box, select the Copy top role and inherited roles option, then click Copy Role.

Note:  When you select the Copy top role and inherited roles option, you copy not only the role you've selected,
but also all of the roles in its hierarchy. When inherited duty roles are copied, you can edit them without affecting
other roles in the source role hierarchy.

6. On the Copy Role: Basic Information page, review and edit the Role Name, Role Code, and Description values, as
appropriate.

The role name and code have the default prefix and suffix for copied roles specified on the Roles subtab of the
Security Console Administration tab, but you can overwrite these values for the role that you're copying. For
example, you might want to name the role Employee Custom Sales. Any roles inherited by the copied role are
unaffected by any name changes that you make here.

7. Click Next.
8. Click the Summary train stop.
9. On the Summary page, click Submit and Close, then click OK to close the confirmation message.
10.Review the progress of your role copy operation on the Role Copy Status subtab of the Security Console

Administration tab. Once the status is Complete, you can edit the copied role.

How do I remove unneeded privileges from my custom employee
abstract role?  
By default, some privileges are assigned to the Employee abstract role that aren’t used by Sales users. You can delete
these privileges from the custom employee role you previously created.

To delete privileges that are assigned directly to the custom employee role, edit the custom employee role you created.
If a privilege is inherited from a duty in the custom employee role hierarchy, you've to edit the custom duty role to
remove the privilege.

1. On the Roles tab of the Security Console, search for and select the custom employee role you’ve just created, for
example, Employee Custom Sales.

2. In the search results, select the Edit Role option from the Actions menu of the Employee Custom Sales role.
3. Click Next.

On the Edit Role: Function Security Policies page, all the privileges assigned directly to the Employee Custom Sales
role are listed.
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4. To display the privileges the custom employee role inherits from duty roles in its hierarchy, scroll to the end of the
page, then click Load Inherited Policies.
All the privileges the custom employee role has are now listed:

◦ If the Inherited from Role column is blank for a privilege, the privilege is assigned directly to the employee
custom role and can be deleted on this page.

◦ If the Inherited from Role column isn’t blank, you have to edit the custom duty role listed to delete a
privilege from it.

5. Delete the privileges that are assigned directly to the Employee Custom Sales role that aren’t required for sales users.
a. Delete the following privileges by selecting each privilege in turn, then clicking Delete.

- Manage Reputation Scores (HWR_REPUTATION_EE_PRIV)
- Manage Social Roles (HWR_SOCIAL_ROLES_EE_PRIV)

b. Click Yes in the Warning dialog box to confirm the deletion.
c. Click the Summary train stop.
d. On the Edit Role: Summary page, verify both privileges you deleted are listed as Removed in the Function

Security Policies row, click Save and Close, then click OK.
6. Now delete the excess privileges that are inherited by the Employee Custom Sales role from duty roles in its

hierarchy.
a. On the Roles tab of the Security Console, edit each duty role shown in the table and remove the privilege

listed.

Note:  The default prefix and suffix for copied roles is specified on the Roles subtab of the Security
Console Administration tab. By default, the role-name suffix is Custom but this might differ in your
environment.

Privilege to Remove Custom Duty Role to Edit

Manage Expense Report Expense Entry Custom

Create Performance Document by
Worker

Performance Management Worker Custom

Provide Performance Evaluation
Feedback

Performance Management Worker Custom

View Performance Information on
Worker Dashboard

Performance Management Worker Custom

Access Time Work Area Time and Labor Worker Custom

Manage Requisition Requisition Self Service User Custom

Access Learning Common
Components

Access Learning Common Components Custom

b. Once you’ve deleted each privilege, review your changes to the custom duty role on the Edit Role Summary
page and save them.

7. Finally, edit the Employee Custom Sales role on the Security Console.
Navigate to the Function Security Policies page and verify that all the excess privileges, both those assigned directly
to the role and those inherited from other roles in the hierarchy, have been removed.
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Provision the Custom Employee Role to Users  
Modify the predefined provisioning rule for the Employee abstract role so that it assigns users the custom employee
role you created instead of the predefined Employee role. Test your configuration for an individual user, then apply the
change to all users.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage HCM Role Provisioning Rules

2. On the Role Mappings page, enter Employee in the Mapping Name field, then click Search.
3. In the Search Results area, click the Employee mapping.
4. On the Edit Role Mapping: Employee page, make the following change in the Associated Roles region:

a. Select the Employee row, then click the Remove icon to remove the predefined Employee role.
b. Click the Add Row icon to add a new row.
c. In the Role Name field, search for your custom employee abstract role, for example, Employee Custom

Sales, then add the role.
d. Select the Autoprovision option for the role.
e. Click Save and Close, then click OK.

5. Click Done on the Role Mappings page.
6. Test that the role provisioning rule updates are working correctly for a single employee user:

a. Open the Search Person page ( Navigator > My Team  > Users and Roles).
b. Search for and select a user who was created as an employee person type.

The Edit User page for the user opens.
c. In the Roles region, click Autoprovision Roles. Any roles for which the user qualifies automatically appear

in the Role Requests table with the status Add Requested. Your custom employee role, Employee Custom
Sales, should be listed.

Note:  If the Employee role was initially provisioned to a user manually rather than through automatic role
provisioning, the change to the provisioning rule won't remove the original Employee role from the user.

d. Click Save and Close.
7. Now navigate to the Scheduled Processes work area (Navigator > Tools > Scheduled Processes ) and run the

Autoprovision Roles for All Users process.
This process compares all current user role assignments with all current role mappings and creates appropriate
autoprovisioning requests. The process can take some time to complete depending on the number of users
impacted.
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12  Create Sales Users in the UI

Setup Overview  
Setup Assistant creates the CEO at the top of the resource hierarchy for you. You have the option of importing the rest
of the sales users in the hierarchy and skip this chapter. However, you may want to create some users manually in the
UI for testing. Because you must specify the manager for each user you create, start creating users from the top of the
corporate hierarchy and work your way down.

Here are the steps for creating sales users in the UI.

Note:  If you're implementing sales on top of an existing HCM application, salespeople are already created as
employees and users. In this case, you must manually convert the employee into a resource and provision them with
the job roles they need. Make an Employee a Sales Resource

Step Description Navigation Where to Get More Details

1
 

Before you create users, review
your user notifications and
preferences setup. You don't want
to accidentally spam anyone.
 

Setup and Maintenance >
Sales > Users and Security >
Manage Applications Security
Preferences
 

See: Overview of User Account
Preferences Setup
 

2
 

Create the users. Work your way
down the hierarchy because you
must select the manager for every
user you create.
 
When you create a manager user,
 you must also create his or her
resource organization. Users
who aren't managers inherit the
resource organization of their
managers.
 

Setup and Maintenance > Sales >
Users and Security > Manage
Users
 

See the topic: Create Sales Users in
the UI
 

3
 

If you're using some of these
users for testing your setups, then
you must manually reset their
passwords in the Security Console.
 
Make sure that you have turned off
notifications for password resets,
 unless you want the user to be
notified that you manually reset
the password.
 

Setup and Maintenance >
Sales > Users and Security >
Manage Applications Security
Preferences
 

See: Overview of User Account
Preferences Setup
 

After creating the first few users in the top of your hierarchy, import the rest as described in the next chapter.
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Related Topics

Example of a Sales Resource Hierarchy  
Here's an example of the sales resource hierarchy created by the fictitious Vision Corp. The company limits its pilot
implementation to the US sales organization, but starts the hierarchy at the very top, with the Chief Executive Officer.

Starting with the CEO makes it easy to add other branches of the organization in the future. You create the first user at
the top of the hierarchy in Setup Assistant or in the UI. You can import the rest. But creating a few users in the UI is a
good way to check if the provisioning rules work correctly before you import.

Vision Corp. creates only the first user in the UI: William Taylor, Chief Executive Officer.
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Create Sales Users in the UI  
Here's how to create sales users in the UI. The procedure is slightly different for managers and individual contributors:

• You must assign each manager with his or her own resource organization. You can create the resource
organization while creating the manager.

• Each individual contributor automatically inherits the manager's resource organization.

The application determines who's a manager from the resource role you assign to the user.

1. There are two ways to get to the UI where you create users:

◦ In Setup and Maintenance, go to the following:

- Offering: Sales
- Functional Area: Users and Security
- Task: Manage Users

◦ In the Navigator, click Users and Roles under the My Team heading.

2. On the Search Person page, click Create.
3. On the Create User page, Personal Details region, enter the user's name and a unique email address.

The application sends all notifications regarding the user account to this email address unless you turn off
notifications in the Security Console work area.

Tip:  If you want ensure that users are never notified by email, you can change the domain of the email
addresses to any of the special discard email domains provided by Oracle. For example, you can substitute
@discard.mail.us1.cloud.oracle.com. See the Implementation Reference guide for details.

After you create the user, you can no longer update the email address in the Manage Users work area. You must
instead update the email address on the Users tab in the Security Console work area or using Import Management.

4. The application prepopulates today's date in the Hire Date field and uses that date as the start date for the resource.

If you're planning to use quotas, then you must make sure that the hire date is a date before the start of the first
quota period. For example, if you're allocating monthly quotas for fiscal year July 01, 2019 to June 30, 2020, then you
must enter a hire date of 7-1-2019 or earlier. You can't change the hire date after you create the user.

5. In the User Details region, enter the user name.

If you leave the User Name field blank, then the application automatically creates a user name for you. By default,
the application uses the email as the user name. You can select other default user name formats, such as first name
initial and last name, in the Security Console work area.

6. If you didn't disable notifications in the Security Console, you can select the Send user name and password option.
Selecting the option sends users a URL they can use to reset their password and sign in. The application sends the
email notification immediately after you save the user record for the first time. This option is available only before
you save. After you save the record, you must instead use the Security Console to reset the password and send the
notification.
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7. Make these selections in the Employment Information region:

Field What to Select

Person Type
 

Employee
 

Legal Employer
 

Your company name followed by the suffix LE.
 

Business Unit
 

Your company name followed by the suffix LE BU.
 

The legal employer and the business unit names aren't visible in the sales application, so the names don't have to
correspond to actual entities in your company.

Note:  The sales application doesn't use the remaining fields in the Employment Information region: Job, Grade,
Department, Location, Mail Stop, and Manager.

8. Make these entries in the Resource Information region:
a. From the Resource Role list, select the role the user plays in the resource organization. For example, select

either the Sales Representative or the Sales Manager resource role.
b. From the Reporting Manager list, select the user's manager.
c. If the user you're creating is a manager, then you must enter a resource organization for the user in the

Organization field.

Here's how you create the resource organization from this step:

i. Click Create link at the end of the Organization list.

Make these entries in the Create Organization window:
ii. Enter the organization name.

iii. Make sure the Sales option is selected and click OK.
d. If the user you're creating isn't a manager, then the resource organization is automatically copied from the

manager.
9. Click Autoprovision Roles.

The application provisions the job and abstract roles according to the role provisioning rules.

10.Click Save and Close.

The application creates the user. If you selected the Send User Name and Password option, then the application
also sends the email with the URL the user can use to sign in to the application for the first time.

Related Topics
• Modify the Provisioning Rules for Digital Sales
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Can I change the user name after creating a user?  
While both the Users tab of the Security Console and the Manage Users task permit you to change the user name,
changing it isn't a good idea. Changing the user name requires extra setup for Oracle BI Answers.

Oracle BI Answers, the embedded reporting tool for building and modifying reports, creates a separate GUID from the
user name when you create a user. If you change the user name, then you must update the BI Answers GUID by running
the Rename Accounts Self-Service utility. You can download the utility from My Oracle Support article Oracle Fusion BI:
Self-Service Forget Accounts and Rename Accounts Tools (Doc ID 2635720.1). If you used the user name in any script,
then you must update that script as well.

Reset Passwords for Others  
Use the Security Console to reset passwords for other users. Only setup users, and other users with the IT Security
Manager job role, can access the Security Console. This setup applies to both CX Sales and Digital Sales.

All users can reset their own passwords by clicking their user name or image, and selecting the Set Preferences link in
the Settings and Actions menu. They can also reset their passwords by using Forgot Password on the sign-in page.

1. Open the Security Console. You have two options:

◦ In Setup and Maintenance, go to the following:

- Offering: Sales
- Functional Area: Company Profile
- Show: All Tasks
- Task: Manage Applications Security Preferences

◦ Click Navigator > Tools > Security Console.

2. You can ignore and close any warnings regarding the scheduling of the Import Users and Roles Application
Security Data job.

3. Click the Users tab.
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4. Search for the user using one of the following:

◦ First or last name, but not both

◦ User name

Here's a screenshot of the Users tab highlighting the location of the Action menu.

5. From the Action menu, select Reset Password.
6. In the Reset Password page, you have two options:

◦ To send an email to users with a link they can use to create their own passwords, select the
Automatically generate password option.

◦ Reset the password yourself:

i. Select the Manually change the password option.
ii. Enter the new password twice.

Note:  The manual option is available only if you selected the Administrator can manually reset
password option while editing the password policy for the DEFAULT user category in the Security
Console.

7. Click Reset Password.

Related Topics
• Set Up Preferences for User Names, Passwords, and Notifications
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13   Import Sales Users

Overview of Sales User Import  
After you create a couple of sales users in the UI to test your setup, you're ready to import the rest using the resource
import Excel macro provided by Oracle.

The import creates the resource organizations for each manager, creates the sales resource organization hierarchy, and
provisions the users with the job roles and abstract roles they need. You can import up to 5,000 users at a time using
the macro. If you import multiple batches of users, you must ensure that each import completes before starting another.

Note:
• Use the import macro only for sales users. You can't use it to import service users or contracts users, for

example.

• You can import additional attributes by appending columns to the import macro, but you can't make any other
changes. You can't edit the Visual Basic for Applications (VBA) code or other functions.

Here's an overview of the setup steps for importing users using the import macro.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

Synchronize sales security
information with the LDAP
directory before you import
sales users for the first time
and also after creating any
of your own job roles. To
retrieve the latest security
information, you run the
Retrieve Latest LDAP
Changes process using
the Run User and Roles
Synchronization Process
task.
 

Setup and Maintenance >
Sales > Users and
Security > Run User and
Roles Synchronization
Process
 

See the topic: Synchronize
Your Sales Application with
the LDAP Directory
 

2
 

Both Digital Sales and CX
Sales

From article Oracle
CX Sales: Getting
Started with Your Sales
Implementation: Import
Macros (Doc ID 2229503.1)
on support.oracle.com,
 download the Resource
Import Macro and the .jar
file into the same desktop
folder.
 

None.
 

See the topic: Download the
Macro for Importing Sales
Users
 

3
 

Both Digital Sales and CX
Sales

Here's what to enter in the
macro:
 

None.
 

See the topic: Enter Sales
User Data into the Resource
Import Macro and Import
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Step Applies To Description Navigation Where to Get More Details

1. Enter the business
unit and the legal
entity. You can obtain
these from the Review
Company Information
task you completed
earlier.

2. Download any
additional resource
roles you created
by clicking a button
on the Role Details
worksheet.

3. Enter the user
information in the
Resource worksheet,
 starting from the top
of the user hierarchy.

4. Click Create Import
Activity to import.

4
 

Both Digital Sales and CX
Sales

After each import and
whenever you update the
resource hiearchy, you
must run 4 processes to
complete resource and
resource hierarchy creation:
 

• Send Pending LDAP
Requests

• Update Person Search
Keywords

• Reporting Hierarchy
Generation

This process requires
you to select
parameters when you
run it. For the others,
 you just submit.

• Synchronize User
GUID

Navigator > Tools >
Scheduled Processes
 

See the topic: Run
Processes to Complete
Resource and Resource
Hierarchy Creation
 

5
 

Both Digital Sales and CX
Sales

In the Security Console
work area reset the
password for a sales user
you want to use for testing.
 

Setup and Maintenance >
Sales > Users and
Security > Manage
Applications Security
Preferences
 

See the topic: Reset
Passwords for Others
 

6
 

Both Digital Sales and CX
Sales

Sign in as the test user
and review the resource
hierarchy you created by
navigating to the Resource
Directory and displaying a
graphical representation of
the hierarchy.
 
You can upload user images
in the Resource page in

Navigator > Resource
Directory
 

See the topic: Review the
Resource Hierarchy You
Created and Upload User
Images.
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Step Applies To Description Navigation Where to Get More Details

the Resource Directory.
You can't import them. Use
the Manage Users task to
correct any minor errors.
Alternatively, you can make
corrections in the macro
and import again.
 

7
 

Both Digital Sales and CX
Sales

If you enabled forecasting
by opportunity owner
in Setup Assistant, then
you must run the Refresh
Territories from Resources
process to build the
territories for the resources
you just imported.
 
You must run this process
every time the resource
hierarchy changes, so you
should run it on a daily or
weekly basis.
If you're using sales
territories to assign
opportunities by address,
 product or other
dimensions, then you can
skip this step.
 

Navigator > Tools >
Scheduled Processes
 

See the topic: Run the
Refresh Territories from
Resources Process
 

For information on how to manage sales users after you create them initially, see the topic How do I change user
resource roles when job assignments change? and the rest of the User Management chapter in the Securing Sales and
Fusion Service guide.

Synchronize Your Sales Application with the LDAP
Directory  
You must run the Retrieve Latest LDAP Changes process before you import sales users for the first time and after
creating any of your own job roles. The process retrieves the latest security information from the LDAP directory.

1. Open the task Run User and Role Synchronization Process from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Run User and Roles Synchronization Process

2. On the Retrieve Latest LDAP Changes page, click Submit.
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Download the User Import Macro and Import Sales Users
 

Download the Macro for Importing Sales Users  
Here's how to download the Microsoft Excel macro for importing users from My Oracle Support.

1. Sign in to support.oracle.com.
2. Search for 2229503.1.
3. Scroll down in the article to the Details section.
4. Download the .Jar file and the Resource Import Macro file to the same directory on your desktop.

The application saves import logs to the same folder.

Enter Sales User Data into the Resource Import Macro and Import  
Here's how to enter data into the Resource Import Macro and import. You can import up to 5,000 users at a time. If you
import multiple batches of users, you must ensure that each import completes before starting another.

1. Confirm that you have the following information:

◦ Legal entity name (usually your company name followed by LE)

◦ Business unit name (usually your company name followed by BU)

◦ The name of the resource organization that belongs to the resource who manages the first user or users
you're importing.
The resource organization name forms the link between the resources you created and those you're
about to import. If you're importing users who report to the CEO you created in the Setup Assistant, for
example, then you must enter the resource organization name you entered in Setup Assistant for that
CEO. Remember that, because the resource hierarchy is different from the human resources hierarchy,
the manager in the resource hierarchy isn't necessarily the same person as the actual manager in the HR
organization.

2. Open the Resource Import Macro file you downloaded earlier.
3. Enable macros in Microsoft Excel, if required.
4. Click the Role Details worksheet. The standard sales roles are listed:

◦ Chief Executive Officer

◦ Sales Administrator

◦ Sales Manager

◦ Sales Vice President

◦ Salesperson

5. If you created additional resource roles in Setup Assistant or manually, click Populate Roles from Server and
enter the following details in the Login window:
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◦ Host information for your environment.

The host name is the portion of the URL of your environment between https:// and the next forward
slash, /. You can get the correct host name from the URL by signing in to your application. Don't copy the
host name from your application sign-in page because the URL is different.

◦ Your user name

◦ Your password

Here's a screenshot of the Login window with sample host information for a test environment.

6. Click Submit.

The macro retrieves any additional resource roles. All the roles are available for selection from the list of values
in the Resource Role column in the Resource worksheet.

7. If you want to import resource attributes not available on the Resource worksheet, do the following:

a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server and sign in.
c. Use the list of values to add any additional attributes to the Attribute Name column.
d. You can use the Column Header to specify a different name for the attribute to appear as the column

header in the Resource worksheet.
e. Click Update Headers.

The new attributes are appended to the last column on the Resource worksheet.
8. Click the Resource worksheet.
9. In the fields at the top of the sheet, enter your legal entity and business unit.
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10. Enter the sales users that you want to import, working your way down the sales hierarchy. You must start at the
top because you must enter the manager organization name for each user you import.

The macro uses the resource organization names to build the resource organization hierarchy. Here's an
overview of what to enter in the macro columns.

Column What to Enter

First Name
 

Enter the first name as you want it to appear in the sales application.
 

Last Name
 

Enter the last name as you want it to appear in the sales application.
 

Email
 

You must enter a unique email address.
 

Resource Role
 

From the list, select the name of the resource role that you're assigning to the user. If you paste
your data into the worksheet, it gets verified when you import.
 

Organization Name
 

For each manager, enter the name of his or her resource organization. Entry is disabled for
individual contributors because they inherit the organizations of their managers.
 
The organization names you enter here appear in the Resource Directory and elsewhere in the
UI.
 

Manager Organization Name
 

Enter the organization name of the user's manager. You must enter the exact name you entered
for the manager. Even an extra period or change in capitalization can throw the import off.
 

11. When you're done with your entries, click Create Import Activity.
12. If you're asked to correct errors in your entries, do the following:

a. Click OK

The Error worksheet displays your errors.
b. Click each error link in column D and make the correction on the Resource worksheet.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity again.
13. On the Login page, enter the host, user name, and password if required.

If you previously entered these details on the Role Details worksheet when retrieving roles from the server, then
the same values appear here.
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14. Click Submit.

The application displays one of the messages listed in the following table.

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

Open the Errors work sheet to view the error details.
 

15. If your import activity was submitted successfully, then click Activity Details to monitor its progress.

The Activity Details window lists the import activity name, its ID, and its status.

The import may take a few minutes to complete.

◦ You can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

16. If the import activity completes with errors, here's how to correct them:

a. Click Generate Log to display any error messages.
b. On the Errors worksheet, click the value in the Location column (D) to navigate to the record, correct the

issue, and click Submit again to create a new import activity.
17. After the import completes with the status of Completed, you can click Generate Log to save a file that lists the

imported sales users.

The file is saved to the destination folder where you saved the macro.
18. Save the macro file with your data for updates at a later time. You can use the macro to make both minor

updates such as misspelling of names. With a bit of extra work, you can even use the macro to change the sales
hierarchy.

19. Now that you have completed creating users, verify the import from the Manage Users page or from the
Resource Directory.

Run Processes to Complete Resource and Resource Hierarchy
Creation  
After you import sales users, you must run four processes to complete the resource and resource hierarchy creation:

• Send Pending LDAP Requests

• Update Person Search Keywords

159



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 13
Import Sales Users

• Reporting Hierarchy Generation

• Synchronize User GUID

Here's how to run the processes:

1. Navigate to Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. In the Schedule New Process window, Name field, click Search: Name, the down arrow.
4. At the bottom and click Search.
5. In the Search and Select: Name window, enter the name of the process and click Search.
6. Select the process name in the search results and click OK. The Schedule New Process window now displays the

name of your process.
7. In the Schedule New Process window, click OK.
8. In the Process Details window, you must enter parameters only for the Reporting Hierarchy Generation process.

The other processes don't require parameters. Here's what to enter for Reporting Hierarchy Generation:
a. In Tree Structure Code, select RESOURCE_ORG_TREE_STRUCTURE.
b. In Tree Code, select GLOBAL_SALES_MARKETING.
c. In Tree Version ID, select the ACTIVE version (the only one displayed).

9. Click Submit.

Review the Resource Hierarchy You Created and Upload User
Images  
Now that you have created users, you can verify the resource hierarchy in the Resource Directory and upload user
images. The Resource Directory displays a visual representation of the hierarchy and lets you view and edit details for
each resource.

The Resource Directory is part of the HCM application, so much of the detailed information you see is only used if you
implement sales together with HCM. For example, your sales application doesn't track or use resource skills and doesn't
use resource teams, so you can ignore these.

Verify the Resource Hierarchy

1. Click Resource Directory in the Navigator.
2. In the Resource Directory page, search for the top user (the CEO) by first name using the Search: Resources

panel on the left of the page.
3. Click the user name link in the Search Results.
4. Here's what you can do on the Resource page:

◦ View the visual representation of the resource hierarchy by clicking Show Reporting Hierarchy (callout 1
in the screenshot).

◦ Upload a picture of the user by clicking Upload Picture (callout 2).

◦ Review the job and abstract roles provisioned to the user on the Roles tab.

Here's a screenshot of the Resource page showing details for the CEO. Because this screenshot was taken in an
environment with both sales and human resources implemented, the page includes detail you don't see in a
sales-only implementation. The Job Title, Department, and Manager fields are more important for HCM, so is
the information on all of the tabs except Roles. Remember that the resource hierarchy in sales is different from
the HCM hierarchy. The resource hierarchy displays the resource role that's in the Role field and the resource
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organization shown in the Organization field, not the job title and department. In this UI, you can maintain
information about team membership, skills, and so on, but this information isn't used elsewhere in the sales
application.

5. Click Show Reporting Hierarchy.

The application displays a box for the resource.
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6. Double-click the Show icon (the plus sign) to display the whole hierarchy. Navigation tools on the top left of the
page make it possible to zoom in and out.

Edit User Records
Here's how you can change the user name, fix spelling errors, and make other edits in a single record. Alternatively, you
can perform these same edits in the Excel macro and import again.

1. Open the task Manage Users from the Setup and Maintenance work area:
◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Users
2. In the Keywords search field, enter the first name of the user.
3. Click Search (the right arrow icon).
4. Click the name link in Search Results.

The application displays the user record in the Edit User page.
5. In the Edit User page, you can edit the information about each user. For example, you can:

◦ Fix spelling errors

◦ Change the resource roles and provisioning of job roles

◦ Change the user name
Changing the user name requires extra setup for Oracle BI Answers. Oracle BI Answers, the embedded
reporting tool for building and modifying reports, creates a separate GUID from the user name when you
create a user. If you change the user name, then you must update the BI Answers GUID by running the
Rename Accounts Self-Service utility. You can download the utility from My Oracle Support article Oracle
Fusion BI: Self-Service Forget Accounts and Rename Accounts Tools (Doc ID 2635720.1)

6. Click Save and Close when you are done.
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Run the Refresh Territories from Resources Process  
If you enabled forecasting by territory owner in Setup Assistant, this topic is for you. Whenever you import sales users
(resources), you must refresh territories by running the Refresh Territories from Resources process. If you're using
address, product, or another sales territory dimension to assign opportunities, then you can skip this setup entirely.

The Refresh Territories from Resources process runs automatically before each forecasting window. If you run the
process immediately after importing sales users, you assure that users get to see forecasts immediately rather than
having to wait for the next forecasting period. The process updates the territory hierarchy to match your resource
hierarchy, with the resources as territory owners.

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, click Schedule New Process.
3. In the Schedule New Process window, enter Refresh Territories from Resources in the Name field and press

Return.
4. Select the process and click OK.

How can I update the sales organization hierarchy?  
You can use the import Excel macro to update the sales organization hierarchy, but you have to make some
modifications first:

1. You must add a column to the macro for ResourcePartyNumber. The Resource Party Number is required to
identify each resource.

2. You must export the Resource Party Number for your resources and add them to the column.
Importing your updates takes care of many steps that you would have to perform manually in the Manage Resources UI.
For example, if a sales representative gets promoted to a manager, then the import completes these actions for you:

• Automatically end-dates her Sales Representative job role

• Assigns her the Sales Manager resource role

• Automatically provisions her the Sales Manager job role

The import doesn't reassign a manager's reports if the manager moves to a different organization. If you do make
resource hierarchy changes and want these changes reflected immediately in your sales forecasts, you must run the
Refresh Territories from Resources process.

Related Topics
• How do I export data?
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How can I change the name of the top resource
organization and other resource organizations?  
You can change the name of the top resource organization or any other resource organization by editing the name
using the Manage Internal Resource Organizations task.

1. In Setup and Maintenance, go to the Manage Internal Resource Organizations task:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Internal Resource Organizations

2. You can search for the organization by name, or select Sales as the Usage for your search.
3. Edit the organization name and save your changes.
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14  Sales Catalog

Overview of the Sales Catalog  
Salespeople enter the products or product groups that customers are interested in purchasing by making a selection
from a sales catalog. They can either browse the catalog or start typing the product name when they make entries in
opportunities and leads.

The sales catalog consists of a hierarchy of product groups. This hierarchy classifies and organizes the products in your
catalog. Here are some additional key points about the catalog:

• The catalog you create has a root product group and you build your catalog underneath.

• You can include a description for each product group and product.

• You can upload one image for each product.

• There is no specific limit on the number of products you can have in a product category.

• You can use product groups as a dimension in your sales territories and for sales forecasting. During
forecasting setup, you specify the number of levels in your sales catalog product group hierarchy that you want
to forecast.

For example, the fictitious Vision Corp. uses product groups to assign specialists to help close deals on
opportunities. They use a line of green servers that the company has just launched. The company also creates
forecasts for each server line.

• The Product Catalog page gives salespeople a simplified shopping cart experience. They can search for a
product and browse the product group hierarchy to add products to a lead or opportunity. This screenshot
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highlights three product groups under the All Categories section and also individual products in the Products
section.

• Salespeople can drill down into the individual product pages to view the product description and an image.
Here's a screenshot of the product detail page for a sample product. The page includes the product name, the
product description, and an image.
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Products in the Sales Catalog
While you can create the sales catalog with product groups only, you must use products to take advantage of advanced
sales features, such as price books. You must also use products to enable integrations with other Oracle cloud services,
including Oracle Configure, Price, and Quote (Oracle CPQ). You can also use Application Composer to add fields and
perform other modifications to products, a feature not available on product groups.

The products that you create get stored both in Sales and in the Oracle Fusion Product Model. The product model
serves as the master item repository for all front-office cloud services.

For more information on the integration with the Product Model and Oracle CPQ, see the topic Sales and Service
Catalogs in this guide and the topic How Sales Products and SCM Cloud Products Work Together in the Implementation
Reference guide.

Sample Sales Catalog Structure
Vision Corp. sells laptops and two types of servers: Green Servers and Sentinel Servers. To create the catalog, Vision
Corp.:

1. Uses Vision Products as the root product group.
2. Imports the products underneath Vision Products.
3. Imports the remaining product groups and their associations with the products.

This diagram shows the configuration of the Vision Corp. sales catalog. The sales catalog consists of the root product
group, Vision Products, with two child product groups representing the product types: Servers and Laptops. There are
two product groups for the server families: Green Servers, and Sentinel Servers. Each server family includes three server
products. The Green Server products are: Green Server 3000, Green Server 6000, and Green Server 9000. The Sentinel
Server products are: Sentinel Server 1500, Sentinel Server 3000, and Sentinel Server 7000. The Ultra Laptop product
group (a child of the Laptops product group) includes these products: Ultra Z15 Laptop, Ultra Z17 Laptop, and Ultra ZX15
Laptop.

Note:  We highly recommend you use the Setup Assistant to set up your catalog. The Setup Assistant creates the root
product group for you and performs other steps that you would otherwise need to do manually.
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Sales and Service Catalogs  
The building blocks of sales and service catalogs are the same. Both use product groups and products and you create
them using the same UIs and import processes. You create a root product group and build your catalog underneath.
Salespeople use the catalog to enter product interest in opportunities and leads. Service agents use the catalog for
entering products into service requests.

There are two differences between sales and service catalogs:

• How product groups are used.

In sales, you can forecast by product groups and use product groups for assigning opportunities. In service, you
can use product groups to channel service requests to the right work queue for resolution.

• Different product options determine if the product shows up for sales or for service.

Products must have the Eligible to Sell option selected for them to appear in the sales catalog and the Eligible
for Service option selected for them to appear in the service catalog.

You can share products and product groups between the two catalogs and you can even create one catalog for both
sales and service. If you do opt for a single catalog or even reuse the same product groups for the two catalogs, you
must keep in mind that sales may discontinue selling some products that you may still need to service. Or sales may
create product groups specific to promotions or seasonal sales.

Products in the Sales and Fusion Service Catalogs
While you can create sales and service catalogs with product groups only, you must create products to take advantage
of advanced sales features such as price books. You must also use products to enable integrations with other Oracle
cloud services, including Oracle Configure, Price, and Quote (CPQ) Cloud. You can also use Application Composer to add
fields and perform other modifications to products, a feature not available on product groups.

Products you create are also stored in the Oracle Fusion Product Model, which serves as the master item repository for
all front-office cloud services. So, the product you create can be priced and quoted in Oracle CPQ Cloud and serviced in
Sales and Fusion Service.

The Oracle Fusion Product Model, which is included with the different cloud services, provides basic functionality for
use in the front-office cloud services. If you're implementing supply chain cloud services or ERP cloud services together
with your sales application, then you must license the Oracle Product Hub Cloud Service and set up your items using the
UIs and import features of Oracle Product Hub Cloud. You can't create products in your sales application with enough
detail that would make them suitable for back-office supply chain applications. Sales applications don't need to track the
physical locations of the items you're selling or shipping, for example, so all products you create in the sales application
are created at the Item Master Organization level in the Oracle Fusion Product Model. Only the Oracle Product Hub
Cloud includes the ability to manage item classes. All products created in the sales application are created at the default
item class and use the Production design phase.

The following diagram outlines the role products play in Sales, Fusion Service and related cloud services:

• In Oracle CX Sales and Fusion Service, you can create the products for your sales and service catalogs either
individually in the UI (indicated by callout 5) or you import products from a file (callout 6).

• Product records are created both in Sales and Fusion Service and in the Oracle Fusion Product Model (callout 7).
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• You expose the products in the sales or service catalogs (callout 3) by associating them with product groups.

• Salespeople can browse or search the sales catalog from the Opportunity UI (callout 1) and select the products
the customer is interested in buying. Only products with the Eligible to Sell option selected appear in the sales
catalog.

• Service agents enter products from the Service Request UI (callout 4). Only products with the Eligible for
Service option selected appear in the service catalog.

• You can price the products using price books (callout 2), or create quotes for them in Oracle Configure, Price,
and Quote Cloud (callout 8). Price books and CPQ Cloud require additional integration, so aren't covered in this
guide. (Although price books are a sales feature, you must integrate them with opportunities using Groovy
scripting.)

• The Oracle Fusion Product Model (callout 7) forms the foundation of the Oracle Product Hub Cloud (callout
10), a powerful product management application designed for supply chain, order management, and inventory
tasks, which must be licensed separately. Because the sales application uses less than a dozen of the hundreds
of the item attributes that can be captured in Oracle Product Hub, you can't use the sales UIs or product import
if you're implementing Oracle Product Hub Cloud. To create products in Oracle Product Hub Cloud that can be
used with Oracle Supply Chain Cloud or Oracle ERP Cloud (callout 11), you must use the Oracle Product Cloud
Hub UI and item import (callout 9).

169



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 14
Sales Catalog

Overview of Sales Catalog Setup  
The Setup Assistant completes all the prerequisites for creating your sales catalog, so you're ready to import the
product groups and products and publish the catalog. Here's an overview.

What Setup Assistant Completes for You
• Creates the root product group.

• Creates all the prerequisites for creating and importing products. This includes creating the required item
master organization and the units of measure provided by Oracle Fusion Product Model.

• Enables the sales catalog for use by selecting the root node as the "base usage". This step tells the application
which product groups to display in the sales catalog.
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• Runs the scheduled process Refresh Denormalized Product Catalog Table for BI. This process must be run each
time you change the base usage.

Overview of Steps to Perform Manually
Here's an overview of the setups you must complete manually.

Note:  This chapter explains how to create products in your catalog by importing them. For information on how to
create individual products in the UI, see the topic Create Products and the rest of the Products chapter in the Sales
Implementation Reference guide.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

Review the units of
measure to make sure you
have all you need.
 

Setup and Maintenance >
Sales > Sales Catalog and
Products > Manage Units
of Measure
 

See the topic: Review Units
of Measure for Products
 

2
 

Both Digital Sales and CX
Sales

From My Oracle Support,
 download the Excel macros
and the .jar file you need
to import products and
product groups to a folder
on your desktop.
 
Importing the sales catalog
involves four steps using
separate macros:
 

1. You import the
products

2. You import the
product groups

3. You import the
relationship between
the products and
product groups,
 specifying which
products belong in
which product groups

4. You import the
structure of the
product groups in the
catalog

In your browser, navigate
to support.oracle.com and
search for the document
(Doc ID 2229503.1).
 

See the topic: Download
the Macros for Importing
Products and Product
Groups
 

3
 

Both Digital Sales and CX
Sales

Enter product information
in the product import
macro (Product_Import_
Macro.xslm) and import the
products.
 

You carry out this task in
the Excel macro.
 

See the topic: Enter Data
into the Product Import
Macro and Import
 

4
 

Both Digital Sales and CX
Sales

Verify the products you
imported in the Products
work area and, optionally,
 add product images.
 

In your application,
 navigate to the Products
work area and search for
each product you want to
edit.
 

See the topic: Verify
Imported Products and Add
Product Images
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Step Applies To Description Navigation Where to Get More Details

5
 

Both Digital Sales and CX
Sales

Import the relationships
between product groups
and products using
the product group and
product relationship macro
(ProductGroupItem_
Import_Macro.xslm).
 

You carry out this task in
the Excel macro.
 

See the topic: Import the
Relationships Between
Product Groups and
Products
 

6
 

Both Digital Sales and CX
Sales

Obtain the reference
number for the root
product group Setup
Assistant created for you.
You need the reference
number to create the link
between the root and the
product groups you import.
 

Setup and Maintenance >
Sales > Sales Catalog
and Products > Manage
Product Groups
 

See the topic: Obtain the
Reference Number for the
Root Product Group
 

7
 

Both Digital Sales and CX
Sales

Enter the product group
hierarchy information
in the product group
relationship macro
(ProductGroupRelationSetup_
Import_Macro.xslm).
 

You carry out this task in
the Excel macro.
 

See the topic: Import
Product Group Hierarchy
Information
 

8
 

Both Digital Sales and CX
Sales

Validate the sales catalog
on the Manage Product
Groups page.
 

Setup and Maintenance >
Sales > Sales Catalog
and Products > Manage
Product Groups
 

None
 

9
 

CX Sales Enable browsing of the
sales catalog while editing
opportunities by setting
the system profile option
Browse Sales Catalog in
Opportunities Enabled
(MOO_ENABLE_BROWSE_
CATALOG), to Yes.
 

Note:  Browsing of
the catalog happens
automatically in Digital
Sales, so there's no setup
needed.

Setup and Maintenance >
Sales > Opportunities >
Manage Opportunity
Profile Options
 

See the topic: Enable
Sales Catalog Browsing in
Opportunities
 

10
 

Both Digital Sales and CX
Sales

Sign in as a sales user
and validate that your
sales catalog shows up in
opportunities.
 

Navigator > Digital Sales >
Create Opportunity
 

See the topic: Validate the
Sales Catalog
 

11 Both Digital Sales and CX
Sales

Let salespeople filter the
catalog display by only
their own territories or with
products or product groups
from all territories they
have access to.

Navigator > Digital Sales >
Create Opportunity
 

See the topics, Territory
Filtering of Products in the
Catalog and Set Territory
Filter Options
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Review Units of Measure for Products  
The sales organization uses units of measure to sell and price the products in the sales catalog. The Setup Assistant
automatically creates the default units of measure provided by Oracle SCM Cloud for you. Use this step to review the
defaults.

To set up additional units of measure and classes, follow the instructions in the Implementing Common Features for
SCM guide. For example, if you're selling goods priced by the box, then you may want to add Box to the Count class of
measure.

1. In Setup and Maintenance, go to:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Units of Measure

2. On the Manage Units of Measure page, review the list of classes in the Class Name list in the Search section.
You can view the units of measure for each class by clicking Search.

Import Products and Product Groups  

Download the Macros for Importing Products and Product Groups 

Download the four macros for importing products and product groups from My Oracle Support.

Note: 

• This guide focuses on importing your data using import Excel macros. See the Understanding Import and
Export Management guide to learn how to import data without the macros.

• Importing products and product groups applies to both CX Sales and Digital Sales.

• For information on how to create individual products in the UI, see the topic Create Products and the rest of
the Products chapter in the Sales Implementation Reference guide.

1. Sign in to My Oracle Support.
2. Search for the document Oracle CX Sales: Getting Started with Your Sales Implementation: Import Macros (Doc

ID 2229503.1)
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3. In the Details section of the document, locate the portion appropriate to your application update, and download
these files to a folder on your computer. You can create different folders for the different macros provided that
the Product Import Macro folder includes the .jar file.

File Name Description

oracle_ucm_client_11.1.1.jar

 
You must include this file in the same directory as the import macro.
 

Product_Import_Macro.xslm
 

Import products.
 

ProductGroup_Import_Macro.xslm
 

Import product groups.
 

ProductGroupRelationSetup_Import_
Macro.xslm
 

Import the product group hierarchy.
 

ProductGroupItem_Import_Macro.xslm
 

Import the relationship between product groups and products.
 

Enter Data into the Product Import Macro and Import  
Follow these steps to enter data into the Product Import Macro and perform the import. You can import up to 5,000
product records at a time.

1. Open the Product Import Macro file you downloaded earlier.
2. Make sure macros are enabled in Excel.
3. On the UOM worksheet, click Populate UOM from Server.
4. On the Login page, enter the following:

◦ Host information for your environment. The host name is the portion of the URL of your environment
between https:// and /.

◦ Your user name

◦ Your password

5. Click Submit.

The macro retrieves the units of measure you set up from your environment and enters them into the
worksheet so they are available as the list of values in the Primary UOM field in the Template worksheet.

6. The Product Type worksheet lists the product types you can use to classify your products supplied by Oracle.
You can update this list using the following steps. Unless you created new product type values in lookup type
QSC_SALES_PRODUCT_TYPE (not covered in this guide), then you can skip this step.

a. Click Populate Product Type from Server
b. The Login window still contains the host, user name, and password you entered previously, so click

Submit.

The macro retrieves the latest product types from your environment and enters them into the worksheet
so they are available as the list of values in the Product Type field in the Template worksheet.
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7. If you want to import additional fields, then do the following:

a. Click the Attributes Mapping tab.
b. Click Fetch Attributes from Server.
c. In the Login window, enter the following:

- Host information for your environment. The host name is the portion of the URL of your
environment between https:// and /.

- Your user name
- Your password

The macro fetches available product attributes, including any custom attributes you created, from the
application.

d. Add the additional attributes you want to import as follows:

i. In the Attribute Name column, select the field you want to import.
ii. In the Column Header column, enter the name you want to appear as the column header in the

Product worksheet.
e. Click Update Headers.

8. In the Template worksheet, enter your product data. The macro requires just three pieces of information:

◦ Product number

◦ Name

◦ Primary UOM

Here are the details for each existing product attribute:

Column What to Enter

Product Number
 

You can enter the unique product number of the product or leave this required column blank. If
you don't enter a product number, then the macro generates the product number automatically
using the date and time. The product number displays in the product records visible in the
Products work area and the application uses the product number to identify the product record
for updates.
 

Name
 

The product name as it appears in the sales catalog.
 

Description
 

Enter a text description.
 

Primary UOM
 

Unit of measure. One of the values in the UOM worksheet.
 

Product Type
 

Product type. One of the values in the Product Type worksheet.
 

Eligible to Sell
 

Enter Y to make the product appear in the sales catalog and to associate it with product
categories.
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Column What to Enter

If you don't make an entry in this column, then the macro automatically populates the value of
Y.
 
A value of N imports the product, but doesn't show it in the catalog or make it available for
selection by salespeople.
 

Eligible for Service
 

This column is used only if you're integrating with the Oracle Fusion Service. A value of Y
enables service requests for this product. If the product is not eligible for service, then enter N.
 
If you leave this column blank, then the macro automatically populates the value of Y.
 

Enable Customer Self-Service
 

This column is used only if you're integrating with the Oracle Fusion Service. Enter Y to enable
customers to view the product on the self-service portal. Otherwise enter N.
 
If you leave this column blank, then the application populates an N for products of the following
product types:
 

◦ Extended Warranty

◦ Included Warranty

◦ Preventive Maintenance

◦ Service Level Agreement

◦ Software Maintenance

You can't enter a value of Y for these product types into the macro.
 
The macro enters a Y for the rest of the product types supplied by Oracle. You must provide a
value for any product types you created.
 

9. When you're done with your entries, click Create Import Activity.
10. If you're prompted to correct errors, here's what to do:

a. Click OK

The Error worksheet displays your errors.
b. Click each error link in column D and make the correction on the Template worksheet.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity again.
11. On the Login page, enter the host, user name, and password if required.
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12. Click Submit.

The application displays one of these messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

Open the Errors work sheet to view the error details.
 

13. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID, and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

14. Optionally, click Generate Log to save a file listing the products that were imported.

Verify Imported Products and Add Product Images  
You can verify the products you imported and add images in the Products work area.

1. Navigate to the Products work area in CX Sales.
2. Search for the product by product number or product name:

a. Click Advanced Search.
b. In the Advanced Search pane, click Add and select Name from the list.
c. Enter the product name or the first few letters of the name in the field.
d. Click Search.

3. Click the product number link for the product
4. Here are the steps to add a product image on the Edit Product page:

a. Click Manage Attachments (plus sign icon) under the Images heading.
b. In the Attachments window, click Choose File and select the image.

You can only include one image for each product.
c. Click OK.

5. Click Save and Close.
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Import Product Groups  
Here's how to import product groups. You can import as many as 5,000 records at a time. Each import must complete
before you start another.

1. Open the Product Group Import Macro you downloaded earlier.
2. Make sure macros are enabled in Excel.
3. In the ProductGroup worksheet, enter the product groups in your sales catalog hierarchy starting at the top of

the hierarchy, right underneath the root product group you created earlier. You must enter the parent for each
product group.

Here are the details of each column:

Column What to Enter

Product Group Reference Number
 

Enter a unique alphanumeric ID up to 50 characters in length. You can enter the product group
name without any spaces. For example, if your product group is Green Servers, you can enter
GreenServers. The macro enters this value as the Product Group Internal Name for each
product group. The Product Group Internal Name is visible in the Manage Product Groups task
UIs.
 

Product Group Internal Name
 

Optionally, enter a product group internal name of up to 150 characters in length, which is also
visible in the Manage Product Groups task UI. This field is included for customers who may
have lengthy internal IDs for their products. If you leave this field blank, the macro copies the
Product Group Reference number into this field.
 

Product Group Display Name
 

The name of the product group as it will appear in the sales catalog.
 

Product Group Description
 

Enter a text description. This text is not visible to salespeople while making product selections.
 

Allow Selection Flag
 

A Y value in this column means that salespeople can select the product group when entering a
customer's product interest in opportunity revenue lines. An N value means they can't.
 

4. When you're done with your entries, click Create Import Activity.
5. On the Login page, enter the following:

◦ Host information for your environment. The host name is the portion of the URL of your environment
between https:// and /sales.

◦ Your user name

◦ Your password

6. Here's what to do if you're prompted to correct errors in your entries:

a. Click OK.

The Error worksheet displays your errors.
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b. Click each error link and make the correction.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity again.
7. Click Submit.

The application displays one of these messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

You most likely entered the wrong mapping number or the user doesn't have the correct
permissions. Open the Errors work sheet to view the error details.
 

8. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

9. Optionally, click Generate Log to save a file listing the product groups that were imported.

Import the Relationships Between Product Groups and Products  
Import the relationship between product groups and products.

Note:  You can only relate a product to a product group if the product has the Eligible to Sell option set to Y.

1. Open the file ProductGroup_Import_Macro.xlsm with the product groups you just imported. You use the
product group reference numbers to identify the product groups.

2. Open the Product_Import_Macro.xlsm file with the products you imported. You use the product numbers in this
file to identify the products.

3. Open ProductGroupItem_Import_Macro.xlsm.
4. Make sure macros are enabled in Excel.
5. In the ProductGroupItem_Import_Macro.xlsm file, for each product, enter the product group reference number

and the product number.
6. When you're done with your entries, click Create Import Activity.
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7. On the Login page, enter the following:

◦ Host information for your environment. The host name is the portion of the URL of your environment
between https:// and /sales.

◦ Your user name

◦ Your password

8. Here's what to do if you're prompted to correct errors in your entries:

a. Click OK.

The Error worksheet displays your errors.
b. Click each error link and make the correction.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity again.
9. Click Submit.

The application displays one of these messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

You most likely don't have the correct permissions. Open the Errors work sheet to view the error
details.
 

10. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

11. Optionally, click Generate Log to save a file listing the product groups that were imported.
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Obtain the Reference Number for the Root Product Group  
Use this procedure to obtain the product group reference number of the root product group Setup Assistant created for
you. The reference number links the product group hierarchy you're importing to the root product group.

1. Open the task Manage Product Groups from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Groups

Here's a screenshot of the Manage Product Groups page highlighting the View menu (callout 1) and the
Download to Excel icon (callout 2).

2. In the left pane of the window, click View and select Columns, Show All to display all columns.
3. Click the Export to Excel icon and save the Excel file to your desktop. The reference number you need is in

column D.
4. Click Cancel.

Import Product Group Hierarchy Information  
After importing the product groups themselves, you must import the relationships between them to build the catalog
hierarchy.

1. Open the file ProductGroup_Import_Macro.xlsm with the product groups you just imported. You use the
product group reference numbers to build the hierarchy.
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2. Open ProductGroupRelationSetup_Import_Macro.xlsm.
3. Make sure macros are enabled in Excel.
4. In the ProductGroupRelationSetup_Import_Macro, enter the reference number for each product group and the

reference number for its parent. For the product groups immediately under the root product group, you must
enter the root product group reference number you got from the UI.

5. When you're done with your entries, click Create Import Activity.
6. On the Login page, enter the following:

◦ Host information for your environment. The host name is the portion of the URL of your environment
between https:// and /sales.

◦ Your user name

◦ Your password

7. Here's what to do if you're prompted to correct errors in your entries:

a. Click OK.

The Error worksheet displays your errors.
b. Click each error link and make the correction.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity again.
8. Click Submit.

The application displays one of these messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

You most likely don't have the correct permissions. Open the Errors work sheet to view the error
details.
 

9. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

10. Optionally, click Generate Log to save a file listing the product groups that were imported.
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Enable Sales Catalog Browsing in Opportunities  
By setting a profile option, you make it possible for salespeople to browse the sales catalog while editing opportunities.
While browsing, salespeople get to view the product group hierarchy, search, and add any of the product groups or
products as opportunity lines.

Note:  This functionality applies only to CX Sales. Browsing of the catalog happens automatically in Digital Sales,
so there's no setup needed. See the Overview of the Sales Catalog topic in this chapter for some visual examples of
the Digital Sales behavior. Also see the topics, Add Products to an Opportunity and Add Products to a Lead for more
information on the end user tasks in Digital Sales.

After you set the profile option, Browse Sales Catalog in Opportunities Enabled, to Y, the Browse Catalog button appears
on the Edit Opportunity page above the Products table in CX Sales. If you don't display the button, salespeople can still
enter product groups and products in opportunity lines. They just can't browse the catalog.

Note:  Ensure that the Product and Product group objects are enabled for Adaptive Search. While records you create
and update in the UI are automatically indexed and made searchable within seconds, imported records or records
updated by background processes aren't available for search until the indexing process completes.

Set the Profile Option
1. Open the task Manage Opportunity Profile Options from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options

2. In the Manage Opportunity Profile Options page, enter Browse Sales Catalog in Opportunities Enabled in the
Profile Display Name field.

3. Click Search.
4. In the search results, click on the profile option name link.
5. Set the profile option value to Y.
6. Save your changes.

Validate the Sales Catalog  
Now that you've created the catalog, you can check that it's visible in opportunities and leads.

1. Sign in as a sales manager or a salesperson.
2. in Digital Sales home page, click Create Opportunity or Create Lead.
3. On the Create Opportunity page, enter the opportunity name and click Save.
4. Open the opportunity you created.
5. In the Action Bar, enter add and select Add Products.
6. Verify that your product groups (and products if applicable) display in the catalog.
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See Add Products to an Opportunity and Add Products to a Leadfor more information on the end user tasks.

Filter Catalog Display by Territory  

Territory Filtering of Products in the Catalog  
Configure whether the sales catalog displays only product groups and products within a user's sales territories, or if it
displays all product groups and products defined in the catalog.

Furthermore, you can configure whether to have territory filtering off by default, and to let users turn the territory filter
on or off as they view products and product groups. See the Set Territory Filter Options topic for more information.

As they add products or product groups to leads or opportunities, depending on how you set up this feature, users can
toggle the Filter by Territory option on or off. For example, while editing an opportunity, a salesperson enters "add
products" in the search bar. The list of product groups or products appears, where the user can select from product
groups and products. The salesperson can enable or disable the Filter by Territory option (depending on setup), to
have the display of product groups and products limited to only those in her assigned territories.

For setup steps, see Set Territory Filter Options.

See Add Products to an Opportunity and  Add Products to a Lead for more information on the end user tasks in Digital
Sales.

Set Territory Filter Options  
You set the territory filtering options in the product groups setup pages.

You set the territory filtering options in the product groups setup pages.

1. Sign in as the sales administrator.
2. In Setup and Maintenance, go to::

◦ Offering: Sales

◦ Functional Area: Sales Catalog and Products

◦ Task: Manage Product Group Usage

3. Select the Base catalog in the upper portion of the page. (If your catalog uses a different usage, then select it.)
4. Click the Functions tab in the Details section of the page.
5. Click the Value drop-down list for the Territory engine option. If multiple applications have a Territory engine

row, then select the row that has the application you want the filtering to apply to. The applications that can use the
territory filtering functionality appear in the Mode column of the Functions tab. For example, click Territory engine
for the Opportunity Management application shown in the Mode column.

6. Make your filtering selection, using the information in the following table.
1.

Option Description

Do not run Territory filtering is off. The Filter by Territory check box does not display.
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Option Description

  

Enforce territory
 

Territory filtering is on, but is transparent to the user. The Filter by Territory check box does not
display.
 

Display choice - checked by default
 

Territory filtering is on. The territory filter check box is displayed and checked by default. The user
can deselect the check box to disable the territory filtering.
 

Display choice - unchecked by default
 

Territory filtering is off. The territory filter check box is displayed and deselected by default. The
user can check the check box to enable the territory filtering.
 

7. Click Save and Close.
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15  Accounts and Contacts

Account and Contact Basics  
Some basic terminology first. Your sales application is set up for business-to-business sales, so accounts are the
organizations you sell to. The account Type field indicates if an account is a prospect or a customer. You can create
contacts for a specific account or you can create standalone contacts.

Accounts in the CX Sales UI
You can track lots of information for accounts in the various tabs, but most of the information comes from other
business objects. For account-specific information, you use the Overview and Profile tabs. Here's what you can tell
about the sample account in the screenshot just by looking at the Overview tab:

• You know that this account is an existing customer because the account Type field (callout 1) is set to Customer.

• The Industry field displays the primary industry for this customer (callout 2).

You can add multiple industries for each account, but, if you're assigning accounts by industry, then the
account gets assigned using the primary industry.

Tip:  If you're planning to assign accounts by industry, you may want to make entry in the Industry field
required when salespeople create accounts. While you can use Application Composer to make most fields
required, Industry isn't one of them. For Industry, you must use a combination of Page Composer and some
Groovy scripting. See these Oracle Support documents: 2261254.1 and 2193779.1.

• The tab displays the primary address (callout 3) and information about the primary contact (callout 4).

• The account owner (callout 5) is usually the person who created the account, but can be reassigned.

• If you're tracking account relationships, clicking the Ultimate Parent field (callout 6) gets you to the top of the
account hierarchy. You must expose this field during setup.

• The Parent Account (callout 7) just gets you to the immediate parent account.

• You can view and edit the whole account hierarchy by clicking Manage Account Hierarchy (callout 8).
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On the Edit Account, Profile tab, salespeople can add additional industry classifications for the account (callout 1 in the
following screenshot). Without further setup, sales territory assignment uses only the primary industry, indicated by the
check mark icon.

There are multiple ways that you can configure the Profile tab. For example, you can:

• Capture multiple emails, phones, and names and tack customer and contact preferences (callout 2).

• Capture multiple addresses. Only the primary address is used for opportunity assignment (callout 3)

• Display additional fields, including your own classifications that you can use for opportunity assignment (callout
4).
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Accounts in the Digital Sales UI
Accounts in the Digital Sales UI are very different. Gone are the tabs and much of the detail on the overview page.
Records are divided into three sections:

• Summary (callout 1 in the screenshot)

Lists the primary information about the account and contact.

• Action Bar (callout 2)

Instead of clicking on tabs as you do in CX Sales, you enter commands to view and enter detailed information
about the account.

• Panels with key information (callout 3)

Key related information about the account is displayed in panels and linked pages. You access other
information using the Action Bar.
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For more information about the way Digital Sales has transformed the UI layout and functionality see the topic Anatomy
of a Record.

Industry Classification Category Types for Accounts
You can specify which industry classification category you want to use for your accounts. By default, the application
uses the CUSTOMER_CATEGORY classifications created by Oracle. The other classification available categories include:

• 1972 SIC

• 1977 SIC

• 1987 SIC

• CUSTOMER_CATEGORY

• NACE

• NAF

• NAICS_1997

• NAICS_2002

You can add other classification categories, such as NAICS 2012 and NAICS 2017, to this list as described in the topic:
Add to the List of Available Industry Classification Categories.

If you plan to enrich your account records with Dun & Bradstreet Corporation data available from Oracle Data as a
Service (DaaS), then you must either select the 1987 SIC category or add another supported category, such as NAICS
2017, to the list.

Related Topics
• Add to the List of Available Industry Classification Categories

• Enable Address Usage Types for Accounts

• Enable Display of Multiple Addresses
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Account Addresses  
As delivered, the CX Sales accounts pages display a single primary address for each account. You can make it possible
for salespeople to view and enter additional addresses by configuring the Profile tab on the Edit Account page. This
setup isn't required for Digital Sales. Digital Sales accounts can store multiple addresses without any setup.

When you expose multiple addresses, salespeople can indicate the address type and they can designate any one of the
addresses as the primary address. The application uses the primary address for assigning accounts, opportunities, and
leads by address. The primary address is also the address that gets displayed automatically wherever addresses are
listed.

Single Address
By default, the Profile tab of the Edit Account page displays the Address section with the primary address for the
account. Here's a screenshot.

The single address UI doesn't display the address type, which is set as "Sell to" under the covers. You can set a different
default type using the system profile option Default Address Type for Account.

Multiple Addresses
When you configure the Profile tab to display multiple addresses, salespeople see the Addresses section listing the
multiple addresses. On the tab, you can select any address as primary or delete it. You drill down on an address to edit it
or change its type. Here's a screenshot of the tab.
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You add addresses by clicking Add. Here's a screenshot of the Add Address window.

You select one of the available address types from the Type list. An account can have multiple addresses of the same
type. You must display the Type field in the window as part of your setup.

Overview of Account and Contact Setup  
Here's an overview of the setups covered in this chapter:

Step Applies To Description Navigation Where to Get More Details

1
 

Both CX Sales and Digital
Sales

Select the industry
classification category
you want to use to classify
your accounts in the
system profile option
MOT_INDUSTRY_CLASS_
CATEGORY.
 

• In Setup and
Maintenance, go to
the following:

◦ Offering: Sales

◦ Functional Area:
Territories

See the topics:
 

• Specify the Industry
Classification
Category for Accounts

• Add to the List of
Available Industry
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Step Applies To Description Navigation Where to Get More Details

If the classification category
you want to use isn't
available in the system
profile, you may be able to
add it to the list of available
categories using the task
Manage Classification
Groups.
 
If you're planning to enrich
your data with the Oracle
Account and Contact
Enrichment by Dun &
Bradstreet (D&B) service,
 you must use the 1987 SIC
category unless you add
additional classification
categories supported by
the service, such as NAICS
2017.
 
Choose the classification
carefully, especially if you're
using the industry of an
account for assignment
and forecasting. Switching
industry categories after
you enable sales territories
and import account data is
complicated. You must load
and activate sales territory
dimensions again and
reimport your account data
with the new classification
codes.
 

◦ Show: All Tasks

◦ Manage Classification
Groups

• In Setup and
Maintenance, go to
the following:

◦ Offering: Sales

◦ Functional Area: Sales
Foundation

◦ Manage Administrator
Profile Values

Classification
Categories

2
 

Both CX Sales and Digital
Sales

Prevent salespeople from
entering duplicate contacts
and accounts in the UI
by enabling automatic
duplicate checking.
There are just two setups
required:
 

• Enable the duplicate
matching server.

• Activate the
duplicate matching
configuration
provided by Oracle.

• In Setup and
Maintenance, go to
the following:

◦ Offering: Sales

◦ Functional Area: Sales
Foundation

◦ Show: All Tasks

◦ Manage Server
Configurations

Manage Enterprise
Data Quality Matching
Configurations

See the topic: How do I
enable duplicate checking
in Sales?
 

3
 

CX Sales As delivered, the accounts
UI displays and enables
the entry of one primary
address for each account.
If you need more than
one address, you can use
Application Composer to
enable multiple addresses
on the Edit Account page,

Navigator >
Configuration >
Sandboxes
 

See the topic: How can I
enable multiple addresses
for accounts?
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Step Applies To Description Navigation Where to Get More Details

 Profile tab. Salespeople can
view and enter additional
addresses on this tab. Other
accounts pages continue
to display the primary
address.
 
When they add or edit
addresses on the Profile
tab, salespeople select an
address type to indicate
how the address is
used. You must use the
Application Composer tool
to expose the Type field on
the Add Address window.
 

4
 

CX Sales You can make it possible
for salespeople to go
directly to the top account
in the account hierarchy,
 by exposing the Ultimate
Parent field in the Edit
Account page Overview
tab. You can make this
Application Composer
UI change in the same
sandbox as the previous
step.
 

Navigator >
Configuration >
Sandboxes
 

See the topic: Display the
Account at the Top of the
Account Hierarchy in the
Account Overview Tab
 

5
 

Both CX Sales and Digital
Sales

By default, the Type field
lists three address types:
 

• Bill to

• Ship to

• Sell to

You can specify different
and additional address
types by editing the lookup
type Party Site Use Code
(PARTY_SITE_USE_CODE).
This lookup type is shared
with other Oracle Fusion
applications. Only values
tagged with SALES_CLOUD
are available for use in the
sales application.
 

In Setup and Maintenance,
 go to the following:
 

• Offering: Sales

• Functional Area: Sales
Foundation

• Show: All Tasks

• Manage Standard
Lookups

See the topic: Manage
Address Types
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Add to the List of Available Industry Classification
Categories  
Use these steps to add to the list of available industry classification categories. For example, if you want to use NAICS
2017 for your accounts, you can add it as described here.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Task: Manage Classification Groups

2. Click Search without entering any search criteria.
3. Highlight the row for Industrial Categories in the search results.
4. Click Edit (the pencil icon).
5. On the Edit Classification Category Group: Industrial Categories page, click Add Row (the plus sign icon).
6. From the Classification Category list, select the classification category you want to add, for example,

ORA_HZ_NAICS_2017.
7. Click Save and Close.
8. On the Manage Classification Category Groups page, click Done.

Specify the Industry Classification Category for Accounts
 
Specify the type of industry classifications you want to use for accounts.

1. Open the task Manage Administrator Profile Values from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Search: Profile Option region, Profile Option Code field, enter MOT_INDUSTRY_CLASS_CATEGORY.
3. Click Search.
4. If you don't see the classification category you need, try adding additional classification categories to this list as

described in the topic: Add to the List of Available Industry Classification Categories.
5. Select the classification category from the Profile Value list.
6. Click Save and Close.

Related Topics
• Add to the List of Available Industry Classification Categories
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How do I enable duplicate checking in Sales?  
You can have the application automatically check for possible duplicates whenever a salesperson creates an account or
a contact. If you're using Oracle Financials, the application checks for potential duplicates in financial accounts as well as
sales accounts. Salespeople see the possible duplicates in a separate window and get to decide if they want to continue
creating the new record or edit an existing one instead. If they select a financials record that doesn't yet exist in sales,
the basic in formation from that record becomes available in Sales as well. Setup is simple: just enable the duplicate
checking server, activate the built-in duplicate matching, set a couple of profile options, and you're ready to go.

How do I enable duplicate checking in Sales?

Here's a screenshot of the window salespeople see when the try to create an account with possible duplicates.

In the background, the application uses sets of rules, called matching configurations, to identify potential account
and contact duplicates. If you license Oracle Customer Data Management, you can create matching configurations of
your own and you can also check for duplicates in your data in batches. Oracle Customer Data Management includes
industrial-strength data cleansing features, but the basic duplicate checking you're enabling here's available free of
additional charges.

If you're using Oracle Financials, the application checks for potential duplicates in financial accounts as well as sales
accounts.

Enable the Server Used for Duplicate Matching

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Server Configurations
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2. Click the Enabled option for EDQ Realtime and Batch Basic Match Server.

3. Click Save and Close.

Activate the Existing Duplicate Matching Configurations

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Enterprise Data Quality Matching Configurations

197



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 15
Accounts and Contacts

2. Activate each of the matching configurations provided by Oracle:

◦ Account Duplicate Identification

◦ Contact Duplicate Identification

◦ Address Duplicate Identification

Here's how:

a. Drill down into the configuration to edit it.
b. In the Edit Match Configuration page, click Rebuild Keys.

The application warns you that all existing keys will be purged.
c. Click Yes.

The application starts the key generation process, which takes a few minutes to complete. The page
doesn't automatically refresh the status, but you can monitor the progress of the process in the
Scheduled Processes work area (Navigator > Tools > Scheduled Processes)

Here's a partial screenshot of the Edit Match Configuration page highlighting the Rebuild Keys button
(callout 1), which is disabled after you start the process. When the process completes, the page displays
the Active option (callout 2).

d. Select the Active option.
e. Click Save and Close.
f. Reply Yes to the warning.

g. In the Incremental Key Generation window, click Submit.

When you're done, all three configurations should now have a check mark in the Active column on the Manage
Enterprise Data Quality Matching Configurations page.
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Set Profile Options for Account Matches
Set two profile options:

• Duplicate Account Notification (ZCM_ACC_DUP_NOTIFICATION)

This profile option enables the UI that shows notifications of potential duplicate accounts. Make sure that this
profile option is set to TRUE.

• Exact Account Name Match (ZCM_ACC_EXACT_NAME_MATCH)

If the data quality matching configuration fails to identify potential account duplicates, this profile option
enables checks for potential duplicate records using exact name matches. Setting this profile option to TRUE is
optional because the data quality checking configuration uses multiple attributes, including the name, D-U-N-S
number, tax ID, and address to identify potential duplicates. The exact name match is just an extra check.

1. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, Profile Option Code field, enter the
profile option code name for one of the profiles:

◦ ZCM_ACC_DUP_NOTIFICATION

◦ ZCM_ACC_EXACT_NAME_MATCH

3. Click Search.
4. Set the profile option value to the TRUE.
5. Click Save and Close.

How can I enable multiple addresses for accounts?  
Here's how to enable multiple addresses for accounts. You can use similar steps to enable multiple addresses for
contacts and for other sales objects that display addresses, such as households.

Create and Enter a Sandbox
Create and enter a sandbox with the Application Composer tool enabled.

1. In the Navigator, click Configuration > Sandboxes.
2. Click Create Sandbox.
3. Enter a sandbox name.
4. Select Active for Application Composer.
5. Click Create and Enter.
6. From the sandbox Tools menu, select Application Composer to enter the tool.
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Display Multiple Addresses on the Account Profile Tab
While in Application Composer, expose Multiple Addresses in a custom layout:

1. Open the Standard Objects node on the left panel.

Open the Account node.
2. Click Pages
3. On the Application Pages tab, scroll down to the Details Page Layouts section.
4. Select Standard Layout and click Duplicate.
5. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
6. Drill down into your layout.
7. Click the Profile tab in the Subtabs Region.
8. Scroll down until you see the Primary Address and Multiple Address selections.
9. Click the Show link for Multiple Address.

10. Click Hide for the Primary Address.

Multiple Address now displays Hide and Primary Address displays Show. Here's a screenshot:

Note:  You can't expose both regions at the same time.

11. Click Done to leave Application Composer.
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Expose the Type Field
Expose the address Type field in the Add Address window. As they add addresses, salespeople use the field to indicate if
an address is a sell-to address, a bill-to address, and so on. Exposing the field on the Add Address window automatically
adds it to the Edit Address window as well.

1. While in the sandbox and Application Composer, open the Standard Objects node on the left panel.

Open the Address node.
2. Click Pages
3. On the Application Pages tab, Creation Page Layouts section, select the Standard Layout and click Duplicate.
4. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
5. Drill down into your layout.
6. Click Edit (the pencil icon) for Create and Edit Address.
7. In the Configure Detail Form section, locate the Type field in Available Fields pane and move it to the Selected

Fields pane.
8. Click Save and Close.
9. Click Done to leave Application Composer.

Publish Your Sandbox

1. Click Navigator > Configuration > Sandboxes.
2. On the Sandboxes page, click the name of the sandbox.
3. Click Publish.
4. Click Continue to publish.
5. When the sandbox completes publishing, click Done.

Display the Account at the Top of the Account Hierarchy
in the Account Overview Tab  
You can make it easy for salespeople to see the top of the account hierarchy by exposing the Ultimate Parent field on
the Edit Account Overview tab. If you don't expose this field, salespeople can still view the top account, but they must
traverse the account hierarchy itself.

1. Create and enter a sandbox with Application Composer.
2. In the navigation tree, expand Standard Objects, and then expand Account
3. Click the Pages node.
4. Ensure that the Application Pages tab is selected.
5. In the Details Page Layouts region, open a custom layout or create a custom layout by duplicating the standard

layout.
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6. In the custom layout, click Edit (the pencil icon highlighted in the screenshot) for the Account Overview Subtab.

7. In the Configure Detail Form, select Ultimate Parent from the list of Available Fields and move it to the list of
Selected Fields.
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8. Move the field right above the Parent Account field.

9. Click Save and Close.
10. Click Done.
11. To test the changes, view the Account Overview page for an account.
12. Publish the sandbox.

Manage Address Types  
You can specify what address types are used in your sales application by editing the lookup type Party Site Use Code
(PARTY_SITE_USE_CODE).

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page, search for the lookup type PARTY_SITE_USE_CODE or the meaning
Party Site Use Code.

3. Your sales application uses only those values that are enabled and include the tag SALES_CLOUD.
Here are the available values for sales:

Lookup Code Meaning

BILL_TO
 

Bill to
 

SELL_TO Sell to
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Lookup Code Meaning

  

SHIP_TO
 

Ship to
 

4. You can enable additional values for your sales application by entering SALES_CLOUD in the Tag field.
5. You can also create address types of your own using the New button.
6. Click Save and Close.

Related Topics
• Can I modify the phone types for accounts and contacts?

Show Account Invoices to the Sales Team  
Let your sales team see the outstanding and paid invoices of accounts they handle. Enable the Invoices panel on an
account foldout view so that invoices related to the account show up on the panel.

What You Need to Have Before Setting Up
• CX Sales and Oracle Financials integrated.

• The CX Sales accounts need to link to the financial billing accounts for the invoices to show up.

Setups Involved
• Add the AR_VIEW_RECEIVABLES_INVOICE_PRIV privilege to the sales administrator, sales manager, and sales

representative roles, and assign users who need to see the invoices.

• Enable the Show Invoices check box in Smart Actions in Application Composer.

• Enable the Invoices Panel on an object’s foldout view using the Visual Builder Studio.

Enable Show Invoices in Smart Actions  
1. Enter an active sandbox and navigate to Application Composer > Smart Actions.
2. Search for Show Invoices.
3. Ensure that the Enabled check box for Show Invoices is selected.
4. Save your changes and publish the sandbox.

Enable the Invoices Panel on an Object’s Foldout View Using Visual
Builder Studio  

1. Create a workspace in Visual Builder Studio.
See "Create Your Own Workspace" in the Oracle Fusion Cloud Sales Automation Extending Digital Sales (Next
Gen Sales) guide. To access this guide, contact your Oracle representative.
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2. Sign in to the sales application and Visual Builder Studio simultaneously.
3. In Digital Sales, go to the foldout view of any account to add the Invoices panel.
4. On the Account foldout view, click your username in the global header and select Edit Page in Visual Builder.
5. In the Visual Builder Studio, open the workspace you just created and click the Source icon on the left

navigation pane.
6. From Source, navigate to extension 1 > sources > self > applications > digital-sales > flows >

mycustomers > pages > accounts-page.json.
7. In the JSON tab, add the Invoices panel to the displayProperties list.
8. Click the play icon to see the preview of the account foldout view with the Invoices panel.
9. Click Publish.

The Invoices panel appears on the account foldout view.
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16  Import Accounts and Contacts

Overview of Account and Contact Import  
Use the Excel macros provided by Oracle to import some of your existing sales data so that you can test your sales
territory assignment and other features. You import accounts (including account hierarchies) and contacts in separate
files, first the accounts, and then the contacts. You can import up to 5,000 records at a time, but you must ensure that
each import completes before you start another.

Note:  While you can import additional fields by appending columns to import macros, you can't make any other
changes. You can't edit the Visual Basic for Applications (VBA) code or other functions.

Here's an overview of your import tasks.

Step Description Navigation Where to Get More Details

1.
 

From Oracle Support document
2229503.1, download to the same
folder the Excel macros and .jar file
required for import:
 

• oracle_ucm_client_
11.1.1.jar

• Account Import Macro

• Contact Import Macro

• Address Import Macro

My Oracle Support
 

See the topic: Download the Files
for Account and Contact Import
 

2.
 

If you're classifying the accounts by
industry in your import, then you
must obtain a list of the industry
codes for the industry category
you're using. You enter the codes
along with your account data.
 

Setup and Maintenance > Sales >
Accounts and Contacts > Manage
Classification Categories
 

See the topic: View the Industry
Codes for Accounts
 

3.
 

Import your accounts and account
hierarchies.
 

Complete this step in the Account
Import Macro
 

See the topic and video: Import
Accounts and Account Hierarchies
Using the Account Import Macro
 

4.
 

Import account contacts as well as
stand-alone contacts.
 

Complete this step in the Contact
Import Macro
 

See the topic: Import Contacts
 

5.
 

Import additional account and
contact addresses. To view the
additional addresses, you must
have the multiple addresses
regions exposed in the UI.
 

Complete this step in the Address
Import Macro
 

See these topics:
 

• Import Additional Addresses

• How can I enable multiple
addresses for accounts?
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What You're Importing  

What Information You Import for Accounts and Contacts  
Importing account and contact data is a bit more complex than importing users or your sales catalog. That's because
customer data, such as organizations, addresses, and contact points, are stored as different objects in the application.

Each object requires a unique ID for each record to identify it. You can use the IDs to relate the data you import. For
example, your account import includes a unique ID for each organization. You can enter that unique ID into the contact
import file to establish the relationship between the contact and the organization. The unique reference ID you add to
each record also permits you to update the information later.

What You Import for Accounts
You use the account import macro to import basic information about the organizations you do business with:

• Organization name

• Account type
The account can be of type customer or prospect. A customer is an account you have sold to in the past.

• Industry classification

• Account owner: the salesperson who owns the account

• Primary address
You can import additional addresses for accounts using a separate macro.

• Phone

• Fax

• URL

• Parent account
Importing the parent account for each account creates the account hierarchy.

What you import is a subset of what's available on the Overview and Profile tabs of the Edit Account page. The tabs
include other information that you must import separately:

• Attachments that you import as described in import guides

• Primary contact information that you can import using the contact import macro

Here's how the information you see in the Edit Account page Overview tab relates to what you import.

Callout Number Description

1
 

You import the basic account information, including the primary address, using the account import
macro.
 

2 You enter the parent account in the account import macro to create the account hierarchy.
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Callout Number Description

  

Here's how the information on the Edit Account Profile tab, relates to the information you import.

Callout Number Description

1
 

The basic organization information and primary address you import using the account import macro.
 

2
 

Attachments you import separately. (no macro available)
 

3
 

Primary contact information imported using the contact import macro.
 

4
 

Parent account imported along with the account.
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What You Import for Contacts
For contacts, you're importing all of the basic information displayed on the Profile tab of the Edit Contact page. This
includes the name, the primary address, phone, and other contact information, as well as the contact owner and the
account, if any. You can import multiple addresses for a contact using the separate address import macro.

Here's a screenshot of the Profile tab on the Edit Contact page.
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Account Hierarchies  
An account hierarchy provides salespeople a visual representation of relationships between accounts. You can use an
account hierarchy to represent the structure of accounts in large customers and organizations with multiple layers. The
hierarchy need not mirror the formal corporate structure, but can instead represent your organization's view of your
customers. Each account in the hierarchy can have only one parent account.

Capturing account hierarchies can benefit the sales organization in a number of ways:

• Salespeople can use the hierarchy to see the position of their account in the hierarchy.

• You can create BI Publisher reports to show revenue for the hierarchy as a whole.

• You can use the hierarchy to provide key account directors and other select managers access to accounts and
opportunities in the hierarchy that they can't access otherwise.

Accounts for a large multinational corporation, for example, are typically assigned to sales teams in different
countries or regions. Because managers in each region can only access information in their own region, no
single manager can access all of the accounts and opportunities for the entire multinational. By including
an account in the territory of a manager, you can provide that manager with edit access to all accounts and
opportunities in the hierarchy below that account. If you include the top account in the territory, the manager
gets edit access to all accounts. If you include an account in the middle of the hierarchy, the manager can
access only those accounts in that particular branch.

Here's a screenshot of the hierarchy of the fictitious Pinnacle Technologies company and its subsidiaries.
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You can create and maintain the account hierarchy in the UI, by clicking the Manage Account Hierarchy link in the Edit
Account page, Overview tab.

You can also build the hierarchy by entering the parent of an account on the Edit Account, Profile tab. Here's a
screenshot of the portion of the tab, highlighting the Parent Account field.
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Alternatively, you can import the hierarchy as described in this chapter.

Related Topics

Download the Files for Account and Contact Import  
To import accounts and contacts requires you to use two or three different macros. You import the accounts first
followed by their contacts. Importing the additional account addresses is optional. Here's how to download the files you
need.

1. Sign in to My Oracle Support.
2. Search for the document Oracle CX Sales: Getting Started with Your Sales Implementation: Import Macros (Doc

ID 2229503.1)
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3. In the Details section of the document, locate the section appropriate to your application update, and download
these files to the same folder on your computer. You can create different folders for the different macros
provided that each folder includes the .jar file.

File Name Description

oracle_ucm_client_11.1.1.jar

 
You must include this file in the same directory as the import macro.
 

Account Import Macro
 

The Excel macro that you populate with the account data
 

Contact Import Macro
 

The Excel macro that you populate with the contact data
 

Address Import Macro
 

Enables you to import additional addresses for both accounts and contacts. You must expose
the multiple address region in the account and contact pages before you import.
 

View the Industry Codes for Accounts  
Here's how to find the account classification codes to use in the Industry Code column in the account import macro.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Task: Manage Classification Categories

2. In the Search region of the Manage Classification Categories page, enter the classification category name in the
Classification Category field. For the default category provided by Oracle, enter CUSTOMER_CATEGORY.

3. Click Search.
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4. Click the classification category name.

Use the classification codes listed in the Classification Code column on the page for entries in the import macro.

Here's a screenshot of a part of the Classification Category page for the CUSTOMER_CATEGORY provided by
Oracle.

5. Click Done.
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Import Accounts and Account Hierarchies Using the
Account Import Macro  

Watch video
 

Here's how you populate the account import macro with your data and import. You can enter and import a maximum of
5,000 records at a time. You must wait until a previous import is complete before using the macro again.

Note:  You can modify the macro to import additional fields, including any custom fields you created, using the
Attributes Mapping worksheet in the macro.

1. Open the Account Import Macro.
2. If you receive a security warning that macros have been disabled, you must enable macros.
3. Click the Resource EMail to ID Mapping worksheet.
4. Click Populate Resource Attributes from Server to populate the worksheet with information about the

resources who are the owners of the accounts you're importing.

The Login window appears.
5. In the Login window, do the following:

a. Enter the host name. The host name is in the portion of the URL between https:// and /sales.
b. Enter the user name and password.
c. Click Submit.

6. If you're importing additional fields, including custom fields, then do the following:

a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server.
c. In an empty row in the worksheet, select the attribute from the Attribute Name column.
d. Enter the name you want displayed as the column heading in the Account worksheet. This name displays

only in the macro.
e. Click Update Headers to add the column to the Account worksheet.

7. Click the Account worksheet, and enter the account data in the columns.

The address you enter in the worksheet becomes the primary address for the account. If you create sales
territories by address, the assignment process uses the primary address to assign territories.

Column What to Enter

Account Number
 

Required unique ID for the organization. You can leave this field blank and generate the IDs later
by clicking Generate Account Number.
 

Account Name
 

The name of the organization. Entry in this column is required.
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Column What to Enter

D-U-N-S number
 

The data universal numbering system (D-U-N-S) number from Dun & Bradstreet Corporation.
 

Account Type
 

Enter either ZCA_CUSTOMER or ZCA_PROSPECT.
 

◦ ZCA_CUSTOMER for organizations you have sold to in the past.

◦ ZCA_PROSPECT for potential customers. If an organization still requires qualification, then
you should consider importing the record as a lead instead.

If you leave this column blank, then the macro enters ZCA_PROSPECT.
 

Owner E-Mail
 

Enter the email address of the salesperson who is the account owner. The email address must
be listed on the Resource EMail to ID Mapping worksheet. Entry in this column is required.
 

Address Number
 

A unique identifier for the address. If you leave this column blank, then the macro generates the
number for you when you import.
 
If you want to reuse an address from another account, then you can enter the address number
from that address and skip the rest of the address fields.
 

Address 1
 

Enter the street address for the primary account address.
 

Address 2
 

Enter additional address information, such as the suite number.
 

City
 

City.
 

State
 

For the US, enter one of the two-letter state codes.
 

Postal Code
 

Postal code.
 

Country Code
 

The two-letter ISO code for a country. For example, enter US for the United States, and IN for
India. Entry is required.
 

Address Type
 

Address types indicate how an address is used. For example, a customer gets billed at the bill-to
address and receives the goods at the ship-to address. Address types are displayed only if you
enable the display of multiple addresses for accounts.
 
You can import any of the address type codes entered in the lookup type Party Site Use Code
(PARTY_SITE_USE_CODE) with the tag SALES_CLOUD. By default, these are the codes available
for import:
 

◦ BILL_TO
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Column What to Enter

◦ SELL_TO

◦ SHIP_TO

The sales application by itself doesn't use the address type to drive any logic, but different
applications you integrate may. By default, every account address you create in the application
is set to the sell-to address.
 

Phone Country Code
 

Country code for the main phone for the organization.
 

Phone Number
 

Main phone number. No spaces or delimiters.
 

Fax Country Code
 

Fax number country code.
 

Fax Number
 

Fax number. No spaces or delimiters.
 

Email
 

Email address.
 

URL
 

The URL.
 

Industry Code
 

The industry code that you retrieved from the application for the classification category that
you're using. You can obtain a list of the codes using the Manage Classification Categories task
as described in the Viewing Classification Categories for Accounts topic.
 

Named Flag
 

A Y entry indicates the account is a named account. You can create special assignment for
named accounts.
 

Parent Account Number
 

Enter the account number of a parent account to create an account hierarchy. You can copy
over the IDs from the Account Number column.
 

8. In the account import macro, click Create Import Activity.
The Login window is already populated with the information you provided earlier.

9. Click Submit.
10. Here's what to do if you're prompted to correct errors in your entries:

a. Click OK
The Error worksheet displays your errors.

b. Click each error link in column D and make the correction on the Account worksheet.
Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity and Submit again.
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11. If the macro data is validated without errors, then the macro displays one of the following messages.

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

Open the Errors work sheet to view the error details.
 

12. If your import activity was submitted successfully, then click Activity Details.
The Activity Details window lists the import activity name, ID, and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ A status of "Completed" means your import completed successfully.

Import Contacts  
After the account import process completes, you can import the account contacts. You can import multiple contacts
for each account, but you must specify one of the contacts as the primary contact. If you don't identify an account for a
contact, the contact gets imported as a stand-alone contact. Using the macro, you can import up to 5,000 contacts at a
time. You must ensure each import completes before starting another.

1. Open the Contact Import Macro.
2. Enable macros in Microsoft Excel, if required.
3. Select the Resource EMail to ID Mapping worksheet.
4. Click Populate Resource Attributes from Server to populate the worksheet with information about the

resources you will assign as owners of the contacts you're importing. The contact owner is usually the resource
who created the record. Owner entry is required.

5. Sign in on the Login window:
a. Enter the host name. The host name is in the portion of the URL between https:// and /sales.
b. Enter the user name and password.
c. Click Submit.

The worksheet now includes both IDs and email addresses of the sales resources in your application. The email
doesn't get imported; it just helps you enter the owner.

6. If you're importing additional fields, including custom fields, then do the following:
a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server.
c. In an empty row in the worksheet, select the attribute from the Attribute Name column.
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d. Enter the name you want displayed as the column heading in the Contact worksheet. This name displays
only in the macro.

e. Click Update Headers to add the column to the Contact worksheet.
7. Enter the contact information in the Contact worksheet. Here's a description of the columns:

Column What to Enter

Contact Number
 

Unique ID for the contact. If you leave this required ID blank, the macro automatically generates
it for you from the date and time when you import. The application uses the contact number to
identify the contact for updates.
 

Prefix
 

Enter the contact name prefix. Here are the valid values:
 

◦ DR.

◦ MISS

◦ MR.

◦ MRS.

◦ SIR

First Name
 

Contact first name. Entry is required.
 

Last Name
 

Contact last name. Entry is required.
 

Job Title
 

Contact job title.
 

Owner E-Mail
 

Enter the email of the account owner. The email must be one of the email addresses on the
Resource EMail to ID Mapping worksheet. An owner is required for every record.
 

Work Phone Country Code
 

Country code for the work phone.
 
If you import a work phone and no mobile phone, then the application displays the work phone
as the primary phone in the contact and account UI.
 

Work Phone Number
 

Phone number without spaces.
 

Mobile Country Code
 

Country code for the contact's mobile phone number.
 
If you import a mobile phone number, it automatically becomes the contact's primary number
in the contact and account UI.
 

Mobile Number
 

Phone number without spaces.
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Column What to Enter

E-mail
 

Email address.
 

Address Number
 

If you don't have a unique ID to plug in this required field, you can leave it blank. The macro
generates it for you automatically.
 

Address 1
 

Enter a street address unless you're using the account address.
 

Address 2
 

Second address line.
 

Address 3
 

This column is hidden in the macro.
 

City
 

City.
 

State
 

State.
 

Postal Code
 

ZIP or other postal code.
 

Country Code
 

Two-letter ISO country code. You must enter a country even if you don't enter an address.
 

Account Number
 

The account number links the contact to the account. Copy the account number for the
contact's organization from the Account Number column in the account import macro file. If
you leave this column blank, then the contact is imported as a standalone contact.
 

Primary Contact Flag
 

Each account must have one and only one primary contact. You must select Y for one of the
contacts for each account. The other contacts must have a value of N.
 

8. Click Create Import Activity.

The Login window appears already populated with the information you provided.
9. Click Submit.

10. If you're prompted to correct errors, here's what to do:

a. Click OK

The Error worksheet displays your errors.
b. Click each error link in column D and make the correction on the Template worksheet.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity and Submit again.
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11. If the macro data is validated without errors, then the macro displays one of the messages listed in the
following table:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

You most likely entered the wrong mapping number or the user does not have the correct
permissions. Open the Errors work sheet to view the error details.
 

12. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

13. Optionally, click Generate Log to save a file listing the contacts that were imported.

Validate the Imported Contacts
You can validate the imported contacts either in the Contacts work area or in Workspace. Here's how to do it in the
Contacts work area.

You can view the primary contacts of the accounts you imported from the list of accounts. Here's another way that you
can view a list of contacts for the country you imported:

1. Make sure that you're signed in as a sales administrator in the sales organization. Sales administrators have
broad access to sales data.

2. Open the Contacts work area.
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3. Click Advanced Search (the filter icon, callout 1 in the screenshot) to open the Advanced Search panel.

4. From the Saved Search list select Contact Name (callout 2).
5. Add United States or the country you imported as an additional filter:

a. Click Add (callout 3) and select Country.
b. Enter the country (callout 4).

6. Click Search.

Import Additional Addresses  
Here's how to import additional addresses for accounts and for contacts using the address macro. You must expose the
multiple addresses section in the UI to view them.

1. Open the Address Import Macro.
2. If you receive a security warning that macros have been disabled, you must enable macros.
3. Review the attributes available for import on the Address worksheet. If you need to import additional address

attributes, then do the following:

a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server.
c. In an empty row in the worksheet, select the attribute from the Attribute Name column.
d. Enter the name you want displayed as the column heading in the Address worksheet. This name displays

only in the macro.
e. Click Update Headers to add the column to the Address worksheet..

4. Enter the address data on the Address worksheet.

Here's a description of the available columns.
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Column What to Enter

Address Number
 

A unique identifier for the address. If you leave this column blank, then the macro generates the
number for you.
 

Address 1
 

Enter the street address for the primary account address.
 

Address 2
 

Enter additional address information, such as the suite number.
 

City
 

City.
 

State
 

For the US, enter one of the two-letter state codes.
 

Postal Code
 

Postal code.
 

Country Code
 

The two-letter ISO code for a country. For example, enter US for the United States, and IN for
India. Entry is required.
 

Address Type
 

Address types indicate how an address is used. For example, a customer gets billed at the bill-to
address and receives the goods at the ship-to address. Address types are displayed only if you
enable the display of multiple addresses for accounts.
 
You can import any of the address type codes entered in the lookup type Party Site Use Code
(PARTY_SITE_USE_CODE) with the tag SALES_CLOUD. By default, these are the codes available
for import:
 

◦ BILL_TO

◦ SELL_TO

◦ SHIP_TO

The sales application by itself doesn't use the address type to drive any logic, but different
applications you integrate may. By default, every account address you create in the application
is set to the sell-to address.
 

Associated Party Number
 

Copy the account or contact number from the appropriate macro to link the address.
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5. Import the additional addresses. The process is the same for all the macros:

a. Click Create Import Activity and sign in.
b. If you get errors, correct them and import again.
c. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window lists the import activity name, ID, and its status.

- If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.
- A status of "Completed" means your import completed successfully.
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17  Mass Update and Inline Editing

Mass Update  
With mass update , salespeople can update fields on multiple records at the same time with a few clicks. No need to
drill into and edit each record individually. In Digital Sales UIs, this feature is available by default. In CX Sales, you must
complete the updates listed in this chapter.

In CX Sales UI's Workspace and in the new work areas that use Adaptive Search, updating ownership and status of
multiple leads is as simple as selecting the leads in the landing page list, right-clicking, and selecting the Update action.

Salespeople get a list of fields they can update such as the one shown in the screenshot.

Mass update is also available in the CX Sales UI legacy work areas that haven't been converted to Adaptive Search,
including Business Plans, Competitors, Service Requests, and Products. Because these work areas use the older CRM
Search technology, you must set these up separately. Inline editing is available only in these legacy work areas.

Note:  Mass update isn't available for dynamic choice list (DCL) fields with dynamic filters.

Setup Overview  
Here's how to enable mass update and inline editing in CX Sales UIs.
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Step Applies To Description Navigation Where to Get More Details

1
 

CX Sales Enable mass update of
records in Workspace and
the new single-object work
areas, including Accounts,
Contacts, Leads, and
Opportunities.
 

Setup and Maintenance >
Sales > Sales
Foundation > Configure
Adaptive Search >
Parameters
 

See the topic: Enable Mass
Update
 

2
 

CX Sales Optionally, enable mass
update of records in the
work areas that haven't
yet been converted to
the new Adaptive Search
technology. You can do
this by adding the Update
action to a custom layout
of the landing page in
Application Composer.
You can also specify the
maximum number of
records users can update in
a profile option.
 

• Navigator >
Configuration >
Application
Composer

• Setup and
Maintenance >
Sales > Sales
Foundation >
Manage
Administrator Profile
Values

See the topics in the section
Inline Editing in Legacy
Work Areas:

• Enable the Mass
Update Action

• Enable Inline Editing
of Records Displayed
in Lists

 

3
 

CX Sales Optionally, you enable the
inline editing in the legacy
work areas, by setting the
profile option Click-to-Edit
on Landing Page Enabled
to Yes.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Administrator Profile
Values
 

See the topic: Enable
Inline Editing of Records
Displayed in Lists
 

Enable Mass Update  
Here's how to make it possible for salespeople to update multiple records at the same time while using Workspace,
Accounts, Contacts, Leads, Opportunities, and the other work areas in CX Sales that now use Adaptive Search.

1. Navigate to the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click Parameters (callout 1).
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3. Click Edit.

Here's a screenshot of the page after you click Edit.

4. In the Enable Mass Update row, Current Value column, enter Y (callout 2).
5. Click Save and Close.

Enable Mass Update and Inline Editing in Legacy Work
Areas  

Enable the Mass Update Action  
You enable mass update for the legacy work areas that still haven't been updated to behave like Workspace, by creating
a custom layout of the landing page in Application Composer. Within the layout, you specify which fields users can
update.

Create and Activate a Sandbox

1. Click Navigator  > Configuration  > Sandboxes.
2. On the Sandboxes page, click Create Sandbox.
3. Enter a name for your sandbox.
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4. In the All Tools section, select Application Composer as the tool you want to activate for this sandbox.
5. Click Create and Enter to create and enter the sandbox.

The application displays a bar at the top of the page with the sandbox name.

Enable the Update Action and Specify the Fields in a Custom Layout

1. Open Application Composer, Navigator > Configuration > Application Composer.
2. In the navigation tree, expand Standard Objects, and then expand the object you want to modify. For example,

expand the Opportunity object.
3. Within the object you're modifying, click the Pages node.
4. Ensure that the Simplified Pages tab is selected.
5. In the Landing Page Layouts region, select the Standard Layout and click Duplicate Landing Page Layout (the

document icon).
6. In the Duplicate Layout window, enter a name for your layout. The Standard Layout is the source.
7. Click Save and Edit.

Notice that your new layout is now active. The Standard Layout you copied is inactive.
Here's a screenshot of Application Composer showing the Opportunity: Pages region. Callouts highlight some
of the features.

Callout Number Description

1
 

Pages node
 

2
 

Duplicate Landing Page Layout button
 

3
 

Role Name (down arrow icon) that you use to specify job roles that see the layout.
 

8. Edit the new layout to add the Update action and select the fields that users can update. Here are the steps for
the Opportunities landing page:

a. Click Edit (the pencil icon) on the Fuse Opportunity Overview Table.
b. Navigate to the Configure Detail Form: Buttons and Actions region.
c. In the Available Actions window, move the Update action to the Selected Actions pane. You can either

double-click or use the arrow buttons.
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d. Scroll down to the Configure Mass Update Fields region.
e. Move the fields you want users to update to the Selected Fields column.

Tip:  If entry in a field depends on the value of another field, you must expose both fields. For example,
users can't enter a sales stage unless they select the sales method first.

f. Click Save and Close, then Done.
9. By default, your custom layout is available to everyone. Here's how to restrict use of layout to specific job roles:

a. Select the layout and click Role Name (the down arrow icon).
b. In the Select: Roles window, click Show available predefined roles and Specific Roles.
c. Move the job roles to the Selected Roles column and click OK.

Test and Publish the Sandbox
Test your new layout in the work area where you enabled it and publish the sandbox.

1. Click on the sandbox name in the sandbox toolbar and select Publish.
2. Click OK in the dialog box to navigate to the Sandbox Detail page.
3. In the Sandbox Detail page, click Publish again.
4. Click Continue to Publish in the warning message to confirm that you want to publish.

Specify the Maximum Number or Records Users Can Update at
the Same Time  
You can specify the maximum records users can update at the same time in the legacy work areas by setting two profile
options.

Note the following:

• By default, users can update a maximum of 25 records at the same time.

• The maximum number of records you can update is 500.

• For custom objects, the maximum number is set to 25 records. You cannot change this number.

Application Object Profile Option

Activities
 

Activity Mass Update Threshold Value (ZMM_MASS_UPDATE_THRESHOLD)
 

• Accounts

• Assets

• Contacts

• Leads

• Opportunities

Mass Update Threshold Value (ZBS_MASS_UPDATE_THRESHOLD)
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Set the Profile Options
Here's how to set the profile options:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, search by the profile option name or code.
3. Click the profile option name link.
4. Set the profile option value.
5. Save your changes.

Enable Inline Editing of Records Displayed in Lists  
Enabling inline editing of records in landing page lists saves the extra clicks it takes to drill down into individual records.
Inline editing is available in the legacy work areas.

You enable the feature by setting the system profile option Click-to-Edit on Landing Page Enabled.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZBS_ENABLE_CLICK_TO_EDIT in the Profile Option Code field.

3. Click Search.
4. Click on the profile option name in the search results.
5. Set the profile option value to Yes.
6. Click Save and Close.
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18  Sales Dashboard

Overview of the Sales Dashboard  
A sales dashboard is a visual representation of key sales performance metrics and KPIs (Key Performance Indicators)
designed to provide a quick and easy-to-understand overview of a sales team's performance.

Salespeople and sales managers can use the Sales Dashboard to review items that need their immediate attention,
including upcoming appointments and tasks. The dashboard can also display tables of information and visualizations
from OTBI and from shared saved searches.

Oracle delivers two Sales Dashboards: one for the sales representative and one for the sales manager.

As an administrator, you can use Oracle Visual Builder Studio to configure each version of the Sales Dashboard to meet
your requirements.

Here's an example of what a salesperson sees in the Sales Dashboard provided by Oracle:

• The tiles at the top of the page, called Metric Cards (or Attention Tiles), display the number of important work
items in the list generated from a saved search. For example, the My Overdue Tasks tile shows the number of
overdue tasks a salesperson owns (callout 1 in the screenshot). Clicking on a tile displays the list.

• The bottom section of the salesperson dashboard displays a list or graphical representations, called
visualizations:

◦ My Open Opportunities (callout 2) lists opportunities that are closing soon. The list is generated from
a saved search with the same name. Salespeople can take an action on an item in the list by clicking
Actions (the three dot icon, callout 3), or they can click View all to see the complete list of open
opportunities.

The layout of My Open Opportunities and other sections of the Sales Dashboard are saved as templates
that you can copy and use to display other saved searches in a similar way.

◦ Sales Pipeline (callout 4) displays a visualization of a salesperson's pipeline by sales stage. Click the
opportunity stages to get a list of opportunities at each stage. The data for the visualization comes from
an Oracle Analytics Cloud analysis.

◦ My List shows accounts, contacts, leads, and opportunities that were recently accessed by the
salesperson or are associated with an activity. Items accessed more often get higher priority on the list.
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What You Can Modify
The Sales Dashboard displays content in individual sections, or logical regions of the page. Each section maps to a
template, which defines the content displayed within that section.

In VB Studio, there are four types of templates you can use to display both preconfigured and custom saved searches:

• Attention Tile (also called a Metric Card)

A tile that displays the name of the saved search and the number of items in the list of results. Clicking on the
tile displays the list.

• List

Displays data as a single-column a list.

• Table

Displays data in a table with multiple columns.

• Visualizations

Displays data as a visualization.

To display visualizations created from saved searches and reports, you use the Chart template type.

Digital Sales delivers a predefined set of visualizations that you can add to a dashboard. Or you can create your own
custom visualizations using the Visualization Configurations page. See the topic Create a Visualization of a Saved
Search or an Analysis. (You can add the same visualizations to both the Sales Dashboard and to CX Sales Mobile
layouts.)

For each dashboard, you can:

• Add and remove existing templates, and change their display order.

• Create new templates.

• Add visualizations you created from saved searches or from Oracle Analytics Cloud analyses.
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Sales Representative and Sales Manager Dashboards
Let's look at the templates that are preconfigured for each version of the Sales Dashboard.

The dashboard for the sales representative includes these templates:

• Attention Tile for Sales Representative

• My Appointments Table

• My Open Opportunities List

• Sales Pipeline Chart

• My Open Tasks List

• My List

The dashboard for the sales manager includes these templates:

• Attention Tile for Sales Manager

• My Appointments Table

• All Opportunities List

• My Team's Pipeline Chart

• My Team's Performance Chart

• My Team's Deal Size Chart

Digital Sales also delivers a default Sales Dashboard. If the user isn't a sales representative or sales manager with the
right roles, then the default Sales Dashboard displays at runtime. The default dashboard includes these templates:

• Attention Tile for Sales Representative

• My Appointments Table

• My Open Leads List

• Sales Pipeline Chart

• My Open Tasks List

• My List

Complete List of Sales Dashboard Templates
Digital Sales delivers the below templates already configured for the Sales Dashboard. You can add these templates to
any custom Sales Dashboard layout.

Template Type Template Name

Attention Tile • Attention Tile for Inside Sales Manager

• Attention Tile for Sales Representative

• Default Attention Tile

• Template for Aggregates

Lists • All Accounts List

• All Contacts List
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Template Type Template Name

• All Opportunities List

• My Open Leads List

• My Open Opportunities List

• My Open Tasks List

• My List

• My Team's Opportunities List

• Template for List

Table • My Appointments Table

• Template for Table

Visualizations • My Earnings by Period

• My Team's Deal Size Chart

• My Team's Leads Size Chart

• My Team's Performance Chart

• My Team's Pipeline Chart

• Sales Pipeline Chart

• Template for Chart

Overview of Sales Dashboard Setup  
Here's an overview of the steps you can use to configure the Sales Dashboard. It also lists the steps to enable access to
the dashboard from Digital Sales.

Here's how you enable access to the Sales Dashboard from the Navigator:

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox and enter a new sandbox with Structure enabled.
3. From Tools, select Structure to open the Structure page.
4. Locate and select the Sales Dashboard entry in the Navigation Configuration tab of the Structure tool.
5. Publish the sandbox by clicking the sandbox name and Publish.

Once the Sales Dashboard is enabled, you can access it from the Navigator by selecting Sales Dashboard. Alternatively,
it can also be accessed via the Springboard.

Here's an overview of the steps you can use to configure the Sales Dashboard.

Step Description Navigation Where to Get More Details

1
 

Duplicate the predefined
dashboard layout that you want to
configure in VB Studio. There are
two predefined layouts: one for the

VB Studio See the topic Duplicate the
Predefined Sales Dashboard Layout
in this chapter.
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Step Description Navigation Where to Get More Details

sales representatives and one for
sales managers.
 

2
 

Add predefined or custom saved
searches as metric cards (the tiles
along the top), lists, or tables.
 
The different elements of the
dashboard provided by Oracle are
saved as templates that you can
copy and reuse.

VB Studio See the topics:
 

• Add a Predefined Saved
Search to the Sales
Dashboard

• Add a Custom Saved Search
to the Sales Dashboard

• Metric Cards and Badges

• Configure Metric Card Badges
and Descriptions

3 You can add badges to the metric
cards that warn users when certain
conditions are met. For example,
 the My Overdue Tasks metric
card provided by Oracle displays
a warning badge if a user has 5 or
more overdue tasks and a critical
badge if there are 10 or more.

VB Studio See the topics:
• Metric Cards and Badges

• Configure Metric Card Badges
and Descriptions

4
 

Add any visualizations (charts)
for saved searches or for Oracle
Analytic Cloud analyses.

VB Studio
 

See the topic: Add a Visualization
to the Sales Dashboard
 

Duplicate the Predefined Sales Dashboard Layout  
You must duplicate the predefined Sales Dashboard layout, so you can make changes.

1. In Digital Sales, navigate to the Sales Dashboard.
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2. Under the Settings and Actions menu, select Edit Page in Visual Builder Studio.

3. Select the project that's already set up for you. If only one project exists, then you will automatically land in that
project.

4. If you're working in an active sandbox when you launch Visual Builder Studio from Digital Sales, then Visual
Builder Studio looks for a workspace that's associated with your sandbox. If you're not working in a sandbox
when you launch Visual Builder Studio, then Visual Builder Studio looks for a workspace without a sandbox. You
might have to select a workspace if more than one workspace exists. If no workspace exists, then Visual Builder
Studio automatically creates one for you.

5. When you enter into your workspace in Visual Builder Studio, you land on the Page Designer. This is where you
create your application extension.

The Sales Dashboard is displayed in the main design area called the canvas.

Tip:  To display more of the dashboard, collapse the left pane by clicking the App UIs tab on the left. Then,
select Wide screen from the list along the top of the Page Designer.

6. On the Properties pane, click the Default Ruleset link.

The default ruleset contains the page layouts that are available for the Sales Dashboard, one for the sales
representative and one for the sales manager. There's also a default layout for those users who might not have
the right roles. Each layout is read-only. To make changes to a layout, you must first duplicate it. In this case, we
want to change the dashboard for the sales representative.
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7. Scroll down to the Representative layout.

Note the two icons: Layout Preview and Duplicate.

◦ Click the Duplicate icon to make a copy of the layout that you can then configure.

◦ Click the Layout Preview icon to view the template layout in the canvas. This lets you easily toggle
between layouts.

8. Click the Duplicate icon.

Visual Builder Studio makes a copy of the layout named Representative (Copy).
9. In the Representative (Copy) layout, review the layout's condition to ensure that the correct role is specified for

this layout.

You're now ready to make changes to the dashboard layout.

Add a Predefined Saved Search to the Sales Dashboard  
Here's how to add one of the saved searches predefined by Oracle to the Sales Dashboard. In this example, we're adding
the All Accounts saved search to the Sales Dashboard for sales representatives.

Note:  To learn how to display a custom saved search on the dashboard, see the topic "Add a Custom Saved Search to
the Sales Dashboard The instructions are the same with some minor differences.

To add a predefined (also known as "base") list template to a Sales Dashboard layout:

1. On the Properties pane for the Representative (Copy) layout, click the + Add Section icon.
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2. Click All Accounts List.
The newly added All Accounts List is added at the bottom of the layout. You can change the order the sections
are displayed. Just use the Move Up and Move Down arrows in the Sections region.

3. To remove a section from the dashboard layout, click the Delete icon next to the section that you want to
remove.

4. Click the Preview button to see your changes in your runtime test environment.

Add a Custom Saved Search to the Sales Dashboard  
Here's how to display a custom saved search on the Sales Dashboard for sales managers either as a table or a list.

Note:  This example explains how to add a custom saved search or smart list to the dashboard layout as a table. To
display a list, the instructions are the same except for some minor differences, which are noted in step 13.

Prerequisites
1. Create the custom saved search and share it with the job roles who view the dashboard. Create Saved Searches

for the Sales Organization.
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2. Display the saved search and copy its UUID. The UUID is displayed in the saved search page's URL.

You will use the UUID when adding the table to the Sales Dashboard in Visual Builder Studio.

Display the Custom Saved Search as a Table in the Sales Dashboard
1. Let's configure a dashboard layout for a manager.

On the Properties pane for the Manager (Copy) layout, review the layout's condition to ensure that the correct
role is specified for this layout.

2. Click the + Add Section icon > + New Section.
3. In the Create Section dialog, enter a title, My Open Leads < 10K, and click OK.

Note:  The title is the name of the template, not how the template will appear at runtime on the dashboard.
The runtime title comes from the saved search.

The newly added section is added to the bottom of the layout. Use the Move Up arrow to move the new section
to the desired location.

4. Click the My Open Leads < 10K link.

The template editor opens.
5. Click the Code button.

Your new My Open Leads < 10K section displays with empty placeholder template tags.

6. For a table, enter this code between the existing placeholder template tags.
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<oj-cx-saleshub-tile>
 <oj-cx-iss-mini-workspace>
 </oj-cx-iss-mini-workspace>
</oj-cx-saleshub-tile>

Here's a screenshot of the new code for a table:

7. Click the Design button.

8. On the Structure pane, click Sales Hub Tile Container.
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9. On the Properties pane, on the All tab, select 6x2 as the size.

If data in the table is too wide for the size you select, then scroll bars automatically display.
10. Still on the Structure pane, click Sales Hub Mini-List Component.
11. On the Properties pane, on the All tab, click the Show sub-properties icon next to the Display Options field.
12. In the Display Option field, select TABLE.
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13. In the Maximum rows to display field, enter 3.

The table displays a maximum of 3 rows. If more data exists, then a View All link displays.

Note:  To add a list instead of a table, change the value of the Display Option field to LIST. Lists and tables
use the same underlying component, Sales Hub Mini-List Component, and are both populated by saved
searches.

For example, here's a screenshot of creating a template for a list instead of a table:

In addition to adding lists, you can also add a My List component to the Sales Dashboard. For more information
about My List, see "My List" in the Oracle Fusion Cloud Sales Automation Using Digital Sales (Next Gen Sales)
guide. To add a My List component, set the Display Option field to LIST, click < Display Options, and set the
Show My List field to true.

14. Let's continue with the table example. Click < Display Options.
15. In the Type of objects field, select Lead.

Note:  A set of attributes is already predefined, per object, to display in the table. You can further modify
which attributes display, if required. See "Modify the Columns in a Table Template" in the next section of this
topic.

16. In the Identifier for Saved Search field, enter the UUID of the saved search.

The UUID refers to the unique identifier of the saved search. The UUID is displayed in the saved search page's
URL.
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17. Click the Preview button to see your changes in your runtime test environment.

For example:

Modify the Columns in a Table Template
When you add a table to a dashboard, you specify the object that the table pulls its data from. For each object that
you can select, Visual Builder Studio knows which attributes to display in the table since default attributes are already
predefined. However, you can further modify which attributes display in the table, if desired. You can control three
things: which fields to display as columns in the table, the width of those columns, and the column titles. Let's do that
now.

1. In the Manager (Copy) layout, click the My Open Leads < 10K template.
2. On the Structure pane, click Sales Hub Mini-List Component.
3. On the Properties pane, on the All tab, copy and paste the attributes you prefer to display in the Name of

dynamic form layout field.

Specify your preferred set of attributes using the field names from the object's elastic search payload, arranged
in the below format. To override an attribute's display label, enter a headerText value. For example:

[[ [
{mappedField: 'Name', width: 200, template: 'objectDetailLinkCellTemplate'},
{headerText: 'Customer', mappedField: 'CustomerAccount.PartyName', width: 200},
{mappedField: 'DealAmount', width: 100},
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{mappedField: 'Owner.PartyName', width: 100}
] ]]

Here's a screenshot of the Name of dynamic form layout field:

4. Click the Preview button to see your changes in your runtime test environment.

Notice the change in the table display:
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Metric Cards and Badges  
You can display a saved search on the Sales Dashboard as a metric card, one of the tiles at the top of the page. Metric
cards are useful because they display an aggregate sum of items returned by the saved search. For example, how many
overdue tasks do you have? Or, how many open leads exist that are over $100,000? Metric cards can display badges
that visually alert salespeople when data meets certain conditions, which you can set. For example, the Critical badge
appears automatically when there are 10 or more overdue tasks.

Here's a screenshot of a metric card and its components:

Anatomy of a Metric Card

Callout Description

1
 

Badge
 

2
 

Title
 

3
 

The aggregate sum
 
The sum is derived from the saved search that the metric card is based on.
 

4
 

Description
 

All metric cards provided by Oracle include a title and display the aggregate sum. Some metric cards provided by Oracle,
such as the one for My Overdue Tasks, display badges. None of the metric cards include a description, but you can add
one.
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What You Can Configure
You can configure the following metric card components using Oracle Visual Builder Studio:

• Type of badge, and the conditions when the badge should appear

For example, display a warning badge if the aggregate sum on the metric card is between 5 and 10 records. But
if the aggregate sum is under 5, then don't display a badge at all.

• Badge text

You can pick any text you'd like to display inside the badge.

• Metric card description

For more information, see "Configure Metric Card Badges and Descriptions."

Example of Badge Conditions
For example, the My Overdue Tasks metric card displays a badge above the card title under certain conditions. This
metric card has two conditions and displays a different badge depending on the number of overdue tasks.

My Overdue Tasks Metric Card Badges

Condition: Number of Overdue Tasks Badge Text

>= 5 and <=10
 

Warning
 

>10
 

Critical
 

If there are fewer than 5 overdue tasks, then no badge displays on the metric card.

Configure Metric Card Badges and Descriptions  
You can configure metric cards so that different badges and descriptions display depending on certain conditions. For
example, if a metric card displays 10 open leads, then maybe you'd like the warning badge to display. But if there are
only 2 open leads, then maybe you don't want a badge to display at all. You do this configuration in Oracle Visual Builder
Studio.

Prerequisites
A metric card displays data from a saved search. Before you add a metric card to the Sales Dashboard and configure it,
you must:

• Create the saved search

• Share the saved search with the appropriate job role

• Capture the UUID of the saved search from the URL on the list page. Here's a screenshot showing the location
of the UUID when you display the saved search.
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• Create a copy of the Sales Dashboard layout where you want to add the metric card. See the topic Duplicate the
Predefined Sales Dashboard Layout for details.

Overview of Setup Tasks
To configure the badges and descriptions for a metric card, complete these steps inside your Sales Dashboard layout:

1. Add a metric card region to the layout.
2. Specify the metric cards to display inside the region.
3. For each metric card, modify the card's badge properties:

a. Specify the badge type and its display text.
b. Specify the conditions when you want each badge type to display.
c. Add description text, if needed.

Example of Metric Card Conditions
To configure badges and descriptions on a metric card, you first determine the display conditions. Each condition is a
range of aggregate sum numbers that display on the metric card. For each range, you decide which type of badge and
description to display. For example, you can configure this type of setup:

• If fewer than 5 overdue tasks exist, then don't show a badge at all.

• If 5-10 overdue tasks exist, then show a warning badge.

• If more than 10 overdue tasks exist, then show a critical badge and a description.

You can also configure the metric card so that the card always displays the same badge or description regardless of the
aggregate sum on the card.

This setup is optional. If you skip this setup for a metric card, then no badges or descriptions will ever display on the
card.

Sequence of Conditions
When you define the display conditions for a metric card, the order of those conditions is important. Each condition
is evaluated in the order in which you define them, from top to bottom. Whichever condition is satisfied first is the
condition that's applied.

Badge Properties: Sample Format
For each metric card, the badge properties that you define must always follow a specific format. Here's a sample of the
required format. In this sample, there's only 1 UUID which means that there's only 1 metric card.

saved-searches-list="[[ [
 {
 queryUuid: '5141f8ab-3aa8-4c0e-adf8-0b3ebb3218ac',
 badgeProp: [
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 {badgeStatus:'success', lowerLimit: 0,upperLimit: 3, badgeText: 'All OK'},
 {badgeStatus:'warning', lowerLimit: 4, upperLimit: 5, badgeText: 'Please Check'},
 {badgeStatus:'danger', lowerLimit: 6, badgeText: 'Problem'}
 ]
 }
 ] ]]"

Badge Properties

Badge Property Description

badgeStatus
 

• danger

• info

• neutral

• success

• warning

Each type of badge (badgeStatus) displays with a specific color, which you can't change.
 
Here's an example of several badges and colors:
 

lowerLimit
 

Lower limit of the display condition for a specific badgeStatus.
 

upperLimit
 

Upper limit of the display condition for a specific badgeStatus.
 

badgeText
 

Text that appears on the badge. Each type of badge (badgeStatus) displays with default text, but you
can use this property to change it.
 

metaText
 

Text description for the metric card.
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Configure Badge Properties
To configure badges and descriptions for a metric card:

1. From the Sales Dashboard, enter into Oracle Visual Builder Studio. Under the Settings and Actions menu, select
Edit Page in Visual Builder Studio.

You should be on the salesday tab in Page Designer.
2. Duplicate a Sales Dashboard layout, for example, duplicate the Manager layout and accept the default name,

Manager (Copy).

See "Duplicate the Predefined Sales Dashboard Layout."
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3. On the Properties pane for the Manager (Copy) layout, click the + Add Section icon > + New Section.
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4. In the Create Section dialog, in the Title field, enter a section title, such as NewMetricSection, then click OK.

The newly added section is added to the bottom of the layout. Use the Move Up arrow to move the new section
to the top of the layout.
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5. Delete the existing Attention Tile for Sales Manager section.

6. Click the NewMetricSection link.

The template editor opens.
7. Click the Code button.

The NewMetricSection template displays with empty placeholder template tags.
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8. To add a new metric card region to the dashboard layout, enter this code between the existing placeholder
template tags.
<oj-cx-saleshub-tile>
 <oj-cx-iss-attention-card>
 </oj-cx-iss-attention-card>
</oj-cx-saleshub-tile>

Here's a screenshot of the new template code for a metric card:

9. Click the Design button.

10. On the Structure pane, click Sales Hub Tile Container.

11. On the Properties pane, on the All tab, enter 8x1 as the size.
12. Still on the Structure pane, click Sales Hub Attention Component.
13. Click the Code button.
14. Add this placeholder code inside the oj-cx-iss-attention-card opening tag:

saved-searches-list="[[ [
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 {
 queryUuid: '5141f8ab-3aa8-4c0e-adf8-0b3ebb3218ac',
 badgeProp: [
 {badgeStatus:'success', lowerLimit: 0,upperLimit: 3, badgeText: 'All OK'},
 {badgeStatus:'warning', lowerLimit: 4, upperLimit: 5, badgeText: 'Please Check'},
 {badgeStatus:'danger', lowerLimit: 6, badgeText: 'Problem'}
 ]
 },
 {
 queryUuid: 'b803d9db-8b59-44b9-8968-f3525ae62882',
 badgeProp: [
 {badgeStatus:'success', lower: 25, Upper: 35, badgeText: 'All OK'},
 {badgeStatus:'info', upper: 24, badgeText: 'Track'}
 ]
 }
 ] ]]"

In the above sample, there are 2 UUIDs. The UUID refers to the unique identifier of each saved search that
populates a metric card. Each UUID represents a single metric card.

Copy and paste the placeholder code to meet the number of metric cards you want to add to this region. For
optimal viewing, 6 or 7 metric cards is a good maximum number to include in this region.

15. Once you've adjusted the code with the number of UUIDs (metric cards) you need, you can now update the rest
of the code.

a. For each metric card, replace the sample UUIDs with the correct UUIDs of your saved searches.
b. For each UUID, optionally configure a badge properties section:

- Specify the type of badge to display.
- Define the conditions (upper and lower limits) under which each badge (and optionally a

description) will display.
- Optionally indicate the badge text. For example, does the text say Warning or Problem?
- Optionally specify a description.

Tips:

- You can specify only a lower limit without an upper limit (to indicate an aggregate sum that's
greater than 10, for example).

- You can add metaText without any range conditions. So, if none of the ranges apply, then show a
description on the metric card.

- If you don't want to display a badge or description at all, then just add the queryUUIDs. For
example:

saved-searches-list="[[ [
 {
 queryUuid: '5141f8ab-3aa8-4c0e-adf8-0b3ebb3218ac'
 },
 {
 queryUuid: 'b803d9db-8b59-44b9-8968-f3525ae62882'
 }
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 ] ]]"

Note:  The code that you add to the template editor displays in the List of Saved Searches field on the
Properties pane.

16. Click the Preview button to see your changes in your runtime test environment.

Add a Visualization to the Sales Dashboard  
You can add visualizations of saved searches or for Oracle Analytics Cloud analyses. Digital Sales (Next Gen Sales)
delivers a set of predefined visualizations, or you can configure custom visualizations using the Visualization
Configurations page. This topic walks you through how to add both predefined and custom visualizations to the Sales
Dashboard.
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Predefined Visualizations
Digital Sales includes these predefined visualizations which you can add to a Sales Dashboard layout where needed:

• My Earnings by Period

• My Team's Deal Size Chart

• My Team's Leads Size Chart

• My Team's Performance Chart

• My Team's Pipeline Chart

• Sales Pipeline Chart

• Template for Chart

To create your own visualizations, follow the instructions in the topic Create a Visualization of a Saved Search or an
Analysis.

Prerequisites
Before you start you must create a copy of the sales dashboard layout in Visual Builder Studio. See Duplicate the
Predefined Sales Dashboard Layout for details.

Add a Predefined Visualization to the Sales Dashboard
1. In the copy of the layout, for example, Manager (Copy), review the layout's condition to ensure that the correct

role is specified for this layout.
2. You're now ready to add a predefined visualization to your copy of the Sales Dashboard. In this example, we're

adding the Sales Pipeline Chart to the Sales Dashboard for sales managers.

On the Properties pane for the Manager (Copy) layout, click the + Add Section icon.
3. Click Sales Pipeline Chart.

The newly added Sales Pipeline Chart is added at the bottom of the layout. You can change the order the
sections are displayed. Just use the Move Up and Move Down arrows in the Sections region.

4. Click the Preview button to see your changes in your runtime test environment.

Add a Custom Visualization to the Sales Dashboard
If you previously created your own visualizations using the Visualization Configurations page, then you can add them to
any Sales Dashboard layout:

1. In the copy of the Sales Dashboard layout, for example, Manager (Copy), review the layout's condition to
ensure that the correct role is specified for this layout.

2. On the Properties pane for the Manager (Copy) layout, click the + Add Section icon > + New Section.
3. In the Create Section dialog, in the Title field, enter a section title, such as My DV Chart, then click OK.

Note:  The title is the name of the section, not how the section will appear at runtime on the dashboard. The
runtime title comes from the chart-title field which you set later in this procedure.
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The newly added section is added to the bottom of the layout. You can change the order the sections are
displayed. Just use the Move Up and Move Down arrows in the Sections region:

4. Click My DV Chart.

The template editor opens.
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5. Click the Code button.

All custom sections that you've created for this dynamic container, if any, display in the editor.

Your new My DV Chart section displays at the bottom with empty placeholder template tags.

6. For a visualization, enter this code between the existing placeholder template tags.

<oj-cx-saleshub-tile>
 <oj-cx-iss-dv-chart>
 </oj-cx-iss-dv-chart>
</oj-cx-saleshub-tile>

Here's a screenshot of the new template code for a visualization:

7. Click the Design button.
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8. On the Structure pane, click Sales Hub Tile Container.

9. On the Properties pane, on the All tab, select 2x2 as the size.

10. Still on the Structure pane, click oj-cx-iss-dv-chart.
11. On the Properties pane, in the Title field, enter My Team's Pipeline.
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12. In the Configuration Number field, enter the reference number of the visualization that you previously created
on the Visualization Configurations page.

For more information about creating visualizations, see Create a Visualization of a Saved Search or an Analysis.
(Visualizations can be added to both CX Sales Mobile layouts as well as Sales Dashboard layouts.)
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13. Click the Preview button to see your changes in your runtime test environment.

 

Add an Oracle Analytics Component to the Sales
Dashboard  
You can embed content created in Oracle Analytics Cloud into the Sales Dashboard using Oracle Visual Builder Studio.

For more information about the Oracle Analytics embedding framework, see the Oracle Cloud Visualizing Data and
Building Reports in Oracle Analytics Cloud guide.

Here's an example of an Oracle Analytics component:
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Prerequisites
Before adding an Oracle Analytics component to the Sales Dashboard, you must:

1. Retrieve the Object ID from your existing Oracle Analytics content:

a. Navigate to the Oracle Analytics Host where the analytics workbook is saved.
b. Click the Actions menu > Inspect.

c. Next to the Object ID, click Copy.
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d. Paste the Object ID, along with the Oracle Analytics Host URL, into a separate file for later use. For
example:

i. Oracle Analytics Host:

https://oac01-gse00010001-px.analytics.ocp.oraclecloud.com/

ii. Object ID:

/@Catalog/users/oac01.user/Win-Loss Analysis

2. Create your own workspace in Visual Builder Studio if you don't yet have one.

For more information, see "Create Your Own Workspace" in the Oracle Fusion Cloud Sales Automation
Extending Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

3. Add the Analytics Canvas component to your workspace.

a. Click the Components side tab in Visual Builder Studio.
b. Use the search field to find the Analytics Canvas component.
c. Click Install.
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4. Create a copy of the Sales Dashboard layout in Visual Builder Studio. See Duplicate the Predefined Sales
Dashboard Layout.

Add an Oracle Analytics Component to the Sales Dashboard
1. In a copied version of the Sales Dashboard layout, such as the Manager (Copy) layout, review the layout's

condition to ensure that the correct role is specified for the layout.
2. On the Properties pane for the Manager (Copy) layout, click the + Add Section icon > + New Section.
3. In the Create Section dialog, in the Title field, enter a section title such as OAC Section, then click OK.

Note:  The title is the name of the section, not how the section will appear at runtime on the dashboard. The
runtime title comes from the header attribute that you define for the component in step 6.

The newly added section is added to the bottom of the layout. To reorder sections, use the Move Up or Move
Down arrows in the Sections region.

4. Click OAC Section.

The template editor opens.
5. Click the Code button.

All custom sections that you've created for this layout display in the editor.

Your new OAC Section section displays at the bottom with empty placeholder template tags.

6. For an Analytics Canvas component, enter this code between the existing placeholder template tags.

<oj-cx-saleshub-tile size="8x5">
 <h2 class="oj-typography-heading-sm">Win Loss Analysis</h2>
 <oj-sp-analytics-canvas></oj-sp-analytics-canvas>
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</oj-cx-saleshub-tile>

Here's a screenshot of the new template code:

Tip:  The value of the size attribute defines the size of the component on the Sales Dashboard. Use "8x5" to
take the full width of the dashboard.

7. Click the Design button.
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8. On the Structure pane, click Analytics Canvas.

9. On the Properties pane, in the Oracle Analytics Host field, enter the host URL that you previously saved, such as
https://oac01-gse00010001-px.analytics.ocp.oraclecloud.com/.

10. In the Project Path field, enter the repository path of the project to render, such as /@Catalog/users/
oac01.user/Win-Loss Analysis.

This is the Object ID of the Oracle Analytics workbook that you previously saved.
11. Optionally click the Code button to view the template code. The code will look something like this:

<oj-cx-saleshub-tile size="8x5">
 <h2 class="oj-typography-heading-sm">Win Loss Analysis</h2>
 <oj-sp-analytics-canvas host="https://oac01-gse00010001-px.analytics.ocp.oraclecloud.com/"
 project-path="/@Catalog/users/oac01.user/Win-Loss Analysis"></oj-sp-analytics-canvas>
</oj-cx-saleshub-tile>
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12. Click the Preview button to see your changes in your runtime test environment.

For example:

13. Click Publish to apply the changes to the Sales Dashboard.

For more information, see "Share and Publish Your Application Extension" in the Oracle Fusion Cloud
Sales Automation Extending Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle
representative.
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19  Sales Territories and Assignment

Setup Overview  
If you assign accounts and opportunities to salespeople by address, product, industry, or other criteria, this chapter is
for you.

You learn how to set up a sales territory hierarchy to automatically provide salespeople with access to the accounts and
opportunities they need to work on. Although you set up Sales Territories in the CX Sales UIs, sales territories apply to
both CX Sales and Digital Sales UIs.

The hierarchy you build also provides the reporting hierarchy used for forecasting and for assigning quotas. Salespeople
access both forecasting and quotas using the CX Sales UI.

The sales territory hierarchy is separate from the resource hierarchy you built earlier when you created sales users. Both
hierarchies provide access to opportunities: the owners of parent sales territories gain access to opportunity data in
child territories in the same way as resource managers gain access to the opportunities of the resources reporting to
them. However, forecasting and quotas rely on the sales territory hierarchy. If you want sales managers to forecast and
work quotas, create a sales territory hierarchy that includes those sales managers.

Note:  If your salespeople forecast only the opportunities they own and you don't need to assign opportunities to
them automatically by address or other criteria, then you can skip this chapter entirely. That's because, for this use
case, the application sets up everything you need. It sets up a territory structure that mirrors your sales organization
hierarchy. And it automatically assigns the opportunity to the opportunity owner's territory. The opportunity revenue
gets included in the owner's forecast and passed up the management chain for adjustment and approval. The
Forecasting chapter provides the details.

Here are the steps for setting up sales territories and assignment.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Digital Sales and CX
Sales

Enable the territory
dimensions you plan to use
in your territories.
 

Setup and Maintenance >
Sales > Territories >
Enable Dimensions and
Metrics
 

See the topic: Enable Sales
Territory Dimensions
 

2
 

Both Digital Sales and CX
Sales

Create a territory proposal.
A proposal is a sandbox
that permits you to update
territories without affecting
any existing territory setup.
 

Navigator > Territories
 

See the topic: Create a
Territory Proposal
 

3
 

Both Digital Sales and CX
Sales

Create the hierarchy of
sales territories in the
proposal starting with the
top territory and working
your way down. You can
get an overview of some of
the techniques you can use

Navigator > Territories
 

See the topic: Create the
Sales Territory Hierarchy
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Step Applies To Description Navigation Where to Get More Details

for the setup in the Sales
Territory Use Cases section.
 

4
 

Both Digital Sales and CX
Sales

Activate the territory
proposal.
 

Navigator > Territories
 

See the topic: Activate the
Territory Proposal
 

5
 

Both Digital Sales and CX
Sales

Enable automatic
assignment of sales
territories to imported
accounts by setting the
following system profile
options to Yes:
 

• Sales Account
Automatic
Assignment on Import
Enabled

• Sales Account
Automatic
Assignment on Create
Enabled

• Sales Account
Automatic
Assignment on
Update Enabled

Setup and Maintenance >
Sales > Foundation >
Manage Administrator
Profile Values
 

See the topic: Enable
Automatic Assignment of
Imported Accounts
 

6
 

Both Digital Sales and CX
Sales

You can enable automatic
assignment of territories to
opportunities whenever the
opportunities are updated.
 
By default, the application
automatically assigns sales
territories to accounts
whenever an account is
created or updated, but
opportunity assignment
isn't automatic. Sales users
must trigger opportunity
assignment manually while
editing an opportunity
or they must wait for the
opportunity assignment
process to run.
 
Oracle specifies manual
opportunity assignment
as the default to prevent
performance issues for
companies with a large
number of opportunity
lines (100,000 and up).
 
If your organization
doesn't have such a large
volume, then set the profile
Assignment Submission at
Save Enabled to Yes. Oracle

Setup and Maintenance >
Sales > Opportunities >
Manage Opportunity
Profile Options
 

See the topic: Make
Opportunity Assignment
Automatic
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Step Applies To Description Navigation Where to Get More Details

also recommends a setting
of Yes for forecasting.
 

7
 

Both Digital Sales and CX
Sales

Run the account and
opportunity assignment
processes (Request
Account Assignments and
Revenue Territory Territory
Based Assignment)
immediately after setting
up sales territories and on
a regular schedule, perhaps
once every day during off-
peak hours.
 

Navigator > Tools >
Scheduled Processes
 

See topics:
• Run the Account

Assignment Process

• Run the Opportunity
Assignment Process

 

Sales Territories and Assignment  
Getting assigned to a sales territory provides salespeople with access to accounts and opportunities. Sales territories
also provide the framework for forecasting. Salespeople can forecast only opportunity lines in their territories and
forecasts roll up the territory hierarchy.

How You Gain Access to Sales Data
All salespeople can view basic account information, including customer names, contacts, and addresses. You must
have additional access to view the opportunities on the account, and to share all the details you need to collaborate
during the sales process. Information that requires additional access includes customer interactions, to-do lists,
and appointments. Without the additional access, you can't share collateral, and collaborate on presentations. If you
implement Microsoft 365 or Mobile, then only the accounts that are part of a salesperson's territory are downloaded
and synchronized. Here's how you get access to additional sales information:

• You're the owner of the record.

Each record must have an owner. You automatically become the owner of any record you create. The owner,
who is automatically a member of the team on the record, has full privileges, including the ability to edit the
record and add others to the team. The record owner or the sales administrator can reassign ownership of
individual records. The sales administrator can also reassign ownership of multiple records at the same time
using the Mass Transfer feature available in the Navigator. Users converting a lead to an opportunity, can also
assign the owners of the resulting accounts and opportunities.

• You're a member of the team on the record.

The owner can add members manually and assign different levels of access to them: view only, edit, or full (the
ability to add others). For opportunity and lead teams, you can also assign team members automatically using
assignment rules.
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• You're the owner or a member of a sales territory assigned to the record or owner or member of the parent
territories in the sales territory hierarchy.

Being the owner of a territory makes gives you additional privileges over a member: owners can review and
submit forecasts up the sales territory hierarchy.

Note:  While the territory name is always listed in each record that's assigned to a territory, opportunities also
copy over the names of the territory members to the opportunity team. Lead teams and account teams don't
include the territory team members. If you want to make the opportunity team behavior consistent with leads
and accounts, you can set the system profile option Territory Based Resource Assignment Style as described
in the Opportunity Profile Options Default Values and Effects topic in the Implementation Reference guide.

• You're a manager in the resource hierarchy of the resource with access.

Managers in a salesperson's resource management hierarchy have automatic visibility to their team's set of
accounts, contacts, opportunities, leads, and other information. They don't have to be explicitly assigned to
each territory or team. The resource hierarchy provides you access to sales data, but not to forecasts. Only
territory owners can view forecasts. Most Oracle customers create a sales territory hierarchy that matches the
resource hierarchy, so a manager is also the owner of the territory, but the two can be different.

• You're assigned to an access group.

Access groups provide an alternate way of providing access to sales data based on conditions you define. For
example, you can use access groups to grant specific users access to all open opportunities, or all accounts in
the UK, and so on. Access groups aren't replacements for sales territories, but they provide a good way to grant
access to people who assist with sales. For example, you may need to provide the legal department with access
to certain opportunities.

• You're a sales administrator (a user with the Sales Administrator job role).

Sales administrators have access to everything.

• The implementation team configures and assigns job roles with different privileges.

You can change the default access levels, by copying and modifying the existing job roles. See the Create and
Edit Job, Abstract, and Duty Roles chapter of the Securing CX Sales and Fusion Service guide for more details.

How You Grant Additional Access Automatically
You can provide salespeople access by manually reassigning record ownership or adding someone to the team on the
record, or you can automate the process using one or both of the following methods:

• Assign access using sales territories.

You can set up the sales territory boundaries based on a wide variety of factors, called dimensions. The most
common dimensions include address, product, customer size, customer type, and industry. Many Oracle
customers also define their own additional dimensions.

When you assign salespeople using territories, the territories themselves become associated with the account,
opportunity, or lead. If you later realign your sales territories or if there's a turnover in your sales organization,
then the assignments reflect those changes automatically after you run the assignment process.

The application assigns territories for each individual opportunity line separately. If an opportunity line gets
assigned to your territory, you automatically gain access to the whole opportunity. If Lisa Jones' territory
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includes servers and Julian Henderson's laptops, both salespeople get access to an opportunity that includes
servers and laptops.

• Assign opportunity and lead access to specific individuals by creating assignment rules.

You can use rules to assign individual salespeople you specify to lead and opportunity teams if the rule
conditions are met. Rules are the primary way of assigning salespeople to leads, and so rule setup is covered
in the Leads chapter. For opportunities, you can create rules to assign additional salespeople using factors
that aren't covered by sales territories, such as deal size or product knowledge. Creating rules to supplement
territory assignment requires additional setup, including the setting of system profile options not covered in
this guide. See the Implementation Reference guide for details.

Salespeople can trigger assignment manually or you can assign leads, accounts, and opportunities automatically by
running assignment processes.

Sales Territory Boundaries
You define sales territory boundaries by the values you assign to their dimensions. For accounts, the territory
dimensions provided by Oracle include:

• Address

Define territories by address elements such as city, state, and postal code.

• Geography

Legacy dimension that existing customers are using for geographical territories. While you can still use
Geography to set up territories by states and other address elements, new Oracle customers should use the
Address dimension instead. You can't use this dimension together with the Address dimension.

• Account type

The account type specifies if the account is named or not.

• Customer size

• Industry

• Organization type

You can also create classification categories to define up to three additional dimensions.

Because opportunities are associated with an account, you can use the account dimensions to assign opportunities as
well. Opportunities and leads have these additional dimensions:

• Business unit

• Product

You can enter product groups or individual products from the sales catalog.

• Sales channel

The available sales channels are: Direct, Indirect, and Partner.

Related Topics
• Opportunity Profile Options Default Values and Effects
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Address Dimension  
Use the Address dimension to set up sales territories by a combination of address elements, such as state, city, and
postal code.

The application uses pattern matching for assignment, so you must include all variations of spellings that exist in your
data in the territory definition. The cleaner and the more consistent your data, the less work you have to do.

When you define each territory, you can enter multiple rows of address elements:

• All the entries in a row must match for assignment (AND operator)

• If you enter multiple rows, one of the rows must match for assignment (OR operator)

Here's how the entries are matched:

• For all of the address attributes except Postal Code, the application uses exact matches. When you define the
coverage for a territory, you must include all the possible spellings that exist in your address data. The match
must be exact, but matches aren't case-sensitive, so you don't have to include TX and Tx as separate spellings,
for example.
If you're creating a territory for the state of Texas, you may need to include these different spellings, depending
on what's in your data: TX, Tex, Tex., and Texas.
You enter these spelling variations as four separate lines in the Texas state territory definition. The country is
always required.

Country State

United States
 

TX
 

United States
 

Tex
 

United States
 

Tex.
 

United States
 

Texas
 

Here's how you could define a territory for the city of Dallas, Texas:
◦ You need both state and city to match.

◦ Dallas must be spelled correctly in your data every time.

Country State City

United States
 

TX
 

Dallas
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Country State City

United States
 

Tex
 

Dallas
 

United States
 

Tex.
 

Dallas
 

United States
 

Texas
 

Dallas
 

• To match by postal codes, such as US ZIP codes, you can enter ranges of values or partial values. Here are the
rules:

◦ You can enter ranges of values and the ranges don't have to be valid postal codes. For example:
94501-94599.

◦ Use the percent sign (%) at the end of an entry to indicate partial matches. For example, you can enter
940% to indicate all the postal codes starting with 940.

◦ You can't use the percent sign for ranges.

◦ You can use US ZIP+4 postal codes in ranges, provided you enclose them in double quotation marks, for
example: "94065-0000"-"94070-9999".

If there's a chance that some of your Dallas addresses don't include the city, then you could add a line to your
Dallas territory definition to enable assignment by postal code:

Country State City Postal Code

United States
 

Any
 

Any
 

75001 - "75222-9999"
 

Here's an explanation:

◦ The country is required, but the values for state and city are Any because you're matching only the postal
code. There's an implicit AND operation in each row, so if the postal code doesn't match, the account
won't get assigned to the territory even if you specified the city.

◦ The upper limit of the postal code range is "75222-9999" to include addresses with ZIP+4 postal codes.
Entering 75222 as the upper limit wouldn't assign addresses with 75222-0002. The double quotation
marks are required because you're entering a code with a hyphen. The entry for the upper limit isn't a real
postal code, but that's OK for the pattern matching.

Here are a few more examples of postal code territories:

Country State Postal Code Explanation

United States
 

Any
 

940%
 

Territory for all the postal
codes starting with 940%,
 which include most of the San
Francisco peninsula.
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Country State Postal Code Explanation

United States
 

Any
 

94065 - 94070
 

Territory for Redwood City and
San Carlos, California.
 
The rule doesn't assign accounts
with 94070 ZIP+4 codes in
the address because these are
higher numerically than 94070.
For example, this rule won't
assign a San Carlos account at
an address with the postal code
94070-0121.
 

United States
 

Any
 

94065 - "94070-9999"
 

Territory for Redwood City and
San Carlos, California.
 
This version correctly assigns
accounts with 94070 ZIP+4
code, including 94070-0121.
 

Postal Code Assignment Example
Here's an example of how accounts are assigned using postal codes. Suppose you set up the following three territories:

Territory Name Country State City Postal Code

San Francisco
 

United States
 

Any
 

Any
 

941%
 

Western Arizona
 

United States
 

Any
 

Any
 

853%
 

Phoenix, Arizona
 

United States
 

Any
 

Any
 

85000-85299
 

When you run assignment on the following accounts:

Account Name Address

Blue Semiconductor
 

100 Main Street, Phoenix, AZ 85254
 

Fantastic Laptops
 

500 East Main Street, Avondale, AZ 85338
 

First Software
 

2361 21st Avenue, San Francisco, CA
 

Compucon 500 Spear Street, San Francisco CA 94105-1548
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Account Name Address

  

You get these territory assignments:

Account Name Assigned Territory

Blue Semiconductor
 

Phoenix, Arizona
 

Fantastic Laptops
 

Western Arizona
 

First Software
 

Not assigned to any of the territories because the postal code is missing.
 

Compucon
 

San Francisco
 

Available Address Elements
When you enable the Address dimension, you can enable any of the following address elements. You can use the
additional attributes to accommodate the address elements that are required for some countries.

• Country

• State

• Province

• County

• City

• Postal Code

• Additional Attribute 1

• Additional Attribute 2

• Additional Attribute 3

• Additional Attribute 4

• Additional Attribute 5

How Sales Territories Support Assignment and
Forecasting  
Here's how sales territories support automatic assignment and sales forecasting.
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Sales Territory Assignment
Sales territory assignment matches the values that you enter in the territory dimensions to the records you're assigning.
The application:

1. Evaluates all territories regardless of their position in the sales territory hierarchy to see if there's a match.
2. Discards the ancestors of any of the matching territories.

Here's an example to illustrate how sales territories work in assignment and forecasting. Consider a simple territory
hierarchy for a company that sells laptops and servers in the US:

• The company divides the US states and assigns them to two territories: East and West.

• The East and West territories are divided into two territories, one territory sells laptops and the other sells
servers.

• The company requires only two territory dimensions to define territories: address and product.

Here's what the sales territory structure looks like:

Here are the values that you enter in the address and product dimensions for the example:

• A value of Any means that all values, even a missing value, match.

• The top territory in this hierarchy has a value of Any across all the dimensions making it the overall catchall
territory.

The application assigns all records not matching any of the coverage values of other territories to the overall
catchall territory.

• The West and East territories have a value of Any for the Product dimension. They are the catchall territories for
any opportunities in those regions for products other than laptops and servers.

Territory Name Address Product

US Product Sales
 

Any
 

Any
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Territory Name Address Product

West
 

States in the western US
 

Any
 

East
 

States in the eastern US
 

Any
 

West Laptops
 

States in the western US
 

Laptops
 

West Servers
 

States in the western US
 

Servers
 

East Laptops
 

States in the eastern US
 

Laptops
 

East Servers
 

States in the eastern US
 

Servers
 

To assign accounts, assignment uses the address of the account only (there's no product information available in
accounts). Here's how the application assigns an account with an address in New York:

1. Finds the following matching territories: East Laptops, East Servers, East, US Product Sales.

East Laptops, East Servers, and East territories include New York explicitly in the list of states. US Product Sales
has the value of Any in the address dimension.

2. Discards East and US Product Sales because these are parents and grandparents of the East Laptops and East
Servers.

The application assigns the account to the East Laptops and East Servers territories.

For assigning opportunities, the application assigns each opportunity line separately. The assignment process uses the
address of the account (each opportunity must be associated with an account). For example, here's how the application
assigns an opportunity for servers and laptops in a New York account.

Here's how the application assigns the servers opportunity line:

1. Finds these matching territories: East Servers, East, and US Product Sales

East Servers includes the correct product and state. East includes the state and Any as the value for the
product. US Product Sales matches because it has Any for both dimensions.

2. Discards East and US Product Sales because these are parents and grandparents of East Servers.

The application assigns the opportunity line to the East Servers territory. The application uses the same process to
assign the laptop opportunity line to the East Laptops territory.

For the matching territories, assignment gives each territory owner edit access to the opportunity as a whole, and both
territories are listed on the opportunity Team tab. Only the matching opportunity line is included in forecasts for that
territory, however.

Here's a diagram that illustrates the different effects of territory assignment on opportunity access and forecasting. The
diagram shows an opportunity for laptops and servers. Here's what happens when agent A owns the laptops territory
and agent B owns the servers territory:

• Both agents gain edit access to the opportunity as a whole.

• Agent A can only forecast laptops.
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• Agent B can only forecast servers.

• Agent A's and Agent B's managers (who are also the owners of the parent territories) gain access to the
opportunity as a whole, but they get to view and adjust only the forecasts submitted by their subordinates.

• The colleagues of agents A and B don't have any visibility into the opportunity unless they have edit access to
the account.

The Importance of Catchall Territories
Some of the values required for assignment may be missing from the records you're assigning and you may have gaps
in your territory coverage. For these reasons, you must set up one or more catchall territories with Any as the value for
each of your territory dimensions. The value of Any means that any value, even a missing value, is a match. The owner
of the catchall territory, or another user you assign as a territory member, must monitor the catchall territory for records
that didn't get assigned properly. You can adjust your territory structure over time to minimize the number of records
assigned to the catchall territories.

Using the sample territory setup, an opportunity for service (a product not specified in any territory) in a Japanese
account (a country not specified in any territory) is assigned to the overall catchall territory. An opportunity for service in
California, gets assigned to the West territory because the West territory includes the rule: Country=US, State=CA.
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How Sales Territories Work for Forecasting
You can enable two types of forecasts: Prime and Overlay. Forecasts designated as Prime forecast sales revenue.
Overlay forecasts are designed to permit any overlay organization, such as sales support, to create a separate forecast.
The overlay forecast isn't included as part of the sales revenue forecast. How forecasting works depends on the
hierarchy of the sales territories you set up and the value you enter in the Enable Forecasting field for each territory. The
Enable Forecasting field can have these values:

Enable Forecasting Field Value Explanation

Prime only
 

The territory owner can forecast and adjust the sales revenue forecasts.
 

Overlay only
 

The territory owner can forecast and adjust forecasts that are not counted in the sales revenue
forecast.
 

Prime and Overlay
 

The territory owner can adjust both types of forecasts.
 

Disabled
 

The territory owner is excluded from creating or reviewing forecasts.
 

The sales territory hierarchy that you set up determines how forecasts are passed up for adjustment and approval. In
the example, the East Laptops and East Servers forecasts are automatically submitted to the owner of the East territory
for adjustment. Then the forecasts are passed on to the US Product Sales territory owner. The western forecasts mirror
that process.

Sales Territory UIs for Different Uses  
You have the option of using multiple UIs to manage sales territories. You can make changes to individual territory
coverage and other adjustments in Workspace and in the Territories tab of the Territories work area. For creating
territory hierarchies, you must use the Sales Territories Hierarchy tab of the Territories work area.

The Territories work area includes two tabs: a full-featured UI that's designed for setting up the territory hierarchy and a
simpler UI that you can use for ongoing minor adjustments to territories after they're set up. Users can toggle between
the two UIs by clicking the Territories and Sales Territories Hierarchy tabs on the left side of the Territories work area
or in Workspace.

Territories Tab for Making Changes to Individual Territories
When you open the Territories work area, the application displays the Territories tab. The tab is optimized for sales
managers who want to make simple changes to individual territories, such as changing territory owners or minor
tweaks in coverage.
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On this tab, you can add any prospect accounts as named accounts in your sales territories. In the Sales Territory
Hierarchy Tab, the prospect accounts you add must be part of an account hierarchy below a customer account.

Note:  If you want to use add accounts of type prospect to sales territories, make sure that the profile option Account
Types Enabled for Assignment (ZCA_ASSIGNMENT_ACCT_TYPE_ENABLED) is enabled for prospects by setting the
profile to ZCA_CUSTOMER,ZCA_PROSPECT, see the topic Enable Prospects for Inclusion in Sales Territories.

Sales Territories Hierarchy Tab for Building Your Sales Territory Hierarchy
To build sales territory hierarchies, you use the Sales Territory Hierarchies tab. On the Sales Territories Hierarchy tab,
territory setup is done not on live territories, but in a proposal that you must activate after your setup is complete.
Proposals make it possible to make territory revisions without affecting live territories and to create different versions to
be used at different times.

Here's a screenshot of the Active Territories page on the tab. The callouts highlight and describe different features on
the page.

Callout Number Feature Description

1
 

The left pane of the Active Territories page displays the active territories as a collapsible hierarchy.
 

2
 

Selecting a territory, displays territory details at the bottom of the page.
 

3
 

Using the Manage Proposals button, you can create territory proposals with your territory changes.
 

4
 

The Show Dimensions,Hide Dimensions button lets you toggle the display of dimension details in the
list of active territories.
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Differences Between the Two UIs
Here are the major differences between what you can do in the two UIs. Whichever UI you're using to make your
territory changes, your records aren't reassigned until the appropriate assignment process runs.

Feature Sales Territory Hierarchies Tab Territories Tab

Changing a territory owner or member
 

Your changes aren't effective until you activate
the proposal.
 

Your changes take effect immediately.
 

Making changes without immediately effecting
live territories
 

You create territories in a territory proposal
that isolates your changes from existing active
territories until you activate. You can even
decide to create different proposals to go live
in the future, to account for seasonal sales
demands, for example.
 

Territory proposals aren't available. Changes
you make to territories are immediate.
 

Inheriting the properties of parent territories
 

When you create child territories in both UIs,
 the child territories automatically inherit
the properties and coverage of the parent

At creation, the child territories automatically
inherit the properties and coverage of the
parent territories. However, in the Territories
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Feature Sales Territory Hierarchies Tab Territories Tab

territories. In the Sales Territory Hierarchies
Tab, you can also link territories so that any
subsequent change in coverage for the parent
territory is automatically reflected in the linked
territory.
 

tab UI, you can't link the territories to make
subsequent coverage changes reflected
automatically.
 

Include prospect accounts in sales territories as
named accounts.

You can only add prospect accounts that are
part of an account hierarchy and below an
account of type customer.

You can add any prospect account to a territory.

How You Can Make the Sales Territory Hierarchies UI the Default and Only
UI
By default, users can toggle between both UIs using the tabs. You can make the Sales Territory Hierarchies UI the default
UI and remove the tab controls. To change the defaults, all you have to do is set the system profile option Default to
Territory Classic Interface (MOT_DEFAULT_CLASSIC_INTERFACE) to Yes. The setting, which is made at the site level,
affects all users. You can edit the system profile value option from the Setup and Maintenance work area using the
following:

• Offering: Sales

• Functional Area: Sales Foundation

• Task: Manage Administrator Profile Values

Use Workspace for Resolving Territory Gaps and Overlap Issues
Managers who need to resolve territory gaps and overlap issues in existing territories, can also use Workspace. Both
Workspace and the Territories work area let you search for territories not only by salespeople but also by dimension
coverage details, such as included accounts, products, or geographies. The territories features in Workspace are the
same as in the Territories tab in the Territories work area. What Workspace doesn't have is the ability to create and
manage hierarchies. For that you must go to the Territories work area.
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Can I include a prospect account in a sales territory?  
Yes, you can include prospects as named accounts in sales territories.

Note:  Make sure that the profile option Account Types Enabled for Assignment
(ZCA_ASSIGNMENT_ACCT_TYPE_ENABLED) is enabled for prospects by setting the profile to
ZCA_CUSTOMER,ZCA_PROSPECT.

To add prospects to territories, use the Territories tab in the Territories work area. The Sales Territories Hierarchy tab,
where you set up territory hierarchies using proposals, limits how you can add them. Here are the details of what you
can do in each tab.

Territories Tab
On the Territories tab, you can add any account of type prospect to a live territory.

Sales Territories Hierarchy Tab
On the Sales Territory Hierarchy tab, you can:

• You can add prospect accounts only if they're child members of an account hierarchy for accounts of type
customer.

• View and delete prospect accounts. These include prospect accounts that you added on the Territories tab that
aren't part of a hierarchy.
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Sales Territory Use Cases  

Overview  
This section uses very simple examples to illustrate how you set up sales territories to provide salespeople access to
accounts and opportunities and how you enable them to forecast.

The examples use the two most frequently used dimensions: address and product. Here's what they cover:

• Automatically assigning access to individual salespeople by product or address.

• Automatically assigning access only to managers when salespeople manage and sell to their own accounts.

• Handling territories that don't roll up neatly by address or by product and to separate assignment and
forecasting.

• Automatically assigning product specialists and others to help with a particular opportunity line using special
territories, called overlay territories.

• How to set up catchall territories so executives don't have to troubleshoot territories.

• Ignoring or hiding the owner fields in the account and opportunity UIs and relying exclusively on sales
territories and assignment rules to determine access.

As a rule, if you can draw the boundaries of sales territories along some dimension, then you should use sales territories
to automatically assign access to accounts and opportunities to individual salespeople. Assigning salespeople using
territories makes it easy for you to change the assignment when salespeople leave or are hired and to perform sales
territory realignment. When you're realigning territories to balance the workload and to reward your top performers, you
can experiment with different what-if sales territory scenarios in territory proposals. If you're dividing your territories by
address and by product, then you can draw the territory boundaries for individual salespeople by either dimension.

Salespeople in a Region Sell Different Products to the Same
Customers  
Suppose, for example, that salespeople in a particular region sell different types of products to the same customers. You
want salespeople to coordinate their engagement with each customer and to be always included on those opportunities
that involve their products.

You know which salespeople work in each region, so you can use territories to provide them with edit access to all
accounts in their region using the address dimension. You can then assign salespeople to opportunities when their
products are involved using the product dimension.

Territory Setup
The US product sales organization is divided into two regions: West and East. Each regional office includes a manager
and two salespeople who sell different products: one sells laptops and the other servers.

Here's a diagram of the sales territory hierarchy. You must always create at least one catchall territory with the value of
Any for each of your dimensions. The overall catchall territory is the topmost territory (callout 1), but both the West and
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East territories serve as catchall territories for the product dimension. For the Address dimension, you must list every
state in each territory.

Here are the key entries for the territories in this example. Territory Type is always set to Prime because all territories
are used for sales revenue forecasting. The Enable Forecasting field is always set to Prime only, enabling the territory
owner to participate in sales revenue forecasting. For the Address dimension coverage, you must enter a separate line
for every state.

Territory Name Territory Type Address Product Enable Forecasting

US Product Sales
 

Prime
 

Any
 

Any
 

Prime only
 

East
 

Prime
 

• Country: United
States, State: NY

• Country: United
States, State: NJ

• Country: United
States, State: MA

And entries for all the
remaining 22 states in the
eastern half of the US
 

Any
 

Prime only
 

East Laptops
 

Prime
 

• Country: United
States, State: NY

• Country: United
States, State: NJ

• Country: United
States, State: MA

And entries for all the
remaining 22 states in the
eastern half of the US
 

Laptops
 

Prime only
 

289



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 19
Sales Territories and Assignment

Territory Name Territory Type Address Product Enable Forecasting

East Servers
 

Prime
 

• Country: United
States, State: NY

• Country: United
States, State: NJ

• Country: United
States, State: MA

And entries for all the
remaining 22 states in the
eastern half of the US
 

Servers
 

Prime only
 

West
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

And entries for all the
remaining 22 states in the
western half of the US
 

Any
 

Prime only
 

West Laptops
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

And entries for all the
remaining 22 states in the
western half of the US
 

Laptops
 

Prime only
 

West Servers
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

And entries for all the
remaining 22 states in the
western half of the US
 

Servers
 

Prime only
 

How Assignment Works for This Scenario
When a lead comes in for a potential customer with an address in California who is interested in purchasing laptops, the
inside sales team converts the qualified lead into an account and opportunity. The application does the following:

• Assigns the West Laptops and West Server territories to the account because California matches the address
dimension. The owners of the territories gain full access to the account and can share information about their
interactions with the customer. Full access means they can add other team members in addition to editing the
account information itself.
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• If the account is missing the state in the address, the application assigns the account to the catchall territory, US
Product Sales.

• Assigns the West Laptops territory to the opportunity line using the product dimension and the address of the
account. The laptop revenue can now be forecast by the West Laptops territory owner.

• If the opportunity line for the California account is for products other than laptops and servers, then the
application assigns the opportunity line to the West territory.

Salespeople Sell All Products to Customers in Their Region  
If you draw boundaries purely by address elements in a geographical region, then each salesperson handles customers
in their particular region and sells all of the products into that region.

Territory Setup
Here's a diagram of a sample territory structure. The West and East regions split the states in the US. Each of the two
regional territories are split again. You must list every state in each territory.

Here are the territories for this example and the key entries for each. For the Address dimension coverage, you must
enter a separate line for every state. The Product dimension value is always Any because salespeople sell all products.
You could choose not include the Product dimension at all if you're not going to be using products for assignment
elsewhere in your territory hierarchy. The Territory Type is always set to Prime and the Enable Forecasting field to Prime
only

Territory Name Territory Type Address Product Enable Forecasting

US Product Sales
 

Prime
 

Any
 

Any
 

Prime only
 

East
 

Prime
 

• Country: United
States, State: NY

Any
 

Prime only
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Territory Name Territory Type Address Product Enable Forecasting

• Country: United
States, State: NJ

• Country: United
States, State: MA

• Country: United
States, State: FL

And entries for all the
remaining 21 states in the
eastern half of the US
 

East 1
 

Prime
 

A subset of the states in the
east: NY ,NJ, MA, RI, and so
on.
 

Any
 

Prime only
 

East 2
 

Prime
 

A subset of the states in the
east: VI, NC, SC, FL, and so
on.
 

Any
 

Prime only
 

West
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

• Country: United
States, State: NM

And entries for all the
remaining 21 states in the
western half of the US
 

Any
 

Prime only
 

West 1
 

Prime
 

A subset of the states in the
west: CA, NV, AZ, and so
on.
 

Any
 

Prime only
 

West 2
 

Prime
 

A subset of the states in the
west: OR, WA, ID, MT, UT,
 NM, and so on.
 

Any
 

Prime only
 

How Assignment Works for This Scenario
When a lead comes in for a potential California customer who's interested in purchasing laptops, the inside sales team
converts the qualified lead into an account and an opportunity. Here's what the application does:

• Assigns the West 1 territory to the account because California is in the West 1 territory. The salesperson in the
territory gains edit access as does her management chain.

• Assigns the West 1 territory to any opportunity line for the California account using the account address.

• If the account is missing the state in the address or is located in another country, then the application assigns
the account to the catchall territory: US Product Sales.
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Salespeople in Each Region Manage Their Own Accounts and Sell
All Products to Those Accounts  
If individual salespeople in each region manage their own customer relationships and sell all products to those
customers, then there may be no way of drawing sales territories to assign new accounts to them directly.

Instead, you can automatically assign access to the managers in each region and have the managers distribute the
accounts to the salespeople working for them. Even though you are not assigning records to individual salespeople, you
must still set up territories for them so they can forecast.

Territory Setup
Because everyone sells all products, you can set up sales territories by address only for the managers. For salespeople,
you create territories with no coverage for the address dimension so the territories get skipped over by assignment but
can be used for forecasting. A territory with no coverage is blank, has no entry, for any dimension.

Here's a diagram that shows the territory hierarchy using only the address dimension. You must list all the appropriate
states in the West and East territories. An entry of Blank means the territory has no address coverage (no accounts are
assigned automatically). Because all salespeople sell all products, the product dimension is not required unless you are
using products in overlay territories or other portions of your territory setup.

Here are the key entries for each territory. Territory Type is always set to Prime because all territories are used for sales
revenue forecasting. The Enable Forecasting field is always set to Prime only, enabling the territory owner to participate
in sales revenue forecasting.

Territory Name Territory Type Address Enable Forecasting

US Product Sales
 

Prime
 

Any
 

Prime only
 

East
 

Prime
 

• Country: United States, State:
NY

Prime only
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Territory Name Territory Type Address Enable Forecasting

• Country: United States, State:
NJ

• Country: United States, State:
MA

And entries for all the remaining 22
states in the eastern half of the US
 

East 1
 

Prime
 

Blank
 

Prime only
 

East 2
 

Prime
 

Blank
 

Prime only
 

West
 

Prime
 

• Country: United States, State:
CA

• Country: United States, State:
NV

• Country: United States, State:
AZ

And entries for all the remaining 22
states in the western half of the US
 

Prime only
 

West 1
 

Prime
 

Blank
 

Prime only
 

West 2
 

Prime
 

Blank
 

Prime only
 

Child territories automatically inherit the coverage of their parent when you create them, so you must delete the
inherited coverage to make them blank. For details on how to delete the coverage for a territory, see the Creating a
Territory with No Coverage topic.

How Assignment Works for This Scenario
When a lead comes in for a potential customer with an address in California who is interested in purchasing laptops, the
inside sales team converts the qualified lead into an account and opportunity. Here's the assignment process:

1. The application automatically assigns the new account to the West territory using the address dimension.
2. The manager who owns the West territory (or a sales administrator working on the manager's behalf), edits the

salesperson's territory and includes the account by name.
3. Running territory assignment automatically assigns the opportunity lines for that account to the same

salesperson as well.

If an account is missing the state information or the account is in a country other than the US, then the account is
assigned to the catchall territory, US Product Sales.

Note:  Because the accounts are assigned by name to the territories, administrators must manually move the
accounts during territory realignment.
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Irregular Territory Hierarchies Where Territories Don't Roll Up to
the Same Parent  
Normally, the coverage values in the child territories roll up to the parent. For example, the territory selling laptops in
Hawaii and the territory selling servers in Hawaii both roll up to the territory selling products in the western US.

But what if the VP of US sales decides to take over the Hawaii servers territory for herself so she can play golf? Now
the two Hawaii territories roll up to different levels in the territory hierarchy. You could end up with wrong assignments
and duplicate forecasts. This topic explains how you can assure proper assignment and forecasting by creating parent
territories with no coverage. A parent territory with no coverage still gets the forecasts from the children territories,
but it's skipped over for assignment. Creating sales territories with no coverage effectively separates assignment and
forecasting. Here are two scenarios to illustrate the difference between a regular hierarchy and an irregular one.

Regular Address Hierarchy
Here's a diagram illustrating the structure of a simple regular address hierarchy. The Western US territory includes
territories for the western states and the Eastern US territory includes all the territories for the eastern states. The
Western US territory is the parent of both Hawaii Servers and Hawaii Laptops.

Here are the entries for the territories in the diagram.

Territory Name Territory Type Address Product

US Sales
 

Prime
 

Any
 

Any
 

Eastern US
 

Prime
 

States in the eastern US.
 

Any
 

Western US
 

Prime
 

States in the western US.
 

Any
 

Hawaii Servers
 

Prime
 

Hawaii
 

Servers
 

Hawaii Laptops Prime Hawaii Laptops
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Territory Name Territory Type Address Product

    

Here's how the application assigns accounts and opportunities using this territory setup:

• An account in Hawaii is automatically assigned to both the Hawaii Servers and Hawaii Laptops territories.

• An opportunity for a server in a Hawaii account is assigned to the Hawaii Servers territory. An opportunity for a
laptop goes to the Hawaii Laptops territory.

• An opportunity for a service product in Hawaii is assigned to the Western US.

Irregular Address Hierarchy
Now imagine that the Vice President for US Sales likes to play golf in Hawaii, so she decides to handle one of the Hawaii
territories herself. The resulting territory structure splits Hawaii across two different hierarchy levels. The Hawaii Servers
territory is now a child of US Sales, while the Hawaii Laptops territory remains under Western US. The following figure
reflects the change.

If you keep the territory settings the same and the same opportunity comes in for servers in the Hawaii account, the
application assigns both the Western US and Hawaii Severs territories.

Here's how the application arrives at the assignment:

1. The application first checks for all possible matching territories. These are Western US, Hawaii Servers, and US
Sales

2. The application discards all the ancestors of the matching territories: US Sales is a parent of Western US so gets
discarded.

Because the opportunity is assigned to two territories in the hierarchy, it could end up in both territory forecasts and
being counted twice in revenue projections. You can fix the assignment issues in this example by creating the Western
US territory with blank coverage. Having blank coverage (no coverage in all the territory dimensions) means that the
territory gets skipped for assignment, but still allows for forecasting to roll up as before. Here are the revised entries:

Territory Name Territory Type Address Product

US Sales Prime Any Any
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Territory Name Territory Type Address Product

    

Eastern US
 

Prime
 

States in the eastern US.
 

Any
 

Hawaii Servers
 

Prime
 

Hawaii
 

Servers
 

Western US
 

Prime
 

Blank
 

Blank
 

Hawaii Laptops
 

Prime
 

Hawaii
 

Laptops
 

The application now assigns only the Hawaii Servers territory. Here's how the application arrived at the assignment:

1. The application first checks for all possible matching territories. These are Hawaii Servers, and US Sales.
2. The application discards all the ancestors of the matching territories: US Sales is a parent of Hawaii Servers and

so gets discarded.

How to Assign Outside Help Using Overlay Territories  
Sometimes you want to assign others in your organization to assist with a sale. For example, if an opportunity line
includes complex equipment, product specialists may be required to help with the technical details. You can make such
assignments using overlay territories.

Sales Territory Setup
This diagram shows a simple overlay organization in a sales territory structure. The overlay organization consists of a
manager and two product specialists. Each specialist is automatically assigned to help with the sale of a specific server
model. The overlay organization territories are the children of the US Product Sales catchall territory for convenience.
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The table lists the key entries for each overlay territory. Note the following:

• The Territory Type is always set to Overlay.

• For the Sales Support Overlay territory, the values of both dimensions are blank. This ensures the territory is
not assigned to any account or opportunity.

• The Enable Forecasting column for the overlay territories can be set to Disabled or Overlay Only.

◦ Use Disabled if you're not forecasting overlay territories.

◦ Use Overlay Only if your overlay organization creates its own forecasts for the sales where they're
involved. Such overlay forecasts are not counted as part of the sales organization forecasts to prevent
double counting. If you do enable overlay forecasting, then you must set the value for manager territories
that approve or adjust forecasts for both prime and overlay territories, such as US Product Sales, to Prime
and Overlay. Enabling forecasts by overlay territories also requires additional setup so salespeople can
specify overlay credit on the opportunity UI itself. See the Implementation Reference guide for details.

Territory Name Territory Type Address Product Enable Forecasting

US Product Sales
 

Prime
 

Any
 

Any
 

Prime or Prime and Overlay
 

Sales Support Overlay
 

Overlay
 

Blank
 

Blank
 

Disabled or Overlay Only
 

Sentinel Server Overlay
 

Overlay
 

Any
 

Sentinel Servers
 

Disabled or Overlay Only
 

Green Server Overlay
 

Overlay
 

Any
 

Green Servers
 

Disabled or Overlay only
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Child territories automatically inherit the coverage of their parent when you create them, so, for the Sales Support
Overlay territory, you must delete the inherited coverage as described in Creating a Territory with No Coverage topic.

How Assignment Works for This Scenario
The application assigns both the prime and overlay territories at the same time. Here is the detail for the assignment of
overlay territories:

• The application assigns both the Sentinel Server Overlay and Green Server Overlay territories to all accounts
because the Address dimension is set to Any. This provides the overlay team access to account notes, activities,
and other details they need if they engage with the account.

• The application assigns the Sentinel Server Overlay and Green Server Overlay territories only to opportunities
with server products in those two product groups.

What to Do When You Don't Want Executives Handling Catchall
Territories  
If you don't want your execs troubleshooting account and opportunity assignment, read on. Catchall territories are
territories high up in the territory hierarchy that have a value of Any for some or all of the territory dimensions.

Your organization must monitor the catchall territories to identify and reassign records with incomplete data and
to adjust for any gaps in your territory structure. The territories at the top of your hierarchy are usually owned by
sales executives who aren't involved in territory troubleshooting. You can make it possible for others to manage the
troubleshooting in either one of two ways:

• You can add the sales administrator as a member of the top catchall territory. As a territory member, the sales
administrator can troubleshoot assignment, but she also gains access to all the forecasts the executive is
reviewing.

• You can create two territories: one for the executive and one for the administrator right underneath in the
hierarchy. The executive's territory gets a blank coverage (no coverage), so no accounts or opportunities are
assigned. The administrator gets the catchall territory, with Any as the value for the appropriate dimensions.

When you create separate territories, the executive can review and adjust all the forecasts from the sales team. The
owner of the catchall territory gets to troubleshoot any accounts or opportunities that aren't properly assigned. You
can turn off forecasting for the catchall, so that the catchall territory owner doesn't see the forecasts the executive is
approving.

Here's a diagram of a sample territory hierarchy with a separate overall catchall territory. The separate overall catchall
territory, US Product Sales Catchall, is a child of US Product Sales and the parent of the next level of territories: West US
and East US. A catchall must be a parent node. It cannot be a leaf node in the hierarchy.
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Here are the setup details for the territories. A value of Blank for the top territory means that you removed coverage,
assuring that no accounts or opportunities are assigned to that territory. Entering the value Disabled in the Enable
Forecasting field for the catchall territory, disables access to forecasting for the territory owner.

Territory Name Territory Type Address Product Enable Forecasting

US Product Sales
 

Prime
 

Blank
 

Blank
 

Prime
 

US Product Sales Catchall
 

Prime
 

Any
 

Any
 

Disabled
 

West US
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

And entries for all the
remaining 22 states in the
western half of the US
 

Any
 

Prime
 

West Laptops
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

Laptops
 

Prime
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Territory Name Territory Type Address Product Enable Forecasting

And entries for all the
remaining 22 states in the
western half of the US
 

West Servers
 

Prime
 

• Country: United
States, State: CA

• Country: United
States, State: NV

• Country: United
States, State: AZ

And entries for all the
remaining 22 states in the
western half of the US
 

Servers
 

Prime
 

East US
 

Prime
 

• Country: United
States, State: NY

• Country: United
States, State: NJ

• Country: United
States, State: MA

And entries for all the
remaining 22 states in the
eastern half of the US
 

Any
 

Prime
 

East Laptops
 

Prime
 

• Country: United
States, State: NY

• Country: United
States, State: NJ

• Country: United
States, State: MA

And entries for all the
remaining 22 states in the
eastern half of the US
 

Laptops
 

Prime
 

East Servers
 

Prime
 

• Country: United
States, State: NY

• Country: United
States, State: NJ

• Country: United
States, State: MA

And entries for all the
remaining 22 states in the
eastern half of the US
 

Servers
 

Prime
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How to Get Rid of the Owner Field and Rely on Automatic
Assignment Exclusively  
If you want to rely on sales territories or assignment rules to provide access to accounts, opportunities, and leads, you
have to get rid of the owner field somehow. That's because you can't automatically assign ownership of accounts,
opportunities, and leads.

Whoever creates a record becomes its owner and ownership provides edit access to data, including the ability to assign
others to the sales team and reassign ownership. Here's how to get rid of the field from the UI:

• By default, each work area displays a list of records owned by the user, called My Opportunities, My Accounts
and so on. You can replace these default lists with your own lists displaying records in user territories.

• You can also remove the infolets summarizing owned records from the Sales Infolet page.

• You can hide the field itself in the UI by creating custom layouts in Application Composer.

If you're concerned about unauthorized access by owners, you can create a dummy user and assign ownership of all
records to that dummy resource. Whatever solution you explore, you must keep in mind that the owner field assures
that the creator of a record retains access to that record.

How to Provide Managers in Completely Different Sales Regions
with Access to Everything  
Accounts for large multinational corporations are typically assigned to sales teams in different countries or regions.
That creates a problem. By default, managers in each region can only access information in their own region.

No single manager can access all of the accounts and opportunities for the entire multinational. You can use a
combination of account hierarchies and sales territory setup to provide access. By including the account at the top of
the multinational hierarchy in the territory of a manager, you provide edit access to all accounts and opportunities in the
hierarchy, regardless of where the're located. Managers get access to the account you include in the territory, and to all
the accounts below it in the hierarchy. So, you can also use this method to provide access to a subset of the hierarchy.

Setup Summary

1. Create the account hierarchy either directly in the Edit Account UI or by importing the hierarchy as described in
this guide.
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2. Include the top account or another account in the hierarchy:

a. Create the territory in a territory proposal.
b. On the Coverages tab in the Included Customers, Selected Customers region, click Select and Add.
c. In the Select and Add window, search for the account by name or other criteria.
d. Click Save and Close to include the account and return to the Coverages tab.
e. Select the account and click Include Hierarchy.

The Include Hierarchy indicator appears in the Include Hierarchy column.

Here's a screenshot of a sample territory in the Territory Proposal page with the Pinnacle Technologies
account included on the Coverages tab. The presence of the Include Hierarchy indicator (callout 1)
means that the territory owner has edit access to all of the accounts in the hierarchy below the Pinnacle
Technologies account.
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Sales Territory and Assignment Setup for the Vision
Corp. Use Case  
This topic explains the use case for the sales territory setup detailed in this chapter. The fictitious Vision Corp. divides its
field sales organization for the US into two regions, East and West.

Each regional sales organization includes two salespeople, one sells laptops and the other servers. A sales support
organization helps out with sales of technically complex server products. The organization includes a sales
administrator who monitors and refines the territory assignment and two inside sales representatives who qualify leads.

The Organization and Use Case
Here's the Vision Corp. sales resource hierarchy you set up earlier.
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Sales Territory Setup
Vision Corp. creates territories using the address and product dimensions. Here's a diagram that shows the sales
territory structure:

• The top territory, US Product Sales, is the overall catchall territory.

The territory is owned by Martin Conway and includes the sales administrator John Dunbar. John Dunbar can
troubleshoot any accounts and opportunities that are assigned to the overall catchall territory and also to the
West and East catchall territories. By monitoring the catchall territories, John can refine the territory structure
over time and fill in any gaps.

• The Sales Support territory owned by Alex Smith has blank (no value) entries for Address and Products
coverage. No accounts and opportunities are assigned to him because he only manages the product specialists
working for him.
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• Peter Branch and Marilyn Richie are assigned to help with opportunities that involve their products, Sentinel
Servers or Green Servers.

• The inside sales representatives do not have any territories because they qualify leads assigned to them using
rules you set up as part of the Leads chapter.

Here are the key entries for the territories:

• Entries in the Product dimension column are the product groups in the sales catalog. Selecting a product group
includes all the product groups and products nested within the product group.

• Vision Corp. is forecasting sales only. There's no forecast for the sales support organization. For this reason, the
Enable Forecasting column value for the overlay territories is set to Disabled. For the prime territories, the value
is Prime Only.

• The Sales Support territory has no coverage values so it doesn't get assigned to any accounts and
opportunities. Because each child territory automatically inherits the coverage of its parent, you must delete
the coverage to make it blank. For details, see the Create a Territory with No Coverage topic.

Territory Name Territory Owner Territory Type Address Products Enable Forecasting

US Product Sales
 

Martin Conway
 
John Dunbar
 

Prime
 

Any
 

Any
 

Prime only
 

East
 

Michael Rhodes
 

Prime
 

Arkansas and all the
other states in the
eastern US
 

Any
 

Prime only
 

306



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 19
Sales Territories and Assignment

Territory Name Territory Owner Territory Type Address Products Enable Forecasting

East Laptops
 

Kristen Garrity
 

Prime
 

Arkansas and all the
other states in the
eastern US
 

Laptops
 

Prime only
 

East Servers
 

Sean Goodkin
 

Prime
 

Arkansas and all the
other states in the
eastern US
 

Servers
 

Prime only
 

Sales Support
 

Alex Smith
 

Overlay
 

Blank (no value)
 

Blank (no value)
 

Disabled
 

Sentinel Servers
 

Peter Branch
 

Overlay
 

Any
 

Sentinel Servers
 

Disabled
 

Green Servers
 

Marilyn Richie
 

Overlay
 

Any
 

Green Servers
 

Disabled
 

West
 

Mateo Lopez
 

Prime
 

Alaska and all the
other states in the
western US
 

Any
 

Prime only
 

West Laptops
 

Lisa Jones
 

Prime
 

Alaska and all the
other states in the
western US
 

Laptops
 

Prime only
 

West Servers
 

Julian Henderson
 

Prime
 

Alaska and all the
other states in the
western US
 

Servers
 

Prime only
 

How It Works
Vision Corp. runs the assignment process once a day in off-peak periods to assign new accounts or opportunities and
qualified leads. Here's an outline of how assignment works for accounts:

• The application assigns an account to both the prime and overlay territories using the state the account is
located in. A new account in Alaska gets assigned to West Laptops, West Servers, Sentinel Servers, and Green
Servers territories. The owners and members of these territories gain access.

• If the account information is missing a state for some reason or is in a country other than the US, then the
application assigns the account to the US Product Sales. Sales administrator John Dunbar reviews and
troubleshoots the accounts assigned to this catchall territory.

The application assigns opportunities and qualified leads using the address information from the account and the
product in each opportunity. For forecasting purposes, each opportunity line is assigned individually to territories and
the territory owner gets to forecast only that line, but the territory owner gains edit access to the whole opportunity and
the territory is listed on the opportunity Sales Team tab:

• An opportunity for green servers in an Alaska account, gets assigned to the West Servers prime territory and to
the Green Servers overlay territory.

• An opportunity for laptops in the same Alaska account, gets assigned to the West Laptops prime territory only.
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• An opportunity for both green servers and laptops in the same Alaska account, gets assigned the West Laptops,
West Servers prime territories and the Green Servers overlay territory. All three territory owners gain edit access
to the opportunity and the territories show up in the opportunity Sales Team tab. Although each territory
member gains access to the opportunity as a whole, the forecasts for each of the prime territories include only
their specific products.

• If an opportunity for the Alaska account includes a product not included in any of the territory coverages, then
the application assigns the West territory.

Enable Sales Territory Dimensions  
You must enable the sales territory dimensions that you plan to use for your sales territories. Make sure you complete
any prerequisites for the dimension you want to use.

For example, if you want to enable the product dimension, then you must first create the sales catalog and you must run
the Refresh Denormalized Product Catalog Table for BI process.

1. Open the task Enable Dimensions and Metrics from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Territories

◦ Task: Enable Dimensions and Metrics

2. On the Enable Dimensions and Metrics page, click Edit.
3. In the Dimensions region, click Select and Add.
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4. Select the dimensions that you want to use and click OK.
Vision Corporation adds Address and Product.

Note:  If you add the Address dimension, the application displays a warning that you can't use territory
metrics. Click Yes because you don't need these features.

Here's a screenshot of the Edit: Enable Dimensions and Metrics page highlighting the location of the Select
and Add button (callout 1) and the Address Attributes (callout 2) section where you select the address elements
you want to use in territory setup.

5. If you added the Address dimension, select the address elements you want to use to set up your territories,
such as state, city, or postal code. Our simple Vision Corp. example uses state only.

6. From the Actions menu at the page level, select Load and Activate.
Your selection runs a process that loads the required dimension data. This is a one-time action unless you
make changes in the territory dimensions after running the process. If you do make changes later, if you add
dimensions or decide to change the industry classification for accounts, for example, then you must load and
activate again.

You can select Refresh Status from the Actions menu at the page level to monitor the process progress. When the
process completes successfully, you can start defining territories in the application.

Create the Sales Territory Hierarchy  

Create a Territory Proposal  
Here's how to create a territory proposal. A territory proposal is the sandbox where you create the sales territory
hierarchy.

1. Navigate to the Territories work area.
2. Click the Sales Territories Hiearchy tab (the second tab from the top on the left side).

309



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 19
Sales Territories and Assignment

3. On the Active Territories page, click Manage Proposals.
4. In the Manage Territory Proposals page, Current Territory Proposals region, click Create (the plus sign icon).
5. In the Create Territory Proposal window, enter a name for the proposal.
6. Leave the Activation Date field blank. You want the proposal to be activated immediately after you build your

territories.
7. Click Save and View.

Your territory proposal opens and you can start building your territory hierarchy.

Create the Sales Territory Hierarchy  
With your territory proposal open, create the sales territory hierarchy starting with the top territory. For each territory
you create, enter the name of the salesperson or manager who owns the territory, and the values for the dimensions
that form the territory boundaries.

When you create child territories, the application automatically copies all the dimension values from the parent
territories to speed up entry.

Create the Overall Catchall as the Top of the Hierarchy
Here's how to create the territory at the top of the sales territory hierarchy as the overall catchall territory. The top
territory is usually owned by a senior manager or executive. Because you don't want executives troubleshooting
territory assignment, you must add a second resource to do the troubleshooting.

1. In the Territories region of your territory proposal, click Create.
2. On the Create Territory page, enter the territory name, for example, US Product Sales.
3. Enter the resource who is the owner of the top territory, most likely the VP of Sales:

a. From the Owner list, select Search.
b. Search for the resource name using any of the criteria.
c. Select the name and click OK.

The owner is now listed on the Territory Team tab in the Additional Information section at the bottom of the
Create Territory page.

4. From the Type list, select Prime.
5. From the Enable Forecasting list, select Prime only. This setting enables the territory to be used for

forecasting.
6. Now add the sales administrator or another resource for troubleshooting any accounts and opportunities that

get assigned to the catchall territory.

a. In the Territory Team tab in the Additional Information region, click Select and Add (the document icon
with a plus sign).

b. Search for the resource using any of the fields.
c. Select the resource from the search results and click OK.

7. Click Save and Close.

Your new territory appears in the Territories table of your proposal.
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8. With the territory selected in the Territories table, click the Coverages tab in the Details region at the bottom of
the page.

The Address Coverage section (callout 1 in the screenshot) lists the address elements you enabled for
territories, all with the value of Any. The Dimensional Coverage section (callout 2), includes all of the other
dimensions you are using, also with the value of Any for each. A setting of Any is what you want for your overall
catchall territory.

Note:  If the Coverages tab is blank, then your territory configuration is incomplete. Navigate to Scheduled
Processes and check to see whether the Synchronize Stage Environment process completed successfully. See
the topic Enable Territory Dimensions for more information.

You're now ready to add the rest of the territory hierarchy.

Add the Rest of the Hierarchy
With the territory proposal open, add the rest of the sales territory hierarchy from the top down. Here's how to add a
territory:

1. Select the parent territory in the Territories table.
2. Click Create Child of Selected Territory (the plus sign icon).
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3. On the Create Territory page, enter the territory name.
4. Enter the owner for the territory.
5. Select the territory type, either Prime or Overlay depending on the territory you're creating.
6. From the Enable Forecasting list, select Prime only for territories involved in forecasts. For overlay territories,

select Disabled. The setting of Disabled removes the territory from forecasting.
7. Click Save and Close.

You're returned to the Territory Proposal page. You're now ready to enter the values for the different territory
dimensions.

8. If you're creating a territory with no coverage, then select the territory in the Territories table and do the
following:

a. In the Coverages tab, select a row showing coverage values.
b. From the Actions menu, select Remove all.

Here's a screenshot of the Coverages tab. Callout 1 highlights the location of the Actions menu.

The coverage now shows a No data to display message.
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9. If you're creating a territory with coverage, then select the territory in the Territories table, and enter the values
for the dimensions:

a. For the address dimension, do the following:

i. In the Address Coverage section, select any row and click Edit (the pencil icon, callout 2 in the
screenshot).

Your action opens up a separate window to enter all of the address values for the territory.
ii. In the separate Address Coverage window, click Add and enter the values for each address

element. Add as many rows as you need to cover all the possible address values in your data:

◦ Except for the Postal Code field, the application matches your entries exactly, but the
matches are not case-sensitive. If your data includes a variation of spellings, then you must
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add rows for them all. For example, if your data includes CA, California, and Ca., then you
must include a row for each spelling variation to assure correct assignment.

Here's a screenshot of the Address Coverage window with a row for each of the different
states in a western US territory.

◦ If you are creating territories using postal codes, such as US ZIP codes, you can enter ranges
of values and use the percent sign (%) to indicate partial matches.

b. Here's how to enter values for the other dimensions in the Dimensional Coverage section:

i. In the Dimensional Coverage section, click Edit.
ii. Select the dimension from the Dimensions list.

The Edit Coverage window shows a list of available values in the left Available Dimension Members
pane.

iii. Move the values you want to use for the territory to the Selected Dimension Members pane on the
right.

Tip:  If the Product dimension shows the wrong products, go to the Scheduled Processes
work area and run the Refresh Denormalized Product Catalog Table for BI process. The wrong
products may show up if you changed the root of your sales catalog.

iv. Click Save and Close.

You're returned to the Territory Proposal page.

After you complete adding territories and specifying coverages, you're ready to activate your territory proposal.
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Activate the Territory Proposal  
You can activate your territory proposal right away after you complete building your territory hierarchy. Just click
Activate while still editing the territory proposal. If you didn't, no worries. You can activate the proposal from the
Manage Territory Proposals page. Here's how:

1. Navigate to the Territories work area.
2. Click the Manage Territory Proposals link.
3. If the proposal you want to activate doesn't appear on the Manage Territory Proposals page, in the Current

Territory Proposals table, select All Proposals from the Proposals list.
4. Select the proposal and click Activate.

The application displays the proposal in the Completed Territory Proposals region. You can refresh the page to
display the most recent status and navigate to the Territories page to view the territories after they are active.

Create a Territory with No Coverage  
Sometimes you need to create a territory to group other territories for forecasting or you want to forecast accounts
that are included in a territory by name. In these cases, you don't want any accounts or opportunities assigned to the
territory.

You can create territories that are skipped by the assignment process by deleting the coverage across all territory
dimensions. You can only delete coverage while you're in a territory proposal and you must delete coverage across all
the dimensions in a territory. You can't delete coverage for individual dimensions.
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Here's how to create a territory with no coverage:

1. In the territory proposal, Territories region, select the territory you want to turn into a territory with no coverage.
Make sure it's added to the proposal.

A Yes in the Added to Proposal column indicates that the territory is in the proposal. Here's a screenshot of the
Territories region of a sample territory proposal highlighting the column.

2. In the Details region, select the Coverages tab.
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3. Select the row showing the coverage values in the Dimensional Coverage region on the tab.

Here's a screenshot of the Territory Proposal window with the Coverages tab. Callout 2 shows the location of
the row of values you delete to create a territory with no coverage. Callout 1 indicates the location of the Delete
icon.

4. Click Delete.

The application warns you that your action will remove all data in the table.
5. Click Yes in the warning.

The entire row is deleted.
6. Save.

Enable Automatic Assignment of Imported Accounts  
Enable automatic sales territory assignment of accounts you import by setting the following system profile options to
Yes. Setting the profiles to Yes, runs the Request Account Assignment process after import. By default, you must run the
process manually to assign accounts.

System Profile Option Name Description

Sales Account Automatic Assignment on
Import Enabled (ZCA_BATCH_ASSIGN_
ON_BULK_IMPORT)
 

Enable automatic sales territory assignment after you import accounts.
 

Sales Account Automatic Assignment on
Create Enabled (ZCA_SA_AUTO_ASSIGN_
ON_CREATE)

Enable automatic sales territory assignment of new accounts after you import accounts.
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System Profile Option Name Description

 

Sales Account Automatic Assignment on
Update Enabled (ZCA_SA_AUTO_ASSIGN_
ON_UPDATE)
 

Enable automatic sales territory assignment whenever accounts are updated when you import.
 

1. In Setup and Maintenance, go to the Manage Administrator Profile Values task:
◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
2. Search for each of the profile options.
3. Set the Profile Value to Yes.
4. Click Save and Close.

Make Opportunity Assignment Automatic  
You can make the assignment of opportunities automatic by setting the system profile option Assignment Submission
at Save Enabled. By default, sales users must assign opportunities manually when they edit each opportunity.

1. In Setup and Maintenance, go to the Manage Opportunity Profile Options task:
◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Opportunity Profile Options
2. In the Manage Opportunity Profile Options page, search for the profile option by entering Assignment

Submission at Save Enabled in the Profile Display Name field.
3. In the MOO-OPTY_ENABLE_AUTO_ASGN: Profile Values region, select Yes from the Profile Value list.
4. Click Save and Close.

Run Assignment Processes  

Run the Account Assignment Process  
You must run the Request Account Assignment process to assign territories to accounts each time you activate a
territory proposal. You must also schedule this process to run regularly to ensure that all territories are assigned
properly.

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, click Schedule New Process.
3. In the Schedule New Process window, enter Request Account Assignment in the Name field and press Return.
4. Select the process and click OK.
5. On the Process Details page, make these entries to assign all records:
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Field Entry

Work Object
 

Account
 

Candidate Object
 

Account Territory
 

Assignment Mode
 

Territory
 

View Criteria Name
 

AllSalesAccountsVC.
 

Note:  You can run the assignment process on a subset of records by entering different parameters in the
View Criteria Name and View Criteria Bind Values fields.

6. The first time you run the process click Submit to run it immediately.
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7. You must also set up the process to run regularly, perhaps once a day:

a. Click Advanced.
b. Click the Schedule tab.
c. Select the Using a schedule option.

Here's a screenshot of the Process Details page with the Schedule tab and the Using a Schedule option
selected.

d. Select the frequency and start date.
e. Enter an end date far in the future.
f. Click Submit.

8. Depending on your settings, your process runs immediately or at the intervals you specified. You can monitor
its progress by searching for the process by name on the Overview page.

Related Topics
• Schedule Account Assignment
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Run the Opportunity Assignment Process  
You must run the Revenue Territory Territory Based Assignment process to assign territories to opportunities after you
activate a territory proposal. You must also schedule this process to run daily to ensure that all territories are assigned
properly.

1. Click Navigator > Tools > Scheduled Processes.
2. In the Scheduled Processes page, click Schedule New Process.
3. In the Schedule New Process dialog, Name field, click Search: Name icon (down arrow) and select the Search

link at the bottom of the list.
4. In the Search and Select dialog, enter the process name Revenue Territory, and click Search. You can search by

a partial name, but note that the search is case-sensitive.
5. Select the process name in the results and click OK.
6. Click OK again, if required.

7. Enter these process parameters:

Field Entry

View Criteria Name
 

Enter OpenOpportunitiesByCreationDate.
 

View Criteria Bind Values
 

You can have the option of assigning territories to those open opportunities created since a
certain date or those created for a range of dates:
 

◦ For a specific date, enter BindOptyCreationDateFrom=YYYY-MM-DD where
YYYY-MM-DD is the date you started implementing the application. For example,
BindOptyCreationDateFrom=2014-01-01 assigns all open opportunities created
since January 1, 2014.

◦ To use a date range, enter BindOptyCreationDateFrom=<date>,
 BindOptyCreationDateTo=<date>. Note that the From and To values are separated
by a comma.

Note:  You can find information about additional process parameters in the Implementation Reference guide.

8. You must also run this same process periodically to assign new opportunities

a. Click Advanced.
b. Select the Schedule tab.
c. Select the Using a schedule option.
d. Select the frequency and start date.

9. Click Submit.
10. Unless you specified a schedule, your process runs immediately. You can monitor its progress by searching for

the process by name on the Overview page.

Related Topics
• Recommendations for Assignment Processes for Opportunities
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20  Leads

How to Handle Leads from External Sources  
The leads you get from the web, from trade shows, from marketing campaigns, or from lists you purchased aren't
always of the highest quality. You want to contact the potential customer and verify the information before creating new
account and contact records in your application. And you don't want to pass worthless leads to your highly paid and
busy field sales.

This chapter outlines how you can set up a process for creating, verifying, and qualifying these kinds of net new leads.
We are calling these leads "net new" leads because the account and contact information stays in the lead until the
lead is qualified and converted. Our use case follows the common practice of using inside sales to do the initial lead
qualification. But there's nothing stopping you from modifying the use case to suit your needs.

Use Case Overview
The fictitious company, Vision Corp., uses a team of inside sales representatives to verify the information in leads. All
qualified leads are automatically assigned to field sales representatives for further assessment and conversion into
opportunities. Here's an overview of the process:

1. Net new leads can get created in one of three ways:

◦ The leads are imported, perhaps by a sales administrator using the import macro you download from My
Oracle Support.

◦ The leads get created from an integration with a marketing application, such as Oracle Eloqua.

◦ A salesperson can also create net new leads manually in the UI.

2. Using an assignment rule you create, the application automatically assigns all inside sales representatives to
the sales team on each of the imported leads. Being on the sales team, makes it possible for the inside sales
representatives to view and update the leads, but it doesn't assign them ownership of the leads. Salespeople
become owners of a lead only when they accept a lead.

3. Individual inside sales representatives review the list of leads and accept the leads they want to work on.
Accepting a lead lists you as the lead's owner.

4. The inside sales representatives verify the information in each lead. They check for potential duplicates, contact
the customer, and answer a standard list of questions in a qualification template that you set up for them.

5. When leads meet the qualification criteria, the inside sales representatives set the leads to the qualified status.
6. If the leads don't meet the criteria, the inside sales representatives retire them instead.
7. The application automatically assigns the qualified lead to sales territories in the field sales organization.
8. Field sales representatives review the individual leads assigned to them, and convert the promising ones to

opportunities.

The representative doing the conversion becomes the owner of the new opportunity.
9. During the conversion process, the application creates new account and contact records of type prospect. The

lead is automatically set to a converted status and linked to the account and opportunity records.

Here's a diagram that illustrates the processes:
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How Inside Sales Works Sales Leads
Here's how salespeople work leads in the CX Sales UI. Because of the changed UI, the process in the Digital Sales UI is a
bit different. For information about working with Leads in Digital Sales, see the Leads chapter in the Using Digital Sales
(Next Gen Sales) guide.

1. To find the imported leads to work on, the inside sales representatives select the Unaccepted Leads list (callout
1 in the screenshot).

You create the saved search for this list during setup.
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2. Representatives accept ownership of the leads that they want to work on, either by:

◦ Selecting the Accept from the Actions list (callout 2).

◦ Or by drilling down on the lead name (callout 3) and clicking the Accept button in the Edit Lead page.

By accepting the lead, a representative becomes the lead owner and can now see the lead listed in the My
Open Leads list.

3. Inside sales representatives check if the account and contact information in the lead duplicates information
already in the sales application. In our use case, the representatives check for duplicates manually in the leads
UI by selecting the Check for Duplicates action.

4. The representatives contact the customer and qualify the leads, guided by the questions you set up as part of a
qualification template. Using the qualification template, while not mandatory, ensures that everyone follows the
same procedure for qualifying leads.

Note:  Qualification templates are replaced by Orchestration processes in Digital Sales.

Here's a screenshot of a sample qualification template in the CX Sales UI. Salespeople access the template on
the Qualification tab (callout 1) of the Edit Lead page. They answer the questions that you provide (callout 2).
These questions are organized in question groups, which serve as headings on the page. As they answer the
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questions, salespeople get visual feedback on the quality of the lead (callout 3). You select the ratings and color
schemes during qualification template setup.

5. When inside sales representatives set the lead status to Qualified, an assignment process assigns the lead to
the appropriate sales territory. The process also adds the appropriate field sales representatives to the sales
team.

6. The field sales representatives convert the lead to an opportunity by selecting the Convert from the Actions
menu after viewing the lead.

7. You can rename the opportunity and change ownership in the Convert Lead window (shown in the screenshot).
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How You Import Leads Depends on the Lead Type
How you import leads depends on whether you're importing the net new leads described in this chapter or leads linked
to existing accounts and contacts. Here are the main differences:

• Net new leads

You import the account and contact as part of the lead business object. Account and contact records are
created only when the sales representatives convert the leads to opportunities. You can use the Excel macro
provided by Oracle to import these types of leads.

• Leads linked to existing accounts and contacts

You must use IDs to reference the existing accounts and contact record in your import file. You can use the IDs
you generated in your account and contact import files or you can export IDs from your application. You cannot
use the leads import Excel macro for this type of import.

This chapter discusses only the import of net new leads using the import macro. See the Understanding Import and
Export Management for CX Sales and Fusion Service guide to understand how to import the other types of leads.

Overview of Leads Setup  
Here are the setup steps required to set up the sample leads use case covered in this chapter.

Step Applies To Description Task Where to Get More Details

1
 

CX Sales To permit salespeople to
enter account and contact
information as text in net
new leads in CX Sales, you
must expose two fields,
 New Account and New
Contact, on the appropriate
lead pages.
 
In Digital Sales, salespeople
can enter information
as text or select existing
accounts and contacts
in the same field. No UI
change is required.
 

Application Composer
 

See the topics:
 

• Make Changes to the
Lead Pages

• Add the New Account
and New Contact
Fields to the UI

2
 

Both CX and Digital Sales Create the assignment rule
to assign the leads to the
inside sales representatives
who will qualify them.
 

Manage Sales Lead
Assignment Rules
 

See the topic: Set Up
the Assignment Rule for
Assigning Leads
 

3
 

Both CX and Digital Sales Set two system profile
options to enable lead
assignment. Setting Lead
Assignment Mode to
Both turns on both rule-
based and territory-based

Manage Sales Lead Profile
Options
 

See the topic: Enable Lead
Assignment
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Step Applies To Description Task Where to Get More Details

assignment. Setting the
Assignment Rule for Rule
Based Lead Assignment
profile option tells the
application which rule
category to use.
 

4
 

Both CX and Digital Sales Before importing your
leads, you can optionally
change the values provided
by Oracle for lead rank and
the lead source channel.
Salespeople can use lead
rank, for example, hot or
cold, to prioritize leads to
work on next. The lead
source channel indicates
if the lead came from the
web, an email, and so on.
 

Manage Set Enabled
Lookups
 

See the topic: Change the
Values for Lead Rank and
Lead Channel
 

5
 

Both CX and Digital Sales Import leads using the lead
import macro. You can
import up to 5,000 leads at
a time.
 

None. You import from the
Excel macro itself.
 

See the topic: Import Leads
Using the Import Macro
 

6
 

Both CX and Digital Sales Run the lead assignment
process twice: the first time
to assign the imported
leads to inside sales
and the second time to
assign qualified leads to
field sales. You can also
schedule assignment
process to run at regular
intervals.
 

Manage Lead Processing
Activities
 

See the topic: Run the Lead
Assignment Process
 

7
 

Digital Sales only Create a list that inside
sales representatives use
to view the imported leads
that are available for them
to work on.
 

None
 

See the topic: Display List of
Unaccepted Leads
 

8
 

Both CX Sales and Digital
Sales

Sign in as one of the inside
sales representatives
and one of the field sales
representatives to test your
setup.
 

None
 

See the topic: Verify Your
Leads Setup
 

9 Both CX Sales and Digital
Sales

Schedule the process
Update Leads with Most
Recent Contact and
Account Information to
run periodically in order
to make sure any changes
to account and contact
information are reflected in
leads.

Navigator > Tools >
Scheduled Processes

See the topic: Update Leads
with Most Recent Contact
and Account Information
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Step Applies To Description Task Where to Get More Details

10
 

CX Sales only Create a list that inside
sales representatives use
to view the imported leads
that are available for them
to work on.
 

None
 

See the topic: Display List of
Unaccepted Leads
 

11
 

CX Sales only Specify which qualification
template you want to
appear in a lead by default
by setting the system
profile option Advanced
Lead Qualification Enabled.
You can specify one
template as the default for
all leads, or have different
defaults for different users
and products.
 

Manage Sales Lead
Administrator Profile Values
 

See the topic: Select
Default Lead Qualification
Templates
 

Set Up the Assignment Rule for Assigning Leads  
You can use assignment rules to automatically assign your leads to sales resources or to sales territories. In this
example, you set up a rule that assigns imported leads to sales resources, the inside sales representatives.

Creating an assignment rule involves the following three major steps:

1. Create a rule set.
2. Create the rule.
3. Publish the rule set.

Create the Rule Set
You must create a rule set before you create your rule. The rule set makes it possible for you to have more than one rule
for your lead assignment.

1. Open the Manage Sales Lead Assignment Rules task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Show: All Tasks

◦ Task: Manage Sales Lead Assignment Rules

2. Select the Sales Lead Resource Rule Category from the Category list. You're assigning resources to the leads.

329



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 20
Leads

3. Create a rule set:

a. Click Add Row (plus sign icon) in the Rule Sets region toolbar.
b. Enter a rule set name in the Name field and an optional description.
c. Make sure that All is selected as the Filter.

The All setting ensures that all the inside sales representatives are assigned to all of the lead sales teams
so each sales representative can work any of the leads you import.

If you selected Random as your filter value, then the inside sales representatives are assigned to the lead
teams at random. Each representative would be assigned approximately to the same number of leads,
but the representatives could not view and work on the leads assigned to the others.

d. Save.

Create the Rule
Now create the rule to assign the inside sales representatives to all imported leads that are unqualified.

1. With the rule set you just created selected, click Create (the plus sign icon) in the Rules region.

The Create Rule page appears.
2. Enter a rule name and an optional description.
3. In the Conditions region, make sure the All conditions met operator is selected for the Rule Applies If field.
4. Click Add Row (the plus sign icon).
5. Now enter the first of the two conditions. This first condition ensures that the rule only assigns imported leads.

Field Selection

Object
 

Sales Lead
 

Attribute
 

Import Activity Identifier
 

Operator
 

Is not blank
 

6. Click Add Row again and enter the second condition. This condition assures that the rule assigns only
unqualified leads.

Field Selection

Object
 

Sales Lead
 

Attribute
 

Status
 

Operator
 

Equals
 

Value Unqualified
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Field Selection

  

7. In the Action region, enter the names of the inside sales representatives who work the imported leads:
a. Click  Select and Add (plus sign icon).
b. Search by name in the Select and Add window.
c. Select the name.
d. Click OK.

Clicking Apply instead keeps the window open so you can add additional resources.
8. Click Save and Close.

You're returned to the Manage Sales Lead Assignment Rules page.

Publish the Rule Set
For the rule to become active, you must publish the rule set after each change by clicking Save and Publish on the
Manage Sales Lead Assignment Rules page. The application lists the day and time when the rule was last published.

Enable Lead Assignment  
Enable lead assignment using both rules and sales territories by setting these two system profile options. Territory
assignment assigns sales territories to the lead, not individual resources. Resources are added to the lead only by
resource assignment rules.

System Profile Option Display Name Value to Enter Description

Lead Assignment Mode
 

Both
 

Specifies if you're using rules, sales territories,
or both for assigning leads. Vision Corp. is using
both.
 

Assignment Rule for Rule-Based Lead
Assignment
 

Sales Lead Resource Rule Category
 

Specifies the rule category for the rule used for
lead assignment.
 

Here's how to set the profiles:

1. Open the task Manage Sales Lead Profile Options from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Profile Options

2. Enter the profile option name in the Profile Display Name field.
3. Click Search.

The application displays the profile option information.
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4. For the Assignment Rule for Rule-Based Lead Assignment profile, click Add (the plus sign icon) in the Profile
Values region and select Site as the Profile Level. For the Lead Assignment Mode system profile option, Site is
already entered for you.

5. In the Profile Values region, select the value from the  Profile Value list.
6. Click Save or Save and Close.

Change the Values for Lead Rank and Lead Channel  
Optionally, you can change the values for lead rank and lead channel by editing their lookup types. Salespeople use lead
ranks to prioritize leads to work on. The lead channel records the source of the lead.

The lookup type Lead Rank (MKL_LEAD_RANK_SETID) includes these predefined values:

• Cold

• Hot

• Warm

The lookup type Lead Channel (MKL_LEAD_CHANNEL_SETID) includes these predefined values:

• Direct Mail

• E-Mail

• Fax

• Model-based prediction

• Phone

• Rules-based prediction

• Sales visit

• Web

• Wireless Message

Here's how to change the existing values and to add new ones:

1. Open the task Manage Set Enabled Lookups from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Show: All Tasks

◦ Task: Manage Set Enabled Lookups

2. On the Manage Set Enabled Lookups page, search for either of the lookup type names by entering Lead Channel
or Lead Rank in the Meaning field.
The lookup type and the available values, called lookup codes, appear below.

3. Here's how to change a lookup codes:

◦ For the existing values, you can change the wording displayed to the user by modifying the meaning or
you can end date values you do not need.

◦ You can add new values, by clicking New (the plus sign icon).

4. Click Save and Close when you are done.
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5. If you made changes, you must remember to enter the changes on the Lead Channel and Lead Rank 
worksheets in the lead import macro.

Import Leads Using the Import Macro  
Here's how to enter your lead data into the macro and import. You can import up to 5,000 lead records at a time. If you
import multiple batches, you must ensure that each import completes before you start another. You can use the macro
only to import net new leads. You can't use it to import leads for existing customers or prospects.

Note:  You can add import additional attributes by appending columns to the import macro, but you can't make any
other changes. You can't edit the Visual Basic for Applications (VBA) code or other functions.

1. Open the Lead Import Macro.
2. Make sure that macros are enabled in Excel.
3. If you're importing additional fields, including custom fields, then do the following:

a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server.
c. In an empty row in the worksheet, select the attribute from the Attribute Name column.
d. Enter the name you want displayed as the column heading in the Lead worksheet. This name displays

only in the macro.
e. Click Update Headers to add the column to the Lead worksheet.

4. If you changed the lead rank or the lead channel lookup types, then enter the new values in the Lead Rank and
the Lead Channel worksheets.

5. In the Template worksheet, enter your lead data. The import requires you to enter three pieces of information
for each lead:

◦ Lead name

◦ Account name

◦ Contact full name

The macro generates the required lead number after you click Create Import Activity.

You must also include contact information for your inside sales representatives to be able to qualify the lead.
If you're assigning qualified leads using the state where the business is located, you must include the state in
your import or have the inside sales representatives enter it as they qualify the lead.

Here's what to enter in the macro:

Column What to Enter

Lead Number
 

Leave this required column blank. The macro generates the lead number automatically using
the date and time. The application uses the lead number to identify the lead record for updates.
 

Lead Name
 

The lead name identifies the lead in the lists salespeople see in the Leads work area. In the UI,
 the application automatically enters a lead name as a combination of the contact name and
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Column What to Enter

the date and time. You may want to follow the same practice in your import. Entry in this field is
required.
 

Account Name
 

Organization name. Entry is required.
 

Contact Full Name
 

You must enter the contact's first and last names separated by a space.
 

Job Title
 

Job title.
 

E-mail
 

Contact email address.
 

Phone Country Code
 

Contact phone country code.
 

Phone Area Code
 

Contact phone area code.
 

Phone Number
 

Contact phone number with no spaces or delimiters.
 

Address 1
 

Contact address line 1.
 
If you convert the lead to an opportunity, then the application uses the address entered in the
contact address fields both as the contact address and the account address.
 

Address 2
 

Contact address line 2.
 

City
 

Contact address city.
 

State
 

For US states, enter the two-letter state code.
 

Province
 

This column (O) is hidden in the macro.
 

ZIP Code
 

Postal code.
 

Country
 

The ISO two-letter code for the country.
 

Product Group
 

Enter the Product Group Reference Number. You can copy this number from the macro you
used to import product groups.
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Column What to Enter

Product
 

Product name you imported earlier using the product import macro. If you're importing a
product interest for a lead, you can't import a product group at the same time.
 

Lead Rank
 

You must use one of the standard values provided by Oracle in the macro, unless you changed
them. The standard values are:
 

◦ COOL

◦ HOT

◦ WARM

Lead Channel
 

You must use one of the standard values provided by Oracle in the macro, unless you changed
them. The standard values are:
 

◦ DIRECT_MAIL

◦ EMAIL

◦ FAX

◦ PHONE

◦ SALES_VISIT

◦ WEB

◦ WIRELESS_MESSAGE

◦ ZSP_MODEL_PREDICTION

◦ ZSP_RULES_PREDICTION

6. In the lead import macro, click Create Import Activity.
7. If you're prompted to correct errors in your entries, do the following:

a. Click OK.
b. Click each error link in column D and make the correction on the Template worksheet.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity again.
8. On the Login page, enter the following:

◦ Host information for your environment.

The host name is the portion of the URL between the https:// and /sales. You must be signed in and
navigate to one of the sales work areas to ensure that the host name is correct. The name on the sign-in
page and on setup pages is different.

◦ Your user name

◦ Your password
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9. Click Submit.

The application displays one of these messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

You most likely entered the wrong mapping number or the user does not have the correct
permissions. Open the Errors work sheet to view the error details.
 

10. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID, and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

11. Optionally, click Generate Log to save a file listing the leads that were imported.

Run the Lead Assignment Process  
Here's how you assign leads using the rules you set up. For implementations similar to the Vision Corp. use case, you
may need to run the assignment process multiple times. Vision Corp. runs it the first time to assign the imported leads
to the inside sales representatives for lead qualification. The second time, the process assigns the qualified leads to field
sales for conversion to opportunities. Assignment is not automatic, so you must run the process at regular intervals,
perhaps once every hour.

1. Open the task Manage Lead Processing Activities from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Lead Processing Activities

2. On the Lead Processing Activities page, click Create Lead Processing Activity.
3. To assign the leads you imported to inside sales for qualification, enter these parameters:

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
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UI Region Field Entry

Lead Selection
 

Status
 

Unqualified
 

Lead Selection
 

Assignment Status
 

Unassigned
 

Schedule
 

Schedule Mode
 

Immediate
 

4. Click Submit.
5. Now create and submit a second activity to assign the leads to field sales after the leads are qualified. Enter

these parameters:

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection
 

Status
 

Qualified
 

Schedule
 

Schedule Mode
 

Assignment is not automatic. You must
run this activity on a repeating schedule to
make sure that the leads are transferred to
field sales as soon as they are qualified by
inside sales.
 
To run the activity regularly, select Repeats,
 enter a frequency (1 hour, for example),
 a start date, and an end date far into the
future. You must enter both a start date and
an end date for the process to run.
 

6. You can monitor the processes on the Manage Lead Processing Activities page. This page lists all of your
processing activities.

Display List of Unaccepted Leads  
Use these steps to create a saved search list of the leads you imported in the Leads work area. Inside sales
representatives use the list to review incoming leads and accept the leads they want to work on. After sales
representatives accept a lead, the lead displays among the leads they own and no longer appears on the list.

Saved searches store all of your search criteria, filters, and formatting of results for reuse. Use saved searches to create
lists of information useful to you in each work area. For example, you can create a saved search for the leads you
imported in the Leads work area. Inside sales representatives use the list to review incoming leads and accept the leads
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they want to work on. After sales representatives accept a lead, the lead displays among the leads they own and no
longer appears on the list.

Your saved search saves whatever you added to your search, including keywords, filters, columns, and sort order of the
results. You can create lists for the whole organization or lists targeted to specific job roles. Here's an overview of the
steps:

1. Navigate to the Leads work area.
2. Click in the Action Bar and select Manage Saved Searches.
3. Click Actions (the three dots in the Actions column) and select Edit.
4. Modify the list to create a saved search for the leads you imported.
5. Click Save.

Verify Your Leads Setup  
Test your leads setup. Sign in first as an inside sales representative to accept and qualify the lead. Then sign in as a field
sales representative to convert the lead to an opportunity.

Sign In as an Inside Sales Representative

1. Sign in as one of the inside sales representatives and navigate to the Leads work area.
2. Select the list of unaccepted leads you created.

The list should contain all your imported leads.
3. Open one of the leads and click Accept.

You should now be listed as the lead owner.
4. Click the Sales Team tab to make sure all the appropriate sales representatives are listed.
5. Make sure that the information in the lead you're qualifying is sufficient to assign the lead to the field service

representative you're using for testing.
In our use case, qualified leads are assigned to sales territories by state. Make sure that the contact address in
the lead includes one of the states in the US that belong to the territory of the field sales representative you're
using for testing.

6. Click Qualify to indicate the lead is qualified.

Sign In as a Field Sales Representative

1. Ensure that the assignment process you scheduled previously has successfully completed. If you have not run
the assignment process, then you must run the process again, this time, immediately.

2. Sign in as the field sales representative who owns the territory the qualified lead is assigned to.
3. Navigate to the Leads work area.
4. Select the Open leads where I am on the team list.
5. Edit the lead.
6. From the Actions menu, select Convert.

The Convert window appears.
7. Optionally, change the opportunity name to something more meaningful.
8. Click Submit.

338



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 20
Leads

9. The opportunity work area view automatically opens in the current tab replacing the leads work area.
10. You can open the opportunity and view the created account and contact from there.

Update Leads with Most Recent Contact and Account
Information  
Schedule the process Update Leads with Most Recent Contact and Account Information to run periodically in order to
make sure any changes to account and contact information are reflected in leads.

1. Open Navigator > Tools > Scheduled Processes .
2. On the Overview page, click Schedule New Process and click the Search Name button (down arrow) on the

right side of the Name field.
3. Click the Search link at the bottom of the list.
4. In the dialog box, search for Update Leads with Most Recent Contact and Account Information.
5. Select the process and click OK
6. In the Process Details window, click Advanced.
7. Under Advanced Options, select Schedule.
8. Select Using a schedule and enter information about how often you want to update the lead information.

Related Topics
• What are scheduled processes?

CX Sales Only  

Create a Lead Qualification Template  
You can use a lead qualification template to set up questionnaires that guide salespeople through the lead qualification
process. You can set up multiple qualification templates, each for a different product.

1. Open the task Manage Sales Lead Qualification Template from the Setup and Maintenance work area:
◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Qualification Template
2. Click Create (the plus sign icon) to create a new template, or you can copy and modify the template provided by

Oracle.

Enter Basic Template Details
Make these entries in the Enter Details page:

1. Enter a template name. For example: Imported Web Leads.
2. Select Lead as the Template Type.
3. For the Template Set, select Common Set.
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Sets make it possible for you to target different qualification templates for different business units, but the
application covered in this guide uses only one business unit. For an explanation of how you can tailor your
sales application for multiple business units, see the Implementation Reference guide.

4. Click Next.

Configure Ratings
Ratings group question responses in a template into different categories. There are three predefined ratings: Poor,
Average, and Good. You can add your own ratings or modify the predefined ratings. When you're done, click Next.

Create Question Groups, Questions, and Responses
Create the question groups, which serve as headings in the template, and the questions within each group.

1. Click Create (the plus icon) and select Create Question Group.
2. Enter a name, which appears as the heading for this group of questions, and click Save and Close.
3. Now create your questions for this group. For each question:

a. Click Create (the plus icon) and select Create Question.
b. In the Create Question window, enter the question text.
c. Enter a weight indicating how important this question is in the qualification process. You have a chance

to revisit and adjust the weights to all the questions at a later stage.
d. Click Save and Close.

4. Enter the possible responses for each question:

a. Enter the response, score and rating.

Here are the response entries for a yes or no question, for example: Did you reach the contact by phone?

Response Score Rating

Yes
 

100
 

Excellent
 

No
 

0
 

Poor
 

b. When you complete entering your questions, you can reorder the questions by clicking Move (the double
right arrow).

5. Click Next.

Edit Question Weights, Configure Score Ranges, and Associate Task Templates
Use these steps to edit the question weights, configure score ranges, and associate task templates:

1. On the Edit Question Weights page, the weights in the Weights column for each question until the total equals
100.

2. Click Save and then Next.
3. The application derives the score range for ratings using the scoring to response mapping in the questions and

responses that you entered earlier. On the Configure Score Range Attributes page, you can select the Override
Score Ranges option to edit the automatically derived score ranges. You can also set different start and end
scores for the ratings. You can use the Graph Color list to change the colors shown in the various score ranges.
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Deploy the Qualification Template
When you're ready to deploy the qualification template, do the following:

1. Click Save.
2. Click Deploy.
3. Click OK to close the confirmation window.

The application displays any errors in setup. For example, if you did not enter question weights which total 100.

Note:  After you deploy a template, you can't change its name or edit many other aspects. If you need to
make changes, make changes in a copy, and then deploy the copy.

Select Default Lead Qualification Templates  
To turn on lead qualification, you set the profile option Advanced Lead Qualification Enabled to the lead templates you
want to use by default. You can specify one template for use for the whole sales organization, you can specify different
templates for different products, and you can assign specific templates to different users. The settings are not mutually
exclusive. You can provide a default template for the whole organization, but target different template to individual users
or product groups, for example.

1. Open the task Manage Sales Lead Profile Options from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Profile Options

2. Enter Advanced Lead Qualification Enabled in the Profile Display Name field.
3. Click Search.
4. Select the profile option.
5. In the Profile Values section, click New (the plus sign).
6. If you're using only one template, then select Site from the Profile Level list. The options are:

◦ Site

The same template is used for the entire organization unless you specify additional templates for product
and user.

◦ Product

The template is used for a product group. All other product groups are assigned the template you specify
at the site level.

◦ User

The template is used for the user you enter. All other users are assigned templates for the product or the
site.

Select the name of the template from the Profile Value list.
7. Repeat the previous steps for additional products and users.
8. Click Save and Close.

341



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 20
Leads

Configure the CX Sales Leads UI  

Make Changes to the Lead Pages  
If your sales organization handles large volumes of unqualified leads using the CX Sales UI and you want to prevent
your sales data from getting cluttered with unverified account and contact information, read on.

With a bit of setup, you can store account and contact names in the lead as text and create the account and contact
records only after salespeople verify that the information is legitimate and accurate. If a lead doesn't pan out, the
information just stays in the lead.

Lead Pages Handle Only Leads for Existing Accounts
Here's how the application act by default:

• When creating a lead in the CX Sales UI, salespeople can only enter accounts and contacts that already exist in
the application. If they want to create leads for completely new accounts and contacts, they must first create the
appropriate account and contact records.

• If you import completely new leads, as you do using the import macro, the leads get imported, but the new
accounts and new contacts names don't show up on the Edit page.

Here's what the default Create Lead page looks like from the CX Sales UI. The screenshot highlights the Existing
Contact and Existing Account fields.

Two Fields Enable Net New Leads in CX Sales
You enable salespeople to view and enter the account and contact names as text in net new leads by exposing the New
Account and New Contact fields in the CX Sales UI.
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Here's a screenshot of the Create Lead page highlighting the fields in the CX Sales UI.

You must expose these same two fields in the Edit Lead page and other pages required for your leads process. These
pages include the Leads landing page and the pages used to convert leads into opportunities.

Here's how salespeople see net new leads in the Edit Lead page from the CX Sales UI.
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Leads for existing accounts, display the existing contacts and accounts as links:

No UI Changes Required in Digital Sales
In the Digital Sales UI, salespeople can enter accounts and contacts as text or select existing accounts and contracts in
the same field, so no UI changes are required. The screenshot highlights the Existing Account and Existing Contact
columns on the list page. Salespeople can enter an account or contact as text or select an existing record in these fields.

You can also use the Account Name and Contact Name  fields for the same purpose. These fields are equivalent.
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Add the New Account and New Contact Fields to the UI  
You must add the New Account and New Contact fields to the leads pages that salespeople use to create and qualify net
new leads.

You may want to add the two fields to these pages. The table gives the CX Sales page names and lists the equivalent
names in Application Composer.

UI Page Name Application Composer Page Name Comments

Leads
 

Landing Page
 

This is the landing page that opens when you
navigate to the work area. Salespeople should
see the New Account field displayed in the list
of leads.
 

Create Lead
 

Creation Page
 

Add the fields to the create page if you want
salespeople to create net new leads manually
in the UI. If a salesperson comes back with a
few business cards from a trade show, she may
want to create leads individually.
 

Edit Lead
 

Details Page
 

This is the page that inside sales agents will use
to verify the contact and account information,
 so you must expose both the fields. You must
expose the fields here to display any net new
leads you import using the lead import macro.
 

Convert Lead
 

Lead Convert Page
 

Converting a lead from a net new lead creates
a new account, a new contact, and a new
opportunity. Expose both fields so agents can
see what they are converting.
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UI Page Name Application Composer Page Name Comments

 

Convert Leads
 

Mass Lead Convert Page
 

Page you use to convert multiple leads at the
same time using the Qualify action from the list
page.
 

If you're adding the fields to the Digital Sales UIs, then you must use VB Studio instead of Application Composer. For
an example, see "Add a Custom Field to the Edit Contact Page" in the Oracle Fusion Cloud Sales Automation Extending
Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

If you're adding the fields to CX Sales UIs, follow these steps:

1. Create and activate a sandbox.
2. Create custom layouts for the appropriate pages and add the fields.
3. Review your work in the leads pages.
4. Publish the sandbox.

Create and Activate a Sandbox
To start customizing the CX Sales UI, activate a sandbox.

1. Click Navigator  > Configuration  > Sandboxes.
2. On the Sandboxes page, click Create Sandbox.
3. Enter a name for your sandbox.
4. In the All Tools section, select Application Composer as the tool you want to activate for this sandbox.
5. Click Create and Enter to create and enter the sandbox.

The application displays a bar at the top of the page with the sandbox name.

Add the New Account and New Contact Fields to the CX Sales Lead UIs

1. In the Navigator, click Application Composer located under the Configuration heading.

346



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 20
Leads

2. In the left pane of the Application Composer page, search for the Sales Lead object (callout 1 in the screenshot).

3. Open the Sales Lead object (callout 2).
4. Click Pages (callout 3).
5. For each of the pages where you need to expose the fields, do the following:

a. Locate the page.
b. Click Duplicate (callout 4).
c. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
d. On the Layout page, click Edit (the pencil icon).
e. Scroll down in the Available Fields column to locate the New Account and New Contact fields and move

them to the Selected Fields column.
f. Use the arrow buttons to move the fields where you want them.

g. Click Save and Close.

You're returned to the Layout page, which reflects your changes.
h. Click Done.

You're returned to the Application Composer page.

Test Your Changes
Here's how to test changes you made in CX Sales pages:

1. Click Home (the icon located at the top of the page).
2. Navigate to the Leads work area by clicking Sales > Leads.
3. Check to see if the New Account field displays as a column on the list page.
4. Click Create Lead.
5. Enter a lead name only.
6. Click Save and Continue.
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7. On the Edit Lead page, enter test data in the New Account  and New Contact  fields.
8. Click Save.
9. Click Actions > Convert.

10. On the Convert Lead page, click Submit.

After the lead processing completes, the Edit Lead page displays the converted lead. The contact displays as a
link in the Existing Contact field. And the account as a link in the Existing Account field.

11. You can drill down in the account and contact links to see that the account and contact records have been
created for you. From the Opportunity tab on the lead, you can also drill down into the opportunity created
from the lead.

12. If you need to make further changes, you can go back to Application Composer and edit the layouts again.

Publish Your Sandbox
After testing, publish your sandbox:

1. Click on the sandbox name in the sandbox toolbar and select Publish.
2. Click OK in the dialog box to navigate to the Sandbox Detail page.
3. In the Sandbox Detail page, click Publish again.
4. Click Continue to Publish in the warning message to confirm that you want to publish.

Next Gen Sales UI Only
If you need to make changes such as adding custom fields to the data model for the Digital Sales (Next Gen Sales) UI,
then you use Application Composer first to make those changes as describes in this topic. You can then use VB Studio
to expose those changes on the Digital Sales UI.

In Application Composer, you make data model changes inside a sandbox. You can see those data model changes in VB
Studio provided that your workspace is associated with the sandbox you're using in Application Composer. For more
information, follow the example topic, "Add a Custom Field to the Edit Contact Page", in the Oracle Fusion Cloud Sales
Automation Extending Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

Add the Redirect to Opportunity After Conversion Check Box  
Sales administrators can add the Redirect to Opportunity After Conversion check box to the Convert Lead page so that
users can choose whether to be redirected immediately to the opportunity page after the successful conversion.

This reduces the time spent going to the Opportunities subtab on the Lead and finding the right opportunity to open.

Note:  The redirect to opportunity feature is available for single lead conversions only. The check box is deselected by
default and isn't available from the Mass Convert Layout Pages for Leads.

Use these steps to add the Redirect to Opportunity After Conversion check box to the Convert Lead page.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. On the Application Pages tab, under the Lead Convert Page Layouts section, duplicate the standard layout to

create a new layout to edit.
7. Type a new layout name and click Save and Edit.

The Lead Convert Page Layout page appears.

348



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 20
Leads

8. Click the Edit icon next to  Lead Convert Page Layout.
9. From the Configure Detail Form region, move the Redirect to Opportunity After Conversion field from the

Available Fields area to the Selected Fields area.
10. Click Save and Close.
11. On the Edit Layout page, click Done and ensure that the layout status for your Lead Convert Page Layout is set

to Active.
12. Verify that you can see the Redirect to Opportunity After Conversion  check box on the Convert Leads page

for a selected lead that you want to convert.
13. Publish your sandbox.

FAQs for Sales Leads  

How can I provide Account team access to Leads?  
A user with the IT Security Manager job role can provide access to the leads associated with an account team by
creating a new data security policy for the Sales Lead database resource.

Using the security console, they can specify the access level such as view or update sales lead data, and then assign
what role, such as Sales Representative or Sales Manager, to apply to the security policy. Finally, they must specify a
condition for the new data security policy. For example,

Access the sales lead for table MKL_LM_LEADS where they are a member of the lead sales account team or in
 the management chain
 of a lead sales account team member.

For more information, see the Create a Data Security Policy for a Database Resource section in the topic Manage
Database Resources topic of the Oracle CX Securing CX Sales and Fusion Service guide on Oracle Help Center (https://
docs.oracle.com).

Related Topics
• Manage Database Resources

Can I update a lead number?  
No. A lead number can't be updated after the lead record is created. The only option is to delete the existing lead and
recreate it with the data you want.

How come I don't see products in leads or opportunities?  
You must enable and publish product and product groups in Adaptive Search before you see them in the leads and
opportunities UIs. You can do this either using Setup Assistant or using this procedure.

1. Open the task Configure Adaptive Search from the Setup and Maintenance work area:

◦ Offering: Sales
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◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. Click the Setup tab.
3. Select Product and Product Group and any other object you want to enable.
4. From the Actions menu, select Full Publish.
5. You can monitor the progress of the publish process on the Monitor tab.

Related Topics
• Speed Up Your Initial Setup with Setup Assistant

• Run Setup Assistant

How do I notify a lead owner by email when a lead is assigned to
them?  
You can create email notifications using the Routines feature. Routines is the fastest way of creating email notifications.
It doesn't require any Groovy scripting, and automatically appends a link to the lead in the email.

The following steps apply mainly to Redwood User Experience (UX) users. However, Simplified UI users can also use
these steps but note that some options on the Trigger page aren't available for Simplified UI users.

1. Open Application Composer outside a sandbox (Navigator > Configuration >  Application Composer).
2. Click Routines.
3. Click Create Routine.
4. Click Skip Templates.
5. Enter a name and description. For example: Email Notification for New Lead Owner Notify owner that a lead

was assigned to them.
6. Select the object, in this case Sales Lead.
7. Click Next.
8. On the Trigger page:

◦ Redwood UX users have the following options:
- Hourly
- Daily
- Weekly
- Monthly
- Yearly
- Record created
- Record deleted
- Attribute changed

◦ Simplified UI users have the following options:
- Hourly
- Daily
- Weekly
- Monthly
- Yearly
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Note:  For Simplified users, if the existing options don't suit your requirements, you can use Rules to specify
a trigger when the routine should run. For example, you can create and apply certain rule conditions to
Attribute Owner ID, or Last Update Date, or Status and so on to trigger and submit the routine.

9. For Redwood UX users, select Attribute changed and then select Owner ID from the list of attributes because
you're sending the email after the owner is updated in the record.

Note:  Redwood User Experience (UX) users will have access to more triggers to specify when the routine
runs. For example, in addition to the defined recurring schedules, they can choose to run the routine as soon
as an attribute is changed or when a record is created, updated, or deleted.

10. Click Next.
11. On the Actions page, select Send Email as the action type.
12. In the To field, select Owner ID.
13. In the Subject and Body fields, you can enter both text and mail-merge attributes. For example, to include the

lead name, enter Name in the Attribute search box, press Return, and click Lead Name. Your action enters the
mail-merge field {{$Name}}.

Note:  The email sent to the new owner gets automatically appended with a link to open the lead.

14. Optionally, you can add another action. For example, in addition to sending the email you can create a task by
selecting Create Task from the Action Type list and entering the task attributes.

15. Click Next.
16. In the Rules, page you can create rules and groups of rules that select the leads the notification runs on. In this

example, we're notifying the owner when any lead is assigned to them, so you can skip this step.
17. Click Next.
18. On the Review page, review your entries and click Submit.

See Overview of Routines for more information about routines.
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21  Competitors

About Sales Competitors  
The sales organization can track and analyze the impact competitors are having on sales by recording the competitors
in each opportunity. By default, the sales application requires salespeople to enter the primary competitor whenever
they close an opportunity. Unless you changed that default, you must create the list of competitors to enable
opportunity closing.

To create the list of competitors, you're only required to enter competitor names. However, you can track more details
about each competitor in the Competitors work area. You can enter company details, including its line of business, and
status.

The Opportunities tab automatically displays all of the opportunities where that competitor has been selected as the
primary competitor. Access to the Competitors work area is restricted to users with the Sales Administrator job role.
However, sales managers and others in the sales organization can access preconfigured reports to view the effects of
the competitors entered in opportunities.

Setup Assistant and Competitors
You can create up to 15 competitors using Setup Assistant. For each competitor you can enter:

• Name and suffix

• Line of business

• Threat level

• Organization size

You must go to the Competitors work area in Sales to enter the other details.

Related Topics
• Overview of Sales Competitors

• Manage Sales Competitors

Review the List of Competitors and Create Additional
Ones  
Here's how to review the list of competitors you created using Setup Assistant, add more information, and create new
ones. The names of the competitors you create are available for selection in opportunities in both CX Sales and Digital
Sales.
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Here's how to create a competitor in the CX Sales UI. Salespeople enter the names of competitors when they close
opportunties in both Digital Sales and CX Sales. However, detailed information about each competitor is available only
in the Competitors work area in the CX Sales UI.

1. Click Navigator > Sales > Competitors.
2. To create a new competitor:

a. On the Review Competitors page, click Create.
b. In the Create Competitor page, enter the competitor name in the Organization Name field.
c. You can enter a suffix, such as Ltd. or Co., in the Name Suffix field.

The suffix is automatically appended to the name in the application.
d. Select a threat level. Salespeople can use the threat level to filter their competitor searches.
e. Optionally, enter additional information about the competitor.

Any additional information you enter is only visible in the Competitors work area. Only the competitor
name is visible while selecting competitors in opportunities.

f. Click Save and Edit.
g. The application checks to see if any other organizations are potential duplicates. If there are existing

companies with a similar name, you can choose to edit one of these instead.
h. You can enter additional competitor information on the Edit Competitor page.

3. To review or edit an existing competitor, click on the competitor name link.

Related Topics
• Manage Sales Competitors

• Enable Competitors in Opportunities

• View Competitor Information Outside Opportunities

• Associate Competitors with Opportunities

• Enable Competitors in Leads
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22  Opportunities

Overview of Guided Sales Processes  
You can guide salespeople through a structured sales process as they pursue an opportunity from the initial qualifying
stage to closing the deal. In CX Sales, you build the guided sales process exclusively as a sales method. In Digital Sales,
sales methods provide the scaffolding for a much more full-featured process provided by orchestrations. Using sales
methods in CX Sales, you can provide only a single set of linear recommendations. Orchestrations in Digital Sales, by
contrast, can have multiple branches to suggest different actions when a particular step in the sales process does or
doesn't succeed.

Each opportunity must be associated to a sales method that takes the salesperson through a series of sales stages. For
each sales stage, you can specify any of the following:

• Prepopulate the win probability for opportunities at that stage.

If you're including opportunities in forecasts using win probability, then prepopulating a default win probability
ensures that opportunities don't get left out by mistake.

• Specify which field entries are required

For example, you may require salespeople to enter the close date or budget for opportunities that are about to
close.

For Digital Sales, you suggest appropriate tasks, documents, and actions for each sales stage by creating orchestrations.
At each sales stage, you specify what information the salesperson needs to provide and what actions they need to take
to move the opportunity to the next sales stage. You can also provide automated steps that take actions behind the
scenes to follow up when things don't go as planned. For example, you can automatically send a follow-up email if a
customer doesn't respond when a salesperson contacts them. See the topic Guide Salespeople Through Best Practices
Using Orchestration for more information.

CX Sales doesn't include orchestrations, but, for each sales stage, you can specify any of the following:

• The tasks you want assigned

• Documents you want to provide as part of Sales Coach

See the topic Overview of Sales Methods, Sales Stages, and Sales Coach in the Implementation Reference guide.

• Assessments

See the topic Overview of Assessments in the Implementation Reference guide.

Oracle provides several predefined sales methods, which you can modify to your needs. These include:

• Accelerated Sales Process

A sales process for deals that involve a single decision maker and short time frame.

• Standard Sales Process

A sales process designed for longer sales cycles, where decisions are made by committee.

You can create multiple sales methods for different sales situations and products. By default, all opportunities use the
sales method you specified as the default in the Configure Opportunities quick setup page. In Digital Sales, salespeople
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get to choose one of the available sales methods when they create an opportunity. If you want to give salespeople the
same option of choosing a sales method in CX Sales opportunity pages, then you must use Application Composer to
display the Sales Method field in the UI.

Setup Assistant and Opportunities  
You use Setup Assistant to configure basic opportunity behavior, but you must still supply the details of the sales
process you want the sales organization to follow.

What You Can Do in Setup Assistant
• Select the default sales method.

• Add, edit, or reorder sales stages.

• Specify if win or loss reasons are required when closing opportunities.

• Specify the default close date for opportunities.
If salespeople don't enter a close date in an opportunity, the close date is set to the creation date plus the
number you entered. The close date affects the way opportunities are forecast in the CX Sales UI.

What You Must Complete Manually

• Create the content for the sales method that you selected.
For example, for each sales stage in CX Sales, you can suggest action items, make some entries required, and
provide documents and assessments.

• Edit the list of opportunity statuses.

• Edit the list of win/loss reasons salespeople enter when closing opportunities.

• In Digital Sales, specify what information the salesperson needs to provide and what actions they need to take
to move the opportunity to the next sales stage and to complete the sale. See Guide Salespeople Through Best
Practices Using Orchestration.

Summary of Opportunity Setup  
Configure opportunities to guide salespeople through a structured sales process that's appropriate to your business.

Here's a summary of the setup tasks covered in this chapter.

Step Applies To Description Navigation Where to Get More Details

1
 

Digital Sales and CX Sales You can review and change
the default sales method
and change the opportunity
close behavior on the

Setup and Maintenance >
Sales > Opportunities >
Quick Setup (gears icon)
 

See the following topics in
this chapter:
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Step Applies To Description Navigation Where to Get More Details

opportunity Quick Setup
page.
 
However, you must use the
Manage Sales Methods
and Sales Stages task to
create new sales methods
or properly configure the
one you chose.
 

Setup and Maintenance >
Sales > Opportunities >
Manage Sales Methods
and Sales Stages
 

• What Opportunity
Behavior You Can
Configure and Where

• Configure Basic
Opportunity Behavior

• Create and Edit Sales
Methods and Stages

2
 

Digital Sales and CX Sales Optionally, configure
opportunity statuses.
 

Setup and Maintenance >
Sales > Opportunities >
Manage Sales Methods
and Sales Stages
 

See the topic: Modify
Opportunity Statuses
 

3
 

Digital Sales and CX Sales Optionally, configure the
list of win/loss reasons
salespeople enter when
they close opportunities.
 

Setup and Maintenance >
Sales > Opportunities >
Manage Set Enabled
Lookups
 

See the topic: Modify
the List of Reasons
Opportunities Are Won or
Lost
 

4
 

Digital Sales and CX Sales You can enable further
aggregations on custom
opportunity fields and
define the aggregation
label. For example, for
Deal Size, you might want
to aggregate a custom
revenue field or aggregate
a different custom revenue
field for an Expected
Revenue aggregation.
 

Setup and Maintenance >
Sales > Configure
Adaptive Search  >
Configure UI  >  Enable for
Group By
 

See the topic:
 
Enable Group By and
Custom Aggregations for
Opportunities

5
 

Digital Sales only
 

Before salespeople can
create recurring revenue
schedules in Digital Sales,
 you must first enable
the feature. You do this
in Oracle Visual Builder
Studio.
 
You must then enable the
Revenue Lines UI elements
for Digital Sales.
 

In Digital Sales, navigate to
the page that displays the
area you want to extend.
For example, navigate
to an opportunity record
and then click View All
Products on the Products
panel.Digital Sales >
Opportunities > View All
Products
 
Under the Settings and
Actions menu, select Edit
Page in Visual Builder.
 
Configuration >
Structure > Revenue Lines
 

See the following topics in
this chapter:
 

• Enable Recurring
Revenue Schedules

• Enable Revenue Lines
UI Element
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What Opportunity Behavior You Can Configure and
Where  
You can configure opportunities to support your specific sales process. For basic configuration, you can use either
Setup Assistant or the Configure Opportunities quick setup page (the two are equivalent). You must use other tasks to
make more substantial changes.

Here's an overview of default opportunity behavior for Digital Sales and CX Sales UIs and some of the ways that you can
change it.

Default Opportunity Behavior Applies To Changes You Can Make in Setup
Assistant or in the Configure
Opportunities Quick Setup Page

Additional Setup

Opportunities follow the Standard
Sales Process sales method
provided by Oracle.
 

Digital Sales and CX Sales
 

Oracle provides two sales methods:
 

• Standard Sales Process (the
default)

• Accelerated Sales Process

You can select any one of these
sales methods as the default and
modify its sales stages. Or you
can select a sales method that you
created from scratch.
 
In Setup Assistant or Quick Setup
page, you can edit the sales
method sales stage names and add
your own stages. To enter or edit
the stage details, you must use the
Manage Sales Methods and Sales
Stages task.
 

Use the Manage Sales Methods
and Sales Stages task to populate
the details of each sales stage,
 including:
 

• What fields are required

• The actions you want
salespeople to take

• The tasks you want assigned
(CX Sales Only)

• Documents you want to
provide as part of Sales Coach
(CX Sales Only)

• Assessments (CX Sales Only)

• For the Digital Sales UI, you
can suggest appropriate
actions to each of the sales
methods and sales stages
you create using Sales
Orchestration processes.

See the topic: Guide
Salespeople Through Best
Practices Using Orchestration.

Salespeople are required to
enter a win or loss reason for an
opportunity when they close it.
 

Digital Sales and CX Sales
 

You can make the entry of the win
or loss reason optional. Your entry
is the equivalent of setting the
profile option Close Opportunity
Win/Loss Reason Required.
 

You can modify the list of win and
loss reasons. See the Modify the
List of Win/Loss reasons topic for
details.
 

Salespeople must also enter at
least one competitor before closing
opportunities.
 

Digital Sales and CX Sales
 

You can make competitor
entry optional. Your setting is
the equivalent to setting the
profile option Close Opportunity
Competitor Required.
 

If you want salespeople to enter
competitors, you must set them
up as described in the Competitors
chapter.
 

358

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30231636
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30231636
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30231636


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 22
Opportunities

Default Opportunity Behavior Applies To Changes You Can Make in Setup
Assistant or in the Configure
Opportunities Quick Setup Page

Additional Setup

When a salesperson creates
an opportunity, the application
automatically sets the close date
to 20 days after the creation date
unless the salesperson enters a
different date. The close date can
affect opportunity forecasts.
 

Digital Sales and CX Sales
 

You can change the default close
date. Your entry is the equivalent to
setting the Opportunity Close Date
Default profile option.
 

By default, when the salesperson
closes an opportunity, the close
date is automatically updated to
the actual date. You can retain the
previous date, by setting the profile
option Opportunity Close Date
Retain on Closure to Yes.
 

A salesperson closes an
opportunity by selecting one of the
closed statuses: Won, Lost, or No
Sale.
 

Digital Sales and CX Sales
 

None
 

You can modify the list of
opportunity statuses using the
Manage Sales Status task. For
more details, see the Modify
Opportunity Statuses topic.
 

Configure Basic Opportunity Behavior  
Here's how to select and modify a sales method for your opportunities and to change opportunity close requirements. If
you're satisfied with the entries you made in Setup Assistant, you can skip this step.

1. Click Quick Setup (gears) icon for the Opportunities functional area in Setup and Maintenance:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Quick Setup

2. You can make these modifications to the sales method:

◦ Select a different sales method from the Default Sales Method list.

◦ Edit an existing sales stage name, description, or win probability.

◦ Select a different phase and status for a sales stage.

◦ Enter a new sales stage:

i. Click Add Row (the plus sign icon).
ii. Enter the sales stage information.

iii. In the Order column, enter a decimal number to insert the new stage between new stages. For
example, enter 1.5 to enter a stage between stage 1 and stage 2. To enter a sales stage at the
beginning, enter a value smaller than 1, for example, 0.5 or 0.75.

Note:  You can't change the order of the existing sales stages by changing the order number.

3. Modify opportunity close behavior:

◦ Make the entry of the competitor and win or loss reason optional by selecting the No option for each.

◦ Enter a different number of days in the Default Close Date in Days After Opportunity Creation field.
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If salespeople don't enter a close date in an opportunity, the close date is set to the creation date plus the
number you entered. The close date affects the way opportunities are forecast.

Manage Sales Methods and Stages  
Use these steps to edit an existing sales method, including one of those predefined by Oracle, or to create a new sales
method entirely.

Here's how to create and edit sales methods.

1. From Setup and Maintenance, open the task Manage Sales Methods and Sales Stages:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. On the Manage Sales Methods page, edit a sales method by clicking its name or click Create.
3. Leave the default value of Common Set for the Set field. Other values apply for implementations that require

different sales methods for different business units.
4. Enter a name for the sales method and an optional description. These entries aren't visible to salespeople by default,

but can be made visible when you configure the UI.
5. To provide a default close date for opportunities when they're created, enter a number of days in Close Window.

Create or edit the sales stages for the sales method as described in the following section.
6. Save your changes.

Note:

◦ The Enable Revenue Line Set Capability option is used only for multiple business unit
implementations.

◦ You can use the Disable option to remove any unused sales methods from use. You can't delete sales
methods after you create them.

Create or Edit Sales Stages for Sales Methods  
Here's how to create or edit sales stages for a sales method.

1. Edit a sales stage by clicking its name link or click Create.
2. Enter basic information about the sales stage, including predefined values for win probability and analytics reports:

Field Description

Name
 

Stage name visible in the UI.
 

Phase
 
(For CX Sales only)

Select a classification of the sales stage.
 
You can define the sales stage phases by using the Manage Sales Stage Phase Codes task from the
Setup and Maintenance work area.
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Field Description

Description
 

Description visible in the UI.
 

Status
 

Use the status of Open for all stages representing opportunities that are still in progress.
 

Order
 

Enter a number for the order of this sales stage in the sales method.
 

Quota Factor
 

Enter any number in this field. This number is used only for legacy reports, but entry is required.
 

Disable
 

Select the Disable option to remove any unused sales stages from view. You must not disable sales
stages after they're used in opportunities.
 

Win Probability
 

Enter a default win probability for opportunities in this stage.
 

Duration
 
(For CX Sales only)
 

The number of days this stage should last. When an opportunity is in a sales stage longer than the
duration, the opportunity is considered stalled. Stalled opportunities appear on the Stalled Deals
Infolet and underlying report.
 

Stalled Deal Limit
 

This field is no longer in use.
 

If you're including opportunities in forecasts using win probability, then prepopulating a default win probability
ensures that opportunities don't get left out by mistake. For example, if you automatically forecast all opportunities
with a 70 percent or greater win probability, then you can set up the following predefined win probabilities. Your
setup ensures opportunities in the Agreement, Negotiation, and Closed stages are included in forecasts even if a
salesperson forgets to manually enter a win probability.

Sales Stage Win Probability

Qualification
 

10
 

Opportunity
 

20
 

Building Vision
 

30
 

Presentation
 

50
 

Agreement
 

70
 

Negotiation
 

90
 

Closed
 

100
 

3. Add any fields that you want to make required for opportunities in the Additional Required Fields region.
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4. For the CX Sales UI, add any activity templates you have created in the Activity Templates region. The activity
templates can automatically create tasks and appointments, which appear in the Activities tab of the Edit
Opportunity page in the CX Sales UI.

5. Save your changes.

What to do next
For the Digital Sales UI, you can suggest appropriate actions to each of the sales methods and sales stages you create
using Orchestration. For more information, see the topic Guide Salespeople Through Best Practices Using Orchestration.

Clear Cache if New Values Don't Show Up in the UI  
If you don't see a new value that you created for a list of values in the Digital Sales UI, try clearing your browser cache.
For performance reasons, Digital Sales uses the browser cache to store data such as lists of values and dynamic choice
lists. A process clears the cache automatically every hour.

For example, if you're adding a sales stage to a sales method, you won't see the new sales stage in the Digital Sales
UI until the automatic process runs and clears the browser cache. You see the new sales stage in the CX Sales UI
immediately.

Modify Opportunity Statuses  
The application comes with four predefined opportunity statuses: Lost, No Sale, Open, and Won. Follow these steps to
add new statuses or modify the existing ones.

1. From the Setup and Maintenance work area open the Manage Sales Status task:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Show: All Tasks

◦ Task: Manage Sales Status

2. Here's how to add a new status:

a. Click Add (the plus sign icon).
b. Enter a name without spaces in the Status Code field. The code doesn't display to users.
c. Enter a display name in the Status field. This name displays in the opportunity pages in alphabetic order.
d. Select the Active option.
e. Select from one of the predefined values for Status Category.

3. You can modify an existing status by selecting its row.
4. Save your changes.
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Modify the List of Reasons Opportunities Are Won or
Lost  
When they close an opportunity, salespeople enter the reasons why the opportunity was won or lost. The application
comes with a predefined list that you can modify to suit your business:

• Customer not ready

• Good lead

• Install base

• Lost to competition

• Lost to internal development

• Lost to no decision

• No bandwidth

• No budget

• Other

• Price

• Product

• Relationship

• Track record

Use these steps to modify the reasons:

1. Open the task Manage Set Enabled Lookups from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Set Enabled Lookups

2. On the Manage Set Enabled Lookups page, Lookup Type field, enter MOO_SETID_WIN_LOSS_REASON.
3. Click Search.
4. Here's how you can add a new reason in the Lookup Codes section:

a. Click Add (the plus sign icon).
b. Enter an internal name in the Lookup Code field. No spaces permitted.
c. Select Common Set from the Reference Data Set list.
d. Select Enabled.
e. Optionally, enter a start and end date.
f. Enter the wording salespeople see as they close an opportunity in the Meaning field.

5. You can modify an existing win/loss reason by selecting its row.
6. Save your changes.
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Enable Group By and Custom Aggregations for
Opportunities  
Additional predefined fields are now available for Group By and Aggregations for opportunities.

Previously, salespeople could group opportunities by Quarter, Month, and Sales Stage, and aggregate opportunity
records by Opportunity Count and Revenue Amount fields. With Digital Sales, they now have access to other group-by
options including group ranges and values. You can also enable the group-by feature on any supported opportunity
fields including custom fields and configure aggregations to display predefined enabled aggregated fields in the
opportunity pipeline list.

For example, a salesperson might want to group opportunities by a custom Invoice Date field that isn't based on the
predefined Close Date field or they might want to group by Deal Size with specified defined ranges. You can enable
further aggregations on custom fields and define the aggregation label. For example, for Deal Size, you might want to
aggregate a custom revenue field or aggregate a different custom revenue field for an Expected Revenue aggregation.

Manage Opportunity Group By Field
Predefined fields are available for Opportunities for display as filters for your Group By search in Workspace, but you
can specify field values for display as a filter in your Group By search by going to the Configure Adaptive Search  >
Configure UI  >  Enable for Group By.

This list contains the standard predefined configuration for opportunity group by fields.

• Sales Stage

• Win Probability (PrimaryRevenue.WinProb)

• Month - on close date (EffectiveDate)

• Quarter - on close date

• Account (CustomerAccount)

See the related topics, Set Up Search Results in Groups, and Supported Objects and Predefined Fields for Group By from
the Adaptive Search and Workspace chapter of the Implementation Reference guide for more information.

Related Topics
• Set Up Search Results in Groups

• Supported Objects and Predefined Fields for Group By

Enable Recurring Revenue Schedules  
Using recurring revenue schedules, salespeople can account for revenue against opportunity products or product
groups that are part of subscription business models.

Before salespeople can create recurring revenue schedules, however, you must first enable the feature. You do this in
Oracle Visual Builder Studio. To enable recurring revenue schedules, you must complete these steps:
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Steps to Enable Recurring Revenue Schedules

Setup Step Context

1. Manually add the Add Schedule button
to the Edit dialog, which displays when
editing an opportunity product.
 

When editing an opportunity product, salespeople click the Add Schedule button to create a recurring
revenue schedule.
 
This button isn't displayed by default.
 

2. Manually add the Schedule column to
the Product list page.
 

When reviewing the list of products on an opportunity, salespeople can use the Schedule column to
see whether or not a product line has a recurring revenue schedule.
 
This column isn't displayed by default.
 

3. Configure the Schedule region to display
in more than two columns, if needed.
 

When adding or editing a recurring revenue schedule, the Schedule region is automatically organized
into two columns.
 
You can optionally change this layout, if needed.

1. Display the Add Schedule Button
Before your salespeople can create recurring revenue schedules for opportunity products, you must first display the
Add Schedule button. By default, the button is hidden.

To display the Add Schedule button:

1. In Digital Sales, navigate to the page that displays the area you want to extend. For example, navigate to an
opportunity record and then click View All Products on the Products panel.

The Products list page displays.
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2. Under the Settings and Actions menu, select Edit Page in Visual Builder.

3. Select the project that's already set up for you. If only one project exists, then you will automatically land in that
project.

4. If you're working in an active sandbox when you launch Visual Builder Studio from Digital Sales, then Visual
Builder Studio looks for a workspace that's associated with your sandbox. If you're not working in a sandbox
when you launch Visual Builder Studio, then Visual Builder Studio looks for a workspace without a sandbox. You
might have to select a workspace if more than one workspace exists. If no workspace exists, then Visual Builder
Studio automatically creates one for you.

5. When you enter into Visual Builder Studio, you're on the opportunities tab. Click the Variables subtab.
6. In the Constants region, highlight the isIndivScheduledOccurrences variable.
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7. On the Properties pane, in the Default Value field, select true.

8. Click the Preview button to see your changes in your runtime test environment.

9. Navigate to the product list on an opportunity and click Actions > Edit for a product.

In the Edit dialog, the Add Schedule button should display.

2. Add the Schedule Column to the Opportunity Products List
When reviewing the list of products on an opportunity, salespeople will want to know if a product has a recurring
revenue schedule. To enable this, you must add the Schedule column to the opportunity's Products list page. The
Schedule column displays either Yes or No to indicate if a product has a recurring revenue schedule.

To add the Schedule column to the Product list page:

1. In Visual Builder Studio, on the opportunities tab, click the Page Designer subtab.
2. Click the Design button.
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3. In the design area of the Page Designer, click the dynamic table component on the Products list page so that
the table region is selected.

4. On the Properties pane, click the Opportunity Child Revenue Sub View Layout rule set.

This is the layout for the revenue table.
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5. On the Rule Sets > Layouts tab, duplicate the default built-in layout by clicking the Duplicate icon.

6. Enter a name for the layout and click Duplicate.

Note:  It's not required to duplicate the default built-in layout before modifying it, but it's good practice to do
so.

7. Visual Builder Studio creates a duplicate copy of the built-in layout, which you can change.
8. Click the Open icon to edit the layout.
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9. Scroll through the list of fields to find the scheduledRevenueVirtual field. This virtual field is the Schedule field
that displays a Yes/No value.

Tip:  To find a field more quickly, enter the field name into the Filter field.

10. Select the scheduledRevenueVirtual field from the field list.

When you select a field, it displays in the list of fields to the right, at the bottom of the list. Use the field's handle
to drag the field to the desired location.

11. Click the Preview button to see your changes in your runtime test environment.

370



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 22
Opportunities

12. Navigate to the product list on an opportunity.

The Schedule column should display.

3. Configure the Columns on the Product Page
To create a recurring revenue schedule, salespeople can click the Add Schedule button when editing an opportunity
product. The Add Schedule button opens the Product page where salespeople can review product details and create a
recurring revenue schedule.

The Product page consists of two regions:

• A Product region at the top

• A Schedule region at the bottom

The Product region is extensible using Visual Builder Studio.

The Schedule region isn't extensible, although you can change its column layout. You might want to do this to match the
column layout of the Product region, for example.

To change the column layout of the Schedule region on the Product page:

1. In Visual Builder Studio, on the opportunities tab, click the Variables subtab.
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2. In the Constants region, highlight the revenueFormColumnNumber variable.

3. On the Properties pane, in the Default Value field, enter your desired number of columns, such as 5.

4. Click the Preview button to see your changes in your runtime test environment.

5. Navigate to the product list on an opportunity and click Actions > Edit for a product.

◦ If a schedule already exists, then click Edit Schedule to view the Product page. The Schedule region
should display with five columns.

◦ If a schedule doesn't yet exist, then click Add Schedule. On the resulting Product page, the Schedule
region should display with five columns.
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Related Topics
• About Recurring Revenue Schedules

Enable Revenue Lines UI Element  
The Revenue Lines UI element isn't displayed as part of the Digital Sales predefined object configuration. Use the
Structure page to enable the UI elements for the revenue lines object.

Revenue lines let salespeople view which products are being sold and how much credit they receive.

When configured, they can click the revenue lines icon under Digital Sales in the Navigator or springboard to launch the
Revenue Lines landing page. The Revenue Lines UI elements include:

• Revenue Lines icon on the springboard

• Revenue Lines link in the Navigator

• Revenue Lines landing page

Enable the Revenue Lines UI elements for Digital Sales as follows:

1. Sign in as the sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Configuration > Structure.
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4. In the Navigation Configuration page, select Revenue Lines under the Digital Sales section.

5. In the Edit Page Entry: Revenue Lines page, select Yes for the Show on Navigator and Show on Springboard options.
6. Click Save and Close.
7. Publish the sandbox.
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8. Verify that the Revenue Lines item is visible under the Digital Sales group and that you can view the Revenue Lines
landing page.

Related Topics
• Overview of Configuring Home Page and Navigation

• Configure the Navigator and Page Entries on the Home Page for Navigation

Enable Credit Receiver Record Set Values  
You can enable credit receiver related values that appear in the opportunity search filter record sets. From the
Setup and Maintenance work area, go to the Manage Standard Lookups and you can set the lookup types from the
ORA_MOO_OPTY_SRCH_RS_WS: Lookup Codes page.

Prerequisites
Keep in mind the following prerequisites when salespeople assign sales credits in opportunities:

• Territories have been set up and your company is using territories for assignment of opportunity products.

• The user must have Full access to the opportunity to assign sales credits.

The record set called I or my subordinate am a credit receiver returns records where the signed in resource or their
subordinate is a credit receiver for the opportunity. This allows sales managers and sales VPs to view the revenue lines
for their entire team and see who is receiving credit.

The I am a credit receiver record set returns records where the signed in resource is a credit receiver for the
opportunity. These record sets are predefined but they must be enabled before your salespeople can use them in Digital
Sales.

Note:  Record sets involving subordinates, which are resources within an organization or a line manager's hierarchy,
are available only to managers.
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Here are the steps to enable I am a credit receiver and I or my subordinate am a credit receiver values for the
opportunity search filter record set.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Meaning field, enter Opportunity Filter Record Sets for Workspace.
3. Click Search.
4. Select the lookup type you want to enable in the ORA_MOO_OPTY_SRCH_RS_WS: Lookup Codes page.

◦ Scroll to the ORA_CREDITRECEIVER_ISME (I am a credit receiver) lookup code and select Enabled.

◦ Scroll to the ORA_CREDITRECEIVER_MYORG (I or my subordinate am a credit receiver) lookup code and
select Enabled.

5. Click Save and Close.

376



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 23
Import Opportunities

23   Import Opportunities

Opportunity Import Steps  
You use two different Excel macros to import opportunities in two stages:

1. Use the Opportunity Import Macro to import opportunities minus the revenue lines.
2. Use the Opportunity Revenue Line Import Macro to import the revenue lines.

You can import up to 5,000 opportunities at a time using the macros.

Note:  While you can import additional fields by appending columns to the import macros, you can't make any other
changes. You can't edit the Visual Basic for Applications (VBA) code or other functions.

Import Opportunity Information Minus the Opportunity
Revenue  
You can use an Excel macro provided by Oracle to import basic information of up to 5,000 opportunities at a time. The
information you import includes the account, the opportunity owner, the primary competitor, and so on. You must
import the individual revenue lines for the opportunities separately, using the opportunity revenue macro.

Note:  All opportunities you import with the macro are imported with the Qualification sales stage and the default
sales method. To import opportunities at different stages, you must add the fields Sales Method and Sales Stage to
the macro.

1. Open the opportunity import macro file.
2. Enable macros, if required.
3. If you modified opportunity statuses, click the Status worksheet and enter the status codes and statuses in the

appropriate columns.
4. If you modified the win/loss reasons, click the Win_Loss_Reason worksheet and enter the codes and values in

the appropriate columns.
5. On the Competitors worksheet, click Populate Competitors from Server.
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6. Make these entries in the Login dialog:

a. Enter the host name. The host name is in the portion of the URL between https:// and /sales.
b. Enter the user name and password.
c. Click Submit.

The Competitors worksheet is populated with the competitors and their IDs. Here's a screenshot of the Excel
macro Competitors worksheet.

The macro uses this list to validate your entries in the Opportunity worksheet.
7. Click the Resource_EMail_To_ID_Mapping worksheet.
8. Click Populate Resource Attributes from Server to populate the worksheet with information about the

resources you will assign as owners of the opportunities you're importing.

The Login window appears with the user and password information you entered previously.
9. Click Submit.

The worksheet populates with the resource data.
10. If you're importing additional fields, including custom fields, then do the following:

a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server.
c. In an empty row in the worksheet, select the attribute from the Attribute Name column.
d. Enter the name you want displayed as the column heading in the Opportunity worksheet. This name

displays only in the macro.
e. Click Update Headers to add the column to the Opportunity worksheet.

11. Click the Opportunity worksheet.
12. Enter the currency code for your transactions.
13. Enter your opportunity data as described in the following table.

You must always enter data in these columns:

◦ Opportunity Name
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◦ Account Number

◦ Owner E-Mail

◦ Expected Close Date

◦ Status

◦ Creation Date

◦ Last Update Date

◦ Created By

◦ Last Updated By

You may have to enter data in additional columns, depending on your settings and what type of opportunity
you're importing. Here are the macro columns:

Column What to Enter

Opportunity Number
 

Leave this required column blank. The macro generates the opportunity number automatically
using the date and time when you click Generate Opportunity Number. You must generate
the opportunity numbers before entering opportunity revenue lines. The application uses the
opportunity number to link the opportunity to the revenue lines and to identify opportunities
during updates.
 

Opportunity Name
 

Entry is required. The opportunity name identifies the opportunity in lists displayed in the
Opportunity work area.
 

Account Number
 

Enter the account number. You can copy the account number from macro you used to import
accounts.
 

Owner E-Mail
 

Enter the email of the opportunity owner. The email must be one of the email addresses on the
Resource EMail to ID Mapping worksheet.
 

Win Probability
 

Optionally, enter a win probability. Depending on your setup, a win probability can determine
if an opportunity is included in a forecast. For example, you can decide to include all
opportunities with a win probability greater than 70 percent in your forecasts. See the Setting
Up Forecasting chapter for details.
 

Expected Close Date
 

Enter the expected close date in the following format MM/DD/YYYY. The expected close date
determines which forecast includes the opportunity. See the Forecasting chapter for details.
 

Status
 

Using the list of values, select one of the statuses available on the Status worksheet. You can
also enter the statuses manually.
 

Win/Loss Reason
 

Using the list of values, enter a win or loss reason for a closed opportunity. If you enter an
actual close date, then a win/loss reason is required depending on your profile option setting.
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Column What to Enter

 

Primary Competitor
 

Select the primary competitor from the list of values or enter one of the valid company names
manually. For opportunities with a close date, entry in this field is required depending on the
profile option setting you made.
 

Creation Date
 

Enter the opportunity creation date. The required format is YYYY-MM-DD'T'HH:MM:SS.SSS
which stands for Year-Month-Date'Time'Hour:Min:Sec + UTC. You can enter the date as MM/
DD/YYYY and have the macro convert your entry into the required format. For example, your
entry 2017/01/2005 converts to 2017-01-05T00:00:00.000+0000.
 

Last Update Date
 

Enter the date the opportunity was last updated. This date field requires the same format as
the creation date. You can enter MM/DD/YYYY, and have the macro convert your entry to the
required format.
 

Created By
 

Enter the Party Number of the user who created the opportunity. You can copy the Party
Number from the Resource EMail to ID Mapping worksheet. See the chapter on Importing
Accounts and Contacts for details.
 

Last Updated By
 

Enter the Party Number of the user who last updated the opportunity. You can copy the Party
Number from the Registry ID column in the file you exported to obtain the Party ID. See the
chapter on Importing Accounts and Contacts for details.
 

14. When you're done with your entries, click Create Import Activity.

The Login dialog appears displaying the host name, user name, and password you entered earlier.
15. Click Submit.
16. If the application prompts you to correct errors, then do the following:

a. Click OK

The Error worksheet displays your errors.
b. Click each error link in column D and make the correction on the Opportunity worksheet.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity and Submit again.
17. If the macro data is validated without errors then, the macro displays one of the following messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
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Message Meaning

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

Open the Errors work sheet to view the error details.
 

18. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

19. Optionally, click Generate Log to save a file listing the opportunities that were imported.

Import Opportunity Revenue Lines  
You can use the Excel macro provided by Oracle to import basic information of up to 5,000 opportunity lines at a time.

1. Open the Opportunity Revenue Quick Import Macro file.
2. Enable macros, if required.
3. If you modified opportunity statuses, click the Status worksheet and enter the status codes and statuses in the

appropriate columns.
4. If you modified the win/loss reasons, click the Win_Loss_Reason worksheet and enter the codes and values in

the appropriate columns.
5. Click the Resource_EMail_To_ID_Mapping worksheet.
6. Click Populate Resource Attributes from Server to populate the worksheet with information about the

resources you assign as owners of the opportunity revenue lines you're importing.
7. Make these entries in the Login dialog:

a. Enter the host name. The host name is in the portion of the URL between https:// and /sales.
b. Enter the user name and password.
c. Click Submit.

8. If you're importing additional fields, including custom fields, then do the following:

a. Click the Attributes Mapping worksheet.
b. Click Fetch Attributes from Server.
c. In an empty row in the worksheet, select the attribute from the Attribute Name column.
d. Enter the name you want displayed as the column heading in the Opportunity worksheet. This name

displays only in the macro.
e. Click Update Headers to add the column to the Opportunity Revenue worksheet.

9. Click the Opportunity Revenue worksheet and enter the revenue lines. You can enter multiple lines for each
opportunity. Here's what to enter in the columns:
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Column What to Enter

Revenue Number
 

Leave this column blank. This unique identifier for the revenue line number is automatically
populated by the macro when you initiate the import by clicking Generate Import Activity.
 

Opportunity Number
 

Enter the opportunity number linked to the revenue line you're entering. You can copy the
number from the Opportunity Number column in the opportunity import macro.
 

Product Group Reference Number
 

This column identifies the sales catalog product group the customer is interested in purchasing.
Enter the Product Group Reference Number from the macro you used to import product
groups. See the Setting Up the Sales Catalog chapter for details.
 
Each revenue line can have either a product group or a product. You can't enter both.
 

Product Number
 

You can enter the Product Number to indicate the specific sales catalog product the customer is
interested in purchasing. You can copy the product number from the product import macro you
used earlier or you can view the product numbers in the Products work area.
 
You can't enter a product if you entered a product group. A revenue line can't have both.
 

Currency Code
 

Enter an ISO currency code for the opportunity. For example, USD, EUR, or AUD.
 

Status
 

Select the status of the opportunity revenue line from the list of values or enter one of the
statuses manually. For example, Open, Won, Lost, or No Sale.
 

Win/Loss Reason
 

Using the list of values, enter a win or loss reason for a closed opportunity. If you enter an
actual close date, then a win/loss reason is required depending on your profile option setting.
 

Actual Close Date
 

For closed opportunities, enter the date the opportunity was closed in the following format
MM/DD/YYYY.
 
If you enter a close date, you must also enter a primary competitor and a win/loss reason,
 depending on the profile option settings you made.
 

Owner E-Mail
 

Enter the email of the opportunity revenue line owner. The email must be one of the email
addresses on the Resource EMail to ID Mapping worksheet.
 

Quantity
 

Enter the number of products or product groups that the customer is interested in.
 

Estimated Price
 

Enter the estimated price per unit for the product group or product.
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Column What to Enter

Amount
 

Leave this column blank. The macro automatically calculates the amount when you import.
 

10. When you're done with your entries, click Create Import Activity.

The Login dialog displays the host name, user name, and password you entered earlier.
11. Click Submit.
12. If the application prompts you to correct errors, then do the following:

a. Click OK

The Error worksheet displays your errors.
b. Click each error link in column D and make the correction on the Template worksheet.

Note:  After you correct an error, you must click outside the field for the correction to be recognized.

c. Click Create Import Activity and Submit again.
13. If the macro data is validated without errors, then the macro displays one of the following messages:

Message Meaning

The file import activity was

submitted successfully.

 

Your import has started. If the file import activity is submitted successfully, then the
confirmation message displays the job ID.
 

Unable to connect to the

server at this time.

 

You may have entered an incorrect host.
 

Unable to submit the file

import activity. Check log

for details.

 

You most likely entered the wrong mapping number or the user doesn't have the correct
permissions. Open the Errors work sheet to view the error details.
 

14. If your import activity was submitted successfully, then click Activity Details.

The Activity Details window appears, listing the import activity name, its ID, and its status.

◦ If the import activity is still in progress, you can refresh the status periodically by clicking Refresh.

◦ If your import completed successfully, then the status listed is Completed.

15. Optionally, click Generate Log to save a file listing the opportunities that were imported.
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Validate the Opportunities You Imported  
You can validate the opportunities you imported using specific filter methods from the Opportunities work area.

1. Sign in as a salesperson with the sales administrator job role. Sales administrators have broad access to sales
data.

2. Navigate to the Opportunities work area.
3. Enter filter criteria to view and verify that the list of records returned includes your imported opportunities.
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24  Sales Quotas

Overview of Sales Quota Setup  
Quotas are targets salespeople strive to reach. Set up this feature to simplify assigning quotas to salespeople and to
track their progress. This chapter covers the basic setup for quota management using the UI. It doesn't cover quota
import or advanced quota calculation features. Quotas functionality is available only in the CX Sales UI.

Here are the setup steps.

Step Applies To Description Navigation Where to Get More Details

1
 

CX Sales You previously set up
sales territories. Each
salesperson eligible to
receive a quota must be
assigned to an active
territory. Quota calculations
rely on territory coverage.
If you plan to use quota
calculations, then make
sure that territories have
dimensional coverage
defined.
 

Navigator > Sales >
Territories
 

See the Sales Territories
and Assignment chapter.
 

2
 

CX Sales Seasonality applies
percentages to split a quota
over months or quarters
to factor in seasonal
fluctuations. Seasonality
factor groups can be
associated with quota plans
or specific territories to
account for variations in
sales seasonality among
different territories. Instead
of entering quotas for each
period of the year, you rely
instead on seasonality to
split your annual quota into
period quotas. This task is
optional.
 

Setup and Maintenance >
Sales > Quotas > Manage
Sales Quota Seasonality
Groups
 

See the topic: Set Up Sales
Quotas
 

3
 

CX Sales The sales revenue goal is
predefined for revenue
quotas. You can add other
types of goals, such as
volume. This is optional.
 

Navigator > Quotas >
Tasks (the side panel) >
Manage Sales Goals
 

See the topic Sales Goals
in the Implementation
Reference guide
 

4
 

CX Sales Create a sales quota plan
for your fiscal year. One
plan per fiscal year is
required for tracking quotas

Setup and Maintenance >
Sales > Quotas > Manage
Sales Quota Plans
 

See the topic: Set Up Sales
Quotas
 

385

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20042169


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 24
Sales Quotas

Step Applies To Description Navigation Where to Get More Details

for the entire territory
hierarchy. The plan must
be activated before you can
allocate sales quotas.
 

5
 

CX Sales Allocate sales quotas
starting from the root
territory down the sales
territory hierarchy.
 

Navigator > Sales >
Quotas
 

See the topic: Set Up Sales
Quotas
 

Set Up Sales Quotas  
Your sales organization sets sales quotas starting at the top of the territory hierarchy. Quotas pass down through the
hierarchy to territories and the owners.

You create a sales quota plan to track the quotas for a year. Seasonality factors automatically split yearly quota into
period quotas according to known seasonal fluctuations.

Create a Sales Quota Plan
This sales quota plan uses seasonality, which isn't required.

1. Open the Manage Sales Quota Seasonality Groups task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Quotas

◦ Task: Manage Sales Quota Seasonality Groups

2. Create a new group.
3. In the Seasonality Factors region, enter the factor percentages for time periods. Percentages must add up to

100.
4. Click Save and Close.
5. Open the Manage Sales Quota Plans task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Quotas

◦ Task: Manage Sales Quota Plans

6. Click Create.
7. Enter information for your new sales quota plan.

Field Value

Calculate Default Territory Quota
 

Deselect. If selected, the application calculates the quotas for each of the territories using the
default territory quota formula.
 

Track Select. Only one plan can track quotas for the year.
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Field Value

  

Copy Quotas From
 

Leave Blank. After creating your first sales quota plan, copy a previous plan for a quick way to
create a new plan.
 

8. Click Save and Close.
9. On the Options tab, select the name of your seasonality factor group.

Here's the Options tab.

10. Click Save.
11. With your new quota plan selected in the list of plans, click the Activate button.
12. Set the activation to right now plus a few minutes in the future.
13. Click OK.

The initial status is Pending Activation. Refresh the page to verify that the status changed to Active.
14. A sales revenue goal is automatically assigned to every territory owner during the annual quota planning

process. Upon activation, sales managers can sign in to the application and begin allocating revenue quotas to
their teams. Click Synchronize if you suspect the territory hierarchy for quotas isn't current.

Allocate Sales Quotas
Use the following steps to allocate sales quotas to territories. Allocate quotas to each territory from the top of the
territory hierarchy down. You can allocate a quota to a territory only after you allocate the quotas for all the territories
higher in the territory hierarchy.

1. Navigate to Quotas.
2. Select your activated quota plan.
3. In the Edit Sales Quotas region, verify that the territory quotas and owners' quotas are zero.
4. Select the root territory in the hierarchy.
5. Enter a territory quota amount and a resource quota amount for the year for the whole organization.
6. Click Publish and verify that the status changed from Not Published to Published.
7. For each child territory of the root territory, enter a territory quota amount and an owner's quota amount.
8. Select the parent territory and click Details for the territory.

The Details table shows the rollup quotas total for the child territories and the variance from the parent quota.
9. Click Save.
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10. Click the Territory Quota tab and verify that as part of the publish process, seasonality was automatically
applied to split the annual quota into period quotas.

11. In the Manage Sales Quotas page, select a child territory of the root territory and click Publish.

Note:  If the Publish button is disabled, this could be the result of one of the following:

◦ You did not publish the parent territory.

◦ You don't own the parent territory.

◦ The territory was already published. You can't republish a territory at the bottom of the hierarchy.

12. Verify that the status is Published.

The application notifies the territory owner and the analyst that the territory was published.
13. Click Save.

The following table lists common publishing errors and their solutions.

Error Steps to Resolve

You can't publish quota for the territory
because the territory has revenue
quota assigned prior to the territory
quota start date.
 

a. Select the parent territory.
b. Click Details to navigate to the Edit Sales Quotas page.
c. Select the territory.
d. Select the Territory Quota tab.
e. Set the period quota to zero for any period prior to the territory quota start date.

The total quota of all quarters for the
territory doesn't equal the annual
quota.
 

a. Select the parent territory.
b. Click Details to navigate to the Edit Sales Quotas page.
c. Select the territory.
d. Select the Territory Quota tab.
e. Update the period quotas so their sum equals the territory quota.

You can't perform this action for the
selected record.
 

This error occurs when you attempt to publish a quota for a territory that you own. Only
administrators and owners of parent territories can publish quotas for this territory.
 

Schedule Quota Processes  
Sales managers or administrators frequently make changes to active territories directly, using territory proposals, or
through web services. Schedule synchronization to run frequently to provide the latest structure for allocating quotas.

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. For the Type field, select Job.
4. In the name field list, click Search.
5. Search for Synchronize Quotas.
6. Select Synchronize Quotas and click OK.
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7. In the Parameters region of the Process Details page, select the sales quota plan.
8. Click Advanced.
9. In the Schedule tab, select Using a schedule.

10. Select the Daily frequency.
11. Change the start date to when you want to start running the process, and select the time of day when you want

it to run.
12. Change the end date to a future date.
13. Use the Notification tab to add notifications to specific people when the process completes.
14. Click Submit.

389



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 24
Sales Quotas

390



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 25
Forecasting

25  Forecasting

What are some common opportunity forecasting
scenarios?  
Your sales organization can forecast opportunities by sales territory for each forecasting period and managers can
adjust those forecasts as required. The forecasting feature is available in the Classic user experience only. There are two
broad forecasting scenarios that require different setup:

• Scenario 1: Forecasting by Opportunity Owner

• Scenario 2: Forecasting When You Use Sales Territories to Assign Opportunities

Scenario 1: Forecasting by Opportunity Owner
Individual salespeople own their opportunities and forecast them. The forecasts are passed up the management
hierarchy for adjustment and approval. Your organization doesn't use geography, product, industry, or other territory
dimensions to assign salespeople to opportunities. If your sales process meets these criteria, then setup is as simple as
selecting Enable Sales Forecasting in Setup Assistant. The application sets up everything you need:

• Sets up a sales territory hierarchy that mirrors your sales resource hierarchy, with the individual salespeople as
territory owners.

• Assigns opportunities to the territory of their owners. This means that opportunity revenue is automatically
included in the forecasts of the opportunity owner.
When new accounts or opportunities come in, managers assign ownership to one of their salespeople and the
application automatically includes those accounts and opportunities in each owner's territory.

• Keeps the sales territories in sync if your resource hierarchy changes.
If you do update the sales hierarchy and want to see that the changes reflected in your forecasts right away,
then you must run the Refresh Territories from Resources process. The process is set to automatically run
before each forecasting window freeze.

• Rolls up forecasts up the sales resource hierarchy.

• Enables quarterly forecasts.

• Creates monthly forecast submission windows, so the sales organization can adjust forecasts and pass them up
the management chain. All you have to do is adjust the forecast submission window dates.

• Makes it possible for your sales organization to forecast product totals.

If you enable forecasting by opportunity owner in Setup Assistant, then each resource can only be in one territory (their
own) and you can't use sales territories to assign opportunities by geography, product, industry, or any other dimension.

Scenario 2: Forecasting When You Use Sales Territories to Assign
Opportunities
You assign opportunities to sales territories by geography, product, industry, and other dimensions. You may have
multiple salespeople from different parts of the sales organization involved in the sale. The opportunity owner is not
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necessarily the sole person forecasting the revenue. If your implementation meets any of these criteria, then you must
set up sales territories and enable assignment using the Set Forecasting Options task. You can't use Setup Assistant.

Setup Overview  
Forecasting can be set up in many different ways, depending on your requirements. Here are the steps for setting
up forecasting two representative forecasting scenarios to give you an idea of how forecasting works. Forecasting is
available only in the CX Sales UI.

Before you start review the topic What are some common opportunity forecasting scenarios?.

Step Description Navigation Where to Get More Details

1
 

If your implementation fits the
second scenario (you use sales
territories for assignment), you
enable Forecasting by clicking
Submit on the Select Forecasting
Options page.
 

Setup and Maintenance > Sales >
Sales Forecasting > Select
Forecasting Options
 

See the topic: Enable Forecasting
If You Use Sales Territories for
Assignment
 

2
 

Enabling Forecasting using either
method creates quarterly forecasts
for the next year and monthly
forecast submission windows for
each.
 
The forecast submission windows
are created automatically, without
accounting for the different
number of days in each month,
 weekends, or holidays. For these
reasons, you may need to adjust
the starting and ending dates of
each window to conform to your
company's schedule.
 

Setup and Maintenance > Sales >
Sales Forecasting > Select
Forecasting Options
 

See the topic: How can I adjust
forecasting windows and set
forecasting options?
 

3
 

You can change other forecasting
options on the same page:
 

• Increase the number of
quarters you can forecast at
the same time.

• Specify criteria for including
opportunities in the forecast.

• Set the number of levels of
the sales catalog hierarchy
managers can adjust
forecasts by product revenue.

• Display a different chart on
the Forecasts landing page.

• Hide the Products tab on
the forecast page to disable

Setup and Maintenance > Sales >
Sales Forecasting > Select
Forecasting Options
 

See the topic: How can I adjust
forecasting windows and set
forecasting options?
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Step Description Navigation Where to Get More Details

forecast adjustments by
products.

4
 

If you didn't hide the Products
tab, permitting sales managers to
adjust forecasts by product, then
you should specify what kinds of
adjustment types the managers
can make.
 
You don't want sales managers
entering their best case forecasts, if
the VP of sales isn't interested, for
example.
 
Hide the unused forecasts
adjustment types by editing the
ORA_ZSF_SHOW_METRICS lookup
type.
 

Setup and Maintenance > Sales >
Sales Foundation > Manage
Standard Lookups
 

See the topic: Specify the Types
of Forecast Adjustments Sales
Managers Can Use
 

Related Topics
• What are some common opportunity forecasting scenarios?

How Forecasting Works and How You Can Change It  
Your sales organization can start forecasting as soon as you enable forecasting using any of the available methods:
the Sales Setup Assistant, the Quick Setup page, or the Select Forecasting Options task. The application automatically
creates all you need to get started:

Watch video
 

• Quarterly forecasts for each sales territory for one year.

Each quarterly forecast automatically includes all won opportunities and all opportunities with a win probability
greater than 70 percent with close dates that fall within the quarter. Lost opportunities are never included in
forecasts.

• Monthly forecast submission windows.

During each forecast submission window, salespeople and their management adjust their forecasts and submit
them up the management hierarchy.

How It Works
Sometimes forecasting sales isn't much better than gazing into a crystal ball. Forecasting depends on the accuracy of
your pipeline data, and that's a problem. Sales prospects often lie about what they want to purchase to gain a better
bargaining position. Salespeople get lazy about entering deals or they withhold information because they're scared
others will steal their hot prospects. Your sales application can't make anyone truthful, but it does provide a structured
process that encourages salespeople to enter what they know, and holds them accountable. Each month, salespeople
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submit their quarterly forecasts to their managers. The managers review the forecasts, adjust the forecast amounts,
if necessary, and submit them up the management chain. Your organization gets a historical record of the monthly
forecasts that lets you evaluate how well you're doing. Here's how the process works as delivered:

1. Salespeople review their pipeline and their forecasts.

The Forecasts work area displays a dashboard with a summary of revenue forecasts by territory and quarter.
The forecasts are compiled automatically from all won opportunities with close dates in the quarter, and those
with 70 percent or greater win probability. Salespeople choose the territory they want to view (callout 1 in the
screenshot). A bar chart shows the amounts for the forecasts, won revenue, and open pipeline (callout 2). By
default, a second summary chart displays a bar chart that shows forecasts by time period. If you use quotas,
you can instead display a visual indicator showing in percentage of quota attainment with a numeric summary
(callout 3). The page also indicates if the forecast is submitted, how it was changed, and how much pipeline
remains to be submitted.
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2. Salespeople can review the list of opportunities included in the forecast and drill down to edit the opportunities.
Their changes are automatically reflected in the forecast by the Refresh Forecast process.

Here's a screenshot of the Review Sales Forecast page. The page summarizes the forecast amounts, the
forecast window dates, won revenue, and open pipeline.

3. While editing opportunities, salespeople can manually exclude or include opportunities from the forecast by
altering the win probability and the close date.

4. Each month includes a monthly forecast submission window. The submission windows typically start after a
monthly sales call. During the monthly submission window, territory changes are frozen, and salespeople can
submit their forecasts for review by their managers.

5. When they review forecasts, managers see a dashboard that's very similar to what salespeople see. The
dashboard summarizes the forecast revenue for the quarter, and makes it possible to compare the forecast
with won revenue and the pipeline. But, instead of summarizing individual opportunities for the quarter, the
manager dashboard summarizes the forecasts of all the territories in the territory hierarchy below the territory
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the manager selected. Managers can view at a glance which subordinates submitted their forecasts and the
trend of the latest updates.

Here's a screenshot of the forecast detail managers see. The highlighted table lists the forecasts for the
territories under the manager's territory in the sales territory hierarchy.

6. Managers can drill down into their subordinates' forecasts to see the details. After their subordinates submit
their forecasts, managers can adjust them, and submit their own forecast up the management hierarchy.
Sometimes managers know a deal is coming that a salesperson hasn't entered properly, so adjusting forecasts
gives those higher up in the management chain a more accurate picture of what's happening in the pipeline.
Managers can adjust the individual opportunities on the Forecast Items tab, or they can make adjustments by
products (Products tab).

There are multiple ways available for managers to adjust their forecasts. They can adjust the forecast amounts
or change the product quantities. And they can enter their best-case and worst-case forecast estimates.

Managers can drill down into forecasts to see who adjusted what and when. The changes in forecasts are also
indicated by icons. Hovering over an icon displays details about the change. Here's a screenshot of a portion
of a forecast. An up arrow indicates the forecast has increased since the last time the forecast was submitted.
Hovering on the icon displays the details.
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About Forecast Submission Windows and How You Adjust Them
By default, the application automatically generates the quarterly forecast periods and forecast submission windows for
each month for one year.

• Each quarterly forecast starts on the Start Date and ends on the End Date.

• There are nine rows in the table. Each row represents a monthly forecast submission window.

• There are three monthly forecast submission windows for each quarter.

• Each forecast submission window starts on the Territory Freeze Date and ends on the Due Date.

During the submission window, salespeople and managers get to submit and adjust their forecasts. The
application continues to update the forecasts automatically if new opportunities meet the inclusion criteria you
set. The application doesn't allow any territory changes during the submission window.

The application uses the default parameters entered in the Forecast Period Parameters region of the Select Forecasting
Options page to generate the windows. By default, each submission window starts on the first day of the month and
ends on the last day of the month. Salespeople and managers can submit their forecasts at any time.

Here's a sample schedule of the quarterly forecasts and submission windows the application generates:

Forecast Name Start Date End Date Territory Freeze Date Due Date

Q2-2019 -2019/04/30
 

4/1/2019
 

6/30/2019
 

4/1/2019
 

4/30/2019
 

Q2-2019 -2019/05/31
 

4/1/2019
 

6/30/2019
 

5/1/2019
 

5/31/2019
 

Q2-2019 -2019/06/30
 

4/1/2019
 

6/30/2019
 

6/1/2019
 

6/30/2019
 

Q3-2019 -2019/07/31
 

7/1/2019
 

9/30/2019
 

7/1/2019
 

7/31/2019
 

Q3-2019 -2019/08/31
 

7/1/2019
 

9/30/2019
 

8/1/2019
 

8/31/2019
 

Q3-2019 -2019/09/30
 

7/1/2019
 

9/30/2019
 

9/1/2019
 

9/30/2019
 

Q4-2019 -10/31/2019
 

10/1/2019
 

12/31/2019
 

10/1/2019
 

10/31/2019
 

Q4-2019 -11/30/2019
 

10/1/2019
 

12/31/2019
 

11/1/2019
 

11/30/2019
 

Q4-2019 -12/31/2019
 

10/1/2019
 

12/31/2019
 

12/1/2019
 

12/31/2019
 

The application automatically generates new submission windows at the end of each quarter, so there's always a year's
worth of submission windows. Your organization can modify the start and end dates of each submission window
by entering new dates in the Territory Freeze Date and Due Date fields. If you do adjust the dates, then you must
continue to adjust these dates as the new quarters get generated.
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Here's how forecasting works before each territory freeze date:

• The application compiles the forecast from opportunities that meet the forecast criteria.

• Salespeople and managers can't submit their forecasts or adjust them. All changes are made by editing the
opportunities themselves.

• Changes to the territory and sales catalog product hierarchy are automatically synchronized to the forecast.

• Salespeople and managers can change the opportunity lines and the changes are automatically reflected in the
forecasts.

Here's what happens after each freeze date:

• Salespeople and managers can edit, adjust, and submit forecasts for review up the management chain.

• Territories are frozen. Any changes to territories and product hierarchy aren't reflected in the forecasts.

• Changes to revenue items are synchronized to forecast items.

• Salespeople can adjust and submit their forecast between the Territory Freeze Date and the Due Date.

After salespeople submit their forecasts, their managers can review and adjust them. Salespeople can change and
resubmit their forecasts until managers submit theirs. After the due date is reached, each forecast becomes read-only
and can't be adjusted any more.

How You Change How Many Quarters You Can Forecast At the Same Time
By default, you can only forecast one quarter at a time. However, you can forecast two or three quarters at the same
time. Just enter a 2 or a 3 in the Number of Concurrent Forecasts field in the Forecast Period Parameters section of the
Select Forecasting Options page and regenerate the forecast submission windows.

How You Can Change What's Included in Forecasts
By default, the application automatically includes in each forecast all won opportunities and opportunities with a win
probability greater than or equal to 70 percent with close dates that fall within the forecast period. Only sales territories
that have the Forecast Participation attribute set to revenue can participate in forecasts.

What You Can Change How

Change the win probability required to
automatically include an opportunity in
the forecast.
 

On the Select Forecasting Options page, Unadjusted Forecast Criteria section, specify a different
probability.
 

You can let salespeople override the
automatic criteria and decide what
opportunities to include in forecasts.
 

On the Select Forecasting Options page, Unadjusted Forecast Criteria section, select the Enable
Forecast Criteria Override option in the Select Forecasting Options page, Unadjusted Forecast Criteria
section.
 

Prevent opportunities from getting left out
of forecasts when salespeople forget to
enter a close date and win probability.
 

You can set up your sales method to ensure that opportunities aren't left out because of incomplete
data entries. For example, you can make entries in the Win Probability and Close Date fields required
for the later stages of the sales process and you can have the application automatically prefill the win
probabilities themselves when salespeople move an opportunity to a particular sales stage.
 
You can also set up your sales method so that a particular sales stage defaults a win probability that
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What You Can Change How

Make sure that an opportunity at a
particular sales stage gets included in
forecasts.
 

When setting up your sales method, you can specify a default win probability. By entering a default
of 70 percent for opportunities in the Agreement sales stage, for example, you ensure that all
opportunities in the Agreement stage are included unless sales representatives change the win
probability manually.
 

You can enable forecasting on individual
line items separately.
 

By default, the win probability and close date are set for the whole opportunity. To forecast individual
revenue lines, you can expose the Win Probability field for the lines in the Edit Opportunity page
using Application Composer. See the Implementing Sales guide for details on this and other advanced
features.
 

Forecast Adjustment Options
By default, managers can adjust the submitted forecast revenue by opportunities on the Forecast Items tab and by
products on the Products tab of the Edit Forecast page. Adjustments on the Products tab are especially handy when
sales managers want to forecast products that aren't yet entered as part of an opportunity.

• You can specify the level of granularity for the product adjustments. For example, you can enable adjustments
just for broad groups of products, or down to the individual product. By default, the application enables
adjustments two levels down from the sales catalog root. The adjustments that managers make are visible to
their own managers after they submit the forecasts.

Here's a screenshot of the Products tab on the Edit Forecast page. The page shows a sample sales catalog
hierarchy, which extends four-levels down to the individual product. Callout 1 highlights a product forecast line
selected for adjustment.
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• If you don't want managers to adjust forecasts by products, you can remove the tab entirely by deselecting the
Enable Product Totals option in the Product Tab section of the Select Forecasting Options page.

Enable Forecasting If You Use Sales Territories for
Assignment  
Here's how to enable forecasting if you set up sales territories to assign opportunities by geography, product, or other
dimensions.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Forecasting

◦ Task: Select Forecasting Options

2. Select Enable Forecasting.
3. Click Submit.

The application runs a background process to generate your forecast windows and forecasts using the
application's default option settings. The application generates quarterly forecasts for one year with a forecast
submission window each month. After the process completes, your sales organization can start reviewing your
forecasts right away. You can also change the forecasting defaults on the Select Forecasting Options page.

Overview of the Sales Forecasting Options Page  
The Select Forecasting Options page is the Swiss Army knife in your forecasting setup, so it's worth getting an overview
of the tools at your disposal. Here's an overview of the different page sections and what you can use them for.

Section Name Overview

Forecast Period Parameters
 

The application generates the forecast submission windows using the default parameters entered in
this section when you enable forecasting and at the end of every quarter.
 
The generated submission windows are displayed in the Scheduled Forecasts section where you can
adjust them to conform with your actual forecasting schedule.
 
The automatically generated submission windows are approximations only, so you must adjust the
dates manually. You can also enter different parameters to generate entirely different set of submission
windows.
 
 

Unadjusted Forecast Criteria
 

Here you specify the win probability the application uses to determine which opportunities to include
in the forecast. You can also permit salespeople to include any opportunity they want.
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Section Name Overview

Product Tab
 

Selecting the Enable Product Totals displays the Products tab on the Edit Forecasts page. Sales
managers use the tab to adjust forecasts by product group rather than by territories. Deselect Enable
Product Totals to enable adjustments by territories only.
 

Metrics
 

All forecasting metrics are enabled automatically, but you can use this section to change what chart
is displayed in the Forecasts landing page. If you want to enable the display of the chart comparing
forecasts to quotas, select the Quota option and disable the Enable Forecast Trend Graph option in
Additional Settings. You can ignore the other options. They aren't used any more.
 

Additional Settings
 

Use this section to enable the forecast trend graph as the second chart on the Forecasts landing page,
 and to make it possible for managers to enter notes about their forecast adjustments.
 

Scheduled Forecasts
 

The application displays the generated forecast submission windows in this section. You must
manually adjust the dates of each submission window.
 

How can I adjust forecasting windows and set
forecasting options?  
You can adjust the monthly forecast submission windows the application generated, change the criteria for including
opportunities in forecasts, and set other forecasting options.

After you navigate to the Select Forecasting page, you can:

• Adjust the forecast submission windows.

• Set forecasting criteria.

• Specify the granularity of product adjustments or disable adjustment by product entirely.

• Change the chart on the landing page and turn on adjustment notes.

Navigate to the Select Forecasting Options Page
Open the task Select Forecasting Options from the Setup and Maintenance work area:

• Offering: Sales

• Functional Area: Sales Forecasting

• Task: Select Forecasting Options

Adjust the Forecast Submission Windows
The application generates the monthly forecast submission windows using the parameters specified in the Scheduled
Forecasts section.

1. Review and adjust the monthly forecast submission windows the application generated in the Scheduled
Forecasts section of the page. Each window starts on the Territory Freeze Date and ends on the Due Date.
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2. If you want to specify a different set of forecasting periods or want to forecast more than one quarter at a time,
you can enter different parameters in the Forecast Period Parameters section. You must then regenerate the
scheduled forecasts and submission windows by clicking Submit. Here's an explanation of the fields in this
section:

Field Explanation Provided and Suggested Values

Forecast Period
 

Typically a quarter. Each forecast includes
only those opportunities set to close in the
forecast period.
 

Quarter
 

Adjustment Period
 

This read-only field displays the type of
period you selected when you set up your
accounting calendar. Typically, this is a
month.
 

You can't edit this field.
 

Forecast Frequency
 

Enter the number of submission windows
you want to generate for each forecast
period.
 

Because you are holding a forecasting call
each month and there are three months in
each quarter, the value is 3.
 

First Forecast Due Date
 

The date you want the first submission
window to end relative to the forecast
period. The application takes the forecast
snapshot at the end of the day.
 

The First Forecast Due Date has the default
value of 31 and the After the forecast
period start date option is selected. These
settings create the first forecast submission
window, which ends on the last day of the
first month in each quarter.
 
The application generates the subsequent
submission windows based on the number
of days you enter here and in the Territory
Freeze Date field.
 

Territory Freeze Date
 

The number of days before the end date
when you want the submission window to
start.
 
Any sales territory changes after this
freeze date are ignored and applied only to
subsequent forecasting windows.
 

For the forecast submission windows to
start at the beginning of each month, the
number provided is 31.
 

Number of Concurrent Forecasts
 

Specified how many quarters you can
submit forecast for at the same time.
 

The default value is 1, so by default, you can
forecast only one quarter at a time.
 
Entering a 2 or a 3, makes it possible for you
to submit and adjust forecasts for two or
three quarters every month.
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Field Explanation Provided and Suggested Values

Number of Scheduled Periods
 

The number of forecast periods you want to
view.
 
Managers can only adjust the forecast for
the current period during the submission
windows you generated, but you can view
the forecasts for subsequent periods.
 

The number of forecast periods is set to 4
(four quarters) for the whole year. You can
change the number of forecast periods.
 

3. If you modified forecast period options, then click Submit.

The application runs a process to regenerate the forecasting periods and updates your forecasts. The Select
Forecasting Options page is unavailable until the processes completes. When the process completes, the
generated submission windows appear in the Scheduled Forecasts region.

4. Click Submit when you are done.
5. The application automatically generates new submission windows at the end of each quarter. You must

continue to manually adjust these windows as they are generated.

Set Forecasting Criteria
The application includes in a quarterly forecast any opportunities that close within the quarter and match the forecast
criteria you set in this section.

1. By default, the application includes opportunities with a win probability greater than or equal to 70 percent. You
can change the probability to include or exclude more opportunities. It's a good idea to specify a probability
that matches the default probability of the appropriate sales stage in your sales method.

Note:  By default, the win probability is set at the opportunity level. To forecast at the level of individual
revenue lines, you can expose the win probabilities for the lines in the Edit Opportunity page using
Application Composer.

2. Selecting the Enable Forecast Criteria Override option makes it possible for salespeople or their managers to
include or exclude an opportunity from a forecast while editing regardless of its win probability. If you select the
option, then salespeople can make a selection from the Include in Forecast list while editing an opportunity.

3. Select the Enable nonrevenue forecasting option if you want to generate separate forecasts for overlay
territories.

Specify the Granularity of Product Adjustments or Disable Adjustment by
Product Entirely
By default, sales managers see the Products tab on the Forecasts page and can adjust forecasts by product. You can
make these changes:

• Specify number of sales catalog levels sales managers can adjust in the Product Hierarchy Depth field. By
default, managers can adjust product groups up to two levels below the catalog root.

• Hide the Products tab and disable adjustments by product entirely, by deselecting the Enable Product Totals
option.

403



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 25
Forecasting

Change the Chart on the Landing Page and Turn on Adjustment Notes
The Forecasts landing page displays a Forecast Overview chart that compares your forecast with won revenue and
open pipeline. It also displays a second bar chart that shows your forecast by time periods. You can replace the second
chart with a chart comparing the forecast and quotas. You can also enable managers to add notes about their forecast
adjustments.

• To display the forecast to quota comparison chart instead of the forecast by time periods bar chart, make these
selections:

◦ In the Metrics section of the Select Forecasting Options page, select the Quota option.

◦ In the Additional settings section, deselect the Enable Forecast Trend Graph option.

• If you want to enable sales managers to add notes when they adjust forecasts, select the Enable Adjustment
Notes option in the Additional Settings section. Sales managers can add adjustment notes for each forecast
item. They can also create and edit a single adjustment note for summary territory adjustments or a note for
summary product adjustments.

Specify the Types of Forecast Adjustments Sales
Managers Can Use  
Sales managers can adjust forecasts on the Products tab in a number of ways. They can adjust the revenue totals for
products or groups of products, or they can adjust the product quantities, for example.

A salesperson didn't get around to entering the potential sale of 20 Green Servers? No problem! The manager can
add the servers to the forecast without creating an opportunity. Managers can also enter their best case and worst-
case forecast scenarios. All of the adjustments and scenarios get passed up the management chain. You should decide
which forecast adjustment types you want to use in your sales organization and disable the rest. There's no point for
managers to enter the best-case or worst-case scenarios if their management doesn't view them.

Available Forecast Adjustment Types
Managers select the adjustment type they want to use from the Show list on the Product tab. Here are the available
adjustment types:

• Forecast

Managers can adjust the revenue for products or product groups for each forecast submission window.
And they can even enter revenue for products that aren't associated with any opportunities. These revenue
adjustments get reflected in the forecast landing page charts.

• Best Case

Managers can use this forecast to enter their best-case scenario numbers. You can also make it possible for
sales managers to view the best case or worst case forecast totals on the Forecasts landing page. You must
expose the Best Case and Worst Case fields on the landing page layout using Application Composer. Some
Oracle customers also write Groovy scripts to automatically enter the sum of submitted and potential sales.
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• Worst Case

Managers can use this forecast to indicate their best case scenario numbers. A Groovy script you create could
automatically enter the submitted opportunity numbers.

• Quantity

Makes it possible to forecast and adjust forecasts by product quantity. This is the only adjustment type not
displayed in the list by default.

• All Totals

Displays a table summarizing the totals for all the different forecast adjustment types. Here managers can
update the total revenue forecast for the quarter, rather than updating the individual monthly numbers on the
Forecast selection.

Here's a screenshot of the Products tab highlighting the Show list:

Specify What Adjustment Types Managers Can Use
Here's how to specify which adjustment types sales managers can use:

1. Open the task Manage Standard Lookups from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation
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◦ Show: All Tasks

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page, search for the lookup type ORA_ZSF_SHOW_METRICS or the
meaning Forecast metric options.

3. Highlight the row containing this lookup type.
4. In the Lookup Codes region, make sure Enabled is selected only for the forecast adjustments you want to use.
5. Click Save and Close.
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26  Configure the Navigator and Home Page

A Single Page for All Your Sales Activities  
In the default home page design provided by Oracle, salespeople can access both the different work areas they need
as well as the reports and analytics that highlight key sales information. Here's a brief description of the home page
sections. You can configure the different sections and even hide some, but you can't change their order on the page.
The home page is shared both by Digital Sales and CX Sales.

Global Toolbar and Springboard with Navigation Icons

Callout Number Region Description

1
 

Global region with toolbar.
 

The toolbar includes icons to open the
Navigator, Home page, and the Settings and
Actions menu, among others. The toolbar,
 described in a separate topic, is available on all
pages.
 

2
 

Tabs that group navigation icons.
 

Which tabs users see depends primarily on
their security privileges. Because setup users
have broad privileges, you see many more tabs
than sales users. For example, sales users never
see the Service or Help Desk tabs, as these
aren't part of CX Sales or Digital Sales.
 
Sign in as a Sales Representative or a Sales
Manager to get an idea of how the application
is set up by default for each user.
 
Using the Structure tool, you can rename the
tabs, hide them, change heir order, and move
their contents.
 
The tabs correspond to the groupings you
see in the Navigator, but you can choose to
display only a subset of what's available in the
Navigator.
 

3
 

Navigation icons within the tab you selected.
This region is called the springboard.
 

Navigation icons within the tab you selected.
 
The navigation icons correspond to the
selections you see in the Navigator.
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Things to Finish and News
The middle of the page includes two regions that you can hide during setup:

• Things to Finish

Displays the same notifications you can view using Notifications (bell icon) in the global toolbar.

• News and Announcements

You can create company-wide announcements as described in the topic Create and Enable an Announcement
in the Oracle Applications Cloud Implementing Applications guide.
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Analytics and Key CX Sales Information Displayed in Infolets
The Analytics section displays tabs grouping infolets. Infolets are containers that display key sales information in CX
Sales. In Digital Sales you display the information in the Sales Dashboard instead.

You can display different infolets for different job roles in the organizations and salespeople can configure what
information they want to see on their own page.

There are two types of infolets you can display:

• Infolets with business intelligence reports provided by Oracle or those you create in Oracle Business Intelligence
Answers (BI).
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• Workspace infolets that summarize sales information and make it possible to take action on individual items
without drilling down into individual records.

Here's a screenshot of the Sales Infolets tab displaying two Workspace infolets.

Note:  By default, your application displays an older type of infolet, called actionable infolet, rather than the
Workspace infolets. As described in this chapter, new customers should switch to using Workspace infolets
because they're designed to work with Workspace. Actionable infolets are designed to work with individual
work areas and the saved searches created in them.

Related Topics
• Workspace Infolets

Workspace Infolets  
Workspace infolets summarize key sales information in the Sales Infolet tab in the Analytics section at the bottom of the
home page. Workspace infolets are used in CX Sales. They provide salespeople with many of the features they use in
Workspace, such as quick actions and filters.

For example, from within the My Accounts Workspace infolet, salespeople can take notes, log calls, schedule
appointments, and even create opportunities for a specific account in the list. They can also create accounts directly
from the infolet. Here's a screenshot of the My Accounts infolet provided by Oracle:

Callout Number Function What You Can Configure

1 Infolet title. Edit the title.
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Callout Number Function What You Can Configure

   

2
 

Select a Workspace saved search as a filter.
 

Specify which Workspace saved searches are
available as filters.
 

3
 

Review basic information about accounts and
drill down to edit
 

You can specify which fields display in each
record in the list.
 

4
 

Take actions on an account without drilling
down. On an account, you can take notes, log
calls, and even create opportunities.
 

You can enable, disable, or reorder the smart
actions using Application Composer.
 

5
 

Create new accounts.
 

N/A
 

6
 

Navigate to Workspace.
 

N/A
 

Oracle provides you with 10 Workspace infolets. Six are preconfigured and four blank:

• My Accounts

• My Appointments

• My Contacts

• My Leads

• My Opportunities

• My Tasks
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• Additional Actionable Infolet

• Additional Actionable Infolet

• Additional Actionable Infolet

• Additional Actionable Infolet

As a sales administrator or setup user, you can configure the information in each of the infolets, even those that
are preconfigured. You can specify which Workspace saved searches are available as filters, change the infolet title,
and decide how you want the infolet information to display. You can configure Workspace infolets to display any
combination of saved searches from Workspace. Suppose, for example, that you created a project custom object to
track projects involving multiple customers. You could configure one of the Workspace infolets as My Projects to track
the accounts and the tasks involved.

Setup Overview  
Here's an overview of the steps to configure your home page and navigation to application features.

Home Page
Here's a summary of the steps to configure your home page appearance. The home page is shared by both CX Sales
and Digital Sales.

Step Applies To Description Navigation Where to Get More Details

1
 

Both CX Sales and Digital
Sales

Create a sandbox with the
Appearance tool.
 

Configuration >
Sandboxes
 

See the video and topic:
Configure Home Page
Appearance
 

2
 

Both CX Sales and Digital
Sales

Upload your company
logo and save your new
configuration.
 

In the sandbox, select
Tools > Appearance
 

Covered in the same video
and topic.
 
For additional configuration
options, see the
Configuration of Home
Page and Navigation
chapter of the Oracle
Applications Cloud
Configuring and Extending
Applications guide.
 

3
 

Both CX Sales and Digital
Sales

You can remove the Things
to Finish and the News
and Announcements
sections of the home page,
 by clicking Home Page
Display (top icon in the
Appearance tool) and
setting Visible to No.
 

In the Appearance tool,
 click Home Page Display
 

Covered in the same video
and topic.
 

4
 

Both CX Sales and Digital
Sales

Publish your sandbox.
 

Click Publish in the
sandbox.

Covered in the same video
and topic.
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Step Applies To Description Navigation Where to Get More Details

  

Navigation and Infolet Tabs
Here's an overview of the steps to configure navigation and specify which infolet tabs appear in the Analytics section.
Infolets are important only for CX Sales.

Step Applies To Description Navigation Where to Get More Details

1
 

Both CX Sales and Digital
Sales

Sign in as users with the
different job roles you
are using and review the
default navigation for each
to see which items you
want to hide or configure.
CX Sales icons appear in
the Sales tab. Digital Sales
icons in the Digital Sales
tab.
 

Not applicable.
 

See the topic: What
Different Sales Job Roles
See in the Navigator and
Springboard
 

2
 

Both CX Sales and Digital
Sales

Create a sandbox with the
Structure tool.
 

Configuration >
Sandboxes
 

See the video and topic:
Configure Navigation
 

3
 

Both CX Sales and Digital
Sales

Specify which items
salespeople see on the
Navigator and which icons
they see on the home
page springboard and
in which order. You can
hide unwanted items from
everyone or you can add
EL Expression conditions
to make them visible
only to a subset of users.
You can make features
accessible from both the
Navigator and the home
page springboard, or from
the Navigator only.
 

In the sandbox, select
Tools > Structure
 

Covered in the same video
and topic.
 

4
 

CX Sales For CX Sales, specify which
infolet tabs in the Analytics
section appear and in
which order. All of the
Workspace infolets you
need to display key sales
information are available
within the Sales Infolet tab,
 so you can hide the rest
unless you need them.
 

In the Structure tool, click
the Home Configuration
tab.
 

Covered in the same topic.
 

5
 

Both CX Sales and Digital
Sales

Publish your sandbox.
 

Click Publish in the
sandbox.
 

Covered in the same topic.
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Workspace Infolet Configuration

Step Applies to Description Navigation Where to Get More Details

1
 

CX Sales Create and enter a sandbox
with Page Composer as
your tool. If you want to
display different Workspace
infolet configurations for
different job roles, you can
specify a job role.
 

Configuration >
Sandboxes
 

See the topic: Create and
Enter a Sandbox with Page
Composer as Your Tool
 

2
 

CX Sales Specify which Workspace
infolets you want to expose
on the page and how you
want the page to look.
 

While in Page Composer,
select each infolet you want
to display from the Infolet
Repository.
 

See the topic: Specify Which
Workspace Infolets Display
and In What Order
 

3
 

CX Sales Configure the content of
each Workspace infolet. You
can:
 

• Change the infolet title

• Specify which
Workspace saved
searches salespeople
can select

• Choose the fields that
display in each record
for each saved search

While in Page Composer,
 open each Workspace
infolet and go to Actions >
Configure
 

See the topic:Configure
Workspace Infolets
 

4
 

CX Sales Remove any unused
infolets from the list of
infolets available for display.
 

While in Page Composer,
 open each Workspace
infolet and go to Actions >
Edit Visibility
 
 

Covered in the same topic.
 

5
 

CX Sales Save your work by
clicking Close in the Page
Composer toolbar, and
publish your sandbox.
 

Click Close in Page
Composer and then
Publish in the sandbox.
 

N/A
 

6
 

CX Sales In Application Composer,
 you can enable, disable, or
reorder the actions users
can take for each object.
This setup is optional.
 

Application Composer >
Common Setup > Smart
Actions
 

See the topic Overview
of Smart Actions in the
Configuring Applications
Using Application
Composer guide.
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Configure Home Page Appearance  
Oracle provides you with a default home page design that salespeople can use to access all of the navigation icons
and key sales information they need. While you can still use alternate multipage designs that are more configurable,
Oracle recommends that for CX Sales, you use the default theme and limit your configuration to uploading your logo
and hiding sections of the page you don't need. You can't change the order of the sections on the page.

Watch video
 

1. Create and enter a sandbox with the Appearance tool enabled:

a. In the Navigator, click Configuration > Sandboxes.
b. Click Create Sandbox.
c. Enter a sandbox name.
d. Select Active for the Appearance tool.
e. Click Create and Enter.
f. From the sandbox Tools menu, select Appearance to enter the tool.

2. In the Logo field, select File from the list and upload your logo.

The logo image must be saved as a .png file with a transparent background with a recommended maximum
size of 200 pixels wide and 50 pixels high.

3. If you're hiding the Things to Finish and News and Announcements sections, there's no point in uploading an
image using Cover Image. The image appears in the center of the page under these sections.

4. Remove either or both of the Things to Finish and News and Announcements sections of the page if you
aren't using them. Things to Finish displays notifications you can also access from the toolbar. News and
Announcements can display your company-wide announcements. Here's how to hide them:

a. Click Home Page Display, the top icon on the page.
b. Click in the Visible column for each section and select No.

5. View your new home page configuration while inside the sandbox by clicking Home.
6. Publish the sandbox:

a. Click the sandbox name and select Publish.
b. On the Sandbox Detail page, click Publish.

You can check the progress of the publish process in the Current Status section.

415

http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:27621
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:27621


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 26
Configure the Navigator and Home Page

Configure Navigation  

The Different Factors That Determine What Users See on the
Home Page  
Which selections users see in the Navigator, and which icons and infolets they see on the home page depends on a
number of factors:

• Security roles

What users see in the UI is primarily determined by their security roles. For example, users you provision with
any of the standard sales job roles, get to see all of the sales navigation, including Opportunities, Accounts,
Leads, Contacts, and so on. But they don't see the Security Console, a feature only available to users with the
IT Security Manager job role. Because users are granted the Employee abstract role, they get many human
resources features on the Navigator that aren't pertinent to sales unless you're implementing Oracle HCM
Cloud.

• Configuration in the Structure tool

Use the Structure tool to fine-tune the access granted by the security roles:

◦ Specify if navigation is available in the Navigator and the springboard or hidden from users. You can
create, edit, and change the order of the different headings (called groups) and even create new groups.

◦ Specify which sales infolet tabs appear and in which order.

You can add conditions (EL Expressions), to display or hide specific items or groups. For example, you can
remove an item from view for a specific user or a specific job role. Sales representatives have the security
permissions to import accounts and contacts and monitor background processes, but you may want to leave
these rather technical tasks for sales administrators. Some selections already include EL Expressions that make
items visible depending on system profile option settings or only when you enable a particular functional area
of an offering. You can append additional conditions to the existing expressions.

• Default infolet views you create

Using Page Composer, you can specify which infolets appear in an infolet tab by default and in which order.
Hiding an infolet doesn't remove the infolet entirely. Users can always add it back to their home page. If you
want to hide infolets from users entirely, you must edit the visibility of each one. See the Enable and Configure
Workspace Infolets section for details.

• Personalization

Individual users can create their own personal views of the navigation icons they see on their springboard, but
they can't change what displays on the Navigator. Users can also select the infolets they want to display and
change their display order. Any personalization supersedes the default Infolet views you created.

Here's a diagram that illustrates the different factors that together determine what a user sees in the Navigator, on the
springboard, and in the infolet tabs.
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Navigation Configuration
The Navigation Configuration page displays all the feature selections available to all users of Oracle Fusion Cloud
applications. It's not filtered by the security roles. So, you don't have to hide selections that are never displayed to sales
users. To change the display setting and to add EL Expression conditions, you must drill down into each item.
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Infolet Tab Configuration
Use the Home Configuration page in the Structure tool to specify which infolet tabs users get to see in the Analytics
section of the home page. Just like the Navigation Configuration page, this page shows you the selections for all
applications. You can hide, add EL Expressions, rename, and reorder.
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What Different Sales Job Roles See in the Navigator and
Springboard  
To help you configure navigation, here's an overview of what users with common sales job roles see by default in the
Navigator and springboard. The different Navigator items are grouped under headings.

The table lists all the headings, but not every item under every heading. If it makes sense to hide the whole heading,
there's no need to list each item. For each of the common job roles, you learn if the item or category is displayed in both
the Navigator and springboard, in the Navigator only, or in neither.

Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Me
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

All of the items under
the Me category
come from the Oracle
Human Resources
Cloud. Unless you're
implementing HCM,
remove all of the items
here except Roles and
Delegations.
 
Salespeople can use
Roles and Delegations
to see which security
roles are assigned to
them, and request
more, depending on
your security setup.
 

My Team, Users and
Roles
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove. Only setup
users can use Users
and Roles to create
and manage sales
users.
 

Partner Management
 

Neither
 

Neither
 

Neither
 

Both
 

Remove unless you're
using Oracle Partner
Management
 

Sales, Leads
 

Both
 

Both
 

Both
 

Both
 

Sales leads work area.
 

Sales, Deal
Registrations
 

Neither
 

Neither
 

Neither
 

Both
 

Remove unless you're
using Oracle Partner
Management
 

Sales, Forecasts
 

Both
 

Both
 

Both
 

Both
 

Sales work area where
you submit, adjust,
 and review sales
forecasts.
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Sales, Activities
 

Both
 

Both
 

Both
 

Both
 

Work area where
salespeople manage
their calendar and
tasks, log calls and
emails, and other
activities.
 

Sales, Products
 

Neither
 

Neither
 

Neither
 

Both
 

Create and manage
products for the sales
catalog, and upload
product images.
 

Sales, Competitors
 

Both
 

Both
 

Both
 

Both
 

View and manage
sales competitors.
Sales Administrators
can create
competitors. The other
sales roles can only
view them.
 

Sales, Opportunities
 

Both
 

Both
 

Both
 

Both
 

Work area for
managing sales
opportunities.
 

Sales, Accounts
 

Both
 

Both
 

Both
 

Both
 

Work area salespeople
use to manage their
accounts.
 

Sales, Analytics
 

Both
 

Both
 

Both
 

Both
 

Central work area for
viewing BI reports.
 

Sales, Price Books
 

Neither
 

Neither
 

Neither
 

Both
 

Price the products
you're selling and to
offer discounts.
 

Sales, Territories
 

Neither
 

Navigator only
 

Both
 

Both
 

Sales territory
management for Sales
Managers and Sales
Administrators.
 

Sales, Campaigns
 

Navigator only
 

Both
 

Neither
 

Navigator only
 

Marketing campaign
information from
Oracle Marketing
Cloud.
 
Remove unless
you're implementing
integration with Oracle
Marketing Cloud
(Eloqua).
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Sales, Quotes and
Orders
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove unless
you're implementing
integration with Oracle
Configure, Price, and
Quote (CPQ) Cloud.
 

Sales, Contacts
 

Both
 

Both
 

Both
 

Both
 

Sales contacts work
area.
 

Sales,
 Recommendations
 

Neither
 

Both
 

Both
 

Both
 

Remove. No longer
used.
 

Sales, Lightbox
 

Both
 

Both
 

Both
 

Both
 

Enables salespeople to
share and collaborate
on presentations.
 

Sales, Promotions
 

Neither
 

Neither
 

Neither
 

Both
 

Sales administrators
can create promotions
to offer discounts.
 

Sales, Quotas
 

Neither
 

Both
 

Both
 

Both
 

Enables sales
managers and sales
administrators to set
sales quotas for their
directs.
 

Help Desk
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove unless you're
implementing Oracle
Help Desk.
 

Business Plans
 

Both
 

Both
 

Both
 

Both
 

Salespeople and
managers can use it to
create business plans
for the accounts they
serve.
 

Contract Management
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Remove. Sales users,
 including Sales
Administrators cannot
use contracts without
additional security
roles.
 

Incentive
Compensation
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Manage sales
compensation.
 

Procurement
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove unless
you're implementing
purchasing.
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

My Enterprise,
 Offerings
 

Neither
 

Neither
 

Neither
 

Both
 

Sales administrators
and setup users
enable the offerings
related to the
applications they
purchased. You must
enable the offering
and its features for
implementation.
 

My Enterprise, New
Features
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Sales administrators
and setup users
 

My Enterprise,
 Subscriptions
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Oracle Subscription
Management
information.
 
Remove unless
you're implementing
Oracle Subscription
Management.
 

Tools, Set Preferences
 

Both
 

Both
 

Both
 

Both
 

Lets users reset their
password and upload
their picture. The
same Set Preferences
is also available in the
Settings and Actions
menu that you can
open by clicking on
your user initials or
image.
 

Tools, Spaces
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove. Oracle Web
Center Portal.
 

Tools, Scheduled
Processes
 

Both
 

Both
 

Both
 

Both
 

Lets you monitor
and run background
processes.
 

Tools, File Import and
Export
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove. Imports
Oracle Web Center
content. Not used in
Oracle CX Sales.
 

Tools, Smart Text
 

Neither
 

Neither
 

Neither
 

Navigator only
 

A feature
administrators and
implementers can use
to change UI text and
prompts.
 

Tools, Deep Links
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Deep links make it
possible to navigate
from your company's
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

pages directly to a
page within your sales
application without
going through the
menu structure.
 

Tools, Contact Search
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Remove if you aren't
using the telephony
(CTI) feature.
 

Tools, Import
Management
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Import accounts,
 contacts, products
and other sales
information from a
file.
 

Tools, Download
Desktop Integration
Installed
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove if you aren't
deploying Oracle Sales
for Outlook.
 

Tools, Notification
Preferences
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Remove. Not used
in sales. Feature to
trigger automatic
notifications.
 

Tools, Worklist
 

Both
 

Both
 

Both
 

Navigator only
 

Worklist notifications.
 

Tools, Reports and
Analytics
 

Both
 

Both
 

Both
 

Navigator only
 

Create BI reports you
can display in your
sales application.
 

Tools, Export
Management
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Export accounts,
 contacts, products
and other sales
information as a file.
 

Tools, Mass Transfer
 

Neither
 

Neither
 

Neither
 

Both
 

Transfer data to other
environments, for
example, from test to
production.
 

Configuration,
 Appearance
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Change application
home page layout,
 logos, icons and other
feature.
 

Configuration,
 Structure
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Change Navigator and
springboard layout.
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Configuration,
 Business Objects
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Configure additional
business objects for
your application.
 

Others, Resource
Directory
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

View the sales
organization hierarchy.
 

Others, My Dashboard
 

Both
 

Both
 

Both
 

Both
 

Remove. Provides an
alternative home page
for your company.
 

Others, Setup and
Maintenance
 

Neither
 

Neither
 

Neither
 

Both
 

Access setup tasks.
 

Others, Social
 

Both
 

Both
 

Both
 

Both
 

Opens the Oracle
Social Network UI.
 

Others, Marketplace
 

Both
 

Both
 

Navigator only
 

Both
 

Links to Oracle Cloud
Marketplace where
you can view partner
applications.
 

Others, Getting
Started
 

Both
 

Both
 

Both
 

Both
 

Access short videos to
help users get started.
Your organization can
add your own videos
here.
 

Others, Cloud
Customer Connect
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Opens Cloud
Customer Connect
where users can
interact with other
users and ask
questions.
 

Workspace
 

Both (after you enable
Workspace)
 

Both (after you enable
Workspace)
 

Both (after you enable
Workspace)
 

Both (after you enable
Workspace)
 

Workspace appears
both in the Navigator
and springboard
automatically when
you enable the feature.
 
The Home
Configuration page
includes two versions
of Workspace. One
provides access to
Workspace for sales
job roles. The second
version provides
access for service job
roles.
 
The service version
includes the ability to
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

view records in nested
tabs (the dynamic tabs
feature).
 
Users see only one
of these items,
 depending on their
security privileges.
 

Configure Navigation  
Use the Structure tool to configure which selections appear in the Navigator, which icons area available on the
springboard, and which infolet tabs are visible to users.

Watch video
 

Create and Enter a Sandbox with the Structure Tool
Create and enter a sandbox with the Structure tool:

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox.
3. In the Create Sandbox page, enter a name and select Structure as the tool.
4. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
5. From Tools, select Structure to open the Structure page.

Specify What Users See on the Navigator and in the Springboard
With the Navigation Configuration tab selected, you can configure what appears on the Navigator and springboard.
Just click the item or group name to edit.

• Specify where and for whom the item shows up by making a selection from Show on Navigator and Show
on Springboard. You can choose to display individual items in the Navigator only, in both the Navigator
and springboard, or in neither. You can't display an item in the springboard only. If you hide an item in the
Navigator, it gets automatically hidden on the springboard as well. Here are the options:

◦ Yes: displays the item for all users with the right security permissions.

◦ No: hides the item from all users in all applications.
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◦ EL Expression: lets you add an EL Expression that must be true to display the item.

Add EL Expression conditions to display items or groups selectively to users with specific job roles, or
even by user name. Here are some examples of EL Expressions you can use:

Who can see the group or page
entry

EL Expression and Example

Only users having any of the specific
roles
 

#{securityContext.userInRole['<Role_Name>']}

 
#{securityContext.userInRole['ORA_FND_APPLICATION_ADMINISTRATOR_

JOB,ORA_PER_EMPLOYEE_ABSTRACT']}

 

Only users not having any of the
specific roles
 

#{!(securityContext.userInRole['<Role_Name>']}

 
#{!(securityContext.userInRole['ORA_FND_APPLICATION_ADMINISTRATOR_

JOB,ORA_PER_EMPLOYEE_ABSTRACT'])}

 

Only users having all of the specific
roles
 

#{securityContext.userInAllRoles['<Role_Name>']}

 
#{securityContext.userInAllRoles['ORA_FND_APPLICATION_

ADMINISTRATOR_JOB,ORA_PER_EMPLOYEE_ABSTRACT']}

 

Only users not having all of the
specific roles
 

#{!(securityContext.userInAllRoles['<Role_Name>']}

 
#{!(securityContext.userInAllRoles['ORA_FND_APPLICATION_

ADMINISTRATOR_JOB,ORA_PER_EMPLOYEE_ABSTRACT'])}

 

Only users having access to specific
resources, for example, the Social
work area
 

#{securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_

Launch_Social_Menu;action=launch']}

 

• Rename a group and change its icon.

• Move items to a different group by using the arrow keys, or by selecting a different group while editing the item.
You can't nest groups within other groups.

For example, move both Workspace items from the Workspace group to the Sales group. There are two
Workspace items because Oracle provides two different versions of Workspace: one for sales and one for
service. Users see only one icon on their home page, depending on their security settings.

• Copy items.

• Move items within a group using the up and down arrow keys.

For example, you may want to move the Workspace icon to be the first icon users see on their page.

426



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 26
Configure the Navigator and Home Page

• Get rid of the Others group.

Any top-level items (items that aren't part of a group in the Structure tool) display in the Others group in the UI.
You can't rename that category or move it, but you can hide the group by moving or hiding all items in it.

• Create new groups and add your own content.

You can create new groups from the Create menu and display them selectively by adding EL Expressions. You
can copy items into the group or create your own items by selecting Create Page Entry from the Create menu.

Note:  To simplify future functionality updates, don't create groups to provide different views for different
sets of users, however. Add the EL Expressions to individual items instead.

Example of Hiding a Whole Navigator Group You Don't Use
If you aren't implementing Oracle Global Human Resources Cloud, then hide the whole Me group, which appears in the
Navigator for all sales users by default.

1. Click the Me group name.
2. Set Show on Navigator to No. Hiding the group hides all of the individual items in the group as well.

Example of Hiding an Individual Sales Feature You Don't Use
If you aren't implementing Oracle Marketing Cloud, then remove the Campaigns item from both from the Navigator
and springboard:

1. Open the Sales group to display the different sales features.
2. Click Campaigns
3. In the Edit Page Entry page, set Show on Navigator to No.

Removing the selection from the Navigator automatically removes the link from the springboard as well. You
can't display a selection on the springboard if it's not displayed in the Navigator
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Selectively Hide Navigation
You may want to leave technical tasks, such as importing data or monitoring scheduled processes, to sales
administrators. To remove the navigation links for a subset of users, you edit the EL Expression for these items and add
your conditions. For example, here's how to remove the Scheduled Processes navigation from both the Navigator and
springboard for all salespeople with the Sales Representative job role:

1. Open the Tools group to display its selections.
2. Click the second Scheduled Processes item.

Here's a screenshot of a portion of the Navigation Configuration page highlighting the item.

Note:  Oracle includes two Scheduled Processes items in the list because it supports two different interfaces
for scheduled processes. If you aren't sure which item to edit, add your condition to both.

3. Click Edit for Show on Navigator to edit the EL Expression.
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The Expression Editor displays the expression provided by Oracle. In this example:
#{(securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_Scheduled_Processes_Menu;action=launch'])

and(Profile.values.ESS_ALLOW_CLASSIC_INTERFACE ne null) and (Profile.values.ESS_ALLOW_CLASSIC_INTERFACE

ne 'Y')}

4. In the Expression Editor, append the condition: and!
(securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB']) to the original expression.

Here's the resulting expression:
#{(securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_Scheduled_Processes_Menu;action=launch'])

and(Profile.values.ESS_ALLOW_CLASSIC_INTERFACE ne null) and (Profile.values.ESS_ALLOW_CLASSIC_INTERFACE

ne 'Y')and!(securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB'])}

5. Click Validate to check for errors.
6. Click OK.
7. It's a good idea to click Save after each edit to make sure your changes are saved.
8. Repeat the steps to add the condition to the Show on Springboard  EL Expression.

Here's a screenshot of the Expression Editor with the edited Show on
Springboard expression: :#{(Profile.values.ESS_ALLOW_CLASSIC_INTERFACE
ne 'Y' and Profile.values.ESS_ALLOW_CLASSIC_INTERFACE ne null)and!

(securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB'])}
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Specify Which Infolet Tabs Appear and in Which Order
You can specify which infolet tabs appear and in which order.

1. While in the Structure tool, click the Home Configuration tab.
2. Use the arrow keys to change the order of the infolet tabs.
3. To edit the infolet tab name and to specify how the infolet page gets displayed, click its name:

◦ Yes: displays the infolet tab for all users with the right security permissions.

◦ No: hides the infolet tab from all users in all applications.

◦ EL Expression: lets you add an EL Expression condition that must be true to display the infolet page.

4. To create additional infolet tabs with your own content, you can edit the five sales tabs crated for this purpose:
Sales Page 1 through Sales Page 5.

Related Topics
• Examples of EL Expressions

• Overview of Configuring Home Page and Navigation

Enable and Configure Workspace Infolets  

Enable Workspace Infolets  
Enable Workspace infolets by setting the profile Enable Workspace Infolets (ZCA_ENABLE_ADAPTIVE_INFOLETS) to Yes.
Here's how:

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option by entering
ZCA_ENABLE_ADAPTIVE_INFOLETS in the Profile Option Code field.

3. Click Search.
4. In the ZCA_ENABLE_ADAPTIVE_INFOLETS: Profile Values section, set the profile value to Yes.
5. Click Save and Close.

Create and Enter a Sandbox with Page Composer as Your Tool  
You can create different Workspace infolet configurations for the whole enterprise, or for specific job roles. If you're
configuring different configurations of Workspace infolets for different job roles, then you must create separate
sandboxes for each job role.

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox.
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3. In the Create Sandbox page, enter a name and select Page Composer as the tool.
4. If you want to create different infolet configurations for different user roles, select the job role:

a. Click Edit in the Support Context column for Page Composer.
b. In the Edit Sandbox Context window, select Job Role and select the job role you want to configure.

Each job role can access different saved searches and can have a different infolet configuration on their
page.

c. Click OK.
5. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
6. Click Home to return to the home page.
7. In the sandbox, select Page Composer from the Tools menu.

The Page Composer toolbar appears underneath the sandbox toolbar.

Specify Which Workspace Infolets Display and In What Order  
Use this procedure to specify which infolets salespeople see when they open the page and in which order.

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.
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2. You must expose Workspace infolets one by one. Here's how:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select one of the 10 Workspace infolets. If the list includes two infolets with the same name, select the
second one on the list. For example, the Infolet Repository list may include two entries for My Account,
My Opportunities, and so on.

Note:  Even though you set the profile to use the Workspace infolets, the older version of actionable
infolets remains present when you configure the view for a site, for example. These older infolets are
present on the list during configuration, but not displayed to users because of the value of the EL
Expressions they contain.

c. Make sure the infolet that's displayed on the page is a Workspace infolet. Workspace infolets include the
Workspace icon (callout 1) and the three dots for quick actions (Callout 2). Here's a screenshot of the My
Accounts Workspace infolet.

If you displayed the wrong infolet by mistake, just expose the second one.
3. Change the order of the infolets by dragging them around. Alternately, you can click the Infolet Repository

icon, scroll down in the list and select Reorder Infolets.
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4. If you are done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.

Configure Workspace Infolets  
You can configure any of the 10 Workspace infolets provided by Oracle, including the six that are predefined for you.

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.

2. If the infolet you want to configure isn't displayed in the Sales Infolets tab, you must display it on the page.
Here's how:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select the Workspace infolets you want to configure. If you're configuring one of the predefined infolets,
and the list includes two infolets with the same name, select the second one on the list. For example, the
Infolet Repository list may include two entries for My Account, My Opportunities, and so on.

Note:  Even though you set the profile to use the Workspace infolets, the older versions of the
predefined infolets remain present when you make site-level configurations. These older actionable
infolets are present on the list during configuration, but not displayed to users. You can recognize
which infolet is which because the predefined Workspace infolets include the Workspace icon and the
three dots for quick actions.

Change the Infolet Title

1. In the right top corner of an infolet, click Actions (the down arrow) and select Edit Title and Views.
2. Edit the title.
3. Click Save and Close.

Note:  You can't add use the other sections of this window to configure Workspace infolets. You can't display
BI reports or other content on the back of this type of infolet.

4. If you're done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.

Specify Which Saved Searches Appear in the Infolet

1. In the right top corner of an infolet, click Actions (the down arrow) and select Configure.
2. In the Manage Infolet window, Filters tab, use the arrows to move the saved searches you want to display in

the infolet to the Selected column. The saved searches determine what information salespeople can display
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in the infolet. You aren't limited to selecting saved searches for just one object. For example, you could select
Accounts: My Accounts and Assets: My Customer's Active Assets.

3. If you're done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.

Specify What Fields Display for Each Saved Search
Here's how to determine which fields display on the infolet for each record. You must configure each saved search you
are using separately.

1. In the right top corner of an infolet, click Actions (the down arrow) and select Configure.
2. In the Manage Infolet window, select the Layout tab (callout 1 in the screenshot).
3. Select the saved search you want to configure (callout 2).
4. Add the fields you want to display (callout 3). Be sure to always display the Name field: it provides the link that

salespeople use to drill down into the record.
5. You can adjust the relative width of the columns using the slider (callout 4).
6. Keep the Show quick actions option selected to display the actions for each record (callout 5).

7. If you're done with your configurations, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.
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Hide Unused Workspace Infolets from Users  
Remove unused Workspace infolets from use by changing their visibility. Unless you change their visibility, infolets are
listed in the Infolet Repository list and available for display by salespeople even if you remove them from the page.

You may want to remove the four blank infolets (Additional Actionable Infolets) if you aren't using them, for example.
Here's how:

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.

2. Before you can change their visibility, you must expose the Workspace infolets you want to remove. Here's how:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select one of the Workspace infolets you want to remove. If you're removing one of the predefined
infolets, and the list includes two infolets with the same name, select the second one on the list. For
example, the Infolet Repository list may include two entries for My Account, My Opportunities, and so on.

Note:  Even though you set the profile to use the Workspace infolets, the older versions of the
predefined infolets remain present when you make site-level configurations. These older actionable
infolets are present on the list during configuration, but not displayed to users. You can recognize
which infolet is which because the predefined Workspace infolets include the Workspace icon and the
three dots for quick actions.
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3. In the right top corner of the infolet, click Actions (the down arrow identified by callout 1) and select Edit
Visibility (callout 2).

CAUTION:  Don't select Delete. Deleting removes the infolet entirely. If you delete an infolet by accident, you
must contact Oracle Support to restore it.

4. In the Edit Visibility window, Visible list, select No.

5. Click Save and Close.

The Workspace infolet is grayed out on the page. The infolet remains in listed in your Infolet Repository list, but
it doesn't appear to users after you publish the sandbox.

6. If you're done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.
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27  Microsoft Outlook Add-In

About Integrating the Outlook Add-in with Oracle Sales  
Oracle currently supports two versions of the Microsoft Outlook add-in. It's highly recommended that you use the
latest version – the Microsoft 365 add-in for Oracle Sales Redwood User Experience (hereafter called Microsoft 365 for
Redwood UX) which consists of the next-generation Microsoft Outlook add-in and sync capabilities.

Note:  If you're migrating the CX Sales for Microsoft 365 integration to the Oracle Sales Redwood UX for Microsoft
365 integration, there are specific steps for the migration. See Migration Overview for more information. For more
information about setup steps, start with the How do I implement Microsoft 365 for Oracle Sales Redwood UX?
playbook on Oracle Help Center > Sales > Playbooks page.
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28  Mobile

Overview of CX Sales Mobile  
The Oracle CX Sales Mobile app helps your users manage their day effectively and develop customer relationships using
their phone or tablet.

Read the following sections to learn more. For more information on implementing Mobile, start with Overview of CX
Sales Mobile Setup.

Manage Sales Activities
Sales teams can manage Sales activities. Here are the highlights:

• Use the action-driven, configurable home page that contains a sales briefing, letting salespeople track the sales
pipeline and stay on top of daily activities.

• Leverage optimized task-based flows for key sales functions: Accounts, contacts, leads, opportunities,
activities, assets, service requests, partners, and custom objects.

• View, create, and edit tasks, appointments, and call reports.

• Saved searches that are shared across CX Sales Mobile and Workspace lists, for consistency across applications.

• View your recently accessed records in the app when using the global search, or when sharing notes from an
external app.

• Add contacts and leads to CX Sales Mobile from the mobile device's address book.

• Create contacts and leads by using a photo of a business card.

• Scan an asset's bar code to search for an asset and automatically enter the asset serial number.

• Share notes, photos, videos, documents, or files from mobile to Sales accounts, opportunities, or other records.

• Plan your sales activities around your current location by viewing your nearby contacts, accounts,
opportunities, and leads plotted on an interactive map. You can also plan future appointments in a city or near
an address with an easy location search.

• View your quotes in the app and stay updated on the quote status. View and send quote proposal documents
to customers, or share them with your team for feedback.

• View reports and analytics with modern visualizations optimized for mobile displays, such as bar graphs,
funnels, bubble charts, and more. Role-based layouts let sales administrators provide unique experiences to
salespeople, managers, and others.

Manage Partner Relationship Management Activities
Partners can manage Oracle Partner Relationship Management activities:

• Partner users can effectively manage and improve channel sales on-the-go.

• Channel Managers can track overall channel sales and also easily manage partners, partner contacts, and
related information.

• Partner role-based restriction features let you configure the app according to your business requirements.
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Oracle Sales Assistant Chatbot
Integrate with the Oracle Sales Assistant chatbot to get these features:

• Oracle Sales Assistant helps salespeople perform their daily sales-related tasks. Using their phones, they
can type or use your voice to ask questions, and the sales assistant retrieves the information or acts on the
requests.

• Sales Assistant reduces manual data entry and makes it easier to view and update sales records using voice
commands or typing.

Note:  If you need help enabling the Sales Assistant, send us a message on the Sales Assistant forum on
Oracle Cloud Customer Connect.

New Design for Efficiency on the Go
Take advantage of these new design for efficiencies on-the-go:

• Modern and intuitive user experience, designed to boost productivity with fast and seamless interactions.

• At-a-glance record views for a quick grasp of summary, key, and related information.

• Access contextual actions everywhere for fast and easy record updates.

• Improved picker experience powered by Adaptive Search.

Global Search
These global search features make finding records efficient:

• Fast and simple search across all objects in one place.

• Use the multi-keyword search across multiple fields for faster and easier access to information.

• Search more easily with recent searches and type ahead results that display results as you type.

• Filter search results by object types.

New and Improved Sign-In Experience
This version of the mobile app has a new and improved sign-in experience:

• Scan a QR code to sign in easily using your single sign-on credentials or using basic authentication.

• Use face or fingerprint recognition to securely sign in to the app.

• View new configurations with fast download and instant activation of your configurations.

• Enable OAuth authentication token support to let users stay signed in to the app for longer.

Use a Phone or Tablet
Use either a phone or tablet to access the app. Using a tablet changes the display to 2x portrait mode.
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Easy Configuration
Implement Mobile using these easy configuration aspects:

• Configure the app using the new interface designer.

• Create criteria for page layouts for both standard and custom objects.

• Download your configurations to the app quickly and easily. Mobile automatically signs you in to the correct
sandbox without restarting the app.

• Create custom scripts that enforce custom validations and business logic for both top-level parent and child
objects.

Use Offline
Salespeople can use Mobile in offline mode when they're not able to be online:

• View and edit Sales data in areas with no network connection.

• Sync automatically when a connection is re-established.
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29  Account Data Enrichment and Verification

Two Services to Enrich and Verify Your Data and Save
Salespeople Time  
Perhaps nothing is more important for your sales effort than having up-to-date and actionable information about your
customers and contacts and minimizing the time salespeople spend entering data. Oracle provides two services that
enrich your customer data, improve its accuracy, and eliminate data entry time.

For account and contact information, you can obtain information on millions of companies worldwide by subscribing to
the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B). A second service, Oracle Address, Email, and
Phone Verification, ensures that you have the correct postal addresses, that your emails don't bounce, and your calls go
through.

Note:  Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) is the new name for Data as a Service
(DaaS).

Here's an overview of the 2 services:

Service Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B)

Oracle Address, Email, and Phone
Verification

Purpose
 

Account and contact search, enrichment, and
prospecting.
 

Address, phone, and email address verification.
 

What It Does
 

Instead of entering data themselves when
they create accounts, salespeople can look
up the organizations they sell to from Dun &
Bradstreet Corporation, one of the premier
sources of business information. The service
provides access to more than 347 million
account records and more than 135 million
contact records worldwide. Included is
information about more than 90 different
company attributes, including sales volume,
 growth data, hiring trends, competitors, and so
on.
 
Users can also filter the data by using over 60
company or contact attributes such as industry,
 revenue, company hierarchy, private or public
indicator, contact title, contact department.
 
The service also provides information about
account hierarchies, showing the linkages
between a corporation's subsidiaries, branches,
 and divisions. You can also schedule account or
contact enrichment on thousands of records at
the same time.
 

Salespeople can search and validate addresses
in more than 248 countries using data from
Loqate.
 
They can verify addresses when creating or
editing an account: correct misspellings, add
missing elements (such as the postal code), and
standardize elements (for example, changing
"Drv" to "Dr"). You can also schedule address
verification on thousands of records at the
same time.
 
The service automatically checks if phone
numbers and email addresses exist and informs
you if they're invalid. No more bounced emails
or calls that don't go through.
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Service Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B)

Oracle Address, Email, and Phone
Verification

Oracle licenses account and contact enrichment
separately. You subscribe to the Oracle Account
Enrichment Cloud Service and the Oracle
Contact Enrichment Cloud Service.
 

How It Works
 

Salespeople start typing the account name,
 and the application suggests possible matches
straight away. Selecting a match automatically
fills in all the rest of the information.
 
Salespeople can add contacts to accounts by
job role. Selecting the Enrich action for existing
accounts gets the latest information.
 
The account and contact information
continues to be updated automatically based
on synchronization rules setup by your
administrator.
 

Salespeople start typing the street address
in the search field and the application starts
suggesting possible matches. Selecting one of
the suggestions fills in the rest of the address
fields.
 
You can also enable a Verify Address button
that salespeople can use to verify addresses
for a particular country. That's useful if you
added nonstandard fields to the address or if
salespeople don't always use the search field to
look up an address.
 
You can also verify and update addresses in
bulk.
 
The service informs salespeople if phone
numbers and email addresses are invalid as
soon as they enter them. They can also verify
any existing ones to make sure they're still valid.
 

Setup
 

After you activate the service, and complete the
simple setup described in this chapter in your
sales application, salespeople can start looking
up and enriching their data right away.
 
To get the most out of the application, however,
 you must add fields to the UI to expose the
additional information you're getting. While
most of the information maps onto fields you
can expose using Application Composer, you
must create some custom fields to map the
rest.
 

After you activate the service, and complete
the simple setup described in this chapter in
your sales application, salespeople can start
looking up street addresses and verifying
phone numbers and email addresses.
 
In the CX Sales (Classic UI), you can also expose
the Verify Address button with a few extra
steps.
 

Where to Get More Information
 

This guide includes the information you need
to get started. You can get the full scoop in the
Using Account and Contact Enrichment by Dun
& Bradstreet guide.
 

This guide includes the information you need
to get started. You can get the full scoop in
the Using Oracle Address, Email, and Phone
Verification guide.
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Related Topics

Enrichment and Verification You Can Start Using Right
Away  
After you complete the brief setup described in this chapter, salespeople can start enriching and verifying their
customer data with two of the services: Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle
Address, Email, and Phone Verification. Additional fields and actions appear automatically in all of the appropriate
create or edit account, lead, and contact pages. Here's a brief summary of how it works.

Saving Time Entering Accounts, Contacts, and Addresses
Salespeople can start saving time and improving accuracy while creating new accounts right away. Instead of entering
data about an account themselves, they search for the account and address in new search fields, and the information is
populated automatically. Here's a screenshot of the CX Sales Create Account page with callouts highlighting the new UI
elements.

Callout Number New UI Element Description

1
 

Account search
 

Salespeople search for accounts by name or
by address and add them. The application
suggests possible matches as soon as they
start typing. Selecting an account populates the
available company data.
 

2
 

Address search
 

Salespeople start typing an address and the
service starts suggesting matching addresses.
Selecting an address populates all of the
address data.
 

3
 

Verify Address button
 

If you enable the optional Verify Address
button, salespeople can verify an address that
they enter in the CX Sales UI or import from a
file. You can enable this field with a few setups
for CX Sales UIs only. If salespeople use the
address search consistently, they don't need the
button.
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Enriching Existing Accounts
To enrich an existing account, salespeople use the Enrich Account action available in all the UI pages where you edit
accounts. Here's a screenshot of the Actions menu in the Edit Account page.

When you enrich an account, you get to choose which fields to keep and which to replace.
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If you're adding contacts to an account, you can add whole sets of contacts using criteria such as job category. You can
also enrich multiple accounts and contacts at the same time on the landing page.

If you subscribe to Customer Data Management, you also have the option of enriching large batches of accounts and
contacts in the Data Enrichment work area.

Email Address and Phone Number Verification
When you enter a phone number or an email address, the application automatically checks if they're valid. The
application can't check if the phone numbers and emails you enter are valid for the specific person or account, of
course, but it does assure that a phone number will actually dial and that an email won't bounce.

If the email or phone number you enter isn't valid, you get informed right away: the application displays the status right
under the field. If nothing appears, your entry is valid. Here's a screenshot of a phone number to give you an idea of
what appears under invalid information:

Callout Number Description

1
 

Status. For phone numbers, this can be only Invalid. Email addresses can also display the status of
Partially-Valid: the domain is valid but the name can't be verified. A Partially-Valid status for an email
means that the complete email can't be verified by Loqate, but Loqate did validate the email domain.
If the person left the company, or changed their name, you'll see the Partially-Valid status for the
email, for example.
 

2
 

Date the email address or phone number was verified by the application.
 

3
 

Reverify button that you can use to verify again. You never know when area codes or email addresses
may change. What's valid today may not be in 6 months.
 

4
 

Overwrite button to manually set the status. The application, isn't perfect. If you know that the number
or email is correct, you can set the status to Verified. When you do, you see Overwritten on instead of
Verified on.
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Callout Number Description

 

The application does display a Valid status, but only much later. By default, the status appears 180 days later. When
the information is old, salespeople may want to verify it again by clicking on the Reverify button. You can specify the
number of days before the Valid status appears or even turn this option off during setup. For details, see the topic:
Enable the Verification of Addresses, Emails, and Phone Numbers.

Three Ways to Enrich Data  
There are three ways to enrich account and contact data from the Oracle Account and Contact Enrichment by Dun &
Bradstreet (D&B) service:

• Real-time enrichment

You can enrich data directly in the Account and Contact pages as described in this chapter.

The real-time enrichment uses the REST APIs and the mapping you maintain using the Manage Oracle Data as
a Service Attribute Mapping and Preferences task in the Setup and Maintenance work area.

• Manual enrichment

You can do your sales prospecting in the D&B service UI, which provides more ways to filter and search. You
then export your account or contact records into a file and import the file into your sales application.

The D&B service includes a default export mapping you can edit. You can edit the import mapping in the sales
application. The Using Account and Contact Enrichment by Dun & Bradstreet guide provides the details about
the export and import mappings.

• Batch enrichment

You can also enrich your account and contact data in bulk. Bulk enrichment uses the same REST APIs and
mapping you maintain in Manage Oracle Data as a Service Attribute Mapping and Preferences. However, the
integration doesn't support any additional custom fields you add.

Here's a diagram to illustrate the architecture:

• The D&B service includes the mapping you can use to export a file with accounts and contacts. Importing the
file using Import Management into your sales application uses an import mapping.

• The real-time enrichment feature and Oracle Customer Data Management (CDM) both use the REST APIs and
the mapping you can update in your sales application. The mapping determines which fields show up in the UI.

448



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 29
Account Data Enrichment and Verification

Overview of Data Enrichment and Verification Setup  
This chapter outlines the process for setting up two Oracle cloud services that enrich and verify your account and
contact data: Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle Address, Email, and Phone
Verification.

When your organization subscribes to Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle
Address, Email, and Phone Verification services, the person or people designated as the service administrators for
your sales application domain or the account administrator, receive a welcome email. You must be one of the service
administrators to complete the setup. If you don't receive the email, you can ask the account administrator to create you
as a service administrator or resend the email. Here's a list of the setup tasks.

Before you start, you must complete the required setup in the Oracle Cloud Dashboard. See the Using Account and
Contact Enrichment by Dun & Bradstreet guide for details.
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Step Applies To Description Navigation or Steps Where to Get More Details

1
 

Both CX Sales and Digital
Sales

Enter the service URL,
 and the user name and
password for a user with
the role: DATASERVICE
CLIENT API APPID, in two
separate pages in Setup
and Maintenance:
 

• Manage Integration
with Oracle Data as a
Service

• Manage Integration
with Oracle
Verification Services

Setup and Maintenance >
Sales > Integrations >
Manage Integration with
Oracle Data as a Service
 
Setup and Maintenance >
Sales > Integrations >
Manage Integration
with Oracle Verification
Services
 

See the topic: Integrate the
Account Enrichment and
Verification Services
 

2
 

Both CX Sales and Digital
Sales

Enable the UI verification
for street addresses, email
addresses, and phone
numbers.
 

Setup and Maintenance >
Sales > Data Quality
Verification Services >
Quick Setup
 

See the topic: Enable the
Verification of Addresses,
Emails, and Phone Numbers
 

3
 

CX Sales Optionally, you can enable
a Verify Address button
that salespeople can use in
CX Sales to verify addresses
entered manually.
 

Setup and Maintenance >
Sales > Sales
Foundation > Geographies
 

See the topic: Enable the
Verify Address Button
 

4
 

Both CX Sales and Digital
Sales

Salespeople don't see all
of the great account and
contact information you
enrich unless you expose
additional fields in the UI.
Some of the additional
information you get from
D&B is already mapped to
existing sales account and
contact fields. All you need
to do is to use Application
Composer to add these
fields to the UI. For other
attributes, you must create
custom fields and add them
to the mapping.
 

Navigator >
Configuration >
Application Composer
 
Setup and Maintenance >
Sales > Accounts and
Contacts > Show >
Manage Oracle Data as a
Service Attribute Mapping
and Preferences
 

See the topics:
 

• Add Enriched Fields
to the Account and
Contact Pages

• Add Fields to the
Mapping

5
 

Both CX Sales and Digital
Sales

Specify if you are enriching
accounts, contacts, or both
and indicate enrichment
preferences. This setup is
done in the Preferences
tab on the same Manage
Oracle Data as a Service
Attribute Mapping and
Preferences page you used
in the previous step.
 

Setup and Maintenance >
Sales > Accounts and
Contacts > Show >
Manage Oracle Data as a
Service Attribute Mapping
and Preferences
 

See the topic: Configure
Enrichment Preferences
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Related Topics

Integrate the Account Enrichment and Verification
Services  
Here's how to integrate the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and the Oracle Address,
Email, and Phone Verification services in your sales application.

Note:  Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) is the new name for Data as a Service
(DaaS).

Prerequisites
Before you start, you must:

• Set up the DaaS service in the Oracle Cloud Dashboard.

• Copy the URL of the DaaS instance.

• Provision a user with the DATASERVICE CLIENT API APPID role.

• Add each service as a confidential application in Oracle Identity Cloud Service as described in the topic "Add a
Confidential Application" in the Administering Oracle Identity Cloud Service guide.

On the Client page of the Add Confidential Application wizard, in the Authorization section, select Resource
Owner, Client Credentials, Authorization Code, and Refresh Token as Allowed Grant Types. Leave Redirect
URL blank. If you use Basic Authentication, do not include the question mark special character (?) in the
password.

You must enter the URL and user name and password to complete the integration in the Setup and Maintenance work
area.

Integrate the D&B Enrichment with Your Sales Application

1. In the Setup and Maintenance work area, open the Manage Integration with Oracle Data as a Service task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Show: All Tasks

◦ Task: Manage Integration with Oracle Data as a Service

2. In the Manage Integration with Oracle Data as a Service page, select the OAuth Authentication option.
3. In the URL field, enter the URL of the DaaS instance. Remove /data/ui from the end of the URL. Here's an

example: https://mydataservice-myidentitydomain.data.us2.oraclecloud.com.

If you didn't save the URL, you can find it in the welcome email and in Oracle Cloud Dashboard.
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4. In the Client ID and the Client Secret fields, enter the values you obtained when you added the service as a
confidential application in Oracle Identity Cloud Service.

5. Click Save and Close.

Integrate the Address, Email, and Phone Verification with Your Sales
Application
Enter the same information in the Manage Integration with Oracle Address Verification page:

1. In the Setup and Maintenance work area, open the task Manage Integration with Oracle Verification
Services:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Show: All Tasks

◦ Task: Manage Integration with Oracle Verification Services

2. In the Manage Integration with Oracle Verification Services page, select the OAuth Authentication option.
3. In the URL field, enter the URL of the verification service instance. Remove /data/ui from the end of the URL.

Here's an example: https://mydataservice-myidentitydomain.data.us2.oraclecloud.com.

If you didn't save the URL, you can find it in the welcome email and in Oracle Cloud Dashboard.
4. In the Client ID and the Client Secret fields, enter the values you obtained when you added the service as a

confidential application in Oracle Identity Cloud Service.
5. Click Save and Close.

Related Topics

Enable the Verification of Addresses, Emails, and Phone
Numbers  
After you enter the integration information, you enable the verification services that you want to use. Here's the easiest
way, using the Quick Setup page provided for this purpose:

1. In the Setup and Maintenance work area, open the Sales offering.
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2. In the Functional Areas section, the left pane of the page, scroll down to the Data Quality Verification
Services, and click Quick Setup (the gears icon highlighted in the screenshot).
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3. In the Configure Verification Services page, select the verification services you want to enable. Address is
enabled by default.

4. Using Show Valid Status for Email and Phone field, you can specify if and when users see the status of Valid
for verified phone numbers and emails.
Users see right away if the email address or phone number they enter are invalid, but they don't see a Valid
status until later. By default, the Valid status displays after 180 days. Displaying the status makes it possible for
users to verify the information again. In 6 months, the contact may be gone; the number may have changed.

a. To enable or disable the display of the Valid status, select Yes or No.
b. If you selected Yes, then enter the number of days before users see the Valid status.

5. Click Save and Close.

Note:  Using the Quick Setup page is the equivalent of setting the following profile options using the Manage
Administrator Profile Values task:

• Email Verification Service Enabled (ORA_ZCH_EMAIL_VERIFICATION)

• Phone Verification Service Enabled (ORA_ZCH_PHONE_VERIFICATION)

• Phone and Email Status Validity (ORA_ZCH_PHONE_EMAIL_STATUS_VALIDITY)

Related Topics
• Enrichment and Verification You Can Start Using Right Away

• Integrate the Account Enrichment and Verification Services

• How do I verify email addresses and phone numbers?

Enable the Verify Address Button  
If your salespeople are diligent in using the search field to enter addresses, you can skip this step. Addresses added
using search are already verified. The Verify Address button is only useful if you want to check that the accuracy of
addresses entered manually or if you imported unverified addresses. You can enable the button only for countries you
imported earlier.
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Repeat these steps for each of the countries where you want the button. You can only enable the button for country
geographies you imported.

1. Open the Manage Geographies task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for each country you imported using either its name or its two letter
ISO code. For example, enter either United States or US, and click Search.

3. Select the country in the Search Results area.
4. Click Go to Task (the circular icon) in the Address Cleansing Defined column.

Here's a screenshot of the Manage Geographies page highlighting the Go to Task icon and the Address
Cleansing column.

5. In the Address Cleansing Level window, select Optional for Real-Time Address Cleansing Level.

6. Click Save and Close.
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Add Enriched Fields to the UI  

Review the List of Additional Account and Contact Attributes  
Review the list of mapped and unmapped account and contact information you can expose in the UI. You can expose
the mapped fields in the UI using Application Composer. For the unmapped fields, you must first create a custom field
for it in the sales application and add the field to the mapping.

Mapped Account Fields
You can expose any of the fields listed in the table in the account pages using the display name. Long field names
aren't always completely visible in Application Composer, but you can hover over a display name to see the underlying
technical name.

The table lists the name of the Oracle Account Enrichment attribute in the first column, and provides a brief definition
and description. The Account Field Display Name field lists the display name in the UI and in Application Composer. The
Account Field Name lists the technical name. The names don't always match.

Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

Data/DataCloudStatus
 

Data Cloud Status
 

Indicates if the record has
been matched.
 

Enrichment Status
 

DataCloudStatus
 

Data/
PrefFunctionalCurrency
 

Currency
 

A code value that describes
the type of currency in
which the sales volume
(local currency) is
expressed.
 

Preferred Functional
Currency
 

PrefFunctionalCurrency
 

Data/
CurrFyPotentialRevenue
 

Sales Volume (Local
currency)
 

The total annual sales
revenue in US dollars as
a signed, decimal field. If
the revenue is collected
in local currency, then the
local value is converted to
US dollars.
 

Current Fiscal Year's
Potential Revenue
 

CurrFyPotentialRevenue
 

Data/
DomesticUltimateDunsNumC
 

Domestic Ultimate DUNS
Number
 

A subsidiary within the
global family tree that is the
highest-ranking member
within a specific country.
May contain leading zeros,
which will be lost if the field
is treated as numeric.
 

Domestic Ultimate D-U-N-
S Number
 

DomesticUltimateDunsNumC
 

Data/DunsNumberC
 

DUNS Number
 

A randomly generated 9-
digit number assigned
by Dun & Bradstreet
Corporation to identify

D-U-N-S Number
 

DunsNumberC
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

unique business
establishments. May
contain leading zeros,
which will be lost if the field
is treated as numeric.
 

Data/
GlobalUltimateDunsNumC
 

Global Ultimate DUNS
Number
 

The top-most responsible
entity within the corporate
family tree. May contain
leading zeros, which will be
lost if the field is treated as
numeric.
 

Global Ultimate D-U-N-S
Number
 

GlobalUltimateDunsNumC
 

Data/ParentDunsNumC
 

Parent DUNS Number
 

The D-U-N-S number of
the parent organization.
May contain leading zeros,
which will be lost if the field
is treated as numeric.
 

Parent D-U-N-S Number
 

ParentDunsNumC
 

Data/
EmpAtPrimaryAdrEstInd
 

Number of Employees (This
Site)
 

The number of employees
at this location.
 

Employees at Identifying
Address
 

EmployeesAtPrimaryAddressText
 

Data/
EmpAtPrimaryAdrEstInd
 

Employees Here Reliability
Code
 

Describes the reliability of
the Employees Total value.
 

Number of Employees at
Identifying Address
 

EmployeesAtPrimaryAddress
 

Data/
EmpAtPrimaryAdrMinInd
 

Employees Primary
Minimum Indicator
 

A code value that describes
the reliability of the
Employees Total value.
 

Number of Employees at
Identifying Primary Address
Minimum
 

EmployeesAtPrimaryAddressMinimum
 

Data/EmployeesTotal
 

Employees Total
 

The total number of
employees in the business
organization; it should
include subsidiary and
branch locations.
 

Number of Employees
 

EmployeesTotal
 

Data/TotalEmpEstInd
 

Employees Total Reliability
Code
 

Describes the reliability of
the Employees Total value.
 
The possible values are:
Actual, Estimated, and
blank.
 

Number of Employees
Estimated Qualifier
 

TotalEmployeesEstimatedIndicator
 

Data/TotalEmpMinInd
 

Employees Total Minimum
Indicator
 

Displays the reliability of
the Employees Total value.
 
The possible values are:
Includes Subsidiaries,
 Subsidiaries not included,
 and blank.
 

Number of Employees
at Identifying Address
Minimum Qualifier
 

TotalEmployeesMinimumIndicator
 

Data/ImportInd
 

Import Indicator
 

A code value that identifies
whether the business
imports goods or services

Importer Indicator
 

ImportInd
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

for remanufacture or
sale, exports products
or services to a foreign
country, or is an agent for
goods.
 

Data/ExportInd
 

Export Indicator
 

A code value that identifies
whether the business
imports goods or services
for remanufacture or
sale, exports products
or services to a foreign
country, or is an agent for
goods.
 

Exporter Indicator
 

ExportInd
 

Data/LegalStatusCode
 

Legal Status Code
 

A code value that describes
the legal structure of the
business.
 

Legal Status
 

LegalStatusCode
 

Data/LineOfBusiness
 

Line of Business
 

A description of the
operations or activities of
the business. Relates to the
primary four-digit 1987 US
SIC.
 

Line of Business
 

LineOfBusiness
 

Data/MinorityOwnedInd
 

Minority Owned Indicator
 

Whether or not the
business is owned by a
member of a minority
group.
 

Minority-Owned Indicator
 

MinorityOwnedInd
 

Data/MinorityOwnedType
 

Minority Owned Type
 

Indicates the ethnicity of
the minority holding an
ownership interest.
 

Type of Minority-Owned
Organization
 

MinorityOwnedType
 

Data/RentOwnInd
 

Owns Rents Code
 

A code value that indicates
if the business owns
or rents the building it
occupies.
 

Rent or Own Indicator
 

RentOwnInd
 

Data/
PublicPrivateOwnershipFlag
 

Public Private Indicator
 

Whether or not ownership
of the business is public or
private.
 

Private Ownership
 

PublicPrivateOwnershipFlag
 

Data/SmallBusInd
 

Small Business Indicator
 

Indicates if the business
meets SBA certification
eligibility criteria effective
July 1, 1999. All firms must
be certified by one of
the Small Disadvantaged
Business Certification
Agencies.
 

Small Business Indicator
 

SmallBusInd
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

Data/ParentSubInd
 

Subsidiary Status
 

Whether or not the subject
business is more than 50-
percent owned by another
organization.
 

Subsidiary Indicator
 

ParentSubInd
 

Data/YearStarted
 

Year Started
 

The year when the current
ownership or management
assumed control of the
business or the year
established if no control
change has taken place.
This is not provided for
branch records.
 

Year Established
 

YearEstablished
 

Data/LocationType
 

Location Type
 

A code value that describes
the organizational status
of the business; for
example, Single Location,
 Headquarters, Branch.
 

HQ Branch Indicator
 

HQBranchIndicator
 

Data/FederalTaxIDNumber
 

Federal Tax ID Number
 

A number assigned by
the Internal Revenue
Services (IRS) that either
uniquely identifies or helps
to identify a subject, also
referred to as Federal
Taxpayer Identification
Number.
 

Taxpayer Identification
Number
 

JgzzFiscalCode
 

Data/PrimaryAddressLine1
 

Street Address 1
 

The first street address
line where a business
is physically located.
Generally in local language.
 

Address Line 1
 

PrimaryAddressLine1
 

Data/PrimaryAddressLine2
 

Street Address 2
 

The second street address
line where a business
is physically located.
Generally in local language.
 

Address Line 2
 

PrimaryAddressLine2
 

Data/PrimaryCity
 

City
 

City where the business is
located. Generally in local
language.
 

City
 

PrimaryAddressCity
 

Data/PrimaryCounty
 

County
 

The full name of the county
where the business is
located.
 

County
 

PrimaryAddressCounty
 

Data/PrimaryState
 

State
 

The full name of the state
where the business is
located.
 

State
 

PrimaryAddressState
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

Data/PrimaryPostalCode
 

OSC Postal Code
 

The 5-digit postal code
where the business is
physically located.
 

Postal Code
 

PrimaryAddressPostalCode
 

Data/PrimaryCountry
 

Country
 

The 2-byte alpha character
ISO code for the country
where the business is
located.
 

Country
 

PrimaryAddressCountry
 

Data/RawPhoneNumber
 

Phone Number
 

The primary phone number
for the business with no
formatting or punctuation.
This string contains all
telecommunication number
components (area code,
 exchange, number).
 

Primary Phone Number
 

PrimaryPhoneNumber
 

Data/
FaxRawPhoneNumber
 

Facsimile Number
 

The primary facsimile
number for the business
with no formatting
or punctuation. This
string contains all
telecommunication number
components (area code,
 exchange, number).
 

Fax
 

Fax
 

Data/Url
 

Url
 

The primary URL for the
company.
 

URL
 

PrimaryURL
 

Data/WomanOwned
 

Woman Owned
 

A business that is at least
51-percent owned by, and
whose management and
daily business operations
are controlled by, a woman.
 

Woman-Owned Indicator
 

WomanOwnedInd
 

Unmapped Account Fields
You must create a text or a number field for these attributes and add them to the mapping before you can expose the
field in the account pages.

The table lists the name of the attribute on the mapping page in the first column, and provides a brief definition and
description. The Geographical Availability column indicates if the attribute is available for all countries or just a subset.

Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

Data/State Name
 

State Name
 

The full name of the physical
state or province name where the
business is located.
 

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

Data/PrimaryFullPostalCode
 

Full Postal Code
 

Full postal code as received by Dun
& Bradstreet Corporation.
 

Global
 

Data/LatitudeShort
 

Latitude Short
 

The angular distance north or
south from the earth's equator
measured through 90 degrees.
Note: This is a less granular view of
the Latitude field.
 

Canada, Germany, UK, US, Mexico,
 Vietnam, Belgium, Australia,
 Netherlands, Republic of Korea
 

Data/LongitudeShort
 

Longitude Short
 

The angular distance east or
west from the prime meridian
measured through 180 degrees.
Note: This is a less granular view of
the Longitude field.
 

Canada, Germany, UK, US, Mexico,
 Vietnam, Belgium, Australia,
 Netherlands, Republic of Korea
 

Data/MailingFullPostalCode
 

Mailing Full Postal Code
 

Full postal code as received by Dun
& Bradstreet Corporation.
 

Global
 

MetaData/MatchScore
 

Match Score
 

A score representing the likelihood
of a match between records.
 

Global
 

Data/CompanyDescription
 

Company Description
 

Narrative company description.
 

Global
 

Data/MarketableIndicator
 

Marketability Indicator
 

Indicates that the record satisfies
Dun & Bradstreet Corporation
global marketability rules.
 

Global
 

Data/GEOCodeAccuracy
 

GEO Code Accuracy
 

A code value that describes how
close the coordinates for a location
are to a rooftop level.
 

Global
 

Data/
SalesVolume(USDollars)Reliability
Code
 

Sales Volume (US Dollars)
Reliability Code
 

A code value that describes the
reliability of the annual sales/
revenue figure that is expressed in
US dollars.
 

Global
 

Data/SalesVolume(LocalCurrency)
 

Sales Volume US Dollars
 

The total annual sales revenue for
this business in local currency. Not
available on branch locations.
 

Global
 

Data/
SalesVolumeLocalCurrencyReliabilityCode
 

Sales Volume Local Currency
Reliability Code
 

A code value that describes the
reliability of the annual sales/
revenue figure that is expressed in
local currency.
 

Global
 

Data/
DomesticUltimateBusinessName
 

Domestic Ultimate Business Name
 

The primary name of the domestic
ultimate business.
 

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

Data/
DomesticUltimateFIPSCountryCode
 

Domestic Ultimate FIPS Country
Code
 

The Federal Information
Processing Standards code value
that identifies the country where
the domestic ultimate company is
located.
 

Global
 

Data/
DomesticUltimateD&BCountryCode
 

Domestic Ultimate D&B Code
 

Dun & Bradstreet Corporation
geographical code identifying
the country where the domestic
ultimate is located.
 

Global
 

Data/DomesticUltimateState/
ProvinceAbbreviation
 

Domestic Ultimate State Province
Abbreviation
 

The abbreviated name of the state
or province in which the domestic
ultimate is located.
 

Global
 

Data/GlobalUltimateBusinessName
 

Global Ultimate Business Name
 

The name of the ultimate
company.
 

Global
 

Data/GlobalUltimateIndicator
 

Global Ultimate Indicator
 

Indicates whether the site record is
the Global Ultimate D-U-N-S within
the corporate family tree.
 

Global
 

Data/
GlobalUltimateFIPSCountryCode
 

Domestic Ultimate FIPS Country
Code
 

The Federal Information
Processing Standards code value
that identifies the country where
the domestic ultimate company is
located.
 

Global
 

Data/
GlobalUltimateD&BCountryCode
 

Domestic Ultimate D&B Country
Code
 

Dun & Bradstreet Corporation
geographical code identifying
the country where the domestic
ultimate is located.
 

Global
 

Data/GlobalUltimateState/
ProvinceAbbreviation
 

Global Ultimate State Province
Abbreviation
 

The abbreviated name of the state
or province in which the global
ultimate is located.
 

Global
 

Data/HeadquarterDUNSNumber
 

Headquarter DUNS Number
 

The D-U-N-S number of the
headquarter organization. May
contain lead zeros, which will be
lost if field is treated as numeric.
 

Global
 

Data/Parent/
HeadquarterBusinessName
 

Parent Headquarters Business
Name
 

The primary name of the parent
headquarters company.
 

Global
 

Data/HierarchyCode
 

Hierarchy Code
 

A number used with the status and
subsidiary indicators to pinpoint
the location of an establishment
within a corporate hierarchy. The
hierarchy on the global ultimate is
'01'. A branch hierarchy is the same

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

as its headquarters'. A subsidiary's
hierarchy is one more than its
parent's.
 

Data/NumberofFamilyMembers
 

Number of Family Members
 

The number of family members
including the global ultimate and
all subsidiaries and branches of the
entire family tree worldwide. All
family members within a particular
tree carry the same count.
 

Global
 

Data/OutofBusinessIndicator
 

Out of Business Indicator
 

Indicates that the business is out
of business or inactive based upon
D&B policies and procedures.
 

US only
 

Data/
OvertheCounterStockExchange
 

Over the Counter Stock Exchange
 

The symbol used to trade the
company's stock on the Over the
Counter Stock Exchange.
 

US only
 

Data/NYSEStockExchange
 

NYSE Stock Exchange
 

The symbol used to trade the
company's stock on the New York
Stock Exchange.
 

US only
 

Data/ASETicker
 

ASE Ticker
 

The symbol used to trade the
company's stock on the American
Stock Exchange.
 

US only
 

Data/NMSTicker
 

NMS Ticker
 

The symbol used to trade the
company's stock on the NASDAQ
National Market.
 

US only
 

Data/NASTicker
 

NAS Ticker
 

The symbol used to trade the
company's stock on the NASDAQ
Small Cap Exchange.
 

US only
 

Data/
OperatesFromResidenceIndicator
 

Operates From Residence Indicator
 

Operates From Residence Indicator
 

US only
 

Data/PrimaryCompetitor1
 

Primary Competitor 1
 

DUNS number of the company
deemed to be the primary
competitor for the business.
 

Global
 

Data/3YearGrowthPercentageonSalesVolume
 

3 Year Growth Percentage on Sales
Volume
 

The percentage increase or
decrease in the sales volume over
a three-year period. Includes a
plus (+) or minus (-) sign denoting
positive or negative growth in
sales.
 

US only
 

Data/3YearGrowthPercentageonEmployees
 

3 Year Growth Percentage on
Employees

The percentage increase or
decrease in the number of

US only
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

 employees over a three-year
period. Includes a plus (+) or
minus (-) sign denoting positive or
negative growth in sales.
 

Data/DeliquencyRisk
 

Delinquency Risk
 

Based on the standard Commercial
Credit Score, which predicts the
likelihood of a company becoming
severely delinquent over the next
12 months. Grouped into risk
ranges.
 

US only
 

Data/CensusFIPSTerritoryCode
 

Census FIPS Territory Code
 

The Federal Information
Processing Standards territory
code for where this subject is
located. These territory codes are
defined and developed by the
National Institute of Standards and
Technology (NIST) organization
within the US federal Department
of Commerce.
 

US only
 

Data/CensusFIPSCountyCode
 

Census FIPS Country Code
 

The Federal Information
Processing Standards county code
identifying the county where the
subject is located.
 

US only
 

Data/PrimaryCompetitor2
 

Primary Competitor 2
 

DUNS number of the company
deemed to be the second primary
competitor for the business.
 

Global
 

Data/PrimaryCompetitor3
 

Primary Competitor 3
 

DUNS number of the company
deemed to be the third primary
competitor for the business.
 

Global
 

Data/SecondaryCompetitor1
 

Secondary Competitor 1
 

DUNS number of the company
deemed to be the secondary
competitor for the business.
 

Global
 

Data/SecondaryCompetitor2
 

Secondary Competitor 2
 

DUNS number of the company
deemed to be the secondary
competitor for the business.
 

Global
 

Data/GlobalExchangeName
 

Global Exchange Name
 

The exchange where the stock
symbol is listed.
 

Global
 

Data/PrimaryIndicator
 

Primary Indicator
 

Indicates whether or not the ticker
is the primary one for the business.
 

Global
 

Data/NationalIdentificationCode
 

National Identification Code
 

A code value that describes
the type of national ID number

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

provided; for example, '12' = CRO,
 '14' = Siren.
 

Data/FIPSMSACode
 

FIPS MSA Code
 

The Federal Information
Processing Standards code value,
 which identifies the Metropolitan
Statistical Area (known as the MSA)
where this subject is located. These
MSA codes were defined and
developed by the National Institute
of Standards and Technology
(NIST) organization within the US
Federal Department of Commerce.
 

US only
 

Data/
ParentHeadquarterD&BCountryCode
 

Parent Headquarters D&B Country
Code
 

Dun & Bradstreet Corporation
geographical code identifying
the country where the parent
headquarters are located.
 

Global
 

Mapped Contact Fields
You can expose any of the fields listed in the table in the contact pages using the display name. Long field names
aren't always completely visible in Application Composer, but you can hover over a display name to see the underlying
technical name.

The table lists the name of the attribute on the mapping page in the first column, and provides a brief definition and
description. The Contact Field Display Name field lists the display name in the UI and in Application Composer. The
Contact Field Name lists the technical name. The names don't always match.

Oracle Contact
Enrichment Attribute

Definition Description Contact Field Display
Name

Contact Field Name

Data/DataCloudStatus
 

Data Cloud Status
 

The status of the record.
Example: Matched.
 

Enrichment Status
 

DataCloudStatus
 

Data/
PersonPreNameAdjunct
 

Prefix
 

The prefix (Mr., Ms.,
 Dr.) associated with the
person's name.
 

Prefix
 

PersonPreNameAdjunct
 

Data/PersonFirstName
 

First Name
 

The first name of the
person.
 

First Name
 

PersonFirstName
 

Data/PersonMiddleName
 

Middle Name
 

The middle name of the
person.
 

Middle Name
 

PersonMiddleName
 

Data/PersonLastName
 

Last Name
 

The last name of the
person.
 

Last Name
 

PersonLastName
 

Data/JobTitle
 

Title
 

The title associated with
the person's role. This is the

Job Title
 

JobTitle
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Oracle Contact
Enrichment Attribute

Definition Description Contact Field Display
Name

Contact Field Name

title as it would read on a
person's business card.
 

Data/PersonNameSuffix
 

Suffix
 

The last name suffix of the
person.
 

Suffix
 

PersonNameSuffix
 

Data/Address1
 

Street Address 1
 

The first street address
line where a business
is physically located.
Generally in local language.
 

Address Line 1
 

PrimaryAddressLine1
 

Data/City
 

City
 

City where the business is
located. Generally in local
language.
 

City
 

PrimaryAddressCity
 

Data/State
 

State
 

The abbreviation for the
physical state or province
name where the business is
located.
 

State
 

PrimaryAddressState
 

Data/PostalCode
 

OSC Postal Code
 

The 5-digit postal code
where the business is
physically located.
 

Postal Code
 

PrimaryAddressPostalCode
 

Data/Country
 

Country
 

The 2-byte alpha character
ISO code for the country
where the business is
located.
 

Country
 

PrimaryAddressCountry
 

Data/
PhoneRawPhoneNumber
 

Direct Dial Phone
 

The direct-dial phone
number associated with
this person in this role. It
includes country code, area
code and phone number.
 

Phone Number
 

PrimaryFormattedPhoneNumber
 

Data/CompanyPhone
 

Company Phone
 

The company phone
number at which the
professional can be
reached (for current role
assignments).
 

Phone Number
 

PrimaryPhoneNumber
 

Data/PhoneExtension
 

Company Phone Extension
 

This is the phone extension
associated with the
company phone number
indicated on this record.
 

Phone Extension
 

PrimaryPhoneExtension
 

Data/EmailAddress
 

Email Address
 

The main email address
associated with this
person's role or contact
record.
 

Email
 

Email
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Oracle Contact
Enrichment Attribute

Definition Description Contact Field Display
Name

Contact Field Name

Data/Department
Department
 

Department
 

A division of a large
organization such as
Executive, Administration,
 and so on.
 

Department
 

Department
 

Unmapped Contact Fields
You must create a text or a number field for these attributes and add them to the mapping before you can expose the
field in the contact pages.

The table lists the name of the attribute on the mapping page in the first column, and provides a brief definition and
description. The Geographical Availability column indicates if the attribute is available for all countries or just a subset.

Oracle Contact Enrichment Cloud
Service Attribute

Definition Description Geographical Availability

Data/FullPostalCode
 

Full Postal Code
 

Full postal code as received by Dun
& Bradstreet Corporation.
 

Global
 

DataDUNSNumber
 

DUNS Number
 

The D-U-N-S number of the
business location.
 

Global
 

Data/IndividualID
 

Individual ID
 

The unique identifier of the
professional.
 

US only
 

Data/RoleID
 

Role ID
 

Unique identifier of the
professional's job at a particular
DUNS location.
 

US only
 

Data/LastUpdateDateRole
 

Last Update Date Role
 

The date any of the role data was
last updated.
 

Global
 

Data/ManagementLevel
 

Management Level
 

Level of management; for example,
C-Level, VP-Level, and so on.
 

Global
 

Data/StandardizedTitle
 

Standardized Title
 

A business title derived from the
Management Responsibility Code,
 which identifies a title or area of
responsibility of an executive.
 

Global
 

MetaData/MatchScore
 

Match Score
 

A score representing the likelihood
of a match between records.
 

Global
 

Data/Location
 

Location
 

Address information for individual.
 

US only
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Create the Fields for Any Unmapped Information  
Here's an outline of how you can create text and number fields for any of the unmapped information that you want
to display in the UI. You can get more details about creating fields in the Oracle Applications Cloud Configuring
Applications Using Application Composer guide.

1. Ensure that you're working in a sandbox.
2. Click Navigator >  Configuration >  Application Composer.
3. Make sure CRM Cloud is selected in the Application field and expand Standard Objects.
4. Expand Account or Contact.
5. Click Fields.
6. In the Custom tab, click the Create a custom field icon.
7. Select Text or Number and click OK.

◦ Here are the guidelines for creating a text field:

Property Description

Display Label
 

Enter the text users see.
 

Display Width
 

Character width for the text field. The default is 30.
 

Display Type
 

Determines the type of text field displayed to the users. You can choose Simple Text Box
that is a single-line text field, or Multiline Text Area, a larger text area that spans multiple
lines.
 

Name
 

The unique identifier for the field that you add to the mapping. The application enters a
name for you, but it's a good idea to change the name to match the field you're mapping.
 

Description
 

Optional description of the object. This field is used for internal purposes.
 

Required
 

Leave deselected. The field isn't required.
 

Updatable
 

Leave selected.
 

Searchable
 

Indicates whether to make the field available for selection as additional search criteria in
the Add Fields list in Advanced Search mode.
 

Depends On
 

Leave blank.
 

Fixed Value Leave selected and blank.
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Property Description

  

◦ Here are the guidelines for creating a number field:

Property Description

Display Label
 

Enter the text users see.
 

Display Width
 

Leave blank.
 

Name
 

The unique identifier for the field that you add to the mapping. The application enters a
name for you, but it's a good idea to change the name to match the field you're mapping.
 

Description
 

Optional description of the object. This field is used for internal purposes.
 

Required
 

Leave deselected. The field isn't required.
 

Updatable
 

Leave selected.
 

Searchable
 

Indicates whether to make the field available for selection as additional search criteria in
the Add Fields list in Advanced Search mode.
 

Indexed
 

Indexing a field for search improves search performance.
 

Maximum Length
 

Leave the default value.
 

Minimum Value
 

Leave blank.
 

Decimal Places
 

Leave at 0.
 

Depends On
 

Leave blank.
 

Fixed Value
 

Leave selected and blank.
 

8. Click Save and Close.
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Add Enriched Fields to the Account and Contact Pages  
Here's how to add enriched fields to the Profile tab in the Edit Account and Edit Contact pages in CX Sales. You can use
the same process to add the fields to other CX Sales pages as well.

If you're adding the fields to the Digital Sales UIs, then you must use VB Studio instead of Application Composer and
follow the example topic, "Add a Custom Field to the Edit Contact Page", in the Oracle Fusion Cloud Sales Automation
Extending Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

1. Create and activate a sandbox.
2. Navigate to Configuration > Application Composer.
3. With the Account or Contact object selected in Application Composer, click Pages.
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4. Expose the field on the Profile tab on the Edit Account or Edit Account page.

Note:  The "Edit" pages are called "Details" pages in Application Composer.

a. Scroll to locate the Details Page Layouts and open a custom layout or create one by duplicating the
default layout.

b. Click the Profile subtab (callout 1 in the screenshot).
c. In the Summary Subtab section, click Edit (callout 2).

d. Scroll down in the Available Fields column to locate the field and move it to the Selected Fields column.
e. Use the arrow buttons to move the field where you want it
f. Click Save and Close.

You are returned to the Layout page, which reflects your changes.
g. Click Done.

You are returned to the Application Composer page.
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5. Review the pages where you added the fields:

a. With the sandbox still open, click Home.
b. Open the Account or Contact work area.
c. Review each of the pages to make sure the fields are where you want them.

6. Publish the sandbox.

Add Fields to the Mapping  
Here's how to add fields to the mapping:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Show: All Tasks

◦ Task: Manage Oracle Data as a Service Attribute Mapping and Preferences

2. Click the Attribute Mappings tab.

On the Attribute Mappings tab, there are two sections: Account Attributes and Contact Attributes.
3. In the appropriate section, find the field you want to map in the Social Data Cloud and Insight Attribute

column.

4. In the Sales Cloud Object column, select Account from the list.
5. In the Sales Cloud Attribute column, select the sales field you want to map.
6. When you complete mapping all of the fields, click Save and Close.

472



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 29
Account Data Enrichment and Verification

Configure Enrichment Preferences  
Specify if you want to enable enrichment of accounts, contacts, or both, and configure enrichment preferences to define
what data is updated in an enriched account or contact.

CAUTION:  Ensure that you configure attribute mappings before you start configuring enrichment preferences.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Oracle Data as a Service Attribute Mapping and

Preferences and open it.

This page includes two tabs, one for accounts and another one for contacts. You can use these to enable
enrichment for accounts and contacts, and configure the data that should be included in the enriched account.

3. Select Account or Contact to enable enrichment for accounts or contacts, respectively.
4. Enter a match threshold for accounts and contacts in the Match Threshold field.
5. Enter the maximum number of records that should be enriched in the Maximum Number of Accounts for

Real-Time Enrichment and Maximum Number of Contacts for Real-Time Enrichment fields.
6. In case of contact enrichment, enter the maximum number of new contacts to create during enrichment in the

Maximum Number of New Contacts field.
7. Map the source attributes with the required sales attribute. You can also select preferences for each attribute.

For example, you can set an attribute to be displayed during real-time enrichment. Note that the preferences
aren't available for child fields.

Note:  Click Reset to revert back to the default mapping and preferences.

8. Click Save and Close
If you have a preproduction or staging environment, then test the service association between your sales preproduction
environment and your Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) subscription. You must limit
testing to 500 records. When you go to production, do the service association between your production environments
and your Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) production environment. The service
association steps are the same, but the test and production service URLs are different. The service URLs are listed in
your welcome email and in the Unified Console application.
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30  Computer Telephony Integration (CTI)

Overview of Computer Telephony Integration (CTI) in
Digital Sales  
Computer telephony integration (CTI) enables integration of third party media toolbars. You can display a media toolbar
by enabling the Partner CTI Service, and by giving your signed-in users the Access Partner Media Toolbar privilege
which allows access to the toolbar.

Note:  If your users have the standard Sales job roles, you don't need to add the Access Partner Media Toolbar
privilege.

Use CTI to:

• Receive phone calls on the Digital Sales app and automatically view the caller's contact record or lead record.

• Make an outbound call using Click to Dial and skip manual dialing.

Integrating with CTI gives you the following features:

• Notifications of incoming calls and ability to accept or reject the call

• Automatic caller identification

• Ability to search for a contact

• Optional caller verification

• Display of predefined screen pop with caller or service details

• Automatic interaction recording

• Call wrap up

Prerequisite Setup  
First ensure that the Service offering is enabled, and then that the Redwood user interface is enabled. You enable the
Redwood user interface through the Service application whether you're using Sales or Service Center.

1. Sign in to CX Sales or Service as an administrator or setup user.
2. Navigate to My Enterprise > Offerings.
3. Click the Opt In Features button.
4. From the Opt In: Service screen, locate the Redwood User Interface for Service option and make sure that it's

enabled.
5. Verify all the child items are also enabled.
6. Click Done on the Opt In page, then click Done again.
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Configure Profile Options to Enable Partner Media
Toolbar  
The profile option SVC_PARTNER_MEDIA_TOOLBAR_ENABLED controls the visibility of the partner media toolbar. If
you don't enable the profile option, the partner media toolbar is hidden. You can set this profile option either at a site
level or at a user level.

To configure the profile options for enabling the partner media toolbar:

1. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
2. Click Search from the list of displayed tasks.
3. In the Search field, type Manage Admin.
4. From the displayed list of tasks, click Manage Administrator Profile Values.
5. In the Manage Administrator Profile Values page, navigate to the Search: Profile Option region.
6. In the Profile Option Code field, type SVC_PARTNER_MEDIA_TOOLBAR_ENABLED.
7. Click Search.

The Search Results: Profile Options region displays the list of profile options.
8. In the Profile Values region, specify the values in the Profile Value column for the Site Profile Level to 'Yes' if

you want the partner media toolbar to be visible to all users.
9. Alternatively, set the Site level value to 'No' and add a new row for a user for whom the partner media toolbar

must be visible.
10. Click Save and Close.

Note:  Ensure that the user is assigned the privilege Access Partner Media Toolbar
(SVC_ACCESS_PARTNER_MEDIA_TOOLBAR_PRIV) before trying to access the toolbar.

Configure Multichannel Architecture (MCA) Profile
Options  
Profile options let you configure and control application data centrally. Use the Multichannel Architecture (MCA) profile
options to manage the MCA run time profile option values. Administrators and setup users manage MCA profile options
in the Setup and Maintenance work area.

To configure the MCA Profile Options:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Communication Channels

◦ Task: Manage MCA Profile Options

2. Click the name of the profile option you want to set.
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This displays the Manage MCA Profile Options page for the selected profile option code.
3. In the Profile Values section for the profile option code, set the Profile Value for the Site Profile Level.
4. In the selected profile value, click the New icon to add a profile value.
5. Click Save or Save and Close to save the configuration.

MCA Profile Options
The following table lists the various MCA profile options that you can configure:

Profile Option Description

SVC_MCA_DISABLE_JWT
 

Enables or disables the JSON Web Token generation.
 

SVC_MCA_DISABLE_OUTBOUND_
CONTACT_VERIFY
 

Enables or Disables automatic display of contact verification screen for outbound calls. If enabled, it will
override the call flow parameter configurations.
 

SVC_MCA_DISABLE_OUTBOUND_WRAP_
UP
 

Enables or disables automatic display of the wrap-up screen for outbound calls. If enabled, it will
override the call flow parameter configurations for wrap up.
 

Note:
For Digital Sales implementations, this setting must be enabled.
 

SVC_MCA_ENABLE_ENGAGEMENT_SYNC Controls the in-focus chat interactions to be automatically associated to their screen popped tabs.

SVC_MCA_RECORD_ACTIVITIES_YN
 

Indicates whether activities must be logged for real time interactions.

Note:  For Digital Sales implementations, this setting must always be disabled (set to No).

 

SVC_MCA_RT_CHECK_EVENT_DISPATCH_
INTERNAL_MS
 

Sets the number of milliseconds the user must wait for the start communication event. We recommend
that you don't modify this value unless instructed by Oracle Support.
 

SVC_MCA_RT_EVENT_DISPATCH_MAX_
RETRIES
 

Sets the number of times the user must wait for reverse lookup to return before running the start
communication event. We recommend that you don't modify this value unless instructed by Oracle
Support.
 

SVC_MCA_SHOW_CONTACT_ON_WRAP_
UP

Indicates whether to show the contact information during the wrap up process.

SVC_OVERRIDE_PARTNER_TOOLBAR_
SELECTION

This option allows user to override system default setting of the partner media toolbar. User can select
alternative toolbars from the list of active toolbars.

SVC_OVERRIDE_PARTNER_TOOLBAR_
SELECTION
 

Enables the administrator to override the default setting of the partner media toolbar. The
administrator can select alternative toolbars from the list of active toolbars.
 

SVC_PARTNER_MEDIA_TOOLBAR_
ENABLED
 

Controls the visibility of the partner media toolbar. If it's not enabled, the partner media toolbar is
hidden.
 

SVC_TOOLBAR_DEBUG_MODE_ENABLED
 

Turns on the JavaScript logging messages for debugging toolbar-related issues.
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Related Topics
• Enter or Edit Translated Text

• Set Profile Option Values

CTI Media Toolbar APIs  
Media toolbar APIs are a set of JavaScript functions delivered by Oracle to enable Computer Telephony Integration (CTI)
partners to integrate their media toolbars with your application.

For information on the media toolbar APIs including details on each available API, see the Related Topics for the CTI
Media Toolbar APIs topic in the Implementing Fusion Service guide.

Related Topics
• Overview of the Media Toolbar API

Create a CTI Toolbar for Redwood  
Use this task to add a new Redwood toolbar.

1. Sign in as an administrator or setup user.
2. In the Setup and Maintenance work area, choose the following:

◦ Offering: Service.

◦ Functional Area: Communication Channels.

◦ Task: Manage Media Toolbar Configuration.

3. In the Manage Media Toolbar Configuration screen, click the Add (+) icon.
4. In the Toolbar work area, do the following:

◦ Name: Redwood Toolbar.

◦ Layout: Redwood

◦ Communication Panel URL: Paste the appropriate URL.

5. In the Manage Media Toolbar Configuration list, make sure the Default column entry is checked.
6. Click Save and Close.

Assign the CTI Toolbar
You can enable the toolbar at site level, meaning it's available to all your users, or you can assign the toolbar to just
specific users.

1. In the Setup and Maintenance work area, click the Tasks icon, and then click the Search link.
2. Enter Manage Administrator Profile Values in the Search box and click Search.
3. Click the task link, and then in the Manage Administrator Profile Values work area, enter the following search

string in the Profile Display name field: %Partner%.
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4. In the Search results field you have two choices depending on how you want to assign the toolbar.
5. To enable the toolbar at the site level, do the following:

a. Locate and select SVC_PARTNER_MEDIA_TOOLBAR_ENABLED profile option.
b. If there's a Site Profile Level entry, make sure the Profile Value is set to Yes. To disable the toolbar at the

site level, set that value to No.
c. If there's no Site entry, click the Add (+) icon, and from the Profile Level drop down list, select Site, and

then from the Profile Value drop down list, select Yes.
6. To enable the toolbar only for specific users, do the following:

a. First, make sure the Site Profile Level value is set to No.
b. Then, click the Add (+) icon, and from Profile Level drop down list, and select User.
c. And finally, in the User Name field, enter the user's name.

7. When finished, click Save and Close.

Call Flow Parameter Settings  
The call flow parameters determine the default and administrator-defined actions to be performed for a customer
interaction. Customer interactions are calls with the customer in Digital Sales and calls or chats in Service Center.
Administrator-defined settings override the default settings.

You can specify the settings listed in the following table:

Setting Options Description

Contact Required
 

Yes/No
 

Specifies whether the contact details of a
customer must be displayed.

Note:  For Digital Sales implementations, you
must select No.

Select No if you're using Digital Sales.
 

Contact Verification
 

Yes/No
 

Specifies whether the customer details must be
verified at the beginning of the call.
 

Note:  For Digital Sales implementations, you
must select No.

 

Screen Pop
 

Yes/No
 

Specifies whether a screen pop page must be
displayed. Select Yes.
 

Wrap Up
 

Yes/No/Server Driven
 

Specifies whether a customer interaction
requires wrap up. Select the Server Driven
option to get notified by the toolbar if an
interaction must be wrapped up.
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Setting Options Description

Note:
For Digital Sales implementations, this
setting must always be enabled.
 

Deactivate Contact Verification
Contact verification allows a user to verify a caller against records already set up in the database prior to the exchange
of sensitive information. In Digital Sales however, most inbound calls are related to sales opportunities where, for
instance, a new lead may be calling about an inquiry. Given that the majority of calls are of this type, call verification isn't
required.

1. Sign in to the application as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Communication Channels

◦ Task: Configure Call Flow Parameters

3. In the Default Settings work area, click the following drop-down lists, and change the value of both to No.

◦ Contact Required

◦ Contact Verification

4. Click Save and Close.

Configure Seeded Interaction Outcome Values  
By default, Interaction outcome values, such as Call answered, Positive outcome, include values that pertain both to
Service users and to Sales users. To configure the list to show only outcomes valid to a Sales user, perform the following
task.

1. Sign in to CX Sales as an administrator or setup user.
2. In the Setup and Maintenance work area, and choose Sales from the Setup drop down list.
3. Click the Tasks icon, then select Search.
4. In the Search field, enter Manage Standard Lookups, and click the task link in the results.
5. In the Manage Standard Lookups work area, enter ORA_SVC_MCA_RESOLUTION_CD in the Lookup Type field,

then click Search.
6. Uncheck all values you don't want your users to see.
7. When you’re finished, click Save and Close.
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31  Key Performance Indicators (KPI)

About Key Performance Indicators (KPI)  
Sales managers are always looking to boost sales by measuring performance and motivating their teams. The Digital
Sales performance feature makes it possible for them to do both by setting up goals and contests.

Oracle provides a number of predefined key performance indicators (KPIs) that sales managers can use for creating
goals and contests, but you can create your own by following the procedures described in this chapter. Here's a list of
the KPIs provided by Oracle.

KPI Name This KPI measures the...

Appointments Completed
 

Number of appointments completed.
 

Appointments Scheduled
 

Number of appointments scheduled.
 

Call Activities Completed
 

Number of call activities completed.
 

Calls Made
 

Number of calls completed.
 

Demos Completed
 

Number of demo activities completed.
 

Email Activities Completed
 

Number of email activities completed.
 

Emails Sent
 

Number of emails sent.
 

Leads Converted
 

Number of leads converted.
 

Opportunities Created
 

Number of opportunities created.
 

Opportunities Won
 

Number of opportunities won.
 

Revenue
 

Sum of the revenue for won opportunities.
 

Tasks Completed
 

Number of tasks completed.
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View Details of Predefined KPIs
You can drill down to view basic, calculation, and statistical details as well as the filter conditions defined for each of the
predefined KPIs. For example, follow these steps to see what is configured for the Opportunities Won KPI.

1. Navigate to Digital Sales  > Sales Performance.
2. From the Sales Performance dashboard, click the Actions menu (3 vertical dots icon) located near the top right

area of the dashboard.
3. Select Manage KPI.
4. From the Sales Performance KPI page, click Opportunities Won to view the details as outlined in this table.

Basic Details Calculation Details Conditions Statistic Details

Name: Opportunities Won
 
Status: Active
 
Description: Measures the
number of opportunities won.
 

KPI Object: Opportunity
 
Calculation Type: Count
 
Credit Recipient: Owner
 
Credit Date: Close Date
 

Filter Condition: StatusCode =
'WON'
 

Breakup Category: Sales
Channel
 

Attributes for Supported KPI Objects  
The following table lists the attributes for each of the supported KPI objects:

KPI Object Calculation Type Credit Recipient Credit Date Sum Attribute Breakup Category

Activity
 

• Count

• Sum

• Percentage

• Activity Created
By

• Checked-In By

• Checked-Out By

• Last Updated By

• Owner ID

• Submitted By

• Activity Creation
Date

• Check-In Time

• Check-Out Time

• Date

• Due Date

• End Date

• Ends

Not applicable
 

• Activity

• Direction

• Outcome

• Outlook

• Partner Usage

• Priority

• Private

• Status

• Type

Interaction
 

• Count

• Sum

• Percentage

Owner Resource ID
 

• End Time

• Start Time

Not applicable
 

• Channel Type

• Direction

• Status

• Stripe Code

482



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 31
Key Performance Indicators (KPI)

KPI Object Calculation Type Credit Recipient Credit Date Sum Attribute Breakup Category

• Substatus Code

Opportunity
 

• Count

• Sum

• Percentage

• Opportunity
Created By

• Opportunity Last
Updated By

• Owner

• Close Date

• Date Budget
Available

• Opportunity
Creation Date

• Opportunity Last
Updated Date

• Timeline

• Amount

• Best Case

• Budget Amount

• Expected
Revenue

• Need

• Worst Case

• Budgeted

• Decision Level

• Estimated Deal
Duration

• Include in
Forecast

• Key Internal
Sponsor

• Level of Risk

• Line of Business

• Quoted

• Registered

• Registration
Status

• Registration Type

• Sales Channel

• Sales Stage

• Source

• Strategic Value

• Win/Loss Reason

Opportunity Revenue
 

• Count

• Sum

• Percentage

• Owner • Actual Close Date

• Close Date

• Update Date

• Amount

• Best Case

• Quantity

• Revenue in
Corporate
Currency

• Worst Case

• Include in
Forecast

• Opportunity
Status

• Revenue Type

• Sales Channel

Sales Lead
 

• Count

• Sum

• Percentage

• Lead Created By

• Lead Last
Updated By

• Owner ID

• Accepted Date

• Converted Date

• Estimation Close
Date

• Expiration Date

• Last Automatic
Assignment Date

• Lead Creation
Date

• Lead Last
Updated Date

• Qualification
Date

• Budget Amount

• Deal Size

• Accepted

• Budget Status

• Contact Time
Zone

• Origin

• Product Type

• Rank

• Reassign Reason

• Registration
Status

• Registration Type

• Sales Channel
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KPI Object Calculation Type Credit Recipient Credit Date Sum Attribute Breakup Category

• Registration
Approval Date

• Rejected Time
Stamp

• Retired Time
Stamp

• Source

• Source Code

• Status

• Time Frame

Rule Conditions for Supported KPI Objects  
You can use both standard and custom attribute (fields) to define rule filter conditions for your KPI.

If you're creating or editing custom KPIs, use the Attribute drop-down list from the Conditions section of the Create
Custom KPI page and apply rule filter conditions to your custom KPI.

Note:  The Attribute drop-down list is automatically populated with the correct predefined internal field name. For
custom fields, you must enter the internal name of the custom field you previously created in Application Composer.

The following table lists the predefined fields available for adding filter conditions to each of the supported KPI objects.

KPI Object Add Field

Activity
 

• Account ID

• Account Number

• Activity

• Activity Number

• All Day

• Assessment ID

• Asset ID

• Business Plan ID

• Campaign ID

• Case ID

• Claim ID

• Contact Number

• Deal ID

• Delegator

• Direction

• Externally Owned

• Fund Request ID

• Lead ID
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KPI Object Add Field

• Location

• Location ID

• Objective ID

• Opportunity ID

• Outcome

• Owner

• Owner ID

• Partner Party ID

• Partner Program ID

• Percentage Complete

• Primary Contact ID

• Priority

• Private

• Resource Number

• Service Request ID

• Status

• Subject

• Subtype

• Type

Interaction
 

• Account ID

• Account Number

• Channel ID

• Channel Type

• Contact ID

• Contact Number

• Direction

• Interaction Number

• Owner Resource ID

• Resource Number

• Status

• Stripe Code

• Substatus Code

Opportunity
 

• Asset Number

• Authority

• Budgeted

• Currency

• Forecast

• Line of Business
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KPI Object Add Field

• Name

• Need

• Opportunity Last Update Date

• Opportunity Number

• Owner

• Primary Competitor

• Primary Contact

• Sales Channel

• Sales Stage

• Source

• Status

• Win Probability

• Win/Loss Reason

Opportunity Revenue
 

• Amount

• Comments

• Customer Product Group Name

• Include in Forecast

• Opportunity Number

• Opportunity Status

• Primary

• Product

• Product Group

• Product Type

• Recurrence Type Code

• Revenue Number

• Sales Channel

• Sales Credit

• Sales Credit Type

• Split Type Code

• Status

• Win/Loss Reason

Sales Lead
 

• Accepted

• Account Name

• Asset ID

• Asset Number

• Budget Status

• Contact Email

• Contact Time Zone
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KPI Object Add Field

• Customer ID

• Deal Size

• Job Title

• Lead Created By

• Lead Last Updated By

• Lead Name

• Lead Number

• Owner

• Owner ID

• Primary Contact ID

• Primary Contact Name

• Primary Partner Identifier

• Primary Group

• Rank

• Registration Number

• Registration Status

• Registration Type

• Score

• Source

• Status

KPI Filter Condition Operators for Custom Fields  
You can use operators as part of the rule filter conditions when defining your KPI custom fields.

These are the three field types currently supported:

• Fixed Choice List (FCL)

• Text

• Number

The following table lists the supported operators to use for defining rule filter conditions for the KPI custom fields. The
underscore c ( _c ) attached to the attribute name, for example Score_c, denotes a custom field attribute.

Note:  You can combine 2 or more conditions using the AND operator, for example, Status_c in ('DRAFT',
"IN_PROGRESS") AND Score_c > 50. You can't use the OR operator for custom KPI filter conditions.
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Operator Example

Equals
 

Type_c Equals 'NETNEW'
 
Score_c Equals 10
 

In
 

Status_c In ('DRAFT', 'IN_PROGRESS')
 
Score_c In (20, 30, 40)
 

Is Null
 

Comments_c Is Null
 

Is Not Null
 

Comments_c Is Not Null
 

Not Equals
 

Score_c Not Equals 50
 

How can I activate a Key Performance Indicator (KPI)?  
From the Sales Performance KPI page, click the name of the draft KPI that you want to activate. The KPI details are
displayed.

Next, click Edit and from the Basic Details section, select Active from the Status drop down field. Click Save to activate
the KPI.

Custom KPIs  

Create a Custom KPI  
Here's an example of how to create a custom KPI where the owner of a sales lead gets credit whenever a lead is
qualified.

1. Navigate to Digital Sales >  Performance.
2. From the Sales Performance dashboard, click the Actions menu (3 vertical dots icon) located near the top-right

area of the dashboard.
3. Select Manage KPI.
4. From the Sales Performance KPI page, click the Actions menu (3 vertical dots icon) located near the top-right

area of the dashboard.
5. Select Create Custom KPI.
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6. In the Basic Details section:

◦ Enter a name for the KPI.

◦ From the Status drop-down field, select from Draft, Active, or Inactive.

◦ Enter a meaningful description for the KPI so that users have a good understanding of the purpose and
use of the KPI.

7. In the Calculation Details section:

◦ From the KPI Object drop-down list, select the object that you want to track. For example, you can select
from Activity (appointments and tasks), Interaction (calls and emails), Opportunity, Opportunity Revenue,
and Sales Lead standard objects. Select Sales Lead.

◦ From the Calculation Type drop-down list, select how you want to calculate the KPI, for example, Count,
Sum, or Percentage. Select Count and then enter who will get the points.

Note:  If you select Sum as your calculation type, then enter what attributes you want to sum up. The
purpose of the custom KPI of percentage type is to measure your key performance as a percentage.

◦ In the Credit Recipient drop-down list, select who will get credit. For example, select from the following
options for Lead count:

- Lead Created By
- Lead Last Updated By
- Owner ID

In this example, select Owner ID so each time a lead is qualified, its owner gets credit.

◦ In the Credit Date drop-down list, select when the credit will be allocated. For example, select from the
following options for Leads:

- Accepted Date
- Completed Date
- Estimation Close Date
- Expiration Date
- Less Automatic Assignment Date
- Lead Creation Date
- Lead Last Updated Date
- Qualification Date

Select Qualification Date so that each time a lead is qualified, credit is due to the owner on the date of
the lead qualification.

8. In the Conditions section, enter what conditions to use to select records.

◦ From the Add Field drop-down list, select what attribute you want to measure for the KPI, for example,
select Status of the Sales Lead.

◦ From the Filter Condition area, enter the KPI condition, for example, use Qualified / Converted

9. In the Statistic Details section:

◦ From the Breakout Category drop-down list, select how you want to break down the information
displayed in the contest or goal for your custom KPI. For example, selecting Sales Channel for leads,
displays how many leads were qualified by telesales, direct, or indirect sales channels. This provides
valuable insights of KPI achievements to sales teams.

10. Click Save.
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Create a Custom KPI of Percentage Calculation Type  
Here's an example of how to create a custom Opportunity Win Rate KPI where the owner of an opportunity gets credit
whenever an opportunity is won.

The purpose of the custom KPI of percentage type is to measure the percentage of opportunities being won. Note that
the number of opportunities won is calculated as the sum of all opportunities won by close date.

1. From the Sales Performance KPI page, click the Actions menu (3 vertical dots icon) located near the top right
area of the dashboard and select Create Custom KPI.

2. In the Basic Details section, enter a name, status, and meaningful description for the KPI of percentage type.
3. In the Calculation Details section:

◦ From the KPI Object drop-down list, select the object that you want to track. For example, you can select
Opportunity.

◦ From the Calculation Type drop-down list, select how you want to calculate the KPI, for example, select
Percentage.

Note:

The Percentage value is calculated by dividing the numerator value by the denominator value and
multiplying the result by 100. For example, (Numerator / Denominator * 100). For both numerator and
denominator calculation, you must have a sub calculation type. So you can calculate numerator or
denominator by either counting or summing records. The resulting number of records calculated is a
subset of the denominator value

◦ In the Credit Recipient drop-down list, select who will get credit. In this example, select Owner.

4. In the Statistic Details section:

◦ From the Breakout Category drop-down list, select how you want to break down the information
displayed in the contest or goal for your custom KPI. For example, selecting Sales Channel for
opportunities, displays how many opportunities were won by telesales, direct, or indirect sales channels.
This provides valuable insights of KPI achievements to sales teams.

5. In the Records to include for Numerator  section specify what records to include as part of the numerator
percentage calculation.

For example, select Count as the Calculation Type. Opportunity is already selected as the Object.

Note:  The object for both the numerator and denominator will be the same as the object already selected
and the calculation type will also be the same for the numerator and denominator.

6. In the Credit Date drop-down list, select when the credit will be allocated. For example, select Close Date so
that each time an opportunity is won, a percentage of the credit due to the owner on the close date of the
opportunity.

7. You now want to narrow down the KPI details by entering some filters you want to use to select the records for
the KPI of Percentage type. For example, in the Filter section, select Status from the Attributes drop-down list,
select Equals from the Operation drop-down list, and enter Won to complete your filter condition.

8. In the Records to include for Denominator section, specify what records to include as part of the denominator
percentage calculation. Note the calculation type must match the type used for the numerator so for example,
both the Calculation Type and Object fields are automatically pre-populated with Count and Opportunity
respectively.
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9. From the Filter section enter the conditions to use to select the records for the denominator KPI. For example,
to select all opportunities, you select credit date so that all closed opportunities will be counted:

◦ Select Opportunity Number from the Attributes drop-down list, and select Is Not Null from the
Operation drop-down list

◦ You can click the plus sign (+) to add other condition rows, if required.

10. Click Save.

Sample Scenarios for Creating Custom KPIs  
The following table specifies sample scenarios for creating custom key performance indicators:

Scenario Create Custom KPI

Opportunity
 
You want to create a KPI to measure
opportunities created which are net new
opportunities. You have created a custom
field named Opportunity Type that has the
following values.
 

• Net New

• Renewal

• Upsell

• Cross sell

1. In the Name field, enter Net New Opportunities Created
2. In the KPI Object field, select Opportunity.
3. In the Calculation Type field, select Count.
4. In the Credit Recipient field, select Opportunity Created By.
5. In the Credit Date field, select Opportunity Creation Date.
6. In the Filter Condition area, enter Equals 'Net New' after the OpportunityType_c internal

name. For example, OpportunityType_c Equals 'Net New'
7. In the Breakup Category field, select Sales Channel.

Activity
 
You want to track how many presentations
are scheduled. Create a KPI named
Presentations Scheduled which measures
appointments scheduled of type
'Presentation' created for the activity
object.
 
You have selected the predefined
Appointments Scheduled KPI and
have created a copy of it by using the
Duplicate action from the Actions menu.
Your custom KPI is named Presentations
Scheduled.
 
You have created a custom field named
Appointment Type that has the following
value.
 

1. In the Name field, enter Presentations Scheduled
2. In the KPI Object  field, select Activity.
3. In the Calculation Type field, select Count.
4. In the Credit Recipient  field, select Activity Created By.
5. In the Credit Date field, select Start Date.
6. In the Filter Condition area, enter Equals 'Presentation',  after the AppointmentType_c

internal name. For example, AppointmentType_c Equals 'Presentation'
7. In the Breakup Category field, select Activity.
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Scenario Create Custom KPI

• Presentation

Sales Lead
 
You are following up on a sales lead
and you want to ensure that the correct
participant gets credit for qualifying a lead
for an account. You can do this by passing
the field filter Lead Status Type for the lead
activity. You have created a custom field
named Lead Status Type which has the
following values.
 

• Qualified

• Converted

1. In the Name field, enter Qualified Leads
2. In the KPI Object  field, select Sales Lead.
3. In the Calculation Type field, select Count.
4. In the Credit Recipient  field, select Owner ID.
5. In the Credit Date field, select Qualification Date.
6. In the Filter Condition area, enter In ('Qualified', 'Converted') after the

LeadStatusType_c internal name. For example, LeadStatusType_c In ('Qualified', 'Converted')
7. In the Breakup Category field, select Sales Channel.

Can I choose to display or hide the activity history for a custom
KPI?  
Yes, you can decide to display or hide history for a given custom KPI by selecting or deselecting the Show activity
history radio button from the Create Custom KPI page.

If selected, then all activity history, in addition to audit history, is displayed. This means that sales users can view any
contest or goals created using a custom KPI from the history panel. If you deselect the Show activity history radio
button, individual or team activity entries for goal and contests related to KPI progress won't appear in the history panel.
However, audit entries such as contest created, goal updated, participant added, participant removed and so on will
continue to be shown.

How can I hide the progress indicators for active goals?  
You can choose to either display or hide goal progress indicators on the goal card for active goals.

The Goal Progress Indicators Enabled (ZCA_ENABLE_GOAL_PROGRESS_INDICATORS) profile option is set to display
the goal progress indicators by default so that users can see at a glance how they are performing in reaching their goal
performance target.

If users no longer want goal indicators displayed for their active goals, then you can set the profile option value to No.
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32  Email Integration

Email Integration Options  
Your organization has four options for setting up email for Digital Sales. Which option your implementation team
chooses affects the way you send and receive emails. The first three options all involve integration with Microsoft
Exchange.

All four options let you access the email conversations with contacts both from Digital Sales and from any email client
that's also hooked up to Microsoft Exchange. The fourth option uses the built-in Oracle Email application.

No matter which one of these options you use, you must always initiate your email conversation from within Digital
Sales. To compose the initial email, click an email address or enter "send email" in the Action Bar. Digital Sales inserts a
code in your draft email. The code, which is invisible to recipients, lets the application track the email thread.

Here's an overview of the different email options:

• Microsoft Office 365

You compose your email in your regular Office 365 Outlook compose window. As long as you start the email
conversation from within Digital Sales, the complete email conversation gets recorded in the record where you
started it and is also visible in Outlook. You can view and reply to emails in either application, and you get the
benefit of all the Office 365 features: your drafts get saved as soon as you start typing, for example, and you
can use your usual signature.

Here's a screenshot of an email thread with a contact that you can view and respond to interchangeably in
Digital Sales and in Office 365. Your drafts and sent emails get saved as usual (callout 1) and you get the same
options when composing your email (callout 2):
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• Microsoft Outlook or another client application integrated with Microsoft Exchange

You compose emails in Outlook or another client. The main differences:

◦ The tracking code is visible in your out-going draft, though it's not visible to the recipients. Here's a
sample code:

------
CRM Reference:
Oracle Digital Sales
(##0000014003##)

◦ In Office 365, the entire email thread is automatically copied in outgoing replies. In the Outlook client, the
email recipient sees only the header and the subject of the email you're replying to.

Here's a screenshot of a sample email compose window in Outlook when you reply to an existing thread
with a contact. The reply includes only the subject of the email you're replying to (callout 1) and includes a
reference number that email recipients don't see (callout 2):
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• Digital Sales UI with Microsoft Exchange

You compose your initial email in the Digital Sales UI.

Here's a screenshot of the Digital Sales compose page:

Just like with the other Microsoft Exchange options, you can view customer replies and continue the
conversation either in Digital Sales or in the client you're using. Here are a couple of differences:

◦ You see the emails you compose recorded in Activities right away. You don't have to wait a few minutes
for them to appear as you do with the other options.

◦ The Digital Sales UI doesn't save your draft, so you must send the email before you close the browser tab.

◦ You can't use your signature for the initial email and any others you send from Digital Sales.
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• Digital Sales UI with Oracle Email

If your organization isn't implementing integration with Microsoft Exchange, then you use the Digital Sales UI
exclusively to send and receive email. Here are the main differences:

◦ You can't use client applications to view and send emails. There are no email signatures, and you must
send your email before you close the browser tab. Oracle Email doesn't save drafts.

◦ Unlike the other options, this one doesn't use your email address for outgoing and incoming emails. Your
contacts see your name in the From: field as usual, but Oracle inserts a special email address with a code
that identifies the email for tracking in the application.

Here's a quick comparison between the different options:

Email Feature Microsoft Office 365 Outlook or Another Client
That Integrates with
Microsoft Exchange

Digital Sales UI with
Microsoft Exchange

Digital Sales UI with
Oracle Email

You must create the initial
email in Digital Sales.
 

Yes
 

Yes
 

Yes
 

Yes
 

Compose window you use
in Digital Sales
 

Office 365
 

Outlook or another client
 

Digital Sales compose UI
 

Digital Sales compose UI
 

Enables Cc, Bcc, and
attachments
 

Yes
 

Yes
 

Yes
 

Yes
 

Hides autogenerated IDs in
compose window
 

Yes
 

No
 

Yes
 

Yes
 

Displays email thread in
replies
 

Yes
 

Only the subject and
header of the most recent
email you're replying to
 

Yes
 

Yes
 

Signatures and templates
 

Yes
 

Yes
 

No
 

No
 

Drafts get saved
automatically
 

Yes
 

Yes
 

No for emails sent from the
Digital Sales UI, including
the initial email.
 
You can save drafts in your
client application.
 

No
 

Uses your own email
address in the From: field
 

Yes
 

Yes
 

Yes
 

No. The recipient sees
the sender's name, but
the application includes a
computer-generated reply
email address.
 

Send later at a scheduled
time
 

Yes
 

Depends on which client
you use
 

No
 

Yes
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Email Feature Microsoft Office 365 Outlook or Another Client
That Integrates with
Microsoft Exchange

Digital Sales UI with
Microsoft Exchange

Digital Sales UI with
Oracle Email

How you know you have
mail
 

Receive notification (bell
icon) in Digital Sales
 
Check Inbox
 

Receive notification (bell
icon) in Digital Sales
 
Check Inbox
 

Receive notification (bell
icon) in Digital Sales
 
Check Inbox
 

Receive notification (bell
icon) in Digital Sales
 

Where you can read
and respond to replies,
 including attachments
 

Inbox in Office 365 Outlook
 
In the Activities page of
the Digital Sales record
where you composed the
initial outgoing email and
in the Activities page of the
contact
 

Outlook or other client
Inbox
 
In the Activities page of
the Digital Sales record
where you composed the
initial outgoing email and
in the Activities page of the
contact
 

In the Activities page of
the Digital Sales record
where you composed the
initial outgoing email and
in the Activities page of the
contact
 
In a client application
integrated with Microsoft
Exchange.
 

In the Activities page of
the Digital Sales record
where you composed the
initial outgoing email and
in the Activities page of the
contact
 

When your initial email
appears on the Activities
page
 

In a few minutes, after a
process runs
 

In a few minutes, after a
process runs
 

Immediately
 

Immediately
 

Overview of Email Setup  
You have the choice of setting up either Oracle Email or an integration with Microsoft Exchange

Note:  Starting in June 2023, Microsoft Exchange no longer supports the REST APIs to access on-premises mail
boxes, so you must set up your integration with the cloud version only.

Option Setup Description Where to Get More Details

Microsoft Exchange
 

To set up the integration with Microsoft
Exchange you must perform setups in
Microsoft Azure, Microsoft Exchange Server,
 and Oracle CX Sales.
 

• In Microsoft Azure, you create an
application for the integration and provide
application access to the mailbox.

If you're using the CX Sales for Microsoft
365 add-in, you must create a new
application in Microsoft Azure for this
integration.

• In Microsoft Exchange Server, you create
a rule to add identifying information in
emails.

See the topic:Exchange Email Integration for
Digital Sales .
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Option Setup Description Where to Get More Details

• In Oracle CX Sales, you must register
your choice to use Microsoft Exchange
by setting the system profile option
ORA_ZCA_DS_EMAIL_OPTIONS to MS
Exchange with Redwood Compose UX.
By default, the profile is set to Oracle
Email.

Oracle Email
 

If you aren't using Microsoft Exchange, set up
Oracle Email. The setup involves:
 

• Registering access points.

• Configuring an email channel.

• Running scheduled processes to retrieve
inbound emails.

• Setting profile options to display past
conversations in the outbound emails.

See the topic: Oracle Email Integration with
Digital Sales
 

Exchange Email Integration for Digital Sales  
The Microsoft Exchange email integration lets salespeople send emails from the Contact, Account, Opportunity, and
Leads work areas of Digital Sales. They can see the entire email conversations related to a particular record they're
working on without leaving the work area.

Exchange Email Overview
The Exchange email integration saves sent emails to the activity feed and the Sent Items folder of the native email
client. When a recipient replies, the reply appears as a thread to the originally sent email in the activity feed. The
Exchange saves the reply to the Inbox of the sender as well.
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Here's a diagram of the Exchange email integration process.

Note:  Starting in June 2023, Microsoft Exchange no longer supports the REST APIs to access on-premises mail
boxes, so you must set up your integration with the cloud version only.

This table details the integration steps.

Integration at Work Description

Administrator sets up the exchange
integration
 

Set up the integration in three areas:
 

1. Microsoft Azure
2. Microsoft Exchange Server
3. Oracle Sales

In Microsoft Azure (callout 1):
 
Create an application for the integration and provide the read, write, and send application permissions.
This allows the application to access the mailbox.
 
In Microsoft Exchange Server (callout 2):
 
Create a rule to search for a keyword in the subject and the email body of the sent and received emails,
 and add the global address to the bcc.
 
In Oracle Sales (callout 3):
 
Set Microsoft Exchange as your email server in Digital Sales through a profile option. Using the email
Integration page, associate the application you created in Azure with the rule you created in Exchange.
This causes the integration engine to control the compose email action in Digital Sales.
 

User initiates an email conversation from
Digital Sales
 

When an email is sent to a contact from Digital Sales (callout 4), the integration engine inserts the
keyword in the background of the email body (callout 5) and sends it to the contact.
 
Microsoft Exchange (based on the rule) forwards a copy of the email with the keyword to your global
address and saves it in the activity feed of Digital Sales (callout 8).
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Integration at Work Description

Recipient replies and the salespeople see
the reply in Digital Sales
 

When the recipient replies (callout 6), the integration engine displays the reply on the Digital Sales
activity feed by identifying the keyword, auto inserted in the first sent email. All the sent and received
email conversations in the thread (callout 7) are shown in the Digital Sales activity feed.
 
If your user is using a native client such as Outlook, the email chain also shows up in the Sent Items
and Inbox of the native email client of the sender (callout 9).
 

Set Up in Microsoft Azure
If you have reused the Application ID and key of Microsoft 365 add-in for the Exchange email integration, before
proceeding with the Set up in Microsoft Azure, read through the FAQ: I already have an app registered with Microsoft
Azure for Microsoft 365 add-in. Can I reuse the Application ID and Key of that app for the Exchange email integration?

Here are the steps to create a new application for Exchange email integration that uses Microsoft Graph API:

1. Sign in to Microsoft Azure at https://portal.azure.com.
2. In the Azure Services, click Azure Active Directory.
3. In the left pane of the Azure Active Directory Overview page, click App registrations.
4. Click New Registration.
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5. On the Register an application page, make these entries:

a. Enter a name.
b. For Supported account types, make sure Accounts in this organizational directory only (tenant name

- Single tenant) is selected.
c. Click Register.

6. Microsoft Azure registers and generates an ID for your application. Copy the Application (client) ID for later
use.
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7. Go to Certificates and secrets to generate the secret or the Application Key.

a. On Certificates and secrets, Client Secret section, click New client secret.

b. Enter a name, for example, Email Integration Secret.
c. Select the longest tenure. Microsoft allows 2 years from the Start Date.
d. Click Add.

e. Copy the generated string from the Value field. Value is the application key.
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8.

Go to API permissions and click Add a permission. 

a. On Request API permissions, click Azure Active Directory Graph under Microsoft APIs.

b. Click Application permissions. 
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c. Expand Mail and select Mail.ReadWrite and Mail.Send permissions.

d. Click Add permissions.
9. Remove the default User.Read Delegated permission. 
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10. Click Grant admin consent and click Yes.

The Status of the permissions changes to Granted.

Set Up in Microsoft Exchange Administrator Center
1. Sign in Microsoft Exchange at: https://admin.exchange.microsoft.com/.
2. Go to Mail flow > Rules.

Note:  Ensure that your network settings allow access to Microsoft Exchange when you're connected on VPN.
Otherwise, you might have to disconnect from your VPN before setting the rule.

3. Click the plus icon and select Create a new rule.

4. Enter a name.
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5. For Apply this rule if, select Subject or body contains a rule and enter a keyword. Though Microsoft
Exchange lets you to add many, add only one keyword. The keyword you enter here, is used as the hidden
keyword in the Email Integration setup of the sales application.

6. In Do the following, select Bcc the message to.
7. Add your global address and click OK.

The email you enter here, is used in the Email Integration setup of the sales application.

8. Click Save.

9. Ensure that the priority is set to the highest.
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10. To set the priority to the highest, select the rule and click the edit icon.

11. In the edit mode of the rule, set Priority to 0 and save your changes.

Set Up Email Integration in the Sales Application
Use Manage Microsoft 365 to configure the settings for email Integration.

1. In the Setup and Maintenance work area, use the Manage Microsoft 365 task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft 365

2. On the Manage Microsoft 365 page, go to the Email Integration tab.
3. Read and accept the integration notice.
4. On the Email Integration tab, make these entries:

a. Enter the Application ID, generated in Microsoft Azure.
b. Enter the Application Key, secret value generated in Microsoft Azure.
c. Select the Email Integration Enabled check box so that other applications such as Digital Sales can use

the email integration service.
d. For the Email Integration Address, enter the global email you provided in the rule created in the

Microsoft Exchange portal.
e. For the Email Integration Keyword, enter the keyword you entered in the rule created in the Microsoft

Exchange portal.
f. Click Save and Close.
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5. Go to the Manage Administrator Profile Values task, search for the ORA_ZCA_DS_EMAIL_OPTIONS profile
option and select the following Site value:

a. MS Exchange with OS Native UI: Select this to route the email flow via Microsoft Exchange and use the
native email client such as Apple mail. When a user clicks Compose Email in Digital Sales, the native client
compose window appears.

b. MS Exchange with Redwood Compose UX: Select this to choose Digital sales UI for composing the
emails and send or receive them via Microsoft Exchange server.

c. MS Exchange Office 365 UI: Select this to route the email flow via Microsoft Exchange and use Microsoft
365 (Outlook) as an email client. When a user clicks Compose Email in Digital Sales, the Microsoft 365
client appears.

Note:  Oracle Email is the default site for the ORA_ZCA_DS_EMAIL_OPTIONS profile option. The email flow is
routed through the Oracle Email service, using Digital Sales as the email client. Salespeople send and receive
emails using the Digital Sales UI. See the Oracle email Integration for Digital Sales topic to know more.

Run the Exchange Sync Process
Run the Microsoft Exchange Email Sync scheduled process to see the inbound emails in the activities list of Digital
Sales.

See the Microsoft Exchange Email Sync Job topic to learn more about this job.

Oracle Email Integration with Digital Sales  
Sales teams can use Integration with Oracle Email to send and receive emails in the Digital Sales application. Emails can
be sent directly from the Contact, Account, Opportunity, or Lead work areas.

To set up this feature, you need to complete a few steps:

1. Set Oracle Email service as the mail server for Digital Sales.
2. Register access points.
3. Configure an email channel.
4. Set a scheduled process to retrieve inbound emails.
5. Set the profile options to display past conversations in the outbound emails.

Set Oracle Email Service as the Mail Server for Digital Sales
Set the following profile option to use Oracle Email service as the mail server for Digital Sales.

1. In the Setup and Maintenance work area, use the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, select Oracle Email as the site value for the
ORA_ZCA_DS_EMAIL_OPTIONS profile option.
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Register Access Points
For emails to process successfully you need to register the email addresses in the SVC_INBOUND_EMAIL_ADDRESSES
profile option as access points.

1. Go to the Manage Email Configuration, Registration, and Validation. The Access Point Value of the Access
Point Setup region shows the email addresses specified in the SVC_INBOUND_EMAIL_ADDRESSES profile
option.

2. Click Register on an email address to register it. Restart the servers to ensure the newly registered email
addresses are active. Contact Oracle Support to restart the servers. If you unregister an email address, all
inbound emails to that address are lost.

Configure an Email Channel
Set up an email channel to enable users to send and receive emails.

1. Go to Manage Communication Channels.
2. On the Service Channels page, click Create Channel.
3. In the Create Channel window, select a Stripe Code.

Select CRM to process emails from and to external customers.
4. Select the Channel Type as Email.
5. Select Purpose as Sales.
6. Use the sales email ID of your company as the Account Name. For example: sales@mycompanydomain.com.

If a forwarding rule is configured, all the emails that are sent to the specified sales email ID are forwarded to
Oracle inbound email ID. If an outbound email is configured, Oracle emails the customer as the specified sales
email ID.

7. Ensure that the generated Channel Code is unique.

The channel code is autogenerated and identifies a communication channel when exporting or importing
channels from one environment to another.

◦ If the autogenerated channel code is unique, you can leave it unchanged.

◦ If the autogenerated channel code isn't unique, add a set of characters to the code.

8. (Optional) Enter a Display Name to indicate any information about the channel such as the name of the
organization for the channel. The new channel you create is active by default.

9. Click Save.

This table summarizes the details for email setup.

Email Description

Inbound Email
 

Indicates the emails received from your contacts.
 
As part of your implementation, set up a forwarding rule on your company email server to redirect
these emails to Oracle inbound email ID. This is the email account that Oracle provided at the time of
provisioning.
 
For example, all the emails sent to sales@mycompanydomain.com are forwarded to
pod_name.fa.extservice.incoming@pod_name-opcwf.mail.dcsn.oraclecloud.com for
processing.
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Email Description

Forward the sales emails to one of the email IDs provided in the SVC_INBOUND_EMAIL_ADDRESSES
profile option.
 

Outbound Email
 

Indicates the emails sent by salespeople to the contacts.
 
To ensure that the outbound email is delivered successfully to the external recipients, set up a Sender
Policy Framework (SPF) policy on the domain.
 
Set up an SPF policy on your domain as an authentication mechanism. The exact method of setting
up an SPF policy varies from one domain provider to another. For example, v=spf1 include:spf_
c.oraclecloud.com ~all.
 

Set a Scheduled Process to Retrieve Emails
To retrieve emails at regular intervals, set a scheduled process.

1. From the Navigator menu, select the Scheduled Processes option.
2. In the Scheduled Processes screen, click Schedule New Process.
3. In the Schedule New Process dialog box, select Job for Type.
4. Search for and select the Retrieve Inbound Email Messages option from the Name drop-down list.
5. Click OK.

The Process Details dialog box shows.
6. Click Advanced.
7. In the Schedule tab, in the Run options, select the Using a schedule option.
8. Select Frequency and specify a Start Date.
9. Click Submit.

Set the Profile Options to Display Past Conversations in Outbound Emails
To enable your sales team to see the past conversations in the email threads, configure the following profile options in
the Manage Administrator Profile Values task:

Profile Option Description

SVC_EMAIL_ENABLE_PAST_
CONVERSATIONS
 

This is the profile option to display past conversations.
 
By default, it's set to No. Change the value to Yes to enable the past conversations.
 

SVC_EMAIL_NO_OF_PAST_
CONVERSATIONS
 

This profile option sets the number of past conversations to be included in the email thread.
 
The default value is 1. You can specify a value from 1 to 10.
 
If you set the value to 0, past conversations aren't included. If you set a value greater than 10, only a
maximum of 10 conversations are displayed.
 

ORA_SVC_EMAIL_PAST_CONVERSATION_
SHOW_MSG_TYPES
 

This is the profile option to include the message type in past conversations.
 
The default value is Y.
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Profile Option Description

The message type is translated based on the user locale. The default language may be different than
the local language. For example, if the user locale is Japanese and the default language is Chinese,
 although everything gets translated to Chinese, only the message types appear in Japanese.
 

Related Topics
• Overview of Buy Side Scheduled Processes

• Submit Scheduled Processes and Process Sets

FAQs for Exchange Email Integration  

I already have an app registered with Microsoft Azure for Microsoft
365 add-in. Can I reuse the Application ID and Key of that app for
the Exchange email integration?  
No. The latest version of the Exchange email integration uses Microsoft Graph API. That’s why we recommend you
create a separate app for the Exchange email integration.

If you have reused the application ID and key of Microsoft 365 add-in, do these two things first:

1. Disable the Exchange email integration on that application.
2. Revoke the admin consent and remove the application mail permissions on that application.

Disable the Exchange Email Integration  
1. In the Setup and Maintenance work area, use the Manage Microsoft 365 task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Manage Microsoft365

2. On the Manage Microsoft 365 page, go to the Email Integration tab.
3. Unselect the Email Integration Enabled check box.
4. Save and close.

Revoke Admin Consent and Remove the Application Mail Permissions  
1. Sign in Microsoft Azure.
2. Find the Microsoft Azure application for Microsoft 365 add-in.
3. Go to the API Permissions tab.
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4. In Office 365 Exchange Online, find the Mail.ReadWrite and Mail.Send Applicationpermissions. 

5. Right-click on the Mail.ReadWrite permission and select Revoke Admin Consent. Repeat this for the
Mail.Send permission. 

6. Next, right-click on the Mail.ReadWrite permission and select Remove permission. Repeat this for the
Mail.Send permission.

7. Now, create a new app for Exchange email integration using the steps provided in Set Up in Microsoft Azure in
the Exchange Email Integration for Digital Sales topic.

Can a user send an email to an external contact?  
The external contact is a person who isn't saved as a business contact, lead, opportunity contact, or resource in the
sales application. When a salesperson sends an email to an external contact from the context of the Lead, Opportunity,
or Account UI of Digital Sales, the sent email appears in the activity feed of the respective object. If the email is sent
from a contact record, it's visible in the context of Contact but doesn't appear in the context of other parent objects.

Can a user send an email to a contact from Outlook, outside of the
Digital Sales UI and still find it in the activity feed?  
Yes, but only if the sender has inserted the keyword manually into the email body or has copied the email to the global
address, they can find the email in the activity feed of Contacts in Digital Sales.

All the subsequent emails and replies are also saved to the activity feed.

Note that if a sender copied to the global address only or the recipient removed the original message that contains the
keyword, the replies won't be captured.
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What are the attachment size limits in Digital Sales?  
Users can attach a file of up to 10MB to the email. The attachment of size greater than 10MB is saved to Digital Sales as
a web page link.
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33  Notifications

Overview of Notifications Setup  
Sales users can receive multiple types of notifications that relate to their daily work.

This chapter focuses on notifications about changes to leads, opportunities, accounts, contacts, and other sales objects.
For example, you can notify salespeople whenever they're assigned as the owner of a lead or a task.

In the Sales application, administrators can have the notifications delivered in multiple ways:

• Under the Notifications (the bell icon)

• On the browser page

• Sent using email

In CX Sales Mobile, the notifications can be pushed like other mobile notifications or they can appear under the bell
notifications icon.

Here's an overview of the setup steps:

Step Description Navigation Where to Get More Details

1
 

Enable notifications for the web
and mobile applications.
 

Setup and Maintenance > Sales
offering >  Sales Foundation > 
Change Feature Selection
 

See the Enable Notifications topic
in this chapter.
 

2
 

Create Groovy trigger scripts so
users get notified about object
changes.
 

Configuration > Application
Composer > Account > Server
Scripts
 

See the Define Notification Scripts
and Sample Notification Scripts
topics in this chapter.
 

3
 

Specify the recipient types, delivery
methods, and notification text for a
specific trigger event.
 

Tools > Notification Preferences
 

See the Configure Delivery
Preferences and Text for a
Notification topic in this chapter.
 

4 To enable notifications for Oracle
CX Sales Mobile, you must
complete a couple of additional
steps that are covered in the CX
Sales Mobile chapter.

Configuration > Application
Composer > Mobile Application
Setup > Settings > Notifications
Settings

Enable Notifications for Sales
Objects in CX Sales Mobile

Enable Notifications  
Here's how to enable notifications for Digital Sales.

1. Navigate to Setup and Maintenance and select the Sales offering.
2. In the Functional Area pane, select Sales Foundation and click Actions (the down arrow), and select Change

Feature Selection from the drop-down list.
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3. In the Edit Features: Sales Foundation page, expand the Notifications row.
4. Select the Enable check boxes for the types of notifications you want to enable:

◦ Mobile Notifications to enable notifications in CX Sales Mobile.

◦ Browser Notifications to enable notifications using the Notifications (Bell) icon at the top of the page.

◦ Use Email as a Notification Delivery Channel to enable email notifications.

5. Click Done.
Other configurations:

• You can further configure these options by specifying recipients. See the "Configure Delivery Preferences and
Text for a Notification" topic in this chapter for details.

• You can also set appointment and task reminders at the company and user levels, enable drill-down to activity
notifications, and enable activity delegation. For more information, see the start with Overview of Activities in
the Implementation Reference guide.

Define Notification Scripts  
Define the Groovy scripts for the notifications.

Note:  For your reference, you can use the sample scripts and related details that we provide in the Sample
Notification Scripts topic as you work through this procedure. These scripts are provided as examples only; your own
business requirements may be different from what these samples provide.

1. Ensure you're working in an active sandbox.
2. From the Tools menu, select Application Composer.
3. In the navigation tree, expand Standard Objects, expand the object you want, and then click Server Scripts.

Example: Standard Objects > Account > Server Scripts.
4. Click the Triggers tab on the Server Scripts page.
5. Click the add icon.
6. In the Create Trigger Object page, create the Groovy trigger:

a. In the Trigger field, select the trigger type.

Example: Before Insert in Database
b. Enter a name for the trigger.

Example: Account Owner Changed
c. Add a description.

Example: Sends a notification when the owner of an account is changed.
d. Enter the trigger Definition details. When you create a Groovy script, you need the API names of the

fields you're trying to access. Create your triggers based on parent/child fields, with these steps:

i. In the Trigger Definition section's toolbar, click the Show/Hide Expression Palette icon.
ii. Click the Fields tab.

iii. Select an Object.
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iv. Click the arrow to collapse the Object area and expand the fields area for the object you selected.
The fields for the selected object are displayed.

v. Select the API you want, and click Insert.
vi. To close the expression palette, click the Show/Hide Expression Palette icon.

The isAttributeChanged() function works only for the Before trigger types. The workaround for the
After trigger types involves retrieving the old value before the database is updated, then retrieving
the new value after the update, and then comparing the two values to see whether the attribute is
changed. However, this workaround works only for high-level attributes such as CriticalFlag and
Status and not for the ViewRow attribute.

7. In the Edit Script area, add a Groovy script.
8. Click Save and Close.
9. Test your changes and publish the sandbox.

Sample Notification Scripts  
This topic contains sample notification scripts you can use for different objects. These are for reference only. Your own
business requirements may mean you use different scripts.

Account Sample Scripts
Here are some sample scripts for the Account object:

Use Case 1: Notifies the owner of an account that a new account has been assigned to her

Notification and Navigation Details

• Notification information: New account: <account name>

• Sent to: Owner of the account

• Navigates user to: Account details page

Type

Before Insert in Database

Script

/def upID = adf.util.getUserPartyId(); if (isAttributeChanged('OwnerPartyId') && OwnerPartyId!=upID) { try

{ def map = new HashMap(); // Specifying the recipient def recipientPartyId = OwnerPartyId // Specify default

MessageText def messageText = "New Account : '" + OrganizationName + "'." // Specify one or more channels

map.put("Channels",["ORA_SVC_BELL"]); map.put("MessageText", messageText); // The following can be used to

pass a Long PartyId map.put("RecipientPartyId", recipientPartyId); if (recipientPartyId) { // Call to send

notification adf.util.sendNotification(adf, map)

Use Case 2: Notifies the owner of an account that another user has been assigned as the account owner

Notification and Navigation Details

• Notification information: Account assigned: <account name>

• Sent to: Owner of the account
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• Navigates user to: Account details page

Type

Before Update in Database

Script

/if (isAttributeChanged('OwnerPartyId')) { try { def map = new HashMap(); // Specifying the

recipient def recipientPartyId = OwnerPartyId // Specify default MessageText def messageText =

"Account Assigned: '" + OrganizationName + "'." // Specify one or more channels map.put("Channels",

["ORA_SVC_BELL"]); map.put("MessageText", messageText); // The following can be used to pass a Long

PartyId map.put("RecipientPartyId", recipientPartyId); if (recipientPartyId) { // Call to send notification

adf.util.sendNotification(adf, map)

Activity Sample Script
Here is a sample script for the Activity object:

Use Case: Notifies the assignee of a task when a task is assigned to him

Notification and Navigation Details

• Notification information: Task assigned: <task name>

• Sent to: Assignee

• Navigates user to: Task details page

Type

Before Update in Database

Script

/if (isAttributeChanged('OwnerId') && ActivityFunctionCode == 'TASK') { try { def map = new HashMap();

def messageText = "Task assigned: " def recipientPartyId = OwnerId // Specify one or more channels

map.put("Channels",["ORA_SVC_BELL"]); // Specify default MessageText map.put("MessageText", messageText); //

The following can be used to pass a Long PartyId map.put("RecipientPartyId", recipientPartyId); if

(recipientPartyId) { adf.util.sendNotification(adf, map) } else { println("No Owner associated with this

Task") } } catch (e) { throw new oracle.jbo.ValidationException('Failure to trigger Notification from Groovy

Script: ' + e.getMessage()) } }

Contact Sample Scripts
Here are some sample scripts for the Contact object:

Use Case 1: Notifies the owner of a contact that a new contact has been assigned to her

Notification and Navigation Details

• Notification information: New contact: <contact name>

• Sent to: Owner of the contact

• Navigates user to: Contact details page

Type
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Before Insert in Database

Script

/def upID = adf.util.getUserPartyId(); if (isAttributeChanged('OwnerPartyId') && OwnerPartyId!=upID) { try

{ def map = new HashMap(); // Specifying the recipient def recipientPartyId = OwnerPartyId // Specify

default MessageText def messageText = "New Contact: '" + PersonName + "'." // Specify one or more channels

map.put("Channels",["ORA_SVC_BELL"]); map.put("MessageText", messageText); // The following can be used to

pass a Long PartyId map.put("RecipientPartyId", recipientPartyId); if (recipientPartyId) { // Call to send

notification adf.util.sendNotification(adf, map)

Use Case 2: Notifies the owner of a contact that another user has been assigned as the contact owner

Notification and Navigation Details

• Notification information: Contact assigned: <contact name>

• Sent to: Owner of the contact

• Navigates user to: Contact details page

Type

Before Update in Database

Script

/ if (isAttributeChanged('OwnerPartyId')) { try { def map = new HashMap(); // Specifying the recipient def

recipientPartyId = OwnerPartyId // Specify default MessageText def messageText = "Contact Assigned: '" +

PersonName + "'." // Specify one or more channels map.put("Channels",["ORA_SVC_BELL"]); map.put("MessageText",

messageText); // The following can be used to pass a Long PartyId map.put("RecipientPartyId", recipientPartyId);

if (recipientPartyId) { // Call to send notification adf.util.sendNotification(adf, map)

Contest and Goal Sample Scripts
Here are some sample scripts for the Contest and Goal objects:

Use Case 1: Notifies participants of a contest that a contest has been created

Notification and Navigation Details

• Notification information: Contest created: <contest name>

• Sent to: Contest participants

• Navigates user to: Contest details page

Type

Before Insert in Database

Script

/def map = new HashMap(); // Specify one or more channels map.put("Channels",[ "ORA_SVC_BELL"]); //

Specify default MessageText def messageText = "Contest created: " + ContestName; map.put("MessageText",

messageText); // The following can be used to pass a Long PartyId map.put("RecipientPartyId", OwnerId);

adf.util.sendNotification(adf, map)
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Use Case 2: Notifies goal participants that a new goal has been created

Notification and Navigation Details

• Notification information: Goal created: <goal name>

• Sent to: Participants

• Navigates user to: Goal details page

Type

Before Update in Database

Script

// Specify one or more channels map.put("Channels",["ORA_SVC_BELL"]); // Specify default

MessageText map.put("MessageText", messageText); // The following can be used to pass a Long PartyId

map.put("RecipientPartyId", recipientPartyId); if (recipientPartyId) { adf.util.sendNotification(adf,

map) } else { println("No Owner associated with this Goal") } } catch (e) { throw new

oracle.jbo.ValidationException('Failure: ' + e.getMessage()) } }

Lead Sample Scripts
Here are some sample scripts for the Lead object:

Use Case 1: Notifies lead owner that a new lead has been assigned to him

Notification and Navigation Details

• Notification information: Lead assigned: <lead name>

• Sent to: Owner

• Navigates user to: Lead details page

Type

Before Update in Database

Script

/if (isAttributeChanged('OwnerId')) { try { def map = new HashMap(); def messageText = "Lead

Assigned: " + Name def recipientPartyId = OwnerId // Specify one or more channels map.put("Channels",

["ORA_SVC_BELL"]); // Specify default MessageText map.put("MessageText", messageText); // The following

can be used to pass a Long PartyId map.put("RecipientPartyId", recipientPartyId); if (recipientPartyId)

{ adf.util.sendNotification(adf, map) } else { println("No Owner associated with this Lead") } } catch (e)

{ throw new oracle.jbo.ValidationException('Failure: ' + e.getMessage()) } }

Use Case 2: Notifies the lead owner when a lead is assigned to her but the signed-in user has a userPartyId that's
different from the lead owner of the lead

Notification and Navigation Details

• Notification information: New lead: <lead name>

• Sent to: Owner

• Navigates user to: Lead details page
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Type

Before Insert in Database

Script

/def upID = adf.util.getUserPartyId(); if (isAttributeChanged('OwnerId') && OwnerId!=upID) { try { def map = new

HashMap(); def messageText = "New Lead: " + Name def recipientPartyId = OwnerId// Specify one or more channels

map.put("Channels",["ORA_SVC_BELL"]); // Specify default MessageText map.put("MessageText", messageText); // The

following can be used to pass a Long PartyId map.put("RecipientPartyId", recipientPartyId);if (recipientPartyId)

{ adf.util.sendNotification(adf, map) } else { println("Notification is not sent as Owner of this Lead: "+

Name + " is same as logged in user"); } } catch (e) { throw new oracle.jbo.ValidationException('Failure: ' +

e.getMessage()) } }

Opportunity Sample Scripts
Here are some sample scripts for the Opportunity object:

Use Case 1: Notifies the opportunity owner when an opportunity has been assigned to her

Notification and Navigation Details

• Notification information: Opportunity assigned: <opportunity name>

• Sent to: Owner

• Navigates user to: Opportunity details page

Type

Before Update in Database

Script

/if (isAttributeChanged('OwnerResourcePartyId')) { try { def map = new HashMap(); def messageText =

"Opportunity Assigned: " + Name def recipientPartyId = OwnerResourcePartyId // Specify one or more channels

map.put("Channels",["ORA_SVC_BELL"]); // Specify default MessageText map.put("MessageText", messageText); //

The following can be used to pass a Long PartyId map.put("RecipientPartyId", recipientPartyId); if

(recipientPartyId) { adf.util.sendNotification(adf, map) } else { println("No Owner associated with this

Opportunity") } } catch (e) { throw new oracle.jbo.ValidationException('Failure: ' + e.getMessage()) } }

Use Case 2: Notifies the opportunity owner when an opportunity is assigned to them, but the signed-in user has a
userPartyId that's different from him

Notification and Navigation Details

• Notification information: New opportunity: <opportunity name>

• Sent to: Owner

• Navigates user to: Opportunity details page

Type

Before Insert in Database

Script

/def upID = adf.util.getUserPartyId(); if (isAttributeChanged('OwnerResourcePartyId') && OwnerResourcePartyId!

=upID) { try { def map = new HashMap(); def messageText = "New Opportunity: " + Name def recipientPartyId
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= OwnerResourcePartyId // Specify one or more channels map.put("Channels",["ORA_SVC_BELL"]); // Specify

default MessageText map.put("MessageText", messageText); // The following can be used to pass a Long PartyId

map.put("RecipientPartyId", recipientPartyId); if (recipientPartyId) { adf.util.sendNotification(adf, map) }

else { println("Notification is not sent as Owner of this Opportunity: "+ Name + " is same as logged in

user"); } } catch (e) { throw new oracle.jbo.ValidationException('Failure: ' + e.getMessage()) } }

Configure Delivery Preferences and Text for a
Notification  
Here's how you specify the recipient types, delivery methods, and notification text for a specific trigger event:

1. Sign in as a user with the Sales Administrator job role.
2. In the Navigator, click Tools > Notification Preferences.
3. In the Notification Preferences page, select an object from the Object list.
4. Click Add to add a blank row to the table.
5. Select Yes from the Enabled drop-down list
6. In the Override  field, select Yes or No:

Override lets you specify whether a user has the ability to opt-out of the notification. If you set it to no, users
can't opt out of the notification.

7. Select a Groovy notification prompt from the Triggering Event list.
8. Enter the notification name and description. The text you enter into the Notification Name field becomes the

first part of the notification subject.
9. In the Recipients column, click the edit icon.

10. In the Configuration for Trigger Name window, select the notification delivery options for recipients and then
click Done.
The application sends notifications to the specified recipients only if you select at least one delivery method,
so be sure to select at least one method. In addition to getting communication through the selected delivery
method, the recipient also receives a bell notification. Select the Bell Notifications option to enable the
notifications that appear in the global header.
See the tables later in this topic for more information about the supplied recipients and delivery methods.

11. Click the New SmartText link, enter the notification text for the selected object, and then click Publish.
SmartText also lets you add variables to the notification message.

12. To delete a notification preference, select the row and click Delete. This action deletes any associated
notification text, too.

Note:  If you delete a notification that's generated using a Groovy script, you can create a new notification
using the same Groovy script, if it isn't used by another notification.

13. To modify an existing notification text, click the Update SmartText icon for the selected row.
14. Click Save.

Here are the predefined notification recipients:

Recipient Description

Manager of Owner ID Manager of the notification owner
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Recipient Description

  

Owner ID
 

The one who sends or assigns the notification
 

Resource team
 

Additional resources added to an object in the Team subtab (Fusion Service only)
 

Note:
Resource teams aren't applicable for Digital Sales.
 

Here are the predefined delivery methods:

Delivery Method Description

Bell Notifications
 

Enables the bell notification for the web application
 

Mobile Notifications
 

Enables notifications on the mobile application
 

Browser Notifications
 

Enables notifications to users in the Omnichannel toolbar (Fusion Service only)
 

Email Notifications
 

Enables email notifications
 

For more information about using SmartText, see topics on using smart texts in the Using Fusion Service guide.

Note:  In the sales applications, activities (tasks and appointments) use a different model to set up notifications.
For more information on how to set up notifications for activities, see the "Set Up Activity Notifications" topic in the
Activities chapter in the Implementing Sales guide.

Related Topics
• Set Up Activity Notifications

• How You Use SmartText in Service Requests

• What are the SmartText naming conventions?
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34  Oracle Digital Assistant

Language Processing Using Oracle Digital Assistant  
Sales features that require natural language processing, including sales recommendations, Action Bar filtering, and
the Sales Assistant chatbot, rely on the Oracle Digital Assistant (ODA) platform. Here's a brief overview of concepts
that will help you complete the required basic ODA setup and integrate the different sales features. Refer to the ODA
documentation to understand the full capabilities of the platform. At present, natural language processing is available
for English only.

Here's an architecture overview:

1. Oracle Digital Assistant (ODA) is a platform that's used to create chatbots and to provide natural language
processing for other applications and features.

2. Different domains, such as sales, service, and financials, require different sets of language skills. Oracle
provides some skills as stand-alone components. It builds others into digital assistants. You can install both in
your ODA application instance from the ODA "store".

3. For all Oracle cloud application chatbots, including the Sales Assistant, and for filtering activities, you install
(the term used is "pull") the FADigitalAssistant digital assistant.

4. FADigitalAssistant includes multiple chatbot skills, including CX Sales, Help Desk and HCM Knowledge. For
sales, you're using only the CX Sales skill.

5. For the Recommendations feature in both the Digital Sales UI and in CX Sales Mobile,, you install ("pull") the CX
Text Analyzer skill.

6. For each sales feature that uses natural language processing, you create a separate channel. There are different
types of channels for different uses.

◦ For sales recommendations (handled by the CX Text Analyzer skill) in both the Digital Sales UI and in CX
Sales Mobile, you create the Webhook channel. The Sales Recommendations feature analyzes the text of
call logs and notes salespeople enter to recommend what action to take.

◦ For the CX Sales skill in FADigital Assistant, different channels handle different applications:
- To enable natural language filtering of activities, you create an Oracle Web channel.
- To enable the Sales Assistant chatbot in CX Sales Mobile, you create Oracle Web channel. You can

use the same Oracle Web channel for both activities filtering and Sales Assistant.
- To enable the Sales Assistant chatbot for Microsoft Teams in CX Sales Mobile, you create a

Microsoft Teams channel.
7. After you create and activate a channel, you copy over identifying information from the channel to the sales

application to complete the link. You can learn how to create the channel for each feature and how to create the
link by reviewing the documentation for the feature.

Here's a visual overview of the integration between Sales and the Oracle Digital Assistant platform:

Oracle Digital Assistant Integration Elements

Callout Description

1 Oracle Digital Assistant (ODA) is a platform that's used to create chatbots and to provide natural
language processing for other applications and features. It bundles others into digital assistants You
can install both in your ODA application instance from the ODA "store".
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Callout Description

2 Different domains, such as sales, service, and financials, require different sets of language skills. Oracle
provides some skills as stand-alone components. Others are bundled into digital assistants.

3 For Sales, you use the CX Text Analyzer skill set for the Sales Recommendation feature.

4 For activities filtering and for the Sales Assistant chatbot in CX Sales Mobile and Microsoft Teams, you
use the FADigitalAssistant.

5 You connect the skills in ODA to the sales application, by creating different types of channels.

6 You copy the identifying information in a channel.

7 And enter it in the Sales Application. How you enter the information varies depending on the channel.
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Related Topics
• Getting Started with Oracle Digital Assistant for Cloud Applications.

Overview of Common ODA Setup for Sales  
Here's an overview of the basic Oracle Digital Assistant setup that you must complete for sales features that use natural
language processing, including sales recommendations and the Sales Assistant chatbot used with Oracle CX Sales
Mobile and Microsoft Teams.

Step Setup Task Application Description Where to Get More Details

1
 

Enable a user to administer
the Oracle Digital Assistant
application.
 

Oracle Identity Cloud
Service (IDCS)

In IDCS, you must provide
the user setting up the
sales feature with the ability
to administer the Oracle
Digital Assistant (ODA)
platform.
 
This one-time setup
involves importing sales
users into IDCS, and
assigning the Service
Administrator role to the
user doing the setup in
ODA.
 
You must have the Identity
Domain Administrator role
to complete this step.

See the topic: Enable Users
to Administer Oracle Digital
Assistant.
 
For additional information,
 see the Oracle Digital
Assistant documentation:
Getting Started with Oracle
Digital Assistant for Cloud
Applications.
 

2
 

Copy the URL for the Oracle
Digital Assistant (ODA) for
your use in setup.
 

Oracle Identity Cloud
Service (IDCS)

You can obtain the URL to
access the ODA platform UI
during your IDCS setup.
 
Just copy the URL from
the idcs-oda application
Configuration tab,
Resources section, Primary
Audience field.
 
This step is optional. After
you opt in to the Digital
Assistant feature in your
sales application (step 3),
 you can also access the
ODA platform UI directly
from the sales application
through the Manage Digital
Assistant setup task.
 

See the topic: Obtain the
Oracle Digital Assistant URL
 

3 Opt in to the Digital
Assistant feature.

Sales application Opt in to the Digital
Assistant feature. This is a
one-time setup.
 

See the topic: Opt in to
Oracle Digital Assistant
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Step Setup Task Application Description Where to Get More Details

After you do so, you can
access the ODA platform
UI directly from Setup
and Maintenance in the
Sales application using the
Manage Digital Assistant
setup task.
 

4 Install the Digital Assistant
for Fusion Applications
(FADigitalAssistant)
provided by Oracle.

Oracle Digital Assistant In the ODA platform, you
must pull (install) the
FADigitalAssistant and the
CX Text Analyzer from the
application's skill store.
 
The FADigitalAssistant
includes the CX Sales skill
that's required for activities
filtering and the Sales
Assistant chatbot in the CX
Sales Mobile and Microsoft
Teams applications.
 
The CX Text Analyzer
digital assistant is
required for the Sales
Recommendations feature.
 

See the topic: Install the
Digital Assistants
 

5 Create channels for the
features that use natural
language processing and
hook them up to Sales.

Use Oracle Digital Assistant
for the channel creation.

How you create the
channels and how you hook
them up depends on the
feature.
 
Follow the setup
instructions in the chapters
covering different features.
 

See the topics:
 

• Overview of Sales
Recommendations
Setup

• Overview of Natural-
Language Filtering
Setup for Activities

• Set Up Oracle Sales
Assistant for CX Sales
Mobile

• Set Up Oracle Sales
Assistant for Microsoft
Teams

6 Periodically update the
FADigitalAssistant and
CX Text Analyzer digital
assistants.

Oracle Digital Assistant FADigitalAssistant and the
CX Text Analyzer digital
assistants are updated
every release and three
times within each release.
You should periodically
update both to the latest
version.

See the topic: Refresh the
Digital Assistants
 

528



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 34
Oracle Digital Assistant

Enable Users to Administer Oracle Digital Assistant  
Before you can set up the integration with the Oracle Digital Assistant (ODA) platform, you must grant one or more
users the appropriate permission in the Oracle Identity Cloud Service.

Here's how:

• Import the users from your sales application into the Oracle Identity Cloud Service (IDCS).

Although you only need one user to perform the integration and administer the service, you must import all of
them.

• Assign the Service Administrator Role to the user who will be doing the ODA integration.

Import Sales Users into IDCS
1. Sign in to Oracle Identity Cloud Service.
2. To import the users, enable user synchronization:

a. Click Navigator > Oracle Cloud Services
b. Search for and select the Oracle Applications Cloud instance.
c. Click the Provisioning tab.
d. Turn on Enable Provisioning.
e. In the Select Provisioning Operations section of the page, select the Authoritative Sync check box.
f. Turn on Enable Synchronization.

g. Click Save.
3. Verify that the users are available and synchronized in the application:

a. Click the Users tab.
b. Check whether the users are available in the application. If they're not, import the users:

i. Click the Import tab.
ii. Click Import.

Assign the Service Administrator Role to the User Performing the
Integration

1. While signed in to the Oracle Identity Cloud Service, click Navigator > Oracle Cloud Services.
2. Search for the application name that starts with idcs-oda.
3. Open the application.
4. Click the Applications Roles tab.
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5. Select the Service Administrator role (callout 1 in the screenshot) and click the corresponding menu item
(callout 2).

6. From the menu, select Assign Users.
7. Search for the user you want to assign.
8. Select the user and click OK.

Obtain the Oracle Digital Assistant URL  
Here's how to obtain the URL that you can use to access to the Oracle Digital Assistant platform for setup.

1. While signed in to the Oracle Identity Cloud Service (IDCS), click Navigator > Oracle Cloud Services (callout 1 in
the screenshot).

2. Search for the application name that starts with idcs-oda (callout 2).
3. Click to open the application (callout 3). 

4. Click the Configuration  tab (callout 1 in the following screenshot).
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5. Expand the Resources section (callout 2). 

6. Copy the URL from the Primary Audience field (highlighted in the following screenshot) 

Install the Digital Assistants  
To enable the integration, you must pull the FADigital Assistant and the CX Text Analyzer digital assistants from the
Oracle Digital Assistant platform store. The FADigitalAssistant includes the CX Sales skill that's required for activities
filtering and the Sales Assistant chatbot in the CX Sales Mobile and Microsoft Teams applications. The CX Text Analyzer
digital assistant is required for the Sales Recommendations feature.

.
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1. Sign in to Oracle Digital Assistant as the user granted the administrative privilege.
2. Click the Navigator.
3. Expand the Development menu item.
4. Click Store (callout 1 in the screenshot).
5. In the Skill Store, search for either FADigitalAssistant or CX Text Analyzer.
6. Locate the version that corresponds to your application release, the first four digits of the version number.

For example, Version 22.04.30 corresponds to applications version 22A. The last two digits show the
FADigitalAssistant version. To see all available versions, click Display all versions of this skill (the square icons)
next to the Actions menu.

7. Click Actions (three vertical dots highlighted by callout 3) and select Pull (callout 4). 

Opt in to Oracle Digital Assistant  
You must opt in to the Digital Assistant feature. Opting in enables the Digital Assistant functional area in the Sales
offering. You can then open Oracle Digital Assistant directly from the sales application using the Manage Digital
Assistant setup task.

1. Navigate to the Setup and Maintenance work area and select the Sales offering.
2. In the Functional Areas pane, click Change Feature Opt In.
3. Enable the Digital Assistant functional area by selecting the check box.
4. Click Done.
5. From now on, you can open the Oracle Digital Assistant from the Sales offering:

a. In the Functional Areas pane, click Digital Assistant.
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b. In the Task  pane, click the Manage Digital Assistant  task.

Refresh the Digital Assistants  
Oracle updates both digital assistants used in Sales (FADigitalAssistant and the CX Text Analyzer) once very release and
multiple times between releases. To get the full benefit of the feature, you must ensure that you have the latest version
that corresponds to your sales application version.

Here's how to get the latest updates:

1. Sign in to Oracle Digital Assistant as the user granted the administrative privilege.
2. Click the Navigator.
3. Expand the Development menu item.
4. Click Store (callout 1 in the screenshot).
5. In the Skill Store, search for FADigitalAssistant or CX Text Analyzer.
6. Locate the version that corresponds to your application version. The first four digits of the version number

correspond to the release. For example, Version 22.04.33 (callout 1 in the following screenshot) corresponds to
applications version 22A. The last two digits show the FADigitalAssistant version.

7. Click Display all versions of this skill (callout 2 in the screenshot).

8. Find the latest version for your release (the highest number) (callout 1 in the following screenshot).
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9. Click Actions (three vertical dots highlighted by callout 2) and select Pull (callout 3).

10. Now select the refreshed skill in the channel:
a. Click Channels.
b. Select the channel to refresh the skill in the list of channels.

Note:
- For Oracle Sales Assistant for Microsoft Teams, configure the Microsoft

Teams channel. See Set Up Oracle Sales Assistant for Microsoft Teams in the
Implementation Reference guide for more information.

- For CX Sales Mobile, configure the Oracle Web Channel. See the topic Enable Sales
Assistant for CX Sales Mobile.

c. In the Route to field, select the new skill version.
d. In the Change Channel Routing dialog, click Change.
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35  Activities on Individual Records

What Activities Track on Individual Records  
In Digital Sales, the Activities panel and page on each record track and display a broad range of activities, not just the
tasks and appointments you see in the Activities work area. Activities tracked include email exchanges, notes, call logs,
past and future tasks and appointments, as well as recent updates to the record itself. The application tracks these
activities on accounts, opportunities, contacts, and leads.

The Activities page on individual records tracks important updates in chronological order, sometimes called the
activity stream. For example, the list of activities for an opportunity may show that the opportunity was reassigned to a
different owner, that an appointment is scheduled for the next day, or that a task has been created. Administrators can
determine what information gets displayed, but don't think of activities as an audit trail. Not all updates are tracked.

Here's a screenshot showing both pending activities and the record of recent updates for a contact. The items under
the Matt Hooper Updated Contact  heading lists the important changes Matt Hooper made to the account during one
edit. Each time you save, the application creates another heading with a time stamp.
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Overview of Activities Setup  
Here's a summary of the steps to specify which activities get tracked for different objects in Digital Sales.

Note:  This chapter covers only activity setup for Digital Sales. For information on how the CX Sales UI defines and
handles activities, see the Activities chapter of the Implementation Reference guide: Overview of Activities.

Step Description Navigation Where to Get More Details

1
 

You must create and activate an
activities configuration for each
object you use in Digital Sales. You
create an activities configuration
by duplicating an existing one.
Oracle provides a predefined
configuration for each object. If
you want to use the predefined
configuration, just copy it and
activate it. If you want to change
what gets displayed in Activities for
an object, you can edit your copy
before activating it.
 

Navigator > Configuration >
Configure Activities Display
 

See the topic: Create and Activate
an Activities Configuration
 

2 Set the profile option Set the
Common CRM Signals Active
(ORA_ZCA_ENABLE_SIGNALS) to
No.

Setup and Maintenance  > 
Sales > Sales Foundation >
Manage Administrator Profile
Values

See the topic: Set Profile Option
Values
 

3 Run the Publish Feed Elements
process to create the index
required by Adaptive Search.
 
Don't select the Production to Test
Enabled check box. This check box
is used for migrating indexes from
production to test instances.
 
You run this process only once.

Navigator > Tools > Scheduled
Processes
 

See the topic: Run the Publish
Feed Elements Process to Index
Activities
 

4 Enable the natural English-
language filtering of activities.
Using this feature, a salesperson
can enter "filter my tasks due
tomorrow", to view all tasks due
by the end of the next calendar
day in their time zone where they
are listed as a resource. Like all
natural-language processing in
Sales, this feature uses Oracle
Digital Assistant (ODA) to process
the text.

Setup and Maintenance  > 
Sales > Digital Assistant >
Manage Digital Assistant

See the topics and explanation in
this section: Natural-Language
Filtering for Activities

5 Set the profile option Set the
Common CRM Signals Active

Setup and Maintenance  > 
Sales > Sales Foundation >

See the topic: Set Profile Option
Values
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Step Description Navigation Where to Get More Details

(ORA_ZCA_ENABLE_SIGNALS) to
Y.

Manage Administrator Profile
Values

How You Determine What Shows Up in Activities  
You can specify what information displays in Activities for each record by creating an activities configuration in the
Configure Activities Display page and activating it. You must create and activate a separate activities configuration for
every object.

In the configuration, you can make information visible by checking two check boxes:

• Make Available for Display

Displays the attribute in activities.

• Monitor for Changes

Tracks changes in the attribute.

You must check both check boxes for the information to be visible. For many attributes, you check both check boxes for
the same attribute. For example, note text is stored in the NoteTxt attribute. So, to display notes salespeople create any
subsequent updates to the note text, you select both check boxes for the NoteTxt attribute:

Attribute Unique Name Make Available for Display Monitor for Changes

Note NoteTxt Yes Yes

To display information from certain fields, including dynamic choice list fields and fixed choice list fields, you must
check the check boxes for different attributes. That's because the information that displays in the UI comes from the
name column while the tracking of changes comes from the ID column. For example, if you're displaying the owner of a
task, a dynamic-choice list field, there are two attributes at play:

• Owner

• Owner Party ID

The Owner field stores the name of the person identified by the Owner Party ID. You want to display the owner name in
the UI, but you have to monitor the Owner Party ID to see if a new owner has been assigned. Here are the settings you
make for displaying the owner:

Attribute Unique Name Make Available for Display Monitor for Changes

Owner OwnerName Yes No

Owner Party ID OwnerPartyID No Yes

Some information displayed in the UI, such as the postal address, come from aggregating multiple fields. The attribute
FormattedAddress displays the address in the UI. FormattedAddress is composed of many elements including
country, state, city, province, street address, and so on. There are different fields involved in different formats for each
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country, which you can review using the setup task Manage Formatted Addresses. Presumably, you want to display
the changed address if any of address elements are updated. For that to happen, you must check the Monitor for
Changes check box for all the address elements you're using and check the Make Available for Display check box for
the FormattedAddress attribute. Here are the settings for just some of the available address fields:

Attribute Unique Name Make Available for Display Monitor for Changes

Address Line 1 AddressLine1 No Yes

Address Line 2 AddressLine2 No Yes

Building Building No Yes

City City No Yes

Country Country No Yes

Postal Code County No Yes

State State No Yes

Address FormattedAddress Yes No

If you check Make Available for Display for any of the address components, then you'd also see an entry for that
component as well. Suppose, for example, you check Make Available for Display for City:

Attribute Unique Name Make Available for Display Monitor for Changes

City City Yes Yes

Address FormattedAddress Yes No

The Activities would display two lines when the city is updated. For example:

• Address changed to 100 Main Street, New York, NY 10021

• City changed to New York

Anatomy of the Configure Activities Display Page  

Using the Configure What Displays in the List of Activities page, you can configure what information shows up in the list
of activities for each business object and which activity updates trigger an entry in the time line. Here's an overview:

Callout Description

1 Select the object you want to configure.

2 List of available configurations. You can have as many as 10 per object. SEED_DATA_FROM_
APPLICATION indicates the configuration provided by Oracle. You can't edit the seeded configuration,
 but you can duplicate it and edit the duplicate.
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Callout Description

3 Actions you can take on a configuration:
• Duplicate a configuration

• Edit a configuration you created.

• Delete a configuration you created.

• Activate a configuration.

4 Select an object to view its attributes.

5 Attributes of the selected object. Those that are selected and those that are available.

6 When you edit a configuration, you can:
• Save your changes by clicking Update.

• Revert to the previous saved version by clicking Reset)

• Discard the edits you made in the configuration by clicking Cancel

Create and Activate an Activities Configuration  
You must create and activate an activities configuration for each object you use in Digital Sales. You create an activities
configuration by duplicating an existing one. Oracle provides a predefined configuration for each object. If you want to
use the predefined configuration, just copy it and activate it. If you want to change what gets displayed in Activities for
an object, you can edit your copy before activating it.

539



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 35
Activities on Individual Records

You must have the Manage Feed Configurations duty role to be able to duplicate, edit, delete, and activate a
configuration. Users with the Access View Feed Configurations duty role can only view the configurations.

Note:
• You can't edit or delete configurations provided by Oracle.

• You can have only one active configuration for each object.

• You can't delete an active configuration.

• You can create a maximum of 10 custom configurations for each object.

• You can enable Monitor for Changes for a maximum of 50 attributes for each object in a configuration.

1. Click Navigator > Configuration > Configure Activities Display.
2. Select a sales object you want to configure.
3. In the Activities configurations section, select an existing configuration. Oracle provides one standard

configuration for each object. Look for SEED_DATA_FROM_APPLICATION in the Created By column.
4. In the Action column (the last column on the right), click Actions (three dots) and select Duplicate.
5. In the Duplicate dialog, enter a name for your configuration and an optional description.
6. Click Duplicate.
7. Click on the new configuration name to display its attribute setup.
8. If you want to use the configuration provided by Oracle, then skip steps 9 through 11 and activate the

configuration as described in step 12.
9. If you want to change the way attributes display first, then click Actions and select Edit.

10. Configure the attributes:
a. Select one of the objects you want to configure for display on the left pane.
b. In the right pane, locate the attribute you want to update and set the two parameters:

- Make Available for Display: makes a field available for display on the UI.
- Monitor for Changes: monitors the field for updates.

11. When you're done, click Update.
12. To make your configuration active, click Actions (the three dots) and select Activate. You must then confirm

that you want to activate.
Use Actions (the three dots) menu to activate, delete, duplicate, and update your configurations.

Related Topics
• How You Determine What Shows Up in Activities

• Anatomy of the Configure Activities Display Page
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Run the Publish Feed Elements Process to Index
Activities  
During initial Digital Sales application setup, the activities for all your existing records are blank. You must run the
Publish Feed Elements job to populate activities for each record with the date and time the record was created. The
process also publishes the indexes required for the Adaptive Search to track activities for all the objects that have
activities enabled. You can't run the process separately for individual objects.

Note:  You run this process only once during initial Digital Sales setup.

1. Click Navigator > Tools > Scheduled Processes.
2. On the Scheduled Processes Overview page, click Schedule New Process.
3. Leave the type as Job.
4. In the Name field, type Publish Feed Elements, and press Enter.
5. Make sure that the Production to Test Enabled check box is unselected. You use this option only if you want to

migrate the activity indexes from production to test as part of your data migration.
6. Continue to the next steps. Or, just skip to the steps for finishing the submission, to run the process once as

soon as possible with the default output.
See What are scheduled processes? for more information.

Which Records Get Populated with Activities
The Publish Feed Elements process populates activities in records that meet the following criteria

Object Criteria

Lead Lead status equals Unqualified or Qualified and the lead was updated in the last 180 days

Opportunity Opportunity status is Open and the opportunity was updated in the last 300 days

Account All accounts of type Customer and Prospect with any tasks and appointments added in the last 300
days

Contact All contacts that were updated in the last 300 days.

The process also populates activities for child objects of the objects that meet the above criteria:

Lead

Child Object Criteria

Activity Type = Appointment All activities of type Appointment that have not passed the due date.
 
All activities of type Appointment that have passed a due date 60 days from current date.
 

Activity Type = Task All activities of type Task that have the following status: Not Started, In Progress, and On Hold.
 
All tasks in the Completed status that passed a due date 60 days from current date.
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Notes All available notes that were created or updated in the last 60 days.

Audit Log Audit log that shows the Created By and Updated By information for the Lead record.

Contact

Activity Type = Appointment All activities of type Appointment that have not passed the due date.
 
All activities of type Appointment that have passed a due date 180 days from the current date.
 

 
Activity Type = Task
 

All activities of type Task that have the following status: Not Started, In Progress, and On Hold.
 
All tasks in Completed status that has passed the due date 180 days from current date
 

Notes All available notes that were created or updated in the last 180 days.

Audit Audit log that shows the Created By and Updated By information for the Contact record.

Opportunity

Activity Type = Appointment All activities of type Appointment that have not passed the due date.
 
All activities of type Appointment that have passed a due date 180 days from current date.
 

Activity Type = Task All activities of type Task that have the following status: Not Started, In Progress, and On Hold.
 

Notes All available notes that were created or updated in the last 180 days.

Audit Audit log that shows the Created By and Updated By information for the Opportunity record.

Account

Activity Type = Appointment All activities of type Appointment that have not passed the due date.
 
All activities of type Appointment that have passed a due date 180 days from current date.
 

Activity Type = Task All activities of type Task that have the following status: Not Started, In Progress, and On Hold.
 

Notes All available notes that were created or updated in the last 180 days.

Audit Audit log that shows the Created By and Updated By information for the Account record.

Service Request

Audit Audit log that shows the Created By and Updated By information for the service request record.

Messages All service request messages of the following types:
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• Customer Entry

• Response

• Internal Note

• Forwards

• System Note

• System Response

Interactions Interactions for all SRs where StatusCd = "ORA_SVC_CLOSED" AND ChannelTypeCd IN [ "ORA_SVC_
CHAT","ORA_SVC_PHONE"]

Migrate Index of Activities from Production to Test  
If you want to migrate the index created for activities from your production environment to a test environment, you
must run the Publish Feed Elements process in the production environment with the Production to Test Enabled check
box selected.

Before you run the Publish Feed Elements process in the production environment, make sure you completed the
following:

• You set up activities in the environment as outlined in the Overview of Activities Setup.

• You created an activities configuration in both production and test.

• You ran the Publish Feed Elements process in the test environment.

Note:  If Data Masking is enabled during the Production to Test process, all your activities generated for the objects
are deleted. You must run the Publish Feed Elements process again after the production to test process completes to
populate the activity stream with the masked data.

Related Topics
• Run the Publish Feed Elements Process to Index Activities

• Create and Activate an Activities Configuration

Natural-Language Filtering for Activities  
You can make it possible for salespeople to use English-language expressions in the Action Bar to filter the list of
activities. For example, entering "filter my tasks due tomorrow", displays all the tasks due by the end of the calendar day
in your time zone where you are listed as a resource. Entering "filter communications about pricing", displays all emails
threads and phone logs with the keyword pricing.

Without the natural language processing, you must select one of the predefined filters and then use keywords for the
rest of the search.
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Oracle Digital Assistant and Activity Filtering  
Natural language filtering uses the text analysis features of Oracle Digital Assistant (ODA) just like the other natural
language features in Sales. Here's a brief overview of concepts and tasks to help you with your implementation.

Overview of Oracle Digital Assistant Integration Elements for Activities Filtering

Callout Description

1 The Oracle Digital Assistant (ODA) platform that's used to create different natural language analysis
skills. The skills are bundled into Digital Assistants.

2 For activities filtering, you use the FADigitalAssistant digital assistant.

3 FADigitalAssistant includes multiple skills, including CX Sales, Help Desk, and HCM Knowledge. For
activities filtering, you use the CX Sales skill.

4 You connect the skills in ODA to the sales application, by creating different types of channels. For
activities filtering, you create an Oracle Web channel.

5 After you create and activate the channel, you copy its Web Channel ID.

6 You paste the Web Channel ID into the profile option Sensing Agent to ODA Channel ID (ORA_ZCA_
SENS_ODA_CHANNEL_ID).
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Overview of Natural-Language Filtering Setup for Activities  
Here's an overview of the setup tasks that make it possible for salespeople to use the English language to filter activities.

Here's an overview of the setup tasks.

Step Setup Task Application Description Where to Get More Details

1
 

Complete the prerequisite
Oracle Digital Assistant
application setup.
 

Oracle Identity Cloud
Service (IDCS)

Before you set up any
of the features that use
natural language processing,
 you must perform some
prerequisite setup of Oracle
Digital Assistant:

• Set up administrator
users

See the topic: Overview of
Common ODA Setup for
Sales.
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Step Setup Task Application Description Where to Get More Details

• Obtain the ODA URL

• Install (pull) the
FADigitalAssistant.

• Enable the Digital
Assistant used for
Oracle Fusion Cloud
Applications

 

2
 

Create the Oracle Web
channel to sales
 

Oracle Digital Assistant Create the Oracle Web channel
that enables the analysis of
the text salespeople enter in
the Action Bar.
 
After you create the channel,
 you copy the Webhook URL.
You need it for the next step.
 

See the topic:
 
Create an Oracle Web
Channel

3 Associate the Oracle Web
channel that you created
to the sales application.

Sales application Paste the Web Channel ID into
the profile option Sensing
Agent to ODA Channel ID
(ORA_ZCA_SENS_ODA_
CHANNEL_ID).

See the topic:
 
Enter the Channel ID into
a Profile Option to Enable
Activity Filtering

Create an Oracle Web Channel  
Create an Oracle Web channel to send what salespeople enter in the Action Bar to Oracle Digital Assistant for natural-
language processing.

1. Navigate to the Setup and Maintenance work area and select the Sales offering.
2. In the Functional Areas pane, click Digital Assistant.
3. In the Task  pane, click the Manage Digital Assistant  task.
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4. On the Oracle Digital Assistant home page, click the Navigator (the hamburger menu highlighted by callout 1).

5. Expand the Development menu item (callout 2).
6. Click Channels (callout 3).
7. Make sure that the Users tab is selected (callout 4).
8. Click Add Channel  to open the Create Channel window.
9. Make these entries in the Create Channel window:

a. Give your channel a name.
b. Select Oracle Web as the channel type.
c. In the Allowed Domains field, enter *.
d. Turn off Client Authentication Enabled
e. Click Create.

10. In the Route To field, select the CX Sales skill from the FADigital Assistant that you pulled from the store earlier.
11. Scroll to the Channel ID field and copy the value. You must enter the value in the profile option Sensing Agent

to ODA Channel ID (ORA_ZCA_SENS_ODA_CHANNEL_ID ).
12. Turn on Channel Enabled at the top of the page.

Enter the Channel ID into a Profile Option to Enable Activity
Filtering  
To enable the activity filtering, enter the Channel ID from the Oracle Web channel you created in the profile option
Sensing Agent to ODA Channel ID (ORA_ZCA_SENS_ODA_CHANNEL_ID ).

Before you start
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Create the Oracle Web channel.

1. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task.

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option code name
ORA_ZCA_SENS_ODA_CHANNEL_ID in the Profile Option Code field.

3. Click Search.
4. Click on the profile option name in the search results.
5. Paste the channel ID into the Profile Value field.
6. Click Save and Close.
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36  Sales Recommendations

Recommended Actions from Text Analysis  
When you enable sales recommendations, the application analyzes the English-language text in notes and call logs
and recommends appropriate follow-up actions. An action can be to create a task, an appointment, or a contact,
depending on the text that was entered. The recommendations appear at the top of the Activities panel and page where
salespeople can either accept or dismiss them. You can enable the same sales recommendations you set up here for CX
Sales Mobile with minimal additional setup. At present, the sales recommendations feature and other natural-language
processing features are available in English only.

Suppose, for example, that a salesperson enters "asked for a meeting next Tuesday at 11" in a call wrap-up and saves.
Based on the text, the application suggests the creation of an appointment.

This screenshot shows the recommended appointment viewed in the Activities page in Digital Sales. The CX Sales
Mobile app works very much the same way.

• The recommendation (callout 2)

• The text on which it was based (callout 1)

Salespeople can either create the appointment or click Dismiss to reject the recommendation and remove it from view.
The application schedules the appointment at the time specified in the text and in the salesperson's time zone. The
appointment includes the relevant text from the call wrap-up.
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When enabled, this feature replaces the automatic creation of a task after call wrap ups.

Multiple Recommendations
If salespeople receive multiple recommendations either, they can review and act on them one by one either on the
Activities pane or page by clicking the View Details link.

Here's a screenshot of the Activities panel on a lead listing two sample recommendations. The View Details link is
highlighted.

Oracle Digital Assistant and Sales Recommendations  
Sales recommendations use the text analysis features of Oracle Digital Assistant (ODA). Here's a brief overview of the
different features and concepts that will help you in your integration.

Overview of the Oracle Digital Assistant Integration for Sales Recommendations

Callout Description

1 Oracle Digital Assistant (ODA) is a platform that's used to create chatbots and to provide language
analysis for other applications and features. ODA is used not only by the sales recommendations
feature, but also by CX Sales Mobile, and the integration with Microsoft Teams, for example.
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Callout Description

2 Different domains, such as sales, service, and financials, require different sets of language skills. Oracle
bundles some of these predefined skills into digital assistants, such as FADigital Assistant. Others are
available as stand-alone skills. You install both types in your ODA application instance from the ODA
"store". For sales recommendations, you install (the term used is "pull") the CX Text Analyzer skill.

3 Applications integrate with the different skills through channels of different types. To integrate the CX
Text Analyzer skill with the sales recommendations feature, you create a channel of type Webhook and
associate the CX Text Analyzer skill to it.

4 After you create and activate the channel, you copy its Webhook URL and secret key.

5 To link the channel to the sales application, you enter the Webhook URL and secret key into Application
Composer (Oracle Sales Assistant Setup, Configure Text Analysis tab).
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Overview of Sales Recommendations Setup  
Digital Sales uses the natural language processing capabilities of the Oracle Digital Assistant (ODA) to analyze the text
of notes and tasks. This guide covers only the steps to enable the Sales Recommendations feature using the Sales skill
in ODA provided by Oracle. For information on creating skills and other ODA features, you must follow the instructions
in the Getting Started with Oracle Digital Assistant for Cloud Applications.

Note:  Sales recommendations from Sales Insights and Opportunity next best action are also available as part of
central recommendations.

Here's an overview of the setup tasks.

Step Setup Task Application Description Where to Get More Details

1
 

Complete the prerequisite
Oracle Digital Assistant
application setup.
 

Oracle Identity Cloud
Service (IDCS)

Before you set up any
of the features that
use natural-language
processing, you must
perform some prerequisite
setup of Oracle Digital
Assistant:

• Set up administrator
users

• Obtain the ODA URL

• Install (pull) the CX
Text Analyzer skill

• Enable the Digital
Assistant used for
Oracle Fusion Cloud
Applications

 
If you already completed
the setup for another
feature, you can skip this
step.

See the topic: Overview of
Common ODA Setup for
Sales.
 
For additional information,
 see the Oracle Digital
Assistant documentation:
Getting Started with Oracle
Digital Assistant for Cloud
Applications.
 

2
 

Create the Webhook
channel to sales
 

Oracle Digital Assistant Create the Webhook
channel that enables the
analysis of sales text.
 
After you create the
channel, you copy the
Webhook URL and secret
key for use in the next step.
 

See the topic: Create a
Webhook Channel
 

3 Associate the Webhook
channel that you created to
the sales application.

Sales application Enter the Webhook
URL and secret key in
Application Composer (
Application Composer > 
Common Setup >  Oracle
Sales Assistant Setup >
Configure Text Analysis).

See the topic: Associate
the Webhook Channel
to Sales and Specify
Recommendation Options
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Step Setup Task Application Description Where to Get More Details

You then enable text
analysis, and disable any
fields you don't want
analyzed.
 

4 Enable Recommendations Sales application Opt in to the Sales
Recommendations feature.

See the topic: Enable Sales
Recommendations
 

Create a Webhook Channel  
Create a Webhook channel so that the meeting notes can be sent to Oracle Digital Assistant for text analysis.

1. Navigate to the Setup and Maintenance work area and select the Sales offering.
2. In the Functional Areas pane, click Digital Assistant.
3. In the Task  pane, click the Manage Digital Assistant  task.
4. On the Oracle Digital Assistant home page, click the Navigator (the hamburger menu highlighted by callout 1).

5. Expand the Development menu item (callout 2).
6. Click Channels (callout 3).
7. Make sure that the Users tab is selected (callout 4).
8. Click Add Channel  to open the Create Channel window.
9. Make these entries in the Create Channel window:

a. Give your channel a name.
b. Select Webhook as the channel type.
c. In the Payload Version field, select the Conversation Model option.
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d. Enter an arbitrary value in the Outgoing Webhook URL field. It doesn’t matter what you enter. Just don't
enter a real URL.

e. Don't change the value in the Session Expiration  field.
f. Click Create.

10. In the Route To field, select the TextAnalyzer skill that you pulled from the store earlier (callout 2 in the
screenshot).

11. Scroll to the Secret Key (callout 3) and Webhook URL  fields (callout 4) and copy both of the values.
12. Now enable the channel by clicking the Channel Enabled toggle (callout 1 in the screenshot).
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Associate the Webhook Channel to Sales and Specify
Recommendation Options  
Here's how to associate the Webhook channel you created for recommendations to the sales application and how to
specify which recommendations you want displayed to which audience. You can specify which fields you want analyzed
and which job roles and regions will see the recommendations. By default, the application analyzes the text entered in
all of the available fields to all job roles and regions.

1. Enter an active sandbox with the Application Composer as one of the available tools (callout 1 in the screenshot)
2. Open Application Composer.
3. Click Oracle Sales Assistant Setup under the Common Setup heading in the left-hand pane (callout 2 in the

screenshot).

4. Click the Configure Text Analysis tab (callout 3).
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5. On the Configure Text Analysis tab, activate the Enable text analysis option as highlighted in the sample
screenshot. 

6. Enter the Webhook URL and the secret key that you obtained when you set up the Webhook channel.
7. Click Configure Fields.
8. On the Configure Fields tab, specify which fields get analyzed and generate recommended actions. By default,

all the available fields are enabled.
9. Next, click Configure Recommendations to select which recommended actions you want displayed and

for whom. If your organization doesn't use appointments, you can turn off any recommendations to create
appointments, for example. By default, all available recommended actions display for all salespeople.
You can disable the action completely, or restrict availability by job role and geography. For example, you can
specify that you want only sales managers in Germany to receive suggestions to create appointments. To do so,
expand Create Appointment and enter Sales Manager in the roles box and Germany in the regions box.

Note:  Any restrictions by job role and geography you specify here also affects the availability of
recommendations in CX Sales Mobile. During CX Sales Mobile setup you can restrict availability further but
the settings you make here take precedence.

10. Click Save Configuration.
11. You must publish the sandbox to make your changes active.

Related Topics
• Create and Activate Sandboxes

Enable Sales Recommendations  
Here's how to enable sales recommendations. The sales recommendation feature analyzes text of notes and call logs
and recommends follow-up tasks and appointments. When enabled, this feature replaces the automatic creation of a
task after call wrap ups.

1. Open the Setup and Maintenance work area and select the Sales offering.
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2. In Setup: Sales, click the Change Feature Opt In link.
3. In the Opt In: Sales page, click Features for Sales (the pencil icon in the topmost row highlighted in the screenshot).
4.

5. Select Enable for Sales Recommendations.
6. Click Done.

Turn Off Unwanted Recommendations  
You can turn off sales recommendations for features that you don't use in your implementation in Application
Composer Sales Assistant Setup. For example, if you don't use appointments, you can disable recommendations to
create appointments.

For navigation details, see the topic: Associate the Webhook Channel to Sales and Specify Recommendation Options
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37  Rollups

What are rollups?  
Rollups summarize data. For example, a rollup can calculate the sum of the potential revenue from the opportunities for
an account hierarchy.

Rollup calculations appear on top of the panels. This screenshot shows Opportunities and Service Requests rollups:

In Sales, the calculated value of a rollup appears in the object detail page. Here's a screenshot of an account in Sales,
showing rollup attributes. This screenshot shows the Rollups tab on the left pane and the rollup attributes shown in a
table:
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Note:  The Rollups feature replaces the predefined aggregated fields that were available in previous releases for
search criteria for your Workspace summarized data.

The sales application provides these predefined rollups:

Predefined Rollup Relationship Rollup Value

Total Number of Employees
 

Account only
 

The total number of employees in an account and its hierarchy
 

Fiscal Year Total Potential Revenue
 

Account only
 

The current fiscal year potential revenue from an account and its
hierarchy
 

Total Open Leads
 

Account to Sales Lead
 

The total count of the qualified and unqualified open leads of an account
and its hierarchy
 

Total Open Hot Leads
 

Account to Sales Lead
 

The total count of the qualified and unqualified hot leads of an account
and its hierarchy
 

Total Potential Revenue from Open
Leads
 

Account to Sales Lead
 

The sum of the potential revenue from qualified and unqualified open
leads of an account
 

Total Open Critical Service Requests
 

Account to Service Request
 

The total count of the open, critical service requests that are in the new,
in-progress, or waiting status of an account and its hierarchy
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Total Open Service Requests
 

Account to Service Request
 

The total count of service requests that are in the open, in-progress, and
waiting statuses, associated with an account and its hierarchy
 

Total Amount from Open Opportunity
Quotes and Orders
 

Account to Quotes and
Orders
 

The sum of amounts from the open and in-progress opportunity quotes
and orders of an account and its hierarchy
 

Total Open Activities
 

Account to Activity
 

The total count of open tasks of an account and its hierarchy
 

Total Potential Revenue from Open
Opportunities
 

Account to Opportunity
 

The sum of the potential revenue from the open opportunities of an
account and its hierarchy
 

Total Potential Revenue from Won
Opportunities
 

Account to Opportunity
 

The sum of the potential revenue from the won opportunities of an
account and its hierarchy
 

Total Open Opportunities
 

Account to Opportunity
 

The total count of open opportunities of an account and its hierarchy
 

Total Amount from Closed Opportunity
Quotes and Orders
 

Account to Opportunity
 

The sum of the amount from the closed and won opportunity quotes
and orders of an account and its hierarchy
 

Last Call Made
 

Account to Interaction
 

The date when your team made a phone call to any of the contacts
associated with an account or its hierarchy
 

Total Calls Made
 

Account to Interaction
 

The total number of phone calls made to an account and its hierarchy
 

Last Email Sent
 

Account to Interaction
 

The date when the last email was sent to any of the contacts associated
with an account or its hierarchy
 

Total Emails Sent
 

Account to Interaction
 

The total number of emails sent to an account and its hierarchy
 

Total Touches
 

Account to Interaction
 

The total number of calls made or emails sent to an account and its
hierarchy
 

Last Touch
 

Account to Interaction
 

The date when an account and its hierarchy were last contacted, either
by email or phone
 

Total Number of Open Leads Associated
with a Contact

Contact to Sales Lead The total number of qualified and unqualified open leads associated
with a contact

Total Number of Open Hot Leads
Associated with a Contact

Contact to Sales Lead The total number of qualified and unqualified hot leads associated with
a contact

Total Number of Open Opportunities
Associated with a Contact
 

Contact to Opportunity The total number of open opportunities associated with a contact

Sum of Open Opportunities Revenues
Associated with a Contact
 

Contact to Opportunity The cumulative total of revenue from the open opportunities associated
with a contact

Total Number of Open Service Requests
Associated with a Contact

Contact to Service Request The total number of service requests that are in the open, in progress, or
waiting statuses
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Total Number of Critical Open Service
Requests Associated with a Contact
 

Contact to Service Request The total number of service requests in the open, in progress, or waiting
statuses, marked as critical

Total Number of Touches with a Contact Contact to Interaction The total number of emails sent or calls made to a contact in the last 120
days

Date of Last Touch with a Contact
 

Contact to Interaction The date when the last email was sent or call was made to a contact in
the last 120 days

Total Number of Calls Made to a Contact
 

Contact to Interaction The total number of phone calls made to a contact in the last 120 days

Total Number of Emails Sent to a Contact
 

Contact to Interaction The total number of emails sent to a contact in the last 120 days

Last Call Made to a Contact
 

Contact to Interaction The date when the last outbound phone call was made to a contact in
the last 120 days

Last Email Sent to a Contact
 

Contact to Interaction The date when the last email was sent to a contact in the last 120 days

Date of Last Response from a Contact
 

Contact to Interaction The date when a last email or call was received from a contact in the last
120 days

Total Number of Responses Received
from a Contact

Contact to Interaction The total number of calls or emails received from a contact in the last
120 days

Total Number of Open Activities for a
Contact

Contact to Activity The cumulative total of:
 

• Tasks that are open and not in completed or canceled status

• Recurring or nonrecurring appointments with the current date as
the start date

• Call reports ending on the current date

Last Touch Date Sales Lead to Interaction The date when the last call or email was sent in the context of a lead

Last Call Made Sales Lead to Interaction The date when the last call was made in the context of a lead

Total Call Made Sales Lead to Interaction The total number of calls made in the context of a lead

Total Emails Sent Sales Lead to Interaction The total number of emails sent in the context of a lead

Total Touches Sales Lead to Interaction The total number of emails and calls made in the context of a lead

Last Email Sent Sales Lead to Interaction The date when the last email was sent in the context of a lead

Total Open Activities Sales Lead to Interaction The cumulative total of:
 

• Tasks that are open and not in completed or canceled status

• Recurring or nonrecurring appointments with the current date as
the start date

• Call reports ending on the current date

Total Open Opportunities Campaign to Opportunity The total number of open opportunities associated with a campaign

Total Won Opportunities Campaign to Opportunity The total number of won opportunities associated with a campaign
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Total Revenue from Opportunities Campaign to Opportunity The total revenue from the open opportunities associated with a
campaign

Total Opportunities Campaign to Opportunity The total number of opportunities associated with a campaign

Total Revenue from Open Opportunities Campaign to Opportunity The total revenue from the open opportunities associated with a
campaign

Total Revenue from Won Opportunities Campaign to Opportunity The total revenue from the won opportunities associated with a
campaign

Total Converted Leads Campaign to Sales Lead The total number of converted leads associated with a campaign

Total Leads Campaign to Sales Lead The total number of leads from a campaign

Total Hot Open Leads Campaign to Sales Lead The total number of unqualified or qualified leads ranked as hot that are
associated with a campaign

Total Open Leads Campaign to Sales Lead The total number of unqualified or qualified open leads associated with
a campaign

Total Revenue from Open Leads Campaign to Sales Lead The total amount from the unqualified and qualified leads associated
with a campaign

Total Emails Sent Opportunity to Interaction The total number of emails sent in the context of an opportunity

Total Touches Opportunity to Interaction The total number of email and calls made in the context of an
opportunity

Last Email Sent Opportunity to Interaction The date when the last email was sent in the context of an opportunity

Total Calls Made Opportunity to Interaction The total number of calls made in the context of an opportunity

Last Call Made Opportunity to Interaction The date when the last call was made in the context of an opportunity

Last Touch Date Opportunity to Interaction The date when the last call or email sent in the context of an opportunity

Total Open Activities Opportunity to Activity The cumulative total of:
 

• Tasks that are open and not in completed or canceled status

• Recurring or nonrecurring appointments with the current date as
the start date

• Call reports ending on the current date

Where Salespeople See Rollups  
Salespeople can see rollups in three different ways:

• On panels in work areas

• As search criteria

• As group-by options
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Rollups on Panels
Rollups display on panels in Digital Sales work areas, such as Accounts, so that your sales team gets quick insights. The
screenshot shows the Rollups tab on the left pane and the rollup attributes shown in a table.

In CX Sales, salespeople can see rollups in the Rollups subtab on the object pages you enable. This screenshot shows
the Rollups tab on the left pane and the rollup attributes shown in a table:
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Rollups as Search Criteria
You can enable using rollups as search criteria on the landing pages. This helps salespeople search for accounts and
contacts based on a rollup value.

Here’s a screenshot of the Accounts landing page that shows an example of searching for accounts based on the
hierarchy number of open leads:

In CX Sales, salespeople can use rollups as search criteria in Workspace.

Rollups as Group By Options
You can help sales team find accounts and contacts that belong to a similar grouping based on rollups.

565



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 37
Rollups

Here’s a screenshot that shows four account hierarchies with 5 to 30 open opportunities and two accounts that have
more than 30 opportunities:

Setup Tasks  

What are the steps to set up rollups?  
Here’s a summary of how to define rollups for Sales. All the privileges, setups, and tasks involved in setting up rollups
for both the classic and Redwood user experience is provided.

This table provides the initial setup steps for rollups, navigation, brief description, and where to get more details.

Step Applies
To

Description Navigation Where to Get the Details

1 Both
classic
and
Redwood
user
experience

Add the Manage Rollup Metrics privilege to a copy
of the Sales Administrator job role (ORA_ZBS_
SALES_ADMINISTRATOR_JOB). To the role, add users
responsible for configuring and setting up rollups.

Navigator > Tools > Security
Console > Roles

See the Edit Job or Abstract Roles
topic in the Securing Sales and
Fusion Service guide for more
information.

2 Both
classic
and
Redwood
user
experience

Verify that these scheduled processes appear on the
Scheduled Process page:
 

• Rollup Full Refresh

• Rollup Account Hierarchy and Linked Records
Refresh

• Rollup Incremental Refresh

Navigator > Tools  > Scheduled
Processes

See the Run Scheduled
Processes for Rollups topic in the
Implementing Sales guide for
more information.
See also the Scheduled Processes
chapter of the Understanding
Scheduled Processes guide.
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Step Applies
To

Description Navigation Where to Get the Details

When you unpublish or delete a rollup, the Data
Cleanup scheduled process prompts you to clear the
data.

2 Both
classic
and
Redwood
user
experience

After adding the privileges for the users, they get
access to the Rollups setup page. Enable the Rollup
Test Enabled profile option (ORA_ZCA_TEST_
ROLLUPS), to display the Test tab on the Rollups
setup page.

Setup and Maintenance >
Sales > Sales Foundation >
Manage Administrator Profile
Values

See the Test and Publish the
Rollups topic in the Implementing
Sales guide for more information.

3 Both
classic
and
Redwood
user
experience
(optional)

When creating new rollups, you can reuse the rollup
attributes of unpublished rollups or create custom
attributes and publish them. The custom attributes
will be available on the Rollups setup page.

Application Composer >
Standard Objects > Account >
Account Rollups >  Fields
Navigation is similar for contact
rollups and other object rollups.
 

See the information on defining
fields in the Configuring
Applications Using the
Application Composer guide.

4 Classic
user
experience
(Preferred)

Use the formula fields instead of a regular field to
create a custom attribute for rollups. Unlike regular
fields, formula fields let you build a script with rules
related to calculations.

Application Composer See the Configure Custom Rollups
Using the Formula Fields topic in
the Implementing Sales guide for
more information.

5 Classic
user
experience
(Optional)

When creating rollups that depend on fiscal year
periods, such as current quarter, use the accounting
calendar periods. The accounting calendar defines
the fiscal year and the time periods within it.

Related Object Filter on the Define
Rollups setup page.

See the Use the Accounting
Calendar Time Periods for Your
Rollups topic in the Implementing
Sales guide for more information.

6 Redwood
user
experience

Use the Visual Builder Studio to add custom rollups
to Redwood user experience pages.
You can also show the rollups on the panels in
Redwood user experience.
 

Settings and Actions > Edit Page
in Visual Builder

See these topics in the Extending
Sales in the Redwood user
experience guide:
 

• Add a Custom Field to the
Edit Contact Page

• Configure the Rollups
Region in a Panel

To access this guide, contact your
Oracle representative.
 

7 Classic
user
experience

Enable the Rollups subtab on object pages in the
Classic user experience.

Application Composer See the Show Rollup Attributes
on the Object Pages topic in the
Implementing Sales guide for
more information.

8 Both
classic
and
Redwood
user
experience
(Optional)

Enable rollups for Adaptive Search. Let salespeople
search accounts or contacts using rollups as search
criteria.

Setup and Maintenance >
Sales > Sales Foundation >
Configure Adaptive Search

See the Enable Searching for
Accounts and Contacts Using
Rollups topic in the Implementing
Sales guide for more information.

9 Redwood
user
experience
(Optional)

Enable Rollups as group by options so that
salespeople can use them to group accounts and
contacts by common attributes.

Setup and Maintenance >
Sales > Sales Foundation >
Configure Adaptive Search

See the Enable Grouping by
Rollups topic in the Implementing
Sales guide for more information.
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Here's the navigation to the Rollups setup page:

1. Go to Navigator > Configuration > Application Composer.
2. Under Advanced Setup, click Define Rollups.

Note:  You don't need to be in a sandbox to access the Define Rollups page.

Here's a sample screenshot of the Define Rollups page:

The table below describes the components of the Define Rollups page.

Callout Name Description

1 Setup
 

Shows the entire list of rollups. The list includes all published and unpublished rollups, both
predefined and custom
 
You can sort the columns by name, type (Regular or Aging), source object (Account), related object
of the rollup, published status, and the last refresh status of the rollup.
 

2 Actions
 

• Create: Use this option to create a new rollup from scratch.

• Duplicate: Use this option to create a working copy of a predefined rollup.

• Edit: Use this option to change the parameters of a custom rollup. For predefined rollups, you
can change two parameters: the hierarchy for, account rollups, and calculation frequency.

• Delete: Use this option to delete custom rollups. You can't delete predefined rollups; you can
only unpublish them.

3 Monitor
 

• Full Refresh: Run a full refresh every time you publish a rollup.

• Incremental Refresh: Schedule an incremental refresh so that published rollups are regularly
updated with the latest values. You can set this process to run once hourly.

Note:  Full refresh is used only after the rollups are published for the first time. After that,
 Incremental Refresh takes care of recalculating and publishing the rollups periodically.
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Callout Name Description

• Hierarchy Refresh: This process is applicable for account rollups only. Schedule or run a
hierarchy refresh to recalculate account rollups if a hierarchy changes.

• Data Cleanup: Schedule a data cleanup so that whenever you delete or unpublish a rollup,
 the rollup engine runs this process and clears the calculations.

4 Test
 

Test the unpublished rollups to ensure that they're producing correct calculations.
 

Work with Rollups  
Here's an overview of how to work with rollups:

The graphic here gives an overall flow for rollups:
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This table describes how to work with rollups and refers to the callouts in the graphic.

Things You Can Do Description

Use the Predefined Rollups You can use predefined rollups in three ways:
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Things You Can Do Description

  
• Use them as they are (callout 1).

• Tweak them slightly.

• Make a working copy of them.

Note:  You can't delete a predefined rollup.

Use Them as They Are (callout 1)
 
Oracle provides the predefined rollups in the Define Rollups page. You can put them to immediate use
just by publishing them and running a full refresh (callout 7).
 
Tweak Them Slightly
 
The parameters in the predefined rollups are read-only. You can tweak two things for a predefined
rollup:
 

• Exclude the hierarchy calculations from an account rollup (callout 2).

• Change the calculation frequency (callout 3).

After that, you can test your changes (callout 6), publish, and run a full refresh (callout 7) on them.
 
Create a Working Copy of a Predefined Rollup
 
You can duplicate a predefined rollup (callout 5) to get a working copy that lets you change the
parameters. After modifying, test the calculations (callout 6), publish the rollup, and run a full refresh
(callout 7).
 
Ensure that you add the rollup attributes to the Digital Sales UI through Visual Basic Studio (callout 8),
 for the calculations to appear as metrics in Digital Sales. For more information, see the "Configure the
Rollups Region in a Panel" topic in the Oracle Fusion Cloud Sales Automation Extending Digital Sales
(Next Gen Sales) guide. To access this guide, contact your Oracle representative.
 
A periodic incremental refresh updates the attributes in Digital Sales with the latest values.
 

Create a New Rollup (callout 5)
 

You can create an entirely new rollup (callout 5). Just be sure the rollup attribute you select is unique for
each rollup. You can use a rollup attribute of an unpublished rollup or create a custom attribute (callout
4).
 
After creating a rollup, you test the calculations (callout 6), publish the rollup, and run a full refresh
(callout 7). A periodic incremental refresh updates the attributes in Digital Sales with the latest values.
 
You need to add the rollup attribute to the Digital Sales UI through Visual Basic Studio (callout 8) for the
calculations to appear as a metric in Digital Sales. For more information, see the "Configure the Rollups
Region in a Panel" topic in the Oracle Fusion Cloud Sales Automation Extending Digital Sales (Next Gen
Sales) guide. To access this guide, contact your Oracle representative.
 

Note:  The same as with predefined rollups, you can exclude hierarchy calculations or change the
calculation frequency of new rollups.

Unpublish or Delete a Rollup
 

You can unpublish a predefined rollup and delete a custom rollup (callout 10). The Data Cleanup
process clears all calculations and nullifies the attributes exposed in the Digital Sales UI.
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Things You Can Do Description

Note:
Unpublished rollups continue to be available on the Rollups Setup page for future use, but the
deleted custom rollups can't be restored.
 

Predefined Rollups  

Enable Predefined Rollups  
Predefined rollups are the Oracle-provided rollups.

They are prebuilt using data from a source object and its related object. That data is further simplified using filter
criteria, thus getting meaningful metrics your team can use.

Setting up predefined rollups is easy. You just have to:

1. Test and publish the predefined rollups.
2. Run a full refresh on them.
3. Show them on panels.
4. Enable them for Adaptive Search.
5. Enable them as Group By options.

Test and Publish Predefined Rollups  
Test the rollups to ensure that they're producing the calculations you want. Here are the steps:

1. On the Define Rollups page, go to the Test tab.

Note:  Ensure that you have enabled the Rollup Test Enabled (ORA_ZCA_TEST_ROLLUPS) profile option to
see the Test tab on the Define Rollups page.

2. Select a rollup you want to test.
3. For Object Instance, select an account you want to calculate the rollup for.
4. Select the Entire Hierarchy check box if you have defined the hierarchy attribute for the rollup and want to

include the hierarchy values, as well, in the test.
5. Click Calculate.
6. In the meanwhile, you can calculate the rollups manually or use this sample URL to run a REST call on the

account rollup child:

https://<hostname:port>/crmRestApi/resources/latest/accounts/<partynumber>/child/AccountRollup

7. Compare your calculations. If you're ok with the results, publish the rollup.
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Publish the Rollup
After testing the rollups, publish them to the environment. Here are the steps:

1. Select an unpublished rollup.
2. On the Edit Rollup page, click Actions and select Publish.

Run a Full Refresh for Published Predefined Rollups  
Run a full refresh every time you publish a rollup.

Here are the steps to run a full refresh:

1. On the Define Rollups page, go to the Monitor tab.
2. Select the Full Refresh subtab.
3. Click Start Process.

It’s recommended that you schedule a full refresh once a day during the non-operational hours of your organization, to
recalculate the aging rollups. Note that a full refresh job scheduled once a day still considers the calculation frequency
set for the aging rollups before recalculating their values.

Show Predefined Rollups on Panels  
You can display rollups on panels in Digital Sales work areas, such as Accounts, so that your sales team gets quick
insights.

For more information, see the "Configure the Rollups Region in a Panel" topic in the Extending Digital Sales (Next Gen
Sales) guide. To access this guide, contact your Oracle representative.

Enable Predefined Rollups for Adaptive Search  
You can have your sales team use rollups to search for accounts and contacts.

See this topic to learn more:

• Enable Searching for Accounts and Contacts Using Rollups

Enable Predefined Rollups as Group By Options  
Let your sales team group the accounts and contacts list based on rollup values.

See this topic to learn more:

• Enable Grouping by Rollups
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Custom Rollups  

Create New Rollups  
Here are the steps to create a new rollup:

1. Enter basic details and define the source object.
2. Define the related object.
3. Define the hierarchy rollup to include the account hierarchy calculations in the rollup.
4. Define calculation frequency in Advanced Settings.

You do all of these tasks in Application Composer under Advanced Setup > Define Rollups.

Enter Basic Details and Define the Source Object
1. Enter Name and Description for the new rollup.
2. Rollup Type:

◦ Aging: Select Aging to calculate a rollup value for a specific period. For example, you want to create a
rollup for the total open activities in the last 30 days.

◦ Regular: Select Regular if the rollup you're creating doesn't have to be time-bound.

3. Source Object: Select a source object. For example, Account.

Note:  You can’t use custom objects as source objects.

4. Rollup Attribute: This attribute stores the rollup value. For example, the Last Call Made and Open Opportunity
Revenue attributes show the rollup values in the Accounts area of Digital Sales.

If you're creating a custom rollup for CX Sales, you can use the formula fields to build a rollup attribute. See the
Configure Custom Rollups Using the Formula Fields topic to learn more.

5. Source Object Filter: This field is enabled for source object rollups that don't need a related object, such as
Total Number of Employees.

Use this field to create rules. For example, you can create a rule to calculate the Total Number of Employees for
only accounts or only prospects.

Note:  Source Object Filter isn't supported if the application needs to traverse the hierarchy, because it
impacts performance.
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Define the Related Object
The related object fields are available for selection only when the Rollup Attribute belongs to non-account objects, such
as Opportunity, Activity, or Service Request.

1. Related Object: This field shows the objects related to the source object. For example, if the source object is
Account, its related objects, such as Contact, Activity, Interaction, Sales Lead, Opportunity, Quotes and Orders,
and Service Requests, show up in the list.

Note:  You can’t use custom objects as related objects.

◦ The Maximum Number of Days for Data Selection field is enabled for interaction-based rollups, such
as Total Calls Made and Total Open Activities. The maximum is 120 days and this is the default value. The
rollup engine uses the data from the past 120 days until today to calculate the rollup.

2. Relationship: Select the relationship between the source object and the related object. For example, select
Account-to-Opportunity if the related object is Opportunity.

3. Aggregate Function: Select the function you want the rollup to perform for the related rollup attribute. The
functions shown in the drop-down list depend on the Rollup Attribute you selected under Source Object. Here
are the available options:

◦ Count: Select Count if you want a total number. For example, calls made to an account or number of
employees.

◦ Sum: Select Sum if you want to get a cumulative total. For example, revenue from all the open
opportunities of an account.

◦ Maximum: Maximum is used to identify the last call made or the last email sent when you're tracking the
last Creation Date for an activity. Maximum doesn't work for the number of calls made.

◦ Minimum: Minimum is used to identify the first call made or the first email sent when you're tracking the
first Creation Date for an activity.

4. Related Attribute: This is the attribute of the Related Object used to calculate the rollup.
◦ Example 1: Use Creation Date from the Interactions object to calculate the date of the most recent call

made to an account.
◦ Example 2: Use Amount from the Opportunity object to calculate the Total Potential Revenue from Open

Opportunities.
5. Related Object Filter: Use this field to create rules around the related object. For example, write a query

like this to aggregate Total Potential Revenue from only qualified and unqualified open leads: StatusCode IN
('QUALIFIED', 'UNQUALIFIED') AND DEAL AMOUNT IS NULL.

If you want to calculate a rollup based on the fiscal year periods of the accounting calendar for CX Sales, can
use the period tokens when building the Related Object Filter criteria. See the Use the Accounting Calendar
Time Periods for Your Rollups topic to learn more.

Include Hierarchy Changes
This section is relevant only for Account rollups.

1. Hierarchy Rollup: Select the check box to include hierarchies in the Account rollups.
2. Hierarchy Rollup Attribute: This field stores the aggregated value from the Account and its child accounts.
3. Aggregation Function: This field shows the same aggregate function you defined for the Related Object. You

must select a value here if the rollup is a source object rollup, such as an Account rollup.

Define Advanced Settings
You define the calculation frequency of a rollup under the Advanced Settings. See the topic, Change the Calculation
Frequency of a Rollup, to learn more.
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After you're done, click Save and Close to save the rollup.

Test and Publish the Rollups  
Test unpublished rollups to ensure that they're producing the calculations you want.

Here are the steps:

1. Go to the Test tab on the Rollups page.

Note:  Ensure that you have enabled the Rollup Test Enabled (ORA_ZCA_TEST_ROLLUPS) profile option to
see the Test tab on the Define Rollups page.

2. Select a rollup you want to test.
3. For Object Instance, select an account you want to calculate the rollup for.
4. Select the Entire Hierarchy check box if you have defined the hierarchy attribute for the rollup and want to

include the hierarchy values, as well, in the test.
5. Click Calculate.
6. In the meanwhile, you can calculate manually or use this sample URL to run a REST call on an account rollup

child:
https://<hostname:port>/crmRestApi/resources/latest/accounts/<partynumber>/child/AccountRollup.

7. Compare your calculations. If you're ok with the results, publish the rollup.

Publish the Rollups
After testing the rollups, publish them:

1. Select an unpublished rollup.
2. On the Edit Rollup page, click Actions and select Publish.

Run a Full Refresh
Next, run a full refresh to get the latest data:

1. Go to the Monitor tab.
2. Select the Full Refresh sub-tab.
3. Click Start Process.

See the Run Scheduled Processes for Rollups topic to learn more about all the processes available for rollups.

Configure Custom Rollups Using the Formula Fields  
Use the formula fields instead of a regular field to create a custom attribute for rollups. Unlike regular fields, formula
fields let you build a script with rules related to calculations.

Another advantage with formula fields is that you can show multiple values on a single field, which is suitable for rollup
attributes.

Below are the high-level steps for using formula fields to show custom rollups:

1. Create custom formula fields.
2. Add the formula fields to the object page.
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3. Create custom rollups to populate the data of the formula fields.
Let’s apply these steps and create a couple of example rollups for the Account and Contact object pages.

Example Account Rollups Created Using Formula Fields  
In this example, we'll create two account rollups using formula fields, and then we'll show them on the Account Profile
page. Our example rollups are:

• Total Open Opportunities

• Total Revenue from Open Opportunities of an account and the child accounts in its hierarchy

Step 1: Create Custom Formula Fields
Create two new formula fields for Total Open Opportunities and Total Revenue from Open Opportunities. Here’s how
you do it:

1. Enter an active sandbox. From the Navigator, go to Configuration > Application Composer > Standard
Objects > Account > Fields.

2. On the Fields page, click Actions > Create.
3. Select Formula and click OK.

To learn more about the formula fields, read the Formula Fields topic in the Configuring Applications Using
Application Composer guide.
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4. Create a formula field for Total Open Opportunities:
a. On the Create Formula Field page, enter Total Open Opportunities for Display Label, and enter the same

name, but without spaces, in the Name field.

Here's a sample image of the Create Formula Field page:

5. Click Next.
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6. On the Configure Expression page, enter an expression the engine should consider when calculating the field
value. For example, use this expression to indicate that the engine must not calculate when the number of
opportunities for an account is zero:
(AccountRollup?.NumberOfOpenOpportunities)?:0;

Here's a sample image of the example expression:

7. Click Submit.
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8. Create a formula field for the Total Open Opportunities Revenue rollup:
a. Follow the procedures given in steps 2 and 3.
b. On the Create Formula Field page, enter Total Open Opportunities Revenue for Display Label, and enter

the same name, without spaces, in the Name field.
c. For Display Type, select Multiline Text Area.

The formula field appears as a multiline text area to display two rollup fields. In this example, the two
rollup fields are SumOfOpenOpportunitiesRevenue and HierSumOfOpenOpportunitiesRevenue -- one for the
account and another for its hierarchy.

Here's a sample image of the Create Formula Field: Describe Field page:

9. Click Next.
10. On the Configure Expression page, do this:

a. In the expression for the formula field, create a variable to store the sum of opportunity revenues for an
account. Create another variable to store the sum of opportunity revenues from an account hierarchy. In
this example, the variables are thisAccountOptyRevn and hierAccountOptyRevn.

b. Ensure that the expression evaluates whether the value of the opportunity revenue is zero. If it is zero,
set the variable to null. Also, evaluate whether the value of the opportunity revenue from an account
hierarchy is zero. If it's zero, don’t display the account hierarchy rollup.

c. To write the expression, select the field from the list corresponding to the Rollup object. In this
case, Account Rollups is a child of Account, and it has a 1:1 relationship with the Account object.
Once you select the Account Rollup, the Rollup fields appear on the list. You can reference the
fields easily and insert them to the script palette to write the expression. In this case, use the fields
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AccountRollup?.SumOfOpenOpportunitiesRevenue and AccountRollup?.HierSumOfOpenOpportunitiesRevenue
in your expression. These are the custom rollups you created in the previous step.

11. Build an expression like the sample here:
def thisAccountOptyRevn = (AccountRollup?.SumOfOpenOpportunitiesRevenue)?:0;
def hierAccountOptyRevn = (AccountRollup?.HierSumOfOpenOpportunitiesRevenue)?:0;
def str = "";
if( hierAccountOptyRevn == 0 )
{
 str = sprintf("\$%,.2f",thisAccountOptyRevn);
}
else
{
 str = sprintf("For this Account: \$%,.2f\nFor the Account Hierarchy: \$%,.2f", thisAccountOptyRevn,
 hierAccountOptyRevn);
}
return str;

Here's a sample image of the Create Formula Field: Configure Expression page:

12. Click Submit.

Step 2: Add the Formula Fields to the Account Profile Page

1. Enter an active sandbox.
2. From the Navigator, go to Configuration > Application Composer > Standard Objects > Account  > Pages >

Application Pages > Details Page Layouts.
3. Create a copy of the Details Layout and add the two custom fields you created in step 1: Total Open

Opportunities and Hierarchy Total Open Opportunities Revenue.
4. Save your changes.

Step 3: Create Custom Rollups to Populate the Data of the Formula Fields

1. Exit the sandbox and navigate to Application Composer > Define Rollups.
2. Create rollups for Total Open Opportunities and Hierarchy Total Open Opportunity Revenue.
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3. When creating the rollups, assign the formula fields you created as a Rollup Attribute and a Hierarchy Rollup
Attribute, respectively.

4. Test your rollup.
5. Run a full refresh on the rollup.
6. Publish the rollup.

For detailed steps, see the What are the steps to set up rollups? topic.

At the end of the configuration, the two rollups you created appear on the Edit Account: Profile page. Here's a sample
image:

Example Contact Rollups Created Using the Formula Fields  
In this example, we will create four contact rollups using only one formula field, and then we'll show the rollups on the
Contact Profile page. Our example rollups are:

• Total Touches with a Contact

• Last Touch with a Contact

• Number of Open Service Requests Created by a Contact

• Number of Critical Open Service Requests Created by a Contact

Step 1: Create Custom Formula Fields

1. Enter an active sandbox. From the Navigator, go to Configuration > Application Composer > Standard
Objects > Contact > Fields.

2. On the Fields page, click Actions > Create.
3. Select Formula and click OK.

To learn more about the formula fields, read the Formula Fields topic in the Configuring Applications Using
Application Composer guide.

4. On the Create Formula Field page, enter Contact Engagement for Display Label, and enter the same name, but
without spaces, in the Name field.
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5. For Display Type, select Multiline Text Area.

6. Click Next.
7. On the Configure Expression page, build an expression that can show the following attributes in a single field:

◦ Number of touches.

◦ The last touch with the contact.

◦ The number or open service requests.

◦ Critical open service requests associated with the contact.

Touches refer to the total Emails sent, or calls made to a contact. The expression evaluates the number
of open or critical service requests. You can add a string to the expression to display a friendly message if
there are no SRs associated with a contact. Here's a sample expression you can build for the field:

Display name: Contact Engagement (Custom field: ContactEngagement_c):
/*
Total Touches with Contact:
Last touch being: ?
Note that the contact has x Service request of which x are critical
No outstanding SRs
*/
def contactLastTouchDate = ContactRollup?.LastTouchDate
def contactNumTouches = (ContactRollup?.NumberOfTouches)?:0;
def contactCriticalSrs = (ContactRollup?.NumberOfOpenCriticalServiceRequests)?:0;
def contactSrs = (ContactRollup?.NumberOfOpenServiceRequests)?: 0;
def str = "";
if( contactNumTouches > (BigDecimal)0 )
 str = "Total touches with contact: " + contactNumTouches + "\n";
if( contactLastTouchDate )
 str = str + "Last touch being: " + contactLastTouchDate.format("M/d/yyyy") + "\n";
if( contactSrs )
{
 str = str + "This contact has " + contactSrs + " open service request";
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 if( contactSrs > (BigDecimal) 1 ) // plural for service request?
 str = str+ "s";
 if( contactCriticalSrs )
 {
 str = str + ", " +contactCriticalSrs+ " critical!";
 }
}
else
{
 str = str + "There are no outstanding Service Requests for this contact";
}
return str;

8. Click Submit.

Step 2: Add the Formula Field to the Contact Profile Page

1. Enter an active sandbox. From the navigator, go to Configuration > Application Composer > Standard
Objects > Contact > Pages > Application Pages > Details Page Layouts.

2. Create a copy of the Details layout and add the Customer Engagement field you created in the step 1.
3. Save your changes.

Step 3: Create a Custom Rollup to Populate the Data of the Formula Field

1. Come out of the sandbox and navigate to Application Composer > Define Rollups.
2. Create a custom rollup and assign the Contact Engagement formula field as a rollup attribute.
3. Test your rollup.
4. Run a full refresh on the rollup.
5. Publish the rollup.

For detailed steps, see the What are the steps to set up rollups? topic.

At the end of the configuration, you can see the rollup showing all four attributes in a single field on the Edit Contact:
Profile page. Here's a sample image:
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Additional Configurations  

Exclude Hierarchy for the Account Rollups  
Here's how to exclude the hierarchy from an account rollup calculation:

1. Select an account rollup.
2. Scroll down to the Define Hierarchy Rollup section.
3. Deselect the Hierarchy Rollup check box.

4. Click Save and Close.
The rollup engine excludes the hierarchy from the rollup calculations in its next run.

Change the Calculation Frequency of a Rollup  
Calculation frequency indicates how often the rollup engine should recalculate the rollup values. By default, the
frequency for Aging rollups is once a day, and for Regular rollups, it's once an hour.

Here's how you change the frequency:

1. Open a rollup.
2. Under Advanced Settings in the edit page, change the Calculation Frequency of the rollup.
3. Maximum Number of Days for Data Selection: This field appears only for Interaction and Activity-based

aging rollups, such as Total Calls Made and Total Open Activities. The maximum is 120 days, and this is the
default value. The rollup engine uses the data from the past 120 days until today to calculate the rollup.

Note:  Ensure that the number of days is within 120 to avoid performance slowdown during a full refresh.

4. Click Save and Close.
The rollup engine uses the new frequency in its next run.

Refer to Create Rollups to learn more about Aging and Regular rollups.

Run Scheduled Processes for Rollups  
The Monitor tab on the Define Rollups page contains these scheduled processes that you can run for rollups:

• Rollup Full Refresh
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• Rollup Account Hierarchy and Linked Records Refresh

• Rollup Incremental Refresh

• Data Cleanup

Full Refresh Process
Run a full refresh every time you publish a rollup. Here are the steps to trigger a full refresh:

1. Publish a rollup.
2. Go to Monitor > Full Refresh.
3. Click Start Process to run the Rollup Full Refresh scheduled process.

After the full refresh completes, your users can see the rollup value as a metric in the Digital Sales UI.
Also, it’s recommended that you schedule a full refresh once in a day during the non-operational hours of your
organization.

Note:  The full refresh job, when scheduled once a day, considers the calculation frequency set for aging
rollups before recalculating their values.

Enforce Recalculation

A full refresh doesn’t run any previously published rollups. This is because the volume of records that the rollup engine
has to process is too high, affecting the performance. If you want to recalculate a previously published rollup, use the
Enforce Recalculation option to include it in the full refresh.

Here's how you can use the Enforce Recalculation option:

1. Open a previously published rollup.
2. On the Edit Rollups page, click Actions and select Enforce Recalculation.
3. Go to Monitor > Full Refresh.
4. Click Start Process.

After the full refresh completes, your users can see the latest rollup value in the Digital Sales UI.

Incremental Refresh Process
The Rollup Incremental Refresh scheduled process runs automatically at scheduled intervals to update published
rollups with the latest calculations. This process is necessary because changes made to contacts, opportunities, leads,
activities, or other related objects, affect the rollup values. The Rollup Incremental Refresh scheduled process is based
on the Calculation Frequency set for the rollups.

Note:  Set the frequency to schedule the Rollup Incremental Refresh process. On the Monitor tab, you can see the
status of the process, but you can't run it manually.

Rollup Account Hierarchy and Linked Records Refresh
The Rollup Account Hierarchy and Linked Records Refresh is only for accounts.

The rollup engine doesn't register changes you make to the account hierarchy. So, run the Hierarchy Refresh process
whenever you change or delete an account node. The recommended frequency is to run this job every 24 hours.

1. Go to the Monitor > Hierarchy Refresh.
2. Click Start Process to run the Rollup Account Hierarchy and Linked Records Refresh scheduled process.
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Note:  Instead of running the Rollup Account Hierarchy and Linked Records Refresh process manually every
time, you can schedule a daily refresh.

Data Cleanup Process
When you unpublish or delete a rollup, the application prompts you to clear up the data.

• Select Initialize on Schedule to let the Data Cleanup scheduled process clear the data.

• Select Initialize Now to initiate the data cleanup immediately.

Rollup and Adaptive Search Scheduled Process Considerations
You must run a rollup Full Refresh each time there's a change to a rollup configuration. A change to the configuration
results whenever a rollup object is created, deleted, published, or unpublished. Once the full refresh process is
completed for the rollup, run the Adaptive Search Partial Publish indexing process to publish only those objects that
have changed their configuration.

For example, if you create a rollup called Num Of Open Opty to calculate the number of open opportunities for the
Account object, then after running a Full Refresh, you perform the one time activity of running an Adaptive Search
Partial Publish for the Account object as follows:

1. Run the Partial Process from the Actions menu in the Advanced tab of the Configure Adaptive Search setup
task.

2. Once the Num Of Open Opty rollup is available in your Workspace for Account, run the Rollup Incremental
Refresh scheduled process job to create an indexing request after an hour (default configuration) and the
subsequent Adaptive Search Periodic Refresh  will index the new rollup.

Note:  This is applicable only for regular (non aging) rollups. The Rollup Incremental Refresh scheduled
process runs automatically at scheduled intervals to update published rollups with the latest calculations.

3. You can schedule a Full Refresh for any existing aging rollups that are available in Workspace. The
recommended schedule for the rollup Full Refresh is once a day but you can schedule it to run more frequently
depending on your requirements.

The Adaptive Search Periodic Refresh scheduled process must be completed before the latest rollup data will
be available in Workspace. The Periodic Refresh process enables you to search for imported records or records
updated by background processes and will be available for search after the indexing process completes.

Note:  This is applicable only for aging rollups.

4. You can choose to recalculate a previously published rollup by selecting the Enforce Recalculation option to
include it in the full refresh of the rollup. So, at any point, if your rollup data is available in Workspace and you
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select the Enforce Recalculation option, the subsequent Adaptive Search Periodic Refresh will sync the latest
data in Workspace.

Use the Accounting Calendar Time Periods for Your Rollups  
When creating rollups that depend on fiscal year periods, such as current quarter, use the accounting calendar periods.
The accounting calendar defines the fiscal year and the time periods within it.

Therefore, the periods that are set based on the accounting calendar are useful when calculating rollups like Revenue
from the last fiscal quarter.

In the sales application, predefined period tokens are available that are created based on the accounting calendar time
periods.

Accounting Calendar Period Tokens for Rollups
This table lists the period tokens based on the accounting calendar. You use the tokens given in the Token column to
define the periods for your rollups.

Note:  Ensure that your accounting calendar supports weekly periods before using the week-related tokens for
rollups. The week-related tokens are: GL_WTD, GL_PWTD, and GL_PW.

Accounting Calendar Period Tokens

# Token Meaning Attribute Description

1 GL_WTD Week-to-date glweekToDate() The period from the beginning of the current week until today.
For example, the current date is Thursday, March 10, and
the first day of the week is set in the accounting calendar as
Monday. The week-to-date period will be from Monday, March
7, to Thursday, March 10.

2 GL_MTD Month-to-date glmonthToDate() The period from the first day of the current month until today.
For example, the current date is March 10. The month-to-date
period will be March 1 to 10.

3 GL_QTD Quarter-to-date glquarterToDate() The period from the first day of the current quarter until today.
For example, if the first day of the current quarter is January 1
and the current date is March 10, the quarter-to-date period will
be January 1 to March 10.

4 GL_YTD Year-to-date glyearToDate() The period from the first day of the current fiscal year until
today. For example, if the first day of your current fiscal year is
January 1, the year-to-date period will be January 1 to March 10.

5 GL_PWTD Previous Week-to-
date

glpreviousWeekToDate() The period from the first day of the previous week until today.
For example, if the week begins on Monday, the previous week-
to-date period will be from Monday of the last week until today.

6 GL_PMTD Previous Month-to-
date

glpreviousMonthToDate() The period from the first day of the previous month until
today. For example, if the current date is March 10, the previous
month-to-date period will be February 1 to March 10.

7 GL_PQTD Previous Quarter-
to-date

glpreviousQuarterToDate() The period from the first day of the previous quarter until today.
For example, if the first day of the previous quarter was October
1, 2021, and the current date is March 10, 2022, the previous
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# Token Meaning Attribute Description

quarter-to-date period will be October 1, 2021, of the previous
year, to March 10, 2022.

8 GL_PYTD Previous Year-to-
date

glpreviousYearToDate() The period from the first day of the previous fiscal year until
today. For example, if the first day of your previous fiscal year
was January 1, 2021, the year-to-date period will be January 1,
2021, to March 10, 2022.

9 GL_PW Previous Week glpreviousWeek() The period from the first day of the previous week until the end
of the week.

10 GL_PM Previous Month glpreviousMonth() The period from the first day of the previous month until the
end of the month.

11 GL_PQ Previous Quarter glpreviousQuarter() The period from the first day of the previous quarter until the
end of the quarter.

12 GL_PY Previous Year glpreviousYear() The period from the first day of the previous fiscal year until the
end of the fiscal year.

How to Use an Accounting Calendar Token in a Rollup
When creating a rollup, you write a query into the Related Object Filter field, defining all the conditions that a rollup
needs to consider while calculating the aggregated value. For example, you want to create a rollup that calculates
revenue from qualified and unqualified leads. In this case, your Source Object is Account, the Related Object is Lead,
and the Related Object Filter query is:

StatusCode IN ('QUALIFIED', 'UNQUALIFIED') AND DEAL AMOUNT IS NOT NULL

This query adds up the revenue or deal amount associated with the qualified and unqualified leads and shows the
aggregated value for the rollup.

Now, let’s say you want to calculate the revenue from the previous quarter of the accounting calendar. You need to add
the period token, GL_PQ, to the query, as shown below:

StatusCode IN ('QUALIFIED', 'UNQUALIFIED') AND DEAL AMOUNT IS NOT NULL AND LastAssignmentDate=:GL_PQ

Show Rollups  

Show Rollup Attributes on the Object Pages  
To show the rollup attributes on the object pages of the sales application, you need to create a custom subtab of type,
child object.

To learn more about subtabs, see the information on custom subtabs in the Configuring Applications Using the
Application Composer guide.
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In the Create Subtab layout, do this:

1. Select the Data Object (callout 1). For example, select Account Rollups if you're adding a Rollups subtab for the
Account object.

◦ The Data Object name you selected is copied into the Display Label field (callout 2). You can change the
label. A display icon (callout 3) is auto-assigned to the subtab. You can change the icon, too.

◦ Based on the data object you selected, the Available Fields area (callout 4) in the Configure Summary
Table region shows the rollups relevant for that object. For example, if your data object is Account
Rollups, the Available Fields shows the entire list of account rollups.

2. From the Available Fields are (callout 4), select the rollups you want to add to the subtab and click the right-
arrow (callout 5) to move them to the Selected Fields area (callout 6).

3. Click Next (callout 7).
4. Click Save and Close.

The Rollups subtab displays on the object details page.

Search Using Rollups  

Enable Searching for Accounts and Contacts Using Rollups  
Enable rollups for Adaptive Search to let your salespeople search accounts and contacts using rollups in Digital Sales.

1. In the Setup and Maintenance work area, use the Configure Adaptive Search task:
◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click Setup in the left navigation pane and click the Advanced tab.
3. Under Advanced, expand Account > Account Rollup, and select Account Rollup.

You can see all the account and hierarchy rollups.
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◦ Select the Enable check box for the account and hierarchy rollups you want to use as the search criteria
and save.

4. To enable the contact rollups, expand Contact > Contact Rollup and select Contact Rollup.

◦ Select the Enable check box for the contact rollups you want to use as the search criteria and save.

5. Click Actions and select Partial Publish.
a. On the Partial Publish window, select Account and Contact.
b. Click Proceed with Partial Publish.

On the Partial Publish window, the Account and Contact objects are shown as selected under the Existing
objects to republish header.

c. Click Publish.

The publishing process begins. To monitor the progress, go to Monitor > Publish.
6. Next, go to Configure UI.
7. On the Configure UI page, select Display in UI for the rollups you just enabled and save your changes.
8. Next, publish the objects again.

a. Click Actions and select Partial Publish.
b. On the Partial Publish window, select Account and Contact.
c. Click Proceed with Partial Publish.

On the Partial Publish window, the Account and Contact objects are shown as selected under the Existing
objects to republish header.

d. Click Publish.

The publishing process begins. To monitor the progress, go to Monitor > Publish.

Your sales team can use the rollups you enabled as search criteria in accounts and contacts.

Scenarios When Enabling Rollups for Adaptive Search
You may need to consider the scenarios shown in the table and then take required action before and after enabling your
rollups for Adaptive Search.

Scenario# Scenario Required Action

1 You want to publish a rollup that uses existing
attributes.

1. If it’s a custom rollup, create the rollup. If it’s a predefined rollup,
 review the settings before publishing.

2. Publish the rollup.
3. Run a full refresh on your published rollup.
4. Enable the rollup attribute for Adaptive Search.
5. Select the object and publish it.

2 You want to create a new rollup that uses
custom attributes.

1. Add the custom attribute to Application Composer and publish the
sandbox.

2. Create the rollup and publish it.
3. Run a full refresh on your published rollup.
4. Enable the rollup attribute for Adaptive Search.
5. Select the object and publish it.

3 • You have rollups of type, Aging, that are
already published.

1. Skip the rollups publish and enable the rollup attribute for Adaptive
Search directly.

2. Select the object and publish it.
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Scenario# Scenario Required Action

• You have done a mass recalculation on
all the published rollups.

Related Topics
• Search Using Hierarchy Rollups

• Search for Contacts Using Rollups

Enable Grouping by Rollups  
Let your salespeople use rollups as criteria to group accounts and contacts.

When you enable rollups to be the group by criteria, they appear in the Group By drop-down list in the Accounts or
Contacts list view pages.

The screenshot below highlights a rollup appearing as a Group By option:

Here’s how you configure rollups as the Group By criteria:

1. In the Setup and Maintenance work area, use the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click Setup in the left navigation pane and click the Advanced tab.
3. Under Advanced, expand Account > Account Rollup and select Account Rollup.

You can see all the account and hierarchy rollups.

◦ Select the Enable check box for the account and hierarchy rollups and save.
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4. To enable the contact rollups, expand Contact > Contact Rollup and select Contact Rollup.
◦ Select the Enable check box for the contact rollups you want to use as the search criteria and save.

5. Click Actions and select Partial Publish.
a. On the Partial Publish window, select Account and Contact.
b. Click Proceed with Partial Publish.

On the Partial Publish window, the Account and Contact objects are shown as selected under the Existing
objects to republish header.

c. Click Publish.
The publishing process begins. To monitor the progress, go to Monitor > Publish.

6. Next, click Configure UI in the left navigation pane.
7. Expand Account > Account Rollups.

a. Search for the rollups you want to enable as the Group By criteria.
b. Select Display in UI.
c. Assign a filter group for the rollup.

To learn more about the filter groups, see the Create Groupings of Values for Display in Search Filters
topic in Advanced Setup in the Adaptive Search and Workspace chapter of the Implementation Reference
guide.
The Enable for Group By check box is enabled only after you assign the filter group.

d. Select the Enable for Group By check box. Here's a screenshot of the Configure page that highlights
enabling the group by option for a sample account rollup:

e. Click Save.
8. Next, go to Contacts > Contact Rollups from Configure UI.

a. Search for the rollups you want to enable as the Group By criteria.
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b. Select Display in UI.
c. Assign a filter group for the rollup.

To learn more about the filter groups, see the Create Groupings of Values for Display in Search Filters
topic in Advanced Setup in the Adaptive Search and Workspace chapter of the Implementation Reference
guide.

The Enable for Group By check box is enabled only after you assign the filter group.
d. Select the Enable for Group By check box.
e. Click Save and Close.

9. Next, publish the objects.
a. Click Actions and select Partial Publish.
b. On the Partial Publish window, select Account and Contact.
c. Click Proceed with Partial Publish.

On the Partial Publish window, the Account and Contact objects are shown as selected under the Existing
objects to republish header.

d. Click Publish.

The publishing process begins. To monitor the progress, go to Monitor > Publish.

The Account and Contact rollups you enabled appear in the Group By dropdown.

Related Topics
• Group Your Accounts and Contacts List by Rollup Values

Remove Rollups  

Unpublish a Predefined Rollup  
Here are the steps to unpublish a predefined rollup:

1. Select the predefined rollup that you want to unpublish.
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2. On the Edit Rollup page, click Actions and select Unpublish.

A warning message appears showing two options: Initialize on Schedule or Initialize Now:

◦ Initialize on Schedule: Select this option to clean up the data whenever the next scheduled Data
Cleanup process for initialization runs.

◦ Initialize Now: Select this option to trigger the Data Cleanup scheduled process immediately.

The data calculated for the rollups is deleted, and the corresponding attributes in the Digital Sales UI are
nullified and automatically hidden from the UI. The unpublished rollups are still available on the Rollups Setup
page for future use.

Delete a Custom Rollup  
Here are the steps to delete a custom rollup:

Note:  You can't restore custom rollups after you delete them.

1. Select the custom rollup that you want to delete.
2. On the Edit Rollup page, click Actions, and then select Unpublish.

A warning message appears showing two options: Initialize on Schedule or Initialize Now:

◦ Initialize on Schedule: Select this option to trigger a data cleanup whenever a scheduled Data Cleanup
process runs.

◦ Initialize Now: Select this option to trigger the data cleanup immediately.

The data calculated for the rollups is deleted and the corresponding attributes in the Digital Sales UI are
nullified and automatically hidden from the UI. Remove the rollup attribute from the Digital Sales UI and also
from Adaptive Search so that it's not available in search any more.

Remove a Rollup from Adaptive Search  
To remove a rollup from being a search criterion in Digital Sales, you must remove the rollup attribute from Adaptive
Search.

This table covers the scenarios and the course of action you must take for removing the rollups as search options:
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Scenario# Scenario Required Action

1 You want to unpublish or delete a rollup
and abandon the corresponding rollup
attribute.

1. Unpublish or delete the rollup.
2. Run a data cleanup job or wait for a scheduled full refresh job to complete.
3. Follow the steps given in the Remove a Rollup from Adaptive Search topic to

enable the rollup attribute for Adaptive Search.
4. Select the object and publish it.

2 You want to change the attribute in
a published rollup and abandon the
previously used rollup attribute.

1. Edit the rollup and change the attribute you used. Save your changes.
2. Publish the rollup and run a full refresh.
3. If it’s a custom attribute, remove the attribute from the object in Application

Composer and publish the sandbox.
4. Follow the steps given in the Remove a Rollup from Adaptive Search topic to

enable the rollup attribute for Adaptive Search.
5. Select the object and publish it.

Here's how you remove the rollup attributes from Adaptive Search:

1. In the Setup and Maintenance work area, use the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click Setup in the left navigation pane and click the Advanced tab.
3. Under Advanced, expand Account > Account Rollup and select Account Rollup.

You can see all the account and hierarchy rollups.

◦ Unselect the Enable check box for the account and hierarchy rollups you want to disable and save.

4. To disable contact rollups, expand Contact > Contact Rollup and select Contact Rollup.

◦ Unselect the Enable check box for the contact rollups you want to disable and save.

5. Click Actions and select Partial Publish.
a. On the Partial Publish window, select Account and Contact.
b. Click Proceed with Partial Publish.

On the Partial Publish window, the Account and Contact objects are shown as selected under the Existing
objects to republish header.

c. Click Publish.

The publishing process begins. To monitor the progress, go to Monitor > Publish.
6. Next, go to Configure UI.
7. On the configure UI page, unselect Display in UI for the rollups you just enabled and save your changes.
8. Next, publish the objects again.

a. Click Actions and select Partial Publish.
b. On the Partial Publish window, select Account and Contact.
c. Click Proceed with Partial Publish.

On the Partial Publish window, the Account and Contact objects are shown as selected under the Existing
objects to republish header.

d. Click Publish.

The publishing process begins. To monitor the progress, go to Monitor > Publish.
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Rollups are disabled from Adaptive Search.
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38  Routines

Overview of Routines  
Routines are a programmed set of actions that let sales administrators automate data hygiene and process compliance
tasks to ensure teams have accurate and current data.

For example, to reduce risk and enforce data integrity, you can create routines to update fields, send email notifications,
and create tasks based on rules. Routines can help salespeople be more efficient and productive.

Let’s say you want to retire aging leads or close tasks open for more than 90 days. You create a routine to retrieve and
filter records meeting specified rules, and, upon a trigger, perform actions within the context of those records. Routines
are scheduled to run at certain predefined intervals, and the associated rule conditions can also be based on specific
time intervals.

The key components of a routine are:

• Trigger

A trigger is something that starts the routine run process. It's based on a schedule event, such as daily, weekly,
monthly, or yearly, and in some cases, a routine run process can be triggered on an event.

Note:  Redwood User Experience (UX) users will have access to additional triggers to specify when the routine
runs. For example, in addition to the defined recurring schedules, they can choose to run the routine as soon
as an attribute is changed or when a record is created, updated, or deleted.

• Rule

A rule contains a set of conditions that a record must meet before an action can be performed.

• Action

An action is a business task performed on records that meet the rule conditions.

Take this example of a schedule-driven routine:

Every day, update all leads older than 30 days to inactive

In this scenario, Every day is the trigger, older than 30 days is the rule, and update lead to inactive is the action.

How do I access the Routines dashboard?  
Sales administrators and users with the appropriate access privileges can view and create routines from the routines
dashboard. Other sales users can get access to configure and manage routines based on granting the appropriate
functional privilege to their roles.

Before you start

599



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 38
Routines

To use routines, you must have access to Application Composer and must have the Manage Routines privilege
(ZCA_MANAGE_ROUTINES). This privilege is available to the following roles by default:

• Application Implementation Consultant

• Sales Administrator

• Customer Relationship Management Application Administrator

Note:  If you're working with custom objects, you will also require the ORA_CRM_EXTN_ROLE role.

Here's how to access the routines dashboard:

1. Open Application Composer by selecting Configuration > Application Composer  in the Navigator menu.
2. Under the Common Setup Menu, click Routines to open the Routines dashboard.

Overview of Routines Dashboard  
If you have access to Application Composer and have the Manage Routines privilege, then you can run and view all
routines created for your organization from the routines dashboard.

Here's an example of some routines created by administrators from the Routines dashboard:
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From the Routines dashboard, you can run a routine on demand. This means that you run a routine immediately if you
want to view the results or to re-run a routine after correcting errors.

Routines that are scheduled to run across all data for an object are denoted by the Elevated access badge. The badge
is displayed for those routines that have the Schedule routine with elevated access check box selected during the
creation of the routine.

Note:  The check box is only available to users who are assigned the ZCA_SCHEDULE_ROUTINE_APPID privilege to
their role. If you are working with custom objects, you will also require the ORA_CRM_EXTN_ROLE role.

If you're using Redwood UX, you can react in real time when a record is created, updated or deleted by triggering a
routine to run immediately. Event triggers inform stakeholders of key changes so they can respond in a relevant time
period. For example, event routines can create tasks, update fields and notify members of critical changes when the
owner is changed on a lead, opportunity or task.

Note:  The option to Schedule Routine with Elevated Access is removed because event routines are run for all records
meeting the routine trigger and rules.

Delete is also available as a quick action to delete routines that are no longer needed. When a routine is deleted, the
routine definition and history are permanently deleted.

You can also activate and pause routines and view a summary of the routines. For example, you can:

• Create, view, edit, and pause routines that are currently in process

• View schedule details

• View last run results

• View list of records processed by the routine

This table describes some of the routines processing information that you can view at a glance from the dashboard.

Status Name Object Trigger Last Run Last Failed Last Updated
Date

Actions

Status of the
routine such
as Active or
Paused.

Name of the
routine.

Business object
associated with
the routine.

Indicates how
often the
routine runs
according to
it's schedule,
 such as daily,
 weekly, monthly
or yearly.

Date of the
last run for the
routine.

The most recent
date when the
routine had a
run with errors.

Date the
routine was last
updated.

Menu action to
activate, edit,
 pause, view or
run a routine.

Select the View menu item from the Actions (three dots icon highlighted in the screenshot) menu to view a summary of
the routines that were run and to drill down to the records processed.

Select a row from the Summary section to view the details for the selected run. Here's a sample screenshot:
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Use Routine Templates  
Routine templates are routine definitions that you, as a sales administrator, can use to quickly create a routine. You can
copy a predefined routine template of your choice to help you configure routines.

Routines can often contain complex rules and actions that aren't always apparent or easily understood. For example,
past due tasks require knowledge about activity function code values and how they work. Templates contain sample
actions and rules which you can easily modify to suit your requirements when creating custom-specific routines. You
can't change the data of these predefined templates or create new templates.

Each routine template has a category defined such as Performance, Revenue, and Process and is denoted by the
relevant badge icon. The sales object type is listed underneath the short description for the template. For example, the
Create Quote template is associated with the Opportunity object and helps you configure a routine to create quotes
automatically for selected opportunities. The Create Quote predefined template is only available if you have enabled
Quotes. For more information see Integrating CX Sales with Oracle CPQ guide.

Here's a sample screenshot of some of the routine templates that are available to use.

Note:  You can click Skip Templates if you don't want to use one of the predefined templates to help create your
routine.
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List of Predefined Routine Templates
This table lists the predefined template name, short description, and category for the different sales objects.

Object Name Description Category

Activity Past Due Tasks Notify owners when tasks are overdue. Select overdue tasks by
priority and object to customize notification for critical tasks.

Performance

Conversation
Messages

Close Email Activities Automatically close a task when the associated email is sent.
Only available with Redwood UX.

Process

Interaction Close Web Conference
Activities

Automatically close an appointment or task when the associated
web conference interaction is complete. Only available with
Redwood UX.

Process

Interaction
Reference

Close Activities Automatically close an appointment or task when the associated
call interaction is complete. Only available with Redwood UX.

Process

Opportunity Create Quote Create quotes automatically for selected opportunities. Only
available if you have enabled Quotes.

Revenue

Opportunity Past Close Date Push out opportunities that are past their close date. Performance

Upcoming Opportunity
Close Date

Get opportunities across the finish line. Performance

Stale Opportunity Follow-up Follow-up on opportunities that haven't been updated in more
than 60 days. For example, create a follow-up task for the owner
or retire automatically.

Performance

Opportunity without Quote Improve team performance with follow-up requests for
opportunities without quotes.

Performance

Quotes and
Orders

Create Proposal Create proposals for quoted opportunities. Only available if you
have enabled Quotes. For more information see Integrating CX
Sales with Oracle CPQ guide.

Revenue

Sales Lead Stale Lead Follow-up Follow-up on leads that haven't been updated in more than 60
days. For example, create a follow-up task for the owner or retire
automatically.

Performance

Automate Repeated Tasks with Routines  
Create routines to do repeated tasks and free up time for your sales organization to focus on selling.

Watch video
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You can create a routine to alert your users when opportunities are stuck and require attention to move them along
the sales cycle. Or you can update obsolete or outdated information and provide timely and relevant reminders for
salespeople to focus on key customers.

Actions and rules instruct the routine what activity to perform on an object. For example, rules tell the routine which
sales leads to process for the actions. You can group rules together and select whether all or any of the criteria must be
met. You can include all or any of the group rules and there's a limit of 15 rules per group. Specify rules which need to be
met in order for the routine to perform a certain action. You create and deploy the routine from the dashboard. Routines
run on a recurring schedule, defined as daily, weekly, monthly and yearly and are scheduled through the Enterprise
Scheduling Service (ESS) process.

Note:  If you’re using Redwood UX, you will have access to additional triggers to specify when the routine runs.

When you submit the routine, it's scheduled to run at the allocated time unless you choose to set pause for the specified
run.

Create a Routine  
Here's how to create a routine without selecting any of the predefined templates.

1. Navigate to Configuration > Application Composer > Common Setup > Routines to access the Routines
Dashboard.

2. Click Create Routine and then click Skip Templates.
3. From the Basic Details section, enter a name and brief description for the routine and select the object you

want from the object drop-down list.

You can also create routines for child objects as well such as lead and opportunity contacts, opportunity
revenue, interaction references, and include their parent attributes in the rules.

Note:  If you change the object as you proceed through the guided process, then any actions and rules for
that object will be cleared automatically. You'll need to enter actions and rules again for the object you want.

4. Click Next.
5. From the Trigger section, select the frequency for which you want this routine to run from the list of available

triggers.

You can select from Hourly, Daily, Weekly, Monthly, or Yearly. In addition to the predefined frequency triggers,
Redwood UX users will have the option to run the routine as soon as an attribute is changed or when a record
is created, updated, or deleted. You can select up to 5 attributes if you choose to select the Attribute changed
option.

6. Select the Schedule routine with elevated accesscheck box if you want to schedule the routine
to run across all data for an object. Note that this check box is only available to users assigned the
CA_SCHEDULE_ROUTINE_APPID privilege to their role.
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7. Click Next to go to the Actions section as follows.

8. From the Selected Actions area, select the Action Type you want from the drop-down list.

Fields marked updateable in Application Composer are available in the attribute list for the Field Update action.
9. Add the attributes and associated values for the selected Action Type and click the plus ( + ) icon to add

additional attributes for the selected action type.
10. Click Add Action to add other action types. Click Next when finished to add rules for your action types.
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11. From the Rules section, set up the rules and conditions that you want to meet to trigger the routine. Any
recommendations based on your selected actions will be populated.
Fields specified as searchable in Application Composer are available in Rules from the attribute list.

Note:  You can group conditions to create more complex rules. Within a group you can choose to include any
or all the conditions and choose to include any or all groups.

For key objects such as Account, Contact, Opportunity, and Sales Lead, you can add dependency rules by
clicking the Add Dependent Group button as highlighted in this sample screenshot. Any dependent rule groups
you add are added to the parent rules.

a. Select Include all groups if you want all rule conditions to be met in order for the routine to perform a
certain action. Or, select Include any group if you want any of the rules to trigger the action.

b. Click Add Dependent Group to add a dependency rule condition for the selected groups area.
c. Click Add Group to add a rule condition from the selected groups area.

12. Add the attributes and associated values for the selected group options.
13. Click Next to preview or edit your routine.
14. Click Submit to create your routine.

Supported Objects and Associated Actions for Sales
Routines  
Sales administrators and users with the appropriate access privileges can view and create routines from the routines
dashboard. Other sales users can get access to configure and manage routines based on granting the appropriate
functional privilege to their roles.

The following table lists the supported sales parent objects and their predefined associated action types for sales
routines:
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Supported Sales Parent Objects for Routines and Associated Action Types

Parent Object Action Type

Account • Field Update

• Create Task

• Send Email

Activity • Field Update

• Send Email

Asset • Field Update

Business Plan • Field Update

• Send Email

Campaign • Field Update

Case • Field Update

• Send Email

Contact • Field Update

• Create Task

• Send Email

Conversation
 

• Field Update

Custom Objects • Field Update

• Send Email - available only if email annotations is enabled

Household • Field Update

• Send Email

Interaction • Field Update

• Close Activity

• Send Email

Opportunity • Create Quote

Note:  You must have Quotes configured to create a quote from the opportunity.

• Create Task

• Field Update

• Send Email

Partner • Field Update
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Parent Object Action Type

Partner Enrollments • Field Update

• Send Email

Product • Field Update

Product Structure • Field Update

Quotes and Orders • Field Update

• Create Proposal

Resource • Field Update

• Send Email

Sales Competitor • Field Update

Sales Lead • Field Update

• Convert

• Create Task

• Send Email

Service Request • Field Update

• Send Email

Subscription • Field Update

• Send Email

Note:  Not all the supported objects are sales objects. For example, Partner and Partner Enrollments are only
pertinent for Partner Relationship Management, and Service Request are specific to Fusion Service. You can also
access and manage any custom objects or custom child objects that your administrator created in Application
Composer.

The following table lists the supported child sales objects and their predefined associated action types for sales
routines:

Supported Sales Child Objects for Routines and Associated Action Types

Child Object Action Type

Component • Field Update

Conversation Message • Field Update

• Close Activity

Conversation Reference • Field Update

610



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 38
Routines

Child Object Action Type

Custom Child Objects • Field Update

• Send Email - available only if email annotations is enabled

Interaction Reference • Field Update

• Close Activity

Opportunity Contact • Field Update

• Send Email

Opportunity Revenue • Field Update

• Send Email

Sales Lead Contact • Field Update

• Send Email

Use Custom Smart Actions Routines
As a sales administrator, you might want to create a routine to use object functions on both standard and custom
objects. You can now use custom smart actions to perform custom processes in routines, such as API or object function
calls. For example, if a lead owner doesn't have a sales representative role, then you can create a custom smart action
to remove the owner so the lead gets reassigned. Other examples of where a custom smart action could be used in
routines might be if you want to update a custom field with a formula.

You can create custom smart actions for routines as needed in Application Composer. Any custom smart actions that
you create will show in your routines only if you selected Routines in the  Application as shown is this sample Create
Smart Action page.
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See Overview of Smart Actions for information about how to use and create smart actions.

Object functions are groovy scripts that are defined for an object in Application Composer and are created in a
sandbox. See the Object Functions section of the Configuring Applications Using Application Composer guide for more
information about object functions.

Note:  Object functions are only callable by event routines and Accounts and Contacts don't support object function
calls.
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About Scheduling Routines  
Understanding scheduling can help you determine the optimal recurrence period when creating routines. Routines run
on a recurring schedule, defined as hourly, daily, weekly, monthly, and yearly.

To schedule and run routines, you must have the appropriate privileges and job roles. For example:

• You must first already have access to Routines via the privilege, ZCA_MANAGE_ROUTINES.

• The ZCA_SCHEDULE_ROUTINE_APPID privilege must be assigned to the desired role. If you are working with
custom objects, you will also require the ORA_CRM_EXTN_ROLE role.

During the trigger step of the Create Routine work flow, you can select the Schedule routine with elevated access
check box if you want to schedule the routine to run across all data for an object. Once a routine is created with elevated
access, the access can't be changed.

Routines are scheduled through the Enterprise Scheduling Service (ESS) process and are included as part of your daily
application processing.

For optimal performance, the application:

• Divides each day into 24 available time slots

• Assigns a maximum of 5 routines to start for each time slot

• Sets a maximum limit of 10,000 rows a routine can process per time slot.

Once a routine is assigned a day and time slot, it continues to run on that specific day and time. The application
schedules to run routines between days 1 to 28 of the month.

Here's a table that lists the maximum number of routines in a day for each schedule period and the maximum number
of routines that can be run for a schedule period.

Routine Scheduling Details

Schedule Time Periods Total Daily Time Slots Total Time Slots per Period

Hourly 24 Hourly routines are limited to 250 records per
run.

Daily 80 Schedule up to 80 routines daily.

Weekly 20 Schedule up to 140 routines weekly.

Monthly 15 Schedule up to 420 routines monthly.

Yearly 5 Schedule up to 1,680 routines yearly.
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Rules  

Dependency Rules for Key Objects  
You can add dependency rules when creating routines for key objects such as accounts, contacts, leads and
opportunities.

Routines are designed to perform a specific action based on a set of rules. As a sales administrator, you can create
and update simple, lightweight routines to help sales representatives, administrators, and data stewards to automate
an action for pertinent sales information. Routines can scan records to evaluate if they meet conditions over a period
of time. For example, you might want to create a routine to scan all opportunities that haven't be updated in past few
weeks.

This table lists the dependency rules associated with key objects when creating a routine.

Object Dependency Rule

Account • Address

• Sales Team Member

Contact • Address

• Sales Team Member

Opportunity • Opportunity Competitor

• Opportunity Contact

• Opportunity Team Member

• Opportunity Revenue

Sales Lead • Sales Lead Contacts

• Sales Lead Products

• Sales Lead Resources

• Sales Lead Territories

• Opportunities

You set up the rules and conditions that you want to meet in order to trigger the routine. From the Rules section of the
Create Routine guided process, you can group conditions to create more complex rules and choose to include all or any
of the groups.

For key objects such as Account, Contact, Opportunity, and Sales Lead, you can add dependency rules by clicking the
Add Dependent Group button. Here is a sample of where you add rules for the Opportunity dependent objects.
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Enter Run Date Values for Routine Rules  
When setting rules for date-based related attribute such as Last Update Date, Creation Date, Close Date and so on,
selecting the equals ( = ) operator lets you choose from the Run Date and Select Date options.

Routines also let you specify date variables to calculate the date based on the routine run date, plus or minus a specific
number of days in integer format. For example, for the Update Field and Create Task actions you can create a task
or update a field with a due date of the routine run date plus 7 days. This means that if all routines rules are met, the
routine will continue to process and update records 7 days past the specified due date.

Here's how to enter run date values for date-related attributes when creating rules.

1. From the Routines dashboard, click Create Routine.
2. Enter the name and a brief description of what the routine is used for and select the object you want for your

routine.
3. From the Actions section, click Add Action and select the Action Type you want.
4. From the Rules section, set up the rules and conditions that you want to meet in order to trigger the routine.

Note:  If you want to set a value for, let’s say, the opportunity Close Date attribute, then if you select the
"since" operators, you get additional options to select either a specific quarter, such as This Quarter, Next
Quarter or Last Quarter. You can also select a flexible run date, or you can set a specific calendar date.Also,
when you select Run Date, you can select a plus or minus operator to either add or subtract a number of days
value to the set run date. For example, you can select the plus operator to enter a numeral in the Value field.

5. Schedule, review and click Submit when done.
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FAQ for Routines  

Frequently Asked Questions (FAQs) for Routines  
This section contains some frequently asked questions (FAQs) when working with routines.

Scroll or search to find answers to common questions.

How do I pause routines?  
You can view routines from the dashboard at any stage. Once you create a routine, the application schedules it to run at
the next available slot. If you want to stop a routine from running, select the Pause menu item from the Actions (three
dots icon) menu. You can click Activate to restart the routine process again for your routine.

Why can't I find the attribute I want to update for my routine?  
Only attributes defined as Updateable in Application Composer are available for use in the Field Update action. In
addition, attributes available in the Rules section must also be set as Searchable in Application Composer.

When must I specify the currency code in my routine?  
If you're updating currency amounts, you must specify the currency code in the rules section and field update action for
your routine.

Can I stop actions being performed on the same records?  
You can stop actions being performed on the same record each time you run a routine.

Rules are applied to select records for processing when a routines runs. If you don’t want the actions performed on the
same records each time, then include rules that exclude previously run records.

Let's say you have a routine that updates the record status to Won for opportunities with a Close Date in the last quarter.
To ensure that those records already updated to the won status aren't processed again, you can insert a rule that checks
only for all opportunity records with a status of not equal to Won.

Why can't I add another rule to my routine group?  
A maximum of 15 rules is allowed per group for a routine. You can add another group to specify additional rules.
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What is the difference between Attribute Changed and Record
Updated triggers?  
The Attribute Changed trigger is the recommended trigger for change event routines where you can enter up to 5
fields. For example, a routine runs (or is triggered) when the specified number of fields change on the record.

However, in some scenarios, you may need to enter more than 5 change fields to trigger the routine. In such cases, you
can use the Record Changed trigger which causes the routine to run whenever the record is updated.

Note:  In a future release, the specified number of fields for the Attribute Changed trigger will increase from 5 fields,
and the Record Changed trigger will no longer be needed for new routines.
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39  Quoting

Overview of the Oracle Sales and Oracle CPQ Integration 

The integration between Oracle Sales and Oracle CPQ supports standard B2B selling processes, which feature highly
configurable products, variable or dynamic pricing models, discount negotiations requiring executive approval, and
large, branded sales documents.

Oracle CPQ ensures that sales forecasts are reliable and based on real-world quotes. It ensures that sales orders are
valid and contain the correct billing and shipping details to eliminate costly change orders. Additionally, quote data
feeds back into Sales, so that businesses can analyze and improve the overall efficiency of their sales teams.

The integration steps help you configure a solution that combines the power of these applications, while reducing the
cost of ownership and the time needed to deploy the application. However, the integration remains configurable and
extensible, so it can support a wide range of use cases serving any industry. For more information, see Overview of
Planning Your Implementation.

619

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u29999119
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u29999119


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 39
Quoting

620



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 40
Email Templates and Sales Guides

40  Email Templates and Sales Guides

Create Email Templates  
You can create email templates that can be used both by salespeople and by automated processes in orchestrations.
You create the templates for a specific object and can include attributes from that object as mail merge fields.
Salespeople who are using the template to send emails to customers can modify the text, and add their signatures and
attachments.

Before you start
If you want to send HTML emails with images, then you must author the HTML ahead of time and copy it into the
template. Any images must be referenced by URLs. Salespeople reviewing the emails before sending them don't see the
HTML code.

Here's what to do

1. Open Application Composer.
2. Click Message Templates.

Note:  Don't click Email Templates by a mistake. That's a different feature entirely.

3. On the Manage Message Templates page, click Create.
4. Give the template a name and description. Salespeople see the name when they select the template.
5. Select the object. A template can be used only for sending emails for the object. For example, salespeople who email

a customer from a leads record only see the active leads email templates.
6. If you don't want to make the template available for use while you're drafting it, switch the Active switch off.

Templates are active by default.
7. Enter the subject and message content.

Use the Attributes list to insert the mail-merge fields.

Tip:  If the meaning of the attribute isn't intuitive, click the attribute to add it as a merge field to see its
technical name. Some of the attributes in the list have the same name. For example, for Opportunities, there
are two attributes with the name "Account". The technical name for the first is TargetPartyId. The second is
TargetPartyName.

8. Save.

Create Interactive Scripts (Sales Guides)  
You can create interactive scripts that salespeople can follow during calls with customers or use for assessing the quality
of an opportunity, for example. During calls, the scripts, called sales guides, can update information in opportunities
and leads as the call progresses and present different follow-up questions, depending on the previous answers. To
create sales guides, you use Oracle Intelligent Advisor, an application that you must license separately. To make the
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sales guides available to salespeople in Sales in the Redwood user experience, you must enable the appropriate smart
actions using Application Composer.

1. Follow the instructions in the Intelligent Advisor documentation to set up the connection to your sales
application and author the sales guides (called interviews in Intelligent Advisor documentation). The following
topic provides and overview of the setup and links to the details: Build Sales Guides.

From this overview, you can download a sales guide template that includes settings required for all sales
guides. You can use the template to create your sales guides. If you create sales guides from scratch, you must
ensure that you include the required settings listed in the topic.

2. To make the sales guides you author available in Sales in the Redwood user experience, you must enable the
Show Guides and Start Guide smart actions in Application Composer. See the topic: Enable Sales Guide Smart
Actions for the Action Bar .

Salespeople can get a list of the enabled interviews by entering Show Guides in the Action Bar. They can start
the interview by entering Start Guide.

Related Topics
• Overview of Smart Actions

Enable Sales Guide Smart Actions for the Action Bar  
Salespeople can display a list of sales guides and start using a guide by entering actions in the Action Bar. You must
enable these smart actions in Application Composer.

1. Navigate to Configuration > Sandboxes and create and enter a sandbox with Application Composer.
2. Open Application Composer from the sandbox Tools menu.
3. In Application Composer, click Smart Actions, available under Common Setup.
4. Search for guide using the search box.
5. Enable the following 4 smart actions, by setting the Enabled attribute to Yes:

Name Object

Show Guides Sales Lead

Start Guide Sales Lead

Start Guide Opportunity

Show Guides Opportunity

6. Publish the sandbox by selecting Publish from the menu which appears on the sandbox name.

Related Topics
• Overview of Smart Actions

• Overview of Sandboxes
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Create Interactive Scripts (Sales Guides)  
You can create interactive scripts that salespeople can follow during calls with customers or use for assessing the quality
of an opportunity, for example. During calls, the scripts, called sales guides, can update information in opportunities
and leads as the call progresses and present different follow-up questions, depending on the previous answers. To
create sales guides, you use Oracle Intelligent Advisor, an application that you must license separately. To make the
sales guides available to salespeople in Sales in the Redwood user experience, you must enable the appropriate smart
actions using Application Composer.

1. Follow the instructions in the Intelligent Advisor documentation to set up the connection to your sales
application and author the sales guides (called interviews in Intelligent Advisor documentation). The following
topic provides and overview of the setup and links to the details: Build Sales Guides.

From this overview, you can download a sales guide template that includes settings required for all sales
guides. You can use the template to create your sales guides. If you create sales guides from scratch, you must
ensure that you include the required settings listed in the topic.

2. To make the sales guides you author available in Sales in the Redwood user experience, you must enable the
Show Guides and Start Guide smart actions in Application Composer. See the topic: Enable Sales Guide Smart
Actions for the Action Bar .

Salespeople can get a list of the enabled interviews by entering Show Guides in the Action Bar. They can start
the interview by entering Start Guide.

Related Topics
• Overview of Smart Actions

Enable Sales Guide Smart Actions for the Action Bar  
Salespeople can display a list of sales guides and start using a guide by entering actions in the Action Bar. You must
enable these smart actions in Application Composer.

1. Navigate to Configuration > Sandboxes and create and enter a sandbox with Application Composer.
2. Open Application Composer from the sandbox Tools menu.
3. In Application Composer, click Smart Actions, available under Common Setup.
4. Search for guide using the search box.
5. Enable the following 4 smart actions, by setting the Enabled attribute to Yes:

Name Object

Show Guides Sales Lead

Start Guide Sales Lead
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Name Object

Start Guide Opportunity

Show Guides Opportunity

6. Publish the sandbox by selecting Publish from the menu which appears on the sandbox name.

Related Topics
• Overview of Smart Actions

• Overview of Sandboxes
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Overview of LinkedIn Sales Navigator  
LinkedIn Sales Navigator helps sales teams acquire new business, expand existing customer relationships, and
maximize sales productivity.

Oracle Sales integrates with LinkedIn Sales Navigator and maps LinkedIn profiles with sales contacts. Salespeople can
view the LinkedIn profile of a contact, find an icebreaker to connect with the contact, and get introduced to the contact.
They can send in-mails or messages from LinkedIn to stay connected - all with the goal of improving sale prospects.

To enable the integration, you need to register LinkedIn with the sales application. After that, display the LinkedIn
link for Digital Sales contacts using Oracle Visual Builder Studio and use Application Composer to enable LinkedIn for
accounts, contacts, and leads in CX Sales.

Where Does the LinkedIn Link Appear?
After the integration, the LinkedIn link appears in the contact overview. Here’s a screenshot of the contact overview
showing the link location in Reference:

In CX Sales, your sales team can use the Show LinkedIn link on the Details layout of Accounts, Contacts, and Leads.

What You Need to Have for Setting Up the Integration
You need to have these privileges and licenses:

Privileges and Licenses Required Description

Sales Administrator role Sales administrative rights to register and configure a partner application in LinkedIn.

Active LinkedIn account An active LinkedIn account and remain in agreement with the terms and conditions of your contract.
 

Note:  When you sign in to LinkedIn for the first time, you must click Allow for your authorization
consent.
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Privileges and Licenses Required Description

LinkedIn license • A LinkedIn license that includes REST API support.

• Permissions to have a fully configured application (grants approved from LinkedIn team).

• Get the client ID and client secret for the partner application.

Note:  The refresh token expiration for LinkedIn is 365 days. Salespeople will be asked to
authenticate and authorize their LinkedIn application after 365 days.

Related Topics
• See the LinkedIn Profile of a Contact

Overview of LinkedIn Sales Navigator Integration Setup  
The table here shows the setups you need to complete to integrate the LinkedIn Sales Navigator with your sales
application.

Step Applies To Description Navigation Where to Get More Details

1 Both Digital Sales and CX
Sales

Register LinkedIn Sales Navigator with
the sales application from the Setup and
Maintenance work area.

Setup and Maintenance >
Sales > Integrations >
Setup LinkedIn
Integration

See the topic: Register
LinkedIn with the Sales
Application

2 Digital Sales Enable the LinkedIn extension app in
Visual Builder Studio for Digital Sales
contacts.

Digital Sales > Contacts >
Edit Page in Visual Builder

See the topic:Enable the
LinkedIn Link Using the
Visual Builder Studio

3 CX Sales If applicable, remove the mashup content
for LinkedIn Sales Navigator for accounts.
Use Application Composer to hide
previously exposed mashup content for
LinkedIn Sales Navigator for accounts.
Mashup content may have been exposed
as a custom subtab, so you must ensure
that you remove any custom instances
of the mashup content for LinkedIn Sales
Navigator for accounts.
 

Navigator >
Configuration >
Application Composer

See the topic: Remove
Mashup Content for
LinkedIn Sales Navigator for
Accounts

4 CX Sales Enable LinkedIn Sales Navigator for
Accounts, Contacts, and Leads

Navigator >
Configuration >
Application Composer

See the topic:Enable
LinkedIn Sales Navigator
for Accounts, Contacts, and
Leads
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Register LinkedIn with the Sales Application  
You need to register LinkedIn with the sales application:

1. In the Setup and Maintenance work area, use the Setup LinkedIn Integration task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Task: Setup LinkedIn Integration

The Create LinkedIn Application page appears that shows Unique ID, Name, OAuth Redirect URL, and
Whitelisted Domains prefilled with details.

Unique ID Unique ID that represents the customer identifier

Name Display name of the child application

OAuth Redirect URL Contains the URL of your pod information

Whitelisted Domains Domains approved for authorized access to data

2. Click Create.

The LinkedIn Application page shows two additional fields: Application ID and Application Key.

Application ID Client ID value, used during OAuth 2.0 token request flow.

Application Key Client Secret value, used during OAuth 2.0 token request flow.

Related Topics
• See the LinkedIn Profile of a Contact

Enable the LinkedIn Link Using the Visual Builder Studio  

1. Create a workspace in Visual Builder Studio.

See "Create Your Own Workspace" in the Oracle Fusion Cloud Sales Automation Extending Digital Sales (Next
Gen Sales) guide. To access this guide, contact your Oracle representative.

2. Sign in to the sales application and Visual Builder Studio simultaneously.
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3. In Digital Sales, open the page you want to add LinkedIn to. For example, if you want to add LinkedIn to the
Contact foldout view, navigate to Digital Sales > Contacts and select a contact from the landing page.
The Contact foldout view appears.

a. On the Contact foldout view, click your username in the global header and select Edit Page in Visual
Builder.

4. In the Visual Builder Studio, open the Workspace you just created and go to the Variables tab.
Here's a screenshot of the Variables tab that shows the LinkedIn extension app under the Constants header.
The Variables tab, LinkedInExtn, Default Value field, and the play icon on the page are highlighted using
callouts from 1 to 4.

a. In the Variables tab (callout 1), under the Constants header, select showLinkedinExtn (callout 2).
b. On the right-side pane, enter True for Default Value (callout 3).

5. Click the play icon (callout 4) to see the preview of the page with the LinkedIn link.
6. Click Publish.

The LinkedIn link appears in a contact's basic information.
Also refer to the See the LinkedIn Profile of a Contact topic in the Using Digital Sales guide.

Remove Mashup Content for LinkedIn Sales Navigator
for Accounts  
Follow these steps to remove previously exposed mashup content for LinkedIn Sales Navigator for accounts.

1. Sign in as a sales administrator or as a setup user.
2. Create and activate a sandbox.
3. Click Navigator  > Configuration >  Application Composer.
4. In the Objects navigation tree, expand Standard Objects and then expand Account.
5. Click the Pages node.
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6. Ensure that the Application Pages tab is selected.
7. In the Edit Account region, select the existing layout where LinkedIn mashup content is already exposed.

Note:  Mashup content could also have been exposed as a custom subtab, so you must ensure to remove any
custom instances of the mashup content for LinkedIn Sales Navigator for accounts.

8. In the existing Details Layout page, click the icon for the Profile subtab.
9. Click the Hide link for the LinkedIn mashup content.

10. Click Done.
11. Publish the sandbox.
12. Verify that the LinkedIn Sales Navigator is no longer visible on the Edit Account: Profile page for an account.
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Enable LinkedIn Sales Navigator for Accounts, Contacts,
and Leads  
The LinkedIn integration maps LinkedIn profiles with sales records and renders relevant contact and lead details
to salespeople. Salespeople can target, understand, and engage with contacts and leads directly within the sales
application.

Let your salespeople access LinkedIn Sales Navigator from an account profile page, a contact's profile page, or from the
edit lead page. Use the Application Composer to enable LinkedIn on the Details layouts of the object pages.

Note:  The integration doesn't synchronize data between the sales application and LinkedIn; therefore data isn't
stored in either application.

Enable LinkedIn Sales Navigator for Accounts
1. Enter an active sandbox.
2. Click Navigator  > Configuration >  Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand Contact.
4. Click the Pages node.
5. Ensure that the Application Pages tab is selected.
6. In the Edit Account region, select the standard layout page, and then click the duplicate layout icon to duplicate

and edit the resulting copy.
7. In the new or existing Details Layout page, click the icon for the Profile subtab.

Note:  If your existing layouts had LinkedIn mashup content, then you must hide the old LinkedIn mashup
content and expose LinkedIn Sales Navigator. Mashup content could also have been exposed as a custom
subtab, so you must ensure to remove any custom instances of the mashup content for LinkedIn Sales
Navigator for accounts.

8. Click the Show link for the LinkedIn Sales Navigator region. Here's a screenshot of the Account Details layout,
highlighting the Show button next to the LinkedIn Sales Navigator option.
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9. Click Done.
10. Publish the sandbox.
11. Verify that the LinkedIn Sales Navigator is enabled on the Edit Account: Profile page for an account.

For more information about extending application pages and creating a custom layout, see the Configuring Applications
Using Application Composer guide.

Enable LinkedIn Sales Navigator for Contacts
1. In the Objects navigation tree of Application Composer, expand Standard Objects and then expand Contact.
2. Click the Pages node.
3. Ensure that the Application Pages tab is selected.
4. In the Edit Contact region, select the standard layout page, and then click the duplicate layout icon to duplicate

and edit the resulting copy.
5. In the new Details Layout page, click the icon for the Profile subtab.
6. Click the Show link for the LinkedIn Sales Navigator region.
7. Click Done.
8. Publish the sandbox.
9. Verify that the LinkedIn Sales Navigator is enabled on the Edit Contact: Profile page for a contact.

Enable LinkedIn Sales Navigator for Leads
1. In the Objects navigation tree of Application Composer, expand Standard Objects and then expand Sales

Lead.
2. Click the Pages node.
3. Ensure that the Application Pages tab is selected.
4. In the Details Page Layouts region, select the standard layout page.
5. Click the duplicate details layout icon to duplicate and edit the resulting copy.
6. In the new Details Layout page, click the icon for the Summary subtab.
7. Click the Show link for the LinkedIn Sales Navigator region.
8. Click Done.
9. Publish the sandbox.

10. Verify that the LinkedIn Sales Navigator is enabled on the Edit Lead page for a lead.

Additional Information  

Supported Platforms for the LinkedIn and Sales Integration  
LinkedIn supports the current and last major revision of these desktop browsers, and recommends moving to one of
these as soon as possible for a better and improved user experience.

• Google Chrome

• Mozilla Firefox

• Microsoft Edge

• Apple Safari
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Note:  LinkedIn no longer supports Microsoft Internet Explorer 11 (or below).

For mobile applications, LinkedIn supports the current and previous major releases of the following browsers:

• Google Chrome

• Microsoft Edge

• Apple Safari

• Android-based web browsers

Disable Restrictive Security Settings
If your browser is set to block third-party cookies, then the security setting must either be disabled. Alternatively, you
can add https://www.linkedin.com as an allowed domain. For example, an iframe may not load if the security settings
of the browser are very restrictive. If the domain of the application being loaded isn't linkedin.com, enable third-party
cookies or JavaScript within the browser to load the iframe.
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Enable the Oracle Eloqua Profiler Link  
Digital Sales integrates with Oracle Eloqua to provide enhanced details about your contacts and leads. With this
integration, sales representatives can view Eloqua Profiler directly from Digital Sales for a contact or lead.

This direct access to Eloqua means that sales representatives can gain immediate insights into the quality of
interactions your contacts have had with your website and marketing emails. They can also view details about leads
coming directly from Eloqua. To enable this integration, you must display the Eloqua link on the contact and lead UIs.
You do this in Oracle Visual Builder Studio.

Where Does the Eloqua Link Appear?
Once enabled, the Eloqua link displays in a contact or lead's basic information region. When you drill down to a record
from a list page, the basic information region displays at the top of the page, under the contact or lead name.

Here's an example of the basic information region for a lead. Notice the Eloqua Digital Profile link displays to the right
of the basic information region.

Here's an example of the basic information region for a contact. On a contact, the link displays to the right of the basic
information region, as well, but the link is called Eloqua.

Sales representatives can click the link in the basic information region to open Eloqua Profiler for a contact or lead in a
new browser tab.
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If sales representatives aren't yet signed in to Eloqua, then they must sign in first.

634



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 43
Eloqua Integration

Create VB Studio Workspace
Before you can work in VB Studio, you must first create your own workspace.

1. Navigate to your instance of Visual Builder Studio using the URL provided to you.

You can also obtain the URL by navigating from your Oracle Cloud Applications development instance. From
the Navigator, under Configuration, select Visual Builder.

2. Click the Workspaces tab on the left pane, then click Clone from Git.
3. In the Clone from Git dialog, enter these values:

Field Value

Workspace name
 

Enter the name of your workspace.
 

Repository Name
 

Select the Git repository connected to your team's project. Ask your administrator for this value.
 

Branch
 

Select main.
 

"New branch from selected" check box
 

Select this check box.
 

New branch name
 

Enter a name for your branch.
 

Development Environment
 

Select Development.
 

Sandbox (optional)
 

You can leave this blank and attach a sandbox to your workspace later, if required.
 

4. Click Create.

For more information, see "Create Your Own Workspace" in the Oracle Fusion Cloud Sales Automation Extending Digital
Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

Enable the Eloqua Link
Now that you have a workspace, you can use VB Studio to display the Eloqua link on both the contact and lead UIs. Do
this procedure twice: once for contacts and once for leads.

1. In Digital Sales, navigate to the page that displays the area you want to extend. In this example, navigate to the
My Open Leads page and then click a lead to view its details.

For contacts, navigate to the My Contacts page and then click a contact.
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2. Under the Settings and Actions menu, select Edit Page in Visual Builder.

3. Select the project that's already set up for you. If only one project exists, then you will automatically land in that
project.
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4. VB Studio automatically opens your workspace. If more than one workspace exists, however, then you must
first pick your workspace.

Tip:  When navigating to VB Studio for the first time, you might enter into VB Studio on the Organization tab
instead of inside your project and workspace. If this happens, return to the Digital Sales page and select Edit
Page in Visual Builder again. You will be navigated to the correct page in your workspace.

When you enter into your workspace in VB Studio, you should land on the Page Designer. This is where you
create your application extension. The page that you were viewing should be displayed in the "design area."

5. Click the Variables tab.

6. In the Constants region, click the showEloquaProfiler constant.

For contacts, the constant is called showEloquaProfilerExtn.
7. In the Properties pane, enter true in the Default Value field.
8. Click the Preview button to see your changes in your runtime test environment.
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Your runtime test environment will display in a new browser tab. The Eloqua Digital Profile link is now present
in the lead's basic information region.

Note:  The link displays at runtime only if the contact or lead record has a contact email address. If no email
address exists, then the link doesn't display.

9. Remember to complete this procedure twice: once for the contact page and once for the lead page.
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Overview of Web Conference Integration Setup  
You can setup and enable Web Conference integration for your sales organization. Once integrated, salespeople can
start a Zoom or web conference meeting or schedule a zoom meeting from within their sales application.

When you complete the integration of your Digital Sales application with Zoom for Web Conferencing, users can:

• Start Zoom meetings

• Verify and update meeting participants as contacts while the meeting is ongoing

• Take notes and record the meeting outcome

Before You Begin
To activate the web conference feature, you must first raise a service request from My Oracle Support who will then
issue you with a promotion code. You must also have an active Zoom account and remain in agreement with the terms
and conditions of your contract to successfully configure the web conference and your sales application integration.
Also, note that your zoom license must include REST API support, as well as the necessary permissions to manage
meetings and recordings.

Summary of Setup Steps
Here's a summary of the steps to enable and integrate a web conference app for your sales organization.

1. Create your own OAuth Application in Zoom.

An OAuth app defines a set of Zoom APIs to allow Oracle access those APIs on your behalf. The OAuth app can
be private and doesn't need to be published. For more details, see the Create an OAuth Application in Zoom
section of the Configure Web Conference for Your Sales Application topic.

2. Instead of making repeated calls to pull data frequently from an API, such as a Zoom account, Webhooks
retrieve the required information about events that happen. The Zoom account must install your Webhook-
enabled app to authorize data flow via Webhooks. For more details, see the Enable Webhooks for Web
Conference section of the Configure Web Conference for Your Sales Application topic.

3. From your CX Sales application, navigate to the Manage Web Conference Integration task in Setup
and Maintenance to complete and activate the integration. For more details, see the Complete Your Web
Conference Integration section of the Configure Web Conference for Your Sales Application topic.

Configure Web Conference for Your Sales Application  
To active the web conference feature, you must first raise a service request from My Oracle Support who will then issue
you with a promotion code.
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Note:  You need the Configure Oracle Fusion Applications Offering privilege (ASM_CONFIGURE_OFFERING_PRIV) in
your user role to enter the promotion code in the application.

When you receive a promotion code to activate Web Conferencing, follow these steps to enter it in your sales
application.

1. Click Navigator > My Enterprise > Enterprise work area.
2. On the Enterprise Information page, click Manage Promotion Code.
3. On the Manage Promotion Codes page, click Enter Promotion Code.
4. On the Enter Promotion Code dialog box, enter the promotion code, and click Save and Close.

The promotion code you entered appears in the Part Number column on the Manage Promotion Codes page.

Once you’ve entered your promotion code, follow the steps to enable, integrate, and verify a web conference app for
your sales application.

Create an OAuth Application in Zoom
Here's how to create an OAuth application in Zoom.

1. Sign in to Zoom as a setup user with access to the Zoom Marketplace and with the necessary privileges to build
apps.

2. Navigate to your profile page and select the Advanced drop-down option.
3. From the Advanced drop-down menu, select App Marketplace. You're redirected to the App Marketplace

website.
4. Select the Develop drop-down menu (callout 1 in the screenshot), and then click Build App.

5. From the OAuth panel, click Create (callout 2 in the screenshot).
6. From the Create an OAuth app page, type your application name in the App Name field.
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7. Select the Account-level app option (callout 1) and deactivate the Would you like to publish this app on
Zoom App Marketplace? toggle (callout 2 in the screenshot).
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8. Click Create.
You're redirected to the App Credentials tab from where you can copy the Client ID and Client Secret.

Note:  The Client ID and the Client Secret are necessary to complete and activate the Zoom integration with
your sales application.

9. In the OAuth Redirect URL field, enter your platform destination URL where Zoom will send the access token
after you complete the OAuth authentication.

10. In the Whitelist URL section, insert your platform full domain in the following format: https://
[podhost:podport]/crmUI/faces/OAuthService?service=zoom.

Note:  You can also get this URL from the OAuth Redirect URL field in the Manage Web Conference
Integration task in Setup and Maintenance. See the Complete Your Web Conference Integration section
below.

11. Click Continue.
12. In the Information section, complete the Basic Information for your app by entering these details:

◦ App Long Name and Description

◦ Your Company Name

◦ Name and the Email Address of the developer in charge of the integration (as a point of contact)

13. Click Continue to move to the Features section where you can subscribe to the interested events to receive
Webhook notifications for your app. For more information, see the section Enable Webhooks for Web
Conference.

14. Click Continue again to move to the Scopes tab.
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15. Click Add Scopes and select these two scope types and associated options:

◦ Meeting - Select View and manage all user meetings

◦ Dashboard - Select View all users' meeting information on Dashboard

These two scope types are the extent of APIs that Oracles are allowed to use. Scopes provide a way to limit the
amount of access that's granted to an app.

16. Click Done to complete the creation of your OAuth application in Zoom.

Note:  This OAuth application won't be published in the Zoom marketplace.

Enable Webhooks for Web Conference
Webhooks act as a medium to notify consumer applications about events that occur in your web conference provider.
For example, Zoom implements Webhooks or callbacks to notify clients about events such as when a:

• Meeting started or completed

• Participant joined or left the meeting

• Participant joined a meeting before the host

• Participant is waiting for host to start a meeting

Instead of making repeated calls to pull data frequently from an API, such as a Zoom account, Webhooks retrieve
the required information about events that happen. The Zoom account must install your Webhook-enabled app to
authorize data flow via Webhooks.

643



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 44
Web Conference Integration

Here's how to enable Webhooks for an OAuth application in Zoom.

1. From the OAuth panel, click the Feature tab to display the My Feature page as follows:

2. Copy the Verification Token to validate an event notification request from Zoom.

Note:   This validation token is necessary to complete and activate the Zoom integration with your sales
application. See the Complete Your Web Conference Integration section for more information.
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3. Click Event Subscriptions and subscribe to the interested events to receive Webhook notifications for your app
by entering these details:

◦ Click  Add new event subscription  and select Meeting. Click the field again if you want to add
additional Event Subscriptions.

◦ Enter the Subscription Name.

◦ Select the events from available Event types that you would like to subscribe as follows.

Note:  Although you can subscribe to as many events as required for each event subscription, you can
only have a maximum of 10 event subscriptions per app.

◦ Enter a valid Event Notification Endpoint URL as shown in the following example: https://
<podhost>:<podport>/crmRestApi/webConferenceEvent/zoom.

This is the designated URL of your app where you receive Webhook POST requests, also known as event
notifications. Event notifications are sent as HTTP POST requests in JSON to the endpoint you specify in
your Marketplace app. This URL must be secured over HTTPS.

4. Click Done to complete the Webhook configuration of your OAuth application in Zoom.
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Complete Your Web Conference Integration
You're now ready to complete and activate the Zoom web conference integration for your sales application. Follow these
steps:

1. Navigate to My Enterprise >  Setup and Maintenance  > Manage Web Conference Integration. The following
screen is displayed.

2. Enter the following:

Field Value

Provider
 

Select Zoom from the drop-down list.
 

Client ID
 

Copy the value generated in the App Credentials section from the application created on Zoom
marketplace. (See step 8 in the Create an OAuth Application in Zoom section).
 

Client Secret
 

Copy the value generated in the App Credentials section from the application created on Zoom
marketplace. (See step 8 in the Create an OAuth Application in Zoom section).
 

OAuth Redirect URL
 

This pre-populated field defaults to the value you entered for the Whitelist URL in step 9 of the
Create an OAuth Application in Zoom section. It contains your pod information in the following
format:
 
https://[podhost:podport]/crmUI/faces/OAuthService?service=zoom

Service URL
 

This pre-populated field defaults to the value you entered in step 9 of the Create an OAuth
Application in Zoom section.
 
To support GDPR requirements of EU customers, you can use this URL as the base URL for all
API requests associated with EU accounts.
 
https://eu01api-www4local.zoom.us

 
For information about the Service URL, go to this URL https://marketplace.zoom.us/
docs/api-reference/introduction
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Field Value

Verification Token
 

Copy the verification token value generated in the Add Feature section from the application
created on Zoom marketplace. (See the section Enable Webhooks for Web Conference).
 

3. Click Register to initiate the OAuth process.

A new window is displayed which requests your Zoom credentials.
4. Sign in with your Zoom account details and once you're successfully authenticated, you receive this message:

Congratulations. You have successfully registered your web conference provider.

Note:  Calls to Zoom will be made with these credentials. The email address for CX Sales resources will be
used as the Zoom user ID.

5. Next, you're prompted to authorize the usages of the scopes you selected in step 15 in the Create an OAuth
Application in Zoom section.

6. Return to the Manage Web Conference Integration page and click Save and Close to complete the registration.

Verify Your Setup
Here's how to verify your setup.

1. Sign in to your sales application.
2. Create an appointment of type Web Conference.
3. Check your Zoom web profile to verify the successful creation of your meeting in Zoom (https://zoom.us/

meeting#/upcoming)

Remove a Web Conference
These steps describe how to remove a web conference integration from your sales application.

1. Sign in to CX Sales as a sales administrator.
2. Navigate to My Enterprise >  Setup and Maintenance.
3. In the Setup and Maintenance work area, click the Tasks side panel icon and then click the Search link.
4. Search for and select the Manage Web Conference Integration task.
5. In the Provider field, remove the current value and leave blank.
6. Click Save and Close.

Enable Web Conferencing for Appointments  
Enable web conferencing for appointments. This setup is required for Orchestration steps that allow salespeople to
open Zoom with the click of the Start Web Conference button.

1. In Setup and Maintenance, open the task Manage Activity Type and Subtype:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

647



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 44
Web Conference Integration

◦ Show: All Tasks

◦ Task: Manage Activity Type and Subtype

2. For the Web conference (WEB_CONFERENCE) entry, select the Appointments check box.
3. Enter a start date.
4. Click Save and Close.
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45  Sales Assistant

Overview of Sales Assistant  
Sales Assistant is a chatbot that you can use to access sales information and perform sales activities. You enter
questions or commands, and the Sales Assistant retrieves the information or acts on your requests. The Sales Assistant
reduces manual data entry, and makes it easier to view and update sales records through text in Microsoft Teams and
through either text or voice in CX Sales Mobile.

Things to note:

• Supported Channels: Microsoft Teams, CX Sales Mobile

• Supported Language: English

• Supported Objects: Accounts, Appointment, Contacts, Opportunities, Service Requests, Tasks, Sales Leads,
and Custom objects

Administrators can enable or disable different objects for each channel.

• Security:  When using Oracle Sales Assistant in Microsoft Teams, you're prompted to sign in to CX Sales via
a sign-in button the assistant sends to you when you first converse with it. After you sign in, the assistant
continues the conversation with you.

To use Oracle Sales Assistant in CX Sales Mobile, you can use the chatbot right away after you sign in to Oracle
CX Sales Mobile.

For any channels, the same functional privilege you have in CX Sales applies when entering into conversations
with the Sales Assistant.

Where to Get Help with Sales Assistant Setup
If you need help with enabling Oracle Sales Assistant, send a message to the Sales Assistant forum on Oracle Cloud
Customer Connect. Here's the URL:

https://cloudcustomerconnect.oracle.com/resources/dee2ff3bf7/summary

Related Topics
• Overview of Sales Assistant Setup

• Set Up Oracle Sales Assistant for Microsoft Teams

• Set Up Oracle Sales Assistant for CX Sales Mobile

Overview of Sales Assistant Setup  
Because Oracle Sales Assistant setup is different for each of the channels it's running in, this chapter is divided into
different sections for each channel.
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Step Setup Task Application Description Where to get more details

1
 

You must have completed
the prerequisite Oracle
Digital Assistant application
setup.
 

Oracle Identity Cloud
Service (IDCS)

Before you set up any
of the features that
use natural-language
processing, you must
perform some prerequisite
setup of Oracle Digital
Assistant:

• Set up administrator
users

• Obtain the ODA URL

• Install (pull) the
FADigitalAssistant.

• Enable the Digital
Assistant used for
Oracle Fusion Cloud
Applications

 
If you already completed
the setup for another
feature, you can skip this
step.

See the topic: Overview of
Common ODA Setup for
Sales.
 
For additional information,
 see the Oracle Digital
Assistant documentation:
Getting Started with Oracle
Digital Assistant for Cloud
Applications.
 

2 Check Adaptive Search
setup.

CX Sales You must check that
Adaptive Search is set up
and the correct fields are
enabled for Opportunity
and Activity objects.

• Opportunity: Status,
 Sales Method

• Activity: Type, Activity,
 Start Date, End Date,
 Status, Due Date

Prerequisite Adaptive
Search Setup in Sales

3
 

Configure the integration
with Microsoft Teams
 

Microsoft Teams Developer
Portal and Oracle Digital
Assistant

For Oracle Sales Assistant
for Microsoft Teams,
 involves creating an app
in the Microsoft Teams
Development Portal and a
Microsoft Teams channel in
Oracle Digital Assistant.
 

See Set Up Oracle
Sales Assistant for
Microsoft Teams for more
information.
 

4
 

Configure the integration
with CX Sales Mobile
 

Oracle Digital Assistant and
Application Composer

For Oracle Sales Assistant
for CX Sales Mobile, you
configure an Oracle Web
Channel and hook it up
to CX Sales Mobile using
Application Composer.
 

See Enable Sales Assistant
for CX Sales Mobile for
more information.
 

5
 

Use the Common
Configuration Tool to
Update Synonyms
 

Application Composer The Oracle Sales Assistant
Common Configurations
administrator tool provides
an easy way for you to
manage synonyms for
all supported channels
without having to manually
manage them in Oracle
Digital Assistant.

See the topic Use the
Common Configuration
Tool to Update Synonyms
of the Common
Configurations section for
more information about
adding synonyms to fields
and objects (if required).
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Step Setup Task Application Description Where to get more details

 

6 Periodically update the
FADigitalAssistant skill

Oracle Digital Assistant The CX Sales skill is
updated every release
and three times within
each release. You should
periodically update to the
latest version.

See the topic: Refresh the
Digital Assistants
 

Prerequisite Adaptive Search Setup in Sales  
Oracle Sales Assistant uses enabled saved searches and the high-performance search capabilities powered by Adaptive
Search. Before using the Oracle Sales Assistant, you must ensure that:

1. Adaptive Search is enabled in the CX Sales application, and that search indexing processes are run and
regularly scheduled.

2. Fields are enabled in Adaptive search for these objects:

◦ Opportunity - Status, Sales Method

◦ Activity - Type, Activity, Start Date, End Date, Status, Due Date

See Make Additional Fields Searchable, Overview of Optional Setup Tasks and the Implementation Reference
guide.

Validate Oracle Sales Assistant Configurations Using the
System Status Tool  
Use the system status tool to check if you are missing information or if you have entered incorrect data for your CX
Sales Mobile and Oracle Sales Assistant configurations.

The system status tool is available from both within and outside a sandbox environment. For example, if you access
the tool inside a sandbox, it checks the objects configured in the sandbox. Alternatively, if you are using the tool from
outside the sandbox, it checks the objects against published configurations.

Previously, you needed to be inside a sandbox to configure the channels, but now you can configure channels for Oracle
Sales Assistant outside a sandbox. This topic explains how to use the system status tool to determine if the setup for
Oracle Sales Assistant is complete and ready to use from outside a sandbox.

The system status tool helps determine whether Oracle Sales Assistant is setup correctly. It also checks whether all
aspects, such as REST APIs, are working as required for the sales assistant to function.
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Navigate to the System Status Tool from Outside a Sandbox
Here's how to access the system status tool from outside a sandbox environment.

1. Open Application Composer by selecting Application Composer under the Configuration category in the
Navigator menu.

2. Under the Common Setup Menu, click Productivity Applications Configuration.
3. Click the Oracle Sales Assistant tab to enter your channels configuration.

Note:  Click the CX Sales Mobile tab to open the System Status tool and view the current status of the CX
Sales Mobile configuration.

4. Click Save Configuration and the system status page is displayed showing the current status of your channel
configurations.

Navigate to the System Status Tool within a Sandbox
Here's how to access the system status tool from inside a sandbox environment.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes

Application Composer as an active tool.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the System Status tab to open the system status tool.

Check the System Status of Your Configuration
The system status page contains a summary of the setup information such as host, user name, and the time and date
of the last system check. The results section displays the status of the requests that were checked and you can filter by
all requests or view only request that failed.

To check the status of your Oracle Sales Assistant:

1. From the Channels Configuration page, click System Status. 

2. View the Setup Information section as follows:

◦ Host
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◦ Username

◦ Last Check

3. Check the General  section which displays the summary status of the following general items for the sales
assistant setup. Note that general checks aren't related to specific objects.

◦ CX Sales Skill Provisioning

Checks if the provisioning is correct for the environment by invoking the list skill API. An error indicates
that there’s an issue with the Oracle Digital Assistant provisioning and you must raise a service request
(SR) with the support team.

◦ CX Sales Skill Version Check

Checks the Sales skill version. The Oracle Digital Assistant list skill API only returns skills whose skill
versions match FA version, which can be used for this validation. If the list returned is empty, then this
checks to see if there is any available valid skill.

◦ Bootstrap Resources

Checks if REST APIs are working successfully in your environment.

◦ User Preferences

Checks if user preference values such as user display name, region, date format and so on can be
successfully retrieved.

◦ Adaptive Configuration

Checks if the Adaptive Search REST API is working successfully and is able to retrieve the available list of
objects which are indexed for Adaptive Search.

4. Click Channel Selection to filter objects based on the channel selected.
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5. View the status results from the Results section to view checks for the configured objects.

Note:  If you are using the system status tool from inside a sandbox, it checks the objects configured in the
sandbox. If you accessed the tool from outside a sandbox, then checks are performed on those published
configurations.

6. Click View Details to display a drawer with additional information for a request that has an error status.

Note:  If an object has any issue, then the View Details is displayed. If the object has no issues, then No
Issues is displayed.

Here are a few examples of some checks that the system status tool performs. If there's an object that is
enabled but does not have synonyms added to it, then an error will be displayed for the object. Also, if there are
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fields that have synonyms but not enabled for Adaptive Search, then an error is displayed for the object. Here's
a sample of the error details screen.

Any requests that aren’t correctly configured are marked accordingly so you can easily tell what areas needs to be
configured based on the status as follows:

Status Description

Success The Success icon means this item passes all validations and no issues are found.

Error The Error icon means this item doesn't pass all validations. This can be caused by either the request to
the server itself fails or some fields are configured incorrectly.

Hidden The Hidden icon indicates that the request is hidden in the Navigator.

Recommended The Recommended icon means this item is not configured as recommended. Although this doesn't
affect the application's functionality, you should configure the item as suggested.
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FAQs for Sales Assistant  

Can I configure channels for Oracle Sales Assistant outside a
sandbox?  
Yes. You no longer need to create and publish a sandbox to configure channels for your sales assistant.

In addition, you can use the system status tool to help validate if the configurations for Oracle Sales Assistant are all
completed and the assistant is ready to use.

Related Topics
• Validate Oracle Sales Assistant Configurations Using the System Status Tool

Microsoft Teams  

Set Up Oracle Sales Assistant for Microsoft Teams  
Enabling Oracle Sales Assistant in Microsoft Teams involves creating an app in the Microsoft Teams Development Portal
and a channel in Oracle Digital Assistant.

1. Create an app using the Developer portal in Microsoft Teams, and add a bot to the app.

Ensure that you set the following 2 options:

◦ Under the Messaging bot section, select My bot supports uploading and downloading files

◦ Under the Scope section, select Personal

◦ Note:  You can create an app using many different ways as outlined in the Microsoft Teams chapter in
the Using Oracle Digital Assistant guide.
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2. Create a channel in Oracle Digital Assistant using the bot ID and password from the bot registration as follows:

a. In a separate browser window or tab, open Oracle Digital Assistant, click Channels in the left menu, and
choose Users.

b. Click + Channel to open the Create Channel dialog.
c. Enter a name for your channel.
d. Select Microsoft Teams as the channel type.
e. Enter the Microsoft Application Id with the Microsoft Bot ID that you obtained when you created your

bot registration in the Developer portal in Microsoft Teams.
f. Enter the Microsoft Application Password  with the client secret that you obtained from your bot

registration.
g. Click Create.
h. From the Channels page, copy the WebHook URL and paste it somewhere convenient on your system.
i. Click the Route To  icon and from the drop down, select the Oracle Digital Assistant or skill that you want

to associate with the channel.
j. Select Channel Enabled.

3. Copy the WebHook URL that was generated when you created the channel and add it to the bot registration in
Microsoft Teams.

4. Test your Oracle Digital Assistant through the Chat window in Microsoft Teams.

Overview of Extending Sales Assistant for Microsoft Teams  
Microsoft Teams Composer is an easy-to-use interface designer tool in Application Composer that lets you configure
the Oracle Sales Assistant chatbot for Microsoft Teams channel users. It helps you manage which objects and fields are
visible in the chatbot.

You can create conditions to define when a page layout displays, without having to carry out specific configurations. You
can add your own custom objects to the chatbot using Microsoft Teams Composer and add page layouts in the same
way that you can with standard sales objects.

You can add a role to a chatbot feature's List, Summary, and Edit layout. For example, a user with the Sales Manager role
might want to see certain fields on an opportunity record that other sales team members won't need. You can assign
geographical regions to a page layout, which will restrict a page layout's availability to users from your selected set of
geographical regions. For example, you might want to configure a summary layout based on the Sales Representative
and Sales Manager roles, for Canada, based on an expression where the amount is less than $200,000 and the win
probability is greater than 50%.

To use this feature, you must have Oracle Sales Assistant implemented for Microsoft Teams. You can enable or disable
the objects available on the channel, which means that Microsoft Teams channel users of Sales Assistant can also view
information about custom objects.

CAUTION:  You can only configure the latest skill from the skill store that matches your current release. For example,
if the skill you want to modify is from a previous release and you're making your changes in a later release, then you
must re-base the skill your users are using to the latest skill that was modified. In addition, you must re-route the
channel to the new re-based skill so that users can start using it and perform Reset sessions in the channel UI.

Note:  If you need help with enabling Oracle Sales Assistant, send a message to the Sales Assistant forum on Oracle
Cloud Customer Connect. Here's the URL:  https://cloudcustomerconnect.oracle.com/resources/dee2ff3bf7/summary
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Access the Microsoft Team Composer tool from the Oracle Sales Assistant Setup node under the Common Setup
section of Application Composer.

Note:  Oracle Sales Assistant for Microsoft Teams utilizes the saved searches enabled in Workspace and the high-
performance search capabilities powered by Adaptive Search. See the Implementation Reference guide for more
information about Adaptive Search and setting up Workspace saved searches.

Navigate to Microsoft Teams Composer  
You can configure custom sales assistant layouts to display data by role, region, or other criteria for Microsoft Teams
channel users. Using the Microsoft Teams Composer configuration tool, you can add, remove, and rearrange standard
or custom fields to suit your business requirements.

Navigate to the Microsoft Teams Composer Tool
Here's how to navigate to Oracle Sales Assistant for Microsoft Teams.

1. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes
Application Composer as an active tool.

2. Open Application Composer by selecting Application Composer under the Configuration category in the
Navigator menu.

3. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
4. Click the Microsoft Teams Composer tab to open the Oracle Sales Assistant for Microsoft Teams configuration

tool.
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On the left-hand side of the configuration tool, you can see the Application Features pane which lists the standard and
custom objects that are enabled for Oracle Sales Assistant for Microsoft Teams in the current sandbox. The standard
objects include:

• Accounts

• Appointment

• Call Report

• Contacts

• Opportunities

• Tasks

• Sales Leads

• Service Requests

When you click Home you have the option to enable or disable an object, or choose a different icon for an object.

The center pane lists the predefined objects or other objects that were added for Oracle Sales Assistant for Microsoft
Teams. You can see at a glance those objects that are enabled and those objects that are deactivated are denoted by
an icon. Scroll to the bottom of the page and you see the + Add Feature button, which let's you add custom objects to
Oracle Sales Assistant for Microsoft Teams.

Note:  If you're adding a custom object, ensure that the Include in Service Payload option is enabled for an object
in Application Composer. For details about how to do this, see the Add Objects and Fields chapter in the Configuring
Applications Using Application Composer guide.

Assign Roles and Regions to Access Oracle Sales Assistant via
Microsoft Teams  
You can assign roles and regions to have access to CX Sales using Oracle Sales Assistant in Microsoft Teams. This gives
you the flexibility to allow users with specific roles and in specific regions to have a conversation with the sales assistant.
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If there are no roles and regions selected for the Assigned Roles and Assigned Regions fields, then Oracle Sales
Assistant will be available to all Oracle Sales users.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.

2. In the Application Feature pane, click Settings.
3. From the General Settings pane, select the regions you want from the Assigned Regions drop-down list.

If you add two regions (region A and region B), the sales assistant will be available for users in region A or in
region B.

4. Next, select the roles you want from the Assigned Roles drop-down list.

If you add one role and one region, the sales assistant will be available for users with that role and in that
region. However, if you add two roles and two regions, users with either one of the roles (role A or role B) in
either one of the regions (region A or region B) can use the assistant.

5. Click Save.

Enable Attachments and Notes for Microsoft Teams  
The Enable Attachments is selected by default and allows you to ask to view or upload attachments to your record. The
Enable Notes is also selected by default and allows you ask to view or add notes.
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For example, you can ask the assistant to attach a file to the object's records for those objects that have an attachment
as a child object. When enabled, it will launch the attachment form for you to share notes, photos, videos, documents,
or files from Oracle Sales Assistant for Microsoft Teams to CX Sales records.

You can also ask the assistant to add a note for any object that has notes as a child object. The assistant prompts you
for the note details to add to the record you want.

Here's how to enable attachments and notes from the Microsoft Team tool in Application Composer.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Create a new sandbox to use for your configurations.
3. Select Application Composer under the Configuration category in the Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Oracle Sales Assistant Setup.
5. Click the Microsoft Teams tab.
6. In the Application Features pane, click Settings.
7. The Enable Attachments toggle is selected by default and allows you to ask to view or upload attachments to

your record. The Enable Notes toggle is also selected by default and allows you ask to view or add notes.

Note:  If you don't have access to attachments or notes in Oracle Sales, you won't be able add attachments or
notes and won't be able to get any notes via Oracle Sales Assistant.

8. Click Save.

Here is a sample screenshot of the general settings highlighting the Enable Attachments and Enable Notes options.

About Page Layouts for Standard and Custom Objects  
If you want to change the standard layout for an object for Oracle Sales Assistant for Microsoft Teams, you can create a
new page layout and configure it to suit your company's requirements.

There are three different types of page layouts that you can create:

• List layout

• Summary layout

• Edit layout
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Here are the basic configuration steps to make simple changes to Oracle Sales Assistant for Microsoft Teams layout
pages:

1. In the Application Features pane, click the standard or custom object that you want to create a layout for.
2. Select the relevant type of page layout, such as the List, Summary or Edit.
3. In the Layouts pane, click the Click to Clone icon for the standard layout and enter a layout name.
4. Click Ok.
5. Change the fields that appear by clicking the relevant field and selecting a new field from the list.
6. You can remove fields by clicking the field and then clicking the cross icon.
7. To move a field, just drag it to the location where you want it to appear.
8. Click Save in the top right-hand corner of the Microsoft Teams Composer page.

Tip:  Before saving, you can click the Preview tab to preview how the changes will display on Microsoft Teams.

9. Test and publish your new page layouts. See the Test Your Oracle Sales Assistant for Microsoft Teams topic for
details about how to check your page layout configuration changes.

If you want to make more extensive changes to a page layout, familiarize yourself with the additional capabilities of the
different types of page layout.

The List Page Layout
The List page layout displays a list of an object's records, with each record showing a set of fields that can be
configured. Here are the points to note about configuring the List page layout:

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature Using Microsoft Teams Composer topic.

• The list layout contains 3 sections, Title, Contextual and Detail. In the Contextual and Detail sections, you can
add up to five fields. Click on add field to select a field for the object. Once a field is added, click add field again
to select another field and the pane shows two fields and a separator. You can rearrange the fields on each row
by clicking and holding the field to move it to a new position.

• Roles and geographical regions can be assigned to List page layouts. These enable you to restrict who can view
the page layout by their role and their geographical region. You can find more details about how to do this in
the Define Criteria for a Feature's Page Layout topic.

Make sure that you click Save in the Microsoft Teams Composer tool page before creating another page layout.

Test and publish your new page layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic
for details about how to check your configuration.

The Summary Page Layout
The Summary page layout displays an object's details. There are six sections to the Summary layout consisting of a top
section that provides the object's contact information and top-level information of your choice, information sections,
and child and actions related object sections.

The sections of the summary layout are as follows:

• The top section is the Header section (fields are standard and you can't add additional fields to this section).

• The Information Section consists of one or many Info1 sections, owner and primary contact (you can rearrange
the sections as required).

• Child object section (you can add child objects and rearrange child objects within the child objects section)
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• Actions section (this is always placed at the end and depends on the selected object). Some objects have
actions and some don't. All action show up as buttons on the card.

Here are the points to note about configuring the top section:

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature topic.

• You can't move the top section, because this section is designed to contain the top-level information for the
object.

Here are some points to note about the information section:

• Displays Info 1 section, Owner, and Primary contact sections. Note that not all objects has Owner and Primary
Contact sections. For example, both Opportunity and Account objects have Primary Contact and Owner, the
Contact object has Owner, and Service Request has Primary Contact.

• You can add as many Info 1 sections as required and each Info 1 section shows up as its own section. The
section is named Info1 section because you can add 1 field per row.

• You can reorder any of the sections by using the blue up and down arrows.

• You can add fields by clicking the + Add Field button at the bottom of each section. There's no limit as to the
number of fields you can add.

• You can add Info 1, Owner, and Primary contact sections by clicking the + Add Section button.

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature topic.

The section for adding child and related objects is at the bottom of the Summary page layout. Child objects such as
notes, attachments, or in the case of the Opportunity object, products, and competitors are supported only for the
Summary layout. If the object has other related objects, those can't be added to the summary card.

• This section can't be moved, however you can add as many child and related objects as you require by clicking
+ Add Child.

• When you add a child or related object, the child object section displays on the left pane of the summary card.
Click the child object and the screen to modify the list view is displayed. Note that only the first two sections of
the list card will be displayed on the summary card. The full list layout on the top level object's summary card
isn't displayed. See the Child Object Page Layouts section of this topic for more information.

Other configuration options for the Summary page include:

• Assign roles and geographical regions to Summary page layouts. These enable you to restrict who can view
the page layout by their role and their geographical region. You can also define a set of conditions that have
to be met before the page layout is displayed. For example, if you create criteria as follows: Win probability is
Greater than 50%, then any opportunities with a win probability greater than 50% will use your layout. You can
find more details about how to set these up in the Define Criteria for a Feature's Page Layout topic.

Make sure that you click Save in the configuration tool page before creating another page layout.

Test and publish your new page layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic
for details about how to check your mobile configurations.
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The Edit Page Layout
When you create an object using Oracle Sales Assistant (OSA), the default action is that the assistant only prompts for
values of required fields that have no default values. Here are the points to note about configuring the Edit page layout:

• Edit page layouts is available for Task, Appointment, and Call Report objects only.

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature Using Microsoft Teams Composer topic of this chapter.

• The order of the questions asked during the create is based on the order of the fields in the edit layout. To
move a field, just drag it to the location where you want it to appear.

• By default, when you create an object, the assistant only prompts for values of fields on the edit page layout
that are required and have no defaults values. However, if you would like the assistant to prompt for additional
fields that aren't mandatory, or mandatory and have a default, then you can select the fields in the "Prompted
Fields on Assistant Create" section on the left hand side of the tool. Any fields selected in this section will
always be prompted during conversational create if the field is part of the edit layout. The fields selected in this
section applies to the predefined standard or custom layouts.

• You can also assign roles and geographical regions. These enable you to restrict who can view the page layout
by their role and their geographical region. You can also define a set of conditions that have to be met before
the page layout is displayed. For example, if you create criteria as follows: Win probability is Greater than 50%,
then any opportunities with a win probability greater than 50% will use your layout. You can find more details
about how to set these up in the Define Criteria for a Feature's Page Layout topic.

Make sure that you click Save in the configuration tool page before creating another page layout.

Test and publish your new page layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic
for details about how to check your mobile configurations.

Child Object Page Layouts
You can only add child objects to the Summary page layouts, but you can also create page layouts for the child objects
themselves.

Here are points to note when configuring page layouts for child objects:

• Note and Attachments are special child objects that can't be extended or modified.

• Only predefined child objects layouts are displayed under the Child object section.

• When you add a child object to a parent object's page layout, the child object is added to the Children pane. To
create a page layout for the child object, click the child object and clone the standard page layout, as you would
for the parent object.

• Configuring a child object page layout is the same as configuring a parent object's page layout, so you can
follow the same steps you're already familiar with in this topic.

• The template that's used for the list view for top level objects page layout is selected when you add the child
object to a parent page. You can then further configure the List page when you select the child object and clone
the standard page layout.

• You can assign roles and geographical regions to child object page layouts. You can also assign criteria for
displaying the list page layout. Child object layouts only supports list layouts for now and advanced criteria isn't
supported for list layouts.

Ensure that you test and publish your new page layouts. See the Test Your Oracle Sales Assistant for Microsoft Teams
Configuration topic for details about how to check your configuration.
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About Page Layouts for Global Actions  
You can create Sales Briefing layouts for specific roles, including custom roles, by either hiding or displaying the
information related to pipeline, tasks or appointments for the particular role.

This can be particularly useful for sales managers who don't have a pipeline and so don't want to see blank pipeline
information on their home page. You can also define the definition of pipeline based on Workspace saved searches.

Here's how you configure the Sales Briefing response:

1. In the Application Features pane, click Global Actions.
2. In the Layouts pane, click the Click to Clone icon to create a new Sales Briefing layout.
3. Enter a layout name and click Ok.

All the Sales Briefing information is displayed by default. You can hide specific information from the Edit
Layouts pane by clicking the Show icon to enable or disable the information on the card.

You can also add a saved search to the pipeline card by clicking the Actions menu (3 horizontal dots icon)
beside the pipeline row.

Tip:  If you want to assign a role to your Sales Briefing layout, add the role in the Assigned Roles pane.

4. Click Save.
5. Test and publish your new page layouts.

See the "Test Your Oracle Sales Assistant for Microsoft Teams" topic for details about how to check your page layout
configuration changes.

Create Your Own Page Layout for a Feature Using Microsoft Teams
Composer  
This procedure shows you how to create a Summary page layout for an Oracle Sales Assistant for Microsoft Teams
feature but you can also use this procedure to help create List and Edit page layouts as well.

Creating your own layout enables you to select the fields your users will see for a feature's view using Microsoft Teams.

Tip:  You can also specify which user roles can view a particular layout, create criteria that have to be met to display
the layout, and specify which geographical regions can view the layout.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Microsoft Teams Composer tab to open the Oracle Sales Assistant for Microsoft Teams configuration

tool.
6. In the Application Feature pane, click the feature that you want to create a layout for.
7. Select the relevant type of page view, such as the summary, list, or edit view.
8. In the Layout pane, click the Click to Clone icon for the Standard layout and enter a layout name.
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9. Click Ok.
10. Select the Active tick icon if it's not already selected.
11. In the Edit Layout pane add fields to the Summary layout page, for example, by clicking + Add Field in the Info

1 Section.
12. Select the field that you want to add to the Summary layout and then select a label, if one exists.

Note:  You can remove fields by clicking the field you want to delete and then click the cross icon.

13. You can move fields by clicking the field and moving it to your preferred location.
14. For the Summary layout, click the + Add Action and select which user actions you want to display or hide using

the toggle buttons.
15. Click Save in the Microsoft Teams Composer page.
16. Test and publish your new page layouts. See the Test Your Oracle Sales Assistant for Microsoft Teams

Configuration topic for details about how to check your configurations.

Assign Roles to Page Layouts  
You can add a role to an Oracle Sales Assistant for Microsoft Teams page layout. You can also add a role to an
application feature's relevant type of page view, such as the summary, list or edit view.

For example, a user with the Sales Manager role might want to see certain fields on an opportunity record that other
sales team members won't need.

Note:  You can assign a role when you create a custom object layout. For example, you can also assign advanced
criteria for custom object summary layouts. Custom features are created when you create a custom object in
Application Composer, and they're selected from the Available Features pane.

Here are the steps to assign a role to an Opportunity Summary layout using Microsoft Teams Composer and display the
new layout in the Oracle Sales Assistant for Microsoft Teams application.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.
2. In the Application Feature pane, click the feature that contains the page layout that you want to add roles to. In

this example, expand the Opportunities subheader.
3. Select the relevant type of page view, such as the summary, list or edit view. In this example, select the

Summary view.
4. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Create Your Own Page

Layout for a Feature Using Microsoft Teams Composer topic for details about how to create a page layout).
5. Expand the Assigned Roles pane, and select the roles you want to add.

Note:  You can remove a role by clicking the Remove (X) icon.

6. Click Save.
7. Check that your changes appear in your CX sales application. Sign in as a Oracle Sales Assistant for Microsoft

Teams user and view your changes by sending "refresh metadata". Then send the utterance to get the record
for the layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic for details about
how to check your changes.

8. When you're happy with your changes, publish your sandbox to distribute your configurations to all Oracle
Sales Assistant for Microsoft Teams users.
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Related Topics
• Create Your Own Page Layout for a Feature Using Microsoft Teams Composer

• Test Your Oracle Sales Assistant for Microsoft Teams Configuration

Assign Regions to Page Layouts  
Adding geographical regions to a feature's layout enables you to restrict its availability to users from a selected set of
geographical regions.

For example, if you add the United States and United Kingdom regions to a page layout, then only users from these
countries can view the page layout. You can assign a region when you create a custom object layout.

Here are the steps to assign a geographical region to an Opportunity Summary layout using Microsoft Teams Composer
and display the new layout in the Oracle Sales Assistant for Microsoft Teams application.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.
2. In the Application Feature pane, click the feature that contains the page layout that you want to add regions to.

In this example, expand the Opportunities subheader.
3. Select the relevant type of page view, such as the summary, list, or edit view. In this example, select the

Summary view.
4. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Create Your Own Page

Layout for a Feature Using Microsoft Teams Composer topic for details about how to create a page layout).
5. Expand the Assigned Regions pane, and select the regions you want to add.

Note:   Select as many regions as you require. You can remove a region by clicking the Remove (X) icon.

6. Click Save.
7. Check that your changes appear in your CX sales application. Sign in as a Oracle Sales Assistant for Microsoft

Teams user and view your changes by sending "refresh metadata". Then send the utterance to get the record
for the layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic for details about
how to check your changes.

8. When you're happy with your changes, publish your sandbox to distribute your configurations to all Oracle
Sales Assistant for Microsoft Teams users.

Related Topics
• Create Your Own Page Layout for a Feature Using Microsoft Teams Composer

• Test Your Oracle Sales Assistant for Microsoft Teams Configuration

Define Criteria for a Feature's Page Layout  
Creating criteria enables you to define a set of conditions that have to be met before the page layout is displayed for a
feature's Summary views.

For example, if you create criteria for an Opportunity Summary layout as follows: Win probability is Greater than 50%,
then any opportunities with a win probability greater than 50% will use your layout in the Summary view.

Note:  You can't create criteria for a feature's List view.
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This procedure shows you how to create criteria for an Oracle Sales Assistant for Microsoft Teams feature's page layout.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.
2. In the Application Feature pane, click the feature that contains the page layout that you want to add roles to. In

this example, expand Opportunities.
3. Select the relevant type of page view, such as the summary or edit view. In this example, select the Summary

view.
4. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Create Your Own Page

Layout for a Feature Using Microsoft Teams Composer topic for details about how to create a page layout).
5. In the Advance Criteria pane, click Add.
6. Create your criterion by selecting a field, operator, and then entering the relevant field value.

Note:  You can't select a field value from a list of values, so enter the field value.

7. To add a conditional statement click Add and select AND or OR. Enter the field, operator, and relevant field
value.

8. Click Save.
9. Check that your changes appear in the CX Sales application. See the Test Your Oracle Sales Assistant for

Microsoft Teams Configuration topic for details about how to check your changes.
10. When you're happy with your changes, publish your sandbox to distribute your configurations to all Oracle

Sales Assistant for Microsoft Teams users.

Related Topics
• Create Your Own Page Layout for a Feature Using Microsoft Teams Composer

• Test Your Oracle Sales Assistant for Microsoft Teams Configuration

Add Custom Objects to Page Layouts  
You can add a custom object to your Oracle Sales Assistant for Microsoft Teams chatbot.

Sales objects are also known as features in Sales Assistant for Microsoft Teams. When you create a custom Sales
object in Application Composer a corresponding feature is also created in Sales Assistant for Microsoft Teams. Custom
features can be found in the Application Features pane in the Microsoft Teams Composer page.

Here's how you add a custom object, or feature to your Oracle Sales Assistant for Microsoft Teams using Microsoft
Teams Composer.

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configuration.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Select the Sales application and find the custom object you want to add to Oracle Sales Assistant for Microsoft

Teams.
5. Expand the object's menu and click Fields.
6. Select the field you want to add to Oracle Sales Assistant for Microsoft Teams.
7. In the Constraints section, enable the Include in Service Payload option.
8. Click Save and Close.
9. Repeat steps 6 to 8 for each field that you want to add to the application.

10. Next, under the Common Setup Menu, click Oracle Sales Assistant Setup.
11. Click the Microsoft Teams Composer tab to open the Oracle Sales Assistant for Microsoft Teams configuration

tool.
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12. In the Features pane, click the + Add Feature and search for the custom object you previously created in
Application Composer.

13. Click the custom object (otherwise known as a feature) that you want to add.
14. Choose an icon from the list to display for the selected custom feature.
15. Click Next and a preview of the List and Summary views that will be created are displayed for the selected

custom feature.
16. Click Ok and add the custom object to the Features pane.
17. If you want to add custom layouts to the List or Summary views, see the Create Your Own Page Layout for a

Feature Using Microsoft Teams Composer topic for more details.
18. When you have finished adding the custom feature, click Save in the top right-hand side of the Microsoft

Teams Composer page.
19. Next, use the Common Configuration tool to define the synonyms for the newly enabled custom object. See the

Common Configurations section for more details.
20. Test and publish your new features. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration

topic for details about how to check your changes.

Test Your Oracle Sales Assistant for Microsoft Teams
Configuration  
After you have configured Oracle Sales Assistant for Microsoft Teams using Microsoft Teams Composer, you should test
your configuration before distributing the changes to your users.

Task Summary
To test your configurations, complete these tasks:

1. Download the configuration changes from the sandbox and verify them.
2. Publish the sandbox.

Download Configuration Changes From the Sandbox
Here's how:

1. After making changes to your configuration, keep the Oracle CX Sales application open (signed in with a Sales
Administrator or Sales Implementor role). Make sure that the sandbox where you made the changes is active in
the application.

2. Sign in as a Oracle Sales Assistant for Microsoft Teams user that will be able to view your configuration
changes. For example, if the changes have been made to a layout with an assigned role, then you'll need to sign
in as a user with the required role permissions to view the changes.

3. Check your configurations by sending "refresh metadata". Then send the utterance to get the record for the
layout.

Publish the Sandbox
Once you're ok with your configurations, publish the sandbox. Here's how:

1. Sign in to Oracle CX Sales as the same user you used to make the configuration changes.
2. Publish your sandbox to distribute your changes to all Oracle Sales Assistant for Microsoft Teams users.
3. Send "refresh metadata" one more time so all users receive the changes you made to your configurations.
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Note:  You can configure only the latest skill from the skill store that matches your current release. For example, if the
skill you want to modify is from a previous release and you're making your changes in a later release, then you must
re-base the skill your users are using to the latest skill that was modified. In addition, you must re-route the channel to
the new re-based skill so that users can start using it and perform Reset sessions in the channel UI.

Configure Microsoft Teams with Custom Scripts  
You can configure Microsoft Teams to match your business requirements by writing custom scripts using JavaScript
that enforce validations and rules.

You can create scripts for Microsoft Teams using the CX Sales Mobile script tools. You can also assign scripts for CX
Sales Mobile to Microsoft Teams if the requirements for both channels are the same. You can add custom scripts for
Microsoft Teams to Appointments, Call Reports, and Tasks for On Create, Before Save, and After Save events.

Note:  To enable the custom scripts for Microsoft Teams feature, you must first create an Enable Custom Scripts
for Microsoft Teams (CDA_ENABLE_CSS_TEAMS) profile option, and then set the option value to Yes. For more
information, see Enable Custom Scripts for Microsoft Teams Profile Option.

Create a Script and Assign to Microsoft Teams
Here's how you create a script and assign to Microsoft Teams:

1. Select the sandbox you want use for your configuration.
2. Select Navigator > Application Composer > Mobile Application Setup.
3. Click the CX Sales Mobile Scripts tab at the top of the Mobile Application Setup page.
4. To create a script for a top-level parent object, select the object you want to write a script for, and then select

the event that will trigger your script. You can choose one of these events:

◦ On Create (triggered when a new record is created in the mobile app).

◦ Before Save (triggered before a record is saved).

◦ After Save (triggered after the app has saved the record).

5. Click the plus icon in the <Event Name> Scripts section.
6. Enter the script name and description.
7. (Optional) If you want the script to work for particular regions, select geographical regions for the script. The

script will work for users who have your selected regions as their country preference setting in the CX Sales app.

Note:  A script can have multiple regions associated to it, but the same region can't be assigned to more than
one active script for the same object and event.

If you want to restrict your script to trigger for certain user roles, you will need to specify these by writing a
JavaScript script
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8. Select Microsoft Teams as your assigned channel and click Create to create your script.

9. Click Validate to check whether your script has any errors. The validation checks include checks for nested
functional calls and anything else in the script that will cause it to run forever in an infinite loop.

10. When you're finished, click Save.

Assign Existing Scripts to Microsoft Teams
You can also assign existing scripts for CX Sales Mobile to Microsoft Teams if the requirements for both channels are the
same.

Here's how you add an existing script and assign to Microsoft Teams.

1. Select the sandbox you want use for your configuration.
2. Select Navigator > Application Composer > Mobile Application Setup.
3. Click the CX Sales Mobile Scripts tab at the top of the Mobile Application Setup page.
4. Choose the event and locate the existing script that you want to assign to Microsoft Teams.
5. Select Microsoft Teams as your assigned channel. 

6. Click Validate to check whether your script has any errors. The validation checks include checks for nested
functional calls and anything else in the script that will cause it to run forever in an infinite loop.

7. When you're finished, click Save.
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Enable Custom Scripts for Microsoft Teams Profile Option  
You can add custom scripts for Microsoft Teams to Appointments, Call Reports, and Tasks for On Create, Before Save,
and After Save events. For example, you can trigger a script to validate or enforce some rules before or after a call report
is saved.

To enable the custom scripts for Microsoft Teams feature, you must first create an Enable Custom Scripts for Microsoft
Teams (CDA_ENABLE_CSS_TEAMS) profile option, and then set the option value to Yes.

Here's how to edit the CDA_ENABLE_CSS_TEAMS profile option:

1. Sign in as a user with access to the setup areas.
2. Navigate to  Setup and Maintenance work area.
3. Open the Tasks side panel and click Search.
4. Search and select the Manage Profile Options task.
5. From the Manage Profile Options page, click Actions > New .
6. Enter all the fields with relevant details with specific attention to the following:

◦ Profile Option Code = CDA_ENABLE_CSS_TEAMS

◦ Profile Option Name = Enable Custom Scripts for Microsoft Teams

◦ Application = Sales Assistant

◦ Module = Sales Assistant (Module Type = LBA)

◦ Start Date = Date that the option should start to be enabled

7. Click Save and Close.
8. For the Site Profile Option Levels, select the Enabled and Updatable check boxes to enable.
9. Click Save and Close.

10. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

11. In the Manage Administrator Profile Values page, search by the profile option code, CDA_ENABLE_CSS_TEAMS.
12. Click the profile option name link.
13. On the Profile Values section, click Actions > New .
14. Select Profile Level to Site and set Profile Value = Y.
15. Click Save and Close.

FAQs for Microsoft Teams  

How can I hide or display a feature?  
Navigate to the Microsoft Teams Composer in Application Composer. In the Application Feature pane, select the feature
you want to hide or display, and click the Enable icon to enable or disable the feature in the Feature Details pane. Click
Save.
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Can I configure additional fields to prompt during a conversational
create?  
Yes, you can specify what fields you want the assistant to prompt in both the edit page layout sections for CX Sales
Mobile and Microsoft Teams.

By default, when you create an object, the assistant only prompts for values of fields on the edit page layout that are
required and have no defaults values.

However, if you would like the assistant to prompt for additional fields that aren't mandatory, or mandatory and have a
default, then you can select the fields in the Prompted Fields on Assistant Create section on the left hand side of the
Microsoft Teams and CX Sales Mobile configuration tools. Any fields selected in this section will always be prompted
during conversational create if the field is part of the edit layout. The fields selected in this section also applies to the
predefined standard or custom layouts.

For CX Sales Mobile, see Configure the Edit Page Layout for more information. For Microsoft Team, click the related link
About Page Layouts for Standard and Custom Objects.

Related Topics
• About Page Layouts for Standard and Custom Objects

• Configure the Edit Page Layout

CX Sales Mobile  

Set Up Oracle Sales Assistant for CX Sales Mobile  
Oracle CX Sales Mobile is a specialized mobile application for CX Sales. Only the CX Sales skill (Oracle Sales Assistant)
for CX Sales can be set up with CX Sales Mobile.

You create a channel in Oracle Digital Assistant and expose your Sales Assistant in Oracle CX Sales Mobile.

Set Up CX Sales Mobile
Once you have performed the steps to configure ODA and have access to start using Sales Assistant, you can configure
the Oracle Web Channel to associate to the Sales assistant skill. Here's a table summarizing what you must do to set up
CX Sales Mobile with the Oracle Sales Assistant. See the topic referenced in the last column for details about each setup
step.

Step Task Description Where to get more details

1
 

Complete the prerequisite Oracle
Digital Assistant application setup.
 

Before you set up any of the
features that use natural-language
processing, you must perform
some prerequisite setup of Oracle
Digital Assistant:

See the topic: Overview of
Common ODA Setup for Sales.
 
For additional information, see
the Oracle Digital Assistant
documentation: Getting Started
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Step Task Description Where to get more details

• Set up administrator users

• Obtain the ODA URL

• Enable the Digital Assistant
used for Oracle Fusion Cloud
Applications

 
If you already completed the setup
for another feature, you can skip
this step.

with Oracle Digital Assistant for
Cloud Applications.
 

2
 

Create a Channel in Digital
Assistant.
 

Create an Oracle Web Channel in
Oracle Digital Assistant.
 

See the section "Create a Channel
in Digital Assistant" in the topic
Enable Sales Assistant for CX Sales
Mobile for more information.
 

3 Set up in CX Sales Mobile
Composer tab in CX Sales
Application Composer.

To enable Oracle Sales Assistant
in CX Sales Mobile, enter the
Oracle Digital Assistant Host
and Channel ID of the Oracle Web
channel registered in Oracle Digital
Assistant.

See the section "Set the Digital
Assistant Host and Channel ID" in
the topic Enable Sales Assistant
for CX Sales Mobile for more
information.
 

4
 

Enable or Disable Sales Assistant
for Standard or Custom Objects.
 

In the CX Sales Mobile
configuration tool, select the
standard or custom objects you
would like to enable for sales
assistant.
 

See the section "Enable or Disable
Sales Assistant for Standard or
Custom Objects" in the topic
Enable Sales Assistant for CX Sales
Mobile for more information.
 

5
 

Test Your Configurations.
 

After you have configured Oracle
CX Sales Mobile using Application
Composer, you should test your
configurations before distributing
them to your user's mobile devices.
 

See the topic Test Your
Configurations of the Mobile
Applications chapter of this guide.
 

Note:  The CX Sales Mobile app uses saved searches and other work areas that are powered by the high-performance
search capabilities of Adaptive Search. Prior to using the CX Sales Mobile application, check that Adaptive Search is
deployed in the CX Sales application, and that search indexing processes are run and regularly scheduled. You must
also ensure that these fields are enabled for use as search filters for the following objects:

• Opportunity: - Status, Sales Method

• Activity: - Type, Activity, Start Date, End Date, Status, and Due Date

Enable Sales Assistant for CX Sales Mobile  
Sales assistant is an individual chatbot that you can use to help you perform your daily sales-related tasks. Using your
phone, you can ask questions or commands to the sales assistant and it retrieves the information, or acts on your
requests. It reduces manual data entry, and makes it easier to view and update sales records through text or voice
commands.
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Follow the steps outlined in the following sections to enable sales assistant for your sales representatives.

Create a Channel in Oracle Digital Assistant
1. In a browser window, open ODA, click Channels in the left menu, and choose Users.
2. Click + Channel to open the Create Channel dialog.
3. Give your channel a name.
4. Choose Oracle Web as the channel type.
5. Disable the Client Authentication Enable option using the toggle.
6. Enter an asterisk (*) for Allowed Domains.
7. Set the Session expiration time.
8. Click Create.
9. In the Channels page, copy the Channel ID and make a note of it.

10. Click Route To and select the Sales skill that you want to associate with the channel.
11. Switch on the Channel Enabled control.

Set the Digital Assistant Host and Channel ID
After you create the Oracle Web channel in Oracle Digital Assistant, configure Oracle Fusion Cloud Applications with
the values from the web channel. You don't need to create and publish a sandbox to configure channels for your sales
assistant.

Here's how to set the Digital Assistant host and channel ID to enable Oracle Sales Assistant in CX Sales Mobile.

1. Select Application Composer under the Configuration category in the Navigator menu.
2. Under the Common Setup Menu, click Productivity Applications Configuration.
3. Click the Oracle Sales Assistant tab to open the Channels Configurations page.
4. Navigate to the Register the Oracle Digital Assistant Channels section of the Channels Configurations page.
5. Enter the following host and channel ID details:

◦ In Oracle Digital Assistant Host, enter the Oracle Digital Assistant Instance URL without https://
See the topic: Obtain the Oracle Digital Assistant URL

◦ In Channel ID, enter the ID of the Oracle Web channel that you created in Oracle Digital Assistant.

Note:  You can now begin to enable, configure, and test the sales assistant for CX Sales Mobile by using the Mobile
Application Setup tool as outlined in the following sections. You must perform these tasks only from a new sandbox.

Enable Sales Assistant in the Mobile Application
Here's how to enable sales assistant for CX Sales Mobile in the Mobile Application Setup tool.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Create a new sandbox to use for your configurations.
3. Select Application Composer under the Configuration category in the Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. Click the CX Sales Mobile Composer tab.
6. In the Application Features pane, click Settings.
7. In the mobile interface designer, click Oracle Sales Assistant Settings.
8. Enable sales assistant by using the Enable toggle.
9. Oracle Sales assistant is available for all roles and regions by default. If you would like to restrict access, you can

specify the roles and regions that can use sales assistant in the Assigned Roles and Assigned Regions fields.
Just click the relevant field and select the roles and regions to assign access.

675



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 45
Sales Assistant

10. The Enable Attachments is selected by default and allows you to ask to view or upload attachments to your
record.

The Enable Notes is also selected by default and allows you ask to view or add notes.

Note:  If you don't have access to attachments or notes in Oracle Sales, you won't be able add attachments or
notes and won't be able to get any notes via Oracle Sales Assistant.

11. Click Save.

Enable or Disable Sales Assistant for Standard or Custom Objects
Finally, you need to specify which objects can be used with sales assistant.

1. In the Applications Features pane, click Home.
2. In the mobile interface designer, click the standard or custom object you would like to enable for sales assistant

and in the Feature Details pane, click the Enable for Sales Assistant toggle.

Note:  Sales assistant isn't available for the following objects: Calls to Log, Products, and Partners. Creating
call reports is supported, but searching for them isn't.

3. Click Save.

Test Your Configurations
Test and then publish your sales assistant configurations. See the Test Your Configurations topic for details about how to
check your mobile configurations.

FAQs for CX Sales Mobile  

Can I modify the Sales Assistant welcome message for CX Sales
Mobile?  
Yes, your administrator can now create a new or modify an existing welcome message with some suggestions of what
sales representatives can do and say to the sales assistant which are relevant to your business.

Your administrator can modify the message in the Oracle Sales Assistant Common Configuration Tool within
Application Composer.

For example, here’s a sample sales assistant screenshot of a CX sales mobile welcome screen.
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Related Topics
• Edit Strings in Oracle Sales Assistant Common Configuration Tool

Common Configurations  

Overview of Managing Synonyms for Sales Assistant  
A synonym is a word or phrase with a similar meaning for the CX objects and fields used in utterances sent to Oracle
Sales Assistant.

Synonyms for CX objects and fields allow Oracle Sales Assistant to understand the objects and fields your user is asking
about, based on your company's jargon. These can include abbreviations, slang terms, and common misspellings.

For example, your salespeople may call or refer to "opportunities" as "deals". The Oracle Sales Assistant Common
Configurations administrator tool provides an easy way for you to manage synonyms for all supported channels without
having to manually manage them in Oracle Digital Assistant.

Navigate to the Common Configuration Tool  
Here's how to navigate to the Oracle Sales Assistant Common Configurations tool.
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1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes

Application Composer as an active tool.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.

When the Common Configurations tool opens, it first checks if there are skills compatible with current version of your
sales application. Currently, Oracle only supports the same skill version as the latest sales application version. For
example, if your sales application version is 21.04, then the skill version must also be 21.04. A message is displayed if
there are no skills found with the same version.

If a skill version matches your sales application, then the Common Configurations tool displays both a left panel and a
right panel. The right will be empty. The left panel consists of 1 main Synonyms section.

Use the Common Configuration Tool to Update Synonyms  
To ensure that Sales Assistant is aware of any objects enabled from the CX Sales Mobile composer tool or Microsoft
Teams composer, you can use the Oracle Sales Assistant Common Configurations administrator tool to update
synonyms for the objects enabled.

Update Synonyms for Objects Enabled for Oracle Sales Assistant
Here's how to update synonyms for objects enabled for your Sales Assistant.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.
6. Expand the Synonyms section and under the CX Objects section, select the object for which you want to

update synonyms.

◦ The objects displayed are objects are that enabled for Oracle Sales Assistant for any supported channels.

◦ If you're looking for a child object, first select the parent object, such as "Opportunities", from CX Objects
section. Then select the child object from the Child Objects section, such as "Opportunities Child
Objects".

◦ If the child object is also a top-level object, select the top-level object to define the synonyms required.

7. From the Object Name Synonym(s) field in the right pane, enter the synonym that you want for the selected
object in the Enter Synonym(s) text box and press Return.

◦ Once the synonym is added, it displays in the list of synonyms for the object.

Note:  Predefined synonyms can't be removed. To remove a custom synonym, select it from the list and
click the X icon.

8. Click Save. The Select Sales Assistant Skill dialog is displayed.
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9. From the Select Sales Assistant Skill dialog, select the Sales Assistant skill that you want the updated
synonyms for objects transferred to.

10. Click Save.

An in progress notification is displayed during the transfer and a success message is displayed when the
transfer successfully completes. The next time you update and save synonyms for an object, the Select Sales
Assistant Skill dialog displays the last updated Sales Assistant skill that you have saved to.

CAUTION:  An error message displays if there is an problem during the transfer to the skill. Any updates you
made won't be saved if you exit the Common Configurations administrator tool at this stage.

Update Synonyms for Fields Enabled for Oracle Sales Assistant
Use the Oracle Sales Assistant Common Configurations administrator tool to update synonyms for the fields to use in a
conversation. You want to ensure that Sales Assistant is aware of the fields you want your users to use in a conversation
with the assistant from any of supported channels, such as updating a synonym for a field used to search for a record.

Here's how to update synonyms for your Sales Assistant fields.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.
6. Expand the Synonyms section and under the CX Objects section, select the object for the field which you want

to update synonyms.

◦ If you're looking for a field of a child object, first select the parent object, such as "Opportunities", from
CX Objects section. Then select the child object from the Child Objects section, such as "Opportunities
Child Objects".

7. Once the object is selected, select a field from the Fields section in the right pane, enter the synonym that you
want for the selected field in the Enter Synonym(s) text box and press Return.

◦ Once the synonym is added, it displays in the list of synonyms for the field.

Note:  Predefined synonyms for fields can't be removed. To remove a custom synonym for a field,
select it from the list and click the X icon.

8. Click Save. The Select Sales Assistant Skill dialog is displayed.
9. From the Select Sales Assistant Skill dialog, select the Sales Assistant skill that you want the updated

synonyms for fields transferred to.
10. Click Save.

An in progress notification is displayed during the transfer and a success message is displayed when the
transfer successfully completes. The next time you update and save synonyms for a field, the Select Sales
Assistant Skill dialog displays the last updated Sales Assistant skill that you have saved to.

CAUTION:  An error message displays if there is an problem during the transfer to the skill. Any updates you
made won't be saved if you exit the Common Configurations administrator tool at this stage.
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Tips for Adding or Updating Synonyms for Objects and Fields
Here are some tips for adding or updating synonyms for objects or fields

• If there are no skills of the same version as your sales application, then you must navigate to your Oracle Digital
Assistant environment to get the latest version of the Sales skill from the Skill Store (via FADigitialAssistant).

• Synonyms can't contain characters such as, : (colon) or , (apostrophe) and can't end with ? (question mark), " or
' (double or single quote mark), or . (period).

• Synonym values aren't case-sensitive. For example, USA and usa are considered as the same value.

• You can't add synonym(s) that are already present in an object or a field. An error message displays if you try to
add a duplicate synonym to the list.

• You can't add synonym(s) if the synonym is part of a set of reserved words for the Oracle Sales Assistant. An
error message displays if you try to add a synonym that contains a reserved word to the list.

• If you add a synonym to a formula field, then Oracle Sales Assistant won't be able to search on the field because
formula fields aren't searchable.

Edit Strings in Oracle Sales Assistant Common Configuration Tool  
Use the Oracle Sales Assistant Common Configuration tool to update phrases or strings from the sales assistant.
Responses from the sales assistant are based on such phrases or strings and applies to either CX Sales Mobile,
Microsoft Teams, or users of both channels.

For example, you can modify the sales assistant help text to make the answer more relevant in response to a user's
request for help on a contact list.

Follow these steps to update strings using the common configuration tool:

1. Create and enter a publishable sandbox where Application Composer is enabled.
2. Navigate to Application Composer.
3. Click Oracle Sales Assistant Setup.
4. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.
5. Click on the Response Text section.
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6. In the Select String drop down list, search for the string you want to update. For example, search for "I am your
Oracle sales Assistant" as shown in this sample screenshot to locate the CX Sales Mobile's sample welcome message.

7. Select the string you want and make your changes in the Edit String field.

Strings are in ICU format. Some strings contain tokens and some strings are pluralized. You can preview how the
string will be rendered under the Preview section. For example, if your string contains tokens, for each token, double

681



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 45
Sales Assistant

click on the token row and enter the value in the Sample Value section. You can then preview the rendered string
based on the sample value you enter.

Here's a sample screenshot that highlights where to enter and preview a sample token value from the Sales Assistant
Common Configurations tool.

8.

Click Save. The Select Sales Assistant Skill dialog is displayed. 
9. From the Select Sales Assistant Skill dialog, select the Sales Assistant skill that you want the updated string to

transfer to.
10.Click Save.
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Related Topics
• Can I modify the Sales Assistant welcome message for CX Sales Mobile?
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46  Web Activity Rules

About Web Activity Rules  
You can perform an activity sync from Oracle Eloqua to CX Sales contacts, leads and opportunities that exist in CX Sales.
Use the Web Activity Rule expression builder to define rules to include or exclude web activity records for the objects
that are of interest.

For example, you might want to create a web activity rule that imports only those emails that were sent from a
campaign after a specific date and exclude any emails that have the term " Oracle" in the email subject.

Here's how to access web activity rules.

1. Open Application Composer by selecting Configuration > Application Composer in the Navigator menu.
2. Under the Common Setup Menu, click Web Activity Rules to open the Web Activity Rules UI.

You can create rules to import records for the following web activity types:

• Email Open

• Email Click-Through

• Email Send

• Form Submit

• Page View

• Web Visit

Any rules that you have already created are displayed in the Web Activity Rules list page. It shows the name of the rule
as well as the type, status, creation and last updated dates and the name of the user who performed the last updates to
the web activity rule.

Manage Web Activity Rules  
From the Web Activity Rules page, you can view previously created rules, create, edit, and delete a rule to either include
or exclude all or any attributes for the Campaign and Web Activity objects.
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Here's how to create, edit, and delete a web activity rule.

1. Sign in as a sales administrators or user with the appropriate access privileges.
2. From Application Composer > Web Activity Rules, navigate to the Web Activity Rules page and click Create.

3. In the Basic Details section, enter the name and a brief description of the rule and the type of web activity to want to
define the rule.

4. In the Rule Definition section, click Add Group to include or exclude groups of attributes for your selected object
that you want to define for your web activity.
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5. Click Add Object to select either the Campaign and Web Activity objects. Select the
attributes, operators, and values that you want to define for the conditions of your rules.

You can define multiple rules for each of your objects. Click the plus (+) sign at the end of each row to add another
rule associated to your web activity type.

Note:  For date values, you can select the specific date that you want or you can specify a run date plus or minus
a specific number of days in integer format. For example, for date-related attributes you specify a run date plus 7
days. This means that if all or any of the rules are met, the rule will continue to process and update records 7 days
past the specified run date.

6. When you're done with including and excluding group for the objects you want and have defined all the rule
conditions, you can activate the rule by changing the Status  field in the Basic Details section from Inactive to Active.
You can only set 1 rule to Active for each web activity type.

7. Click Save.
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Change Web Activity Rules  
1. From Application Composer > Web Activity Rules, navigate to the Web Activity Rules page.
2. In the Name field, double-click the rule you want to edit. Note that you can change the basic details expect for the

name of the rule and you can change all or any of the rule conditions.
3. Click Save to update the web activity rule name with your changes.
4. To delete rules that no longer apply, select them from the list page and click Delete. 
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47  Sales Intelligence

Sales Intelligence Features and Technologies  
Sales Intelligence includes a number of analytics and artificial intelligence features that can help your sales organization
improve sales efficiency and productivity.

The features use three different technologies developed by different teams at Oracle:

• Adaptive Intelligence (Oracle AI Apps for Sales)

Uses machine learning models and analytics to help with processing leads and converting opportunities to
deals. For leads, Adaptive Intelligence (now renamed Oracle AI Apps for Sales) provides salespeople with
the probability of a lead being converted to an opportunity (the lead score). For opportunities, Adaptive
Intelligence recommends the best actions to take on an opportunity. In Digital Sales, the recommended actions
for opportunities appear automatically along with other recommendations at the top of the list of activities. For
CX Sales, you must add these to the UI using Application Composer.

• Sales Insights

Analyzes historical account, lead, opportunity, and contact data to provide salespeople with recommended
actions. As a Sales Administrator, you can enable or disable individual recommendations and change their
wording.

• Machine Learning

A platform for creating sales machine learning models. Oracle provides you with a sample Similar Accounts
model that identifies similar accounts using location, size, industry, and other factors. As a sales administrator
without prior artificial intelligence (AI) modeling expertise, you can configure your own version of the Similar
Accounts model, or you can develop completely new machine learning models of your own. The Similar
Accounts model is enabled by default. In Digital Sales, salespeople can review similar accounts simply by
entering "Show similar accounts" in the Action Bar. For the CX Sales UI, you must expose this feature using
Application Composer.

Here's a list of the different Sales Intelligence features that you can enable by using the Enable Sales Intelligence
Features task from Setup and Maintenance. When you enable a feature, the application determines if you have enough
data to make the feature live. If the feature is available for use, you can then configure it further using the administration
UIs for each technology.

Account Recommendations

Feature Description Technology

Account Engagement Level Rates the level of engagement of the sales
organization with each account. The rating
is based on the number of active leads,
 the number of deals, and the frequency of
interactions and activities with the account.

Sales Insights

Similar Accounts Identifies similar accounts by such factors as
industry, address, and company size.

Machine Learning
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Contact Recommendations

Feature Description Technology

Lead Contact Recommendations Recommends contacts to add to leads.
Contacts are recommended based on their
involvement in past successful leads, deals,
 and their level of interactions with the sales
organization (the number of meetings, calls,
 and emails).
 

Sales Insights

Lead Contact Validation Recommends contacts from similar leads that
have been converted into opportunities.

Sales Insights

Opportunity Contact Recommendation Recommends contacts from similar successful
opportunities.

Sales Insights

Opportunity Contact Validation Recommends contacts that are frequently
added to similar opportunities.

Sales Insights

Lead Recommendations

AI Feature Description Technology

Effectiveness of Lead Activities Suggests what activities that a salesperson
should take on a lead based on the activities
associated with successful leads.

Sales Insights

Lead Score (AI Lead Score) Indicates the probability of a successful
conversion of sales leads to opportunities.
 

Note:  There are two types of lead score in
the application: Score and AI Lead score.
We're talking about the AI Lead Score in the
UI.

Adaptive Intelligence

Opportunity Recommendations

AI Feature Description Technology

Opportunity Activity Effectiveness Suggests what activities that a salesperson
should take on opportunities based on the
activities associated with successful leads.

Adaptive Intelligence

Opportunity Next Best Action Recommends actions from similar deals closed
in the past.

Adaptive Intelligence

Opportunity Predicted Win Probability Predicts win probability using historical data. Adaptive Intelligence
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Enable Sales Intelligence Features  
You can enable the Sales Intelligence features provided by Oracle from the Setup and Maintenance work area. Here's
how.

1. In Setup and Maintenance, open the Enable Sales Intelligence task:

◦ Offering: Sales

◦ Functional Area: Intelligence in Sales

◦ Task: Enable Sales Intelligence

2. On the Enable Sales Intelligence Features page, Select Features panel, click Start.
3. Select the features that you want to enable.
4. Click Continue.

The application runs a process to determine if you have sufficient data to enable the features. This process may
take a while to complete, so you can close the flow and wait for a notification email.

5. On the View Feature Eligibility Report page, you get feedback if you have sufficient data for each feature.
Optionally, you can enable and disable features here as well.

6. Click Continue.
7. The Verify Recommended Features step lists the features you are enabling by technology. You must complete

any additional configuration steps in the admin UIs for each technology.
8. Click Continue.
9. In the Configure Recommended Features page, you can click the links to open the administration UIs for

technologies related to the features you enabled. Links are available for Adaptive Intelligence and Machine
Learning (Similar Accounts). There is no direct link for Sales Insights. You can also navigate to these UI pages
separately.

Adaptive Intelligence  

Overview of Adaptive Intelligence  
Adaptive intelligence uses a combination of machine learning models and decision-based analytics that help you
prioritize leads and recommends what best actions to take on opportunities.

When salespeople work on leads, they see adaptive intelligence predictive lead scores that help them prioritize their
leads better. When they view their opportunities, they get recommendations to increase their win rates. Salespeople can
use these features to improve their productivity and close deals faster.

Before your salespeople can view opportunity recommendations and lead scores, you need to complete a few
integration and configuration steps.

1. Create a user account for integration.
2. Import data from Oracle CX Sales.
3. Set up attributes and filters for opportunity win probability and lead scoring prediction.
4. Configure lead scores and recommended actions.
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Create a User Account for Integration  
Before you start integrating Oracle CX Sales with Oracle AI Apps for Sales, create a user account in Oracle CX Sales for AI
Apps to access sales data.

Ensure that this user has the Sales Administrator job role assigned with access to all opportunities, accounts, contacts,
leads, and activities in Oracle CX Sales. To learn how to create and assign roles, see Create Application Users in the
Securing CX Sales and Fusion Service guide.

About 15 minutes after you create the user account, you can use this account credentials in the Add Service Connection
dialog box as detailed in the topic Import Data from Oracle CX Sales.

Note:  It's important to set a calendar reminder a few days before your password is set to expire, and reset the
password. Update the password on the Edit Service Connection dialog box so that your connection remains intact.

Related Topics
• How do I create application users?

• Create Roles in the Security Console

Connect AI Apps for Sales to CX Sales and Import Sales Data  
Set up the connection and import data into AI Apps for Sales from Oracle CX Sales using basic manual steps and
configuration. After a successful connection, the application can access and import data from Oracle CX Sales.

Set Up Connection
If you have sufficient data to configure AI Apps features, the Configure Recommended Features page, the last page in
the Enable Sales Intelligence task includes the Adaptive Intelligence Activation link.

To complete your configuration, you need to import data from CX Sales.

1. On the Configure Recommended Features page, click Adaptive Intelligence Activation.

The Adaptive Intelligence Activation page lists all the selected features. However, you can’t activate them till
you set up your connection to import data.

2. On the Adaptive Intelligence Activation page, click Add Service Connection.
3. In the Add Service Connection dialog box, enter the following details:

◦ Service Endpoint URL: Your Oracle CX Sales host name in the format https://<osc_host_name>. For
example, https://abcd.fa.us6.example.com.

◦ User Name and Password: User name and password of the Oracle CX Sales user account that you created
earlier.

◦ Data Import Start Date: Optionally, select the date from when you want to ingest data from Oracle CX
Sales. If you don't select a date, the application ingests all the available data.

Note:  After you set the date, don't edit the Data Import Start Date field. Contact Oracle Support if you want
to update the field.
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4. Click Connect.

The connection is tested against your Oracle CX Sales host and is saved if successful.

Note:  Update the endpoint URL only if recommended by Oracle Support. Reading a different data set into an
existing Oracle AI Apps for Sales instance may result in corrupt predictions.

5. After you set up the connection, click Activate to enable all the selected features.

Data ingestion starts immediately.

To complete configuring each feature, see:

• Set Up Attributes and Filters for Opportunity Win Probability and Lead Scoring Prediction

• Configure Lead Scores and Recommended Actions

Set Up Attributes and Filters for Opportunity Win Probability and
Lead Scoring Prediction  
You can configure what fields and records you want AI models to consider, to predict opportunity win probability or lead
score.

You can do one of these on the Opportunity Win Probability and Lead Scoring pages:

• Use filters to exclude records for parent objects such as Lead, Opportunity, or Account. For example, for the
Opportunity object, you can set a filter as Sales Channel Equals Indirect. This means that if an opportunity
has the value for Sales Channel as Indirect, it would not be considered for prediction.

• Replace out of the box fields (also called attributes) for any object used by AI models with custom fields that
have matching data types.

For example, for opportunity win probability prediction, Activity object, you may not want the models
to consider the ActivityTypeCode field. You may instead want the model to consider data from the
ActivityCategory_c custom field. When you select this replacement, the models will consider activity category
across opportunities that were won as one of the factors to predict the win probability of new opportunities.

To configure opportunity win probability and lead scoring:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Intelligence in Sales

◦ Task: Configure AI Apps in Sales

2. On the Intelligence in Sales page, click Configure AI Apps in Sales.
3. On the Configure AI in Sales page, you need to select one of these based on what you want to configure:

◦ Opportunity Win Probability: Select this to configure attributes for opportunity win probability
prediction.

◦ Lead Scoring: Select this to configure attributes for lead score prediction.

4. On the Opportunity Win Probability or Lead Scoring page, from the Object list, select the object from which you
want to remove or replace attributes.
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Note:  The Object list consists of parent as well as child objects. For parent objects, you can also apply a filter
to select specific records in objects that you want to exclude in the model.

After you select an object, attributes related to that object are listed in the Model Feature Configuration table. In
the Model Feature Configuration table, you can do one of these:

◦ Click the Edit icon to replace the out of the box attribute with a custom attribute. Select a custom
attribute from the list in the Replace With field. You can only replace an attribute with another if they
share the same data type. For example, if you’re replacing an attribute whose data type is string, the
attribute you’re replacing it with must also have string as the data type.

Note:  You can only replace certain out of the box attributes.

◦ Click the Delete icon to delete a custom attribute mapping for an out of the box attribute. Deleting this
mapping clears any replacement selections that you made for the out of the box attribute in the Replace
With field.

5. Click Save.

The models will now use the dataset from the attributes based on how you’ve set them up here.

Configure Lead Scores and Recommended Actions  
You must complete configuration steps in Oracle CX Sales for lead scores to display on leads, and for recommendations
to display on opportunities.

• For lead scores to appear on the Leads Summary page and in the Workspace, edit the required profile option,
and add the AI Lead Score field to the Leads Summary page and in Workspace.

• For recommendations to appear for your opportunities, configure the Next Best Action feature and add the
Recommended Action column to the Opportunity and the Edit Opportunity pages.

Related Topics
• Edit the AI Update Who Columns Threshold Profile Option

• Set Up Best Sales Action for Opportunities

Lead Artificial Intelligence (AI) Score  

About Artificial Intelligence (AI) Lead Score  
You can add the AI Lead Score field to indicate the lead conversion probability of a sales lead being converted to an
opportunity.

Lead scores are numeric values typically ranging from 1 to 100 and where the higher value represents a high conversion
probability. Using Oracle AI Apps for Sales, lead scores can help increase the productivity of salespeople. At a glance, it
helps them prioritize and focus on those leads that are more likely to get converted to opportunities.

Before you can use lead scores, you must have Oracle AI Apps for Sales integrated with CX Sales.
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Related Topics
• Overview of Adaptive Intelligence

Edit the AI Update Who Columns Threshold Profile Option  
The AI Update Who Columns Threshold (ORA_ZCA_AI_UPDATE_WHO_THRESHOLD) profile option specifies the
percentage threshold value for both the AI Lead Score field for Leads and the Predictive Win Probability field for
Opportunities. The profile option is set to 5 percent by default.

If the score in either of these fields exceeds or equals the percentage threshold value specified in the profile option, then
the Last Updated Date field gets updated for the lead or opportunity record.

For example, lets say that the AI Lead Score was 50, and it changed to 60. Then the % change is 20%. If the 20% is
greater than or equal to the specified threshold value set in the profile option value, for example 5%, then the Last
Updated Date is updated on the Lead record.

Here's how to edit the AI Update Who Columns Threshold profile option:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
ORA_ZCA_AI_UPDATE_WHO_THRESHOLD in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click on the profile option code link.
5. Set the profile option value to the required value.

For example, change the threshold default value from 5 to a percentage threshold value to suit your business
requirements. So, for example if the lead score or the predictive win probability for an opportunity increases
by more than 3 percentage points, then alert your salespeople so that they can focus on those leads and
opportunities that are more likely to get converted. The Last Updated Date field on the record also gets
updated when the threshold you specify is exceeded.

6. Click Save and Close.

Add AI Lead Score in Leads UI  
You need to make the AI Lead Score field available on the Leads UI. For details on how to do this in the Digital Sales UI,
follow the example topic, "Add a Custom Field to the Edit Contact Page", in the Oracle Fusion Cloud Sales Automation
Extending Digital Sales (Next Gen Sales) guide. To access this guide, contact your Oracle representative. For the CX
Sales UI, you need to do this through Application Composer, as detailed in this topic.

The field is hidden by default so you must manually unhide it so that it's available as a display-only field for the Edit
Lead and Lead List pages.

Here's how to display the AI Lead Score field in Lead pages:

1. Create or activate an existing sandbox.
2. Navigate to Application Composer from the Configuration category in the Navigator.
3. In the navigation tree, expand Standard Objects, then expand the Sales Lead, and click Pages.
4. Ensure that the Application Pages tab is selected.
5. In the Details Page Layouts region, duplicate the standard layout by highlighting the standard layout and

clicking the Duplicate icon.
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6. Type a new layout name and click Save and Edit.

The Details Layout page appears.
7. Edit the Summary region.
8. Select the AI Lead Score field from the list in the Available Fields region and move it to the Selected Fields

region.

Note:  Repeat these steps for the Landing Page Layouts section if you want the AI Lead Score field displayed
on the Lead List page.

9. Test the changes: Navigate to Sales > Leads as a user with access to the leads pages, for example, as a
salesperson. Edit a lead and ensure you can see the AI Lead Score field.

10. Publish the sandbox.

Enable the Lead Score for Display in Workspace UI  
You must make the AI Lead Score field available for display in Workspace.

You can select the Display in UI option in the Configure Adaptive Search page, Configure UI tab to display the AI Lead
Score field as a column in search results and saved searches.

For more information, see the related topics, Enable Fields for Display as Filters and Search Result Columns, and
Monitor Adaptive Search Background Processes in the Adaptive Search and Workspace chapter of the Implementing
Sales guide.

Related Topics
• Enable Fields for Display as Filters and Search Result Columns

• How do I monitor Adaptive Search background processes?

Recommended Actions  

Set Up Best Sales Action for Opportunities  
You must configure the best sales action and expose it in the UI.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Intelligence in Sales

◦ Task: Configure Best Sales Action

You can alternatively navigate to the Configure Best Sales Action page from the Configure AI Apps in Sales
task. On the Configure AI in Sales page, click Next Best Action.

2. Select the Best sales action enabled at site level check box and click Save if you want this feature to be
available to all users.

If you want the feature to be available to a subset of users, deselect the check box and click Save, and then edit
the Enable Adaptive Intelligence profile option (ZCA_ENABLE_ADAPTIVE_INTELLIGENCE). See the topic, Edit
the Enable Adaptive Intelligence Profile Option.

3. On the Configure Best Sales Action page, enter a value for Display alert when user-provided win probability
differs by this amount under the Predicted Win Probability section.
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The artificial intelligence predicted win probability indicator (warning alert) displays based on the results.

Note:  The value you enter is the minimum threshold to display the win probability warning indicator for
opportunities. If the difference between the salesperson's win probability prediction and the artificial
intelligence prediction is more than the value you set here, the warning indicator appears. For example, if the
value is set to 25 and the salesperson's win probability prediction is 20%, and the predicted win probability is
50%, the warning indicator appears.

See the topic: Edit the Opportunity Win Probability Risk Threshold Profile Option.
4. In the table under Recommended Action, enable the recommended action that you want to be displayed by

selecting the associated check box.
5. Optionally, edit the Action and Explanation fields for the selected recommend actions to suit your organization

needs.
6. Click Save to save your changes or click Cancel to return to the Setup and Maintenance search page.

Next, for the CX Sales UI, you want to extend your opportunity pages using application composer to include the UI
elements you want, for example:

• Recommended Action and Win Probability columns in the Opportunities list page

• Recommended Actions section and Win Probability and Predicted Win Probability fields in the Edit
Opportunity page

Your salespeople see alerts in the Win Probability column for those opportunities where the threshold has been
exceeded.

If you're using the CX Sales UI, see the topic Add Recommended Actions to Opportunities and follow the steps.

Add Recommended Actions to Opportunities  
This topic only applies to the CX Sales UI where you need to add the Recommended Actions fields to Opportunities
list and Edit Opportunity pages. For the Redwood User Experience, recommended actions appear along with other
recommendations and these steps don't apply.

Note:  You can enable sales recommendations for Opportunity next best actions in the Redwood User Experience.
The sales recommendation feature analyzes text of notes and call logs and recommends follow-up tasks and
appointments. When enabled, this feature replaces the automatic creation of a task after call wrap ups. See Enable
Sales Recommendations for more information.

After you've configured the best sales action feature, for the CX Sales UI, you need to use Application Composer to
display UI elements in your opportunity pages to display recommendation actions. For example, you can:

• Display the Recommended Action and Win Probability columns on the Opportunities list page

• Display the Recommended Actions section and the Win Probability and Predicted Win Probability fields on
the Edit Opportunity page.

Note:  If you're using Sales Coach, then use Application Composer to also display the Sales Coach UI elements in your
opportunity pages. You must specify what sales method to apply to all newly created opportunities by setting the
profile option Sales Method Default.

Here are the high-level steps to add opportunity-related UI elements, such as Recommended Action and Win Probability
columns and Recommended Actions section to the relevant Opportunity pages:

1. Enter a sandbox. See the Overview of Sandboxes topic for details.
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2. Navigate to Application Composer.
3. Expand the Opportunity object tree.
4. In the Opportunity tree, click the Pages link.
5. Ensure that the Application Pages tab is active.
6. In the region that corresponds to the page you're modifying, duplicate the standard layout or select a custom

layout if one exists, and edit the resulting layout. For example, use these steps to expose the Recommended
Action and Win Probability columns to the opportunities list page:

◦ In the Landing Page Layouts work area, select Standard Layout, then select Duplicate from the Actions
menu.

◦ Click the Edit icon for the Opportunity list page.

◦ In the Landing Page Layout, locate and select Recommended Action, and Win Probability and move
them from the Available Fields list to the Selected Fields list.

7. Next, navigate to the Details Page Layout region, duplicate the standard layout, and then edit the resulting
layout.

8. On your custom details layout page, click Show next to Recommended Actions to ensure that this section
appears on the Opportunity details page.

9. Save your changes.
10. Test the changes you just made.
11. Publish the sandbox.

After you complete these configuration steps, your salespeople see the Recommended Action and Win Probability
columns in the Opportunity list page and the Recommended Actions section in the Edit Opportunity page.

Related Topics
• Overview of Recommended Actions for Opportunities

• Overview of Sandboxes

• Extend Pages for Opportunities

• Page Layouts for Standard Objects

Edit the Enable Adaptive Intelligence Profile Option  
The Enable Adaptive Intelligence (ZCA_ENABLE_ADAPTIVE_INTELLIGENCE) profile option enables the viewing of
integration results between Oracle AI Apps for Sales and your sales application. The profile option is set to No by
default.

Here's how to edit the Enable Adaptive Intelligence profile option:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZCA_ENABLE_ADAPTIVE_INTELLIGENCE in the Profile Option Code field.

3. Click Search.
4. In the list that's returned, click on the profile option code link.
5. Set the profile option value to the required value.

For example, to roll out the best sales action feature to a subset of users:
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◦ From the ZCA_ENABLE_ADAPTIVE_INTELLIGENCE: Profile Values section, click the New icon.

◦ In the Profile Level drop down list, select User.

◦ Enter the users you want to avail of the feature in the User Name field.

◦ Select Yes in the Profile Value field.
6. Click Save and Close.

After you enable the profile option, you can extend the opportunity list and detail pages to display the Recommended
Actions section and related steps. In addition, the Recommended Action column is displayed on the Opportunities edit
page only after you add it to the Opportunities detail page using Application Composer. For more details, see the Add
Recommended Actions to Opportunities topic.

Related Topics
• Add Recommended Actions to Opportunities

• Overview of Recommended Actions for Opportunities

• How do I update existing setup data?

Edit the Opportunity Win Probability Risk Threshold Profile Option  
The Opportunity Win Probability Risk Threshold (MOO_WIN_PROB_AI_THRESHOLD) profile option lets you specify the
threshold value used to determine the percentage win probability differential. The artificial intelligence predicted win
probability indicator displays based on the results. The default percentage win probability differential is 30.

The Win Probability percentage column on the Opportunities page shows the likelihood to win the opportunity that's
predicted by the artificial intelligence algorithm. This prediction might differ from the salesperson's estimation of win
probability by more than the value set in the Opportunity Win Probability Risk Threshold profile option. In this case,
the Win Probability column displays a warning indicator. For example, if the profile option value is set to 25 and the win
probability is 20 percent, and the predicted win probability is 50%, the indicator appears.

Here's how to edit the Opportunity Win Probability Risk Threshold profile option:

1. In the Setup and Maintenance work area, go to the following:
◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values
2. From the search region of the Manage Administrator Profile Values page, enter the profile option code name

MOO_WIN_PROB_AI_THRESHOLD in the Profile Option Code field.
3. Click Search.
4. In the list that's returned, click on the profile option code link.
5. Set the profile option value as needed.
6. Click Save and Close.

Related Topics
• Edit the Enable Adaptive Intelligence Profile Option

• Add Recommended Actions to Opportunities

• Overview of Recommended Actions for Opportunities

• How do I update existing setup data?

• What's the difference between win probability and predicted win probability?
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Product Recommendations  

Enable Product Recommendations for Opportunities and Accounts  
Salespeople can view recommended products while working on opportunities and accounts. Product recommendations
are displayed based on machine learning models that analyze past sales to identify products that are often bought
together.

By understanding what recommended products and services that are likely to be bought, salespeople can recommend
products for up-sell or cross-sell based on recommendations generated from machine learning.

Sales administrators with the required privileges can enable the Product Recommendation for Opportunity and features
by using the self service guided process for Sales Intelligence features.

Note:  Sales administrator must have the following privileges to access the Enable Sales Intelligence setup task
Configure Adaptive Intelligence for Sales and the Generate Sales Intelligence Features Data Sufficiency Report
task. Users must have the View Recommended Products  privilege to access product recommendations for their
opportunities and accounts.

Here are the high level steps:

1. In Setup and Maintenance, open the Enable Sales Intelligence task:

◦ Offering: Sales

◦ Functional Area: Intelligence in Sales

◦ Task: Enable Sales Intelligence

2. On the Enable Sales Intelligence Features page, Select Features panel, click Start.
3. Select the features that you want to enable. For example:

a. Select Product Recommendation for Opportunity for the Opportunity object
b. Select Product Recommendation for Account for the Account object.

4. Click Continue.

The application runs a process to identify if you've enough data to enable the features. This process might take
a while to complete, so you can close the flow and wait for a notification email.

5. On the View Feature Eligibility Report page, you get feedback if you've sufficient data for each feature.
Optionally, you can enable and disable features here as well.

6. Click Continue.
7. The Verify Recommended Features step lists the features you're enabling by technology. You must complete

any additional configuration steps in the admin UIs for each technology.
8. Click Continue.
9. In the Configure Recommended Features page, you can click the links to open the administration UIs for

technologies related to the features you enabled. Links are available for Adaptive Intelligence and Machine
Learning (Similar Accounts). There's no direct link for Sales Insights. You can also navigate to these UI pages
separately.
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Insights  

Opportunity Win Probability Reports  
You can view opportunity win probability reports on the Insights page to better understand how AI Apps
recommendations are working for your opportunities.

In Setup and Maintenance, go to the following:

• Offering: Sales

• Functional Area: Intelligence in Sales

• Task: Configure AI Apps in Sales

On the Configure AI in Sales page, click Insights. On the Insights page, click Opportunity Win Probability to review the
reports.

Recommended Action Status Report  

Use the status report to review the trend in the number of actions recommended to your salespeople during a 12-month
period.

You can also monitor data ingestion by checking the number of open opportunities and the opportunities that closed in
the last 30 days. If you don’t see these numbers, check your connection settings or contact Oracle Support.

Opportunity Prediction Accuracy Report  

Review the accuracy of AI Apps predictions of opportunity outcomes.

The report counts the prediction as accurate if it was correct two-thirds of the way through the opportunity life cycle.
For example, let's take an opportunity that was open for 90 days and closed on September 30th. The report checks
the outcome against the prediction given on August 30th. If the opportunity win prediction was greater than 50% on
August 30th, and the opportunity outcome was a win, the application considers the prediction as accurate.

If the graph on the report shows a lot of variance between months, you can select Show Moving Average to view the
average from all previous data.

Recommendations Displayed on Opportunity Pages  

Your salespeople see recommendations for their opportunities when AI Apps models detect that taking a particular
action improves the chances of winning an opportunity. Recommendations provide useful actions to help salespeople
convert their opportunity to a win.

Recommended Action Type Action (Displayed in Oracle CX Sales) Description (Displayed in Oracle CX Sales)

Activity Frequency Low
 

Contact this account
 

Log more activities for this opportunity.
Opportunities that we win have more frequent
contact.
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Recommended Action Type Action (Displayed in Oracle CX Sales) Description (Displayed in Oracle CX Sales)

Time Since Last Activity High
 

Contact this account today
 

Speak to this account since there has been a
gap in activities. Opportunities that we win have
more frequent contact.
 

Deal Size High
 

Consider whether this deal size is realistic
 

Improve the win probability by decreasing the
deal size if appropriate.
 

Contact Count Low
 

Broaden your contact base
 

Engage with more contacts as similar
opportunities that closed with a win had
engagement with more contacts.
 

Total Activities Low
 

Contact this account
 

Log more activities for this opportunity.
Opportunities that we win have more activities.
 

Competitive Influence Strong
 

Review competitive plays
 

Improve your chances of winning by ensuring
that you're well-differentiated from the primary
competitor.
 

Deal Size Low
 

Consider increasing the deal size
 

Improve the win probability by increasing the
deal size if appropriate.
 

Age High
 

Check that your opportunity is still relevant
 

Typically, similar opportunities close much
faster.
 

Contact Title Low Converting
 

Verify that the primary contact is the decision
maker
 

Review the decision-making ability of the
primary contact to improve your chances of
winning.
 

Time Spent in Stage High
 

Verify the sales stage
 

Verify that the sales stage shows the correct
status. Similar opportunities that closed with a
win are no longer in this stage after this length
of time.
 

Momentum Low
 

Review sales stage and increase momentum
 

Increase momentum as similar opportunities
that closed with a win moved through the sales
stages faster.
 

An administrator can edit the default recommended actions to suit your requirements. See Set Up Best Sales Action for
Opportunities for details.

Lead Conversion Probability Reports  
You can view lead conversion probability reports on the Insights page to better understand how AI Apps predictions are
working for your leads.

In Setup and Maintenance, go to the following:

• Offering: Sales

• Functional Area: Intelligence in Sales
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• Task: Configure AI Apps in Sales

On the Configure AI in Sales page, click Insights. On the Insights page, click Lead Conversion Probability to review the
reports.

Lead Prediction Status Report  

Use the status report to review the trend in the number of predicted leads shown to your salespeople during a specified
12-month period.

You can also monitor data ingestion by checking the number of open leads and the leads that closed in the last 30 days.
If you don’t see these numbers, check your connection settings or contact Oracle Support.

Lead Prediction Accuracy Report  

Review the accuracy of AI Apps predictions of lead outcomes during a selected period. The accuracy is based on how
many high-scoring leads got converted to opportunities. The report counts the prediction as accurate if the lead score
was above 70% when the lead got converted to an opportunity.

If the graph on the report shows a lot of variance between months, you can select Show Moving Average to view the
average from all previous data.

Data Processing Status  

Overview of Data Processing Status  
Use the Data Processing Status page to view a summary of ingested data in the application.

The summary includes the number of ingested open and closed opportunities, activities, contacts, open and closed
leads, and so on.

In Setup and Maintenance, go to the following:

• Offering: Sales

• Functional Area: Intelligence in Sales

• Task: Configure AI Apps in Sales

On the Configure AI in Sales page, click AI Apps Connections to view data sources and their status. To view the data
processing status, click View Status on the Data Sources page.

On the Data Processing Status page, use the summary to know the volume of data ingested as compared to the data
volume in Oracle CX Sales. For example, if you see that the overall data volume in Oracle CX Sales doesn't match the
data volume in the data processing summary, you know there’s potentially an issue with data processing.
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Sales Machine Learning  

Overview of Sales Machine Learning  
Machine learning models recognize patterns in your data and make predictions using the attributes you select in the
model. Your application comes with the Similar Accounts model, which recognizes similar accounts using attributes
such as location, size, and industry. As a sales administrator without prior training in AI, you can use the Machine
Learning feature to modify the existing Similar Accounts model, and you can build machine learning models of your
own.

This table shows the setups that you need to complete to enable the Sales Machine Learning feature and show similar
accounts on the Account pages of CX Sales.

Step Applies To Description Navigation Where to Get More Details

1 Both Digital Sales and CX
Sales

Create and deploy the model
either by copying the Similar
Accounts model or creating
one from scratch.

Open the Machine Learning
Models page either from the
last step in the Enable Sales
Intelligence Features task.
You can also search for the
Configure Sales Machine
Learning task using the Tasks
search panel on the right side
of the Setup and Maintenance
work area.

See the topics:
 

• Overview of Building Machine
Learning Models

• Create a Similar Accounts Model

• Create a Machine Learning Model
from Scratch

2 CX Sales If you copied the Similar
Accounts model, the
application displays similar
accounts automatically in
Digital Sales when salespeople
enter "Show similar accounts"
in the Action Bar.
For CX Sales, you must display
the Similar Accounts in the UI
using Application Composer.
 

Application Composer See the topics in the section: Display
Similar Accounts on the Account pages
of CX Sales.
 
High-Level Setup Steps
 

Overview of Building Machine Learning Models  
Here’s an overview of the high-level steps for building your machine learning models.

1. You have a choice of either duplicating the existing Similar Accounts model and modifying the copy, or you can
create a model of your own from scratch.

2. You add some basic information. If you're creating a model from scratch, you select the object and type of
model you're building: either a prediction model or a model to identify similar records.

3. You select the attributes you want to use for your model.
4. You click Prepare Data to check if there's sufficient data for each attribute.
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5. If your model results in the Error status, you don't have sufficient data for some of the atrributes and you must
select different attributes or fix the data.

6. If your model completes with the Prepared status, then you can add data categories for the different attributes
in the Add Features step.

7. Click Submit to build the model.
8. Analyze the model results. You get tips on how to improve the model.
9. If the model needs improvement, you can go back to the previous steps to tweak it.

10. You can deploy the model to automatically run on a daily, weekly, or a monthly schedule.

Related Topics
• Create a Similar Accounts Model

• Create a Machine Learning Model from Scratch

• See Similar Accounts for an Account in Digital Sales
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Navigate to the Machine Learning Models Page  
You can open the Machine Learning Models page either from the last step in the Enable Sales Intelligence Features task
or you can search for it using the Tasks search panel on the right side of the Setup and Maintenance.

1. In the Setup and Maintenance work area, select the Sales offering.
2. Click the Tasks side panel on the right side of the page.
3. Click Search.
4. Search for the Configure Sales Machine Learning task and click on the link.

Create a Similar Accounts Model  
Here's how to create a similar accounts model of your own.

1. Navigate to the Machine Learning Models page.
2. On the Machine Learning Models page, click Actions (hamburger icon) and select Duplicate for the Similar

Accounts model.

Your action creates a copy of the predefined model in the Draft status.
3. In the Basic Information step, enter a name and description. They're visible only in the administration pages.

4. Click Next.
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5. The Attribute Selection page lists the attributes for the model provided by Oracle(callout 1 in the screenshot
below).

6. Add or delete account attributes you want the model to use. For example, the model provided by Oracle
includes Postal Code as one of the attributes. Too many distinct values will make the model less useful and slow
to run, so remove Postal Code if you're selling in multiple countries, for example.

a. Use the delete icon (callout 2 in the screenshot above) to remove the attributes you don't need.
b. Use the search field (callout 3 in the screenshot above) to add account attributes.

7. Click Prepare Data to validate if sufficient data exists to create a model from the attributes you selected.

The Status column on the Machine Learning page shows the Running status while the validation process is
running.

8. Click Refresh to check for status changes.
9. A status of Error means that you don't have sufficient data for some of the attributes you selected for your

model. At least 30 percent of the records must have a value for the attribute. Here's what to do:
a. Click on the name link of your model.
b. Click to the Attribute Selection step to see a list of the errors.
c. Delete the attributes that you can't use.
d. Click Prepare Data  again.

10. If your model is in the Prepared status, you have sufficient data to analyze and tweak your model further.
11. Click the Features step.
12. Click Actions > Edit for any of the attributes to fine tune you model by categorizing the values.
13. On the Calculation Type page, you can provide one or more categories for the model to consider. Categories

affect the way that the model learns and how it creates clusters of records. For example, if you find out that
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your model has too many unique values for a particular attribute, you can come here and group them. Which
calculation type is available depends on the attribute:

◦ Age Date bucket: Use this calculation type for date-time attributes such as Creation Date. You can define
age groups, such as 0 to 1 year old, 1 to 2 years old, and 2 to 3 years old, instead of a date. Then, your
model searches for similar accounts within the configured age groups.

◦ Number bucket: Use this calculation type for numeric attributes like Potential Revenue and Organization
Size. For example, instead of searching by a deal amount, you can create number buckets of equal
ranges, such as 0 to 100,000, and 100,000 to 200,000. Your model will search for similar accounts that
have a deal amount within the configured number buckets.

◦ Category: You can use this calculation type to create categories based on attribute conditions. For
example, you can categorize accounts by world regions, by grouping countries as Latin America, North
America, Asia Pacific, and Europe. Or you can categorize accounts as Large, Medium, or Small, using
Opportunity Revenue or Organization Size.

14. Here's how to classify the countries where you do business by geographical regions, for example:
a. Click Actions > Edit for Country.
b. From the Calculation Type list, select Category.
c. In the Category Value field, enter North America.
d. From the Operator list, select Equals
e. In the Value field, search and enter one of the countries in North America.
f. Click Add Another Rule (the plus sign) and add a second country.

g. Repeat the process until you added all the countries in the category.
h. Click Add Category to add additional categories.
i. Click Done.

15. When you are done adding calculation types, click Submit to run the model.
16. Click Refresh to refresh the status.
17. When the model status changes from Running to Ready, click Actions > Edit. The Actions menu is the

hamburger icon on the right side of the page.
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18. Click the Review step to review similar accounts the model finds for any account you select:
19. From the Account field, select an account to display the similar accounts predicted by the model.
20. Click Analyze to review information about your model on the Analysis Report page.
21. The report includes tips on how you can improve the model. For example, the report can tell you that some

fields have too few unique values and that others have too many.
If a field has too few values, you'll need to either import more data or eliminate that attribute from the model. If
there are too many values, you'll need to group them into categories on the Features step.
Here's some other useful information:

◦ Algorithm Selected: The algorithm that was run for your model. You can't change the algorithm, so you
can ignore this field.

◦ Model Accuracy: Shows the accuracy of your model as a percentage. A good model accuracy is above 90
percent. If the value is less, change the attributes to improve the accuracy.

◦ Number of Clusters: Number of account groupings in your model. The more clusters that you have the
fewer similar accounts that you get. About 20 clusters is a good number.

◦ The Data Analysis tab shows you the number of distinct values for each attributes and the percent
empty values, for example.

◦ The Model Analysis tab shows the number of clusters and a pie chart of their distribution.

22. Click Next.
23. On the Deploy page: enter the date and time that you want to start running the m and recurrence.

a. Date and Time: Enter the date and time that you want to start the schedule from.
b. Recurrence: Set the frequency for rebuilding your model, depending on how often your data changes.

- Daily
- Weekly
- Monthly

24. Click Deploy.
Your model is now active.

Note:  Only one model can be active at a time. If you already have an active model, you must confirm that
you want to replace it.

Create a Machine Learning Model from Scratch  
You can create a machine learning model completely from scratch. You can use the model to either predict similar
records or predict outcomes for accounts, contacts, opportunities, and sales leads.

Creating a model from scratch involves additional setup in the Basic Information step. Otherwise the process is the
sames as for creating a similar accounts model from the one provided by Oracle.

1. Navigate to the Machine Learning Models page.
2. On the Machine Learning Models page, click Create.
3. In the Basic Information step, enter the following:

◦ Model name

◦ Name of the use case the model covers

◦ Optional description
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4. Select an object. Options are:

◦ Account

◦ Contact

◦ Opportunity

◦ Sales Lead

5. Select the model type, either Identify Similar Records or Predict Outcome.
6. If you selected Predict Outcome, then select the attribute you want to predict. For example, if you want to

predict that an opportunity results in an order, then select Order.
7. Select the records that you want to include in the data set.
8. Click Next.
9. On the Attribute Selection page, add the attributes you want to use in the model.

10. Click Prepare Data to validate if sufficient data exists to create a model from the attributes you selected.

The Status column on the Machine Learning page shows the Running status while the validation process is
running.

11. Click Refresh to check for status changes.
12. A status of Error means that you don't have sufficient data for some of the attributes you selected for your

model. At least 30 percent of the records must have a value for the attribute. Here's what to do:
a. Click on the name link of your model.
b. Click to the Attribute Selection step to see a list of the errors.
c. Delete the attributes that you can't use.
d. Click Prepare Data  again.

13. If your model is in the Prepared status, you have sufficient data to analyze and tweak your model further.
14. Click the Features step.
15. Click Actions > Edit for any of the attributes to fine tune you model by categorizing the values.
16. On the Calculation Type page, you can provide one or more categories for the model to consider. Categories

affect the way that the model learns and how it creates clusters of records. For example, if you find out that
your model has too many unique values for a particular attribute, you can come here and group them. Which
calculation type is available depends on the attribute:

◦ Age Date bucket: Use this calculation type for date-time attributes such as Creation Date. You can define
age groups, such as 0 to 1 year old, 1 to 2 years old, and 2 to 3 years old, instead of a date. Then, your
model searches for similar accounts within the configured age groups.

◦ Number bucket: Use this calculation type for numeric attributes like Potential Revenue and Organization
Size. For example, instead of searching by a deal amount, you can create number buckets of equal
ranges, such as 0 to 100,000, and 100,000 to 200,000. Your model will search for similar accounts that
have a deal amount within the configured number buckets.

◦ Category: You can use this calculation type to create categories based on attribute conditions. For
example, you can categorize accounts by world regions, by grouping countries as Latin America, North
America, Asia Pacific, and Europe. Or you can categorize accounts as Large, Medium, or Small, using
Opportunity Revenue or Organization Size.

17. Here's how to classify the countries where you do business by geographical regions, for example:
a. Click Actions > Edit for Country.
b. From the Calculation Type list, select Category.
c. In the Category Value field, enter North America.
d. From the Operator list, select Equals
e. In the Value field, search and enter one of the countries in North America.
f. Click Add Another Rule (the plus sign) and add a second country.

g. Repeat the process until you added all the countries in the category.
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h. Click Add Category to add additional categories.
i. Click Done.

18. When you are done adding calculation types, click Submit to run the model.
19. Click Refresh to refresh the status.
20. When the model status changes from Running to Ready, click Actions > Edit. The Actions menu is the

hamburger icon on the right side of the page.
21. Click the Review step to review similar accounts the model finds for any account you select:
22. From the Account field, select an account to display the similar accounts predicted by the model.
23. Click Analyze to review information about your model on the Analysis Report page.
24. The report includes tips on how you can improve the model. For example, the report can tell you that some

fields have too few unique values and that others have too many.

If a field has too few values, you'll need to either import more data or eliminate that attribute from the model. If
there are too many values, you'll need to group them into categories on the Features step.

Here's some other useful information:

◦ Algorithm Selected: The algorithm that was run for your model. You can't change the algorithm, so you
can ignore this field.

◦ Model Accuracy: Shows the accuracy of your model as a percentage. A good model accuracy is above 90
percent. If the value is less, change the attributes to improve the accuracy.

◦ Number of Clusters: Number of account groupings in your model. The more clusters that you have the
fewer similar accounts that you get. About 20 clusters is a good number.

◦ The Data Analysis tab shows you the number of distinct values for each attributes and the percent
empty values, for example.

◦ The Model Analysis tab shows the number of clusters and a pie chart of their distribution.

25. Click Next.
26. On the Deploy page: enter the date and time that you want to start running the m and recurrence.
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a. Date and Time: Enter the date and time that you want to start the schedule from.
b. Recurrence: Set the frequency for rebuilding your model, depending on how often your data changes.

- Daily
- Weekly
- Monthly

27. Click Deploy.

Your model is now active.

Note:  Only one model can be active at a time. If you already have an active model, you must confirm that
you want to replace it.

Model Statuses  
This table describes the stages a model goes through and the corresponding statuses it displays while going through
them:

Scenario Status

You create a copy from an existing model,
 enter basic details, and save. The model
appears in the list.

The model is saved as a Draft.

You add attributes and save the model. The model is saved as a Draft.

You click Prepare Data to validate the
attributes.
The engine triggers a model run.
 

Whenever the engine prepares the data or builds the model, the status shows Running.

If the run is successful... The status changes from Running to Draft.

If the run failed... The status changes from Running to Error.

You get the status as Error when the
attributes you select don’t have enough
data.
Review and make changes to the
attributes. Click Prepare Data to run the
model process again.
 
Result: The run is successful.
 

Status changes from Running to Draft.

The engine prepares the data. You now
want to build the model.
You open the model and click Submit.
 

Status changes from Running to Ready.

Your model is now ready for deployment.
Although you can have many models in
the Ready status, you can deploy only one
of them at any give time.
Review the model, enter the deploy
schedule, and click Deploy.

Status changes from Ready to Active.
Your sales team can see the similar accounts based on the similarity identified by the active model.
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Scenario Status

 

You want to retire an active model. Click
Retire from Actions (the hamburger icon).
A confirmation message appears that
the deploy schedule of the model will be
deleted.
 

Status changes from Active to Ready.

You want to delete a model.
• To remove an active model, you need

to retire the model first and delete it.

◦ Click Retire from Actions (the
hamburger icon).

◦ After the model status reverts to
Ready, click Delete from Actions.

• To remove an inactive model, click
Delete from Actions.

The engine removes the model permanently from the list view and the Digital Sales database.

Here's a screenshot of the Machine Learning models list. It shows about seven similar account models that are in
various statuses such as Draft, Ready, Running, and Error. While many models can exist in the Draft and Ready statuses,
only one of them can be active. The model statuses are also indicated in different colors. For example, the Error status is
shown in a red box, the Running status is shown in blue, and Active is shown in green.

713



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 47
Sales Intelligence

Display Similar Accounts on the Account Pages of CX Sales  

High-Level Setup Steps  
Here's a summary of the setups you need to make to display Similar Accounts in the CX Sales account pages. No setup
is required to make Similar Accounts display in Digital Sales UIs.

1. Create a REST web service for Similar Records.
2. Create a REST web service for GET Account.
3. Create a global function for invokeSalesMLSimilarRecordsQuery API.
4. Use Formula fields to create a similar accounts field.
5. Add the similar accounts field to the Account landing page layout.

Create a REST Web Service for Similar Records API  
Here's how you create a REST Web Service for Similar Records API:

1. Enter an active sandbox. From the navigator, go to Configurations > Application Composer > Common
Setup > Web Services.

2. On the Web Services page, click the new web service icon.
3. On the Select Connection Type window, select REST and click OK.

4. On the Create REST Web Service Connection page, enter a Connection Name. For example,
SalesMLQueryAPISimilarRecords.

Ensure that you use same connection name in Global Function Groovy as well. See the Create a Global Function
for SalesMLQueryAPI Similar Records section in this topic.

5. Leave the API-based REST Service check box blank.
6. Select OData for REST Service Type.
7. Enter a URL in the format, https://<host>/crmRestApi/salesML/resources/latest/salesMLQueryAPI For example,

https://fuscdrmsmcxxx-fa-ext.oracle.com/crmRestApi/salesML/resources/latest/salesMLQueryAP.
8. Select any of these values for Authentication Scheme:

◦ Call with Basic Authentication.

◦ Propagate user identity using SAML.

◦ Propagate user identity using SAML over SSL.

Here's a screenshot of the Create REST Web Service Connection page. The page shows the API name,
REST service related settings selected, and a sample URL entered.
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9. Next, enter information in the Select and Configure Methods against the Resource section:
a. Select the POST check box.
b. Let the Method Name be POST and Format be JSON.
c. Select Code Sample for Request Payload and enter this code into the text field:

{
 "UseCaseCode" : "CX_SIMILAR_ACCOUNTS",
 "QueryMetadata":"whereClause:partyid = 300100006784914;numberOfRows:5"
}

d. Select Code Sample for Response Payload and enter this code into the text field:
{
 "PARTYID": "300100006785018",
 "INDUSTRYCODE": "",
 "ORGANIZATIONSIZE": "",
 "STATE": "CA",
 "COUNTRY": "US",
 "POSTALCODE": "94065",
 "CITY": "Redwood Shores",
 "EMPLOYEESTOTAL": "1",
 "PROB": "0.8740334165546894",
 "CLUSTER_ID": "370",
 "RNK_CLUS2": "6"
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}

10. Click Save and Close.

The application creates a web service for the similar records API.

Create a REST Web Service for GET Account API  
After creating the Similar Accounts REST web service, create another REST web service for GET Account API. Here’s how
you create it:

1. On the Web Services page, click the new web service icon.
2. On the Select Connection Type window, select REST and click OK.
3. On the Create REST Web Service Connection page, enter a Connection Name. For example, GET_Accounts.

Ensure that you use same connection name in Global Function Groovy. See the Create a Global Function for
SalesMLQueryAPI Similar Records section in this topic.

4. Leave the API-based REST Service check box blank.
5. Select OData for REST Service Type.
6. Enter a URL in the format, https://<host>/crmRestApi/resources/latest/accounts. For example, https://

fuscdrmsmcxxx-fa-ext.oracle.com/crmRestApi/resources/latest/accounts.
7. Select Call with Basic Authentication for Authentication Scheme.
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8. Add your Credential Key.

9. Next, enter information in the Select and Configure Methods against the Resource section:
a. Select the GET check box.
b. Let the Method Name be GET and Format be JSON.
c. Leave Request Payload blank.
d. Select Code Sample for Response Payload and enter the following code into the text field: { "items" :

[], "count" : 1, "hasMore" : false, "limit" : 25, "offset" : 0, "links" : []}

10. Save and close.
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Create a Global Function for salesMLQuerySimilarRecords API  
Here's how you create a global function for the salesMLQuerySimilarRecords API:

1. Continue in the active sandbox and navigate to Configurations > Application Composer >  Common Setup >
Global Functions.

2. Click the global function icon.
3. On the Create Global Function page, enter a Function Name. For example,

invokeSalesMLSimilarRecordsQueryAPI.

Ensure that you use same global function name in the Groovy for the formulae type field.
4. Select String for Returns.
5. Add these parameters:

◦ Name: useCaseCode Type: String.

◦ Name: objectPKName Type: String.

◦ Name: recordPKValue Type: Long (Integer).

6. Add this Groovy code in the Edit Script field:
def inputMap = [:];
def accountNames = "";
def debugLog = "";
if(recordPKValue != null) {
 try {
 debugLog += "Primary Key:"+recordPKValue;
 def wsRequest = adf.webServices.salesMLQueryAPISimilarRecords;
 def httpHeaders = ['Content-Type': 'application/json', 'Accept-Encoding': 'text/plain']
 wsRequest.requestHTTPHeaders = httpHeaders;
 inputMap.put("UseCaseCode", useCaseCode);
 inputMap.put("QueryMetadata",
 "whereClause:".concat(objectPKName).concat("=").concat(recordPKValue.toString()).concat(";numberOfRows:5"));
 def partyIds = "";
 debugLog += "GOING TO INVOKE SALESML API: ";
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 def wsResponse = wsRequest.POST(inputMap);
 debugLog += "SALESML API INVOKED: ";
 for(similarAccount in wsResponse) {
 if(partyIds == "") {
 partyIds += similarAccount.PARTYID;
 } else {
 partyIds += ","+similarAccount.PARTYID;
 }
 }
 if(partyIds != "") {
 debugLog += "START ACCOUNTS GET PREP: ";
 def wsRequest2 = adf.webServices.Acconts_GET;
 def httpHeaders2 = ['REST-Framework-Version': '2'];
 wsRequest2.requestHTTPHeaders = httpHeaders2;
 def queryParams = ['q':'PartyId IN ('+partyIds+')'];
 wsRequest2.dynamicQueryParams = queryParams;
 debugLog += "GOING TO INVOKE ACCOUNTS GET: ";
 def accounts = wsRequest2.GET();
 debugLog += "INVOKED ACCOUNTS GET: ";
 def count = 0;
 for(account in accounts.items) {
 if(count == 0) {
 accountNames += account.OrganizationName;
 } else {
 if(count<5){
 accountNames += ",\n"+account.OrganizationName;
 } else {
 break;
 }
 }
 count++;
 } 
 }
 } catch (e) {
 debugLog += e.getMessage();
 accountNames = debugLog;
 }
} else {
 accountNames = "Not Available";
}
 
if(accountNames == "") {
 accountNames = "Not Available";
}
 
return accountNames;
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7. Click Validate.

8. Click Save and Close.
The Groovy may show some warnings. Ignore those warnings and click Yes to save the script.

Use a Formula Field to Render a Similar Accounts Field  
Create a multiline text formula field to show the similar accounts you get from the model. Here's how you create the
field:

1. Enter an active sandbox.
2. Navigate to Configuration > Application Composer > Standard Objects > Account >  Fields.
3. On the Fields page, click Actions > Create.
4. Select Formula and click OK.

To learn more about the formula fields, read the Formula Fields topic in the Configuring Applications Using
Application Composer guide.

5. On the Create Formula Field page, enter a Display Label. Enter the same name but without spaces, in the
Name field.
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6. Select Display Type as Multiline Text Area.

The formula field will appear as a multiline text area to display the similar accounts.

7. Click Next.
8. On the Configure Expression page, enter the formula value in the following format:

adf.util.InvokeSalesMLQueryAPI("<Prediction Model Usecase
 Code>","<Primary Key Field Name>",<Primary
 Field Value>)

For example, adf.util.invokeSalesMLSimilarRecordsQueryAPI("CX_SIMILAR_ACCOUNTS","partyid",PartyId).
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9. Click Submit.

You can now add the similar account field to an object page.

Add the Field to the Landing Page Layout  
Add the multiline text formula field you created, to the landing page so that similar account results render in that field.
Here's how you add:

1. Enter an active sandbox.
2. Navigate to Configuration > Application Composer > Standard Objects > Account >  Pages > Application

Pages > Landing Page Layouts.
3. Create a copy of the Landing Page layout and add the Similar Accounts formula field you created.
4. Save your changes.

At the end of the configuration, you can see the similar accounts showing up on the Accounts page.
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Sales Insights  

Overview of Sales Insights  
Sales Insights help provide an objective understanding to salespeople working with accounts, leads, and opportunities.

Based on detailed analysis of account interaction and historical exchanges such as sales activities, status, duration,
contacts, and so on, salespeople can gain key insights and take appropriate corrective actions on records to further
increase their sales pipeline.

Identifying those accounts, leads, and opportunities that are either highly or moderately engaged and by observing
certain accounts helps salespeople:

• Prioritize the next set of actions for records and tasks

• Improve productivity by moving the sales pipeline along

• Identify quickly what's wrong with a lead or opportunity and take the necessary corrective action

Here are the UI paths for salespeople to access Sales Insight details:

• Accounts: Use the Profile tab on the Accounts page

• Leads: Use the Summary tab on the Edit Lead page

• Opportunities: Use the Summary tab on the Edit Opportunity page

See the Using Sales guide topics about Sales Insights for more information about salespeople tasks.

Related Topics
• About Sales Insights
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Enable Sales Insights  
Sales Insights data is mined, evaluated, and analyzed through data analytical and statistical modules. Adaptive Search
finds key metrics and calculates standard deviations, averages, and margins to deliver insights.

You can also enable sales recommendations for Sales Insights for the Redwood User Experience. The sales
recommendation feature analyzes text of notes and call logs and recommends follow-up tasks and appointments.
When enabled, this feature replaces the automatic creation of a task after call wrap ups. See Enable Sales
Recommendations for more information.

You enable the feature using the opt-in task. If you've permission to configure offerings, then you can use the New
Features page to opt in to Sales Insights feature:

1. Click Navigator > My Enterprise > Offerings work area.
2. On the Offerings page, select the Sales offering.
3. Click Change Feature Opt In.
4. For the Sales root node, click the edit link (pencil icon).
5. From the Edit Features page, find Sales Insights and select the check box in the Enable column.
6. On the Opt In page, click Done to save the changes and return to the Offerings page.

Next, you must schedule Sales Insights data processes. For instructions about how to schedule the jobs, see the related
links.

Process Frequency

Generate Sales Insight Metrics
 

Once a week
 

Generate Sales Insight Facts
 

Once a week
 

Generate Sales Insight Facts Using Signals
 

Daily
 

Purge Redundant Sales Insight Facts
 

Once a month
 

Note:  To support opt in with custom layouts for the Account, Lead, and Opportunity objects, you must go to
Application Composer and click Show in the Sales Insights section for your custom layout object. See the Enable Sales
Insights for Custom Layouts section in this topic for more details.

For more information, see the New Feature Opt-In section of the Oracle Applications Cloud - Using Functional Setup
Manager guide on the Oracle Help Center (docs.oracle.com).

Enable Sales Insights for Custom Layouts
Here are the steps to display the Sales Insights section for a custom account layout page. You can also follow similar
steps to show the Sales Insights section for custom sales lead and opportunity layout pages.

Note:  When you first enable Sales Insights for a business or custom object, then all other objects that support the
Sales Insights feature are automatically enabled and ready for use.
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1. Ensure you're working in an active sandbox.
2. Click Navigator > Configuration > Application Composer.
3. In the Objects navigation tree, expand Standard Objects and then expand the object whose pages you want to

change. For example, select the Account object.

Note:  Select the Sales Lead object to display Sales Insights section for the leads UI and select Opportunity
object to display Sales Insights section for the opportunities UI.

4. Click the Pages node.
5. Ensure that the Application Pages tab is selected for either the account, contact, household, or partner object.
6. In the Details Page Layouts region, edit the relevant layout.

If none exists, then duplicate the standard layout using the duplicate layout icon, and edit the resulting layout.
7. In the Details Layout page for Account, click the Profile tab.

Note:  Click the Summary  tab if you're displaying the Sales Insights section for leads and opportunities.

8. In the Sales Insights region for the selected object, click Show to show the Sales Insights region at runtime.

Here's an example screen shot for the Account object.

9. Click Save and Close, then Done.
10. Publish the sandbox according to your company's business practices.

Related Topics
• Submit Scheduled Processes and Process Sets
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